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BASIC 3D TERMS AND CONCEPTS OF MODELING WITH 

T-FLEX CAD 

INTRODUCTION TO 3D  MODELING  

T-FLEX CAD is a parametric solid and surface modeling system. It is equipped with most up-to-date tools 

for creating models of various complexities. Supported exporting and importing geometric data in 

common formats facilitates interoperability with most other CAD systems. T-FLEX CAD also includes a 

complete line of instruments for 2D modeling and drawing compliant with various national and 

international drawing standards. 

Before beginning with 3D modeling, it is recommended that users familiarize themselves with 2D drawing 

techniques in the appropriate sections of the documentation. This will help embracing the general 

modeling principles with T-FLEX CAD. 

This chapter presents a classification and a brief description of all elements in T-FLEX CAD, and basic 

methods and techniques of 3D modeling. The following chapters of this volume will describe each of these 

elements in detail. 

Basic Topology Elements 

A model in T-FLEX CAD is a set of connected or disconnected geometrical components. Shown below are 

the basic topology elements that form any geometrical object in T-FLEX CAD. 

Solid Body (a solid) is a set of geometrical objects – vertices, 

edges and faces that comprise a closed connected volume. A 

simplest solid can be defined by sweeping a bounded surface 

or a contour.  

 

Sheet Body (a surface) is a set of geometrical objects – 

vertices, edges and faces that comprise a closed connected 

area and do not constitute a volume. 

 

 

 

Loop is a set of edges making one closed contour. A loop is an element defining the boundary of a face. 

Each vertex of a loop connects no more than two edges. 
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Edge is a curve segment bounded by two vertices. A closed 

edge may contain only one vertex. 

 

 

Face is a bounded patch of a surface. The boundary is 

represented by loops. One face may have an unlimited 

number of loops. A face may be without loops. This is the case 

of a full face comprising a closed volume, such as a full sphere. 

 

 

Basic Geometrical Terms in T-FLEX CAD 

All geometrical objects in T-FLEX CAD can be classified into four general groups by type of the object 

geometry: 

 The simplest object in the three-dimensional space is 3D point. A point has only one property, 

namely, the placement coordinates. It can be defined by a 3D node, a 3D vertex, a “placement” 

parameter on a curve or surface, a characteristic location property within an object, such as 

on an axis of revolution, at the center of an arc or sphere, at objects intersection, etc. 

 The second group of objects is “wire” geometry, the objects that possess the basic property 

of length. These include all linear objects, as are edges, 3D paths, loops and 3D profiles. 

 The next group includes all objects that are characterized by area. These objects will be 

referred to as “sheet” geometry, and include all kinds of surfaces, sheet bodies, faces, and 

closed 3D profiles. A sheet object can be produced by most 3D operations. 

 The forth group includes all solid bodies. 

3D  ENTIT IES AND OPERATIONS  

A 3D model creation implies building solid or sheet 3D objects describing a certain volume or surface in 

the 3D space. The creation and further modification of such objects is done by means of operations. 

Operation is any step of creating a 3D model that leads to emergence of a new or modifications in an 

already existing solid or sheet geometrical object. A separate command is provided in T-FLEX CAD for each 

operation. The names of operation creating commands correspond to an operation’s purpose. 
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The operations that result in new solid/sheet 3D objects will be referred to as basic operations (extrusion, 

rotation, sweep, loft, etc.). The operations that alter geometry and modify already existing solid/sheet 

objects will be referred to as modifier operations (blend, shell, Boolean, etc.). 

The geometry base for most basic operations is provided by 3D construction elements. 3D construction 

elements are auxiliary elements of a 3D model that are used for creating three-dimensional contours, 

defining spatial orientation, determining directions, vectors, axes, trajectories, etc. A separate command is 

provided for creating each such element. 

Some operations (for example, the operations for creating 3D arrays) can be both basic and modifier 

operations, depending on the source data and parameter settings. 

Any solid or sheet 3D object in the 3D scene corresponds to a special element in the 3D model structure, 

which is Body. The “Body” element is introduced for user convenience: once a new geometrical object is 

created by the first (basic) operation (solid or sheet body), it can be handled in the future as a permanent 

element in the 3D model structure. 

Body is created automatically upon creating a solid or sheet 3D object by a basic operation, and is 

maintained as long as the given object exists. The geometry of the original volume or surface may change 

(as a result of applying modifier operations), but it always refers to the same Body that defines parameters 

of this geometrical object: name, material, color, rendering settings (mesh density, wireframe display).  

A 3D model can contain an unlimited number of Bodies. 

In some commands, Bodies can be used as separate elements. In such a case, the source object will be the 

body of the last operation in the creation history of the given Body. For example, when creating a 2D 

projection, a specific Body can be selected for projecting. This would be convenient, if the first design stage 

was making the drawing of the part’s workpiece or a set thereof, while the second - modifications of this 

model by additional operations. In this way, the drawing reflects on all future modifications to this part. 

In this manual, the term “Body” (with capital “B”) means specifically a 3D model structure element. 

The lowercase inscription “body” will be used for a quick reference to the geometrical object, which 

is a volume or surface in the 3D scene. 

3D Construction Entities 

Workplane is an entity that helps defining the required data for 3D operations, and, first of all, creating 3D 

profiles. A 3D model cannot be built without creating a workplane. Workplanes can be specified in 2D or 

3D window based on various references, such as the 2D drawing views, projections of entities in a 3D 

model, or the 3D entities themselves, including other workplanes. 
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Worksurface serves similar functional purposes as the 

workplanes, providing a non-planar geometrical basis for 

further design. A worksurface can be a cylinder, a sphere, or a 

torus.   

3D node is one of the basic construction entities used for 

representing a point in the three-dimensional space. There 

are several ways of creating 3D nodes. A 3D node can be 

specified, for instance, as a characteristic point on a body, 

referencing a vertex, an edge, or a face. It also can be located 

by using absolute coordinates or offsets from other 3D nodes. 

3D nodes can also be specified using the nodes from the two-

dimensional drawing, and workplanes. In this way, the 3D 

node will be defined by selecting one node on a workplane, 

or two nodes on two different workplanes that are related by 

having a common projection. 
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3D profile is a construction entity used for defining a patch 

on a surface. A 3D profile is one of the basic entities because 

it is used as an original reference for many operations. A 3D 

profile may be defined by an open or closed contour. A closed 

contour defines a fixed area on the surface that can be used 

as a base for various operations creating solid bodies. An 

open profile can be used as a base for creating sheet bodies 

only as it consists of wire geometry. 

There are many ways of creating a 3D profile. Thus, it can be 

drawn on a workplane, or get anew by a variety of 

modifications to an existing profile, and so on. One 3D profile 

may contain several contours of the same type. An example 

of a multi-contour profile is a text entity. A 3D profile can be 

obtained from hatches and graphic lines (when drawn on the 

active workplane). 

 

 

Local Coordinate System is an entity for referencing three-

dimensional objects in space. It is used for inserting 3D 

fragments and other elements, copying, exploding of 

assemblies, etc. This entity is defined by the origin point and 

the axis directions. Objects snap to a coordinate system by 

making the object and the target coordinate systems 

coincide.  

3D connector – is a special type of local coordinate systems 

which allows a user, apart from performing the functions of 

snapping, to automatically tie external variables for jointed 

parametric elements of the 3D assembly models. This 

significantly simplifies positioning of parts and parameters 

assignment when designing the assemblies. 

 

3D Path is a bounded three-dimensional curve with a defined 

traversal direction. The 3D paths are used in the operations 

“Sweep”, “Pipe”, “Loft”. A 3D path can be defined by a hatch, 

2D paths, as a chain of a body edges, as a curve passing 

through a sequence of 3D nodes, by modifying existing 3D 

paths, etc. A 3D path can be closed. 

 

Pipe Path is a 3D path consisting of straight line segments 

smoothly connected by arcs. This command is mainly used for 

modeling pipes. A large variety of options and controls 

provided by this command help quickly and easily solving this 

sort of tasks. 
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3D Section is an entity that, generally, results from extruding 

a planar curve or polyline through all geometry in the 

direction normal to the plane of the curve. In some cases, a 

3D section consists of one or several planes. In this case, it can 

be used for creating two-dimensional cuts.  A 3D section may 

be included in visualization of the objects of a 3D scene, and 

can be used in “cut” operations. 

 

Construction array is a special composite construction 

element. A construction array is a particularly organized set of 

copies of an arbitrary construction element, except for 

sections, light sources and cameras. The copies contributing 

to such an array can be used as conventional construction 

elements. 

Construction arrays are created and edited using any of the 

3D array creation operations. 

 

Basic Three-Dimensional Operations 
 

Extrusion yields a body formed by straight propagation of a 

contour along a specified direction. This operation creates 

both solid and sheet bodies. Extrusion can be performed 

along not only the extrusion vector, but the normal to the 

contour in either or both directions as well.  Thus, it provides 

a means of thickening an arbitrary face, even a non-planar 

one. 

 

 

Rotation yields a body formed by revolving a contour around 

an axis located in space for a given angle. The original contour 

can be located in an arbitrary orientation with respect to the 

axis, but it should not intersect with the axis. This operation 

creates both solid and sheet bodies. 
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Boolean operation is intended for creating a new body by 

combining two existing bodies. The type of the operation is 

specified as addition, subtraction, or intersection. 

 

Blend Edge is an operation that modifies an existing body by 

smoothing or merging its vertices, edges and faces. The main 

difference of this operation from other types of blending is in 

that the new surface is created from the selected edge and 

merges with the adjacent faces only. The operation permits 

creating chamfers, edge rounding with a variable radius and 

elliptic rounding. 
 

Blend Face-Face is an operation for creating smooth 

transitions from one set of smoothly connected faces to 

another. The sets of faces to be blended may not have 

common edges (intersect). The command has numerous 

options for controlling the blending surface shape, trimming 

conditions, bounds, etc. 

This operation should not be considered a substitute for 

blending edges. Each of the two approaches has their own 

advantages and well complement each other.  

 

Blend Three Faces is a special case of face–face blending 

separated into another command. The operation creates a 

transitional surface between a “right” and a “left” wall while 

tangent to a “middle” wall. 
 

Loft is an operation for creating new bodies of complex 

geometrical shapes. The resulting spline surfaces are 

constructed on the wire guides in one or two directions and 

according to the specified boundary conditions. The base 

elements for spline definition can be practically any entities 

of the three geometrical types, “point”, “wire” and “sheet”. 

Depending on the base element type, the result will be either 

a solid body or a set of surfaces.  
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Sweep is an operation that creates bodies whose surface is 

defined by an arbitrary-shape profile propagated along a 

space curve. The operation provides controls over scaling of 

the profile and its twisting with respect to the trajectory axis 

as it moves along. 
 

Parametric Sweep  this operation extends the capabilities of 

the “Sweep” operation. The base profile is defined in such a 

way that its geometry and orientation are driven by a variable. 

The driving variable can assume values within the specified 

range. The body is created as a result of re-computing the 

geometric shape and orientation of the profile across the 

whole range of the variable values. 

 

Spiral is an operation for creating spiral-like bodies. The 

generatrix contour can be defined by an arbitrary-shape 

profile. This operation may be used for modeling actual 

geometry of a thread. However, in most cases, when only 

cosmetic representation of a thread is needed, the “Thread” 

operation is recommended for use instead.  

     

Spring is a specialized operation for creating spring-shape 

bodies. It differs from the “Spiral” operation in the capability 

of forming the end cycles of the spring. The generatrix of a 

spring is defined as a circle. 
 

Cut is an operation that divides a body in two, or cuts a 

portion off a body. The cutting surface can be defined as a set 

of connected faces, or sections, or workplanes. 

 

Shell is an operation that removes the inside material of a part 

by removing the selected faces and leaving the rest of the 

faces just thickened by the specified width in the direction 

where the material used to be, removing all the rest of the 

material. A shell can also be created without removing any 

faces. Another special functionality allows creating new 

bodies offset from a given one. 
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Face taper is an operation that tilts selected faces at the 

specified angle while automatically adjusting other affected 

faces. 

 

Body taper is an operation that creates 3D bodies by tapering 

faces of a selected body at a specified angle with respect to 

selected edges of that body in the taper direction. This 

operation significantly simplifies the design of cast molds. 

Unlike “Face Taper” command, this operation allows creating 

two-sided tapers and tapered body faces without having a 

clearly defined “fixed” edge. 
 

Pipe operation makes a pipe along a space trajectory (a 3D 

path). The user specifies the diameter of the pipe and the 

diameter of the outlet. The outlet itself is optional. 

 

Thread is an operation for creating cosmetic representation 

(imitation) of threads on cylindrical and conical faces of a 3D 

model. When the projections of the model are created on a 

drawing, the thread is automatically drawn according to 

drawing conventions 

 

Hole is an operation for creating standard apertures. It relies 

on a provided parametric library of holes satisfying current 

standards. The command supports creation of patterns of 

holes, holes through multiple bodies, and threaded holes. 

When a threaded hole is created on a face, a cosmetic thread 

is displayed. 
 

Rib – operation that allows us to create ribs of the solid 

body on the basis of one or several 3D profiles. Execution of 

this operation results in a solid body obtained via a Boolean 

operation of a union of the rib being created with the source 

body. 
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Sheet Metal Operations 

The specialized sheet metal operations make a separate group.  

Create Part operation creates a solid body – a flat part. The 

base element for the operation is a flat closed 3D profile. 

The body is created by thickening the profile by a specified 

amount. The part material will be added along the normal 

direction to the profile at either or both sides of the profile.  

Bend operation supports three types of bending, “Bend”, 

“Attach Flange”, “Cut and Bend”.  

 

 The first type is for bending an existing body, such as a 

part, around an infinite axis defined by a pair of 3D nodes 

or a straight-line entity. 

 

 The second type supports attaching a flange to the part 

according to specified length, width, bending radius and 

the offsets from the ends of the bending axis.  

 

 

 

The third type is for bending a portion of the part around 

a finite line segment. This is done by making appropriate 

cuts in the original body. The operation allows introducing 

reliefs defined by their type, depth and width. 

 

Unbend operation can be used after a sheet metal model 

has been defined, to get the flat part and proceed, for 

instance, with its drawing. 

Re-bend operation repeats bending of all surfaces that 

were previously “unbent”. It provides a means of keeping 

the final bent shape with the model data. This is important, 

for instance, when creating a drawing with both the flat 

part views and a final bent shape view. 

 

Convert Solid to Sheet Metal. Command is used for quick 

creation of sheet metal bodies or unfoldings from the solid 

bodies. 
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Forming Feature operation is specifically provided for 

performing common sheet metal stamping manipulations. 

It uses a library of typical elements for creating ribs, beads, 

flanges, embossings, louvers, etc. The geometry of these 

features is defined by 3D profiles. 

 

Face Handling Operations 

The set of commands for direct handling of body faces are united into a separate group. 

Sew is an operation for creating solid bodies or sheet models 

from a set of disjoint surfaces adjacent to each other, as faces, 

3D profiles, sheet bodies. When sewing into a solid body, the 

operation may add simple surfaces as necessary. 
 

Imprint Elements is an operation that forms patches of a 

specified shape on already existing faces. Depending on the 

dividing option, the shape of the new patch is determined 

either by the shape of the dividing element or by the 

geometry of the element being divided. 
 

Delete Faces is an operation that allows deleting one or 

several selected faces. Deleting faces breaks the solid body 

topology. Gaps are introduced that invalidate the closed 

volume. If necessary, the system may attend to mend those 

by various means. 

  

Separate Faces is the command for excluding selected faces 

from an already existing body and using those for creating a 

new body. The gaps in bodies caused by this process can be 

closed by one of several means. 
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Replace Faces is the command for substituting a geometrical 

surface underlying the selected faces by different surfaces. 

Sheet bodies can be used as a replacement surface. 

 

Change Faces is the command for modifying face parameters 

when the underlying surface is analytical (a cylinder, cone, 

sphere or torus), as well as parameters of faces created by the 

blend operation. 
 

Transform Faces is the command that applies a 

transformation to one or multiple selected faces. 

 

Expand Faces is the command for expanding the selected 

face (or multiple faces belonging to a sheet body) in the 

specified direction by the given length. The direction of 

growing the face is defined by selecting side edges on the 

faces being expanded. 3D profiles can also be expanded.  

Fill Hole is the command for creating one or multiple faces 

closing an area bounded by a closed loop of edges. 

Depending on the initial geometry, the system may fill the 

area by an analytical or a ruled surface, or by an explicitly 

specified sheet body. 
 

Copy and Insert Operations for 3D Elements 

Insert 3D Fragment is an operation for using the geometrical data of a standalone 3D model in creating 

an assembly model. Any T-FLEX CAD document containing a 3D model can be used as a 3D fragment. 
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Insert 3D Picture is similar to inserting a 3D fragment, except that the 3D picture has neither associativity 

among elements nor parametric modification capabilities. It is merely a shaded 3D image of a part that 

appears exactly as a 3D fragment. 3D pictures are handy at a final stage of design when the element 

modifications are no longer expected. Since 3D pictures are not subject to regeneration, the overall model 

regeneration time is reduced. 3D pictures cannot be used as references for other elements. Thus, faces of 

such objects can’t be selected, and projections cannot be constructed. 
 

Copy is an operation for creating a transformed copy of a 

body defined by various transformation parameters. Copy 

operation utilizes a “local coordinate system” entity. 

 

Symmetry is an operation for creating new bodies as copies 

of the original of bodies by reflection at a specified symmetry 

plane.  

 

Divide is an operation for separating numerous bodies 

obtained from various operations. The resulting bodies can 

further be processed separately. For instance, the bodies 

created by an “Array” operation, will be separated into 

standalone elements. This command can also be used with 

an imported from other systems model that consists from 

several bodies.  

External Model is an operation for importing models created 

in other systems based on Parasolid format (*.x_t and 

*.xmt_txt). Just like 3D pictures, these objects do not possess 

parametric properties, however, their elements (vertices, 

edges, and faces) can be used as references for further 

design.  
 

Operations for Creating 3D Arrays 

The array creating operations allow simultaneously creating multiple copies of source 3D objects. The 

source objects for creating arrays (objects for copying) can be not only operations and Bodies, but also 3D 

construction elements and faces.  

Placement of the copies being created (the array elements) depends on the array type: linear, circular, array 

by points, array by path, parametric array. 
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Linear array is the one in which the copies of the source 

objects are placed along one or two direction vectors at a 

specified step. The copies can be placed not only in the 

forward, but also in the reverse direction along each direction 

vector.  
 

Array by points is the one in which the positions of the 

arrayed copies are defined by 3D points. 

 

Circular array is the one in which the copies are placed on a 

circle around the array axis. Reverse rotation is also possible, 

including creation of copies simultaneously in two rotation 

directions. It is also possible to create copies in a second 

direction - either along the array axis or in the radial direction.  

Array by path is the one in which copies are placed along one 

or two spatial curves. One can set different ways of orienting 

copies on each guide curve – by the cord, by the minimal 

twist, by parallel translation. 

 

Parametric array is the one in which the spatial positioning 

and parameters of copies are defined by a specified 

parametric law. 

 

Depending on the type of the copied objects, distinguished are the following array types: arrays of 

construction elements, arrays of operations, arrays of Bodies and arrays of faces. All arrays of one element 

type, regardless of their properties, share the specifics of creating and editing. 

Array of construction elements makes copies of any 3D 

construction objects, except for sections, light sources and 

cameras. It results in a special 3D construction element – a 

construction array. 
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Array of operations copies only the result of the selected 

operation. If the body created by the operation is later 

transformed by another modifying operation, the array is not 

affected.  

 

Array of Bodies copies a whole Body. If that Body is modified 

in the future, the array will regenerate, accounting for the 

new operations added in the Body’s history. 

 

 

Array of faces is used for adding holes and protrusions 

repeating existing design elements, to Bodies already 

existing in the 3D model. Any array of faces is always based 

on one model Body: all copied faces must belong to this 

Body.  

     

Deformation Operations 

The operations of deformation allow a user to carry out modification of solid and sheet bodies by various 

means. When applying these operations on the basis of parameters specified by a user, an internal function 

producing the volume deformation of the deformed body is generated in the model. Applying this function 

in a continuous manner deforms the entire volume of this body (or its part). Topology of the deformed 

part of the body is not changed. The number of faces, edges, and vertices, etc. is preserved. If necessary, 

the faces and edges of analytical type (planes, segments, cylinders, arcs of circles, etc.) are automatically 

replaced with spline surfaces and curves. 

Skew – this type of deformation assumes existence of the 

original body and the coordinate system in which a bounding 

parallelepiped is calculated. Deformation law is specified by 

displacing the vertices of this parallelepiped in different 

directions.  

The displacement can be realized along any of the axes of the 

coordinate system, along the edges of the bounding 

parallelepiped, and along the diagonals of the faces of the 

bounding parallelepiped. 
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Sculpt deformation – in this type of deformation a regular 

mesh of points is defined on one of the faces of bounding 

parallelepiped. Any point on this mesh can be displaced 

relative to its initial position by a specified value. As a result, a 

flat face of virtual bounding parallelepiped is transformed into 

a space spline surface which forms the required 

transformation law for the body. 

The operation of sculpt deformation has 3 modes: 

 One side – only the points located on one face of the 

parallelepiped are displaced; 

 Both sides – the points located on opposite faces of the 

parallelepiped are displaced. The points on the face 

opposite to the selected one are displaced in the same 

direction by the same distance; 

 Symmetric – points on the opposite face are displaced 

symmetrically with respect to symmetry plane of the 

parallelepiped. 

 

 

 

 

Scale/Twist – this operation allows a user to specify various 

scales and angles of twist in different sections along the axis 

of the selected coordinate system. This deformation can be 

carried out either for the entire body or within the borders of 

the user-defined region. 

In addition to scaling and twisting sections, it is possible to 

entirely stretch or compress the deformation region in the 

direction of the selected axis of the deformation. For sections, 

the scales along different axes can be different. 
 

Bend – this operation allows a user to bend the selected body 

by a specified angle with respect to the selected axis. In 

addition to bending angle, the distance defining the location 

of the «neutral» surface is specified.  
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Deformation by curve – for the deformation by curve, the 

overlap of the source curve, associated with the deformed 

body, with the target curve takes place. The deformation 

function constructed as a result of this is applied to the 

deformed body. A user can control the location of the body 

with respect to the curve. Upon deformation, one of the three 

body orientation control algorithms and the ways of using the 

source curves can be chosen. 

3D curve – 3D curve. This method uses one source and one 

target curve. In most of the cases in practice, the source curve 

is a line. As an example, consider one of the typical problems 

solved by the present algorithm – wrapping the source body 

into a ring. 

 Curve – Spiral. The spiral-like curve is chosen to be a target 

one and the axis of the spiral is specified. 

 Pair of curves – Pair of curves. The source pair of curves and 

the target pair of curves are specified. Additional curves 

perform the function of controlling the twist of the body with 

respect to the main curve. 

      

 

    

 

      

Deformation by surface – this type of deformation forms the 

transformation law of certain single surface into another 

surface and applies this law to the source body. As the initial 

data from the source and target sides, the surfaces and the 

three points on each surface are chosen for the subsequent 

overlap. An additional displacement of the resulting surface 

from the source surface can be also specified. 

This transformation works in two modes – «By parameters» 

and «With minimal distortion». In the former case, the exact 

overlap of the parametric surface spaces by the selected 

points is carried out. In the latter case, the proportions of the 

geometric distances measured between certain points on the 

source surface are preserved. 

 

 

Commands to Create Welds 

A group of commands in the Tools > Weld menu is provided to design welded parts. Those serve to create 

various types of standard and nonstandard welds on a 2D drawing or in the 3D model. Once a weld is 

created, its symbol can be automatically applied, and tables of welds can be built. 

There are the following 3D weld types: fillet, intermittent fillet, butt, composite. Fillet, intermittent fillet, and 

butt 3D welds are denoted in the 3D scene with a special “cosmetic” body with a characteristic texture. 
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Fillet 3D weld Intermittent fillet 3D weld Butt 3D weld 

The composite weld is a variation of the 3D weld. It can be used to designate some 3D model elements 

(bodies, edges, 3D profiles, 3D paths, or a combination of several existing 3D welds) as a 3D weld. In this 

case, no image of the weld will be created in the 3D scene. 

Geometry Analysis Commands 

Measure is a command for defining mutual situation of objects on the 3D scene, whether one body 

penetrates another one, what is the minimum distance between elements. Besides that, various geometric 

characteristics can be computed for selected elements, such as length of an edge, area of a face, 

coordinates of nodes, etc. One can introduce variables that will be gaining specified characteristics from 

the elements of interest, using special functions. Thus, these characteristic values can be used as input for 

further construction.  

Mass-Inertia Properties is the command for calculating the mass-inertia properties of the selected 

operations. If necessary, the calculations can be done with respect to a specific coordinate system. 

Model check is the command for diagnosing the selected body for errors in its geometry. 

Intersection Check is the command for examining the model 

against intersections and contacts between selected bodies. 

The command is particularly helpful when working with 

assemblies. 

 

Curve curvature is the command for measuring the curvature 

and the radius of curvature on selected curves. The curvature 

is displayed in the form of the porcupine quill. To measure 

curvature, you can select edges and 3D paths.  
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Surface curvature is the command for measuring curvature 

and the radius of curvature of one or multiple selected faces. 

You can watch the overall curvature distribution on the face 

(the model is colored appropriately for this purpose), or read 

the curvature value at a specific point. 

 

Surface deviation is the command for defining the selected 

face’s normal deviation from the specified direction. The 

colored face display allows watching the deviation all over 

the face. You can also measure the deviation at a specific 

point. 

 

Surface gap is the command for evaluating the gap between 

two or multiple selected faces. The command is used for 

analyzing models suffering import/export deficiencies. 

 

Normal deviation is the command for measuring deviation 

between the normals of the neighboring faces evaluated on 

the specified edges. The quills displayed in the 3D window 

help watching normal deviation across the overall edge 

extend. Besides that, the angle of the normal deviation can 

be measured at a specific point. 

 

Surface smoothness is the command for evaluating the 

model regularity. On entering the command, a special 

pattern is applied to the body's faces, usually made by long 

light and dark stripes. This pattern helps usually determine 

whether the adjoining faces make a smooth tangency 

transition, or smooth curvature transition. 
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Model Separation Check is the command for identifying 

faces of the areas preventing a die cast or injection mold from 

opening. Additionally, the faces are highlighted, whose slant 

angle with respect to the selected direction is less than 

specified. 

 

Engineering Analysis 

Besides the geometry analysis commands described in the previous paragraph, the T-FLEX CAD complex 

provides additional modules serving to conduct advanced model analysis: Finite Element Analysis and 

Dynamic Motion. 

Finite Element Analysis – this is a “T-FLEX Analysis” module that serves to perform various types of finite 

element calculations: 

 Static analysis allows calculating the state of stresses and strains in a structure under the 

impact of constant in time forces applied to the model; 

 Frequency analysis allows calculating natural (resonant) frequencies of a structure and the 

respective vibration modes; 

 Buckling analysis is important when designing structures, whose operation implies lasting 

influence of loads ranging in intensity; 

 Thermal analysis is the module providing the capability of evaluating a heated product 

behavior under the impact of sources of heat and radiation. 

T-FLEX Analysis is oriented at solving physical problems in the three-dimensional formulation. All 

calculations rely on the finite element method (FEM). The product's mathematical approximation uses its 

equivalent replacement by a mesh of tetrahedral elements. At the same time, an associative relationship is 

maintained between the three-dimensional model of a part and the finite element model used in the 

calculations. Parametric modifications of the original solid model are automatically propagated into the 

meshed finite element model. 

   
Results of finite element modeling (displacements and stresses) 
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The standard T-FLEX CAD distribution kit includes only a limited trial version of the finite element analysis 

module – Express Analysis. The Express Analysis is a light version of the “T-FLEX Analysis” module, 

specifically tuned for running simplified yet qualitatively sound strength studies. The user is provided with 

the necessary selection of load and restrained types. Based on the T-FLEX CAD model geometry, the 

automatic mesh generator creates a quality finite element discretization within the Express Analysis. Once 

the calculations are completed, the stress, strain, displacement and strength safety factor are output in a 

graphic form. 

The fully functional “T-FLEX Analysis” finite element analysis module is sold separately. 

For details on working with the finite element analysis module, please refer to the “T-FLEX Analysis” 

manual. 

Dynamic Motion – this is the module that serves to run studies on dynamic behavior of various three-

dimensional mechanical systems.  

The dynamical analysis module is capable of solving the following studies: 

 Analysis of the motion trajectory, velocity and acceleration of any point of a component in a 

mechanical system due to applied forces; 

 Analysis of performance times of a mechanical system (the time to the target point, the 

time for vibrations to settle, etc.); 

 Analysis of forces building up in components of a mechanical system during motion 

(reaction forces at the supports, joints, etc.). 
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A mechanism's model is defined as a system of solid bodies, joints, and loads. The data for the analysis is 

automatically accessed directly from the geometrical model created in the T-FLEX CAD system. The familiar 

tools of T-FLEX CAD are used in modeling, with mates and degrees of freedom employed to define 

relations between three-dimensional bodies. The system also provides the means of modeling the contact 

between arbitrary solid bodies, being capable of processing a simultaneous contact of hundreds and 

thousands of solid bodies of arbitrary shape. 

Loads on solid bodies are defined as the initial linear and angular velocities, forces, moments, springs, 

gravity, etc. To read the results, special sampling elements are used. Numerous values are available for the 

analysis: coordinates, velocities, accelerations, reaction forces in joints, forces in springs, etc. The user can 

observe the model behavior from any viewpoint immediately during the actual calculation. One can create 

animation clips from the obtained results of a dynamic calculation. 

The T-FLEX CAD standard distribution kit includes only a limited trial version of the dynamic motion module 

– the Express Dynamic Motion Analysis. The Express Analysis has certain limitations on load types and the 

ways of rendering dynamic motion analysis results (the tools to obtain numerical calculation results are 

not available). In the commercial module, the calculation results are displayed as graphs, dynamic vector 

arrows and as an array of numbers (graph points). 

The fully functional “Dynamic Motion” analysis module can be purchased separately whenever needed. 

More details on working with the “Dynamic Motion” module are provided in the “T-FLEX Dynamic 

Analysis” manual. 

Auxiliary Elements and Operations 

Material is a system element assigned as a parameter to each created body. Material helps rendering 

computer models so that they look like real objects. It contains a list of characteristics of the real material 

used in actual production. Material has the following parameters: density, luminosity, ambience, etc. The 

whole body material can be assigned within parameters of any operation.  

Apply Material is an operation that assigns a material to specific faces of a body.  

Transformation is a command for defining translation and rotation of an object that change its location 

and orientation on the 3D scene. This command works with all operations and most 3D construction 

entities.  

Photorealistic Imaging is a command for creating a file in BMP format containing a photorealistic image 

of the objects on the 3D scene. This is done with POV-RAY application that is shipped together with T-

FLEX CAD. Photorealistic images are also used for creating animated clips.  
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2D Projection 

2D Projection projects all bodies of three-dimensional scene or selected bodies or specified elements on 

a plane. The resulting image is displayed in 2D window. Projection creation accounts for sections for 

instance when creating cuts. This approach helps avoiding additional constructions in 2D window. Simply 

create a three-dimensional body, and all necessary views in 2D window will be obtained by projection. 

Further, 2D projections can be used for laying out drawings.  

     

3D Annotation 

T-FLEX CAD allows creating drawing annotation (dimensions, leader notes, roughness symbols) directly on 

faces, edges and vertices of a 3D model. 

The capability of creating 3D annotation allows introducing in a 3D model not only geometrical, but also 

technological process and other information that can later be used when creating drawings by 2D 

projections, as well as in other applications, for example, in the process design modules or when creating 

CNC control sequences. 
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3D Object Rendering  

View is a combination of 3D window parameters, such as view point, distance to object, visualization 

parameters, the type of projection, etc. Particular sets of these settings can be saved in order to quickly set 

up 3D scene in required configuration later.  

Rendering type is a way of rendering 3D bodies in the 3D window.  

First type is Wireframe model. This way is convenient in that the front elements do not obstruct the ones 

behind, and the objects inside the body can be seen as well.  

Second type is Shading. The faces of the bodies are displayed in a specified color. 

Third type is Shading with Material. The faces display accounts for the material specified for the whole 

body, as well as applied to particular faces. 

Fourth type is wireframe with Hidden line removal. A fast algorithm is used for determining line visibility. 

Fifth type is wireframe with Precise hidden line removal. The wireframe is displayed with invisible lines 

removed per the current orientation. 

     

Projection method defines the way objects are represented on the 3D scene. It may be parallel projection 

without perspective that does not account for the distance from eye to object and the perspective angle, 

or projection with perspective that does account for the above parameters.  
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Clip plane is a plane situated parallel to the screen when originally defined. It can move back and forth 

along the fixed direction and clip out the option of the objects on the scene before the plane (to move 

use: +Ctrl+Shift). It is used for visual analysis of inner elements of the bodies, and for selecting objects 

on the 3D scene located inside the bodies.  

                   

Light Source is an element for controlling the illumination of the 3D scene. Originally, there is a single light 

source coinciding with the viewing point. A light source can be a Spot Light, a Direction Light, and a 

Projector. The user can create additional lights as needed, vary their intensity and direction, turn on or turn 

off any of them. Light source is used for creating a photorealistic image. 

     

Camera is an element that defines the viewing point and direction on the 3D scene. Each 3D window has 

one default camera. One can create additional cameras, select an active camera. The newly created cameras 

can be moved using special cursor or bounded to a local coordinate system. The viewing direction of a 

camera can also be changed. This helps surveying inner elements of the scene and create animated clips. 
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Three-Dimensional Model Animation  

Animation of a three-dimensional model is done by the same means as drawing animation, that is the 

variable-driven model modification. The user assigns the range and the step for the variable modification. 

Since the real-time regeneration of a three-dimensional model driven by a variable modification may be 

slow, the animation may not look well in interactive session. This is why a good strategy is to create a 

multimedia file in *.AVI format (a video clip) for watching the modification animated.  

A video clip may be created using photorealistic imaging. In this case, each frame of the clip will be 

processed by the POV-RAY application.  

APPROACHING SOLID MODELING WITH T-FLEX  CAD  

General Recommendations before You Begin with 3D Model Creation 

Analyze the design intent before starting 3D model creation. The degree of design automation depends 

on how well the engineer thought through of the model layout. Parametric design requires additional time 

investment at the initial stage as compared to non-parametric approaches. However, this brings an 

unmatched advantage at the later stages, as, for instance, in preparing documentation for various 

modifications of a product. 

Due to high flexibility of the system, the same result can be achieved by different means. One of the 

foremost goals of the designer is to find an optimum solution. Naturally, this depends on how well 

the designer manages to operate the instruments provided by T-FLEX CAD system. 

First, decide what operations you will use for creating the elements of a part. Important is what kind of 

references and interdependencies will be imposed on various elements. Define the appropriate boundary 

conditions. Determine what model parameters should be represented by variables. Divide a complex 

assembly into a set of fragments, 3D pictures, copies, and library elements. Begin with a model creation 

after realizing a rough plan of the design layout. 
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Parameterization and Model Regeneration 

A T-FLEX CAD model is constructed as follows. First, create a new Body using 3D operations based on 

construction and other auxiliary 3D elements. Next, a base body is used to create other Bodies, which, in 

turn, undergo modifications and alterations, become subject to certain dependencies, boundary 

conditions, and so on. Each construction element or operation is recorded in the model history. It is 

possible to identify parent-child relations between certain elements. The model hierarchy is represented 

by a tree structure. 

                  

Now, suppose, some parameter of a parent element operation needs to be modified that would affect its 

geometrical configuration. This would cause the children to adjust their locations according to the parent 

geometry and the model parametric dependencies. T-FLEX CAD is capable of handling such issues due to 

its architecture that supports through-model parameterization.  

The word “parameterization” implies a wide range of capabilities. It is possible to modify virtually any 

parameter of any operation at any time. Besides, parameters are not limited to numerical or textual values, 

as they also can be represented by variables. The variables can be driven by certain expressions, and be 

dependent on other parameters and variables. 
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Again, suppose, we changed a parameter of a parent element. Next, the model regeneration is launched 

manually or automatically, traversing the model structure and recalculating the model with the updated 

variable values. 

       

T-FLEX CAD supports full and partial regeneration. Full regeneration is necessary for updating the whole 

drawing and the model. This causes recalculation of all objects from scratch. Partial regeneration saves 

time. The system automatically analyzes what objects were modified since the last regeneration, and 

recalculates these objects and their children only. 

To update a model use a selective regeneration command, 

Icon Ribbon 

 

Parameters → Tools → Regenerate 

Keyboard Textual Menu 

<Alt><F7> or 

<3G> 
Tools > Regenerate 

 

The full regeneration is invoked by the following command, 

Icon Ribbon 

 

Parameters → Tools → Full Regeneration 

Keyboard Textual Menu 

<3RG> Tools > Full Regeneration 

 

The three-dimensional model is fully regenerated after calling the command. This command regenerates 

each element, unlike the Regenerate command, which regenerates only changed and dependent elements. 

The image in 3D view window is automatically updated after the regeneration. 

The following window appears after calling the command: 
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If the flag Regenerate drawing 2D projections is set, only changed 3D elements (optimal regeneration)  

and all projections will be regenerated. 

If the flag Regenerate other 3D elements is set, all 3D objects are regenerated.  

If you set both flags, the full regeneration is performed. If both flags are not set, the optimal 

regeneration is performed. 

The flag Update links allows to update files used in the current document (fragments, images, data bases). 

You can set to update Changed only links or All links. The command UL: Update links is indirectly 

performed in this case.  

The flag Update product structures allows to update all product structures created in the document.  

The flag Update reports/bills of materials updates all reports and bills of materials created in the 

document. 

When you set Don’t ask this question again this window will not appear next time after calling the 

command. 

Three-Dimensional Model Creation Techniques  

T-FLEX CAD supports various techniques of 3D model creation. The mainstream design principle implies 

direct approach to a 3D model creation “from scratch to workplane to sketch to model”. Another approach 

implies use of pre-designed 2D drawings or auxiliary 2D construction. This technique can be called “from 

2D to 3D model”.  

Whichever technique is used in a 3D model creation, the same operations form the body geometry. The 

difference is in the ways of creating the 3D construction entities.  

The Mainstream Approach 

Charted below is the mainstream design approach workflow. 
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Begin a document creation by selecting an appropriate prototype of a 3D model (3D model.GRB). Use 

the command F3: Create New 3D Model. This brings up a 3D window with a standard set of workplanes. 

Now all is set for starting with a 3D model.  

The mainstream 3D modeling approach does not require the 2D window. All auxiliary elements, 

including profiles, nodes, 3D paths, etc., can be constructed directly in the 3D window using the 

same 2D drawing tools. 

Normally, an operation requires a certain set of auxiliary 3D construction entities to be completed. To 

create a 3D profile, first select a workplane or a flat face as a base, then all 2D drawing commands become 

accessible. Just like in 2D, one can draw on the active workplane new lines, contours, etc. Parametric 

dependencies can be automatically introduced into the model at this early stage. A 3D operation, such as, 

say, an extrusion, can be invoked without leaving the drawing mode. The system would automatically 

create a 3D profile based on the just created graphic lines. This minimizes the number of user actions 

required for completing an operation. Consider, for instance, the “Rotation” operation. The required axis 

(a dashed line) and the contour can be created on the fly directly on the workplane. Preview is always 

available to evaluate the result of an operation. Preview activates automatically for the operations that do 

not require extended time for computations.  In other operations, it is invoked by a special command. 

The bodies created at an early design stage may later be used in other operations, such as in Booleans, 

blends, tapers, etc. 

Creating a new file with a set
of standard workplanes

Creating 3D construction entities

Creating the part model
based on 3D operations

Making drawings from
the 3D model
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The completed 3D model can be used for generating drawings, if desired. Create required projections, 

sections and cuts that can be used as references for the necessary elements of the drawing layout, 

dimensions, etc. 

“From 2D to 3D” Technique 

The following chart illustrates a design technique “From 2D to 3D”. 

 

Often, a 2D drawing of a part may already be available before beginning with the 3D model creation. The 

proposed approach to model creation is preferable in such a case. At the initial stage, it is good to have a 

2D drawing of the part that contains all necessary views. The part views are better be laid out in accordance 

with the projection rules, although this is not a strict requirement. Certain parametric relationships of the 

pursued parametric 3D model can be introduced at the 2D drawing stage. The first step in 3D model design 

is creation of workplanes. Often, two or three orthogonal workplane are sufficient that represent the front 

view (the front plane), the top view (the horizontal plane), and the view from left (the side plane). 

Next, the necessary 3D construction entities are introduced, such as 3D nodes and 3D profiles. 3D nodes 

are used as references for 3D profiles, vectors of extrusion direction, rotation axes, etc. In case a workplane 

can’t be activated, the required profile can be defined based on a 2D hatch. The hatch must reference an 

actual drawing. 

 

Besides the profiles, 2D views can be used for constructing 3D nodes from the 2D nodes, and 3D paths 

from the 2D paths and other construction entities. 

 

Creating or retrieving a
2D drawing

Creating Workplanes per the drawing
views

Creating 3D Construction
Entities using projective

relationships

Creating the 3D model
using the 3D

Construction Entities.
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It is thinkable of combining the two techniques described above. Note that three-dimensional 

modeling is a creative process that does not necessarily implies a sole way towards a particular 

solution. The user is provided the necessary set of tools, while it is up to him to make a choice of a 

most effective approach to realizing the design intent. 

Creating Assemblies 

Any T-FLEX CAD document that contains a three-dimensional model can be inserted into another 3D 

model as a fragment. Thus composed model is called assembly. External models, imported from other 

systems in an appropriate format, can also be used in assemblies.  

 

The component architecture of T-FLEX CAD assemblies has certain advantages. Thus, one can create 

libraries of parametric elements, to use them later in assembly creation.  

 

An assembly document keeps the references to the fragment files. Once a fragment file is modified, it 

automatically becomes updated, causing modification of the respective assembly component. Any 

fragment may have external variables that drive the parametric relationships of the part. At any time, one 

can either modify the original part file of the fragment, or specify different values of the external parameters 

of the fragment. In the latter case, the part file is unchanged, while the assembly component – the fragment 

– is recalculated per the new external parameter values. A special functionality helps keeping various sets 

of the assembly parameter values thus facilitating quick loading of a desired variation.  

 

Each fragment file provides storage for BOM data. If this data is entered in each fragment file then the 

assembly BOM can be output automatically. 

 

The assembly model can be used for creating drawings by creating the necessary views, cuts, sections and 

applying dimensions and other layout elements. 
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“Top-down” Assembly Modeling 

There is an alternative approach to assembly creation, as opposed to the typical one briefly described 

above. T-FLEX CAD supports new part creation based on any geometrical and topological elements of the 

parent assembly. In this way, it is no longer necessary to specify placement conditions and the part mutual 

configuration. A part is automatically placed according to the references to elements used in the part 

definition. The parametric relationships among the assembly elements are saved with the model. Once a 

dimension or a part placement is modified, all related elements of the assembly will automatically adjust.  

When working with a part in assembly mode, all elements that are not referenced by the part are shown 

transparent. Snapping works with all assembly elements. Any assembly element may be referenced at any 

moment. 

The part is saved in a separate file. The file may be opened apart from the assembly and worked on 

separately. The assembly references are meanwhile preserved. 

Any T-FLEX CAD document can be
used as a Fragment Part

Creating the assembly drawing
based on the assembly model

Automatic BOM generation
per the specified standards

Assembly creation involves
Fragments, 3D Pictures and

additional 3D Construction Entities

Additional 3D Constructions can
be introduced during assembly

creation

Fragments can
be assigned

transformations defining
the exploded view
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3D Model Rollback Mode 

If you need to make a correction to an already created model, you can use the 3D model rollback mode at 

a certain operation level. This function is helpful in the cases when you need to do additional work in the 

middle of the model tree.  

In the rollback mode, the 3D model returns to an earlier stage of its creation. Elements and operations that 

follow after the rollback point in the model's history become hidden in the rollback mode and are 

inaccessible for selection. In this state, those are marked with semitransparent icons.  

All elements and operations created in the rollback mode are automatically inserted in the 3D model tree 

between the operation, upto which the rollback was made, with the successive operations unloaded from 

the scene. It is possible to do a series of rollbacks.  

Upon finishing the rollback mode, the system automatically rebuilds internal model relations to restore the 

later operations. If for some reason the introduced changes result in errors in the model, then the system 

will offer restoring the model state before the rollback. This protects the user from introducing invalid 

modifications to the model. 

The rollback mode is invoked and finished using context menu commands of an operation in the model 

tree or in the 3D view window. The rollback will be up to the level of the operation, from whose context 

menu the command was called. 

Let's review the use of a rollback on a simple example. In this model, it is necessary to add a blending on 

corner edges. 

Saving parts in their respective files
with references to the assembly

A part can be further worked
on and modified

Parts can be reused
in another assembly

After part modified all changes can
be moved to assembly

automatically

Creating parts in assembly
mode
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We perform the model rollback up to the base extrusion operation. In this case, the operation Shell_1 is 

unloaded from the scene. 

 

Then we make an edge blending (the Blend_1 operation is added in the model tree). 
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We then finish the rollback. 

 

As a result, we get the model presented at the following figure. 

 

T-FLEX  CAD  SYSTEM OPERATION T IPS  

Getting Help 

There are several ways of getting answers to the questions arising during the work process, as follows:   
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 Help on the current command can be accessed by pressing <F1> key. When no command is active, 

pressing <F1> invokes the help. 

 While within a command, limited information is provided as prompts and hints in the status bar. 

 Pop-up help appears by the icon buttons on a toolbar and by the graphic elements when the cursor is 

briefly held pointing at an element or item. The pop-ups report the command or element name, the 

type or parent operation of the element. Pop-ups messages are duplicated in the status bar at the 

bottom of the system window. 

Creating a New Document. Using Prototype Templates 

A new project begins with setting up the new document. Depending on the design intent one can select 

appropriate initial options for the new model. To begin with a 2D drawing creation or other 2D construction 

in 2D window use the command: 

Icon Ribbon 

 

Get started→ Files → Drawing 

Keyboard Textual Menu 

<FN>, 

<Ctrl><N> 
File > New > Drawing 

This will bring up the 2D window. 

When beginning directly with a 3D model creation, use the command for creating a new file, 

Icon Ribbon 

 

Get started→ Files →3D Model 

Keyboard Textual Menu 

<F3> File > New > 3D Model 

This brings up the 3D window with the standard set of workplanes. 

The following commands are used for creation of a new assembly document: 

Icon Ribbon 

 

Get started→ Files → Assembly Drawing 

Keyboard Textual Menu 

<> File > New > Assembly Drawing 
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Icon Ribbon 

 

Get started→ Files →3D Assembly 

Keyboard Textual Menu 

<> File > New > 3D Assembly 

An additional record about assembly drawing exists in the product structure of the assembly document. 

A new document is created using one of the prototype files whose names are defined via the command 

Customize > Options. These files may contain some useful elements and settings that will be created or 

set in the new document. In the case the new document settings need to be changed, edit the prototype 

file (such as, for instance, the ANSI drawing prototype file, named ANSI.GRB, or a 3D model prototype 

ANSI 3D Front Right Bottom Workplanes.GRB). These prototype files must be present in the 

folder …T-FLEX CAD\Program\Template. 

It is possible to create any number of prototype files and use them as desired. For creating a new file from 

a prototype, use the dialog “New From…” invoked by the command FP: Create New Document Based on 

Prototype (File > New from prototype). In addition to that, this dialog is available in the window “Start 

Page”. 

Each folder in the directory …T-FLEX CAD\Program\Template becomes a tab in the dialog box. All the 

prototype files that exist in a respective folder are displayed on the selected tab. Thus, the prototype files 

should be placed in the directory …T-FLEX CAD\Program\Template\<The respective folder of the prototype 

file>. 

When you create a new document, you can choose one of four prototypes.  

 

To save a file as a prototype use the menu command File > Save as Prototype. Use the appearing on 

screen dialog box to assign a name to the would-be prototype file. One can create new folders (turning 

into tabs on the dialog box) for prototype files as desired. One can also delete any prototype files and 

folders, except the folder “Common”.  

Mouse Interface. Context Menu  

Part modeling in T-FLEX CAD is performed mostly by mouse. The keyboard is only used for inputting 

numerical values, names and command accelerators (see below).  

Using left mouse button 

 Pointing cursor at an icon and pressing  launches the command represented by the icon. 

 A command can also be launched by pointing cursor at a textual menu item and pressing . 

 Pointing cursor at an object on the 3D scene and pressing  selects the object. 

 Pointing cursor at a 3D construction element or operation and double clicking   invokes the dialog 

box “Element/Operation Parameters”. 
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 Pressing and drugging  spins the 3D scene. The cursor must be within 3D window bounds. The system 

should not be in drawing mode. 

 Drag&Drop can be used for managing libraries and customizing toolbars and dialog boxes. Point the 

cursor at an element, press and hold , and drag the element to a desired location while holding the 

button. For more information, refer to the appropriate sections of documentation.  

Using right mouse button 

 While within a command, pressing  cancels the last active command.  

 Pressing  while selecting elements on the 3D scene unselects the last selected element.  

 If no command is active, pressing right button invokes the context menu. The menu is composed of 

the commands currently available for the particular element. The content of the context menu will be 

different depending on where the cursor is pointing. These could be the area of the 3D scene, a model 

element, the command area of T-FLEX CAD, such as a dialog box, a menu, or a toolbar. To launch a 

command point the cursor at the corresponding line of the context menu and press .  

 

 Context menu can also be invoked while working with dialog boxes. See the topic “Context 

menu for the dialog fields”, the chapter “Customizing Drawing” in the volume “Two-

dimensional design”. 
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The described right mouse button functions are set by default, but can be customized. To do so, 

call the command Customize > Options (Preferences tab). For more information, refer to the 

chapter “System Customization” in the volume “Two-dimensional design”.  

In “3D drawing” mode mouse manipulations are the same as in 2D window.  

Using mouse with wheel (IntelliMouse) 

 Spinning the mouse wheel zooms in and out.  

 Dragging the mouse with the wheel depressed pans the 3D scene.  

 The mouse wheel can also be used for alternative selection from a set of objects under the 

cursor. Alternative selection mode activates after two-second delay after pointing cursor at 

the object. Scrolling through the list of objects is done by spinning the wheel. 

 Spinning the wheel performs the standard functions of scrolling in the appropriate field of 

dialog boxes.  

Calling Commands from Keyboard, Using an Icon, from Textual Menu 

There are various ways of calling T-FLEX CAD commands. Firstly, a command can be selected via an icon 

on a toolbar using the mouse.  

A command can also be launched from the textual menu. All T-FLEX CAD commands are grouped in a 

certain way. Each group has an entry item in the menu.  

 

Thus, for instance, the commands that create 3D operations are grouped under the entry “Operation”. The 

drawing commands are combined under the entry “Draw”. The 2D and 3D construction commands are 

united in the “Construct” group. The file managing commands are united in the menu “File”. Other groups 

include the editing commands (“Edit”), the variable managing commands (“Parameters”), utility commands 

(“Tools”), the system and the model customization commands (“Customize”), the visualization controls 

(“View”), the window management (“Window”). The system reference and information group of commands 

is under the “Help” entry.  

Most T-FLEX CAD commands are bound to function key combinations (simultaneously pressed), or 

keyboard accelerator sequences (pressed in order). The textual menu item buttons contain keyboard 

accelerator sequences for the commands next to the command name, whenever defined. The keyboard 

accelerator can be changed for any command. For detailed description, refer to the “System Customization” 

topic of the chapter “Customizing Toolbars and Keyboard”, “Keyboard” tab, in the volume “2D design”. 

As said before, some commands can be launched by typing the keyboard accelerator sequence. 

Particularly, this is supported for 3D model and drawing creation and editing commands. The keyboard 

sequence and the command name is shown on the pop-up help and in the message field of the status bar.  
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Just like the 2D subsystem of the T-FLEX CAD, each 3D command has an additional set of options and 

subcommands accessible via the automenu – a toolbar containing subcommand icons, and function key 

combinations. The function key combinations are displayed in the pop-up help widgets. 

 

Certain commands are best accessed via the context menu. This menu is available after selecting one or 

several elements on the 3D scene, such as faces (see diagram below). The context menu contains the list 

of commands available with the selected set. 

 

You can use dynamic toolbar to call the commands. The toolbar appears upon pressing . 

The toolbar provides quick access to frequently used commands and options. 
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If you move cursor from the toolbar, it becomes 

semitransparent. If you move it too far from the toolbar, the 

toolbar disappears. 

When you press  button, the context menu appears. Here 

you can select some operations that are not included in the 

toolbar. When you select one of them, the operation will be 

added to the toolbar. Thus the toolbar consists of favorite 

commands. 

The  button of operation creation toolbar includes automenu for the current operation. When 

you select the automenu options, they are not added to the toolbar, because all operations have 

different automenu options set. 

You can change dynamic toolbar display settings on the Dynamic toolbar tab of SO: Set system 

options command. 

Confirming actions of 3D element creation 

Unlike 2D elements, a three-dimensional element creation takes several steps. Not all of these steps are 

required. To complete an element definition, use the provided option “Finish input” by clicking on the icon 

 or pressing <Y> key. This option becomes accessible only after the required minimum sequence of 

actions has been completed.  

When calling a command, make sure about the command exiting option. Some commands 

remember the current state while the others revert to the initial settings. 

Canceling and exiting a command 

Exiting a command is done by pressing <Esc> key or . Alternatively, use the  automenu icon. 

If the system has entered a 3D command without doing anything (nothing was selected), then calling 

another 3D command makes the former command quit. However, if something has been selected within 

the former command then the newly launched command does not close the former one and becomes 

nested. Once done with the nested command, the system returns into the former command. This is 

different in 3D mode from the 2D mode operation. The above does not affect the 3D drawing mode. To 

return to the command-waiting mode, close subsequently all active commands. Instant exiting from all 

nested commands is done by simultaneously pressing <Shift><Esc>. A 3D command quits automatically 

upon calling any 2D command. 

Setting up Parameters of a New Element 

The parameters can be assigned to an element being created or edited at any stage of the creation or 

editing. To specify an operation parameters use the Property window that supports transparent mode, or 

the Parameters dialog box that always requires confirmation before the input takes effect.  

The parameters dialog is necessary for specifying general properties of an element or operation, such as 

color, level, material, etc., as well as the transformation parameters. These properties are uniformly defined 
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for all construction elements and operations in T-FLEX CAD. The ways of handling these properties are 

described in details in a separate chapter of this volume. This dialog box can be used for editing operation 

properties without calling the operation editing command. This is especially helpful when the operation 

being edited is deep in the model history. Otherwise, the model rollback would be required up to the 

edited operation, consuming considerable time and system resources. Now, it is sufficient to select the 

operation of interest in the model tree and call the parameters dialog using, for instance, the context menu. 

The parameters dialog box may contain several tabs. The common parameters and the transformation 

parameters are always present and are located on their own separate tabs. These parameters are common 

for most of the system elements; therefore, their handling is isolated into a separate chapter of this volume. 

All other tabs in the dialog box repeat those in the property window. Due to this, the related chapters will 

describe main parameter management based on the example of the property window. 

The property window is typically divided into 

several sections. The number of sections depends 

on a particular operation. Each section of the 

window can be expanded or collapsed using the 

buttons  and . Once expanded within a 

particular command, this section state will be 

remembered for this particular command, and 

automatically accounted for in the subsequent 

command calls.  

There is a field to the right of a parameter input box 

that displays the current parameter value. This is 

helpful in the cases when the parameter is defined 

via a variable or an expression, or else when defined 

“from status” (that is, uniformly for the whole 

document). 

 

 

Some automenu buttons are duplicated in the property window, such as the “Accept”, “Exit” and “Preview” 

buttons. The property window works together with the automenu. Pointing cursor at some areas of the 

dialog box causes activation of the respective options in the automenu, such as, say, selection options. 

Special auxiliary graphic objects called draggers are introduced for dynamically controlling parameters of 

a 3D operation being defined. These appear automatically while within a command for creating or editing 

a 3D operation or a construction entity. Dragger manipulation is instantly reflected in the property window. 

The mouse-controlled dragger input defines the numeric parameter values of the operation. There can be 

several draggers on the scene simultaneously, providing control over various operation parameters. As an 

example, the “Bend” operation provides draggers for the bend angle, radius, offset and the two shifts. The 

“Blend” provides control over the rounding radius, etc. The values of the driven parameters are 

simultaneously updated in the property window of the operation being created or edited. 
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Examples of draggers in the commands “Blend Edge” and “Taper” 

Marks with the current parameter values are displayed on the screen for each respective dragger. Besides 

the current value, a mark has an icon indicating the type of the displayed parameter. As the parameter 

value is modified via the property window or a dragger, the value on the mark changes dynamically. 

If it's too many marks and those interfere with working in the 3D scene, you can hide them or move 

sideways. Hiding marks is done in the current 3D command parameters. To move a mark sideways, point 

the cursor to the mark's icon. Once the cursor turns to , depress  and, while holding the mouse button, 

drag the mark image to the desired location. The moved mark will be connected to the dragger with a 

leader line. 

                

Marks serve not only to track the current parameter values, but also to modify them. To do that, click  on 

the parameter value displayed in the mark. The mark will go into the editing mode of the parameter it 

controls.  

Preview 

The following option is provided with each operation to see the result without completing the operation: 

 

 <F5> Preview Operation Result 

This option becomes accessible once the required parameters of the operation have been defined. Once 

this option is set, the displayed body starts to reflect the operation per its current parameters. In the case 
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of satisfactory results, complete the input by pressing the icon . Otherwise, turn off the preview option 

by pressing on the icon once more, and adjust parameters as desired. 

 

Editing Parameters of Operations with the Help of Draggers Outside of 

Commands  

When selecting a Body in 3D window, in addition to the Body itself the draggers of the operations taking 

part in its formation are marked on the screen. The draggers allow us to directly edit parameters of the 

operations that form the Body in a transparent mode without entering into the editing command. 

 

 

Draggers of External Variables 

To specify the values of external variables of a 3D model, the user's draggers can be created. 

     

Draggers of external variables can be used in two ways: 

 to change parameters of the model in the scene. The command of controlling the draggers 

visibility in the scene – «Show/hide draggers» is added to the toolbar of objects visibility 

control in the scene; 
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 to change values of external variables on the fragment upon insertion of the model into the 

assembly. 

To create draggers it is required that the external variables that control parameters of the given model be 

present in the current 3D model.  

 

Preview of Operation Result 

In the commands for creating and editing the modifier operations, there is an additional mode allowing a 

user to see the changes produced in the model by the current operation: 

 <Ctrl+F5> Preview Solid Changes 

In this mode, the parts of the volume which will be added to the source body are shown with a yellow 

color, and the parts of the volume which will be removed from the source model are shown with a blue 

color. 

   

Similar to the option for previewing, the option  is available only when all necessary elements for 

creating operation have been specified. 

The Groups of T-FLEX CAD 3D Modeling Commands 

 Workplane and worksurface management commands 

 <3W>  Construct Workplane 

 <3EW>  Edit Workplane 

 <3SU>  Construct Worksurface 

 <3ESU>  Edit Worksurface 

 Commands for auxiliary 3D element creation 

 <3N>  Construct 3D Node 
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 <3PR>  Construct 3D Profile 

 <3PA>  Construct 3D Path 

 <3SE>  Construct Section 

 <3O>  Create Local Coordinate System 

 <3CA>  Construct Camera 

 <3H>  Create Light Source 

 <3PP>  Construct Pipe Path 

 Commands for auxiliary 3D element editing 

 <3EN>  Edit 3D Node 

 <3EPR>  Edit 3D Profile  

 <3EPA>  Edit 3D Path 

 <3ES>  Edit Section 

 <3EO>  Edit Local Coordinate System 

 <3CC>  Edit Camera 

 <3EH>  Edit Light Source 

 <3EPP>  Edit Pipe Path 

 3D model creation commands 

 <3X>  Create Extrusion 

 <3RO>  Create Rotation 

 <3B>  Create Boolean 

 <3DE>  Create Blend 

 <3DF> Create Face Blend 

 <3DT> Create Three-Face Blend 

 <3SL>  Create Loft 

 <3SW>  Create Sweep 

 <3SA> Create By Parameters 
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 <3PI>  Create Pipe Sweep 

 <3F>  Insert 3D Fragment 

 <3U> Set Adaptive Fragment Parameters 

 <3CT>  Create 3D Mate 

 <3CP>  Create Copy 

 <3SY>  Create Symmetrical Body 

 <3MO>  Insert External Model 

 <3I>  Insert 3D Picture 

 <3AL>  Create Linear Array 

 <3AR>  Create Circular Array 

 <3AN>  Create Array By Nodes 

 <3AP>  Create Array By Path 

 <3AA>  Create Parametric Array  

 <3SD>  Divide Solid 

 <3SR>  Create Spiral 

 <3SP>  Create Spring 

 <3CU>  Cut By Section 

 <3SH>  Create Shell/Offset Body 

 <3TA>  Create Face Taper 

 <3TB>  Create Body Taper 

 <3AM>  Apply Material  

 <3AT>  Create Thread 

 <3H>  Create Hole 

 <3ST>  Create Rib 

 <SMC>  Create new Base Part 

 <SMB>  Create Bend 
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 <SMU>  Unbend Bend 

 <SMR>  Re-bend 

 <SMF>  Create Sheet Metal Forming Feature 

 <SMS>  Convert Solid to Sheet Metal 

 <SMP>  Sheet Metal Operation Defaults 

 <3SS>  Sew Surfaces 

 <3SZ>  Imprint Elements 

 <3ZD>  Delete Faces 

 <3ZX>  Separate Faces 

 <3ZR>  Replace Faces 

 <3ZC>  Change Faces 

 <3ZT>  Transform Faces 

 <3SX>  Extend Faces 

 <3ZF>  Fill Hole 

 <3DRT>  Scale/Twist Deformation 

 <3DRB>  Bend Deformation 

 <3DRS>  Skew Deformation 

 <3DRC>  Sculpt Deformation 

 <3DRV>  Deformation by Curve 

 <3DRF>  Deformation by Surface 

 <3SI>  Simplify 

3D model editing commands 

 <3EE>  Edit Operations 

 <3EX>  Edit Extrusion 

 <3ER>  Edit Rotation  

 <3EDE>  Edit Blend 
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 <3EDF>  Edit Face Blend 

 <3EDT>  Edit Three-Face Blend 

 <3EB>  Edit Boolean 

 <3ESL>  Edit Loft 

 <3ESW>  Edit Sweep 

 <3ESA>  Edit By Parameters 

 <3EPI>  Edit Pipe Sweep 

 <3EF>  Edit 3D Fragment 

 <3ECP>  Edit Copy 

 <3ESY>  Edit Symmetrical Body 

 <3EM>  Edit External Model 

 <3EAL>  Edit linear array 

 <3EAR>  Edit circular array 

 <3EAN>  Edit array by points 

 <3EAP>  Edit array by path 

 <3EAA>  Edit parametric array 

 <3EI>  Edit 3D Picture 

 <3ESR>  Edit Spiral 

 <3ESP>  Edit Spring 

 <3ECU>  Edit Cut By Section 

 <3ESD>  Edit Divided Solid 

 <3ESH>  Edit Shell/Offset Body 

 <3ETA>  Edit Face Taper 

 <3ETB>  Edit Body Taper 

 <3ESS>  Edit Sew Faces Operation 

 <3EAM>  Edit Material Application 
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 <3EAT>  Edit Thread 

 <3EH>  Edit Hole 

 <3EST>  Edit Rib 

 <SMP>  Edit Base Part 

 <ESM>  Edit Bend 

 <ESU>  Edit Unbend Bend 

 <ESR>  Edit Re-bend 

 <ESF>  Edit Sheet Metal Forming Feature 

 <EMS>  Edit Sheet Metal Converted from Solid 

 <3ESZ>  Edit Imprint Elements 

 <3EZD>  Edit Delete Faces 

 <3EZX>  Edit Separate Faces 

 <3EZR>  Edit Replace Faces 

 <3EZC>  Edit Change Faces 

 <3EZT>  Edit Transform Faces 

 <3ESX>  Edit Extend Faces 

 <3EZF>  Edit Fill Hole 

 <3EG> Move/Rotate 

 <3CM>  Move Mated Components 

 3D model visualization commands 

 <3AS>  Apply Section in 3D View 

 <3CD>  Show Clip Plane Position 

 <3CL>  Enable Clip Plane 

 <3CS>  Set Clip Plane Position 

 <3RC>  Select Center Of Rotation 

 <3RF>  Full Rotation 
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 <3RX>  Rotate about X axis 

 <3RY>  Rotate about Y axis 

 <3RZ>  Rotate about Z axis 

 <3RS>  Rotate about global/local axis 

 <3RA>  Automatic Rotation 

 <3VA>  Auto-Resize 3D Scene 

 <3RP>  Panoramic Rotation 

 <3RL>  Fix Direction 

 <3VB>  Back View 

 <3VF>  Front View 

 
<Ctrl + 

Numpad 1> 
 Bottom Isometry 

 

<3VU>, 

<Ctrl + 

Numpad 2> 

 Bottom View  

 
<Ctrl + 

Numpad 3> 
 Bottom Back Isometry 

 

<3VL> 

<Ctrl + 

Numpad 4> 

 Left View 

 

<3VR> 

<Ctrl + 

Numpad 6> 

 Right View 

 

<3VT> 

<Ctrl + 

Numpad 5> 

 Top View 

 <3VI>  Axonometric (front) 

 <3VK>  Axonometric (back) 

 <3VW>  View Wireframe 

 <3VS>  View Shading 
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 <3VD>  View Render 

 <3VH>  View Hidden Line Removal 

 <3VZ>  Precise Hidden Line Removal  

 <3VM>  Semitransparent View 

 <3VE>  Perspective Projection 

 <3VO>  Orthographic Projection 

 <3VP>  Set View Parameters 

 <3VY>  View Ray Tracing 

 <3TE>  Create 3D Model explode 

 <3VX>  Exploded View  

 <3VC>  Select Camera 

 <3RV>  Open Photorealistic View Window 

Geometry analysis commands 

 <PM>  Measure Element or relation between two Elements 

 <3MP>  Mass-Inertial Properties 

 <QM>  Check Model 

 <QI>  Check Model Intersections 

 <QA>  Check Model Changes 

 <QC>  Show Curve Curvature 

 <3VV>  Show Surface Curvature 

 <QD>  Show Face Deviation 

 <QH>  Show Gap Between Faces 

 <QN>  Show Normal Deviation 

 <QZ>  Show Surface Smoothness (Zebra) 

 <QS>  Check Model Separation 
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3D model management commands 

 <3G>  Regenerate 3D Model 

 <3RG>  Full 3D Model Regeneration 

Commands for 2D drawing creation and editing based on three-dimensional 

model 

 <3J>  Create 2D Projection 

 <3EJ>  Edit 2D Projection 

Material creation and editing command 

 <3MT>  Edit Materials 

Customizing List of Element Types for Selection 

The user can control the element types that are subject to selection by mouse . The selection filter icons 

are located in the right part of the system toolbar. For detailed description of selection filter management 

refer to the “Two-Dimensional Design”, the chapter “Main Concepts of System Operation”. 

 

To manage the filters, make sure the 3D window is active. To activate the window, click  anywhere within. 

Element Selection 

3D element selection can be done either in the 2D or in 3D window. A 3D element selection in the 2D 

window is possible only if this 3D element creation was based on 2D elements. For example, consider a 3D 

node defined by two 2D nodes. It can be selected either directly in the 3D window or via any of the two 

2D nodes in the 2D window. Either way results in the 3D node selection. 

The elements of a 3D sketch can be selected while in “3D Drawing” mode just the same way as in the 2D 

window. 

Selecting a 3D element 

Pre-highlighting is turned on in the 3D window. When the cursor approaches an element on the 3D scene, 

the element is getting highlighted, and the cursor gets an attached glyph that indicates the type of the 

highlighted element. If the cursor is briefly held over the element, a pop-up help appears displaying the 

type of the element. To select the element, press . To select a group of elements, hold the <Shift> key 

while selecting. 
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In complicated models, several elements of the same or different types can be under the cursor 

simultaneously. In this case, use the “Other…” button of the context menu that provides selection from list. 

The list is composed of the elements nearest to the cursor, whose types are admitted by the selection filter.  

An alternative way is to point the cursor at the desired element and briefly hold still. The cursor will be 

appended a “scroll list” glyph, and a pop-up widget will appear indicating the total number of elements 

available for selection at this point, and a current element type. The widget allows scrolling through the 

elements with the mouse middle wheel button (if equipped). Pressing  selects the currently highlighted 

object. 

To select a 3D profile, point the cursor at the contour line. To select bodies, set up the selector for operation 

selection and turn off edge and face selection. If in “Shading” or “Render” display mode, point anywhere 

on the body. In “Wireframe” mode, point at an edge of the body. Since the bodies may overlap on the 

scene, re-orient the model to bring the desired body up front. 

 

The selected elements are marked with a color, depending on the object type and 

the purpose of selection. All color settings are defined in the system customization 

functionality. 

In some 3D commands, different elements of the same type are marked with 

different colors. For example, in the three-face blending operation, the user 

specifies the left, right and middle sets of faces. In this case, the faces of each set 

are marked with different colors. These colors also mark the respective tabs of the 

property window dialog box, that contain the corresponding lists of faces.  

When working with large 3D assemblies containing nested fragments, only the 

fragments of the first embedment level are selected in 3D window. To get a quick 

access to the nested fragments of a lower level, it is possible to use the  option 

found on the system toolbar. 
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Selecting elements within a command 

The user often needs to select some existing elements on the 3D scene when defining a command input 

data. The system automatically adjusts the selector for the element type required by the current step in 

the command automenu. Suppose, for instance, while defining a blend we pushed the option “Select edge”. 

The selector then adjusts to edge selection only. Next, reorient the scene for easy selection, point the cursor 

at the desired element, and press . In this case, selecting a group of elements is done by picking 

subsequently, without holding the <Shift> key.  

Often, a required geometrical input in a command may be defined by a number of different-type 3D 

objects. Thus, for instance, a direction can be defined by wire objects, such as edges, paths, profiles, etc., 

or by a pair of 3D nodes, or by a normal to a planar surface, etc. In this case, the automenu option provides 

an extended list of filter settings for the selector. The availability of the list is indicated by a black triangle 

in the right-bottom corner of the option button. A simplified representation of the list is also displayed in 

the system bar. 

 

Should a wrong element get selected (say, a neighboring one), use the automenu option, 

  <I> Select Other Element 

A subsequent pick on the icon switches the selection to the next nearest element, on and on until all 

elements are traversed. This option is available with all 3D commands that require object selection. 

Canceling selection 
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While within a command, element selection can be cancelled by pressing  or <Esc> key. The elements 

are getting unselected one by one in the reversed order of the selection. Many commands allow 

unselecting all elements at once by using an appropriate automenu icon. (Refer to the respective topics in 

the documentation.) 

To cancel selection of an element or a group of elements while outside any command, simply select 

another element or click  at a blank on the 3D scene. 

Element Search 

Search functionality can be invoked in transparent mode, and is available with all commands. For quick 

access to the search command, the button  found in the set “Edit” of the main toolbar 

can be used. 

Advanced search can be performed by the command Edit > Find. 

Opening New Windows 

When creating a new document from a 3D model prototype, a 3D window opens first. Later in design, the 

user may need to open additional 2D or 3D windows. Use the special buttons on scroll bars for this purpose. 

This buttons activates «Views Placement” dialog box, where you can select the location of new views. 

 

In “Views Placement” window you can select one or several 2D and 3D views using special buttons. 
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For custom views placement you can use the drop down lists in the lower part of the dialog box. Mark the 

required views with . The following types of the new views are available: 3D view, 2D view, Database 

Editor and Photorealistic View. They can be assigned in any order and in any combination. 

Use “Set as default” option to create predefined set of views when creating new windows in Window > 

New Window command.  

If the original file was created from a drawing prototype, the 2D window was opened first. A simple way to 

create another 3D window is to click on the button with a triangular arrow in the right-top corner of the 

graphic area of the current window. As a result, the graphic area of the current window will split in two 

equal parts, a 2D window on the left, and a 3D one on the right. 

         

Finally, one can call the command for opening a new window, WO: Open New Window by typing on the 

keyboard or via the textual menu Window > New Window. 

Depending on what kind of window is currently active, some or other commands will not be 

accessible. Thus, if a 2D window is active then the 3D Visualization commands won’t be accessible, 

and neither will be 3D view controls. Vise versa, while in a 3D window, the most of 2D commands 

could only be accessed in a special mode - when a workplane is activated. 

You can fix the particular set of views for the document window for usage in subsequent sessions by 

activating “Fixed set of windows” option in the 3D tab of ST: Set Document Parameters command. The 

document should be saved to apply changes. 

Manipulating Model in 3D Window 

While working in 3D window a model can be spun in any way, zoomed at in and out, and panned. These 

actions can be done at any moment using mouse or keyboard input. When using the mouse, sometimes 

it is necessary to set certain options on the “View” toolbar (located at the right side of the screen). 

To spin the 3D scene while working on an active workplane, use the button  found on the main toolbar 

in the mode “Workplane” or “Workplane (Sketch)”. It is also possible to spin the model with the help of the 

mouse simultaneously pressing the <Alt> key. 

For more details see the chapter “Working with the 3D View Window”. 

“3D Model” Window 

To open the 3D model tree window use the command: 
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Icon Ribbon 

 

View → Window → Tool Windows → 3D Model Tree 

Window 

Keyboard Textual Menu 

<Alt+3> Customize > Tool Windows > 3D Model Tree Window 

The window titled “3D Model” will appear at the left side of the screen. This tool window reflects the 

structure of the 3D model as a tree. 

The toolbar in the upper part of the 3D Model window includes: options for window status switching, a 

drop-down list of columns and a search field. 

 

There are several ways to use the  option: 

If you select a 3D object in the scene and activate the  option, the object will be highlighted in the 

model tree. 

If you select edge, vertex or face and activate the  option, a body/fragment, to which the selected 

element belongs, will be highlighted in the model tree.  

If you select you select an element in the model tree and activate the  option, the selected element will 

be zoomed in the 3D scene 

A search field allows to find an element in the 3D model tree by its name or part of the name. Elements, 

which names match the required name, will be displayed in the tree after searching. 

 

Columns allows to change elements parameters and to receive information. You can change parameters 

for several elements at once. 

For example, if you want to hide several workplanes, it is necessary to select the planes and press  in 

the visibility column. 
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If any parameter can’t be changed, its symbol will not appear in the column. 

The drop-down list is used to select columns: 

 

Bodies are put at the root of the model tree. Depending on the Body geometry type (solid or sheet object), 

the respective icon will be used for it in the model tree. 

Each model Body is assigned a unique name, by default composed of the word “Body” and a number, for 

example, “Body_1”. If desired, any Body can be assigned an arbitrary individual name in the Body 

parameters. 

 

The 3D Fragment, Part and 3D Array creation operations can be displayed at the top level of the model 

structure, along with Bodies. 
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The Body knots are marked by the glyph . It allows watching the history of the given body’s creation. 

Point the mouse at the glyph  and click .  

 

As the model tree branch with the Body history expands, the glyph changes to . The Body history consists 

of a sequence of their defining operations, displayed as a list. The list is formed from top down in the order 

of creating or using operations. To hide the Body history, point to the glyph  and click . 

 

Each model element entered in the Body history has a unique name. By default, the name consists 

of the name of the element type and a number, for example, “Extrusion_6”. If desired, the element, 

just like a Body, can be assigned an arbitrary individual name. 

Named geometrical elements (edges, faces, etc.) can then be used to perform measurement, search 

of parent element used in operations. Searches can be performed via the Edit > Find command or 

Find section of Edit system toolbar. Named elements are available for obtaining information about 

the dependencies in "Information" command dialog. Option Delete that removes dependent 

objects is also available for them. Named elements, when used for subsequent creation of new 

operations based on them, retain their names. If the named geometric element is located on a 

visible body, it is marked in the 3D window when it is selected in the model tree. 

 

You can change the geometric element name using 

the Parameters command in its context menu. Names 

may be set for vertexes, edges, cycles, faces. 

 

 

The   glyph before the element means this element is based on other elements. To expand this model 

tree branch and view the element’s parents, point the mouse to the glyph  and click . After that, the 

glyph will change to . If there is no glyph before the element, this means the element is the last one on 

this branch of the 3D model tree. 

 

If the creation history can be built for an operation, then the history will be displayed instead of the parents. 

In this way, the  glyph is put before the operation name instead of the  glyph. An operation's history is 

displayed in the same way as a Body’s history. 
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The Boolean operations are displayed in a special way in the history. The type of Boolean (addition, 

subtraction or intersection) is drawn before the icon of the operation that comes as the second operand 

of the Boolean. The diagram shows the history of the operation “Boolean_2”: the body “Block_2” is 

subtracted from the body “Block_1”. 

 

In addition to the list of Bodies, in the root of the model tree there are also special branches of the tree in 

which all 3D elements created in the current model are enumerated. Auxiliary 3D elements are put on the 

branch “3D Construction”. All operations are on the second branch, “Operations”. 3D annotation (3D 

dimensions, 3D leader notes, etc.) are put into the branch “3D service elements”. The “Constraints” branch 

lists all constraints created in the given model. All elements are sorted into the folders by types: 3D Nodes, 

Workplanes, 3D Profiles, etc.; within the folders, the elements are sorted alphabetically. The number next 

to the folder name and the colon means the number of elements of this type contained in the model. By 

expanding branches of the model tree, you can access any element of the 3D model. 

 

 

In certain cases, operations can be reordered by moving their labels within the model tree. This effectively 

changes the model structure and geometry. Press  on the element label and drag it to a new location in 

the tree. The following diagrams demonstrate the result of reordering an element in the model tree. In the 

beginning, the operation Shell_3 followed the subtraction operation Boolean_2. Then, the Boolean, 

together with its tool body operand Extrusion_1 (a cylinder), was reordered to be after the shell operation. 
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The model tree helps quickly create Boolean operations of all types. If you select a Body and drag it over 

another Body, the indicator of the Boolean “addition” will appear at next to the pointer. If you additionally 

press the key <Ctrl> or <Shift>, the type of the Boolean changes to subtraction or intersection, 

respectively. Instead of Bodies, you can select operations that are last in their histories. 

 

 

 

3D Model tree in 3D scene 

The 3D Model window can be also displayed in the 3D scene. For this purpose press  icon in the top 

left corner of the 3D scene.  

 

If the 3D Model window becomes at some point not available when working with a 3D model, the model 

tree is automatically expanded in the scene. This occurs, for example, when entering commands of 3D 

elements creating or editing. If the expansion of the tree upon commands activation is not required, it is 

enough to close it once using  and the system will remember this status. 

 

The model tree has a toolbar that is similar to the toolbar in the 3D Model window. The only difference is 

the number of columns to be displayed. To hide this toolbar you need to click on a special button. 

 

The tree can be expanded. To do this place the cursor on the right edge of the toolbar and move it holding 

the left mouse button. 
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Model Tree Context Menu 
By pointing to an element in the model tree, you can access the context menu (by pressing ). 

The context menu consists of standard commands for working with element (Edit, Copy/Paste, Parameters 

and so on) and with 3D Model window. 

The context menus may vary depending on the element selected in the 3D Model window. 

Besides the common commands for managing the selected element, the context menu contains some 

additional commands for working with particular Bodies, operations and the model tree as a whole: 

 

Delete Body (for Bodies). This command serves to delete all the operations which are part of this Body's 

creation history. In addition, all parent 3D construction elements of this Body can be deleted, or just those 

parent elements that are not referenced by other created Bodies. 

Delete (for operations and auxiliary 3D elements). The command deletes the selected operation or 3D 

construction element. 

Detail command allows to unload a body or a fragment from the assembly into a separate file. 

More information about detailing can be found in “Assemblies creation” chapter. 

 

Remove mate transformations. Option allows to remove all mate transformations of the selected object 

and to return it to the initial state. 

Rollback model option allows to rollback a three-dimensional model to the level of the specified operation. 

 

More information about rollback model can be found in “Edit” chapter. 

 

Retain geometry after recalculation option allows you to save intermediate geometry for the operation, 

thereby accelerating transition to its editing. 

 

More information about the option can be found in “Edit” chapter. 

 

Separate branches-folders can be created for grouping Bodies, 3D fragments and 3D array. To do it, in the 

context menu for the Body which you want to put into a separate folder, invoke the command Move to 

Folder > New folder from the context menu. A window for specifying the name of the folder being created 

will appear on the screen. After specifying the name and pressing [OK], there will be a folder having the 

specified name in the tree of the 3D model, and the selected Body will be put into this folder. 
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If in the tree of the 3D model at least one Body folder has been already created, in the context menu for 

each body in the submenu Move to Folder, a list of existing Body folders will be also present. The folder 

that contains the current body will be marked. For moving Body into one of the already existing folders, it 

is enough to select the folder in the list. 

It is also possible to move Bodies from the root of the model tree to the folder and backwards just by 

dragging Bodies while pressing . 

 

 

Selecting objects with the help of the model tree is sometimes very convenient in many commands, for 

example, when selecting this element in the 3D window is difficult for some reasons. 

 

The Visibility group of commands unites the commands to control the visibility of Bodies and 3D 

construction elements: 

 

Hide. This command makes the selected 3D objects invisible in the 3D scene; 
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Show. This command cancels the previous command, making the selected 3D objects visible in the 3D 

scene; 

Hide Only Selected. This command makes all selected 3D objects invisible, and shows all the rest, if those 

were previously hidden. 

 

Show Only Selected. This command makes all the selected 3D objects visible, and hides (makes invisible) 

the rest; 

Show All. This command makes all objects in the 3D scene visible. 

The accessibility of the commands in the group depends on which 3D objects are selected. For 

example, if all selected 3D objects are currently hidden, then the “Hide” command will be 

inaccessible.  

The hidden/shown Body state can be defined using the “Hide” option in the Body's parameters 

dialog without the use of the described commands. This option's value can be defined via a variable. 

If a variable is used, then the commands of the “Visibility” group will not affect the visibility of such 

Body. This will be stated in the provided warning message. 

Suppress (for operations). This command excludes the operation from regeneration. This allows user to 

temporarily remove 3D model elements. To select a suppressed operation, use the “3D Model” window or 

do the element search. 

 

Only selected elements will be displayed in the tree upon using Go to elements command. Status switching 

options , ,  are used to return to the normal mode. 

 

You can create a separate window for the selected elements using Open in new window command. This 

window can be moved around the screen. It retains all the functionality of the 3D Model window. This 

window eliminates having to move the cursor across the screen to select an element in the model tree. 
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After using Hide element command, the selected elements will not be displayed in the model tree. For 

example, you can hide unused items, so as not to be distracted by them. 

 

 

If the flag Show hidden elements is active, all hidden elements are displayed but greyed. The elements 

names are shown in italic to distinguish them from the suppressed elements. 

 

To display elements again you may use Show element command. 

 

Use the Show all elements command to show all hidden elements again.  

View item includes commands and options to customize the display of model tree such as Display 

parameters, Use active View filter, Appearance. 
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In the View parameters window you can set colors for: 3D Model window, selected elements, invisible 

elements, marked elements and hidden elements. In each of these groups, you can set text color and 

background color. 

View group 

The View group in the Parameters dialog is different for the 3D model window and the model tree in the 

3D scene. 

 

Use active View Filter. The 3D window selector can be adjusted for selecting elements in the model tree. 

To activate the filter, flag this item in the context menu. When you move the cursor over the items in the 

tree, only the elements corresponding to the active filter will be highlighted.  
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Indent of sub-elements parameter allows to specify the indentation of child elements in the model tree 

relative to the parent element in pixels. 

Tree Structure parameter allows to set visual representation of the tree structure. The following options 

are available: don’t display, lines, dots. 

  

Blur background borders and Rounding of background box corners parameters are available for 3D 

Model window in the 3D scene. 

 

Use active View Filter - duplicate the appropriate flag from View parameters. 

Appearance… This command allows a user to customize information which is displayed in the tree of the 

3D model. Upon calling this command, the settings dialog window appears. 
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In the dialog “Appearance”, it is possible to select items which will be displayed in the tree for objects of 

various types: time spent by a computer on object recalculation, the memory size of the geometric data 

for the object and the size of the data required for its displaying (mesh), etc. This customization allows a 

user not only to see the objects in the tree in the convenient for the user form, but also carry out the 

recalculation time and the memory usage optimization for the model. The information about the name 

and description of the assembly components can be also convenient when working with the assembly 

models. This information can be displayed together or instead of the filename and the path of the file for 

the assembly components (fragments). 

 

Settings specified in the dialog “Appearance” are saved in the document file and used upon its subsequent 

opening. 

Hide fragment connectors. When the flag is active, fragments connectors are not displayed in the 3D 

scene. 

 “Diagnostics” Window 

This tool window is used for displaying warning and error messages. The errors may occur due to invalid 

operation parameters input, an out-of-range variable value, regeneration with incompatible parameters, 

etc. The system attempts to identify the reason of a failure and outputs a message in this window. Besides 

the failure reasons, the system outputs the information about the failing element. The failing element and 

its dependents are marked with a red cross in the model tree.  
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The context menu in the diagnostics window provides, along with the standard set, some special 

commands, as: 

Hide this message. This command serves to hide messages of the selected type. When this command is 

applied, the messages of the selected type will no longer be displayed in the diagnostics window up until 

this restriction is canceled. The command also affects the future sessions of working with the system. 

Hidden errors list. This command calls the dialog window with the list of hidden messages. To cancel the 

restriction on the messages of the given type, simply clear the check before a message. 

Show window automatically. This option makes the window appear automatically whenever new 

messages are generated. It is useful in the case when several tool windows are grouped together on one 

console. 

Clear window. This command clears the diagnostics window from accumulated messages. 

Hide window. This command removes the diagnostics window. To bring it back, use the main menu 

command Customize > Tool Windows > Diagnostics Window. 

 

 

Edit. This command is accessible only when a specific message is selected. It invokes editing of the failing 

element or operation. 

If the errors occurred within a fragment file then the diagnostics window references the operations from 

the fragment model that caused the error, while the context menu gains another command, 



Three-Dimensional Modeling 

78 

Show Fragment Structure. This command invokes the “Model structure” dialog box. 

 

The fragment in which the error was identified is automatically highlighted. The right half of the window 

contains the information about the fragment variables: their names, values, and comments. To handle the 

error, one can open the fragment file by pressing the [Open] button. 

An error in the fragment model may be caused by an invalid value of a fragment variable. To open the 

fragment with the current values of the variables use the button [Detail]. 

You can select multiple messages in the diagnostics window by using the combination <Ctrl>+ . When 

several messages are selected, the following command will be available in the context menu: 

Delete Related Elements. This command serves to delete all 2D and 3D elements related to the 

selected messages. 
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Arranging Tool Windows 

All tool windows in the T-FLEX CAD application can be 

combined in a common console with tabs. This saves up the 

working area on screen and eases the user from constantly 

adjusting the windows borders while working with the 

application. To combine two windows, pick one of them with 

 at the title area and drag into the title area of the other 

window. The two windows collapse into the common 

console. To switch between the windows, use the tabs that 

appear in the bottom of the console. The system may 

automatically switch between the windows during operation. 

 

 

Toolbars 

Toolbars provide additional convenience to T-FLEX CAD operation. Working with toolbars, their 

customization and access to toolbars are done in the same way as in the 2D drawing mode. Further refer 

to the volume “Two-dimensional design”, the chapter “Main Concepts of System Operation”. 

The necessary options of the command are set using the automenu together with the property window, 

similar to the 2D mode. The set of icons in the automenu is specific to each command. However, some 

options in the automenu are common for all commands: 

 <Y> Finish input. Confirms element creation 

 <P> Set entity parameters 

 <I> Select other element 

 <Esc> Cancel selection 

  <F4> Execute Edit Command 

 <X> Exit command 

 <F5> Preview Operation Result 
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Customization 

Certain customization is necessary for working with T-FLEX CAD. Customization settings include both the 

system-wide ones, and those specific to a particular document. The system settings are automatically saved 

in the Windows registry and are applied at subsequent starts of T-FLEX CAD. The settings specific to a 

particular document are saved with the document. The system customization is done via the “Options” 

dialog box, invoked by the command: 

Icon Ribbon 

 

 → Options 

Keyboard Textual Menu 

<SO> Customize > Options 

All system settings related to 3D modeling are located on the “3D” tab. For more details on working with 

“Options” dialog refer to the volume “Two-dimensional design”, the chapter “Customizing System”.  

Customization of document parameters is done via the Document parameters dialog box invoked by the 

command: 

Icon Ribbon 

 

Edit → Document → Document Parameters 

 

Keyboard Textual Menu 

<ST> Customize > Document Parameters 

All drawing settings related to 3D modeling are located on the 3D tab. For more details on working with 

“Document Parameters” dialog refer to the volume “Two-dimensional design”, the chapter “Customizing 

Drawing”. 

INDICATORS OF 3D  MODEL GRAPHICAL REPRESENTATION  

When working with 3D models you can monitor parameters of graphical representation. To do this, set " 

Display graphics performance data" flag in SO: Set System Options  command ("3D/Graphics Settings ..." 

tab). When flag is checked the upper left corner of 3D view will display the following information: 

FPS - number of frames per second; 

Batch - number of switching buffers when loading bodies into a 3D scene. This parameter depends on the 

number of bodies in the scene. 

Vertex - number of vertices in the scene. Vertex in this case refers to a set of vertex data (coordinates, 

normals, texture coordinates, and other vertex data). 

Face - number of triangular flat faces in the mesh; 

Line - number of lines in the scene; 



Basic 3D Terms and Concepts of Modeling with T-FLEX CAD 

81 

Point - Number of points. 

MTr/s - speed of mesh triangles drawing. Measured in millions of triangles per second. 

To improve performance, you should seek the ways of reducing the quantitative graphical representation 

of models. You can control this via the mesh quality parameters. 
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BRIEF INTRODUCTORY COURSE IN 3D MODELING 

In this chapter, you will learn how to create a three-dimensional model using simple examples. The manual 

describes all necessary steps in the modeling process. Further, you will learn the basic commands and 

principles of creating a 3D model. 

T-FLEX CAD system allows various approaches to creating a 3D model. The main method is creating most 

of constructions directly in the 3D window. In another approach, a 3D model is created based on already 

prepared 2D drawings or auxiliary 2D constructions. This construction may further be used for generating 

drawings by projecting the model in all necessary views and making cuts and sections. These 2D objects 

can further be furnished with necessary dimensions and other drawing attributes. 

MAIN APPROACH TO 3D  MODEL CREATION  

As mentioned above, this approach makes possible creating a three-dimensional model without using the 

2D window. The diagram below shows a sample part that we will be modeling. We will create the three-

dimensional model first, and then automatically generate views and a section.  

 

  

 

The model file is located in the folder “…\Examples\Documentation examples. Introductory 

course\Detail with drawing detailing”. 

The model creation will be done in several steps. First, one has to create initial auxiliary elements. Based 

on those, you will be able to create a first draft of the considered part – without the holes and chamfer. To 

do this, use the “Rotation” operation. At the next step, add six holes in the part’s body. Holes can be created 

by different means. We will discuss several methods here to give you a more complete idea about 3D 

model creation methods. Then, to get the final version of the part, you will just need to apply a chamfer 

via the “Blend” command. 

Creating Auxiliary Elements  

Let’s start from scratch. Create new document. 
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To begin modeling, one can use an appropriate prototype file among available in the T-FLEX CAD 

system (File > New 3D Model). 

You have just created a new document that already has three standard workplanes – Front, Right and 

Bottom. You can see that the 3D window with these elements opens automatically within the system 

window. 

 

For convenience of modeling in 3D window, spinning, panning and zooming of the scene view are 

available at all times, even when commands are active. Note: the view manipulations while in certain 

commands require a specific option to be set. These commands will be described below.  

To spin the scene press and hold  and move the cursor as desired. One can also use the two arrow 

key pairs and the pair <Page Up> and <Page Down> for spinning around the three respective axes. 

Zooming can be done at any moment by scrolling the mouse wheel button (as in IntelliMouse 

design) or via the provided commands on the “View” toolbar located along the right border of the 

window. Panning and zooming of the view can also be controlled via <Ctrl>+  and <Shift>+  

combinations respectively. 

As we move the cursor close to a workplane, the latter gets highlighted. T-FLEX CAD provides pre-

highlighting on cursor over for all elements in the 3D window depending on the selection filter settings. 

The selection filter icons are located on the system toolbar. To pick an element among the icons, simply 

press . 

  

Let’s select the “Right” workplane. One can see now that 2D drawing commands become accessible. We 

will further use these commands for creating auxiliary elements in the 3D window. 

What auxiliary elements do we need? The first body to be created is a body of revolution. To create it, we 

will need the contour and the axis of rotation for this contour.  
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Drawing in 3D window can be performed using any of the tools available for 2D drawing. Thus, one 

can use the sketching environment for rapid creation of non-parametric models. Accordingly, 

parametric modeling approach requires creation of construction lines first, then application of 

graphic lines. The system automatically creates 3D profiles based on drawn graphic lines, to be later 

used in 3D operations.  

To start drawing, call the command, 

Icon Ribbon 

 

Draw → Construct → Line 

Keyboard Textual Menu 

<L> Construct > Line  

After activating the workplane by any 2D drawing command, the main toolbar is switched to the mode 

“Workplane”. In this mode a set of icons for working on the active workplane is displayed on the toolbar. 

 

For convenience, the active workplane is reoriented parallel to the screen. However, it can be spun in any 

desired way, after setting the option .  

It is also possible to open the 2D window and continue drawing in 2D mode. Once the 2D window is closed, 

all changes will be reflected on the 3D scene. The 2D window can be opened or closed using the  icon. 

Let’s construct two base lines, a vertical and a horizontal one. To do so, push the following button in the 

automenu: 

 <Х> Create two crossing Lines and Node 

Point cursor at the center of the workplane and click . 
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Thus, we have created two orthogonal lines and a node. These will be used as a reference for all further 

construction. Press  to quit the last active command. We are now in the parallel line creation mode. (This 

mode is set by default in the command “L: Construct Line”). 

Just like in 2D drawing, we first need to create a framework of thin lines, and then apply graphic 

lines along the intended segments. 

To construct a parallel line, select a reference line first, that will be used as the “parallel” reference for the 

new one. Similarly to 2D operation, the 3D drawing mode also supports object snapping. Thus, to select a 

line, move the cursor to the vertical line. The cursor will gain a glyph like this, . Click  and move the 

cursor leftwards. One can see the cursor changing appearance again – it is now rubberbanding a line 

parallel to the selected. 

To fix the line at an arbitrary location, just click . However, we would like 

to specify the distance of 100 mm, by typing it in the property window. 

(In future, this parameter value can be changed at any time as desired.) 

Press <Enter> to complete the line creation. 
 

We have just created a line parallel to the selected, at the distance of 100 mm from it. As one can see, 

rubberbanding resumes at this point. The system is still in the mode of parallel line creation with respect 

to the original selection. Type a new value of 20 mm right away, followed by <Enter>, thus creating another 

line. That’s all with the parallel line creation for now. Click  or <Esc> key for quitting the parallel line 

creation mode.  

Next, create four more lines in the similar way, parallel to the horizontal base line. Use the distances equal 

to 20, 40, 60 and 100 mm respectively. The result should look like shown on the following diagram.  
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Now, apply graphic lines along the construction lines appropriately. Call the graphic line creation 

command: 

Icon Ribbon 

 

Draw → Draw → Graphic Line 

Keyboard Textual Menu 

<G> Draw > Graphic Line 

Graphic lines snap to the construction entities – lines, circles, nodes, etc., as well as to construction line 

intersections. In the latter case, a 2D node is automatically created at intersections snapped to by graphic 

lines. Straight graphic line segments maintain snapping at their end points. To have an end of a graphic 

line snapped to some entity, move the cursor to the intended location. Let the cursor snap as indicated by 

an appropriate glyph, and click .  

In this example, we use snapping to construction line intersections and to 2D nodes. Draw the profile as 

shown on the following diagram. To do so, click with  at the appropriate points in the order marked on 

the diagram. 
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To quit continuous line creation mode, click . Note that the graphic line creation command is still active. 

Change the line type in order to draw the axis. To do so, pick the icon  on the system toolbar and select 

CENTER type from the pull-down list.  

 

Draw the centerline as shown on the following diagram.  
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Creating Rotation Operation 

One need not quit drawing explicitly in order to create a body of revolution. Simply call the “Rotation” 

command as follows: 

Icon Ribbon 

 

3D Model → Create → Rotation 

Keyboard Textual Menu 

<3RO> Operation > Rotation  

The system automatically determines the rotation axis and the contour among the created lines to be used 

as a 3D profile. You can preview the result as a wireframe model. In our case, the rotation angle is 360 

degrees. Note that the value of 360 degrees for the rotation angle is set by default in the property window. 

Just confirm the operation by pushing the check button , and the body of revolution is created. 

 
 

Creating Holes 

Next, we need to cut six holes in the part. 

Holes can be created by different methods. The fastest and simplest one is using the dedicated “Hole” 

operation. The latter allows creating holes of standard shapes in solids, using templates provided in the T-

FLEX CAD utility library. In this way, the user only needs to specify the position of the would-be hole within 

the solid and specify its type and dimensions. 

 

Non-standard holes and slots can also be created without using the dedicated operation. To do this, the 

user should create an additional solid representing the internal volume of the hole, and then “subtract” it 

from the main body’s volume by a Boolean operation. 

Let us consider both techniques. 
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Creating holes using a dedicated command 
First of all, we will create 3D nodes corresponding to the centers of the would-be holes, on one of the 

part’s faces. To create them, we will again use the 2D drawing mode for creating auxiliary 2D nodes on the 

respective face of the part.  

To select a face, move the cursor to the desired element of the model so that it pre-highlights. At this 

point, press  to invoke the context menu and select “Draw On Face” item in it (see the diagram). 

 

If the desired element is not getting pre-highlighted, make sure the selector is set up for this 

element type. To change selector’s settings, you can use selector filter icons on the system panel or 

select a combination of types from the list. 

The “Draw On Face” command creates a new workplane based on the selected flat face. The selected face 

is automatically projected on this plane, and the mode of drawing in the 3D window activates. Further 

construction can use snapping to elements of the face projection. 
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Call the command L: Construct Line again. Select the following option in the automenu, 

 <V> Create vertical Line 

Move the pointer to the center of the circle - the circle center will be pre-highlighted. It is available for 

snapping to the vertical line. Click . The constructed line will be snapped to the 2D node which was 

automatically created at the circle's center. 

 

    

Call the command: 

Icon Ribbon 

 

Draw → Construct → Circle 

Keyboard Textual Menu 

<C> Construct > Circle  
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Point the cursor at the center node to select it as the center of the new circle. Specify the radius of the 

circle equal to 80 mm by typing in the property window.  

Create a 2D node at the intersection of the vertical line and the new circle using the command: 

 

Icon Ribbon 

 

Draw → Construct → Node 

Keyboard Textual Menu 

<N> Construct > Node  

 

                  

Now, one can construct a 3D node based on the created 2D node. To do this, without leaving the drawing 

on face mode, call the command: 

Icon Ribbon 

 

Draw → Construct → 3D Node 

Keyboard Textual Menu 

<3N> Construct > 3D Node  

When the 3D node creation command starts, move the pointer to the created 2D node and click . The 2D 

node will be highlighted, and the option  will become accessible in the automenu. Click , and the 

3D node will be created. It will be located in the plane of the selected face, while the 2D node will be its 

projection on that face.  

The created 3D node will define the center of one of the six holes. There are two ways to define centers of 

other holes:  
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1. Construct five more 2D nodes on the same workplane and create the required 3D nodes based 

on the 2D ones (similar to the first 3D node creation); 

2. Create the required 3D nodes by means of a 3D array based on the first 3D node. 

The second method is faster, so we will use it in this case. Call the command 3AR: Create Circular Array: 

Icon Ribbon 

 

3D Model → Create → Circular array 

Keyboard Textual Menu 

<3AR> Operation > Circular array 
 

You do not have to explicitly finish the draw on face mode - it will terminate automatically upon 

launching the 3D array creation command. 

In the command's properties window, set the array type as “Array of 

Construction”. Then, in the 3D window, move the pointer to the 

created 3D node (the latter shall highlight) and click  to select it. If 

all was done right, the name of the 3D node selected for copying 

shall appear in the properties window. 

After that, you need to specify the rotation axis of this circular array. 

To do this, you can use a pair of 3D nodes automatically created 

when defining the axis for the rotation operation. Select these two 

3D nodes one by one. 

Next, let's specify what array parameters will be used (“Number of 

copies and total angle”), in the “Rotation (Rows)” section of the 

properties window, and enter the required values of the parameters 

(the number of copies – 6, the total angle – 3600). To complete 

creation of this circular array of 3D nodes, simply click . 

 

             
Selecting 3D node to copy Selecting first 3D node of 

the array's axis of rotation 

Selecting second 3D node 

of the array's axis of 

rotation 

Result of creating an array 

of 3D nodes 

After creating the array of 3D nodes, you can call the command 3H: Create Hole: 
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Icon Ribbon 

 

3D Model → Modify → Hole 

Keyboard Textual Menu 

<3H> Operation >Hole 

 

Upon entering the command, you need to activate the option: 

 <M> Add Hole Array 

After that, move the pointer to one of the 3D nodes of the circular array and 

click . In the command's properties window, select the hole type – “Hole 

for fasteners”. The preview image of the holes being created will appear in 

the 3D window. 

At the bottom of the properties window there is a pane with a schematic 

image of the hole of the selected type and fields for entering the hole 

parameters. Set the hole diameter to be 20 mm. 

The following option will be automatically activated in the command's 

automenu for the holes of this type: 

 <F> Through all 

When this option is set, the depth of the holes will be defined automatically 

by the part's thickness. 

To complete creation of holes, simply click  in the properties window or 

in the command's automenu. 
 

               

Creating holes without using a special command 
In this approach, initial constructions of the holes creation will be same as in the previous method. 
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You select a part's face and call the context menu command «Draw On Face». Call the command “L: 

Construct Line”. Select the automenu option . Construct a vertical line passing through the center of 

the circle (of the face's projection). Then, call the command “C: Construct Circle”. Create the circle with the 

radius equal to 80 and the center at the central node. Similarly, create another circle with the radius equal 

to 10 mm at the intersection of the previous circle's circumferential and the vertical line. 

Then draw graphic line over the newly created circle. To do so, call the graphic line creation command: 

 

Icon Ribbon 

 

Draw → Draw → Graphic Line 

Keyboard Textual Menu 

<G> Draw > Graphic Line 

Pick the  icon on the system toolbar, and select CONTINUOUS type from the pull-down list.  

Move the cursor to the just drawn circle. The circle will get highlighted, and the cursor gain a circle glyph. 

Once so, click , that applies graphics over the whole circle. On a crowded drawing with multiple elements 

near the cursor, snapping may occur to an unintended element. In such cases, the circle can be explicitly 

selected by typing <C> key. This will select the circle nearest to the cursor.  

 

Two possible approaches are available for further construction. In one of them, you could draw five more 

circles, to extrude and subtract them all from the body of the part. Alternatively, extrude just a single circle, 

and then “replicate” the resulting hole by means of the circular 3D array. 

The first approach by steps: 

A handy tool for creating the required number of copies of the circle is the “Create Circular Array” 

command: 
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Icon Ribbon 

 

Draw → Additional → Circular array 

Keyboard Textual Menu 

<XR> Operation > Array > Circular  

 

Once in the command, the system waits for selection of a graphic 

entity. Move the cursor to the image of the hole and click  to 

select the graphic line. That’s all to be selected, therefore, press 

 in the automenu. 

Now the system expects selection of the array center, which must 

be a 2D node. Note that the default setting for the number of 

copies of the circular array is 4, and we need six. Therefore, specify 

the correct parameters in the property window, as shown on the 

diagram at right. 

Now you can select the node. Move the cursor to the center node 

and click . The result will look as on the following diagram.  
 

 

Next, we will need to call the profile extruding command,  

Icon Ribbon 

 

3D Model → Create → Extrusion 

Keyboard Textual Menu 

<3X > Operation > Extrusion 

The system automatically makes a 3D profile from the drawn lines and sets the extrusion vector normal to 

the profile.  
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The amount of extruding, that is, the depth of the hole, can be defined 

in various ways (by a numerical value, by the length of the direction 

vector, etc.). In this particular case, we need to get a through hole, that 

is the one penetrating the entire width of the part.  

In the properties window, set the “First direction” parameter to the 

value “Through all”, by selecting from the drop-down list. In this 

definition, the extrusion amount is determined by the thickness of the 

auxiliary bounding body. Additionally, the created extrusion is 

automatically subtracted from that body. This method of specifying the 

extrusion distance was devised specifically for quick creation of through 

holes in various bodies. 
 

The option of creating a Boolean operation will automatically activate in the automenu: 

 <Ctrl><B> Subtraction 

Since only one body is present in the scene at the time of creating the extrusion, it will be automatically 

selected as the bounding body and the first operand of the Boolean subtraction. 

Upon clicking , two operations will be created at once – an extrusion and a Boolean operation. 

                

The second approach by steps: 

Call the profile extruding command . Specify extrusion length parameter equal to 20 in the reverse 

direction, and confirm the extrusion operation. 
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Next, let’s call the circular array creation command, 

Icon Ribbon 

 

3D Model → Create → Circular array 

Keyboard Textual Menu 

<3AR> Operation > Circular array 

 

In the command's properties window, select the array type – “Array of Faces”. 

The following option will be automatically activated in the automenu: 

 <N> Select Faces to Copy or their boundary Edges or Loops 

Aim the pointer at the cylindrical face of the hole and click . 

 

 

 

If edges or loops highlight instead of the face, then 

you can do any of the following: 

- rest the pointer over the face until the 

multiple selection widget  appears 

next to it. Then scroll through the list of 

elements offered for selection by 

rotating the mouse wheel until you get 

the desired face; 
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- before selecting the face, set up the list of 3D objects 

available for selection (banning from selection anything but 

faces). To do this, double-click  the icon of the faces filter 

. The list of selectable objects can be also set up by the 

drop-down menu of the option : point at the option, 

depress  and hold the mouse button for a second. In the 

appearing menu, disable all flags except “Faces”. 

Once the intended operation is selected, the system expects input of 

the axis of revolution for the array. The axis can be assign by the same 

two 3D nodes as those used in the first method of creating holes. Select 

these two 3D nodes one by one. 

You can define the array parameters in the properties window – 

number of copies and total angle. 

 

 

Press the  button in the automenu to complete the operation. As a result, five new faces will be 

“embedded” in the original body, making up the additional holes. 

Creating a Blend 

The next step is finalizing 3D model creation. This includes creation of a chamfer and a rounding. 

Call the command: 

Icon Ribbon 

 

3D Model → Create → Blend → Edge 

Keyboard Textual Menu 

<3DE> Operation > Blend >Edge  

Pick the following option in the automenu, 

 <E> Select Edge 

The system is waiting for an edge selection. Select two edges in the order shown on the following diagram. 
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Next, specify the operation parameters. Each 

edge can be assigned its specific set of 

parameters in the property window by 

unchecking the “Common Properties” option.  

Select the first edge in the list and specify the 

blending type as Rounding with Radius equal to 

2 mm. For the second edge, define the blending 

type as Chamfer (Offsets), with Offset1 and 

Offset2 both equal to 5 mm. Confirm the 

operation by pressing . The result appears as 

shown on the following diagram. 

 

 

This completes creation of the given 3D model. 
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Creating a Drawing  

Open a 2D window. Do this as follows. Move the cursor to the bottom-left corner of the 3D window and 

locate the split box before the scroll bar. As the cursor approaches the split box, it changes to juxtaposed 

arrows. Press  and dialog box “Views Placement” will appear. Choose  and press [OK]. 

 

The 2D and 3D windows will be located side by side of the vertical split bar. The same result could be 

obtained by calling the command: 

Icon Ribbon 

 

View → Window → Split Vertically 

Keyboard Textual Menu 

<WSR> Window > Split Vertically  

A new window can also be opened with the command: 

Icon Ribbon 

 

View → Window → New Window 

Keyboard Textual Menu 

<WO> Window > New Window 

To activate the newly opened 2D window, place the cursor within and click . 

Now we can generate projections and sections. Call the projection creation command: 

http://g.msn.com/2AD000GN/37000000000210648.1??PID=12303257&UIT=G&TargetID=103039894&AN=270615310&PG=SKYRURU6&ASID=4bf862fe2b2646d4b38ad2420691bf6d&ANID=&MUID=39008DC0D2B167E83F3C8B69D6B165A7
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Icon Ribbon 

 

Draw → 2D Projection 

Keyboard Textual Menu 

<3J> Draw > 2D Projection  

Press the automenu button: 

 <6> Create standard projection 

In the coming dialog box, select “Back View” and press [OK]. 

 

A green box will be displayed on screen, marking the size of the projection to be created. Next, use the 

option: 

 <M> Change Projection Placement 

 

Define the attachment point of the projection in absolute coordinates by clicking  at the desired location 

in the 2D window. Press  in the automenu to confirm projection creation. 

Next, let’s generate a section of the part. 

 

First, we need to do some auxiliary construction. Call the line creation command, 

Icon Ribbon 

 

Draw → Construct → Line 

Keyboard Textual Menu 

<L> Construct > Line  

Pick the automenu option for creating vertical lines, 
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 <V> Create vertical Line 

Point at the center of the circle and click , creating a line along the symmetry axis of the projection. 

 

Then, call the circle creation command: 

Keyboard Textual Menu Icon 

<C> “Construct > Circle”  

Next, we need to reconstruct a construction circle from a graphic circle on the projection. Move the cursor 

to the circle graphic line and click . 

 

Now, we can create the section points snapped to construction line intersections. Call the section creation 

command, 
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Keyboard Textual Menu Icon 

<SE> “Draw > Section”  

Select two intersection points between the line and the circle one by one. Press  automenu icon to 

confirm the section creation. 

  

The next step will be creating a projection of the newly created 2D section. Call the 2D projection creation 

command, 

Keyboard Textual Menu Icon 

<3J> “Draw > 2D Projection”  

In the automenu, select subsequently the following options: 

 <2>  Create section view 

 <L> Select Section defining Projection 

Point the cursor at the section symbol and click . The outline of the section appears rubberbanding with 

the cursor. The projection outline will slide along the projection direction adjusting to the cursor 

movement. To fix the placement, click . 

To complete projection creation, press  in the automenu. 
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If necessary, the projection entities (graphic lines, arcs and circles) can be used as references for 

dimensions, auxiliary graphic lines such as centerlines, and drawing layout attributes.  

 

“FROM DRAWING TO 3D  MODEL”  APPROACH  

Let’s create a 3D model from a 2D drawing. The model will be based on the familiar drawing of a plate with 

a conical hole. This drawing creation was reviewed in details within the brief introductory course of 2D 

design. The following diagram presents the 2D drawing and the 3D model of the plate to be created.  
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The drawing documents are located in the library “…\Examples\Documentation examples. 

Introductory course\ Detail with drawing detailing; Step 1. Plate drawing; Step 2. Hatch and Profile; 

Step 3. Extrusion; Step 4. Rotation; Step 5. Boolean operation”. 

We will pass through several design steps in order to create the 3D model of the plate. The first design 

step includes creation of the workplanes that will further be used for all the rest of 3D element construction.  

In the second step, we will perform extrusion of the defining contour of the plate at the specified depth in 

order to obtain the three-dimensional body of the plate. This will be done by extrusion operation. The next 

design step is creation of the tool body for the conical hole. We will create it using rotation operation. 

Finally, we will use Boolean operation in order to create the three-dimensional model of the plate in its 

final shape. We will subtract the second, tool body, created by rotation operation, from the original body 

created by extrusion. 

The first step in 3D model creation will be creation of the workplanes, as was mentioned earlier. Note that 

the workplanes should be constructed in such a way to maintain projective relationship between the views.  

If not explicitly defined within the drawing, the projective relationship between the views can be 

established by fitting the drawing with associative auxiliary construction.  

The 3D model creation process requires two workplanes. Let’s begin with creating a 2D node defining the 

separation point of the views. To make the node, first create two orthogonal lines. Place these lines as 

shown on the diagram below. 
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Then create the workplanes. 

Call the command: 

Icon Ribbon 

 

3D Model→ Construct → Model 

Keyboard Textual Menu 

<3W> Construct > Workplane  

Set the automenu option: 

 <S> Construct standard Workplane 

In the coming dialog box, press the button [  Front and Right] 

 

The cursor on screen gains the node mark . This mark means the system is now in selection mode. Move 

the cursor to the newly created node to be used for workplane snapping, and click  or type <N>  key. 

Two horizontal workplanes will be created on screen for the main (elevation) and the left side view.  
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Then quit the command by clicking  or pressing  icon in the automenu. One can also type the <Esc> 

key. 

Now we can proceed with creation of 3D auxiliary elements. First, open the 3D view 

window of the T-FLEX CAD system. The 3D view can be opened by clicking on a button 

with a triangular arrow in either the top-right or the bottom-left corner of the current 

drawing window next to the scroll bars. Place the cursor over such a button in the top-

right corner, and click on it with . The current drawing window will be split vertically 

into two windows. One of the windows will be displaying the two-dimensional drawing, 

while the other, 3D view one, reflect the three-dimensional elements and bodies as they 

appear in the process of the 3D model creation.  
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Set the workplanes property Show in 3D View in order to have them displayed in the 3D window. 

To do it, it is necessary to select these planes in the tree of the 3D model, call the context menu with 

the help of   and invoke the command “Parameters” in it. 

To create the main body of the 3D model of the plate, extrude the perimeter contour at the length equal 

to the plate depth. To define the extrusion based on the existing 2D drawing, we need to create auxiliary 

3D elements: a 3D profile and 3D nodes in a special way.  

Let’s create 3D nodes using existing 2D nodes and the workplane mechanism. To create a 3D node, one 

can specify either one node on one workplane, or two nodes on two different workplanes. In the latter 

case, the two nodes must be relatively located as two projections on their respective workplanes of one 

would-be 3D node.  
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Call the command: 

Icon Ribbon 

 

Draw → Construct → 3D Node 

Keyboard Textual Menu 

<3N> Construct > 3D Node  

Next, proceed with selecting 2D nodes. Move the cursor to a node of the first projection of the would-be 

3D node and click  as shown on the diagram below. The 2D node and its workplane will get highlighted.  

 

Normally, upon entering a 3D command, the system expects further user actions. Depending on 

these actions, the system assumes one or another specific mode. This mode usually depends on 

what kind of object was selected by user. The necessary options may automatically be set in the 

automenu depending on the user actions and the specific mode. The user can simply proceed with 

a predefined sequence of actions following the prompts in the status bar.  

Once the first 2D node is selected, the system automatically turns on node creation by two projections: 

 <J> Create 3D Node by two projections 

Once this mode is on, the user will be subsequently prompted to select the first, then the second projection 

2D node, on and on, as he keeps selecting: 

 <F> Set 3D Node 1st projection 

 <G> Set 3D Node 2nd projection 

Move the cursor to the second node, representing the second projection of the 3D node, and click . The 

2D node and the respective workplane, where the selection occurs, will get highlighted. 
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Confirm the 3D node creation by pressing  icon in the top portion of the automenu. The 2D drawing 

elements get de-highlighted, and the newly constructed 3D node appears on the 3D scene.  

Remember that some 3D commands are inaccessible while the 2D view of the current drawing is 

active. To make these commands accessible, activate the 3D view window. To do so, click  

anywhere within the 3D view window. Switching from 3D view back to 2D view is done in the same 

way. 

Let’s create the second 3D node. We are still within the command 3N: Construct 3D Node. Construct the 

second 3D node. To do so, we need to select two nodes as shown on the diagram below.  

 



Brief Introductory Course in 3D Modeling 

111 

To confirm the second 3D node creation, press the  icon in the automenu and exit the command. Two 

3D nodes will be displayed in the 3D window. 

The next step is creation of a 3D profile. We need to establish a relationship between the profile and the 

drawing. Drawing on the active workplane is not available to us since there is more than one workplane 

on one drawing page. Therefore, we will proceed with the 3D profile construction based on a hatch and a 

workplane. First, let’s create the hatch. 

 

Enter the command H: Create Hatch. Create a hatch А on the elevation view. The hatch can be made 

invisible by setting the Fill method attribute of the hatch parameters to Not Visible mode. This is necessary 

for preserving the original look of the part drawing. 

 

 

Now call the command: 

Icon Ribbon 

 

3D Model → Construct → 3D Profile 

Keyboard Textual Menu 

<3PR> Construct > 3D Profile  

The system waits for further user action. Select the hatch А in the 2D window. The contour of the selected 

hatch and the workplane will get highlighted, and the respective profile will appear in the 3D window. 
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Once the hatch is selected, the system enters the mode for constructing a profile based on a hatch, and 

the following option activates in the automenu: 

 <M> Select 3D point for fixing Profile plane 

The 3D node mark  appears next to the cursor. Use the cursor to select one of the 3D nodes in the 3D 

view window. The profile will relocate to pass through the selected 3D node. The node itself and all its 2D 

and 3D construction references will be highlighted.  
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Confirm the 3D profile creation by pressing the  icon in the automenu. All elements in either window 

will then be de-highlighted. We have just created a 3D profile. Quit the command to continue. 

All auxiliary 3D elements have been constructed that are required for a three-dimensional body creation 

by extrusion.  

Let’s create an extrusion operation . The following option will be set in the automenu by default, 

 <R> Select Contour 

 

As we are to use the just created profile as the contour, let’s set up the filters for 3D profile selection. This 

can be done on the system toolbar by   on the desired filter icon as well by clicking  while holding the 

<Ctrl> key. All the rest of the filters will get turned off.  

 

Move the cursor to the 3D window, place it by the profile and point at an edge of the profile. The cursor 

will gain a mark . Click  to select the profile. The profile will be highlighted in the 3D window.  

 

Keep in mind that selection of 3D elements required by 3D commands can be performed either in 

the 3D, or in the 2D view window. This is especially relevant to selection of 3D nodes and 3D profiles 

(contours) that can be selected in the 2D view as nodes and hatches respectively.  

Next, we need to specify direction and the depth of the extrusion. In this example, the depth of the 

extrusion is equal to the thickness of the plate. This dependency can be maintained if the extrusion vector 

is defined based on the existing 3D nodes.  
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Once the 3D profile is selected, turn on the following option in the automenu, 

 <F> Select starting Point of Extrusion 

Several views of the object can be used for specifying a 3D point. Make sure of the correct selection filter 

settings for 3D node selection on the system toolbar or in the pull-down list of active options. 

 

As the cursor is pointed at a 3D node, it gets the node mark . Select the 3D node, which the 3D profile 

plane is passing through. 

 

After selecting the first 3D node, another option will be automatically turned on in the automenu, 

 

 <S> Select ending Point of Extrusion 

Select the second 3D node with the cursor (point and click  as usual). The preview of the current extrusion 

operation will appear on screen.  
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Press the  icon, thus completing the extrusion operation. Quit the command. 

To create a hole in the three-dimensional model of the plate, we need to create the second 3D body. The 

latter will be used in the next step as the tool body for Boolean subtraction from the original extrusion. 

The 3D model of the hole is easiest to create by rotation operation.  

To create a three-dimensional model by rotation, we need to define auxiliary 3D elements: the 3D profile 

and the axis of revolution for rotating the profile. To create the axis, we will need to construct 3D nodes. 

Begin construction by calling the command 3N: Construct 3D Node. Enter the command, and select a 2D 

node as shown on the diagram below, by pointing and clicking . A highlighted 3D node will appear in the 

3D window. 

 

Next, move the cursor to the second 2D node, defining the second projection of the 3D node, and click 

. The highlighted 3D node in the 3D window will move along the Y-axis. 
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Confirm 3D node creation by pressing  icon in the automenu. Highlighting turns off in both windows. 

Create the second 3D node. It is necessary for defining the axis of revolution. The system is still within the 

command 3N: Construct 3D Node. Go ahead with the second 3D node creation. Do this by selecting two 

2D nodes as shown on the following diagram. 

 

After the final selection press the  icon in the automenu, and quit the command. 

The next step is creation of the 3D profile. 

Create a hatch B on the side view of the 2D drawing using the H: Create Hatch command. Make the hatch 

invisible to keep the actual drawing legible. 
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Call the command 3PR: Construct 3D Profile. Use the cursor to select the hatch B. The selected hatch 

contour and the workplane will get highlighted, and a 3D profile appear in the 3D window.  
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Once the hatch is selected, the cursor will gain the 3D node mark  prompting the user for selecting a 3D 

node for locating the contour plane in space. Use cursor to select one of the 3D nodes in the 3D  

 

window. The profile will snap to the selected 3D node.  

 

 

Confirm 3D profile construction by pressing the  icon in the automenu. 

The profile is now created. To continue with the three-dimensional model creation, quit the command. 

We have created all required auxiliary 3D elements for creating the three-dimensional body by rotation 

operation. 

 

Let’s create the rotation operation. Call the command: 
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Icon Ribbon 

 

3D Model → Create → Rotation 

Keyboard Textual Menu 

<3RO> Operation > Rotation  

Once within the command, the following default option is set in the automenu: 

 <R> Select Contour 

Various elements can be used as a contour for rotation operation. We will use a 3D profile created 

specifically for this purpose. Before selecting a profile, check on the system toolbar or in the pull-down list 

that the selector filters are set correctly. 

As the cursor approaches the 3D profile, it gains the profile mark . To select the profile, click . The 

profile will be highlighted in the 3D window.  

 

Next, define the axis of revolution by selecting two 3D nodes.  

Set the following option in the automenu, 

 <F> Select 1st Point of axis 

Move the cursor to a 3D node as shown below, and click . 
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The option will activate in the automenu thereafter: 

 <S> Select 2nd Point of axis 

Move the cursor to the second 3D node defining the axis of revolution, and click . The body to be created 

will appear as a wireframe preview in the 3D window. The icon  becomes accessible in the automenu, 

meaning that the rotation operation can now be completed. Before finishing operation, you need to 

choose «Subtraction» from Boolean operation pull-down list. 

 <Ctrl><-> Substraction 

 

Confirm rotation by pressing  icon in the automenu. 

The following three-dimensional image will appear in the 3D view window. 
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We have just created two simplest 3D bodies, an extrusion and a body of revolution. Tool body of 

revolution was subtracted from the original extruded plate. 

You can find more information about Boolean operations in the chapter Boolean operation 

In the three-dimensional model creation, we were using two-dimensional parametric elements of the T-

FLEX CAD system as references. Therefore, parametric modifications of the two-dimensional drawing will 

drive parametric modifications of the three-dimensional model. 

 

Modify one or more dimensions on the 2D drawing using the command EC: Edit Construction, or V: Edit 

Variables.  
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Then call the command: 

Icon Ribbon 

 View toolbar →  

Keyboard Textual Menu 

<3G> Tools > Regenerate  

This will cause recalculation of the 3D model geometry, and the model will adjust to the latest modifications 

made on the 2D drawing. 
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WORKING WITH THE 3D VIEW WINDOW 

The 3D view window (the 3D window) is one of the main system tools for working with the 3D model. It is 

used for the 3D scene rendering. The 3D window serves for viewing the model being created, as well as 

for selection of 3D objects for performing various manipulations with them (getting information about the 

selected object, editing, using as a base reference when creating operations and 3D constructions). 

WHAT IS  "3D  SCENE"?  

3D scene is the entirety of all 3D objects (3D bodies and 3D constructions) that are present in the model. 

The size of the 3D scene is determined by the minimal cube fitting all 3D elements. When determining 

dimensions of the cube, the invisible 3D objects hidden from display by various methods are also included 

in the account. 

Objects in the 3D scene are viewed using cameras. The camera that feeds the image in the 3D window, is 

called the active camera. By default, only the system camera is present in the model, which is located 

beyond the limits of the 3D scene. This is what is normally used to view the 3D scene. In most cases, just 

the system camera is enough for working with the 3D model. The position and orientation of the system 

camera can be controlled. The system camera cannot be deleted, neither can it be moved inside the 3D 

scene (the distance from the camera to the center of the 3D scene cannot be made less than half the 3D 

scene size). 

In certain cases (for example, when surveilling inner parts of complex 3D models or when creating 

animation clips) the capabilities of just the system camera may not suffice. In such cases, the user can 

create and use one's own cameras for setting up a view in the 3D window. Custom cameras are attached 

to local coordinate systems (LCS). An LCS position determines a camera position. The respective section of 

this chapter is devoted to working with custom cameras. 

THE METHODS OF THE 3D  SCENE RENDERING  

Visualization of 3D objects in the 3D view window can be done by various means (as a wireframe model, 

as solids, etc.). The 3D objects themselves do not change in this case, rather, their rendering method is 

changing. 

There are the following visualization methods: 

 Wireframe - all three-dimensional bodies are displayed as a framework of their member edges. The 

method is convenient in that the background elements are not obstructed by the foreground ones. 

One can also see the objects located inside the body. This property is used when selecting construction 

elements for performing operations. 

 Shading - all three-dimensional bodies are rendered in a specific color defined for each body. 

 Rendering - all three-dimensional bodies are rendered with an account for the specifics of the selected 

material, whether for the entire body or assigned to a particular face. 
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 Wireframe with hidden lines removal - the 3D window displays the 3D model wireframe without invisible 

lines. The fast algorithm of finding line visibility is used.  

 Wireframe with precise hidden lines removal - the wireframe model is displayed in the current position, 

without the invisible lines. This mode can be used only with the orthographic (parallel) projecting 

method. 

             

The selected visualization method is applied by default to all elements of the 3D scene.  

Note that a visualization method is a characteristics of the 3D window, and does not depend on the 

camera used (whether the system or a custom one). That means, the visualization method assigned 

to a 3D window is maintained even when switching the active camera (that is, the one used at the 

moment for viewing the 3D scene). 

The wireframe mode can be also assigned to individual 3D Bodies or operations. Such 3D object will be 

rendered in the wireframe mode always, regardless of the visualization method set for the 3D window. The 

sticky wireframe mode can be turned on by adjusting parameters of the respective 3D Body or 3D 

operation (see the chapter "General parameters of 3D elements"). 

For shading and shading with materials it is possible to additionally enable the mode of semitransparent 

viewing. When using the semi-transparency, the 3D model is displayed according to the rules of the main 

method of visualization but all faces of the bodies in the 3D scene become semitransparent. 

 
Shading with 

materials 

Shading with 

materials  and 

semitranspare

ncy 

 Shading Shading and  

semitransparen

cy 

Transparent view can be enabled individually for any  Body of the model. But such a Body will be displayed 

as transparent only when the mode of shading with materials is used. The transparent view can be enabled 

in the dialog of parameters of the Body or in the dialogs of parameters of operations included into the 

history of creation of the given Body (see the “General Parameters of 3D Elements” chapter).  

Moreover, there is a possibility to make transparent the individual faces of Bodies. This can be done with 

the help of the 3AM: Apply material command. Transparency of faces is also visible only in the mode of 

shading with materials. 
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WORKING WITH THE SYSTEM CAMERA FOR SURVEILL ING THE 3D  

SCENE  

Projecting Method 

The appearance of the 3D scene in the 3D view window depends, besides the specified visualization 

method, on the projecting method used by the system camera. The projecting method determines, how 

the camera will be showing objects in the 3D scene: without respect to the distance from the view point 

and the field of view angle - by the orthographic (parallel) projection, or by accounting for those parameters 

- the perspective projection. 

  

Orthographic (parallel) projection Perspective projection 

A projecting method, unlike a visualization method, is a characteristic of the particular used camera, 

rather than the 3D window. When switching the active camera (for example, switching from the 

system camera to a custom one), the image generation in the 3D window will account for the new 

active camera projecting method. 

Controlling the System Camera. Rotating (Spinning) and Moving a Camera 

Initially after opening the 3D window, the system camera is located at the distance providing visibility of 

all elements of the 3D scene (that is, all 3D constructions and 3D Bodies present in the model). To view the 

3D scene, you can rotate (spin) and/or move it arbitrarily, zoom in and out, change the orientation and 

view direction, as well as scale the image in the 3D window. 

As the user watches the 3D window in the process of spinning (rotating) and moving the system camera, 

one feels as if the 3D scene itself is moving, rather than the camera. Therefore, when describing 3D model 

handling in the future, we will often refer to the process of rotating (spinning) and moving the system 

camera as the 3D scene rotation. 

Camera's center of rotation 

Rotating the image in the 3D window with the default system camera active is achieved by moving the 

camera about the scene center. If necessary, the center of rotation can be changed. The following can be 

selected as the new rotation point: 

 An operation's center of mass; 
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 An arbitrary point in the 3D scene. The center of rotation will be the intersection of the ray passing 

through the selected point perpendicular to the screen plane with the face or edge (in the case of the 

wireframe display) of some 3D Body or any 3D construction element nearest to the camera. If the ray 

does not cross any of the 3D objects, then the center of rotation stays unchanged; 

 The 3D scene center (whenever necessary to return to the original center of rotation). 

System camera rotation modes 

There are the following system camera rotation modes: 

 Free rotation. This mode is preset by default. In this mode, a 3D camera can be rotated in an arbitrary 

direction about the rotation center; 

 Rotation about one of the axes of the coordinate system located at the center of the camera's rotation. 

the direction of the rotation coordinate axes can be: 

̵ Coincident with the direction of the global coordinate system axes (rotation with respect 

to the global coordinate system), 

̵ Defined by the coordinate system of the 3D window itself (rotation with respect to the 

window coordinate system) - one axis being directed perpendicular to the screen plane, 

the two others lying in that plane (one - vertically, the other - horizontally). 

 Panoramic rotation. In this mode the plane of the Z-axis is fixed. This mode creates the effect of viewing 

the room-scene with a video-camera which cannot be inclined (the Z-axis in this case plays a role of 

the vertical axis of the room). The mode of the panoramic rotation can be useful when working with 

the models of buildings, furniture, interiors etc. 

Automatic Rotation 

Automatic Rotation can be performed in any of the above-listed modes of the system camera rotation. To 

activate the automatic rotation mode, specify the direction and speed of rotation. Before terminating the 

automatic rotation mode, the system camera rotation command with such parameters will be repeatedly 

sent to the 3D window, which add the inertia effect to the 3D scene rotation. 

Auto-Resize 

Auto-Resize is a 3D window mode, when the system camera's parameters are automatically updated upon 

each 3D model regeneration, so that the entire 3D scene is visible. 

CL IP PL ANE  

Use a clip plane as a handy visual examination tool for inner body parts. It is a plane, which can move along 

the specified direction and “slash” objects in the scene. The cut-off part of bodies is not displayed. No new 

bodies are created in this case. As the camera rotates, the orientation of the clip plane changes together 

with the changes in the scene position. 
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The resulting body section can be transparent (this would allow looking inside the body) or can be filled 

with blue color (if you need to examine the shape of the section). 

          

The clip plane is not displayed by default. If necessary, the clip plane can be made invisible. It will appear 

as a small rectangle indicating the position and orientation of the clip plane. 

 

L IGHT SOURCES  

Illumination of bodies in the 3D scene is provided by light sources. Light sources can be divided into two 

main types: 

 Stationary sources created by the user in the command 3L: Create Light Source. Such light sources are 

independent of the used camera and its position. How to create stationary light sources will be 

described in details in the “Light sources” chapter of this manual; 

 Dynamic light sources, “mounted” on the active camera. The position of such light sources is defined 

relative to the active camera. When moving/rotating the active camera, the light sources will be also 

changing their position.  

Dynamic light sources, as well as the visualization method, are characteristics of the 3D window, 

that does not depend on the used camera (whether the system or a custom one).  

By default, there are two light sources in the 3D window attached to the active camera, an ambient light 

source (which uniformly illuminates the entire space of the 3D scene) and a directional source of white 
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light, located on the camera. If necessary, the user can change their parameters (color, intensity, and, for a 

directional light - the position with respect to the camera), as well as manually create additional dynamic 

light sources.  

Creation and editing of light sources attached to the active camera is done in the special 3D view 

parameters dialog. You can also specify there the background color of the 3D window (the background 

color does not depend on the light sources present in the 3D window). The user can select any color as the 

background according to one's preferences. You can use a transitional background color (with a smooth 

change from one color to another). 

WORKING WITH MULTIPLE 3D  W INDOWS  

When working with a 3D model, the user can open several 3D windows simultaneously. Individual 

parameters can be assigned to each of the open 3D windows: the visualization method, the orientation 

and view direction of the active camera, the background color and number of light sources on the active 

camera, the image scale, etc. 

 

Division of the window of the document into parts can be fixed for subsequent sessions of work with the 

document. To do so, it is sufficient to enable the “Fixed set of windows” parameter in the dialog of the ST: 

Specify parameters of document command (the “Miscellaneous” tab) and save the document. When the 

document is opened next time, the window will be partitioned in the same way as it was at the moment of 

saving the document after enabling the aforementioned parameter. It will be impossible to modify the 

view of the window of this document. 
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USING 3D  V IE WS  

You can use the system preset 3D views for quick setup of a 3D window. 3D View is a set of information 

about a 3D window, including information about the parameters of the used camera, about the light 

sources attached to it, the current rendering method, etc. 

When loading one of the 3D views stored in the system, into the current 3D window, the 3D window is 

automatically set up according to the data of this 3D view. 

The user can edit 3D views present in the system, adding to those unique sets of data about the state of 

the 3D window. 3D views are handled in the special 3D view parameters dialog. 

MANAGING 3D  W INDOW  

Use the commands located in the “View” textual menu to manage the 3D window and the 3D scene display 

in it. Commands are grouped according to their purpose. Some of the commands are also available on the 

same-name “View” toolbar. 

There is yet another way to call these commands. Point the mouse to a free space of the 3D window and 

right-click . The coming up context menu will contain all commands for managing the 3D window. The 

state of the context menu icons informs you about which mode of a particular command is currently active. 

 

Defining a Visualization Method 

To define a visualization method, use the commands: 

Keyboard Textual Menu Icon 

<3VW> View > Render > Wireframe 
 

<3VS> View > Render > Shading 
 

<3VD> View > Render > Render 
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<3VH> 
View > Render > Hidden Line 

Removal  

<3VZ> 
View > Render > Precise Hidden 

Line Removal  

<3VM> 
View > Render > 

Semitransparent View  

Every method uses additional parameters. You can define those parameters in the 3D view parameters 

dialog described in the respective section of this chapter. 

Rotating and Panning the 3D Scene 

When working with a 3D model, the most commonly used is the free rotation mode; therefore it is preset 

in the 3D window by default. The camera can be moved around the rotation center by simply dragging the 

mouse with the  depressed within the 3D window.  

You can also use the keyboard for rotating the 3D scene. The <Left>, <Right>, <Up>, <Down> keys make 

the 3D scene rotate in the respective directions. You can rotate the camera about its own axis using the 

<PageUp>, <PageDown> keys. When the <Ctrl> key is pressed, all these keys work in the fast rotation 

mode. 

The speed of rotation for the normal and fast modes is set up in the Customize > Settings command 

on the “3D” tab. 

By using  while holding down the <Ctrl> key, you can move the camera in the plane parallel to the screen. 

In this way, the center of rotation moves together with the camera.  

To change the image scale ratio, use  with <Shift>. By moving the pointer up the screen, you zoom out 

of the image, by moving down - zoom in. 

 This process is similar to the function of a real camera. The camera, however, stays still. Only the 

focal length of its objective lens changes. 

If your mouse has a wheel, then you can control the degree of zooming on the image by spinning the 

wheel. Dragging the mouse with the wheel depressed moves the camera in the plane parallel to the screen 

plane. 

Rotation about one axis can be activated by using one of the following commands in the View > Rotate 

textual menu or the same-name item of the context menu in the 3D window: 

Keyboard Textual Menu Icon 

<3RX> View > Rotate > Around X axis 
 

<3RY> View > Rotate > Around Y axis 
 

<3RZ> View > Rotate > Around Z axis 
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Calling any of those commands results in assuming the mode 

of rotating about the selected axis. Switching the axis, about 

which rotation is performed, is done by the same commands. 

You can judge which axis is currently used by the state of the 

respective icons in the textual or context menu. 

Orientation of the rotation coordinate axes is determined by 

the state of the command 3RS: Toggle between 3D Scene 

Rotation Modes: 

 

 

Keyboard Textual Menu Icon 

<3RS> 
View > Rotate > Screen 

coordinate system  

 

When this command is active, rotation occurs in the window coordinates, when off - the orientation of the 

rotation coordinates coincides with the global coordinate system. This command activates automatically 

when switching to rotation about one axis. Therefore, by default rotation occurs in the window coordinates. 

You can judge the state of the command by its icon in the textual or context menu. 

Rotating the 3D scene about one axis is done in the same way as in the free rotation -- using  or the 

keyboard. The difference will be only in that rotation will occur only about one selected axis of the camera's 

rotation coordinate system upon any mouse movement or control key strikes. 

To return to the mode of the free camera rotation, use the command: 

Keyboard Textual Menu Icon 

<3RF> View > Rotate > Free  

The mode of fixed direction of the sight is enabled with the help of the 3RL: Fix direction command. It can 

be invoked from the text menu “View > Rotate” or with the help of the context menu in the 3D window: 

Keyboard Textual Menu Icon 

<3RL> View > Rotate > Fix  

When this mode is enabled, the direction of the sight gets fixed, i.e., rotation of the 3D scene is impossible. 

But it is possible to scale and translate the contents of the 3D scene. This setting is saved in the current 

document and active during subsequent sessions of work with it. 

To turn off the mode of the fixed direction, it is required to select any other mode of rotation of the 3D 

scene. 

The command 3RP: Rotation panoramic: 
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Keyboard Textual Menu Icon 

<3RP> View > Rotate > Panorama  

In this mode the plane of the Z-axis is fixed. This mode creates the effect of viewing the room-scene with 

a video-camera which cannot be inclined (the Z-axis in this case plays a role of the vertical axis of the 

room). The mode of the panoramic rotation can be useful when working with the models of buildings, 

furniture, interiors etc. 

Use the following additional commands for quick manipulations with the orientation and scale of the 3D 

scene display: 

Keyboard Textual Menu Icon 

<F3> View > Scale > Zoom Area 
 

<Ctrl><Shift> 

<PgUp> 
View > Scale > Zoom In 

 

<Ctrl><Shift> 

<PgDn> 
View > Scale > Zoom Out 

 

<Ctrl><Shift> 

<Left> 
View > Scale > Pan Left 

 

<Ctrl><Shift> 

<Right> 
View > Scale > Pan Right 

 

<Ctrl><Shift> 

<Up> 
View > Scale > Pan Up 

 

<Ctrl><Shift> 

<Down> 
View > Scale > Pan Down 

 

<Ctrl><Shift> 

<Home> 
View > Scale > All Objects 

 

<Ctrl><Shift> 

<End> 

View > Scale > 

Maximize  

 View > Scale > Actual Size 
 

 View > Scale > Previous 
 

A detailed description of working with these commands is available in the “Main Concepts of System 

Operation” chapter of the “Fundamentals. Two-Dimensional Design” guide. 

Defining the Center of the 3D Scene Rotation 

To define the center of camera rotation, use the command 3RC: Select Center Of Rotation: 
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Keyboard Textual Menu Icon 

<3RC> 
View > Rotate > Set center of 

rotation  

After the call, the current camera rotation center appears on the screen as a crosshairs. The following 

options become available in the automenu: 

 <P> Select any point as rotation center 

 <O> Select center of solid as rotation center 

 <D> Select center of scene as rotation center 

To select the center of mass of a 3D operation as the center of rotation, simply activate the option , 

and then select the desired operation. The crosshairs marking the rotation center will move to the center 

of mass of the selected body. 

The option  allows specifying an arbitrary point as the center of rotation. For this, after selecting the 

option, simply pick the desired point (using ) in the 3D window. If the ray passing through the given point 

perpendicular to the screen plane crosses some 3D object, then the center of rotation will be carried over 

to that point. 

To return the camera rotation center to the 3D scene center, simply click . 

It is possible to define arbitrary center of rotation without calling 3RC: Select Center of Rotation command. 

This can be done by pressing  without releasing for some time at any object within 3D scene. The special 

marker-cross will appear at the specified point. This marker signals about setting the position of the new 

temporary center of rotation. After finishing the rotation (when mouse button is released) center of rotation 

returns to the original position. 

Activating Automatic Rotation (Spinning) of the 3D Scene 

To activate automatic rotation, call the command 3RA: Automatic Rotation: 

 

Keyboard Textual Menu Icon 

<3RA> 
View > Rotate > Automatic 

Rotation  

To define rotation parameters, depress  and, while holding it, drag the mouse in the rotation direction. 

After that, release . In that way, you define the direction and angular rotation velocity. 

The automatic rotation mode is switched off by a repeated call of the same command. 

Defining the Method of Projecting the System Camera 

Use the following commands to select the method of projecting the system camera: 
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Keyboard Textual Menu Icon 

<3VO> View > Projection > Parallel 
 

<3VE> View > Projection > Perspective 
 

Parameters of each projecting method are defined in the dialog of the current 3D view parameters. 

Working with this dialog is described in the “3D view parameters” section of this chapter. 

Auto-Resize 

To enable or disable the auto-fitting mode of the 3D scene, use the command 3VA: Auto-Resize 3D Scene: 

Keyboard Textual Menu Icon 

<3VA> View > Auto-Resize  

The auto resize mode will be active until the second call of this command. 

Working with a Clip Plane 

To activate a clip plane, use the command 3CL: Enable Clip Plane: 

Icon Ribbon 

 

View → Clip plane → Active 

Keyboard Textual Menu 

<3CL> View > Clip plane > Active 

A repeated command call turns off the clip plane. 

 

To define the clip plane position, use the command 3CS: Set Clip Plane Position: 

Icon Ribbon 

 

View → Clip plane → Set 

Keyboard Textual Menu 

<3CS> View > Clip plane > Set 

Calling this command sets the plane parallel to the screen and activates it. 

 

The position of the active clip plane (the distance from it to the view point) can be modified without calling 

additional commands, using the  together with the simultaneously pressed <Ctrl> and <Shift> keys. By 

moving the pointer up the screen, you move the plane “deeper” into the scene, and vise versa. 

To reveal the clip plane in the 3D scene, call the command 3CD: Show Clip Plane Position: 



Working with the 3D View Window 

135 

Icon Ribbon 

 

View → Clip plane → Draw 

Keyboard Textual Menu 

<3CD> View > Clip plane > Draw 

Repeatedly calling the command will remove the clip plane image from display. 

Defining All 3D View Parameters in One Dialog 

Use the convenient dialog of the 3D view parameters for quick setup of the 3D window, when you need to 

change its several characteristics simultaneously (for example, the visualization method, the orientation, 

the view direction and the method of projecting from the system camera, etc.). Some of the 3D view 

parameters (for example, the background color, the parameters of light sources on the camera) can be 

defined only in this style dialog. 

To call the dialog of the 3D view parameters, use the command 3VP: Set View Parameters: 

Icon Ribbon 

 

View → Properties 

Keyboard Textual Menu 

<PW> View > Clip plane > Properties 

After calling the command, a dialog window appears, which contains all current 3D view parameters. 

The 3D window contents preview pane is on the left-hand side of the dialog window. It displays all the 

same as in the master 3D window, but smaller. You can work with the image in the preview pane in the 

same way as with the image in the 3D view window: spin, pan, zoom. To quickly view the contents of the 

3D scene, you can use the [View All] button - clicking it scales the image in such a way that all contents of 

the 3D scene are visible. All manipulations made in the preview pane will be also applied to the image in 

the 3D view window (after closing its parameters dialog). The size of the 3D view properties dialog can be 

increased by moving the window boundaries with the cursor of the mouse when  is being pressed.  

The “Show Coordinate System” flag can be used for disabling the coordinate system display in the 3D 

view window. The displayed size of the global coordinate system in the 3D window is defined in the 

command SO: Set System Options (the “3D” tab). 
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The Background group of parameters defines the background color of the 3D view window. To achieve a 

smooth transition of colors, set the Gradient to flag and specify two colors by selecting from drop-down 

lists. Clear the flag in order to make the 3D view window background monochrome. In such a case, specify 

just one color (the Background color). 

The Use background texture flag is used to enable/disable the mode of using the texture as a background 

of the 3D view window. When the flag is disabled the 3D view window has the color that is specified in the 

background parameters. 

The Use environment texture flag is used to enable/disable the mode of using the texture as environment 

for 3D model. When the flag is disabled the specified texture will be suppressed. 

The group of parameters in the lower-left corner of the dialog window is provided to manage light sources 

attached to the active camera in the 3D scene. This group includes the list of dynamic light sources existing 

in the current 3D window, buttons for adding/deleting light sources attached to the camera, as well as 

control elements for defining parameters of each of the light sources. 
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To edit parameters of an existing light source, select this 

source in the drop-down list. Control elements located below 

the list allow changing the brightness of the selected light 

source (using the slider or numerically), as well as its color. 

The selected light source can be deleted by clicking the 

button . Clicking the  button creates another 

directional light source attached to the active camera. 

The position of the selected light source with respect to the 

camera is defined using sliders located at the right and below 

the viewing pane of the 3D window contents. By default, 

dynamic light sources are placed directly on the camera (the 

sliders being positioned in the middle of their respective 

scales). By moving the sliders away from the center of the 

scale, one can move light sources right/left and up/down 

with respect to the camera. The  button brings the light 

source back to the camera. 

 

 

The method of the 3D scene rendering in this 3D window is defined using 

the View Style group of parameters. The drop-down list lets you select the 

desired method, while the  button serves for defining additional 

parameters of each mode. Clicking this button brings up the “Options” 

dialog, which specifies the requirements on drawing various lines of the 3D 

model - edges, outline (silhouette), hidden lines - for each visualization 

method. 

 

The View point, Projection and Offset groups of parameters define the view direction and the method of 

projecting from the system camera, as well as its distance from the center of the 3D scene. In the parallel 

projecting method, the camera distance is defined by the Scale parameter. This parameter defines the 

degree of zooming on the image in the 3D scene. 

In the perspective projection, the camera distance can be defined either by the field of view angle of the 

3D scene, or directly by the distance between the camera and the center of the 3D scene. All three 

parameters are defined numerically. Additionally, the scale and the field of view angle can be controlled 

using the mouse, directly in the preview pane of this dialog, similar to the way it is done in the 3D window 

itself when moving/rotating the camera. The Offset parameter defines the horizontal and vertical shift of 

the 3D scene center with respect to the camera. 

The Views group of parameters, located in the lower-right corner of the dialog, serves for quick setup of 

the 3D window state. The Standard drop-down list lets you changing the view direction of the system 

camera according to one of the engineering drafting standards (for example, Front (elevation) View, Back 
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View, Left (side) View, etc.). For this, simply select the desired scene orientation in the list. The Custom 

drop-down list serves for handling 3D views preset in the system.  

A 3D view can be loaded (that is, the 3D window set up according to the information stored in the 3D 

view), saved (by writing 3D View information about the current state of the 3D window) and renamed (by 

simply changing the name, under which the given set of information is stored in the system). To load a 3D 

view, select this 3D view in the list and click the [Load] button. Clicking the [Save] button writes information 

about the current state of the 3D window in the 3D View selected in the “Custom” list. Clicking the 

[Rename…] button calls an additional dialog for defining a new name for the selected 3D view. 

RULERS IN 3D  WINDOW  

When working in 3D window the Show > Hide rulers command becomes available. This command can be 

invoked from the text menu «Customize > Windows». It is also available in the context menu that can be 

invoked upon pressing  and indicating one of the toolbars. 

Rulers allow us to orient ourselves in 3D space, estimate the size of a model and distances between the 

elements of a model. Coordinates displayed on the rulers constitute the coordinates on the imagined plane 

parallel to the plane of the screen. 

Also with the help of rulers of 3D window it is possible to create, in transparent mode, the new workplanes 

and edit location of already existing workplanes. This will be described in more detail in the “Workplanes” 

chapter of this user’s manual. 
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WORKING WITH CUSTOM CAMERAS  

Creating and using custom cameras will be described in details in the “Cameras” chapter. Here we will just 

describe general techniques of working with them. 

Custom cameras are used in the cases, when the system camera is not sufficient. In such a case, the user 

can create one's own cameras in order to get the desired effect - for example, for surveilling inner parts of 

complex 3D models or creating animation clips.  

The position of a custom camera is defined using an LCS. This same LCS defines the viewing direction for 

a custom camera. A number of parameters are defined for a camera, which define the image it yields (for 

example, the projecting method). 

To view the 3D window from the custom, rather than the system camera, select the custom camera as the 

active camera of the given 3D window. This can be done in the command 3VC: Select Camera. 

Icon Ribbon 

 

View → 3D Model → Select Camera 

Keyboard Textual Menu 

<3VC> View > Camera 

 

After calling the commands, the “Select Camera” dialog window appears, which contains the list of all 

cameras present in the current 3D model. In it, select the camera that will be used for viewing 

(surveilling) the 3D scene. 

When working with multiple 3D windows, an individual active camera can be specified for each 

window.  
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While working with a custom camera, you can use auto resizing of the 3D scene image, using clip plane, 

modify existing and create new light sources on the camera. How to move and spin the active custom 

camera is described in details in the “Cameras” chapter. 

Working with the 3D view parameters dialog is similar to the described case of using the system camera, 

with one exception: the parameters pertaining to the active camera will not be available for editing in the 

dialog. In the case of custom cameras, these parameters are defined in the parameters dialog of the camera 

itself.  

You cannot modify parameters of the active custom camera. If necessary, first select another camera 

as the active one (system or custom). 
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GENERAL PARAMETERS OF 3D ELEMENTS 

Similar to the 2D elements, each of the 3D elements has a certain set of parameters. Some of these 

parameters are common to all objects in the system, regardless of their dimension; others are specific to 

the 3D elements, while yet other parameters are only inherent to specific types of objects. To skip the 

description of the general parameters in each chapter, we will do it once, while reviewing only the specific 

parameters in the respective chapters. 

«GENERAL»  TAB IN D IALOGS OF PARAMETERS OF 3D  OPERATIONS  

The dialogs of parameters of all 3D operations contain the identical tab called “General”. The set of 

parameters of this tab includes nonspecific parameters of the given operation and parameters of 

visualization of the Body in the generation of which this given operation is involved. 

Parameters of visualization of a 3D image (level, layer, material, image quality) are specified for the 

entire Body. Therefore, the values of the parameters of visualization on the “General” tab will be 

identical for all operations that are included into the history of creation of the given Body. 

When viewing the properties of the Body itself (the “Properties” command in the context menu of 

the tree of the 3D model), the dialog of parameters of the last, in the history of the given Body, 

operation is. 

 

The “Operation” group: 
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 Operation name – the name of the 3D operation for which the dialog of parameters is invoked; 

This name is used for selection of the desired element from the list. The user can specify the 

name independently. In this case the system only keeps track of the uniqueness of the entered 

name. If the user does not specify the name, the system generates its own name consisting of 

the name of the element and the element's identification number. The default names for each 

type of elements are described in the file Opernames.ini. 

 Suppress – this option is responsible for exclusion of the given operation from 3D model 

recalculation. The suppressed operation is not shown in the 3D scene. It is advantageous to 

use the given parameter during the stage of forming the individual parts of complex 

assemblies. The user can temporarily suppress the elements that have already been worked on 

and work with those elements which are required for further constructions. A real variable can 

be used as the value of the given parameter. The operation will be suppressed if the value of 

this variable is not equal to zero; 

The “Body” group: 

 Body name. The name of the Body in generation of which the given operation takes part. 

 Level, Layer – common to the system parameters of the Body.  

Quality. Parameter that defines the quality of 3D images of the Body. It defines the degree of 

discretization of the model into the grid of planar triangular faces when showing the image in 3D 

window. From the drop down list it is possible to choose the predefined sets of parameters that 

define the quality of the mesh: 

 Ultra coarse; 

 Extra coarse; 

 Coarse; 

 Standard 

 Fine; 

 Extra Fine; 

 Ultra Fine;  

 Dedault (Standard) – the values for model discretization parameters are taken from the 

Customize > Document Parameters command (the “Image quality” parameter on the “3D” 

tab); 

 Source operation – the values for model discretization parameters are taken from the 

parameters of the operation that is a parent with respect to the operation indicated in the 

given dialog of parameters 
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 User-defined – the values for model discretization 

parameters are specified by the user. Additional button 

[…] invokes the dialog window for specifying the user-

defined values of model discretization parameters (in 

units of a model). In the mesh parameters dialog it is 

possible to specify your own values of: allowance by 

edge, face precision and angular allowance.   

The higher quality of model image increases the number of planar faces and slows down the work 

for large models or insufficiently productive video-cards. It is recommended to make the model 

image quality as low as possible.  

When reading the models of the previous versions, the system automatically selects new parameters 

of the quality. In certain situations the automatically assigned quality can turn out to be lower or 

higher than the expected one. In these cases it is recommended to change it manually by selecting 

the corresponding value of the quality in the parameters of the document (the “3D” tab in the 

Customize > Document Parameters command) or in the parameters of the Body. The number of 

triangles that a specific model is discretized into, when a particular value of the mesh quality 

parameter is specified, can be determined with the help of the Display graphics performance data 

option in the the 3D > Graphics Settings tab of the Customize > Options command. 

 Transparency. The flag, scroll bar and the field for editing the transparency value. 

 View as wireframe. When using this option, the body will be displayed in the wire-frame view 

mode. 

 Hide – this option allows us to hide the Body in the 3D scene without excluding it from the 

recalculation of the model. 

All parameters in the “Body” group are accessible for editing only in the case when the current 

operation is uniquely linked with the Body. If the given operation generates several different Bodies, 

parameters of the given group are not accessible. 

Parameters of the Material group allow us to make virtual models appear like a real product when the 

“Shading with Materials” visualization mode is used: 

 Source — parameter which determines from where the material is taken. The possible variants 

are: 

̵ Body. Parameters are specified in the current Body; 

̵ Source operation. Parameters are inherited from the source operation; 

̵ Current operation. Parameters are specified in the current operation. This option is 

introduced to provide compatibility with the previous versions; 

 Color — color of the Body in the modes “Wireframe view”, “Shading”, “Viewing with removal 

of invisible lines”, “Viewing with precise removal of invisible lines”.  
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 Main material - material of the Body used for evaluation of the mass inertial characteristics 

and engineering analysis. It is also used for determining parameters of the model view in the 

3D window if an additional material of the “outer cover” is not specified. It can also be specified 

as a text variable. 

 

The value of such a variable constitutes 

the name of an existing material. When 

the variable is created directly in the 

window of the operation's  parameters, 

the list of possible values of the given 

variable is created simultaneously. This 

list contains all materials used in the 

given model. 

 

If the model is used as a 3D fragment, the material of the fragment can also be controlled with 

the help of  such a variable. 

 Coating. Additional parameter for specifying parameters of the model view in the 3D window. 

It allows us to specify the material that is different from the main material to use it for the 

purpose of visualization. In this case, the main material will still be used for engineering 

calculations. To specify the material of the outer cover, the corresponding flag must be 

enabled. The material can also be specified as a text variable. 

 Show only materials of a model – auxiliary parameter that controls the structure of the 

materials selection list when working with the dialog of operation's parameters. If this flag is 

enabled, the “Name” list will show only those materials which were used in the given model. 

Material – is also an element of the 3D system. It contains the list of characteristics of the real 

material which we encounter in real life. The “material” element has parameters such as density, 

reflexivity, transmittivity and so on. All this is described in more detail in the special chapter 

devoted to this issue.  
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“GENERAL”  TAB IN DIALOGS OF PARAME TERS OF 3D  CONSTRUCTION 

ELEMENTS  

In the dialogs of parameters of 3D construction elements on the  “General” tab there are the following 

common parameters: 

 

Level. The value of the visibility level. It allows controlling the visibility of various elements. 

Color. Element color.  

Layer. The name of the layer to which the element belongs. 

Name. If the user skips assigning a name, then the system generates its own name consisting of the 

element type and a through ID number. The default names for each element type are described in 

the file Opernames.ini. For example, the generated workplanes names are: Workplane_0, 

Workplane_27, etc.  

 “TRANSFORMATION”  TAB  

This tab contains information about the current object transformations.  

A set of various transformations can be defined for any 3D object that will modify its original position in 

the space (the detailed description of handling transformations is available in the chapter “Assigning 

"Transformations" to 3D Entities”).  
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“Offset/Rotation”-type transformation is defined by default for any 3D element with zero parameter 

values. It is initiated automatically at the element creation. A number of additional transformations 

are automatically defined for 3D fragments and Parts. 

Additional transformations can be defined by two ways: by using the command “3EG: Transform Element” 

or directly on the discussed tab of the object parameters dialog box. The two ways are equivalent. The 

transformations defined by the command “3EG: Transform Element” will be displayed and accessible for 

editing in the parameters dialog box of the current object. Vice versa, any changes done to the set of a 3D 

object transformations in the tab “Transformation” of the parameters dialog box will be accessible for 

future editing in the command “3EG: Transform Element”. 

The main difference between using the specialized command and the parameters dialog box is as follows. 

When creating a new transformation via the parameters dialog box, the reference elements of the 

transformation (axis, vector, point, coordinate system referenced by the transformation) are defined by the 

system automatically. When working in the command “3EG: Transform Element”, you can define arbitrary 

reference elements manually. 

 

The list of the existing transformations is displayed in the upper-left corner of the tab. The rest of the fields 

display the parameter values of the current (selected in the list) transformation. The buttons next to the 

transformations list allow defining new transformations ( ), delete the existing ones ( ), move the 

transformations in the list up  and down .. The order of transformations in the list defines the 

sequence in which these transformations are applied to the object. 

The entry beneath the list displays the name of the selected transformation. It can be modified by entering 

a new value here.  
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Besides the geometrical parameters (offsets, rotations, scale), the additional parameters can be defined for 

the selected transformation:  

Suppress. This parameter allows temporary excluding of the transformation from the object 

position calculation. A numerical variable can be used as the value of this parameter. The 

transformation will be suppressed, if the variable value is not zero. 

Only for exploded view. With this flag set, the transformation will be taken into the account in 

the exploded state only (the command 3VX: Exploded View). 

The general parameter Apply exploded view transformation of base elements also affects the behavior 

of the current 3D object in the exploded state. With the flag set, all exploding transformations defined for 

the parent elements of the 3D object will be applied to this object as well. Consider, for example, a nut and 

bolt subassembly. The nut will first be subjected to the bolt exploding transformation, and then to its own. 

With the flag cleared, the object’s position in the exploded state is defined by its own transformations only.  
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WORKPLANES 

A workplane is an auxiliary 3D construction element visualizing the abstract concept of the geometrical 

plane. The main purpose of a workplane is bringing two-dimensional drawing objects into the three-

dimensional space. Such objects are used for creating flat 3D construction elements on their base, such as 

3D nodes, 3D profiles, 3D paths, etc.). Each workplane is related with a certain page of a 2D drawing. One 

can say that workplanes provide a link between 2D drawing pages and the three-dimensional space. 

Besides, workplanes are used as auxiliary elements in various 3D operations. For example, they help 

creating the section plane within a body in the operation “Cut by Section”, or position the section plane 

when creating a section. The normal to a workplane can be used for defining an extrusion direction or a 

revolution axis, etc. 

All workplanes in T-FLEX CAD are divided into two groups: standard and auxiliary. Standard are the T-FLEX 

CAD workplanes that coincide with, or parallel to, one of the principal coordinate planes of the world 

coordinate system (XY, YZ, ZX). Such workplanes are commonly used for creating base 3D constructions. 

However, to create a complete 3D model, using just standard workplanes may not be enough, thus 

prompting the use of auxiliary workplanes. The latter are created based on other 2D and 3D elements: 

already existing workplanes, vertices, edges and faces of 3D bodies, 2D projections, etc. 

T-FLEX CAD provides a dedicated command for creating workplanes: 3W: Construct Workplane, that 

allows creating various types of workplanes. Besides that, the system provides mechanisms that speed up 

creation of workplanes and drawing on those: creation of workplanes in “transparent mode” and drawing 

directly in the 3D scene in the active workplane mode, creation of workplanes parallel to already existing 

workplanes with the help of the special manipulators.  

PRINCIPLES  OF WORKING WITH WORKPL ANES  

Let’s start getting acquainted with workplanes with the most simple and often used techniques of working 

with workplanes. Those include creation of standard planes as part of creating a new document (using the 

standard prototype) and creation of planes based on flat faces of a body. Those do not require use of a 

special command, allowing creating workplanes in “transparent mode”. 

When creating a new 3D model based on a standard prototype, the three standard workplanes are created 

in the model from the beginning – “Front”, “Left” and “Top”. The image of the three standard planes is 

displayed in the 3D scene as three intersecting semitransparent rectangles defining the visual borders of 

the planes. 
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Note that the workplane borders are shown in the 3D scene for display purpose only, as they are actually 

infinite. 

The outer borders of a workplane in the 3D window are drawn in a solid line, while the inner witness lines 

– in thin dashed lines. 

Moving the pointer to a line of a workplane highlights the 

workplane. A workplane can be selected for further 

manipulations by clicking , while right clicking  calls the 

context menu for the workplane. 

A workplane can also be selected in the 3D model tree, in the 

folder “Workplanes” or in a subtree representing the history 

of creation of some 3D element based on the workplane. 

Let's review the main techniques of handling workplanes on 

a simple example. Suppose, we need to create a 3D profile 

on the workplane “Top”, to use as a base for creating a 3D 

body. 

Select the workplane “Top” in the 3D window or in the model 

tree, and right click . In the coming up context menu, select 

the item Draw On Workplane. The selected workplane 

activates. 
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The active workplane mode is intended for applying 2D elements on a plane in the three-dimensional space. 

When starting the mode of drawing on the active workplane, the 3D scene rotates in such a way, that the 

selected workplane becomes orthogonal to the viewing direction. From this moment, any 

relocation/rotation of the 3D scene is blocked. The main toolbar of the T-FLEX CAD (if it is not locked) will 

be switched to the mode “Workplane”. The 2D drawing commands become accessible in the textual menu. 

                  

Now, you can draw on the workplane as if on a common 2D drawing page. Let's draw the contour of the 

future 3D profile directly on the workplane in the 3D window. (To do this, use the command G: Create 

Graphic Line or SK: Create Sketch.) After that, finish working on the active workplane by simply pressing 

the option on the main toolbar (or in the context menu upon selection of any element): 
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<Shift><End> End Drawing On Active Workplane 

The 3D scene rotate back to its original orientation. The 2D commands will become inaccessible again. 

Meanwhile, a 3D profile appears on the workplane “Top”, repeating the shape of the 2D constructions 

made by us on the workplane. 

The mode of automatic creation of 3D profiles on a workplane supports use of not only graphic 

lines, but also text and hatch. To create a parametric 3D profile, you should use lines and hatches in 

the same ways as you do when creating a parametric drawing (by snapping to construction lines). 

To create several 3D contours simultaneously on a single plane, it is possible to use graphic lines of 

different colors or hatches (this is described in more detail in the “3D Profiles” chapter). 

 

Further, suppose that the created profile is used in the rotation operation, resulting in a 3D body (see the 

chapter “Rotation”). Additionally, a hole or slot needs to be created on one of its slanted faces. To do this, 

you need to create a workplane lying on a face of the body. On this workplane, you will create a 3D profile 

– the contour of the future hole. The profile can then be extruded to the specified depth and, after that, 

subtracted by the Boolean operation from the original part. How can you do that? Simply move the pointer 

to the desired face and call the context menu. If the face is flat (as in our case), then the command Draw 

On Face will be provided in the context menu. Calling this command results in the following: a workplane 

will be created on the selected face, and activate. Besides, this source face is automatically projected on 

the created plane (see the chapter “2D projections”). The projection lines and their characteristic points 

can be used for creating the necessary 2D constructions on the workplane, for example, for defining 

hatches or construction lines to snap to. 
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On the newly created plane, let's draw the contour of the hole, and then finish the drawing in the active 

workplane mode. The 3D contour will then be displayed in the 3D scene on the face we selected, that can 

be used for constructing the hole. 

 

Note that the workplane created on a face is not displayed in the 3D scene. However, it appears in the 3D 

model tree. To make such workplane visible in the 3D scene as well, open its parameters dialog box (for 

example, by calling the context menu of that plane in the 3D model tree) and set the flag Show in 3D View. 
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If you select the same face of the body again and call the context menu, you will find in it two similar 

commands: the already familiar Draw On Face and Draw On Workplane. We already know the purpose of 
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the first one – it creates another workplane based on the selected face. The second one allows activating 

the already existing workplane, created on the selected face (if you need, for instance, to edit the 2D 

constructions made on that plane). If several such workplanes are created, the desired one can be selected 

from the pulldown list. 

 

Thus, you have learned the simplest and most commonly used techniques of creating workplanes. Other 

workplane creation techniques are used in the cases, when the standard planes and the planes created on 

the body faces are not enough for solving the posed tasks. Those techniques imply use of the dedicated 

command. Just before learning those techniques, let us clarify the relation between workplanes and the 

2D drawing and review in details working in the active workplane mode. 

WORKPL ANES AND 2D  DRAWING  

Any workplane in the document is linked to a page of the 2D drawing. Any time you create a workplane, a 

special 2D page of the type “Workplane” is automatically created in the document. The workplane will be 



Three-dimensional modeling 

156 

displayed on this page as a rectangle defining the visual borders of the plane in the 3D window. The name 

of the workplane is displayed in the upper left corner of the rectangle. 

All 2D constructions made on this page are assumed by the system as lying on the workplane linked to 

this page. Vice versa, anything created directly on the workplane in the mode of drawing on the active 

workplane, appears on the linked 2D page of the document. In fact, one can think of a workplane as a 2D 

page in the 3D space. This rule applies to most workplanes in T-FLEX CAD. The exception is the workplanes 

created on the base of an existing 2D drawing page and its 2D constructions. No separate page is created 

for such workplanes. Instead, the link is established with the 2D drawing page that was used for creating 

the workplanes. Several workplanes of this type can be linked to such page in a 2D drawing. The 2D 

constructions belonging to this page can be linked to any of such workplanes. Usually, when selecting 2D 

elements intended for creating 3D elements on a workplane, the system suggests the workplane nearest 

to those elements, judging by the rectangular borders of the planes. 

Therefore, 2D images can be created or edited on a workplane not only in the 3D window in the active 

workplane mode, but also in the 2D window. To do this, you need to open a drawing page in the 2D 

window, linked to this workplane. This approach is particularly useful when working with workplanes 

created in the 2D window, that is, based on an already existing drawing page. Workplanes can be activated 

only when they're located on a separate page of the 2D drawing. If several workplanes of the described 

type are linked to one page of a 2D drawing, they cannot be activated. 

 

When working with the 2D pages of the workplanes created in the 3D window, first make sure that 

the display of the auxiliary pages is turned on in the command PG: Pages, and that the respective 

pages are displayed in the 2D window. 
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WORKING WITH ACTIVE WORKPL ANE  

The mode of drawing on the active workplane is intended for placing 2D elements on a plane in the three-

dimensional space and their further use in creation of the 3D model. Let's review this working mode in 

details. 

Workplane Activation 

A workplane can be activated in several ways. All possible ways of activating a workplane are listed here: 

Drawing on the selected plane. Point the mouse to a workplane and click . The selected workplane 

gets highlighted. At this moment, you can start creating elements, using 2D drafting commands. 

Activate a 2D command. This will activate the workplane. On the main toolbar (if it is not locked) the 

button set “Workplane” will be shown. 

Activation from the context menu. Select a workplane in the 3D window or in the model tree and right 

click . In the coming up context menu, select the item “Draw On Workplane”. 

 

If such item is not present in the menu, that means, the plane cannot be activated. All necessary 

constructions should be done in this case in the 2D view (on the page where this workplane is located), 

and then carried over to the 3D scene by using the appropriate 3D commands. 

Activation from the list. While the system is in the command waiting mode, point the mouse to an empty 

space  in the 3D scene and right click . In the coming up menu, select the item “Draw On 

Workplane…”. The list of workplanes available for activation in this document will be displayed on the 

screen. Select the desired workplane in the list and press [OK]. 
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Activation after creation. When creating a workplane on a face of a solid body, this workplane can be 

activated automatically. For this, point the mouse to the face to create the workplane on, and right click 

. In the coming up context menu, select the item “Draw On Face”. A workplane will be created based 

on the selected face, along with the page to contain all elements belonging to the workplane. The 

created workplane will be activated. 

   

Activation from the context menu with plane selection. This is activation of an existing workplane 

created based on a body face. Point the mouse to a face of the body and right click . If there are 

workplanes created on this face, then the coming up context menu will have the item Draw On 

Workplane. Selecting this command displays the list of workplanes created on the current face. The 

workplane selected in this list will be activated. 

 

Active Workplane Control 

Upon activating a workplane, on the main toolbar (if it is not locked) the button set “Workplane” will be 

shown. The options on this toolbar allow performing the following actions: 

 
 Rotate Active Workplane Orthogonal To View 

Direction 

 

If the whole 3D scene needs to be rotated while working with the active workplane, use the option: 
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 Rotate 3D Seen/Select 3D Elements 

 

You can also rotate the 3D scene by the mouse while holding down the <Alt> key. While in the 3D scene 

rotating mode, you can select 3D elements (as for projecting on the workplane, etc.). To continue drawing 

on the active workplane, turn off this mode. 

If you prefer working in the 2D window, you can open the 2D drawing page corresponding to the active 

workplane. This is done by the option: 

 
 Open 2D Window With Active Workplane 

The page is displayed in the full-screen mode. It also contains the projection of the selected face. All 

constructions made on this page are automatically carried over the active workplane. To return to the 3D 

window, turn off this option. 

If you need to project some model elements on the workplane, use the option: 

 
 Project Elements On Active Workplane 

 

This option is available only when working in the 3D window. Upon selecting this option, the icons appear 

in the automenu for selecting 3D model elements (operations, faces, edges) that you need to project on 

the active workplane. Upon finishing the selection, confirm the projection creation with the icon .  

A special option is provided for projecting a 3D node or a body vertex on the active workplane 

 
 Create Projection of 3D Node or Vertex 

Upon activating this option, simply select the nodes or vertices to project on this workplane. 

If the projected elements fall beyond the displayed bounds of the active workplane, their projection on the 

active workplane will not be displayed in the 3D window. In such a case, it may be convenient to use the 

2D window of the active workplane. Alternatively, you can change the size of the workplane. 

To align the cutting plane with the active workplane (see the chapter “Working in the 3D view window”), 

set the option: 

 
 Move Cutting Plane To Active Workplane 

Additional control over the cutting plane is provided when using the option . 

To finish drawing on the active workplane, press the icon: 

 
<Shift><End> End Drawing On Active Workplane 

If the 3D window is active, you can also point the mouse to an empty area in the 3D scene and right click 

. The coming up context menu will have the item End Drawing On Active Workplane. 

While working in the active workplane mode, you can use any construction and 2D element creation 

commands. If the workplane was created on a body face, then the face projection on this workplane will 
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be automatically created on the drawing page linked to this workplane. While working with 2D drafting 

commands, you can snap construction and graphic elements to the lines of the projection and their joint 

points.  

In the “Workplane” and “Workplane (draft)” sets of the main toolbar of T-FLEX CAD, the element of control 

with the list of 3D profiles constructed by graphic lines of the given plane is available. If one of the profiles 

is selected from this list, the graphic lines that form this profile are automatically displayed on the screen 

in large size and newly created graphic lines are assigned the color of the selected profile. 

 

Upon finishing working on the active workplane, the system automatically creates a 3D profile, using the 

following elements: hatch contours, graphic lines and TrueType-font text. If several hatches or text were 

created on the 2D page of the workplane, then multiple 3D profiles are automatically created (by the 

number of identified hatches and/or text). If graphic lines of different colors exist on the workplane, the 

system, upon exiting the mode of drawing on the plane, will prompt the user to create several 3D profiles 

– according to the number of used colors. Each of the created profiles will contain only the lines of one 

specific color. 

To finish working on active workplane without creating a 3D profile, use the option: 

 
<Alt><End> Cancel Drawing On Active Workplane 

While working in the active workplane mode, you can call 3D operation creation commands. In such a case, 

the system finishes drawing on the workplane, and automatically highlights the created profile if the 

operation requires profile selection. 

SETTING V IE W OF  WORKPL ANES IN 3D  SCENE  

Appearance of workplanes in the 3D scene is controlled by collection of parameters found in the settings 

of the system, of the individual document and the workplane itself. 

First of all, it is possible to control the transparency of the workplanes (from totally transparent up to totally 

opaque). Parameter that controls the degree of transparency of an individual workplane is available in the 

dialog of parameters of the given plane (see the “Parameters of workplanes” section). 

At the corner of the rectangle that constitutes the image of the workplane, the name or the type of the 

given plane is usually indicated. It is possible to hide/show them with the help of the “Workplanes > Draw 
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name” parameter in the dialog of the ST: Specify Parameters of Document command (the “3D” tab). The 

font that is used for displaying the name of the workplane is specified in the SO: Set System Options 

command, on the “3D” tab. 

The font size of the workplane is specified by the Workplane font parameter on the 3D tab in the dialog 

of the ST: Specify Parameters of Document command. The larger the value of this parameter, the larger 

the font size will be. 

Inside the rectangle of the workplane, the coordinate system of the given plane can be displayed. The 

visibility of the coordinate system is controlled with the Show coordinate systems parameter in the dialog 

of parameters of the given plane (see the “Parameters of workplanes” section). By default the coordinate 

system of the workplane is not displayed. 

In the SO: Set System Options command, the tab 3D, it is also possible to specify the required number of 

internal lines on the image of the workplane (the Workplanes\Number of lines parameter). There, you can 

also define the mode of selecting workplanes – by the bounding rectangle lines only or by all displayed 

lines (the Workplanes\Selection by all lines parameter). 

 

WORKPL ANE CREATION  

In the beginning of this chapter, we described the most convenient ways of making workplanes – creation 

of standard planes together with the new document creation (using the standard prototype) and, later, 

creation of workplanes based on flat body faces. The dedicated command 3W: Construct Workplane 

provides wider opportunities for workplane creation: 

 

Icon Ribbon 

 

3D Model → Construct → Workplane 

Keyboard Textual Menu 

<3W> Construct > Workplane 

The command allows creating workplanes of the following types:  

 Standard workplane. 

 Workplane parallel to a geometrical plane defined by various 3D elements (face, other workplane, 

flat edge, LCS, etc.). 

 Workplane passing through a 3D point (3D node, body vertex, path or 3D profile, edge midpoint, 

etc.). 

 Workplane passing through a 3D line. 

 Workplane orthogonal to a 3D curve. 

 Workplane tangent to a surface. 
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 Workplane based on a local coordinate system. 

 A copy of an existing workplane (transformed). 

 Workplane based on a 2D projection. 

 Placed proportionally between two planes or faces; 

 Workplane based on a local 2D view. 

Creating Workplane Parallel to a Geometrical Plane 

To create a workplane parallel to an arbitrary geometrical plane, use the following option of the command 

automenu: 

 <1> Select Plane that defines Workplane position 

The set of filters for this option allows selecting a 3D element in the 3D scene, defining the desired 

geometrical plane. This can be another workplane, a flat face (the face underlying plane is actually used), 

a flat elliptical edge, LCS (one of its principal planes), etc. 

Upon selecting the 3D element in the 3D scene, the new workplane is displayed. The original position of 

the created plane coincides with the position of the geometrical plane defined by the parent 3D element. 

Exception is the case of creating a workplane based on another workplane – in such a case, a small initial 

offset is used by default. The final position of the plane being created can be defined by entering a 

numerical value of the offset from the original 3D element in the command property window. Alternatively, 

the offset can be defined directly in the 3D scene, using the mouse. For this, you need to move the pointer 

to the displayed image of the plane being created (the pointer will change to ), depress  and, while 

holding down the left mouse button, move the plane to the desired position.  

 

 

One can also specify an additional 3D element to define the workplane position. To define the position of 

the plane being created by using additional 3D elements, the following options are used: 

 <3> Select first Point of Workplane position 

 <5> Select Surface to which Workplane is tangent 

 <7> Select Edge to which Workplane is tangent 
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The workplane will be oriented parallel to the original 3D element (or, rather, the geometrical plane defined 

by this element) and pass either through the specified 3D point or tangent to the face (or, rather, to its 

underlying surface) or to the edge. If two tangency configurations are found for the specified face or edge, 

the point will be selected, that was nearest to the pointer at the time of selecting the tangency element. 

The workplane will assume its new position instantly after selecting one of the elements. 

If the original 3D element is a face or edge, an additional option will be provided in the automenu: 

 <8> Project Selected Face to Workplane Being Created 

This option allows projecting the selected face on the page of the workplane being created. The option is 

turned on by default. 

Upon the confirmation by the option , the workplane being created assumes its new position according 

to the specified offset. 

There is another way of creating a workplane on a 3D element. While the system is in the command 

waiting mode, move the pointer to the 3D element (a flat face or edge) and right click . In the 

coming up context menu, select the command Create > Construct Workplane. As a result, the 

workplane creation command will be launched, with automatic selection of this 3D element. 

Alternatively, when selecting a face, in the same context menu you can select the command “Draw 

On Face”. As a result, a workplane will be created based on the specified face, and the system will 

enter the mode of working on the active workplane. 

Creating Workplane through a 3D Point 

To create a workplane based on a 3D point, you need to select the following option in the command's 

main automenu: 

 <3> Select first 3D Point of Workplane position 

Using this option, you can select a 3D element in the 3D scene, that defines the necessary point. This could 

be a 3D node, a body vertex, a center of an elliptical edge or a midpoint of a straight one, an LCS origin, 

etc. The coordinate origin of the workplane being created will be positioned in the selected point. 

The following additional options we will appear in the automenu after picking the option : 

 <3> Select first 3D Point of Workplane position 

 <4> Select a line through which the workplane goes 

 <5> Select second 3D Point of Workplane position 

 <7> Select third 3D Point of Workplane position 

 <8> Select Plane from which Workplane angle is measured 

 <9> Select Direction 
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 <T> Select Surface to which the Workplane is tangent 

Using these options, you can construct the following types of workplanes based on the selected 3D point: 

 Workplane going through a 3D point and a line; 

 Workplane going through a 3D point and tangent to a cylindrical or conical surface. 

 Workplane going through two 3D points; 

 Workplane going through two 3D points and in the specified direction (or through two points 

at an angle to the specified direction); 

 Workplane going through two 3D points at an angle to a plane; 

 Workplane going through two 3D points and tangent to a conical, cylindrical or spherical 

surface. 

 Workplane going through three 3D points. 

To construct Workplane going through a 3D point and a line, after selecting the base 3D point you need to 

specify a line, through which the plane should go. The line is selected with the option . The selected 

line should not go through the coordinate system origin point. In this case, the X-axis of the coordinate 

system of the workplane being created will be directed along the selected line, while the Y-axis will be 

going through the coordinate system origin point perpendicular to the line. 

 

To construct Workplane going through a 3D point and tangent to a conical or cylindrical surface, after 

defining the 3D point you need to select the desired surface with the option . From the two tangency 

possibilities, the one will be selected that is closer to the cursor position at the instant of selecting the 

surface. 
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To construct Workplane going through two 3D points, you need to select an additional 3D point after 

selecting the first 3D point, using the option . The workplane is constructed as going through the axis 

defined by the selected 3D points. The workplane position in the space is set arbitrarily by the system. If 

necessary, the workplane position can be modified by rotating it at the specified angle relative to the 

original position. The angle is defined in the command's properties window or directly in the 3D window 

using a dragger. 

 
 

To construct Workplane going through two 3D points in the specified direction, after defining the first 3D 

point you need to select the second 3D point (the option ) and a 3D element defining a direction (the 

option ). The direction can be defined with a planar edge or 3D path, a normal to a surface, an axis of 

a cylindrical or conical surface, etc. 

If necessary, it is possible to define an additional rotation angle of the workplane relative to a specified 

direction (in the properties window or in the 3D window using a dragger). 
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To construct Workplane going through two 3D points at an angle to a plane, after defining the first 3D point 

you need to select the second 3D point (the option ) and a plane (the option ). To define a plane, 

you can select another workplane, a flat (planar) face, a planar edge, an LCS, etc. As in the previous cases, 

the angle is defined in the properties window or in the 3D window using a dragger. 

 

To construct Workplane going through two 3D points tangent to a surface (conical, cylindrical or spherical), 

you need to specify the first 3D point, and then the second 3D point (the option ) and a surface (the 

option ). The X-axis of the created workplane coordinate system will be directed from the first selected 

point to the second one. 

When selecting a conical or cylindrical tangency surface, the construction result will be defined 

similarly to that of a workplane by a single 3D point with a tangency to a surface. The second point 

definition could merely help define the tangency configuration. 

 

To construct Workplane going through three 3D points, you need to define the first 3D point, then select 

the second 3D point (the option ) and the third 3D point (the option ). The X-axis of the created 

workplane coordinate system will be directed from the first selected point to the second one, and the Y-

axis will be perpendicular to it. 
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The workplane creation must be confirmed by the option . 

Creating Workplane through a 3D Line 

A workplane can be defined as passing through a flat edge or a 3D line defined by a straight edge, an axis 

of revolution, an LCS axis or by other 3D elements. To define a workplane of such type, the following 

options of the main command automenu are used: 

 <5> Select flat Edge through which Workplane passes 

 <6> Select Axis for the Workplane 

To select a flat edge (the option ), simply move the pointer to the edge and click . To select a 3D 

straight line (the option ), select a 3D element suitable for defining a straight line (an axis). The list of 

3D elements allowed for selection is defined by the state of the selection filters in the pulldown list of the 

option. 

The origin of the coordinate system of the workplane being created is defined by the start point of the 

edge (the closing point in the case of periodical edges) or by the midpoint of the specified line. The X-axis 

is directed along the edge (tangent to the edge in the case of closed edges) or along the line. 

Initially, the workplane being created can be rotated above the selected edge or 3D line by defining the 

rotation angle by a numerical value in the command property window. Alternatively, the plane rotation 

angle can be defined directly in the 3D scene by using the mouse. To do this, move the pointer to the 

image of the plane being created (the pointer will change to ), depress  and, while holding down the 

left mouse button, move the plane to the desired position.  
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Plane rotation can also be done with respect to a plane that can be selected by using the option: 

 <3> Select Plane from which Workplane angle is measured 

This option allows defining a geometrical plane by specifying a 3D element lying on it: a flat curved edge, 

a path or profile, a flat face, a workplane, etc. 

The workplane being created will be rotated about the edge or 3D line by the specified angle with respect 

to the selected element (originally, this angle is considered equal to 0). The rotation angle can be defined 

by a numerical value in the property window or input directly in the 3D scene, using the dragger. 

The workplane rotation angle can also be specified by selecting an additional 3D point for the plane to 

pass through. To define the point, use the following automenu option: 

 <5> Select first Point of Workplane position 

When selecting a 3D line or straight flat edge, there is yet another way of rotating the plane  by specifying 

a face to which the workplane should be made tangent. The face can be of cylindrical, conical or spherical 

shape. The face selection is done by the option: 

 <7> Select Surface to which Workplane is tangent 

The face won't get selected if its shape is different from the specified above, or if it cannot be made tangent 

to the workplane being created. Upon selecting the face, the workplane being created will rotate about 

the edge or the 3D line to become tangent to the face. The workplane creation must be confirmed by the 

option . 

Creating Workplane Orthogonal to a 3D Curve 

To set the mode of creating this type of workplanes, in the main command automenu select the option: 

 <7> Create Workplane Orthogonal to Path 

Upon selecting this option, the following actions become accessible: 

 <2> Select Path to which Workplane is orthogonal 



Workplanes 

169 

This option allows selecting a 3D element defining the source curve to which the workplane should be 

made orthogonal. This can be a 3D path, 3D profile or its boundary, an edge or a loop of edges.  

Upon selecting the source curve, the image of the workplane is displayed orthogonal to the curve, at its 

start point. The position of the workplane can be adjusted by selecting a 3D point for the workplane to 

pass through: 

 <3> Select Point that sets Workplane position 

Upon selecting the 3D point, the workplane will reposition in the 3D scene to pass through the selected 

point while staying orthogonal to the source curve. The workplane origin will be placed at the intersection 

point. If the selected point is not lying on the path or edge, then the X-axis will be directed to this point. 

Otherwise, the direction of the X-axis is defined by the system automatically.  

The workplane creation must be confirmed by the option . 

Creating Workplane Tangent to a Surface 

The mode of creating this type of workplane is set by the option: 

 <8> Select Surface to which Workplane is tangent 

After that, you need to select the surface to become tangent to the workplane being created. This is done 

by the option: 

 <1> Select Surface to which Workplane is tangent 

This option allows selecting a 3D element suitable for defining a surface. This can be a face, a 3D profile or 

a simple body, a worksurface, workplane, or a flat edge.  

Upon selecting the face, you need to select a 3D point, whose projection on the selected surface is to 

become the tangency point between the workplane being created and the surface (the projection is done 

by the shortest distance to the surface): 

 <2> Select first Point of Workplane position 

Workplane Origin Selection 

This option is available only when creating workplanes based on 3D elements in the ways described above. 

To modify the origin point resulting from the workplane construction, you can use the option: 

 <O> Define Workplane coordinate system 

After that, the options will appear in the automenu for defining 3D points, whose projections on the 

workplane being created, will define the position and orientation of its local coordinate system axes: 

 <1> Select Point that defines Workplane Origin 

 <3> Select Point of X-axis direction 
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 <F> Eliminate Workplane coordinate system definition 

The option  allows selecting a 3D point, whose projection on the workplane will be considered the new 

origin. The option  allows selecting a 3D point, whose projection on the workplane will be defining the 

direction of the X-axis of the plane coordinates. The point selection can be undone using the option . 

To exit the mode of defining the plane coordinate system, use the option: 

 
<Alt+Down 

Arrow> 
Return to previous mode 

Creating Copy of Workplane 

To construct a workplane of this type, select the following option in the main menu: 

 <A> Create Workplane Copy 

As a result, the following options become available: 

 
<W> Select source Workplane 

 <1>  Select source LCS 

 
<2> Select target LCS 

 
<F>  Cancel LCS selection 

To create a copy, do the following steps: 

- Select source Workplane. 

The selection can be done either in the 3D window or in the 2D window. You can set the desired offset and 

rotation angle values in the tab “Transformation” of the workplane parameters. Rotations in this case are 

done with respect to the world coordinate system. This is sufficient for creating a copy. 

- Select source LCS. 

Defining the transformation parameters at this step results in rotations with respect to the selected 

coordinate system.  

- Select target LCS. 

The workplane position is defined by repositioning of the source workplane according to the transition 

from the source to the target coordinate system. Additionally, you can define the transformation 

parameters. Rotations will be done with respect to the target coordinates.  

The workplane is created on the current drawing page. All parameters of the copy plane that are relevant 

to the 2D view (origin, displayed borders) are the same as the source workplane parameters. 
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Creating Workplane Based on Local Coordinate System 

A local coordinate system (LCS) is an auxiliary 3D construction element used for defining 3D object 

positions in the space. A workplane based on an LCS coincides with one of its principal planes – XY, XZ, YZ. 

Since LCS axes can be directed arbitrarily, use of this construction technique allows positioning the 

workplane in any desired point in the space and in any orientation. 

To create such workplane, in the main command automenu select the option: 

  <L> Construct Workplane based on LCS 

As a result, the following actions are accessible: 

 <N> Set attachment point 

 <L> Select target LCS 

 <B> Define Workplane borders 

To create the workplane, just select a local coordinate system (in the 3D window or in the 3D model tree) 

using the option . The image of the workplane being created will be instantly displayed in the 3D 

window, coinciding (by default) with the XY plane of the selected LCS. One of the corners of the displayed 

workplane border rectangle will be at the LCS origin. At this step, you can already complete the plane  

creation by pressing . In this case, a separate 

“Workplane”-type page will be created in the 2D drawing 

for the new workplane. 

You can change the default positioning of the plane with 

respect to the source LCS. Firstly, you can set a different 

principal plane of this coordinate system. To do this, in the 

property window select the desired option. As you do, the 

workplane image in the 3D window will instantly adjust its 

position. 

 

Secondly, you can select a 2D node in the 2D window, using the option , to be assigned as the origin 

of the coordinate system. In this case, the workplane is created on the page of the 2D drawing to which 

the selected 2D node belongs. The image of the plane in the 3D window will move to make the LCS coincide 

with the point on the plane defined by this node. 

Finally, you can additionally change the size and position of the displayed borders of the workplane, using 

the option . The borders are changed in the same way as when creating a standard plane. 
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Creating Standard Workplane in 3D Window 

In the cases when the new document was not based on the standard prototype, you may need to manually 

create one or several standard planes. To do this, activate the 3D window, and in the workplane creation 

command select the option: 

 <S> Construct standard Workplane 
 

A standard workplane can be created either in the 2D or in the 3D window. The way of creating the 

plane and the obtained result depend on what window was active at the time of selecting this 

option. 

The dialog box appears in the screen for 

selecting standard views. The workplanes will 

be made parallel to the respective principal 

coordinate planes, as defined by the selected 

views. One can select several standard views 

simultaneously in the list on the left-hand 

side. Confirming the selection by pressing the 

[OK] button leads to automatic creation of the 

workplanes for the specified views. Separate 

“Workplane”-type 2D pages will be created 

for each workplane. Such pages are not 

displayed in the 2D window by default. 

 

 

The displaying of the workplane pages in the 2D window can be turned on using the command Customize 

> Pages, by setting the flag Show Pages/Workplanes. Such workplanes are displayed in the 3D view by 

default. The position in the three-dimensional space is determined by the world coordinates that provide 

the common origin for all workplanes created in this way.  

 

The origin of each workplane is located in the center of the rectangle that defines the workplane display 

in the 3D window. A standard workplane origin can be modified only in the editing mode. In this case, the 

origin selection is done in the same way as when creating workplanes based on a 2D view (the section 

“Creation of standard workplane in 2D window”). 

Simultaneous creation of several standard workplanes 

The dialog box launched by the option  has another three additional options represented by the 

graphic buttons: [  Front and Top], [  Front and Left], [  Three Standard Views]. You can 

simultaneously create several standard workplanes by using these options. 
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Creating Standard Workplane in 2D Window 

Creation of workplanes in the 2D window, that is, based on an already existing page of a 2D drawing, 

containing 2D constructions, is mostly used with the technique “From 2D to 3D”. Usually, standard planes 

are created for each of the main drawing views. The 3D constructions on the planes are built based on the 

drawings on the respective drawing views. This allows carrying the elements of a complete 2D drawing 

over the three-dimensional space. 

 

To create a standard workplane in the 2D window, use the option . The sequence of steps for creating 

the plane in this case is as follows: 

 Determine, to which of the principal coordinate planes the workplane being created should be made 

parallel. This is done by selecting the view for the workplane. For example, by selecting the front or 

back view, we assume that the plane being created is positioned parallel to the XZ plane of the world 

coordinate system. 

 Select a 2D node on the current page of the drawing (optional in some cases). The node will define the 

position of the workplane borders rectangle on the page, as well as the origin of the plane local 

coordinates. If no workplane is yet linked to this drawing page, then you do not need to specify the 

node. In this case, one of the corners of the drawing format frame will be assumed as the local 

coordinate system origin. 

 The default workplane borders are set as follows. The specified 2D node is considered the first corner 

of the border rectangle. The second corner is placed at the nearest corner of the drawing format frame. 

Standard planes are assigned a specific corner of the format frame, the front view being the upper left 

one, the bottom view – the lower left, the left view – the upper right. 

 The correct definition of the displayed borders of the workplane helps simplify the future creation of 

3D constructions on the plane from the 2D drawing. When selecting 2D elements to use for 3D 
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constructions, you need to define, in which workplane those elements belong. The system can do it 

automatically by taking the plane, whose border rectangle covers the selected 2D elements. If the 

borders of the planes on the 2D page do not align with the respective drawing views, the system choice 

will be incorrect, and you will have to select the workplane manually. Therefore, the attachment node 

should be selected in such a way, that the workplane border rectangle agreed with the drawing view 

intended for the plane. If this cannot be achieved by selecting the attachment node, the border size 

and position of the workplane being created can be additionally adjusted, as described in the next 

paragraph. 

 Change the default settings of the plane displayed borders in the 2D window (optional). The borders 

can be modified in two ways. The first way is selecting another corner of the drawing format frame as 

the second point of the border. The second way is to define the borders of the plane anew by specifying 

the new positions for both corners (by selecting two 2D nodes). 

 Select a 3D node defining the position of the workplane in the space (optional). By default, the standard 

workplane coincides with one of the principal coordinate planes of the world coordinate system. The 

origin of its local coordinate system is positioned in this case at the world coordinates origin. Instead, 

if defining the 3D node, the plane being created is carried over to the position defined by the selected 

node. That means, the resulting plane will be parallel to the principal coordinate plane while passing 

through the 3D node. The plane local coordinates origin is also placed at the selected 3D node. 

 Define the displayed borders of the plane in the 2D window (optional). The default borders of a 

workplane are defined as follows. The first point is considered the point selected at the step 2. The 

second point is considered the nearest corner of the drawing borders. In the case of standard planes, 

a certain corner point is used (for the front view – the upper left one, for the bottom view – the lower 

left, for the left view – the upper right). The user can modify these borders (by selecting, for instance, 

two 2D nodes). 

 Upon performing the necessary steps, confirm the workplane creation by the option: 

 <Y> Finish input 

The workplane created in this way is not displayed by default in the 3D window. To have it displayed 

in the 3D scene, set the flag “Show in 3D View” in its parameters dialog box. 
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Let's review each step in details. 

Activate the 2D window and select the option 

“Construct standard Workplane”. The dialog for 

selecting the standard view will be displayed on 

the screen. Unlike its counterpart for creating 

the standard plane in the 3D window, this dialog 

allows selecting only one standard view from the 

list on the left-hand side. 

If no workplanes exist on the current drawing 

page, then the rectangle will be drawn the size 

of the drawing format, marking the workplane 

being created. 

 

Workplane creation can be completed at the step, using the option . The workplane local coordinate 

system origin will be set automatically. 

If, however, there is at least one workplane on the current drawing page, then the workplane image will be 

displayed on the drawing only after performing the further steps. The following additional options are 

provided in the command automenu: 

 <N> Set attachment point 

 <M> Set relation with 3D Node 

 <B>  Define Workplane borders 

Suppose that the “Left” view was selected at the previous step. This means, the workplane being created 

will coincide (or stay parallel) with the YZ plane of the world coordinate system. After that, you can select 

a 2D node that will define the local coordinate system origin on this workplane. The node is selected using 

the option . The workplane creation can be finished at this step. In this case, it will coincide with the YZ 

plane of the world coordinates. 

If necessary, the workplane borders set by default can be modified (the option ). When calling this 

option, the following additional options become available in the automenu: 

 <B> Set border’s 1st/2nd corner 

 <Tab> Define Workplane borders 

 <K>  Eliminate borders 

 <W> Return to previous mode 

The borders of the workplane can be redefined in two ways. You can simply select another corner of the 

drawing format frame as the second point, using the option : pressing the icon repeatedly makes the 
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system toggle through all corners of the format frame. Alternatively, you can define the plane borders 

anew, attaching them to two nodes by the option . Attachments to the nodes can be canceled by the 

option . 

The final step can be exact positioning of the plane being created in the space by specifying a 3D node 

(the option ). 

As in the case of creating a standard plane in the 3D window, multiple planes can be simultaneously created 

in the 2D window. However, in this case only two additional buttons are present in the dialog lunched by 

the option : [  Front and Top] and [  Front and Left]. Using these options, you can create two 

standard workplanes at once. In this case, simply specify the common coordinate system origin as a 2D 

node. 

 

Creating Workplane Based on 2D Projection 

The workplane created by a 2D projection is positioned in the same way as the projecting plane of the 

selected 2D projection. For example, if the projecting direction is defined by a body face, then the 

workplane will lie on this face. If the projecting direction was defined by a section, then the workplane will 

lie in the plane of the section, etc. Such construction technique allows creating, for example, workplanes 

parallel to the plane of an arbitrary section, whose orientation in the space is different from any other body 

faces or any existing workplanes. 

To create a workplane by a 2D projection, just select the desired projection while in the workplane creation 

command. The created workplane is placed on the same page of the 2D drawing as the selected projection. 

The origin of the coordinate system of such plane is not defined explicitly. It is assigned by the system 

automatically as coinciding with the origin of the drawing page containing the 2D projection. 

To create such workplane, select the option  in the main command automenu. The following actions 

become accessible as a result: 
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 <J> Construct Workplane based on 2D Projection 

 <B> Define Workplane borders 

The 2D projection to use for the workplane creation is selected by clicking  in the 2D window while the 

option  is active. After selecting the 2D projection, a rectangle is displayed on the current page, defining 

the borders of the workplane being created. 

The display of such workplane in the 3D view is controlled by the respective parameter in the 

operation settings. 

The workplane borders are set by the system. If necessary, those can be redefined using the option . 

The workplane creation is finalized by pressing . 

Workplane between two planes or faces 

A workplane in between two planes is created using the command's main automenu option: 

 <E> Create Workplane between other Workplanes 

After selecting this option, you need to select two planes using the options: 

 <1> Select First Workplane 

 <2> Select Second Workplane 

If the source planes are parallel, then the resulting plane divides the distance between them in the specified 

proportion (this is defined by a numerical parameter). If the source planes are not parallel – then it is the 

angle that is divided proportionally.  

The parameter value that defines the position of the workplane 

being created relative to the source planes is entered in the 

command's properties window or in the 3D window using a 

dragger. The default preset value is 0.5, so that the created 

workplane is the symmetry plane for the selected planes. 
 

                      

Creating Workplane for Auxiliary 2D View 

The workplane for an auxiliary 2D view is created using the option: 

 <D> Construct auxiliary Workplane 
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Workplane creation for an auxiliary 2D view is most often used in the technique “From 2D to 3D”. As a 

reminder, let us mention that the 3D model creation is based in this case on a completed 2D drawing. First, 

workplanes are created according to the views of the drawing. Next, auxiliary 3D elements, such as nodes 

and profiles, are created based on 2D constructions. The 3D model is finally built based on the created 

auxiliary elements. 

If a 2D drawing contains only main part views, creating just standard workplanes is enough. However, if 

additional views are present on the drawing (auxiliary or local section views, or simple slanted sections), 

whose projection plane is not parallel to any of the standard workplanes, you may need to use a workplane 

based on an auxiliary 2D view. Such a plane is oriented orthogonal to the selected auxiliary view direction. 

Therefore, creating a workplane based on an auxiliary 2D view amounts to “re-creating” the imaginary 

underlying plane of the projection defined by this auxiliary view. 

Note: the terms “projecting”, “section” and “views” used in this chapter refer to general concepts of 

drafting and design, rather than to the T-FLEX CAD elements “2D Projection”, “Section” or the 2D 

detailing element “Drawing View”. The use of those terms is unrelated to the means of design which 

can be, for instance, manual drafting of a part’s 2D representation. 

Plane creation procedure 
The preconditions to creating an auxiliary view-based workplane are as follows. The 2D drawing of the part 

must be fit with all necessary main views and sections of the part, including the source auxiliary view. The 

source workplane must be created in the 2D window. This workplane must correspond with the part view 

that defines the view direction or the section plane of the auxiliary view in question. 

For clarification, let's review the following example. Suppose, a 3D model is built based on the 2D drawing 

shown below. The general shape of the part was “re-created” by the front view and the top view. Now, we 

need to create a slot on the slanted face of the part based on an existing view “A”. 

 

To create the slot, we need to create a workplane orthogonal to the view direction of the local view “A”. 

This plane will help creating a 3D profile based on the view image. The resulting profile will then be used 

for creating the slot using an extrusion and a Boolean subtraction. 

The workplane of the view “A” will be orthogonal to the “Front” plane. Their intersection line must be 

orthogonal to the arrow marking the view direction.  
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The workplane creation starts with specifying two 2D nodes (“Node 1” and “Node 2”) defining the 

intersection line between the workplane being created and the existing plane. Upon specifying the nodes, 

the system automatically identifies the original workplane and the view direction for “projecting” on the 

auxiliary view plane being created. The workplane viewing direction is marked by two arrows that appear 

next to the selected nodes. This defines the preliminary positioning in the space of the workplane being 

created. 

The choice of the original plane and the view direction can be modified, if necessary. Note also, that 

the view direction initially defined by the system depends on the order of the nodes selection. 

The next step is selection of a 2D node for the attachment point of the workplane being created on the 2D 

page. Normally, you select one of the 2D nodes belonging to the auxiliary view image. The same node 

defines the workplane borders and its local coordinate system origin. The first corner of the plane border 

rectangle will be at the selected node, while the second, the diagonal one – at the nearest corner of the 

drawing format frame on the current document page. In the example, let's select “Node 3” as the 

attachment node for the plane being created. The newly created workplane border rectangle is then 

displayed on the current page of the drawing. 

 

The local coordinate axes of the plane being created are automatically rotated, together with the plane 

itself, by the angle equal to that between the planes' intersection line and the vertical. This ensures the 

correct positioning in the space of the 3D elements that will be created on this plane from the lines of the 

auxiliary view. 

Additionally, one can define a 3D node for the workplane being created to pass through. This step is 

optional. If no 3D node is specified, then the plane will be constructed through the world coordinates 

origin. The plane is positioned in the space in such a way, that the 2D attachment node defined at the 

previous step becomes the projection of this 3D node on the plane being created. The attachment 3D 

point defines the exact positioning of the plane being created in the space. 

In the described example, the new plane positioning is adjusted by using the 3D node “B” (constructed 

from its projections B’ and B’’). As a result, the plane will assume the position shown on the following 

diagram.  
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To view the new plane position in the 3D space, set the flag in its parameters that controls the plane 

display in the 3D scene.  

     

When creating a workplane of an auxiliary view, you can redefine the plane borders in the 2D window. To 

do this, specify 2D nodes on the current page of the document as the corners of the displayed plane border 

rectangle. This can be skipped in the described example. 

Note the hatch shown as gray filling on the view “A”. If you create a 3D profile on the new plane based on 

this hatch, then the profile will be positioned just as a part element supposed to be in order to yield the 

projection on the created plane per the view “A”. 

If the image on the view “A” were rotated as shown on the diagram below, then we would need to 

additionally define the rotation angle for the plane being created. In such a case, two additional 2D nodes 

are to be specified (“Node 3” and “Node 4”) to define the rotation axis. As a result, the local coordinate 

system of the plane being created is rotated additionally by the angle equal to that between this axis and 

the intersection line between the planes. 

   

Plane creation 
Creation of a workplane based on an auxiliary 2D view is done by using the following option in the 

command automenu: 

 <D> Construct auxiliary Workplane 
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Upon selecting this mode, the additional options appear in the automenu: 

 <D> Select 1st/2nd Node of view direction 

 <W> Select Other Workplane 

 <A> Set view rotation 

 <Tab> Switch view direction 

 <N> Set attachment point 

 <M> Set relation with Node 

 <B> Define Workplane borders 

The default option  is activated upon turning on the mode of creating the plane by an auxiliary 2D 

view. This option allows selecting subsequently two nodes in the 2D window (using ), which define the 

planes intersection line. Upon selecting the first node, the system automatically determines and highlights 

the original workplane candidate. If a wrong plane was selected by the system, it can be changed by the 

option . Upon specifying the second node, the view direction of projecting on this plane is determined. 

The initially determined view direction can be flipped by the option . 

 

Upon specifying both 2D nodes and, therefore, the intersection line between the planes, the option  

activates automatically in the automenu. It allows selecting the plane attachment node on the drawing 

page in the 2D window. The plane creation can be finished at this time by pressing  in the command 

automenu or in the property window. Alternatively, you can continue with the plane creation by selecting 

a 3D node with the option , for the plane to pass through. This option activates automatically in the 

automenu after defining the attachment 2D node.  

 

The default workplane borders can be modified using the option . Modifying borders of a workplane 

by an auxiliary 2D view is similar to modifying the borders of other types of workplanes described above. 

Additional rotation of the plane coordinate system (when dealing with a rotated image view) is defined by 

the option . Upon activating the option, specify two additional 2D nodes. The rotation direction 

depends on the order of selecting the nodes. 
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WORKPL ANE S IZE  MODIFICATION  

To modify the displayed borders of any workplane that are not attached to 2D constructions, you can use 

the command PZ: Set Paper Size: 

Icon Ribbon 

 

Workplane → Modes → Page size 

Keyboard Textual Menu 

<PZ > Customize > Page Size 
 

Modifying the displayed borders of a workplane changes the size of the 2D page created for this 

workplane. 

The command is accessible only when the page is active in the 2D 

window, whose size needs to be changed, or when the workplane 

is activated. 

There is yet another way of calling this command. Move the pointer 

to the workplane and right click . This can be done either in the 

3D window or in the 2D window. In the coming up context menu, 

select the item Change Size and Position. (This item does not 

appear in the context menu for workplanes created from existing 

2D pages filled with constructions.) 

As result of the described actions, the workplane and its respective 

page are displayed as shown: 

 

To modify the size of the workplane, move the pointer to one of the 

square handles on the workplane border. The pointer will change 

the appearance, reflecting the current resizing action. Depress  

and move the mouse in the desired direction. The exact values can 

be entered in the command parameters. 

To move the workplane, point the mouse within the border of the 

workplane. As the pointer changes appropriately, depress  and 

move the workplane to the desired position. 

The new size and position of the workplane is confirmed by . 
 

The boundaries of the workplane can also be modified with the help of the special manipulators 

(see the “Manipulators of Workplanes” section). 
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WORKPL ANE PARAMETERS  

As any system elements, the workplanes are assigned a set of parameters. Their values can be defined in 

the dialog box called by the option: 

 <P> Set entity Parameters 

The workplane parameters dialog box has two tabs: Workplane and Transformation. 

 

The tab “Transformation” is described in details in the chapter “General parameters of 3D elements”. The 

tab “Workplane” contains general system parameters (Layer, Color, Level), the parameter Name (default 

names are “Workplane_0”, “Workplane_1”, etc.), which is common across all 3D elements, and several 

workplane-specific parameters. Those are: 

Type. At plane creation, you do not edit the plane type in this dialog box, since the plane type is 

always predefined. When editing, you can modify the types of standard workplanes only, as, for 

instance, replacing “Front” by “Left”. 



Three-dimensional modeling 

184 

Scale. Defines scaling of the 3D construction elements created with the help of this workplane. The 

default value is “Default”, that is, the scale of the 2D drawing page, on which the created workplane 

is based.  

Sometimes, 3D constructions are based on 2D elements drawn to a scale different from the page 

scale. In this case, the workplane scale needs to be defined equal to the scale of the 2D elements. 

Suppose, for example, that the scale of a 2D drawing page is equal to 1:25. The main drawing of 

the part on this page is done to the scale of the page. Suppose, however, that a local view is 

magnified to the scale 1:4. A workplane is created on this drawing page. To capture the 

geometrical data of the local view, this workplane should use the same scale as the view, that is, 

1:4.  

External. Setting this flag allows referencing the given workplane in assemblies when inserting the 

current file as a fragment. 

Show in 3D View. This flag controls the display of the workplane in the 3D view. 

Show 2D Annotations on 3D View. This parameter allows carrying the annotation elements from a 

Workplane over to the 3D space. When the flag is set, the annotation elements (dimensions, leader 

notes, roughness symbols) that were created on that Workplane become displayed in the 3D 

window, and you can work with them as with the usual 3D annotation elements. 

Show all 2D elements in 3D view. When the flag is set, all hatches, graphic lines and other elements 

of the 2D drawing are displayed in the 3D scene.  

Show intersection lines with workplanes. When the flag is set, not only workplane boundaries but 

also intersection lines with the other model workplanes will be shown. 

 

Intersection lines can be selected to create new construction lines. 
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Show Coordinate System. This parameter controls the view of the workplane's own coordinate 

system on its image in the 3D scene. By default, this parameter is turned off, i.e., the coordinate 

system is not displayed. 

Do not delete in Purge command. When the flag is set the workplane will not be deleted, even if 

it is not used for the operations creation. Option is useful when workplane contains sketch, which 

removal from the document is undesirable. 

Transparency. This parameter allows a user to control the transparency level for the rectangular 

box of the workplane in the 3D window. 

Offset by Normal. This parameter defines the offset along the normal to the workplane with respect 

to the parent element. For example, for the workplanes created parallel to a geometric plane, the 

offset is measured from the initial geometric plane. For the workplanes constructed independently 

of other 3D objects (for example, for standard workplanes), the offset is specified with respect to 

the zero point of the global coordinate system. 

MANIPUL ATORS OF WORKPL ANES  

For convenience of work with workplanes in T-FLEX CAD, special manipulators can be used. 

When selecting a workplane in the 3D scene outside the command, on the workplane's image the special 

manipulators will appear in the form of a rectangle.  

Small manipulators in the form of spheres located at the mid-sides of the workplane's rectangle allow us 

to quickly modify the visible boundaries of the workplane. . 
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When the cursor is moved to such a manipulator, the size of the manipulator is slightly increased. Working 

with the manipulator can be carried out in two ways. First, it is possible to point at the manipulator and 

press . The selected boundary of the plane will start moving after the cursor. Pressing  for the second 

time will fix the new location of the boundary of the workplane. The second way – by pointing at the 

manipulator, press  and without releasing the pressed mouse button, move the selected boundary of the 

plane to the desired location. In this case, to fix the new size of the workplane, it is sufficient to release the 

pressed mouse button.  

In both cases, when the manipulator is activated, in the system toolbar appear the additional elements for 

exact specification of the new location of the boundary of the plane being edited. 

 

The large manipulator, which appears at that place where the cursor was at the moment of workplane 

selection, allows us to quickly move the plane and also create new workplanes. The given manipulator 

practically consists of two manipulators: sphere at the center  – manipulator of translation  – serves for the 

translation of the selected plane parallel to its original location; and the cones – manipulators of copying – 

allow us to create new planes parallel to the selected one. 

 

After the plane translation manipulator is activated, the image of the plane being edited is “duplicated”. 

One copy remains at the initial position, the second copy of the plane starts dynamically moving after the 

cursor. Between them a dimension line that measures the magnitude of the distance between the planes 
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is drawn. After pressing  for the second time (or after releasing the pressed mouse button) the workplane 

is fixed at the specified location. As in the case of modifying the boundaries of the plane, the exact value 

of the translation can be specified in the system. 

 

Working with the manipulator of copying is carried out in a similar way. The only difference is that as a 

result of this operation not the original plane but its copy is moved to the specified location. In this way 

any number of parallel planes can be created. 
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WORKING WITH WORKPL ANES WITH THE HELP OF RULERS OF 3D  

WINDOW  

When working in the 3D window with the enabled rulers, there are additional capabilities for quick 

translation and copying of workplanes. 

Visibility of rulers in the 3D window can be controlled with the help of the Customize > Windows 

> Ruler command of the text menu. Also, the identically-named command can be used in the 

context menu that appears upon pressing  and selecting one of the toolbars. 

The rulers in the 3D window allow us to quickly estimate the sizes and distances in the 3D scene. 

Coordinates shown on the rulers constitute the coordinates on the imaginary plane parallel to the 

plane of the screen. 

In case when the workplane is orthogonal to the plane of the current 3D view and occupies in it the vertical 

or horizontal location, the special marker on the ruler (  or ) will show the location of such a workplane. 

 

The marker of the workplane is closely linked with the workplane itself. When the cursor is moved to the 

sign of the marker, the color of the marker is changed to red. Moreover, the workplane itself is highlighted. 

Pressing  on the sign of the marker invokes the context menu for the plane that corresponds to the given 

marker. 
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When the marker is selected with the help of  , the mode of translation/copying of the workplane is 

activated. On the screen the popup dynamical toolbar appears that allows us to specify the exact value of 

the translation of the plane. 

The translation of the selected plane is carried out if, after selection of the marker with the help of  , the 

user moves the cursor without releasing the pressed mouse button. To fix the new location of the 

workplane, it is sufficient to release the mouse button. 

Creation of the new workplane – copying – takes place if, after selection of the marker with the help of , 

the pressed mouse button is released. Pressing  for the second time in this case will fix the location of 

already the new workplane – copy of the original plane. 

By using the <Shift> and <Ctrl> keys, it is possible to select several markers at once. Translation and 

copying in the case of multiple selection are carried out similarly to the selection of one marker. In the 

context menu the additional commands will be available: 

 Distance (available only upon selection of two markers) – this 

command is used for quick modification of the distance 

between the workplanes. When invoking the command, the 

“Distance” window appears in which it is necessary to 

indicate the required value of the distance. After 

pressing[OK], the system will displace the corresponding 

workplanes in such a way that the distance between them 

becomes equal to the specified value; 
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 Uniformly (available only upon selection of three or more markers) – this command displaces 

the planes, which are connected with the selected markers, in such a way that the distance 

between all adjacent planes becomes the same; 

 

 Array… – create array of planes (available only upon selection of two markers of planes). 

 

In the context menu of the ruler of the 3D window two additional commands are available – Associated 

mode and Show dimensions. 

 

The “Associated mode” flag controls the mode of creation of workplanes with the help of tick marks on 

the rulers. When this flag is enabled, the new workplane is created with the shift with respect to the original 

workplane. When the flag is disabled, location of the new plane will be fixed in absolute coordinates 

without snapping to the original workplane. 

The “Show dimensions” mode controls the display of distances between the planes. When this flag is 

enabled, the distances of the selected workplanes between each other (if several of them were selected) 

and the distances to the first and last workplanes along the given axis are shown on the ruler as dimensions. 
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 Grid of Workplanes 

In T-FLEX CAD there is one more 

auxiliary tool for working with the 

workplanes – grid of workplanes. 

The grid of workplanes – is a set of 

lines of intersections of all workplanes 

of the model. Intersections are shown 

with the gray lines. Visibility of the 

grid is controlled with the Show/hide 

grid of workplanes  command of 

the “View” toolbar. By default, the 

grid is not displayed. 

The nodes of the grid of workplanes 

can be used for snapping, once they 

are selected as geometric points in 

different 3D operations. In this case 

3D nodes will automatically be 

created at the nodes of the grid. 
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WORKSURFACES 

Worksurfaces are auxiliary 3D elements that represent geometrical surfaces of certain type. A cylinder, 

sphere or torus can be used as such surfaces. The functional purpose of worksurfaces is similar to that of 

workplanes. Generally, those are intended for carrying 2D objects over to the 3D space. Each worksurface 

is always related with a parametric region on a page of a 2D drawing. Auxiliary 3D elements, such as 3D 

nodes, 3D profiles and 3D paths, can be created based on a flat 2D image located on this page. Those 

elements will be placed on the respective worksurface – a cylinder, sphere or torus.  

The main purpose of worksurfaces is creation of auxiliary objects (3D profiles, 3D paths, 3D nodes) for 

creating parts whose surfaces are curved in two directions: turbine blades, boat propellers, ship hulls, 

aircraft fuselages. 

                   

 

                          

MAIN CONCEPTS  

Worksurfaces are defined parametrically in the special coordinate systems: 

- cylindrical; 

- spherical; 

- toroidal (ring-shaped). 

The parametric coordinates are always counted with respect to an orthogonal (Cartesian) coordinate 

system. (The meaning and the range of the coordinates depend on the surface type.) The particular 

Cartesian system can be either the world coordinate system, or a specifically selected local coordinate 

system (LCS).  
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The position of a point in the cylindrical coordinates is defined by three parameters: the radius of the 

cylinder, the shift along the cylinder axis (Z-axis) and the angle (or the arc length) between X-axis and the 

radius-vector of the point projection onto the X-Y plane. 

The position of a point in the spherical coordinates is defined by three parameters: the radius of the 

sphere, the angle between X-axis and the radius-vector of the point projection onto the X-Y plane, and the 

angle between the point radius vector and Z-axis. 

The position of a point in the toroidal coordinates is defined by four parameters: the two defining radii of 

the torus, the angle between X-axis and the point projection on the X-Y plane and the angle between the 

point radius vector and Z-axis direction. 

The parameters defining the radius of the cylinder, that of the sphere or the two torus radii are called fixed, 

as those are the same for all points belonging to one surface. This is a constant characteristic of the given 

surface. The cylinder and the sphere have one fixed parameter – the radius, while the torus – two (the two 

torus radii).  

Therefore, the position of a point belonging to a surface of any type is actually defined in a special 

coordinate system by two orthogonal parameters – the coordinates (U and V). Due to this fact, a mapping 

can be established between any of the special coordinate systems and a rectangular region on a plane (a 

parametric 2D region). This 2D region represents an “unfolding” of the surface onto the plane (according 

to the rules of mapping the UV-coordinates into the Cartesian coordinates for the selected type of surface), 

playing the same role as the image of the workplane on a page of a 2D drawing. Besides, the 2D region 

defines the range of the UV-coordinates. 

Introducing a parametric 2D region allows working with a surface as if with a common workplane. 

Graphic  

Illustration 
Parametric 2D region  Profile in 3D  

Spherical coordinates  

 

 
U – angle from X-axis (0-2) 

V – angle from Z-axis (0-) 

R – radius of the sphere 
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Cylindrical coordinates  

 

 
U – angle from X-axis (0-2) or arc 

length counted from X-axis (0-2R) 

V  Z-coordinate (-,+) 

R – radius of the cylinder 

 

Toroidal coordinates  

 

 
U – angle from X-axis (0-2) 

V – angle from the vector R in the 

plane ZOR (-,+) 

R – torus major radius, 

r – torus minor radius 

 

DATA REQUIRED FOR CREATING A WORKSURFACE  

When creating a worksurface of any type, you need to define: 

 The parametric 2D region (a rectangular region in the 2D drawing) – the unfolding onto a plane of the 

surface being created; 

 The fixed parameter value for this surface (the radius of the sphere or cylinder, or the two torus radii); 

 The original Cartesian coordinate system (the world coordinate system or an arbitrary LCS), with respect 

to which the parametric surface coordinates are defined. 
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Parametric Region 

The parametric 2D region of a worksurface is defined on one of 2D pages of the current document. The 

size and position of the parametric region in the drawing units is defined either by the system automatically 

or by the user (by specifying two 2D nodes as the diagonal corners of the region). The size of this region 

in the parametric coordinates is always constant, depending on the type of the surface being created 

(entered as the “ranges” in the table above). The region extents along the Х-axis are mapped onto the 

allowed range of the parameter U, along the Y-axis – onto V (the reverse configuration is also supported).  

In the cases when the position and size of the parametric region are defined by the user (by selecting two 

2D nodes), the direction of the worksurface axes is determined by the nodes selection order and position. 

The diagrams below show the configurations of the UV-axes directions with respect to the order of node 

selection.  

                        

When the parametric 2D region of the worksurface is defined automatically, the axes are always directed 

as shown on the right-hand-side figure. 

In spherical and toroidal coordinate systems, both parameter axes represent angular coordinate values. 

The exception is the cylindrical coordinate system. Since a cylinder can be “unwrapped” onto a plane 

without distortions, linear units can be used as cylindrical coordinates. The V-axis units are always linear, 

while the units of the U-axis can be either angular (the angle between the radius vector and X-axis) or 

linear (U being the linear distance as measured along the cylinder unfolding).  

When using linear units along the U-axis of the cylindrical coordinates, the second 2D node defines only 

the axes orientation. The size of the parametric region along the U-axis in this case is equal to 2R, where 

R is the cylinder radius. The diagram below shows the way of defining the parametric region for a cylindrical 

surface, when linear units are used in both axes.  

 

When using angular units along the U-axis in cylindrical coordinates, both nodes are used. The linear 

distance between the two nodes along the U-axis is considered equal to the angular value of 2. The linear 

coordinates in this direction will be converted into the angular ones based on this constant. 
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The choice of units along the U-axis – linear or angular – depends on a particular task. If the 2D construction 

to be carried over on a cylindrical worksurface is described in linear units, then it may be more convenient 

to use linear units along the both axes of the cylindrical coordinates. In this case, the 2D construction will 

be carried over to the 3D space preserving all relations between the construction elements. Use of angular 

units in such a situation will cause distortions in the transition from 2D to 3D. As in illustration, consider a 

simple example of creating a 3D profile on a cylindrical worksurface using a 2D hatch of square shape. One 

can easily see that the profile shape is far from square when using the angular units along the U-axis. 

Meanwhile, when using the linear units, the 3D profile matches the shape of the hatch.  

 

 

Use of the angular units along the U-axis of the cylindrical coordinate system makes sense only in the cases 

when the original 2D constructions are described using angular values. For instance, in the following 

example, the original 2D data for creating a model of a heat exchanger are defined in the angular values 

on the surface of a cylinder. Use of angular units helps easily getting the desired result (provided that the 

boundaries of the parametric region of the worksurface were defined correctly).  
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To be comfortable when working with angular units, use the following rule. The distance between 

the 2D nodes along the U-axis must be set so that the total width of the parametric region along 

the U-axis (that is, the respective distance between the nodes defining its boundary) is a multiple of 

360 (in degrees), or 2 (when using radians).  

When working with worksurfaces of any type, keep in mind the following. Any of the worksurfaces are 

periodic in one or both UV-parameters. Therefore, a parametric surface has cycles in the direction in which 

it is periodic. The diagram below shows periodicity of a parametric 2D region for spherical and toroidal 

surfaces.  

 

In the case of a cylindrical surface, the parametric 2D region cycles only along the U-axis.  

 

The Fixed Parameter and the Cartesian Coordinate System of the Worksurface 

A fixed parameter value (two parameters – in the torus case) is defined with a numerical value. When 

creating a worksurface by an existing geometrical surface, the fixed parameter value is determined by the 

specified offset along the radius of the source geometrical surface. 

The position of the worksurface in space is defined by selecting a Cartesian coordinate system. The 

parametric coordinates will be counted with respect to the system. An arbitrary LCS can be selected as 

such a system. If no local coordinate system is specified, the world coordinates are used. 
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When constructing a worksurface by an existing geometrical surface, the coordinate system of the source 

geometrical surface is used as the Cartesian coordinate system. 

INTRODUCTION TO WORKSURFACES  

To understand how worksurfaces are created and used, let's review a brief example. 

Suppose, we need to wrap a text on a cylindrical body face. To do this, let's create a 

cylindrical worksurface coinciding with the surface of that cylindrical body face. Then 

it is possible to create a 2D element-text on that surface, and use it to create a 3D 

profile and a text-like looking body. 

To create a worksurface, select a cylindrical face of the source body in the 3D window 

and call its context menu. In the context menu, select the command Create/Construct 

Worksurface. 
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As a result, the command will be launched, 3SU: Construct Worksurface.  

Upon entering the command, the cylindrical face will be automatically selected. To create the worksurface, 

just click . As a result, a cylindrical worksurface will be created, which coincides in the radius and position 

in the space with the source face, or, rather, with its geometrical surface. 
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The command's properties window displays the parameters of the surface being created. Those do 

not need to be changed.  

The “Offset” parameter defines the difference between the source face radius and that of the surface 

being created. The required “0” value is already set by default.  

The “Units” parameter defines, what units will be applied along the U-axis. The default setting 

“Linear” should also be left unchanged. 

By now the worksurface is created. Now we need to create the 3D profile-text 

on it. To do that, select the created surface and call its context menu by right-

clicking . In the menu select the command Draw On Workplane. A separate 

window will open with the 2D drawing page, corresponding to the selected 

worksurface. A box will be marking the parametric 2D region of a worksurface 

on the page. 

Let's create the required text on the 2D page. Finish drawing on the active 

worksurface by clicking  on the control panel of the active workplane 

(actually, a surface in this case). 

Upon leaving the mode of drawing on the active worksurface, a 3D profile will 

be automatically created based on the 2D text. 

 

  

What is left is to extrude the 3D profile to the required height and perform a Boolean addition of the 

resulting text and the source cylinder. 
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Let's see another example. In it, we need to apply a text on a cylindrical-shape 

plate while maintaining a specified offset distance from the plate borders.  

In this example, two worksurfaces will be used. We will construct the first 

one by the cylindrical face of the source body. On it, let's create the 3D 

profile of the plate contour. We will construct the second worksurface by 

the outer face of the plate. The 3D profile-text will be created on the 

latter worksurface. 

The difference of this example from the previous one is that in this case 

we need to know how precisely the worksurfaces and their source faces 

are positioned relative to each other. Otherwise, it will be impossible to 

precisely position the plate on the cylindrical body, and the text – on the 

plate. 

To precisely position the worksurface, one can use an additional 3D 

point. The surface coordinate origin will be placed at that point. 

Let's create a 3D node on the face of the source body where the lower-

left corner of the plate shall be positioned. Next, as in the previous 

example, we need to select a cylindrical face of the source body, call its 

context menu and launch the command Create/Construct Worksurface. 

We again will leave unchanged the default parameters of the 

worksurface being created. But, before confirming the surface creation, 

we will enable the automenu option: 

 

 

 <1> Select starting point 

Using this option, we will select the 3D node created earlier. The surface 

coordinate origin will be positioned where the node projects (maps) on the 

surface. 

After selecting the 3D node, the worksurface creation can be finilized by 

clicking . After that we will select the worksurface and call from its context 

menu the command Draw On Workplane. As in the previous example, after 

calling the command, a separate window will open with the 2D drawing page 

corresponding to the selected worksurface. 

A box on the page will be marking the parametric 2D region of the 

worksurface. The worksurface coordinate origin (the lower-left corner of the 

box) corresponds to the 3D node that defines the lower-left corner position 

of the would-be plate. 

 

By accepting the lower-left corner of the box as the base point, let's create the necessary 2D 

constructions to create the plate contour. To create the 3D profile, we need to apply graphic lines and/or 

hatch. Finish working in the mode of drawing on the active worksurface by clicking  on the 
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control panel of the active workplane. Upon exiting the mode of drawing on the worksurface, the plate's 

3D profile will be automatically created. The plate body is created by  extruding the resulting 3D profile. 

 
 

 

To create text on the plate, we will construct a second worksurface. The construction will be similar to the 

previous cases. To define the surface coordinate origin, select one of the vertices (the lower-left one) of 

the plate's upper face. 

 

  

After creating the second worksurface, we will go into the mode of drawing on it (the command Draw On 

Face in the surface's context menu). On the worksurface page, mark the plate boundaries. After that, apply 

2D text at the desired position on the plate. 
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Next, the 3D profile on the worksurface is created based on the 2D text. The profile 

is extruded, and a Boolean addition with the plate body is performed. 

In the described example, we relied on a 3D point selection as the worksurface 

origin to precisely position the 3D profile contour on the worksurface. The same 

goal could be achieved using a different method.  

 

Working in the mode of drawing on the active worksurface (the command Draw 

On Workplane in the context menu) is mostly analogous to working in the 

respective mode on a workplane. The only difference is that one can draw on a 

workplane both in 2D window and directly in the 3D window. For a worksurface, 

only the mode of drawing in the 2D window is available. Besides that, all other 

functions of this mode are supported for a worksurface, including the capability of 

projecting (mapping) a 3D point on the active plane/surface. 

 

In our example, one could have skipped selecting additional 3D nodes as the origin for worksurfaces, but 

rather have them mapped in the drawing-on-surface mode. After that, it is possible to create all underlying 

construction for the 3D profile contours based on the created 2D nodes-the projections. 

METHODS OF CREATING WORKSURFACES  

There are three methods to create a worksurface: 

 Creating a worksurface by an existing geometrical surface of the respective type (a surface 

underlying a face, 3D profile, another worksurface). This method was used in the 

aboveDescribed examples. 

 Creating an arbitrary worksurface (that is, without being based on existing geometrical surfaces 

in the 3D model) in the 3D window.  

 Creating an arbitrary worksurface based on 2D constructions (in the 2D window). 



Three-dimensional modeling  

204 

Worksurface Based on Existing Geometrical Surface 

Worksurface creation by an existing geometrical surface is performed in the 3D window. To define the 

source data, select a 3D object related to the intended geometrical surface. As a result, a worksurface is 

created that coincides with the source geometrical surface. 

                      

Additionally, you can specify an offset amount (two offsets for a torus), which defines the difference 

between the source and target surface radii. In this case, a worksurface will be created as an equidistant 

(offset) to the source geometrical surface. 

 

The source geometrical surface coordinate system is used as the Cartesian coordinate system for the 

created worksurface. The coordinate system position for the worksurface being created can be adjusted 

by selecting an additional 3D point. The point will determine the worksurface coordinate system origin 

(that is, the X-axis direction of the Cartesian coordinate system). Two 3D points are defined for a spherical 

worksurface – first determining the X-axis direction, and the second adjusting the Z direction (and, 

therefore, the Y-axis). 
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A separate 2D page of the “Workplane” type is automatically created for a constructed worksurface. The 

page's format frame size is determined automatically by the size of the 3D object that was used to define 

the source geometrical surface. The parametric 2D region of the worksurface is also created automatically. 

Its size is equal to the size of the page format frame. 

The created worksurface is by default displayed in the 3D window. 

Arbitrary Worksurface 

An arbitrary worksurface is also created in the 3D window. To create a worksurface by this method, you 

need to specify the type and the radius (two radii for a torus) of the surface being created.  

Additionally, you can specify an LCS, relative to which the parametric coordinates of the worksurface will 

be counted. 

As in the previous method, a separate 2D page of the “Workplane” type is automatically created for such 

worksurface. The dimensions of the page format frame and the parametric 2D region worksurface are 

automatically determined by the system. 

Worksurfaces of this type are also displayed in the 3D window by default. 

Worksurface Based on 2D Constructions (in 2D Window) 

Creation of a worksurface of this type is done in the 2D window, on an already existing drawing page of 

any type. To create the surface, you need to define the boundaries (two diagonal corners) of its parametric 

2D region. The region boundaries are defined using two 2D nodes. The position and the order of selecting 

the 2D nodes determine the direction of parametric axes of the worksurface. Besides that, the radius is to 

be defined (two radii for a torus) of the surface being created. 

Additionally, you can specify an LCS, relative to which the parametric coordinates of the worksurface will 

be counted. 
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A worksurface of this type can be created on a 2D page that is already related with other worksurfaces or 

planes. In this case, the boundaries of the parametric 2D region are used by the system to automatically 

match the 2D elements found on this page, with the respective worksurface/plane (when creating 3D 

elements – 3D profiles, 3D paths). 

If several worksurfaces/planes are related to a 2D drawing page, those cannot be activated. 

RULES OF CREATING WORKSURFACES  

To create a worksurface, use the command 3SU: Construct Worksurface: 

Icon Ribbon 

 

3D Model → Construct → Worksurface 

Keyboard Textual Menu 

<3SU> Construct > Worksurface 

Upon calling the command, the following options are available in the automenu: 

 <S> Select Face 

 <1> Spherical coordinate system 

 <2> Cylindrical coordinate system 

 <3>  Ring-shaped coordinate system 

The first option –  – serves to construct a worksurface by an existing geometrical surface.  

The other three options – ,  and  – are used to construct either an arbitrary worksurface in the 

3D window or a worksurface based on 2D constructions (in the 2D window). How a worksurface will be 

created depends on where the 3SU: Construct Worksurface command call originated – from the 3D 

window or from the 2D window. 

Creating Worksurface by an Existing Geometrical Surface 

To create a worksurface by an existing geometrical surface, use the option . It is turned On by default. 

With the option enabled, select a 3D object in the 3D window or in the model tree, suitable to define a 

surface of the cylindrical, spherical or toroidal type. This could be a face of the respective type, a 3D profile, 

or an existing worksurface. 



Worksurfaces 

207 

After selecting the source 3D object, the system will 

automatically determine what-type worksurface will 

be created. The command's properties window will 

have the dialog to define parameters of the given 

worksurface. 

Depending on the type of the created worksurface, 

you can define the values of one or two offsets in the 

properties window. The offsets determine the 

difference between the radius of the source 

geometrical surface and the radius of the worksurface 

being created. 

Original direction of worksurface coordinate axes 

corresponds to direction of the parent surface. 

Reverse Direction flag in the Properties dialog box 

will reverse direction of both axes. 

 

 

 

Additionally, the option is available in the automenu to select a 3D point defining the worksurface 

coordinate origin: 

 <1> Select starting point 

When creating a spherical worksurface, yet another option will be available in the automenu – to define 

the second 3D point to adjust the Z- and Y-axis direction of the Cartesian coordinate system:: 

 <2> Select Pole point 

A 3D point (3D points) selection can be canceled with the option: 

 <D> Cancel selection of points setting surface orientation 

Creating an Arbitrary Worksurface (in the 3D Window) 

To create a worksurface of this type, you must call the command 3SU: Construct Worksurface from the 

3D window. After entering the command, you need to specify the type of the surface being created, by 

selecting the desired automenu option ( ,  or ).  
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After selecting the surface type, the command will go into 

the mode of creating the worksurface of the selected type. 

Define the radius of the surface being created in the 

command's properties window (two radii for a torus). The 

surface creation can be completed right after defining the 

radius (radii), by clicking  (in the automenu or in the 

command's properties window). 

To define an LCS, relative to which the parametric 

coordinates of the worksurface will be counted, use the 

option: 

 

 <L> Select target LCS 

The option to cancel a local coordinate system selection is: 

 <D> Eliminate target LCS 

The system will automatically define the parametric 2D region of the worksurface being created (on a 

separate drawing page of the “Workplane” type). If necessary, you can manually define the boundaries of 

the parametric 2D region of the worksurface being created, using the nodes on the same or another 2D 

page. To do that, use the same options as when creating a worksurface based on 2D constructions. 

Creating an Arbitrary Worksurface Based on 2D Constructions (in the 2D 

Window) 

To create a worksurface of this type, you need to call the 3SU: Construct Worksurface command from the 

2D window. Upon entering the command, just like in the previous case, you need to specify the type of the 

surface being created (the option ,  or ).  

After that, you need to define the parametric 2D region of the worksurface being created. If there are no 

worksurfaces or planes on the current 2D page, then the system will select the region boundaries 

automatically according to the page format frame size. If, on the other hand, the current drawing page is 

already related with worksurfaces or planes, or if you are not satisfied with the system choice, define the 

boundaries of the parametric 2D region by selecting two 2D nodes with the options: 

 <F> Select Node as origin of parametric region 

 <S> Select Node as second border of parametric region 

The start and end points should not coincide. Otherwise, it will be impossible to determine the orientation 

of the U and V axes. 

By default, the range along the Х-axis of the parametric region is mapped onto the range of U parameter, 

the Y-axis – onto V. This can be changed by the option: 
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 <3> Shift coordinate axes 

The fixed parameter value of the worksurface being created (the surface radius) is defined in the 

command's properties window. 

If the worksurface is to be created relative to a local coordinate system, then you need to use the option: 

 <L> Select target LCS 

To cancel a local coordinate system selection, use the option: 

 <D> Eliminate target LCS 

The visible boundaries of a worksurface on the drawing are by default aligned with the defined boundaries 

of the parametric 2D region. The visible boundaries can be modified with the options: 

 <B> Define Workplane borders 

 <Tab> Switch Workplane borders 

 <K> Eliminate borders 

These options work in the same way as those provided for common workplanes. 

By default, a created worksurface of this type will not be displayed in the 3D scene. To make it appear in 

the 3D window, enable the Show on 3D View flag in the command's properties window. 

You can finalize worksurface creation by clicking  (in the automenu or in the command's properties 

window). 

WORKSURFACE REPRESENTATION IN 3D  V IE W  

It is possible to control the visibility of the working surface 

by the special flag Show in 3D View available in parameters 

dialog box when creating/editing a worksurface. By default 

this flag is turned on, that is to display the worksurface in 

3D view. When flag is turned off the worksurface will be not 

shown in 3D view. 
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3D NODES 

A 3D node is a T-FLEX CAD element, representing a point in the three-dimensional space. Main use of 3D 

nodes is as a reference for snapping other three-dimensional objects: additional workplanes, profiles, local 

coordinate systems, etc. 3D nodes help defining objects necessary for performing operations, such as an 

extrusion vector, an axis of revolution. 

There are several types of 3D nodes. These can be divided into three main groups: nodes based on existing 

3D elements, nodes defined in absolute coordinates, and nodes based on 2D nodes. 

The display size of 3D nodes on the 3D scene is defined in the command ST: Set Document Parameters 

on the tab 3D > View. 

THE WAYS OF NODE CREATION  

To create a 3D node, use the command 3N: Construct 3D Node: 

Icon Ribbon 

 

Draw → Construct → 3D Node 

Keyboard Textual Menu 

<3N> Construct > 3D Node  

This command helps creating the following types of 3D nodes: 

1) Based on existing 3D elements: 

- 3D nodes; 

- Vertices; 

- Local coordinate systems; 

- 3D profiles/paths; 

- Edges; 

- Workplanes; 

- Faces; 

- Operations; 

- At the center of elliptical edge; 

- At the center of a sphere or torus; 

- At an intersection of elements; 

- By shortest distance between elements; 

- By faces and offsets; 

- At the center of gravity; 

- At an intersection of three planes; 
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2) In absolute coordinates; 

3) By two projections. 

USING DRAGGER FOR CREATING 3D  NODES  

The draggers can be used for creating 3D nodes in the following situations: in absolute coordinates, relative 

to another 3D node, vertex or a local coordinate system. Draggers can also be used for defining a node 

relative to the center of an elliptical edge or a surface, which is a sphere or torus. A dragger appears as a 

coordinate system. It allows moving a 3D node along one axis or simultaneously in two dimensions. 

 

       

To move a 3D node along one axis, simply move the cursor to one of the node dragger axes.  The respective 

axis will be highlighted in yellow color (by default). Upon clicking , the selected axis becomes pink (by 

default), and the dragger starts moving along the selected axis following the cursor. The subsequent 

clicking  fixes the dragger (and the respective 3D node) in the position of the click. 

Moving the node simultaneously in two dimensions is done similarly. To do this, simply move the cursor 

to the dragger and place it between two axes. The axes will highlight. Upon clicking  the dragger starts 

moving after the cursor in the plane defined by two axes. The subsequent  fixes it in the new position. 

Moving the dragger of the 3D node being created causes update of the node coordinates (offsets) in the 

property window. Vice versa, modifying the coordinates of a 3D node in the dialog box moves the node 

dragger. 

MAIN NODE CREATION TECHNIQUES ON A 3D  ELEMENT OR 

REL ATIVE TO A 3D  ELEMENT  

The following automenu option provides for most common ways of creating 3D nodes based on existing 

3D elements: 

 <S>  Create 3D Node on element or relative to element 
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The option becomes active right after entering the command. To 

create a 3D node based on a 3D element, simply select the desired 

3D element in the 3D scene or model tree. Such a 3D element can 

be an existing 3D node, a local coordinate system, 3D profile or path, 

a workplane, operation, face, edge or body vertex. When selecting 

3D elements, pay attention to the state of element selection filters in 

the pull-down list under the option  or in the system toolbar. 

 

Depending on the selected element, the appearance of the 

automenu or the property dialog box will adjust accordingly. 
 

Creating Node Based on Existing 3D Node, 3D Vertex or Local Coordinate 

System 

Selecting an existing 3D node, 3D vertex or a local coordinate system brings up the node coordinate 

definition dialog box in the property window, and a coordinate system-shaped dragger in the 3D 

scene. The dragger coordinate system origin coincides with the selected 3D element (the origin in 

the case of a local coordinate system). The dragger axis directions coincide with: the world 

coordinates axis directions - when selecting a 3D node or vertex, and with the axes of the selected 

coordinate system – when selecting a local coordinate system. 

 

The position of the node being created is defined in local coordinates either directly on the 3D scene, 

or using a dragger, or else by entering exact numerical values in the section Coordinates of the 

property window. The absolute node coordinates (in the world coordinate system) are displayed in 

the section Absolute coordinates of the same dialog box. 

 

Too quickly reset coordinates of a node to 0, use the following additional automenu option: 

 <Z>  Move Node to coordinate system origin 
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Additional options, collected in the section Options, help tuning the 

command for the following modes: 

Enable dragger. Toggles the display of the dragger of a 3D node in 

the 3D scene. When unchecked, the dragger is not displayed. 

Keep previous coordinates. When set, the relative coordinates, 

defined for the node being created, are remember and will be preset 

by default in the dialog box when creating the next node. 

Keep selected coordinate system. When set, the selected 3D element 

(a vertex or a local coordinate system) will be re-used as the origin 

for new nodes to be created. 

The created 3D node is placed in the specified position with respect to the 

parent element. Upon any modifications to the parent position, the created 

3D node will also change its position according to its relative coordinates 

defined at creation. 

 

Creating Node Based on Single Connected 3D Profile, 3D Path, or Edge 

Selection of a 3D profile (single connected only), 3D path or edge activates the mode of creating a node 

on the selected element. The selected element is highlighted. To create a node, upon selecting the parent 

element do the following: 

- Select the origin point for defining the node position on the parent element; 

- Specify the position of the node being created on the parent element by the offset distance 

from the reference point (along the parent element). 

When the mode starts, the property window displays a 

dialog box for defining node parameters. The dialog has 

two sections. The section Parameter and Offset serves for 

defining the reference point and the node position on the 

parent element. The section Absolute coordinates 

displays the current absolute coordinates of the node 

being created. 

The origin point for positioning the node can be specified 

as: start, end, center of the parent element or an arbitrary 

3D point. 

The start point of a 3D profile, path or edge can be 

distinguished from the end point by the kind of 

element highlighting: an arrow at one of the ends 

of the highlighted element indicates the end point. 

In the case of closed 3D elements, the positions of 

the start and end points coincide. 

 



Three-dimensional modeling 

214 

In the case of using an arbitrary 3D point as the origin, two possibilities exist. If the selected point belongs 

to the parent element, then it will be used as the origin point. Otherwise, the reference point will be the 

nearest point on the parent element to this specified 3D point. 

Selection of the origin point is done in the property 

window from the list under the Origin item. The pull 

down list of values contains the following options: 

Start, End, Center, Point. Before selecting the latter 

option, specify a 3D point to be used as the origin 

for defining the node position on the parent 

element. An additional option is provided in the 

automenu for selecting the point: 

 

 <G> Set point for offset origin 

Upon activating the option, one can select the desired 3D point right in the 3D scene. The 3D node used 

as the origin can also be selected in the 3D model tree. 

To reject the selected point, use another additional option: 

 <X> Cancel selection of offset origin 

The node position on the parent element can be defined either in the property window or directly in the 

3D scene. When using the property window, first choose the way of defining the distance by setting the 

switch By Parameter/By Offset as desired: 

- By Parameter. The distance from the origin point is set in the relative units (0 – the position of 

the origin, 1 – the distance equal of the length of the whole parent element). For example, if 

the midpoint of the profile/path is used as the origin, then parameter values can vary in the 

range [-0,5;0,5]. 

- By Offset. The distance from the origin is set in the model units. 

Should the user enter the value of the offset greater 

than the length of the parent element, the node is 

constructed at its end. An additional field appears in 

the property window, Offset used, that displays the 

actual distance from the origin point to the created 3D 

node. 

As the parameter or the offset is modified in the dialog 

box, the node in the 3D scene moves accordingly. 

 

In the 3D scene, simply point the mouse cursor to the desired position of the node on the object and click 

. On subsequent clicks in the 3D scene, the node will move to the new position. 

At the beginning of node creation, its position coincides with the position of the mouse click 

selecting the parent 3D element. 
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Creating Node Based on Workplane 

Selecting a workplane creates a 3D node on the workplane. The node position is defined in X-Y or U-V 

coordinates in the workplane coordinate system. The coordinates can be defined in the 3D scene using the 

mouse or by numerical values in the property window. 

Upon selecting the plane, the preview image of the node 

appears at the position of the mouse click selecting the 

plane (or at the coordinate system origin, if the plane was 

selected in the model tree). On subsequent clicks in the 3D 

scene, the node will relocate to the new position. 

In this mode, the property window contains a dialog box 

for specifying the exact values of the node coordinates (the 

section “Offsets”). Meanwhile, the additional section 

Absolute coordinates tracks the position of the node being 

created in the world coordinates. 

The flag Scale defines the way of specifying the node 

coordinates: with the flag set, those are the X-Y 

coordinates, cleared – the U-V coordinates of the 

workplane. 

 

Creating Node Based on Underlying Surface 

Selecting face as a parent element allows creating a 3D 

node on its underlying surface. The node position on the 

surface is generally defined in U-V coordinates.  

In the special case of selecting a flat face, one can define 

X-Y coordinates of the node as the local coordinates on 

the face plane. The origin position and the direction of the 

X and Y-axes in this case are defined by the system 

arbitrarily. 

Upon selecting a face (in the 3D scene or in the 3D model 

tree), it is highlighted (by default – green). The node will 

be displayed at the point of the mouse click selecting the 

face. The desired position can be defined by another click 

 in the 3D scene or via the property window. 
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The kind of the dialog box in the property window 

depends on the type of the selected face. If the face is flat, 

the dialog box is similar to that used for node creation on 

a workplane. It allows defining the exact values of local 

coordinates of the node being created (X-Y or U-V, 

depending on the state of the flag “Use Coordinate 

Scale”). When selecting a non-flat plane, the dialog box 

allows defining U-V node coordinates only. 

 

Creating Node Based on Operation 

When selecting an operation as the parent element, the command switches to the mode of node creation 

at the center of gravity of the body or a group of bodies, as described below. The selected operation 

becomes the first body in the group that will be used for constructing the 3D node. 

SPECIAL WAYS OF CREATING NODES BASED ON EXIST ING 3D  

ELEMENTS  

Special ways of creating 3D nodes based on existing 3D elements are separated into a special group of 

options in the automenu, inactive by default. 

Creating Node at Center of Elliptical Edge or Center of Sphere or Torus 

A 3D node can be constructed at the center, or, rather, relative to the center of an elliptical edge or a 

surface of a sphere or torus. To do this, use the following automenu options of the node creation 

command. 

To create a node relative to the center of an elliptical edge: 

 <C>  In center of elliptical edge  

Upon calling the option, specify an elliptical or circular edge (note that a circle is a special case of an ellipse). 

The node will be created relative to the center of the ellipse to which the selected edge belongs. 

To create a node relative to the center of spherical or torus surface, use the option: 

 <U> In center of spherical or torus face  

Upon calling the option, specify a spherical or torus face. The node will be created relative to the center of 

the surface (sphere or torus) to which the selected face belongs. 
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In either case, node creation is similar to creating a node relative to 

another 3D node or vertex. Selection of the parent element (edge or 

face) brings a dialog box for defining the coordinates of the node in 

the property window, and a coordinate system-shaped dragger in the 

3D scene. The origin of the dragger coordinate system coincides with 

the center of the edge or surface (depending on the option used). The 

directions of the dragger axes coincide with the directions of the axes 

of the world coordinate system. 

The position of the node being created is defined in the relative 

coordinates or directly in the 3D scene by using the dragger or by 

specifying the exact numerical values of the offsets in the section 

Coordinates of the property window. 

The absolute coordinates of the node (the world coordinates) are 

displayed in the section Absolute coordinates of the same dialog box. 

To quickly reset the specified offsets, use an additional automenu 

option: 

 

 <Z>  Move Node to coordinate system origin 

Creating Node at Intersection of Elements 

A 3D node can be constructed at an intersection of two 3D elements: the first and the second. To construct 

a node, virtually any elements can be used: a path and a body, two paths, an edge and a body, etc. The 

pairs of 3D elements admissible for selection are defined solely by the possibility of getting an intersection 

between those resulting in a point. To exclude situations when the intersection of the specified elements 

is not a point, only a curve or a line are allowed as the first element, while the second element to intersect 

can be a curve, a line, a sheet body or a solid body.  

To create a node, specify the 

intersecting elements. The order of 

selecting the elements is not important. 

The second element to intersect can be 

selected ahead of the first one. Upon 

specifying both elements, the system 

defines the point of intersection for 

creating a node there. Meanwhile, the 

property window displays its absolute 

coordinates. If several intersection 

points exist, then the one is selected by 

default that was nearest to the element 

selecting clicks. A different intersection 

can be selected if necessary. 
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This mode is turned on by the option: 

 <Q>  Construct 3D Node on intersection of elements 

Upon calling this option, the command switches into the mode of defining the first element. The automenu 

gets additional options: 

 <W>  Select curve as first element 

 <L> Select axis as first element  

These options allow selecting a curve or straight line to use as the first intersecting element. When selecting 

3D elements for the line, pay attention to the state of the element selection filters of these options. 

To reject the first selected element, use the option: 

 <X> Cancel selection of first element  

To proceed with defining the second element, use the option: 

 <T> Select second element  
 

Upon defining the first element, the command automatically switches to the mode of defining the 

second element. 

The following options are used in the mode of defining the second element: 

 <W>  Select curve as second element  

 <L> Select axis as second element  

 <F> Select surface as second element 

 <E>  Select sheet body as second element  

 <B> Select body as second element  

As appears from option names, those allow selecting a curve, straight line, plane, surface, solid body, or 

sheet body as the second intersecting element. When selecting 3D elements defining a line, surface, or 

body, the element selection filters are used. 

To reject selection of the second element, use the option: 

 <X> Cancel selection of second element  

To return to the mode of specifying the first element, use the option: 

 <T> Select first element 
 

If selected elements have multiple intersections, use the following option to select the desired one: 

 <N> Select another intersection 
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Creating Node by Shortest Distance between Elements 

A 3D node can be created by the shortest distance between two 3D elements: 

 <R> 
Construct 3D Node using shortest distance 

between two elements 

Upon calling this option, specify two 3D elements. Either one can be an edge, loop, face, 3D path or body. 

The second element can also be a 3D point. The elements can be specified in any order, however, note 

that a 3D node is always created on the first element at the location nearest to the second element.  

Upon selecting the mode of 3D node creation by the shortest distance between elements, the command 

goes into the mode of defining the first element. The following additional options appear in the automenu: 

 <E>  Select Edge  

 <L> Select Loop 

 <F> Select Face 

 <T> Select 3D Path 

 <B> Select Solid 

These options allow selecting a 3D object of the required type as the first element. 

Proceed with defining the second element using the option: 

 <N> Select second element  
 

Upon defining the first element, the command goes into the mode of defining the second element 

automatically. 

In the mode of defining the second element, similar options are used. The following options appear in the 

automenu for selecting the second 3D element: 

 <E> Select Edge 

 <L> Select Loop 

 <F> Select Face 

 <T> Select 3D Path 

 <B> Select Operation 

 <V> Select 3D point 

To return to the mode of specifying the first element, use the option: 

 <N> Select first element  
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Creating Node by Faces and Offsets 

Creating a 3D node by faces and offsets from a solid is a special case of creating a node on a face. In this 

mode, first specify the base face for the node to be placed on. The required node position on this face is 

defined using two additional faces of the same body, adjacent to the base face (having a common edge), 

and their offsets. To create the node, offsets are constructed from the additional faces at the specified 

distances. The node is defined as the intersection point of the base face and the offsets.  

All three faces can have the underlying surface of any type (a plane, torus, sphere, cone, spline surface). 

Alternatively, the additional faces can be selected by selecting the edges that join the faces with the base 

face. 

In this mode, 3D node construction is done as follows: 

- The offsets from the additional faces are constructed. The offset distances are defined by the 

values entered for those faces. In the case of a positive distance, the offset is constructed inside 

the body, negative - outside.  

- An intersection of the base face and the offsets of the additional faces are calculated. The 

resulting intersection will be the point of the 3D node creation. 

In simple cases, the face surfaces can be extended beyond the bounds (both the base and the 

offsets). For a plane and cone, this extension is unlimited, while for a torus or a sphere it is closed. 

This allows, for example, creating a node beyond the bounds of the base face, yet lying on its 

underlying surface (when the offset distance is negative). This also allows constructing 3D nodes in 

the situations when the offsets from the additional side faces do not intersect with the base face. 

 

The mode of creating a 3D node by faces and offsets is invoked via the following automenu option 

provided in the command: 

 <O> Construct 3D Node using faces and offsets 

Upon starting this mode, additional options for selecting faces appear in the automenu. Select the base 

face using the following option: 

 <F> Select face containing 3D node 
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Was selected face is highlighted in green (by default). A set of options for selecting additional faces or their 

defining edges becomes available in the automenu: 

 <E> Select Edge that sets the first offset  

 <T> Select Face that sets the first offset 

 <D> Select Edge that sets the second offset 

 <G> Select Face that sets the second offset 

The values of the offset distances from the side faces that define the position on the 3D node being created, 

are entered in the property window, in the section Offsets.  

Setting the additional flag Reverse flips the direction of counting the offset 

distances. The node position on the base face would correspond to the 

negative values of the offsets. When the flag is cleared, the positive offsets 

are inside the body, meaning that the node is created within the face. 

The desired node position on the base face can be directly specified in the 

3D scene by clicking . Meanwhile, the property window will display the 

corresponding values of the offsets. 

 

Creating Node at Center of Gravity 

Creation of a 3D node at the center of gravity of one or several bodies is performed using the following 

option: 

 <M>  Create 3D node in center of mass  
 

To enter this mode, you can also use the option , selecting a body as the defining 3D element. 

In the mode of creating a 3D node at the center of gravity, one or several bodies need to be specified to 

define the node. The center of gravity is calculated for the specified set of bodies, defining the position of 

the 3D node being created. The actual material properties are accounted for when computing the center 

of gravity. 

Upon calling this mode, the following additional options appear in the automenu for selecting the 

necessary set of bodies: 

 <B> Select operation to create 3D node in center of mass 

 <L> Select all operations 

 



Three-dimensional modeling 

222 

Operations can be selected in the 3D scene by clicking  or in the 3D model 

tree. Selected operations are included in the list of the defining operations in 

the property window (the section List of Operations).  

The property window, besides keeping the track of the selected operations, 

supports other actions. For example, one can find the mass by clicking  one 

or several operations in the list of selected, and reading the result in the Mass 

box. The list can be edited. Selected operations in the list can be removed by 

pressing the pushbutton [Delete]. 

An additional section in the dialog box, Absolute coordinates, helps keeping 

track of the position of the node being created in the world coordinates. 

 

One or several selected operations can be excluded from the list not only via the property window, but 

also by direct selection in the 3D scene. To do this, use the following options: 

 <F> Cancel selection of operation  

 <D>  Cancel selection of all operations 

These options become accessible only after at least one operation has been selected. 

Creating Node at Intersection of Three Planes 

Creation of a 3D node at a point of intersection of three planes is carried out with the help of the option: 

 <K>  Point is at intersection of three planes 
 

To create a node in this mode, three planes are specified. To select the planes, use the options of the 

automenu: 

 <0>  Select first plane 

 <1> Select second plane 

 <2> Select third plane 

The given options allow us to select any 3D object capable of defining a plane in the space – planar edge 

or face, workplane, LCS, etc. When selecting 3D objects, the user should pay attention to the state of filters 

of selection of the elements for the given options. 

After specifying all three planes, the coordinates of a point of intersection of 

the given planes will appear in the properties window. After pressing  the 

3D node is created at the given point.     

CREATING NODE IN ABSOLUTE COORDINATES  

To create a 3D node in absolute coordinates, use of the option: 
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 <A> Construct 3D node in absolute coordinates 

Upon selecting this mode, the property window displays a dialog box for defining absolute coordinates of 

the node. Simultaneously, a coordinate system-shaped dragger appears in the 3D scene. The dragger 

coordinate system origin is placed at the point (0,0,0) in the world coordinates. The dragger axis directions 

coincide with the directions of axes of the world coordinate system. 

 

The position of the node being created is defined either directly in the 3D scene by the dragger, or by 

entering the exact coordinate values in the section “Coordinates” of the property window. To quickly reject 

the specified position of the node, use the following additional automenu option: 

 <Z> Move Node to coordinate system origin 
 

CREATING NODE BY TWO PROJECTIONS  

A 3D node can also be created based on its two projections on different workplanes. 2D nodes are used 

as projections. 

             

To create a 3D node, specify two 2D nodes lying on different workplanes. To create a 3D node directly on 

a workplane, specify just one 2D node, that is, just one node projection. The workplane and the two node 

coordinates will define the position of the 3D node in space in this case. To define the height of the node 
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being created above the workplane, the second projection needs to be specified, that is, the second 2D 

node. The two projections define a point in space unambiguously. 

When defining a 3D node by one projection, one can use a 2D node lying on a worksurface. As a 

result, the 3D node is created lying on the given worksurface.  

When defining a node by two projections, erroneous situations might occur. The projection is the point at 

the intersection of the workplane and the normal. The second projection is the second intersection. To 

define a point in space, the two normals must intersect. If two projections do not define a point in space, 

a relevant message is display in the diagnostics window. As a rule, errors occur when defining projections 

on two views that do not have an explicit projective relation. 

For instance, in the case shown on the diagram, one can select Node_2 is the first projection that belongs 

to the workplane “Front”. For the second projection, one can select, for instance, Node_3. Two projections 

unambiguously define a point in space. 

To create a 3D node in reviewed example, one can also use Node_3 on the plan view and Node_4 on the 

side view. To avoid erroneous situations, the drawings on these views have a projective relation, as defined 

by the projecting line Line_1. 

The mode of creating a 3D node by two projections is launched via the automenu option: 

 <J>  Create 3D node by two projections  

Upon calling the option, the command automenu subsequently brings the options for defining 2D node 

projections: 

 <F>  Set 3D node 1st projection 

 <G> Set 3D node 2nd projection 

One can select a 2D node by clicking  in the 2D window. The selected node is highlighted. Also highlighted 

is the workplane that contains the node by default (a workplane contains an element by default when the 

element appearance on the screen is within the workplane bounds). To select a different workplane, use 

the option: 

 <W> Select other workplane 

To cancel use of the second projection (in the case when it is already defined), push the following automenu 

option: 

 <D> Delete 2nd projection of 3D Node 

The absolute coordinates of the node being created are tracked in the property window. 

CREATING 3D  NODES BY GRID OF WORKPL ANES  

Upon creating/editing 3D nodes, in situations, when selection of a 3D point is required, there is a capability 

of transparent construction of a 3D node by the grid of workplanes (without invoking the 3N: Construct 
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3D node command). When the grid is displayed in all operations, in which selection of a geometric point 

is required, it is possible to select the points at the nodes of the grid of workplanes, and also the points of 

intersection of paths and planes. In the latter case, at the nodes of the grid a 3D node is automatically 

created.
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3D PROFILES 

A 3D profile is one of the most important elements in T-FLEX CAD. 3D profile is an oriented contour in the 

three-dimensional space. A 3D profile is oriented based on the orientation of the elements used for 

defining the profile (a workplane, worksurface, face or a set of edges).  

A 3D profile can be created based on a parametric 2D contour located on a workplane page. This allows 

propagating parametric properties of two-dimensional drawings into the realm of solid modeling. 

Unfolding a profile by any means in the space is the base operation for a solid body creation. 

MAIN CONCEPTS .  TYPES OF PROFILES  

Profile Geometry 

In a general case, a 3D profile is a sheet geometry element. For working convenience, profiles in the 3D 

scene are usually rendered as a wireframe, that this is a set of bounding lines (contours). However, one can 

set the 3D profile display mode is a sheet body. 

                     

The contour of a 3D profile can be open. Such a profile will appear and behave as a wireframe geometry 

body in either display mode. For example, extruding such a profile will result in a sheet body, rather then 

a solid body as usual. 

                         

A 3D profile might contain several contours (bounding lines). 

Types of Profiles 

All 3D profiles can be divided into three groups by the ways of their creation: 

1. Profiles created based on 2D elements: 

 hatches; 

 text; 

 graphic lines. 
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The above listed types of profiles can be created by the user explicitly, using a dedicated command, or 

created automatically by a system while managing the active workplane. These profiles are used at the 

initial stage of a solid body creation. As the body is being built by various operations, new surfaces, faces 

and edges are created, that can be used for subsequent operations. These elements can be used as a base 

for creating profiles of other types. 

2. Profiles created on the basis of 3D elements: 

 Loops (closed sequence of edges), faces; 

 Profiles created by using existing profiles. For example, one can copy profiles or create offset 

profiles. One can also project or lay an existing profile on a three-dimensional solid body or 

on some of its faces; 

 Elements of wire geometry (edges or set of 3D paths). 

3. Profiles created by unfolding a surface or a set of surfaces. 

PROFILES  BASED ON 2D  ELEMENTS  

3D profiles created from the elements of 2D drawings are widely used in creation of 3D models. To create 

a profile, one can use hatches, text and graphic entities located on workplane and worksurface pages. 

When using a 2D element lying on a workplane page, the resulting 3D profile will be flat. A 3D profile 

created from a 2D element on a workplane will repeat the shape of the underlying surface. 

Profiles Based on Hatches 

When creating a hatch-based 3D profile, its plane (surface) coincides with the workplane or a surface, 

whose page contains the original hatch. 

A flat 3D profile (based on a hatch on a workplane) can be repositioned in space. This can be done by 

using a 3D node through which the plane of the profile being created should pass. If that is not sufficient, 

one can refine the position of the 3D profile in space by specifying a 2D node (on the workplane containing 

the hatch), to which the selected 3D node should be snapped. 

                                    

To create a 3D profile, one can use any hatches, including the ones created for decorating a 2D 

drawing. Those can be of any type: hatches, fills, outlining or hidden. However, the hatches created 
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for a 2D drawing, are not always suitable for creating a profile of the required shape. In this case, 

one has to create a special hatch for the 3D profile. If such hatch is not necessary on the 2D drawing, 

we recommend using the “Invisible” type or put such elements on a special layer. 

Note that one workplane (or, rather, its page) might contain several hatches, any of which can be 

used for creating 3D profiles. 

Self-intersecting contours 
Use of self-intersecting hatch contours is not allowed for creating a 3D profile. For example, if a hatch 

consists of two contours, then the situation shown on the left-hand side diagram is correct. The right hand 

side diagram shows a situation that leads to creating an erroneous contour. 

 

Initially, a 3D profile could be created based on a correct hatch contour. However, after a later editing of 

2D construction elements, an erroneous situation may occur, which is the self-intersecting contour. In this 

case, an error message is output in the diagnostics window, and the 3D profile regeneration suspends until 

after the problem is fixed.  

This rule (about prohibiting self-intersection of elements of a 2D contour used for creating the 3D 

profile) is applied not only to the profiles created from hatches. Self-intersections should be avoided 

also when using text (some TrueType fonts create self-intersections in certain letter combinations), 

and graphic lines. 

Profiles Based on Text 

3D profiles based on 2D text are created identical to those based on hatches. Additional nodes may be 

specified for positioning a flat profile in the space. However, there is a limitation when creating text-based 

3D profiles. Only TrueType fonts are supported. 

The text in this case is considered a union of closed contours, where each contour is a separate character. 

Thus, the resulting 3D profile is a multi-contour one. 

If elements are encountered in a text that cannot be transformed into the profile contour lines, these 

are ignored. For example, if a roughness symbol was inserted in a text, then only letters and numbers 

in the roughness notation will be used for generating the contour lines, while the strokes of the 

roughness symbol itself will be ignored. 
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Profiles Based on Graphic Lines on Workplane 

A 3D profile can be created based on graphic lines lying on the specified workplane. The involved lines 

may constitute any image. This can be a connected sequence making a closed or open contour, or simply 

a set of separate lines. The graphic lines are even allowed to intersect. However, in this case one will have 

to use the thickening option for the profile being created (see the section “Thickening flat profile”). 

If all graphic lines on the workplane have the same color, then only one 3D profile is always created. To 

create several profiles, the graphic lines of different colors can be used. When creating a profile, the system 

will prompt the user to create a separate 3D profile for each color of the graphic lines. Upon approval, the 

number of the 3D profiles that will be created will be the same as the number of the colors that were used 

in creating the image on the workplane. By default, each 3D profile will be assigned the same color as the 

original graphic line. 
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In parameters of each 3D profile that was created by graphic lines, the lines whose color served as a basis 

for the creation of the given profile will be marked. If desired, the user can modify the color of the original 

lines later or altogether refuse the filtering of lines by color. In the latter case, the profile will be 

reconstructed by all graphic lines of the given plane. 

If the image on the workplane is later modified (for example, new graphic lines added or existing ones 

deleted), the 3D profiles created based on this image will adjust accordingly. 

                                   

Automatic Creation of Profiles from 2D Elements (on Active Workplane) 

A 3D profile can be created by the system automatically at the end of a session on the active workplane. 

In this case, the workplane must contain at least one 2D element of any of the following types:  

 Hatch; 

 A graphic line created by the command SK: Create Sketch or G: Create Graphic Line (the lines of 2D 

projections are not considered in this case); 

 Text (using a TrueType font). 

The 3D profile creation algorithm depends on the type of 2D elements present in the workplane. In the 

case when only graphic lines are present on the workplane, the system automatically creates a single new 

profile (the single-contour or multi-contour one). When later adding new graphic lines, the system will 

automatically add contours to the existing profile. If the identified graphic lines intersect, then use the 

thickening option for creating a 3D profile. 

When several different types of elements are present in the active workplane, all suitable for creating a 

profile, then the system works differently. The graphic lines are ignored in this case. The profiles based on 

hatches and text only will be created at the end of the active workplane session. A separate profile will be 

created for each hatch and each text. Only if no 3D profile could be created from any hatches or text in the 

workplane, the graphic line-based profile will be created. 
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PROFILES  BASED ON 3D  ELEMENTS  

Profiles Based on a Loop or a Face  

This type of a 3D profile is created based on a loop (a closed chain of edges) or face (set of faces) of the 

3D solid body. The geometry of this kind of profile is fully defined by the selected elements of the 3D body 

and adjusts to the body geometry modifications. In a general case, this type of profile may not be flat. 

Projecting Profile on a Face or a Body 

A 3D profile can be created as a projection of another existing 3D profile on all faces of a 3D body or on 

its single face. In the case of projecting on all faces, the body itself is selected, when projecting on a face – 

a specific face. In this case, remember the following restriction: the projection of the selected profile should 

fully fit within the selected surfaces. 

The projection vector of the original profile is defined either by one 3D object, capable of defining the 

vector (straight path or edge, LCS), or with the help of two 3D points (3D nodes, vertices of bodies, etc.). If 

the projection vector is not defined, then the projection is constructed along the normal to the selected 

face. Selecting the body is equivalent to selecting a set of faces. Therefore, in this case the projection vector 

will be defined as the normal to the nearest face. 

 

Copying 3D Profile  

To create a 3D profile as a copy of an existing profile, simply select the original 3D profile. The thus created 

profile will coincide in space with the original profile. Various transformations defined among the profile 

parameters will be applied with respect to the global coordinate system. 

If necessary, one can additionally specify the original and the target coordinate systems. In this case, profile 

copying translates the profile from the original to the target coordinate system. The transformation 

parameters defined for the profile will be applied with respect to the original coordinate system in this 

case.  

The capability of copying 3D profiles relieves the user from creating additional workplanes. 

Construct 3D Profile as an offset to 3D Profile 

3D offset profiles can be constructed from flat 3D profiles only. The original profile can be a multi-contour 

one. 
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To create an offset profile, select the original profile and specify the offset with respect to the original 

profile. Offsets can be defined in two ways: 

 By defining a 3D node for the offset to pass through. 

The node should lie in the plane of the original profile. 

 By a numerical amount of the offset distance for the 

target profile from the original profile. 

The diagram shows an example of creating an offset profile 

at a negative distance. 

This drawing is located in the folder “ Examples\3D 

Modeling\ Profile\Offset Curve”.  

When creating an offset, three ways of handling gaps between the offset strokes are possible: 

Natural – the curves that make the original contour are continued naturally. Straight lines are 

continued straight, arcs - round. 

Round – rounds are constructed between the ends of the neighboring strokes of the contour 

being created. 

Extend – the gaps are closed by straight lines tangent to the strokes at their ends. 

                                     

If the original profile to offset from contains inner loops, their handling will be defined separately, 

regardless of the offset distance sign. One of the two options can be chosen: 

Enlarge – offsets to inner contours are constructed by expanding the original contours, regardless 

of the offset distance sign. 

Decrease – offsets to inner contours are constructed by shrinking the original contours. 
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Laying Profile on a Face or a Body 

This functionality allows creating a new profile by laying the original 

flat profile on a face or set of faces in the body.  

How does it work? A point is selected in the profile plane to be tied 

to a point in the face. The point selected on the profile is projected 

on the selected point on the face. After that, the profile is wrapped 

around the face, as if a paper label on the bottle. One can use 

additional elements for precise profile positioning. 

The reference point in the profile plane used for projecting on the 

surface is defined by a 3D node lying on the original profile. 

The area for the profile to be laid on can be represented either by a 

separate body face or by a set of adjoining faces. 

 

The profile transformation is performed without rips or shrinkages of its surface –the area of the original 

and the resulting profiles is the same. This condition poses restrictions on the used faces or sets of faces. 

The faces allowed for laying profile are those that can be created by simple extruding. However, 

those don't have to be produced by the extrusion operation per se. For example, a cylinder is 

allowed, since it can be created by simple extruding, even if it was actually created by the rotation. 

On the other hand, a cone, sphere or torus is not allowed, since it cannot be created by the simple 

extrusion. 

The point on the face used for tying the original profile is defined by a 3D node. The profile is tied to the 

first selected point (the first point selected on the profile is snapped to the point on the face). 

Then, a plane is constructed through the selected 3D node on the face orthogonal to all used faces. If the 

selected faces were constructed by an extrusion, then this plane would have been orthogonal to the 

extrusion direction. The profile will be laid along the intersection line between this plane and the selected 

faces. At this point, two possibilities exist for defining the direction of the profile laying along the 

intersection line. The profile can be laid on either side of the reference point (see the diagram). 
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The plane orthogonal to the selected faces, the intersection line between the plane and the faces 

and the direction vector of laying the profile are not displayed in the scene. Those are shown in the 

diagrams for illustration purpose only. 

To define the direction of laying the profile uniquely, one can select the second point on the used faces. 

The selected node will define which out of the two possibilities should be used as the direction of laying 

the profile. 

If the set of faces is defined in such a way, that the first point belongs to a side face, then the laying 

direction is determined automatically – towards the adjoining faces. This is the case when you do 

not have to select the second point on the face. 

Both cases described above are illustrated by the following diagrams: 

 

The diagram on the right hand side shows the case, when the first selected 3D node (on the surface) 

belongs to a side face. In this case, the laying direction is determined automatically. 

Next, the profile orientation on the face needs to be resolved. 

The vector that defines the profile orientation on the face (set of faces) can be defined in two ways: by 

using the second point on the profile plane, or without it. This vector is not displayed in the scene, and is 

shown in the diagrams for clarity. 

When using the second point, the start and the end of the new vector will be defined by the first and 

second points on the profile plane. In the cases, when the second point on the profile plane is not selected, 

the direction is determined by the following algorithm: 

 The laying direction vector beginning at the first point on the surface is projected on the profile 

plane. This gives the direction of the new vector for profile orientation. 

 The start of the profile-orienting vector is placed in the first point on the profile plane. 
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The arrows that are drawn from the first point on the profile and on the face show the normal directions 

to the profile plane and to the surface. When laying the profile, the profile plane is reoriented to have its 

normal coincide with the normal to the surface in the first selected point. The normal direction of the 

profile plane can be flipped to the opposite. This allows turning the laid profile 180° about the laying 

direction axis. 

3D Profile Based on Wire Geometry Elements 

This method allows you to solve the problem of constructing a 3D profile along a closed path, a set of 

edges forming a closed contour, or along a closed curve on a face. The geometry of such a profile is 

completely determined by the selected elements and changes as the geometry of these elements changes. 

The combination of elements involved in the generation of the profile may be different. 

 
  

 

PROFILES  -  UNFOLDING OF SURFACE OR SET OF SURFACES  

Surface Unfolding Creation 

To build a 3D profile as a surface unfolding, the system offers two types of algorithm: 

 Automatic selection, in which the system determines the optimal method of surface unfolding 

(analytical or iterative); 
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 Iterative, in which the system expands the mesh approximation of the surface by an iterative 

method. The result is inaccurate when unfolding a set of surfaces. 

The analytical method of an unfolding construction is used for unfolded surfaces. Unfolded surfaces are the 

ruled surfaces that can be unfolded so that all their points are combined with the plane without any 

damage to the surface (gaps or folds). In this case, the surface can be either closed (periodic) or unclosed. 

The iterative method is used for non-unfolded surfaces. Non-unfolded surfaces include non-linear surfaces 

and those ruled surfaces that cannot be turned into a plane without damaging the surface. In this case, the 

surface must be unclosed. It is an approximate method of construction. 

Automatic Creation Algorithm 

To build a 3D profile as an unfolding in the automatic algorithm selection mode, the source face and the 

point of tangency of the plane of the created profile of the source face are selected. The created profile is 

built in the plane tangent to the surface of the initial face. The point of tangency of the profile and face 

can be set by any 3D object that can determine the point (for example, a 3D node or a vertex of the body). 

The specified point must lie on the initial face. 

In the general case, if the selected face is closed (periodic), the point of tangency of the profile and the 

face is used to specify the cut line of the unfolding. The cutting is performed along a generatrix of a straight 

line passing through this node. 

 

 

 

Selecting a ruled face 

and a 3D node to 

create an unfolding 

profile 

The result of creating a profile - 

unfolding of the ruled face 

Created profile 

In the case of building a 3D profile as an unfolding of a closed cylindrical surface, the unfolding cut line 

can pass: 

 Along the generatrix passing through the point of tangency of the plane of the profile to the surface 

of the original face; 

 By generatrix passing through an additional 3D point; 

 Along the 3D path, which must lie on the same geometric surface as the unfolding face (for 

example, you can create an arbitrary 3D path and project it onto the face or build a path in a 
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cylindrical coordinate system with the same position and radius as the unfolding face) and its ends 

must lie on the outer edges of the face. 

The figures show an example of constructing a 3D profile as 

an unfolding of a closed cylindrical face using all three 

methods of cutting an unfolding. Node 1 was used to specify 

the point of tangency of the profiles with the initial face, as 

well as to determine the cut line of one of the profiles. 

Additional elements: Node 2 and 3D path were used to define 

the unfolding cut line in two other cases. The resulting 

profiles lie in a single plane tangent to the surface of the 

original face at the point defined by Node 1, but differ by the 

cut line. 
 

 

   
Profile with a cut along a 

generatrix set by the same node 

as the tangency point (Node 1) 

Profile with a cut along the 

generatrix set by an additional 3D 

node (Node 2) 

Profile with a cut along an 

additional 3D path 

 

In the case of building a 3D profile as an unfolding of a closed conical surface, the unfolding cut line can 

pass: 

 Along the generatrix passing through the point of tangency of the plane of the profile to the surface 

of the original face; 

 By generatrix, passing through an additional 3D point. 
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 Profile with a cut along a generatrix 

set by the same node as the touch 

point (Node 1) 

Profile with a cut along the generatrix 

given by an additional 3D node 

(Node 2) 

Iterative Building Algorithm 

To build a 3D profile as an unfolding in the iterative algorithm mode, the source face and the point of 

tangency of the plane of the created profile of the source face are also selected. In this case, the point of 

tangency of the profile and face can be set only by the vertex of the body. 

 

To orientate the profile in the plane of tangency, it is necessary to specify an additional 3D point defining 

the direction of projection. The resulting vector formed by a fixed point and the projection of the point 

specifying the direction to the unfolding will coincide with the vector formed by the fixed point and directly 

the point specifying the direction. 

 

  

You can also set a plane in parallel to which the resulting unfolding profile will be located. 
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Construct Unfolding of Faces Set  

Creating a 3D profile as an unfolding of a set of faces takes place in nearly the same way as creating other 

unfolding profiles. To create such a profile, expandable faces are selected. Such faces should have common 

edges. 

If there is at least one non-unfolded surface in the list of unfolded faces, then the system uses an 

iterative algorithm for constructing an unfolding, which gives an approximate result. 

The 3D point on one of the selected faces determines the position of the profile in space. The profile plane 

will be tangent to this face at the specified point. 

 

  

When creating a profile, several solutions may occur (for example, unfolding of all cube faces). By default, 

the system choses the solution. In order to obtain a specific variant of the profile construction, one can 

additionally select “inseparable” edges, which are used as unfolding lines. When specifying the edges, one 

should set connections between all the necessary edges. Otherwise, the face for which no “inseparable” 

edge is set, which connects it with other faces of the set, will be ignored during profile creation. 

  

By default, the boundaries of the faces of the original body are deleted on the created 3D profile of the 

edge. However, if necessary, they can be saved. 
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THICKENING FL AT PROFILES  
 

Any flat profile representation can be changed 

using Thickening mode. In this mode, the contour 

lines of the profile are offset. The new, thickened, 

contour is constructed based on these lines. The 

contour geometry may change in this case, which 

can be readily seen in the display of the sheet 

profile or the solid body resulting from it. 

 

When creating a 3D profile based on 2D 

elements, the use of this mode may become the 

only way of constructing the profile. This 

happens, for example, when the original graphic 

lines, hatch or text strokes used for constructing 

the profile have self-intersections or forks.  

 

 

In this case, the system will not be able to create the profile, unless in this mode, and will automatically 

prompt the user for turning on the thickening mode. 
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Thickening of a 3D profile depends on the following parameters that affect the resulting shape: 

 Thickness type (the direction(s) of offsetting the original contour lines); 

 Offset distance (distances) from the original 3D profile contour lines; 

 Ends handling of the new 3D profile contour lines; 

 Gap handling between the hanging ends of the offset 3D profile contour lines; 

 Closed area handling (specific to 3D profiles created from graphic lines on a workplane). 

Gap handling and closed area handling work the same way as the respective parameters in the offset profile 

creation. The rest of parameters are described here. 

Note that different shapes of the original 3D profile contour lead to different behavior of this mode. 

Thickening types and line offsetting  
Offsets can be created at either or both sides of the original lines, at specified distances in each direction, 

equal or unequal. The offset distance is defined by a numerical value. 

In theory, the way of constructing offsets is determined by the thickening type that allows the following 

choices: 

 Outward, inward – the offset lines are constructed on one side of the original contour lines; for closed 

contours, the direction of offsetting with respect to the original lines is defined by the selected mode 

(that is, either by expanding or by shrinking the original contour); the offsetting direction for open 

contours is automatically picked by the system. 

 Symmetric – the offset lines are constructed on both sides of the original contour lines at equal 

distances; 

 Double sided – the offset lines are constructed on both sides of the original contour, at different 

distances. 
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Depending on the selected type of thickening, one or two Offset distances are required. One value is 

required for the first three choices of thickening (“outward”, “inward”, “Symmetric”), two – when the 

“Double sided” option is chosen. 

In real life, however, the shape of offset lines is determined, besides the thickening type, by the shape of 

the original contour. It depends on the presence in the original contour of self-intersections or forks, as 

well as closed areas. For example, a contour with self-intersections or forks in most cases can't be thickened 

on two sides by different offset distances. Use of choices “Outward” or “Inward” is not allowed for such 

contours either. The result of subjecting it to the option “Double sided” will also depend on the presence 

of closed areas in the contour. This choice of thickening is also impossible if there aren't such areas in the 

original profile contour. To be precise, use of the option in this case will result in the same shape as the 

choice of “Symmetric”, that is, the same offset distance will be maintained on either side of the original 

contour lines (the second offset distance being ignored). If the contour with self-intersections or forks 

contains closed areas, then the inward offsets (the ones created in closed loops) use one of the distances, 

while the outward ones (all the rest) use the other offset distance. 

 

Handling ends of lines in thickened profiles  
When thickening an open contour, the offsets from the hanging ends of lines can be joined by the following 

two ways: 

Round – the ends of the offset lines are joined by circular arcs. 

By line – the ends of the offset lines are joined by straight lines. 
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CREATING 3D  PROFILES  

To create any 3D profile, use the command “3PR: Construct 3D Profile”. The command is called as: 

Icon Ribbon 

 

3D Model → Construct → 3D Profile 

Keyboard Textual Menu 

<3PR> Construction >3D Profile 

To create a 3D profile, upon calling the command, select the required type of constructing the profile. The 

further steps depend on the selected type of the profile. 

Creating 3D Profile Based on 2D Hatch or Text 

To create a 3D profile based on a 2D hatch or text, use the following options of the command main 

automenu: 

 <H> Select Hatch 

 <A> Select Text 

The normal flow of the 3D profile creation based on a hatch or text consists of the following steps: 

1. Selecting a hatch or text (in the 2D window or on the active workplane). This simultaneously 

defines the workplane or worksurface to which the selected element belongs by default. (The 

hatch or text belongs to a workplane if it is located within the bounds of the workplane in the 

2D window or at a position nearest to the boundaries of this plane.) The hatch and the workplane 

(surface) are marked as selected in the 2D window. Meanwhile, the preview image of the profile 

being created appears in the 3D view window.  

To alter the workplane selection, use the option: 

 <W> Select Other Workplane 

This will result in selecting another workplane or worksurface. Subsequent use of this option 

allows looping through all workplanes present in the active page. Meanwhile, one can watch 

how the profile being created adjusts dynamically in the 3D window. 

When using a 2D element lying on the workplane, profile creation completes at this point. In 

the case of a flat profile, one can additionally: 

2. Select a 3D node to snap the contour plane to: 

 <M>  Select 3D Node for fixing Profile plane 

3. Select a 2D node on the contour to snap the specified 3D node to: 

 <N> Select Node to be moved to 3D Node 
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To complete the 3D profile creation, use the automenu option  or the respective button in the property 

window.  

To undo the snapping to the nodes, use the following automenu options: 

 <K> Break link with 3D Node 

 <F>  Break link with Node 

Those undo the respective actions of repositioning the contour.  

Creating 3D Profiles from Graphic Lines on Workplane 

To create a 3D profile from graphic lines on the workplane, use the following option of the command main 

automenu: 

 <W> Create profile by sketch 

To create the profile, upon turning on this mode, simply select the desired workplane in the 3D window or 

in the 3D model tree and confirm the profile creation by . 

Automatic Profile Creation when Working on Active Workplane 

To have 3D profiles be created automatically, select or activate a workplane (the command “Draw On 

Workplane” in the context menu). Once the necessary 2D elements are created in the workplane, such as 

graphic lines, hatches or text, the profile creation occurs upon completing the active workplane session by 

the option: 

 
<Shift><End> End Drawing On Workplane 

The 3D profile will automatically be created upon completing this mode. 

                 

When on the active workplane the graphic lines of different colors exist, the system, before creating a 

profile, will issue the message: “Create a separate profile for each color of graphic lines? Yes/No”. In case of 

positive answer, several 3D profiles will be created – according to the number of used colors. If creation of 

several profiles is declined, one 3D profile is constructed by all graphic lines of the workplane. 
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The active workplane mechanism allows constructing profiles on flat faces of three-dimensional bodies. To 

do this, move the pointer over a flat face and right-click , and then select the item “Draw on Face” in the 

coming up menu. A new workplane will be created based on the selected face, along with its respective 

page. All newly created 2D elements will be placed there. The created workplane will become active (see 

the chapter “Workplanes”). The selected face is projected automatically on the workplane. Next, do the 

steps described above. 

To project other model elements on the active workplane, use the options: 

 Project Elements On Active Workplane 

 Create Projection of 3D Point of Vertex 

     

       

When drawing on a plane on which the 3D profiles by graphic lines have been already created, the control 

element with the list of available on the given plane profiles is present on the system toolbar. If one of the 

profiles is selected in this list, the graphic lines forming the profile are shown automatically on the screen 

in large scale, and the color of the selected profile is assigned to newly created lines. 

 

In this mode, the “Color only for current page” flag is enabled in the parameters of graphic lines. This 

means that the selected color will be active only upon creation of graphic lines on the page of a workplane. 
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Creating 3D Profile Based on a Loop or a Face 

To create a 3D profile based on loop or face, use the following option of the main command automenu: 

 <L> Select Loop 

 <F> Select Face 

To create the profile, upon turning on one of these modes, simply click  on an appropriate 3D element 

in the 3D window: a loop (a closed set of body edges) or a body face. The selected elements are highlighted. 

When selecting a set of body faces, one can adjust the selection, if necessary: a single face – by clicking  

on the face again, all currently selected faces – by the automenu option: 

 <K> Cancel selection 

To complete the profile creation, use . 

Creating Profile - Projection of Existing Profile on a Face or a Body 

A profile – projection of another 3D profile on a face or body – is created by using the following command 

option: 

 <J> Construct 3D Profile as projection of 3D Profile to face 

Selection of the body or face on which the original 3D profile will be projected is done by one of the 

following automenu options provided in this mode: 

 <B> Select Operation 

 <F> Select face for projecting 3D Profile 

A body or face can be selected in the 3D window by clicking . A body can also be selected in the 3D 

model tree. The selected body or face is highlighted in the 3D window. 

The profile being projected is selected (also directly in the 3D window or in the 3D model tree) using the 

option: 

  <R> Select 3D Profile to project 

The selection made is sufficient for the profile normal projection. In this case, the profile creation can be 

completed by pressing . In other cases, the projection vector needs to be defined for the original profile 

by specifying subsequently two 3D points or by selecting one 3D object, which is able to define the vector.  

To define the vector by two 3D points, subsequently use the options: 

 <M>  Select first 3D points of projection direction vector 

 <S> Select second 3D points of projection direction vector 
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To specify the direction vector by one 3D object the option is provided in the automenu: 

 <L> Select projection direction 
 

To cancel selection: 

 <K> Cancel selection of projection direction 

When selecting elements in the described order, the system automatically switches the options for 

proceeding with the next step. You can do selection in arbitrary order; however, in this case you 

have to pick the appropriate options manually. 

Creating 3D Profile – Copy of Existing 3D Profile 

For creating a 3D profile as a copy of an existing 3D profile, use the option: 

 <M>  Construct 3D Profile as a copy of another 3D Profile 

To create a profile copy, first select the original 3D profile in the 3D scene or in the 3D model tree. The 

profile selection option activates automatically, as the mode is turned on: 

 <T>  Select profile to copy 

Once the profile is specified, one can complete the creation with the option . The created profile will 

coincide with the original one in this case (if no transformation is defined for it).  

To define the coordinate systems that determine the translation of the profile being created off the original 

one, use the following automenu options:  

 <1> Select Source Coordinate System 

 <2> Select Target Coordinate System 

If the required LCS are absent in the current model, the following options can be used: 

 <K>  Select Point for Creating Source Coordinate System 

 <W> Select Point for Creating Target Coordinate System 

These options allow a user to automatically create a desired LCS by specifying its origin point. The axes of 

the coordinate system will be directed according to the direction of the axes of the global coordinate 

system. 

The selected local coordinate systems are highlighted in the 3D scene. The preview image of the profile 

being created appears in the position determined by the specified local coordinate systems. 

A selection of a coordinate system can be instantly rejected by the option: 

 <F>  Cancel Coordinate System selection 
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Creating 3D Profile - Offset 

To create an offset, select the option 

  <Q> Construct 3D Profile as an offset to 3D Profile 

The original profile can be selected in the 3D scene or in the 3D model tree, while under the activated 

automenu option:  

 <T>  Select 3D Profile 

The 3D node determining the offset distance of the profile is defined by the automenu option: 

 <N>  Select offset by 3D Node 

The following automenu option is provided for rejecting the selection of the 3D node:  

 <K>  Cancel link with 3D Node 

To define the offset distance by a numerical value, one can use the 

command property window (the parameter Offset in the same-name 

section of the dialog box). Other offset parameters can also be defined 

there. The choice of handling gaps occurring in the offset contour is 

defined by the parameter Gap Type. The choice of handling the inner 

contours of the profile (if any) is defined by the selector Internal Contours. 
 

Laying Profile on a Face or a Body 

The mode of laying a profile on a face is called by the following option of the main command automenu: 

 <D> Lay profile on sequence of faces 

To create such a profile, do the following steps: 

1. Select the original 3D profile: 

 <1> Select planar profile 

2. Select the first 3D node for defining the profile orientation on the surface:  

 <2> Select point on planar profile 

This option activates automatically right after selecting the profile. 

3. Select the second 3D node for defining the profile orientation on the surface (optional):  

 <3> Select second point on planar profile 
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4. Select a face or a set of faces on which the profile will be laid:  

 <4> Select surface 

An incorrect selection can be canceled using the option: 

 <7> Cancel surfaces selection 

5. Select the first 3D node for tying their original profile to the selected set of faces: 

 <5> Select first point on source surface 

6. Select the second 3D node for tying the original profile to the selected set of faces (optional): 

 <6> Select second point on source surface 

7. Flip (if necessary) the normal direction of the profile plane to the opposite (optional): 

 <Tab> Change profile orientation 

Creating 3D profiles by wire geometry 

To create a 3D profile using wire geometry, use the following option of the main command automenu: 

 <G> Construct 3D Profile by Wire Geometry 

The selection of objects is carried out using options: 

 <E> Select Edge or Line under Reference Element 

 <W> Select 3D path 

At the same time, the mode of selecting the sequence of smoothly conjugate edges  is activated by 

default (see the section “Edge smoothing”). 

To edit the list of selected objects, use the following automenu options: 

 <D> Delete Last Edge 

 <K> Cancel selection 

Also, to exclude specific objects, use the button . 

Creating 3D Profiles – Surface Unfoldings 

The mode of creating a 3D profile as a surface unfolding is called by the following option of the main 

command automenu: 

 <S> Unfold surfaces 

After calling the option, you should select the surface for which you want to create an unfolding in the 3D 

window. The selection is made using the option: 
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 <O> Select surfaces 

Then you should set the point of tangency of the profile (fixed point), which is indicated by the option: 

 <A> 
Select 3D node as tangency point of profile and 

source face 

 

The selected surface and fixed point will be added 

to the properties window. To edit the list of 

elements for scanning, use the buttons Collapse 

, Delete Element from the List , Clear 

. 

The automatic selection of the algorithm is set by 

default.  

 

To determine the cut line of the unfolding of a closed cylindrical face, use the automenu option: 

 <S> Select 3D path to define split line 

To determine the cut line of the unfolding of a closed conic face, use the automenu option: 

 <S> Select 3D node to define split line 

 

In the iterative type of the algorithm mode, the 

system proposes to select an additional 3D point 

defining the direction of profile projection and/or 

plane for the orientation of the unfolding. The 

accuracy of the contour of the resulting unfolding 

is settled by parameters such as Spline 

Interpolation Accuracy and Smooth Edges 

Angle. 

 

 

The choice of the point specifying the direction of projection is performed using the auto-menu option: 

 <D> Select Point to Define Profile Orientation 

The choice of the plane for orientation of the resultant unfolding is carried out using the auto-menu option: 
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 <P> Select Plane to Define Unfolding Direction 

 

If necessary, you can specify the mesh generation 

parameters in the corresponding section of the 

command properties window. 

Edge Tolerance - the maximum distance between 

the curves of the model and the edges of the 

mesh that approximate them. 
 

Face Tolerance - the maximum distance between the surfaces of the model and the flat edges of the grid 

that approximate them. 

Angle Tolerance - the maximum angle between the curves of the model and the grid edges that 

approximate them, given in degrees. The angle is measured as the sum of the angles between the edges 

of the mesh and the tangents to the initial curve at the end points of the edges. This parameter also 

determines the maximum allowable angle between the surfaces of the model and the flat mesh faces that 

approximate them (that is, the angle between surface and face normals). 

Maximal Edge Length - the maximum length of the edge of the generated mesh finite element. If the 

value is zero, the system ignores this parameter. 

Construct Unfolding of Faces Set  
To create such a profile, expandable faces are selected. Such faces should have common edges. 

After selecting the source faces and the point that determines the position of the profile, "inseparable" 

edges are specified, if necessary. To do this, you need to activate the Cut by edges flag in the properties 

window, and select the “inseparable” edges using the auto-menu option: 

 <E> Select inseparably linked edges 
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The selected edges will be added to the 

corresponding list in the properties window. To 

edit the list of inseparable edges, use the buttons 

Collapse , Delete element from the list , 

Clear . 

The Delete redundant edges flag allows you to 

delete the edges of the source set on the 3D 

profile file. 

If there is at least one non-unfolded surface in the 

list of unfolded faces, the system uses an iterative 

algorithm for constructing an unfolding. In this 

case, it is necessary to check that the unfolded 

faces do not form a closed contour, because it is 

impossible to specify a cut along the edges. 

 

Creating Thickened Profile 

The mode of thickening a 3D profile of any type can be set in the command 

property window, in the section Thickness. To turn on the mode, one needs: 

 Check the box Thickness; 

 Select the profile thickening type from the Thickness combo box: 

Outward”, Inward”, Symmetric, Double sided; 

 Specify the offset distance from the original contour. If the option 

“Double sided” was selected in the previous step, specify two values 

for the distances;   

 Define the way of handling the gaps in the offset contours that occur 

due to thickening by selecting the desired option from the drop-

down list of parameters Gap handling: Round, By line, By curve”.  

 Select the choice of handling ends of the contours being created from the drop-down list of 

parameters Ends handling: Round, By line. 

 For 3D profiles created from the graphic lines on the workplane, one can additionally define the 

way of handling closed contours by selecting one of the following options from the drop-down list 

of the respective parameter: Thickening or Closing area. 



3D Profiles 

253 

PARAMETERS OF 3D  PROFILES  

As any other system element, each 3D profile has a set of parameters, which is the same for all types of 

profiles. The parameter values can be defined by calling the parameters dialog box via the option: 

 <P> Set entity parameters 

The parameters dialog box of a 3D profile has four tabs: General, Thickness, Transformation and Mate 

Transformations. The tab Thickness contains the parameters that duplicate the contents of the same-

name section of the property window provided with the profile creation command, as described above. 

The tabs General, Transformation and Mate Transformations are described in details in the chapter 

“General parameters of 3D elements”. We will mention here just the special parameters provided in the tab 

“General” specifically for 3D profiles: 
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Quality. Parameter determining the quality of the image of a 3D profile. It defines the degree of model 

discretization into the grid of triangular planar faces for display of the image in 3D window. From the drop 

down list the predefined set of parameters specifying the quality of the grid can be selected: 

 Ultra 

coarse; 

 Extra 

coarse; 

 Coarse; 

 Standard; 

 Fine; 

 Extra fine; 

 Ultra fine; 

 

 Default (Standard) – the values of 

parameters of model discretization 

are taken from the Customize > 

Document Parameters command 

(the “Image quality” parameter on the 

“3D” tab); 

 User – the values of parameters of 

model discretization are specified by 

the user. Additional button  

invokes the dialog window for 

specifying user-defined values of 

parameters of model discretization (in 

units of a model). In the dialog of 

mesh parameters it is possible to 

specify the user’s own values: 

allowance by edge, face precision and 

angular allowance.  

 

More detailed information on the image quality parameters can be found in the “T-FLEX CAD Brief 

introductory Course” book, chapter “Drawing Setup”, section “Document group”. 

External. If the model is used as a 3D fragment, then the profiles with this parameter set are made 

accessible in the assembly mode. Those can be used for creating operations. The position of such a profile 

is fully determined by the position of its respective model. Only parameters can be modified. The profiles 

derived from 3D fragments have special names (Reference Profile No). These profiles can also be assigned 

the attribute External, that will allow their use in the assemblies of higher level. 
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View as Wireframe. This flag controls the way of rendering the profile in the 3D scene. If it is cleared, the 

profile is rendered as a sheet body. The flag is on by default, and the profile is displayed in the wireframe 

representation. 

Auto Refresh Data from Workplane. With this flag cleared, some changes in the work plane page will not 

be reflected in the 3D profile even after a full regeneration (such as, for instance, adding new contours 

made of graphic lines). 

Transparency. This parameter sets the degree of transparency of the profile in the 3D window. It changes 

from 0 (opaque profile) to 1 (fully transparent profile). 

Convert to Spline. This parameter allows converting each profile contour into a single spline. Each contour 

of the thus converted path or profile consists of a single segment, with the intermediate vertices being 

removed. The approximation accuracy is controlled by the parameter from 0.0 (Rough) to 1.0 (Precise) by 

the slider or via the accuracy input box, similar to the mesh density. In certain cases, such 3D profiles are 

more suitable then those based on polylines (as, for instance, in the “Loft” operation). 

This parameter does not affect combination profiles, whose several faces have adjoining edges (for 

example, if the profile is created from a set of adjoining faces). 

Select lines by color. The given parameter has the meaning only for 3D profiles that were created by 

graphic lines on the workplane. This flag controls the way of creation of the 3D profile. If it is disabled, the 

profile contour is constructed on the basis of all graphic lines of the workplane. When the flag is enabled, 

the profile contour is created only on the basis of the graphic lines of the specified color.
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LOCAL COORDINATE SYSTEMS 

A local coordinate system (LCS) is an auxiliary 3D construction element, that allows positioning 3D objects 

in the space. LCS’s are widely used in 3D modeling, for example, for building 3D assemblies, copying 3D 

bodies, defining transformations, etc. 

An LCS is displayed in the 3D scene as three named arrows, indicating the directions of the axes of the 

given coordinate system. The point where the arrows drawing is the LCS’s origin. The size of an LCS’s image 

is controlled in the command ST: Set Document Parameters, on the tab 3D > View, by the parameter Size 

> LCS. 

 

On the basis of the LCS it is possible to create special 3D construction elements of the T-FLEX CAD — 3D 

connectors. 3D connectors are used for attaching fragments when creating 3D assemblies. They represent 

themselves the LCS of a special type which are able (besides performing the function of attaching the 

fragments) to pass the values of the variables of one 3D fragment into another fragment. The use of the 

3D connectors significantly simplifies positioning of the parts and matching of the fragment parameters 

when designing the assemblies. 

The image of the 3D connector in the 3D window is analogous to the image of the standard LCS, but the 

axes are marked with “volume” arrows. 

 

STEPS OF CREATING LCS  

Generally, an LCS creation includes the following steps: 

1. Selecting LCS origin. A local coordinate system is created in the selected origin point with the 

same axis orientation as the global coordinate system. 
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2. Selecting X-axis direction. X-axis of the LCS resulting from the previous step, is reoriented in 

the specified direction. 

3. Selecting Y-axis direction. Y-axis of the LCS resulting from the previous step, is reoriented in 

the specified direction. 

4. Selecting surface for additional reorientation. The LCS resulting from the previous step, is 

reoriented in such a way, that its X-axis becomes pointing at the nearest point on the specified 

surface. 

5. Selecting tangency surface. The LCS resulting from the previous step, is reoriented to achieve 

tangency with the specified face/surface. 

6. Selecting required LCS transformations. The LCS resulting from the previous step, is rotated 

about its axes. 

7. Specifying additional non-geometrical characteristics of the LCS (associated elements, 

visibility in the assembly, etc.). 

Some steps can be skipped. The only required action is selecting the origin of the LCS. 

Defining the Origin of the LCS 

The origin of LCS is defined by a 3D point. An LCS is created in the specified 3D point with the axes 

orientation (X’, Y’, Z’ on the diagram) coinciding with the orientation of the axes of the global coordinate 

system.  

 

Defining X-Axis Direction of LCS 

To define X-axis direction of the LCS being created, specify either the direction vector itself or its 3D end 

point (the first point of the vector is the 3D point defining the origin of the LCS). As a result, the coordinate 

system is reoriented in such a way, that the X-axis assumes the desired position.  

The rotation axis is defined as follows: a plane is constructed through the two positions of the X-

axis –the old (resulting from the previous step) and the new (defined at the current step). The normal 

to this plane, passing through the origin of an LCS, is exactly the rotation axis. 
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Defining Y-Axis Direction of LCS 

The Y-axis direction is defined, as in the case of the X-axis, either the direction vector itself, or by its 3D 

end point (the first point of the vector is the 3D point defining the origin of the LCS). 

The step is performed only upon the condition of completing the previous one, which is the 

selection of the X-axis direction. You cannot define the Y-axis direction without specifying the X-

axis direction. 

The vector of the Y-axis direction does not define the Y-axis direction, rather, the position of the plane XY, 

in which this axis must be located. The plane will pass through the X-axis of the LCS and the specified 

vector of the Y-axis direction. As a result, the X-axis of the LCS maintains its position, and the Y-axis is 

located in the specified plane at the angle of 900 to the X-axis. The direction of the Z-axis is defined 

automatically based on the X and Y axes. 
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Reorienting X-Axis of the LCS towards the Nearest Point on the Selected Surface 

Reorienting the X-axis of the LCS towards the nearest point on surface is used in the case, when it is 

impossible to achieve the desired position of the LCS by selecting vector of the X-axis direction.  

Upon selecting the reorientation surface, the LCS being created is reoriented in such a way, that its X-axis 

is directed towards the point of the selected surface nearest to the origin of the LCS. 

 

The reorientation surface can be represented by a worksurface or plane. You can also select a face, flat 

edge or a simple body (a body, all whose faces lie on one surface). In this case, the reorientation surface is 

represented by the geometrical surface underlying the selected element. 

Reorienting an LCS is done similar to rotating an LCS at the time of defining the original X-axis direction. 

Snapping LCS to Tangency Point on Surface 

Snapping LCS to tangency point on a face allows adjusting the position of the origin of the LCS being 

created.  

The new position of the origin of the LCS is defined as follows: an auxiliary plane is constructed parallel to 

the plane YZ LCS and tangent to the selected surface. If there are several such planes, the nearest to the 

origin of the LCS is selected. The intersection point of the auxiliary plane and X-axis will become the new 

origin of the LCS. 
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The tangency surface is defined in the same way as the reorientation surface. To do this, you can select a 

worksurface or plane, face, flat edge or a simple body. However, limitations are applied in this case:  

 If a plane is used as the tangency surface (a workplane, and underlying plane of a flat face or flat edge), 

it must be perpendicular to the X-axis of the LCS; 

 If the tangency surface is defined by a cylindrical face – the axis of the cylinder must be perpendicular 

to the X-axis of the LCS. 

Modifying Axes Orientation of LCS 

To modify axes orientation of an LCS, you need to use stepwise rotation of the LCS about any of its axes. 

In one pass, the LCS is reoriented by 900 about the selected axis. Additionally, a provision is made for cyclical 

rotation of the axes of an LCS. The result of the cyclical rotation is shown on the diagram. 

 
If both ways of modifying axes orientation of an LCS are combined together (rotation about one axis and 

cyclical rotation), then the specified rotations about the specifics axes are performed first, and the cyclical 

rotation follows. 

ADDITIONAL CHARACTERIST ICS OF LCS  

In addition to geometrical parameters defining location and orientation of the axes of the local coordinate 

system, for the LCS it is possible to specify a series of additional characteristics which are necessary when 

using the LCS for attaching 3D fragment in the assembly. 
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Visibility of LCS in Assembly 

Four visibility modes can be specified in the assembly drawing for the LCS being created in the 3D fragment 

document: 

- Invisible in assembly. This mode is set on by default. The LCS created in the fragment document, 

will be not accessible in the assembly document. The LCS of the fragment will be visible neither 

in the 3D window, nor in the LCS list of the assembly model; 

- Visible in assembly on one level. This LCS will be visible in the assembly model and available for 

snapping to it under condition that the fragment containing this LCS is a fragment of the first 

nesting level. The location of such coordinate system is determined by the location of the 3D 

fragment. This LCS can be used for attaching other 3D fragments, and also for creating any 

construction elements and operations of the assembly model; 

- Visible in assembly on all levels. The LCS will be visible in the assembly document and accessible 

for snapping to it for any nesting level of the fragment in the assembly; 

- Externally invisible in assembly, but available for snapping to it. This mode is used most frequently 

for 3D connectors operation. In this mode, by default, the LCS of the fragment is not displayed 

in the 3D window of the assembly model. However, upon bringing the cursor to the LCS (or to 

its associated elements) the LCS will be “shown” in the assembly model and it will be possible to 

select it for snapping. Such LCS is also displayed in the list of the local coordinate systems of the 

assembly (with gray color, as invisible). 

Visibility of Fragment’s LCS in Assembly 

The following types of LCS can be visible in the model tree of an assembly: “On one level”, “On all levels”, 

“Connector”. 

Limitations: 

A) “Connector” and “On all levels” external LCS are invisible in the model tree until any other element 

is not snapped to it. 

You can disable the option Hide connectors in the context menu of the model tree to show the 

LCS. 

 

B) LCS will be hidden in the model tree if the option Hide coordinate systems in model tree is enabled 

in the fragment parameters. 

 

LCS for Attaching 3D Fragment 

Location of the 3D fragment in the assembly gets fixed by combining two coordinate systems: source one 

– belonging to the fragment, and target one – located in the assembly model. The LCS created in the 

fragment document and assembly document are usually used as the source and target coordinate systems. 
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However, not all LCS created in the 3D fragment document can serve as a fragment source coordinate 

system. The only LCS that can be selected as the source coordinate system are the LCS marked as used for 

fragment attachment. This parameter is specified in the LCS properties when creating and editing the LCS. 

The coordinate systems marked as used for fragment attachment will be displayed in the 3D window in a 

special way: a sphere is drawn at its origin. By this symbol, it can be distinguished from others. 

             

Degrees of Freedom 

For the LCS which will be used as the source coordinate system upon 

3D fragment attachment, it is possible to specify additional conditions 

in the form of allowed degrees of freedom. They define behavior of the 

3D fragment with respect to the fixing LCS. When inserting a 3D 

fragment, the conditions with degrees of freedom are copied from the 

LCS parameters to the 3D fragment parameters and subsequently are 

taken into account when calculating the set of mates of the designed 

3D assembly model. 

There are 6 degrees of freedom of the fragment – 3 translations and 3 

rotations with respect to the LCS axes. 

For each degree of freedom of the LCS, allowable bounds on the 

fragment displacement can be specified. 

 

Associated Elements 

For the LCS it is possible to specify associated, i.e., connected with the LCS elements (vertices, faces, edges, 

etc.). It will allow a user later on to perform snapping to the given LCS by indicating not the LCS itself, but 

the elements connected with the LCS. For example, if for the “external” LCS created in the fragment of the 

bolt, faces and edges of the bolt are specified as associated elements, then in the assembly when attaching 

a nut to this bolt, it will be sufficient to point at any face or edge of the bolt with the cursor – the LCS 

connected with these elements will be highlighted and selected as a result. 
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3D Fragment Insertion Rules upon Snapping to Given LCS 

For LCS which is going to be used as the target LCS upon 3D fragment attachment, so-called “insertion 

rules” can be specified. They imply the necessity of specifying additional transformations upon insertion of 

the fragment with snapping to the given LCS. 

For example, when a nut is snapped to the bolt LCS, it is usually necessary to specify additional translation 

of the nut along the bolt axis. That is why when designing a bolt model, in the insertion rules for the bolt 

LCS, it is possible to indicate the necessity of translation along the X-axis. 

3D Connector 

3D connector represents itself the LCS for which named values are specified. 

The named values determine information (values of variables) which a 

connector must pass to the 3D fragments switched to this connector. For 

example, among the bolt fragments included in the library of the standard 

T-FLEX CAD elements, 3D fragments containing data about the current 

diameter of the bolt were created. Upon snapping the fragment-nut (from 

the same library) to such connector, the nut diameter will be automatically 

replaced with the value taken from the connector. 

The image of the 3D connector differs from that of the standard LCS by the 

form of the axes arrows. Specifying position and direction of the 3D 

connectors axes is performed in the same way as upon creating the standard 

LCS. 

The named connector values are specified in the dialog of the LCS 

parameters (3D connector). They can be constants (a constant is indicated as 

an expression for such named value) as well as variables (the name of the 

variable of the current document is indicated as an expression for such 

named value). 

 

 

CREATING LCS  

To create an LCS, use the command 3O: Create Local Coordinate System: 



Three-dimensional modeling 

264 

Icon Ribbon 

 

3D Model→ Construct→ LCS 

Keyboard Textual Menu 

<3O> Construct > LCS 

When creating an LCS, the properties window and the command automenu are used together.  

To select a geometrical element defining some property of the LCS (the origin, X and Y axis direction, the 

reorientation surface, etc.) you can simply focus in the respective input box of the properties window. In 

this case, the option for defining the given parameter activates automatically in the automenu. The option 

combo box allows setting up filters for geometry elements selection. The opposite is also true: upon 

activating one of the automenu options, the input focus in the command’s properties window 

automatically switches to the input box of the LCS parameter, corresponding to that option. 

Specifying Geometric Characteristics of LCS 

Note that geometry elements, defining various LCS parameters (the origin, X and Y axis direction, the 

reorientation surface, etc.) can be selected in arbitrary order. Those, however, will be applied in the order 

described earlier in this chapter. 

To select a 3D point defining the origin of the LCS, focus in the input box Origin 

of the properties window (the section LCS parameters). The following 

automenu option will become active: 

 <1> Select 3D Node or vertex as LCS origin 

Once the 3D point of the coordinate system origin is selected, the image of the 

LCS being created is displayed in the 3D window. As the rest of the 

characteristics are specified, the direction of the LCS axes can be modified. 

To define the X-axis direction, use the entry X axis direction of the properties 

window and the automenu option: 

 <2> Select point that sets direction of X axis 

The Y-axis direction of the LCS is defined in the Y axis direction entry of the 

properties window and the automenu option: 

 <3> Select point that sets direction of Y axis 

The surface, whose nearest point defines the reorientation of the X-axis of the 

LCS, is specified in the input box Rotate to Surface. The respective automenu 

option is: 

 

 

 <4> Rotate LCS to be orthogonal to Face 
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To select the tangency surface, use the Move to Surface entry of the properties window and the automenu 

option: 

 <5> Offset LCS to be tangent to Face 

The selected geometry elements (3D node, vertex, edge, etc.) are specified in the respective entries of the 

properties window. To reject an element, focus in this entry and press the button [Delete]. Moreover, by 

pressing  or <Esc> it is possible to successively cancel selection of all elements. 

To modify axes orientation of an LCS, use the following options: 

 <A> Rotate LCS around X axis by 90° 

 <O> Rotate LCS around Y axis by 90° 

 <Z> Rotate LCS around Z axis by 90° 

The cyclical reassignment of the axes of an LCS is done by the option: 

 <Tab> Change LCS axes orientation 

Additionally, in the command’s properties window you can specify the parameters required when using 

this LCS for positioning fragments. 

The detailed description of those parameters is provided in the section LCS parameters of this chapter. 

Once the desired LCS is built, confirm its creation by  (in the properties window or in the command 

automenu). To reject creation of the given LCS, use the automenu option: 

 <F> Reset target LCS 

Before confirming the LCS creation with the help of  in the command's properties window, the LCS 

characteristics (see below) necessary for snapping 3D fragments can be specified. 
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Choosing LCS Visibility Mode in Assembly 

When inserting the current document into an 

assembly as a 3D fragment, the drop down list of 

the parameter “External” in the group “Coordinate 

System Parameters” of the command's properties 

window is used for selecting LCS visibility mode: 

- No. LCS will be always invisible in 

assembly; 

- One level. LCS will be visible in assembly 

on one level; 

- All levels. LCS will be visible in assembly 

on all levels; 

 

- Connector. LCS will be invisible in assembly but available for snapping to it (this option is usually 

used for 3D connectors). 

LCS as Source Coordinate System of 3D Fragment. Specifying Degrees of 

Freedom 

To utilize the LCS being created as the source LCS of the fragment (upon inserting the current document 

into an assembly as a 3D fragment), it is necessary to set on the flag Use for Fragment Insertion found in 

the command's properties window, in the group Coordinate System Parameters. By default, this flag is 

turned on. 

 

When the flag “Use for Fragment Insertion” is on, in the group 

Degrees of Freedom it is possible to additionally indicate 

degrees of freedom of the 3D fragment when given LCS is used 

as the source fixing LCS. 

There are 6 degrees of freedom for a fragment – 3 translations 

and 3 rotations with respect to LCS axes. By default, all degrees 

of freedom are forbidden – the switched off flags found next 

to the strings of all degrees of freedom manifest about that. 
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For enabling any of the degrees of freedom, it is necessary to set on 

the flag to the left of the corresponding string. In this case, the 

fragment can move along the given axis of the LCS (or rotate around 

the given axis of the LCS) with no restrictions. 

For specifying start and/or end limits of permissible motion by allowed 

degrees of freedom, it is necessary to set on flags before the fields 

from and/or to and specify desired value in the opened entry field.  

Note that for rotation around the LCS axes, two (start and end) limits 

of motion have to be specified at the same time. For translation along 

the axis, the limits can be specified independently (for example, only 

start, or only end limit).  

Selection of Associated Elements 

For specifying associated elements, the command's property window (group “Associated Elements”) and 

automenu can be used. 

To specify associated elements with the help of the automenu, it is necessary to turn on the option: 

 <E> Select Associated Elements 

This option allows a user to select the associated elements for the LCS just 

by picking them in 3D window. The drop down list of the option contains 

filters for choosing the elements. The selected 3D elements are put into the 

list “Associated Elements”. 

The option  can be enabled just by putting the cursor over the string of 

the list containing “…”. 

For removing selected elements, the buttons to the right of the list are used. 

The button  allows a user to remove one element – selected in the list at 

the moment of pressing the button. When pressing the button , all 

selected associated elements of the LCS are removed at once. 

 

Specifying 3D Fragment Insertion Rules upon Attaching to Given LCS 

Additional transformations of translation/rotation, which the system automatically prompts a user to carry 

out when the fragment is attached to given LCS, can be specified in the group “Insertion Rules” found in 

the command's properties window. 

To create a new rule, press the button . Upon pressing this button, a drop down menu appears in which 

a desired type of transformation needs to be chosen. The selected transformation is added to the list. 
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For removing one of the specified transformations, choose it in the list and press the button . Pressing 

the button  will lead to deletion of all transformations at once. 

Specifying Named Values for 3D Connector 

When creating 3D connector the named values are specified in the group 

“Connector Values” in the properties window for the LCS. In the list found 

in the given group of the properties window, the names of the named 

values of the connector, their expressions and current values are indicated. 

The buttons located above the list are used for filling in the list of the named 

values. 

To add a new named value to the list, the button  is used. After pressing 

this button, the dialog window “Connector Value” will appear, in which the 

name of the named value being created and expression assigned to it have 

to be specified. Both constant values as well as the variables of the current 

document can be used in the expression. After pressing [OK] the specified 

named value will appear in the list. 

 

 

It is recommended to specify “meaningful” names for the named connector values sticking to the 

same name creation rules in all 3D models. This will simplify the setup of the connection between 

the connector values and external variables of the fragments snapped to it. For example, at first 

sight complicated names like “DiameterOuterMetricThread”, “ThreadPitchMetric”, 

“LengthInnerMetricThread”, “LengthInnerInchThread” used in the standard T-FLEX CAD libraries, are 

actually made up according to the common to all libraries rules and exactly show what information 

is transferred by the given connector value. 

Pressing the button  removes the named value selected in the list at the moment of pressing the 

button. 
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By pressing the button , it is possible to rename already created named connector value or the 

expression specified for connector value. 

The button  allows a user to copy all named connector values and their expressions to the clipboard. 

The button  adds the lines located in the clipboard of the system to the list of the named values (if in 

the list there are no named values with the same names). Copying the named values via clipboard works 

in the framework of the same instance of T-FLEX CAD application. Thus, it is possible to copy the named 

values from one document to another. 

LCS  PARAMETERS  

Parameters of an LCS are defined in the dialog box invoked by the option: 

 <P> Set entity parameters 

Some parameters of this dialog are common across all 3D elements. Their detailed description is provided 

in the chapter General parameters of 3D elements.  

Other parameters of the given dialog duplicate parameters of the LCS properties window already described 

above. Thus, only those LCS parameters which were not mentioned in the previous section of this chapter 

will be described in this section. 

 

You can define the following parameters of an LCS on the tab General: 

 

Comment. This parameter allows specifying a text string – the description of the given LCS. The 

comment helps selecting a coordinate system from the list of those available for positioning, when 

applying a 3D fragment. 
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Use One Color. This flag is responsible for the LCS viewing colors. When it is turned off, the LCS 

axes are drawn with different colors. Each axis color (red, green, or blue) corresponds to the color 

of the global axis. When the flag is turned on, the LCS is drawn with one color (“Color” parameter).  

                             

On the tab Exploded View you can specify the transformations that will be applied to 3D fragments 

attached to the given LCS in the exploding mode (the command Tools > Exploded View). 
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3D PATHS 

3D path is used as an auxiliary 3D element in many system 3D operations. It represents a spatial curve that 

may consist of segments of different types. 

Any 3D path has direction, and, therefore, the start and end points. The direction of the 3D path will affect 

the result of using it in various operations. 

A 3D path can be open or closed. The start and end points of a closed path coincide. 

METHODS OF CREATING 3D  PATHS  

The command 3PA: Construct 3D Path is used for creating 3D paths: 

Icon Ribbon 

 

3D Model → Construct → 3D Path 

Keyboard Textual Menu 

<3PA> Construction >3D Path 

This command unites various methods of creating 3D paths. Those methods can be divided into two 

groups: 

 Creating 3D paths based on already existing 3D elements: 

- 3D path based on a sequence of connected edges; 

- 3D path as a 3D spline through 3D points; 

- 3D path as a sequence of 3D paths; 

- 3D path as a 3D path projection on a face; 

- 3D path as a copy of an existing 3D path; 

- 3D path as an outline edge; 

- 3D path as an offset from a curve (of a 3D Path) lying on a surface; 

- 3D path based on a section of a body by a plane; 

- 3D path by a parametrically varying 3D node. 

 Creating 3D paths based on 2D elements (located on the workplanes or worksurfaces): 

- 3D path by a hatch; 

- 3D path by 2D paths; 

- 3D path by two projections (two 2D paths). 

To create an arbitrary 3D path, you need to accomplish the following steps: 

1. Select the method of creating a 3D path. 
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Each method has its separate option within the command’s automenu. Upon selecting one 

or another option, the automenu provides additional options corresponding to the given 

method of creating a 3D path. 

Some methods of creating a 3D path can be automatically activated by the system if you 

select the source object of a certain type in the 3D scene or in the 3D model tree right after 

entering the command. For example, selecting a 3D node activates the mode of creating a 

3D path by a 3D points; upon selecting a 3D path – the mode of creating a 3D path copy; 

selecting a 2D path on the active workplane sets the mode of creating a 3D path by 2D paths. 

2. Select the source objects for creating a path and the required parameters (if necessary); 

3. Confirm the creation by  in the automenu or in the command's properties window. 

CREATING 3D  PATHS BASED ON 3D  ELEMENTS  

Creating 3D Path as Spline through 3D Points 

Splines are constructed based on a set of 3D points. The points of the set determined the spline control 

points. Modifying positions of the source 3D points will affect the shape of the 3D path built through these 

points. 

There are three types of 3D splines: 

 3D polyline is a spatial curve made of straight segments connecting the points of the source set. A 

polyline can be either open or closed (when a closed polyline is created, the first 3D point of the source 

set is used twice – for defining the start and the end of the path);  

                      

 3D spline through nodes is a spline passing through all control points. Such spline can be periodic or 

nonperiodic. When a periodic spline is created, the first 3D point is used twice. When creating a 

nonperiodic 3D spline through nodes, you can additionally specify the spline direction vectors at the 

spline’s boundaries (the start and the end); 
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 3D spline by polyline (a NURBS – non-uniform rational B-spline) – an arbitrary-degree spline by a 

control polyline. The control points are used for building the control polyline The spline itself does not 

pass through them (except the first and the last point in the case of an open spline). The spline’s 

parameters allow specifying the degree, weights at control points, parameterization type and positions 

of the parameterization nodes. 

Just like the previous case, the 3D spline by polyline can be periodic or nonperiodic. 

                      

To create a 3D path as a 3D spline, in the command’s automenu select the option: 

 <S> Construct 3D Path as spline based on 3D Nodes 

A 3D spline creation usually begins with specifying a set of 3D points through which the spline will be 

constructed. The following option is used for selecting 3D points: 

 <M> Add 3D Point to Spline 

The selected 3D points are added to the list of the spline control points in 

the properties window. To exclude one of the points, pick it in the list and 

click [Delete]. 

The type of the spline being created – periodic or nonperiodic (closed or 

open in the case of a polyline) – is also determined by means of the 

properties window (the check box Periodic). When the check is cleared, a 

nonperiodic spline is created (or an open polyline). When the flag is set, the 

spline will be periodic (closed in the polyline case). 

The further steps of the spline creation depend on its type. The spline type 

selection is also done in the command’s properties window (the parameter 

Type). The appearance of the properties window and the automenu changes 

according to the selected type. 

 

The 3D path as a polyline does not use any more parameters. Its creation is complete at this point. 

When creating a 3D path as a spline through nodes, the following pairs of options are available in the 

automenu for defining spline directions at the bounding points: 

 <L> Set direction at Spline start 

 <R> Set direction at Spline end 
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When selecting the option  or , the automenu brings the options for selecting the second point of 

the direction vector or the vector itself at the corresponding bounding point: 

 <N> Set direction at Spline start by 3D Point 

 <D> Set direction at Spline start by Vector 

 <N> Set direction at Spline end by 3D Point 

 <D> Set direction at Spline end by Vector 

To define the second point of the direction vector, select an additional 3D point. The direction vector will 

be pointing from the respective bounding point to the specified 3D point. To specify the direction vector 

explicitly, you need to select a 3D element suitable for defining a vector in the space. The direction vector 

is created by the parallel translation of the selected vector to the spline's bounding point. 

The length of each directional vector affects the shape of the spline being created - the longer is the vector, 

the longer portion of the curve is affected by this vector. The vector length can be determined automatically 

(based on its defining 3D elements) or be manually set by the user. By default, the vector length is taken 

from its defining 3D elements. For example, when defining the direction vector by a 3D point, the vector 

length will be equal to the distance between the specified 3D point in the respective bounding point of 

the spline. 

To manually specify the length of the direction vector at the start or at the 

end of the spline, you need: 

1. In the group Additional parameters of the command’s 

properties window set the appropriate flag: Start tangent or End 

tangent”. 

2. In the input box becoming accessible below, enter the desired 

vector length. 

 

To abandon the selected direction vector at the start or end of the spline, you can use the automenu 

options: 

 <K> Clear direction at Spline start 

 <F> Clear direction at Spline end 
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When creating a 3D spline by polyline, the shape of the curve being created 

is determined by the spline parameters in the command’s properties window: 

 Weight coefficients of all spline’s base 3D points. The coefficient must be 

greater than or equal to 0. The more is the weight of a point, the closer 

to it the spline will pass. The default value set for all control points of the 

spline is “1”. To modify the value of the weight of the particular point, 

select it in the list and enter the desired value in the Weight parameter’s 

input box. 

 Degree of polynomials of the piecewise-continuous function, describing 

the spline being created is the Degree parameter. The maximum allowed 

value of the degree is the number of the spline control points minus one. 

The default degree set for a spline with at least four control points is 

equal to 3. 
 

The higher is the spline degree, the more “rigid” it becomes. That means, the spline barely reacts to moving 

a particular control point. The low-degree splines pass closer to the control points, and changes in their 

positions stronger affect the spline shape. 

 Parametrization type (By Chord length, Uniform, Centripetal and Manually). In the case of the uniform 

parameterization, the shape of the curve does not adapt to the length of the control polyline segments, 

which may cause cusps and self-intersections on small segments. The two other types of 

parameterization (“by Chord length” and “Centripetal”) this does not happen, while different lengths 

of the polyline segments make different contributions. The effect of the parameterization type on the 

shape of the curve being created is nonlinear and may differ case-by-case. 

In the case of the manual parameterization, the user can change the 

shape of the curve by manually changing positions of the spline 

parameterization nodes. The most convenient way is to do this 

directly in the 3D scene by the draggers defining positions of each 

parameterization node.  
 

3D Path by Connected Edges 

A 3D path is created by a set of edges of an operation body, 3D profile or another path. The set is defined 

by subsequently selecting its member edges. The selected edges must be connected with each other, 

forming a continuous chain. A set consisting of a single edge is also allowed. 

A connected sequence of smoothly joined edges can be found by the system automatically upon selecting 

one of its member edges. 
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This method of creating a 3D path can be set by the following automenu option provided in the command: 

 <E> Construct 3D Path using edge sequence 

Upon turning on this mode, the following auxiliary option activates automatically in the automenu: 

 <E> Select Edge 

This option allows selecting all necessary edges by subsequently picking them in the 3D scene by . 

For automatic selection of editing connected sequence of smoothly joined edges, you need to activate 

another option: 

 <S> Smooth edge chain selection mode 

Upon activating this option, simply select any edge that belongs to the intended sequence. The rest of the 

edges will be selected automatically. 

To exclude several consequent selected edges starting from the last one, use the option: 

 <D> Delete last Edge from 3D Path 

To cancel selection of all edges at once, use the option: 

 <К> Cancel selection 

3D Path as a Sequence of 3D Paths 

This method allows creating a 3D path by combining an arbitrary number of 3D paths. Any paths are 

allowed as the source, except closed ones. 

The resulting 3D path is created as follows: the start of the second path is carried over to the end of the 

first selected 3D path by parallel translation, the start of the third one is carried over the end of the second, 

and so on. Each subsequent path is connected to the end of the previous one. 
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To create a 3D path in this way, select the option: 

 <T> Construct 3D Path using 3D Path sequence 

Selection of 3D paths is done in the 3D scene (by ) or in the 3D model tree with the activated option: 

 <T> Select 3D Path 

The last 3D path selection can be canceled by the option: 

 <D> Delete last 3D Path 

3D Path as a 3D Path Projection on a Face or Operation Body 

A 3D path can be created as a projection of another already existing 3D path on all faces of an operation 

body or on a separate face. In the case of mapping on all faces, select the operation body itself, on an 

isolated face – a specific face. 

Projection on a face is constructed as the intersection line between the selected face and a surface created 

by extruding the source path in the direction of the projection vector. When mapping on an operation 

body, then projections of the path are created on each face. The resulting elements (that is, the results of 

mapping the path on each face) are combined in one path. The elements that cannot be connected are 

discarded. 

When creating a 3D path as a projection, only those pieces of the 3D path are used that fully map 

on the selected face or body. 

When creating a 3D path, the first segment of the source 3D path must be among the resulting 

mappings. 

The vector of mapping (projecting) the source path is defined either with two 3D points, or using some 3D 

object suitable to define a straight line (this could be, for example, a straight path, an edge, an LCS). If the 

projection vector is not specified, then: 

- When projecting on an isolated face, the normal to that face will be used.  

- When projecting on all faces of an operation body, each point of the source path is extruded 

towards a point on the selected body which is nearest to the former point.  
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To create a 3D path as a projection of another 3D path, select the option: 

 <J> Create 3D Path as projection on Face or on Body 

The 3D path creation begins with selecting a body or face on which the path will be mapped. To select 

those, use the following options: 

 <В> Select operation on which 3D path will be mapped 

  <F> Select face that will be used for 3D Path projection 

The face or operation body are selected in the 3D scene by . An operation body can also be selected in 

the 3D model tree by picking the intended operation in it. 

The source 3D path is selected by the option: 

 <T> Select 3D Path for projecting onto face 

The projection vector can be defined by two 3D points with the help of the options: 

 <M> Select first 3D point of projection direction vector 

 <S> Select second 3D point of projection direction vector 

The projecting vector can be defined by a single object using the option: 

 <L>  Select projection direction 

To undo a specified direction, use the option: 

 <K> Cancel selection of projection direction 

Creating Copy of 3D Path 

To create a 3D path as a copy of an existing path, simply select the source 3D path. The new path will 

coincide in the space with the source 3D path. If any transformations are specified among parameters of 

the created path, those will be performed with respect to the global coordinate system. Additionally, one 
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can specify the source in the target coordinate systems. As a result, copying will be done in the direction 

from the source to the target coordinate system. The transformations defined for the path in this case will 

be performed with respect to the specified transformation location. 

The resulting path could be a copy of just a portion of the source 3D path. To do this, specify the start and 

end limits for copying: two 3D points on the source path defining the portion to be copied. If the selected 

3D points do not lie on the source path, the boundaries of the portion to be copied are determined by the 

points on the path that are nearest to the specified points. 

You can also specify just one copying boundary. In this case, the opposite end of the path will be used as 

the second boundary. 

 

To create a copy of a 3D path, use the following option in the main command's automenu: 

 <М> Create Copy 

Creation of a path copy begins with selecting the source 3D path. A 3D path is selected either directly in 

the 3D scene or in the 3D model tree. For this, use the automenu option: 

 <T> Select 3D Path 

To select the source and the target coordinate systems, the following options are provided: 

 <1> Select source LCS 

 <2> Select target LCS 

If the source or target coordinate system doesn't exist, it can be quickly created using the following options: 

 <F> Select Point for creating source LCS 

 <W> Select Point for creating target LCS 
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As a result, LCS will be automatically created with the vertices at the specified 3D points and the same 

orientation of the axes as that of the global coordinate system. 

To cancel a selection of the source or target coordinate system, you can use the option: 

 <F> Cancel LCS selection 

The copying limits are defined by the following options: 

 <S> Set starting copying limit 

 <E> Set ending copying limit 

 <D> Clear copying limits 

3D Path as an Outline Edge 

Creating a 3D Path as an outline edge can be found useful for defining the separation line when designing 

diecast molds.  

Construction of a body's outline edge can be schematically described as follows: imagine that spatial lines 

are drawn parallel to the viewing direction through each point on the body's surface. The points on the 

body surface in which such a line just touches the body (without intersecting it) are the candidate points 

for an outline edge. 

To create a 3D path, the source body and the viewing direction are specified. The system analyzes the 

surface of the body, searching for points satisfying the outline edge definition. The resulting set of points 

is united in one curve –  the 3D path. 

 

If it is impossible to join all found points into one curve, the system returns a set of separate outline edge 

segments. The user is offered to select the segment that will be used for building the resulting 3D path. 

One can select multiple outline edge segments simultaneously. In this case, multiple 3D path will be created 

rather than a single one, according to the number of selected segments. 
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A situation as possible when the vector of the viewing direction is parallel to some of the body's faces. In 

this case, all points of such face satisfy the definition of the outline edge, that is, the system finds an outline 

“surface” instead of an edge. This situation is resolved by the system by constructing the outline edge 

through the first points encountered on such face. As a result, most often, the outline edge is constructed 

along one of the side edges of such a face. A better shape of the outline edge will be obtained by applying 

the “vertical” face processing. In this mode, the system draws the outline edge straight across the face. 

                    

 The mode of processing “Vertical” faces is turned on in the command’s properties window. 

To create an outline edge, in the command’s main automenu select the following option: 

 <O> Construct 3D Path as an outline 

The body whose outline edge will be constructed is selected by the option: 

 <1> Select Solid Body 

The viewing direction is defined either by two 3D points or by one 3D element suitable for defining a 

vector: 

 <2> Select First point of Direction 

 <3> Select Second point of Direction 

 <4> Select direction 

After specifying the source body and the viewing direction, the image of the created outline edge will be 

shown in the 3D scene.  

In the case when the system cannot create a single outline edge, the 3D scene will show one of the 

identified outline edge segments. To create a 3D path based on it, simply confirm the path creation by 

. 

The full list of found outline edge segments is displayed in the command’s properties window. To create a 

3D path based on another outline edge segment, it is possible to select the desired segment in the 

properties window or use the additional option: 

 <Tab> Change outline 
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This option allows us to loop through the outline edge segments found by the system (when pressing this 

option the next segment of the outline edge is displayed on the screen). The segment selected in the list 

is displayed with a light blue color in 3D scene. 

To create a 3D path by several segments of the outline edge, it is necessary to find all required segments 

in the list and checkmark them, and then confirm the path creation with the help of .   

Creating Offset to 3D Path 

This way of creating a 3D path allows creating 3D curves of the following types: 

1. 3D path as an offset from a flat 3D path 

2. 3D path as an offset from a 3D curve on a surface 

3. 3D path as a 3D offset from a 3D path. 

All the methods of creating the 3D path as an offset from another 3D path are united in the automenu 

under the option: 

  Construct 3D Path as offset to existing 3D Path 

The drop-down list of this option contains three choices of creating a 3D path as an offset. 

 

ЗD path as offset to a planar 3D path 
To create a path - an offset to a planar 3D path, select the source path and specify the shift with respect 

to the source 3D path. The shift can be defined in two ways: 

 By specifying a 3D node through which the offset should 

pass. The node must lie in the plane of the source path. 

 By a numerical value of the shift of the offset path from 

the source path. 

The figure presents an example of creating an offset path with 

the shift defined by a 3D node. 

Creating this kind of a path is similar to creating a 3D 

profile as an offset to another planar 3D profile (see the 

chapter “3D profiles”). 
 

The gaps introduced between the segments of the offset path can be processed in three ways: 

Continue – the curves making up the source path are continued. Straight lines are continued 

straight, arcs are rounded up. 

Fillet – a fillet is created between the end points of the neighboring segments of the path being 

created. 
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Extend – straight lines are added to the hanging points that are tangent to the path segments at 

the gaps. 

                                     

When creating an offset to a path of the complex shape, self intersection loops may occur in the contour 

of the new path. An additional loop trimming mode helps removing those automatically. 

                

To create a 3D path as an offset to an existing planar 3D path, use the option: 

 <F> Construct 3D Path as offset to planar 3D Path 

The first step in creating the 3D path is selecting the source planar 3D path by the option: 

 <T> Select planar 3D Path 

After that, one has to specify the required shift by a 3D node or numerical value. The 3D node is selected 

by the option: 

 <N> Select 3D Vertex in the plane of selected path 

To reject a selected node, you can use the option: 

 <K> Cancel node selection 

 

The numerical value of the shift is specified in the command’s properties 

window. Here, other offset parameters are defined as well. The option of 

processing gaps introduced by creating the offset path is defined by the 

parameter Gap Type. The mode of deleting loops turns on upon setting the 

flag Remove loops. 
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3D path as offset to 3D curve lying on surface 
To create a 3D path as an offset to a 3D curve on a surface, select the source curve – a 3D path. The offset 

will be constructed by shifting the points of the original curve by the specified distance along the surface 

of the face on which the source curve lies. The source 3D path must necessarily lie on a face of a body – 

either solid or sheet. 

   

The face on which the selected 3D path lies is defined by the system automatically. Whenever possible, the 

user is offered to change the system selection (for example, if the 3D path was created on an edge dividing 

two faces of a body). 

 

Shifting the offset from the source curve can be defined by a numerical value or by a tabulated function. 

The table definition of the shift distance allows creating an offset with variable shift from the source curve. 

The shift table determines the position of control points on the source path and their respective shift 

values. 
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The accuracy of constructing the resulting 3D path is defined either by the number of points, through which 

the path is created, or by the offset tolerance. When using offset tolerance, the path is constructed in such 

a way that the resulting curve-to-chord distance for any given pair of sequential points does not exceed 

the specified accuracy value. The more use the number of points set for the offset or the higher use the 

specified accuracy, the more precisely the offset path will be constructed. 

To create a 3D path as an offset to 3D curve on a surface, use the option: 

 <D> Construct 3D Path as offset to 3D curve on a surface 

Upon activating this mode, select the source 3D path by the option: 

 <Z> Select path on surface 

 

The offset of an equidistant and its construction accuracy are defined in the properties window or in the 

path parameters dialog (the option ). 

To define an offset by a numerical value, set Offset Type to Constant and enter the desired value in the 

Offset field. To use a tabulated offset function, set the Offset Type parameter to the value Function. The 

[Offset Table] button appears in the dialog that brings up the window to define the table of offsets. 

   

 

The Offsets dialog allows creating or editing the table of shifts: 
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To add a new row, set the cursor on one of the existing rows in the table and click [Add]. The Offset 

dialog will appear on the screen. In it, specify the position of the new control point (the parameter 

Length) and the amount of its offset (the parameter Offset). 

The Offset dialog is also used for editing an existing row in the table (by clicking the button [Edit]). 

 

The button [Delete] allows deleting the selected row from the table of shifts. 

The table of offsets can be also defined using a plot (graph). To do this, use the button [Graph]. Upon 

clicking this button, the window to edit a plot appears. Details about working with plots are described in 

the chapter “Graphs”. 

To define the accuracy of constructing the resulting path, decide on the parameter to use for this purpose 

– Number of Points or Tolerance – and enter the value of the chosen parameter in the field at the right. 

The face on which the offset is being created can be replaced by the option: 

 <Tab> Select other adjacent Face 

The Offset Direction switch in the offset properties dialog can be used for the same purpose.  

3D path as 3D offset to a 3D path 
To create a 3D path as a 3D offset, all you need is just to select the source 3D path (of any shape), the 

offset distance and offsetting direction. The offsetting direction will define the direction of offsetting each 

point of the source path. A 3D spline will then be constructed, uniting all such points created by offsetting. 
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A 3D path created as a 3D offset can be used, for example, in CAM processing for creating tool movement 

trajectories accounting for the tool radius correction; also, in diecast mold design for creating the 

separation surface (using the outline edge and an offset to it). 

There are two ways of defining the offset direction: 

 Direction vector. A single direction vector is defined for the whole offset – by two 3D points, a straight 

edge, a normal to a flat face or workplane. 

To yield the offset, each point of the source 3D path is shifted by the specified distance along 

the vector defined as the cross product of the tangent to the path at the given point and the 

specified offset direction vector. That means, a point being offset is shifted in the direction 

perpendicular to both the direction vector and the tangent to the source path. 

 

 Direction from body. This way of creating a 3D offset implies creation of a 3D Path as a “continuation” 

of a sheet body surface (tangentially). The offsetting direction is defined by the operation body, whose 

surface needs to be extended. The source 3D path must lie on the same body.  

We recommend using a sheet body that lies in one surface, while the source path – a 3D path 

constructed along the bounding edges of this sheet body. Use of other configurations of the source 

data leads to an undetermined result of the offset creation. 

To make the offset, each point of the source 3D path is shifted by the specified distance along 

the vector defined as the cross product of the path tangent and the normal to the guiding 

surface at this point. 

 

An additional provision of offset with rotation can be used together with any method of creating an offset. 

In this mode, the offset vector calculated for each point of the source path is additionally rotated about 

the path tangent at that point by the specified angle. The 3D offset with rotation can be useful, for example, 

in CAM operations – for constructing a guide path defining the tool inclination angle. 
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To create a 3D path as a 3D offset, use the option: 

 <D> Construct 3D Path as offset to 3D Path 

The first step in creating the 3D path is selection of the source 3D path by the option: 

 <A> Select 3D Path 

After that, you need to define the offsetting direction.  

To define the direction by the direction vector, the following options are used: 

 <B> Select first Point of Direction 

 <C> Select second Point of Direction 

 <D> Select Direction 

The first two options (  and ) allow defining the direction vector by two 3D points. The option  

serves to select a 3D object suitable for defining the direction vector at once. 

To define the offset direction from a body, use the option: 

 <G> Select Solid Body 

The offset amount is specified in the command properties window or in the path parameters dialog (the 

option ). 

The shift of the offset is specified in the Distance parameter. 

Here, the offset with rotation mode can also be turned on (if 

necessary). For this, simply enter the desired value of the rotation 

angle in the field of the Angle parameter (the default value is set to 

“0”). 
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Creating 3D Path Based on Body Section by Plane 

To create the 3D path, you need to specify the dissecting workplane and the source body (operation). The 

path will be created along the intersection contour between the body and the workplane.  

The 3D path is constructed only if a single contour results from dissecting the selected body by the 

plane. If the source body is solid, the contour will be closed. Dissecting a sheet body results in an 

open contour. 

 

This mode is initiated by the option: 

 <В> Create 3D Path as intersection of Body and Workplane 

The command's automenu provides the options for selecting the dissecting plane and the operation body: 

 <1> Select Section Plane 

 <2> Select Operation 

Creating 3D Path by Parametric Variation of 3D Point 

The way of creating a 3D path by parametric variation of a 3D point is used for creating trajectories of 

complex geometry. 

A spatial curve of the path results from “sweeping” a 3D point along an arbitrary or specifically defined 

spatial trajectory. “Sweeping” of the point is realized by multiple copying of the source 3D point. The 

resulting set of points is joined by a spline, and a 3D path is built. The resulting 3D path can be closed. 

When constructing such path, a general mechanism is used that provides the final result based on 

parametrical copying of the source element. This mechanism is used in the “By Parameters” 

operation – when creating a body based on “sweeping” (copying) a profile. It is also used in the 

“Parametric Array” operation, where the result of the operation is a set of parametrically varying 

copies of the source object. 
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This algorithm is described in most details in the chapter “By Parameters”. The current chapter provides 

only a brief description and some examples of using this mechanism. 

To create a 3D path by a parametrically varying point, you need to define the law, according to which the 

copies of the source 3D point will be constructed.  

A so-called current copy’s coordinate system is calculated for each copy of the point. Copying the 3D 

point is done in the direction from the source coordinate system to the calculated target coordinate system 

of the current copy. The user can select one of the local coordinate systems available in the model as the 

source coordinates. If no local coordinate system is selected, then the source coordinate system will be 

either the global coordinate system or the coordinate system of the first copy, depending on the method 

of calculating the current copy's coordinate system. 

The current copy’s coordinate system (that is, its origin and axes orientation) can be defined by one of two 

methods: 

 Free copy orientation. The laws of modifying the coordinate system parameters of the current 

copy of the 3D point are described by expressions.  

 Copy orientation by 3D curves or surfaces. To define the spatial position of the current copy's 

coordinate system, existing 3D curves or surfaces of other bodies are used. By directing the 

copy's coordinate system, the user controls the position of each copy of the 3D point. 

Directing the copy's coordinate system is done via the operation parameters. There are parameters of two 

types - driven parameters and driving parameters. 

Driven parameters are the parameters whose values are calculated automatically in the process of creating 

a copy of the point. You can assign independent variables to read the values of such a parameter.  

Driving parameters are the entries with the dependencies defined by the user. The entries of the driving 

variables allow entering arbitrary expressions that can include any system variable. For example, by 

including a variable representing the ID number of the 3D point's copy in such an expression will make the 

value of this parameter dependent on the copy number. 

Some operation parameters can be sometimes driving, and sometimes driven. The leading parameter Copy 

number is always driven. It necessarily requires an independent variable that would be assigned the current 

value of the copy number while calculating the operation. The copy number automatically changes during 

the calculation from 1 up to the specified amount with the increment of 1. 

Calculation is done in the following order: first, the copy number is incremented, then the driving 

parameters are calculated, after which the rest of driven parameters are calculated (if any), and, finally, 

copying is done. All copies of the 3D point obtained in this way are united in one spline. 

The icon for activating this mode is provided in the main automenu of the 3D path creation command: 

 <P> 
Create 3D Path by parametric change of 3D Node 

position 
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Once the mode is active, the following actions become available: 

 <R> Select 3D Node  

 <1> Select Curve defining position of coordinate system  

 <2> 
Select 3D Curve defining X direction of coordinate 

system  

 <3> 
Select 3D Curve defining Y direction of coordinate 

system  

 <4> 
Select Surface defining X direction of coordinate 

system 

 <5> 
Select Surface defining Y direction of coordinate 

system 

 <6> Select source LCS 

 <7> 
Cancel selection of elements defining coordinate 

system 

As was mentioned earlier, one can distinguish two ways of creating a path by parametric variation of a 3D 

point. Let's review examples of each of them. 

Free copy orientation method 
When creating a path by this method, all that is required is selecting a 3D node, specifying the number of 

copies and assigning an independent variable to the “Copy number” parameter. By using the variable 

assuming the value of the current copy number, one can create certain dependencies in the driving the 

variable entries, as well as in 2D or 3D constructions, that, in turn, define the position of the source 3D 

point. 

Example 1 

Let's review the use of a parametric path on the example of creating a model of a cam. This example can 

be found in the library “Examples”, the folder “3D Modeling/Paths/Cam.grb”. The source data is 

represented by a graph defining the cam surface. 
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A parametric segment is constructed between the nodes 1 and 2. Its position is defined by the value of the 

variable “a” in the range from 0 to 1, inclusive. As the variable “a” changes, the line will move from point 1 

to point 2. The resulting line will cost the axis of the graph and the graph curve. A segment can be 

constructed between these points. Its length will be equal to the current value of the function represented 

by the graph. The read value of the segment length is stored in the variable “L” (by means of the function 

get). 

To construct a 3D Path repeating the contour of the cam surface, one needs to create such a 3D node that 

will change its spatial position according to the law defined by the graph as the variable changes that is 

assigned to be the copy counter. Such a node can be conveniently created by adding a few additional 2D 

constructions based on already available data. 

To get the cam of the desired size, the axis of the graph needs to be “wrapped” onto a circle of the specified 

radius. In the given example, the constructed circle has the radius of 50 mm. A new line needs to be created 

through the circle center at an angle to the horizontal. The variable “a1” shall be assigned to the parameter 

defining the slant angle of this line. 

The node 3 is constructed at the intersection of the circle and the slanted line. The node 4 is constructed 

at the distance “L” from the node 3 along the slanted line. A 3D node is constructed based on the 2D node 

4. For that purpose, a “Front view” workplane was created on an existing page. 

Now, we need to relate all variables in such a way that the 3D node would rebuild according to the copy 

counter changes. This can be achieved by introducing the following expressions instead of fixed values of 

some variables, that will maintain the dependency from the copy number: 
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Since the values of the Copy number parameter always start from one, sometimes a (–1) adjustment 

is necessary in the expressions employing the Copy number variable. 

At this point, the parametric 3D path can be constructed. We need to define two parameters in the 

parameters dialog: enter the number of copies and assign the variable to act as the copy counter. In the 

given example, the “Copy number” parameter is assigned the variable “s”. 

 
 

The first copy of the 3D node will coincide in its position with 

the 101-th. As a result, a closed 3D path will be created. Its 

geometry will correspond to the cam shape. 

Next, to create the cam body, extrude the path in the normal 

direction by 50 units and create a solid body based on the 

obtained sheet surface using “Sew” operation. 

Finally, one can make a cylindrical hole along the cam's axis (by 

extruding a circle with automatic subtraction from the main 

body). 
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Method of orienting copy by paths or surfaces 
The method of orienting a copy by paths or surfaces is convenient when other means fail that would define 

the law of varying copy parameters by expressions. In such cases, it could be convenient to use various 3D 

curves or surfaces for defining the position and orientation of the current copy's coordinate system. 

Example 2 

As an example of using a parametric 3D path with orientation of 

the copy by paths or surfaces, let's consider building a 3D path 

defining the outer border of a “waves” surface. On the figure, it is 

denoted as 3D path 2.  

To construct such a path, we need: 

- the source 3D node whose position will be changing 

depending on the number of the copy being created 

in the process of building the path; 

- a 3D path defining the position of the coordinate 

system origin for each copy; 
 

- a surface, defining the orientation of the X-axis of each copy's coordinate system. 

The path being created shall repeat the shape of the outer border of the source sheet body. Therefore, to 

define the origins of the copies’ coordinate systems, we would need to use a 3D path built on the edges 

of the source sheet body – the 3D path 1. 

An auxiliary workplane is constructed in order 

to get the source 3D node, which is 

perpendicular to the 3D path 1 and is passing 

through one of the vertices of the source sheet 

body. 

The necessary 2D constructions are created on 

the workplane. The sought 3D node is created 

based on a 2D node on the workplane – the 

Node 2. 

Node 2 was constructed as follows: first, the 

Node 1 was created on the workplane with the 

coordinates (0,0) (corresponding to the vertex 

of the source sheet body through which the 

workplane passes). A horizontal line is drawn 

through this node. A vertical line is drawn at the 

distance “y” from Node 1, perpendicular to the 

horizontal line. Node 2 lies on this line at the 

distance “L” from the lines intersection point. 
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The value of the “L” 

variable is defined in such 

a way as to vary with the 

changes in the copy 

counter of the 3D path. 

Therefore, as the 3D path 

creation progresses, the 

position of the 2D Node 

2 changes by the 

sinusoidal law with the 

current copy number, 

and so does the based on 

it 3D node. 

 

 

 

To define orientation of the X-axis of the copies' 

coordinate systems with the progress of the 

parametric path creation, we need to specify the 

source sheet body itself. If no surface is selected, 

then the axis orientation will be defined based on 

the curvature vector of the 3D path 1, whose 

direction may change abruptly.  
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The following needs to be defined in 

the path parameters dialog: the 

number of copies (the variable “q”), 

the copy counter variable (in the 

given example, this is the variable 

“n”) and the driving parameter 

“Parameter along path”. 

Once 3D path 2 is created, the based 

on it “waves” surface can be created 

by “Loft” operation. 

This example is located in the 

library “Examples”, the folder 

“3D Modeling/Path/ 

Parametric path with copies 

orientation by path and 

surface.grb”.  

3D  PATHS BASED ON 2D  ELEMENTS  

Hatches, 2D paths and 2D splines can be used for a path creation, that are located on the pages associated 

with the workplanes or worksurfaces. When using a 2D element lying on a page of a workplane, the 

resulting 3D path will be flat. A 3D path based on a 2D element from a worksurface will repeat the shape 

of the used surface. 

Creating 3D Path Based on Hatch Contour 

To create a 3D path, select a 2D hatch on a workplane or surface, whose contour is intended for the path. 

By default, the plane (surface), in which the created 3D path will lie, coincides with the workplane or surface, 

whose page hosts the source 2D hatch. 

For more precise positioning of the 3D path in the space one can specify a 3D node through which the 

path plane or surface must pass. The plane (surface) of the path is shifted by parallel translation. If that's 

not enough, the position of the 3D path can be further adjusted by specifying a 2D node (on the workplane 

hosting the hatch) that shall be aligned with the selected 3D node. 

This method of creating a 3D path fully corresponds with creating a 3D profile based on a hatch 

contour. The detailed description of this capability is available in the chapter “3D profiles”. 

To create a 3D path by this method, select the following option in the command’s main automenu: 

 <H> Create 3D Path from Hatch 
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After activating it, the following options appear in the automenu: 

 <H> Select Hatch 

 <M> Select 3D Node for 3D Path plane fixing 

 <N> Select Node to be moved to 3D Node 

 <K> Break link with 3D Node 

 <F> Break link with 2D Node 
 

Some items may be unavailable at different creation stages. The last icons become available only 

after specifying the 3D path and its snapping points.  

The first step of creating 3D path (and often the only one) is selecting the source hatch. The hatch is 

selected in the 2D window or on the active workplane, while the  option is active. 

The workplane or surface with which we edge can tour will be associated is determined automatically by 

the system. If other workplanes or surfaces also reference the same drawing page, the system selection 

can be altered by the option: 

 <W> Select other workplane 

This option allows to loop cyclically through workplanes or surfaces up until the desired one is selected. 

The 3D node defining the position of the path in the space can be selected by activating the option . 

The 2D node on the page of the source hatch is selected with the help of the option . The selected 

nodes can be rejected by the options  and . 

Creating 3D Path from 2D Paths 

To create a 3D path, several 2D paths are selected subsequently. The paths must lie on a 2D page (pages) 

associated with workplanes or surfaces and be open.  

The system automatically determines the workplane or surface for each selected 2D path. If the automatic 

selection is incorrect, the user can fix it manually. A subsequent 3D segment of the path being created is 

constructed based on the 2D path and the workplane (surface). All resulting segments are joined as follows: 

the beginning of the second segment is connected to the end of the first one, the beginning of the third 

– to the end of the second, and so on. In other words, this method can be considered a variation of one of 

the above-described methods – creation of a 3D path as a sequence of 3D paths. 

For more precise placement of the 3D path in the space, one can specify a 3D node to which the plane 

(surface) of the first 3D path segment will be snapped (that of the one corresponding to the first specified 

2D path). Additionally, to adjust the 3D path position, you can specify a 2D node on the page of the first 

2D path. This 2D node will be aligned with the selected 3D node. 
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Creating a 3D path by this method is done with the help of the option: 

 <C> Create 3D path from 2D Paths 

Upon activating this mode, a number of auxiliary options appear in the command's automenu for selecting 

all required objects. 

To select 2D paths, use the option: 

 <C> Select 2D Path 

 <D> Cancel selection of 2D path 

The option  allows rejecting the last selected 2D path. 

The system automatically finds the workplane or surface for each selected 2D path. A different workplane 

or worksurface can be selected (if any exist on the given 2D page) using the option: 

 <W> Select Other Workplane 

The nodes for exact spatial positioning of the 3D path being created are selected by the following options: 

 <M> Select 3D Node for 3D Path plane fixing 

 <N> Select Node to be moved to 3D Node 

 <K> Break link with 3D Node 

 <F> Break link with 2D node 

Create 3D Path Using Two Projections 

The 3D path is created by two projections on the main workplanes. The projections of the 3D path are 

represented by 2D paths. 

The 2D paths being selected must fully and uniquely define the position and direction of the 3D 

path in the space. Otherwise, the placement of the 3D path in the space will be incorrect or the 

system will output a message about an error and a failure creating a 3D path. 
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This example is located in the library “Examples”, the folder “3D Modeling/Path/3D Path by two 2D 

Paths.GRB”. 

This method of creating a 3D path is activated by the option: 

 <Q> Create 3D Path using two projections 

Upon calling this option, the following options appear in the automenu: 

 <F> Select first projection (2D Path) 

 <S> Select second projection (2D Path) 

These options allow selecting two projections of the path being created in the 2D view window. The 

workplanes on which the projections will be placed are selected by the system automatically. A different 

workplane can be selected (if any exists on the given 2D page) using the option: 

 <W> Select Other Workplane 
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HELIX 3D PATH  

A helix path is a special type of 3D path that allows you to obtain a conical, cylindrical, flat or parametric 

screw curve around the selected axis. 

     

BASIC INFORMATION AND FEATURES  

Axis of the helix 3D path 

The screw curve is built around the axis of the helix. An axis may be defined by any 3D object that can 

define a 3D path in space (see the “3D path” section) and two 3D points: the start and end. 

3D points can be defined by 3D nodes, as well as by any 3D object that can determine a point in space. 

The vector defining the axis of the helix will be directed from the first point to the second (respectively, the 

beginning and the end will be determined). The shape of the curve is determined by the parameters of the 

helix 3D path. 

 

 

The main parameters of the helix 3D path 

The appearance of the resulting helix 3D path resulting from this operation is determined by the following 

parameters: 

 Length may be set by the distance between 3D Points that define the start and the end of the axis, 

or automatically, when you specify a pitch along the axis. If length is set by 3D points, you should 

specify only coils in revolutions or degrees, or only pitch along the axis. The system will calculate 

the missing parameter; 



Three-Dimensional Modeling 

302 

  
The length of the screw curve is determined by the 

distance between the 3D nodes that define the axis 

(the screw curve step is specified additionally) 

 

The length of the screw curve is determined based on 

the specified pitch values and the number of turns (n = 

4) of the screw curve 

 
 

 Reverse direction of coiling allows to change the direction of a screw curve creation; 

 The starting angle - allows you to set the starting angle of the screw curve start point; 

 Start, End radius/diameter are the radius/diameter of the screw curve at the beginning and end of 

the helix 3D path. The initial and final radii/diameter of the cylindrical screw curve are the same; 

 Radius/diameter law –allows to specify a graph for a lateral generatrix of a screw curve; 

 The law for the z -coordinate allows to specify a graph for a screw curve pitch. 

Initial Position of Screw Curve of Helix 3D Path 

The initial position of the screw curve is chosen arbitrarily by the system. It can be changed by setting the 

desired position using an additional 3D point - the start point. Additionally, you can specify the numerical 

value of the rotation angle of the screw curve (from the initial position). 

 

 



Helix 3D Path 

303 

When you specify the starting point of the screw curve, the point will move along the specified initial radius 

to the plane passing through the selected point and start point of the axis of the helix 3D path. 

 

When simultaneously setting the starting point, the position of the screw curve and the numerical value of 

the rotation angle, the angle is set according to the position of the screw curve defined by the starting 

point. 

  

The start position of the screw curve is set with a 

numerical value of the rotation angle (30°) 

without selecting a starting point 

The start position of the screw curve is set using 

the start point and the numerical value of the 

angle of rotation (30°) 

HEL IX  PATH CREATION  

To create a helix path, use the command 3PH: Create helix 3D path: 

Icon Ribbon 

 

3D Model → Construct → Helix 3D path 

Keyboard Textual Menu 

<3PH> Construct > Helix 3D Path 
 

To create a helix 3D path, follow these steps: 

 Set the axis of the helix 3D path. 

 Set the parameters of the helix 3D path (start/end radius/diameter, pitch, radius/diameter law, etc.). 

 Select the start point of the helix 3D path position (optional action). 

 Confirm the creation of the operation. 
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Set Axis of Helix 3D Path 

The start point of the axis of the helix 3D path is set using the automenu option: 

 <F> Select starting Point of axis  

The end point of the axis is selected using the option: 

 <S> Select ending Point of axis  

These options are activated sequentially. Selected 3D objects are marked. After selecting the second point 

in the 3D scene, a screw curve will appear (in accordance with the default values of the helix 3D path 

parameters). 

You can select any 3D object that specifies 3D path in space as a helix path using the automenu option: 

 
<G> Axis of Helix 

After selecting the axis of the helix 3D path in the 3D scene, a screw curve will be displayed (according to 

the default values of the helix 3D path parameters). 

You can specify screw parameters in the properties window of the command or in the parameters dialog 

of the operation that is called by  option. 

Screw 3D Path Parameters 

A screw curve can be created using any combination of input data: 

Length, Pitch and Coils (in revolutions or degrees). The system 

checks that the minimum required number of parameters to 

create a screw curve is set. At list two parameters should be set. 

The system calculates the third parameter. To set the parameter 

value manually, you need to set the flag to the left of the 

parameter name. 

If you need to change the direction of the screw curve creation, 

you need to set the Reverse Direction of Coiling flag. 

The radius of the screw curve at its start is set by the Start 

Radius/Diameter parameter. By default, a cylindrical screw curve 

is created. If you need to create a conical screw curve, you should 

select one of the parameters: End Radius/Diameter or Step in the 

plane, by setting the appropriate flag and setting its value. An 

alternative parameter is calculated by the system itself. 
 

If it is necessary to set the dependence of the change of the radius/diameter of the screw curve on the 

number of coils, set the Radius/Diameter law flag. The Start Radius/Diameter and End Radius/Diameter 

parameters become inactive. If it is necessary to specify the dependence of the pitch change along the axis 
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of the screw curve on the number of coils, you need to set the Z-Coordinate Law flag. In this case, the 

Length and Pitch parameters become inactive. 

To create the required dependencies, you should press  icon to the right. There are two ways: 

 Create new graph – select a name and a type of the 

graph; 

 Use existing graph – select and existing graph. 

 Create a new graph - in this case, you should specify a 

name and select the type of the graph; 

 Use existing graph - you should select a graph among the 

previously created. 

 

Select Start Point of Screw Curve of Helix 3D Path 

You can specify the starting point of the screw curve using the following automenu option: 

 <B> Select Start Point of Helix  

You can cancel selection of a 3D point by selecting of another point or using the following option: 

 <K> Cancel Selection of Start Point  

 

In this case the screw curve will take the original position. 

You can set the numerical value of the rotation angle of the screw curve 

from the start position in the Start Angle parameter in the properties 

window of the operation. 
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ROUTE 

The route is a special type of a 3D path, that is composed of straight segments. The adjacent straight 

segments are connected by arcs of a specified radius. This type of a 3D path is mostly intended for defining 

a spatial trajectory used for creating pipelines. 

BASIC INFORMATION AND FEATURES  

Sections of the route 

The system allows you to create a route consisting of several sections constructed by various methods: 

 by specified points; 

 using the geometry of already existing objects (elements of wire geometry, elements of bodies). 

When constructing the route by specified points for each new point in 

the scene, the LCS manipulator appears. The manipulator allows you to 

set its position in absolute coordinates or relative to the selected 

binding (3D node, vertex, etc.). By default, the direction of the axes of 

the manipulator coincides with the direction of the axes of the global 

coordinate system. 

 

Manipulator provides for the following transformations: 

 translation along the axis (X, Y, Z). To enable translation, move the cursor closer to the axis arrow. 

 translation in the plane (XY, XZ, YZ). To enable translation, move the cursor closer to the image of 

the plane. 

 translation by three axes. To enable translation, move the cursor closer to the sphere at the center 

of the manipulator. 

 rotation about the axis (X, Y, Z). To enable rotation move cursor closer to the arc (the color of the 

arc corresponds to the color of the axis around which the rotation will be carried out). 

Manipulator can work in one of the two modes: 

 numeric specification of the transformation value. To work in this mode move the cursor of the 

mouse closer to the manipulator (it will be highlighted and the tip will appear on the screen) and 

translate the mouse with the pressed left button. Precise value of the transformation can be 

specified on the system toolbar. 
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 transformation is prescribed by snapping to the existing object of the model (for example, 

translation up to a 3D node). To work in this mode move the cursor of the mouse closer to the 

manipulator and click . After that the object snapping will be working upon translation of the 

cursor. In this way it is possible to specify the translation up to a point, edge midpoint, etc. 

 

  

Any change in the location of the manipulator is reflected in the 

auxiliary window Transformations. For each point of the path a 

separate list of transformations is saved. Translations along the axes 

are summed up. Transformations with the use of object snapping are 

recorded as a separate line. Transformation selected in the list can be 

deleted. The object snapping can be redefined by indicating a new 

object in 3D scene. 

The order of transformations can be changed by moving 

transformation up and down along the list with the help of buttons 

with arrows. However, it is important to take into account the fact that 

an arbitrary change of the order might lead to the incorrect result. 
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There is the possibility of multiple editing of points. The selection of the required points is carried out in 

the corresponding list in the properties window. After this translation of the manipulator will affect the 

position of all selected points. 

  

 

  

For a section of the route built at specified points, a type can be specified, which determines the method 

of its construction: 

 Spline through points; 

 Spline by Polygon; 

 Polyline. 

Spline through points 
It is a spline that passes through all given points. The minimum degree of such a spline (the degree of the 

polynomials by which it is described) is 3. 

 

The adjustment of the spline in terms of the behavior between adjacent specified points is determined by 

the maximum deviation of its shape from the chord between these points. 
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All default points are spline interpolation points. In the case when the 

exact passage through the point is not required, but rather only the 

approximate one, it is necessary to remove the Interpolation Point 

flag from it and set the maximum deviation value. 

The deviation of the curve at all points of approximation is the 

same throughout the route. 

 
 

  

  

 

At each interpolation point, it is allowed to change the smoothness 

parameters of the curve, setting the direction and values of the first 

derivatives of the polynomials (Tangent parameter) of the spline.  

The value of the Tangent parameter is specified by the Tangent to curve 

at 3D Node arrow.  

The direction of the tangent is specified by two manipulators in the form 

of arcs Tangency Direction.  
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For intermediate spline interpolation points, the system automatically selects the direction and calculates 

the optimal values of the first derivative, while observing the condition for preserving the smoothness of 

the curvature (the smoothness of the third derivative of the spline polynomials). However, it is allowed to 

set different values. It should be remembered that in this case the condition of preservation of tangency 

(smoothness of the first derivative of polynomials) is violated; accordingly, the curvature at such points will 

tend to zero. 

  

  

Spline by Polygon 
Represents a spline that passes along a controlled polyline, providing the condition for continuity of 

curvature. A polyline is a set of specified points connected in series by chords. The spline itself does not 

pass through the points (except for the start and end points). By default, the system builds a spline of the 

2 degree. If necessary, you can change the degree of the spline, but the maximum allowable value of the 

degree of the spline should be one less than the number of specified points. 
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The main parameter of the given points is the Weight of the curve function. The greater the weight of the 

function at a point, the closer the curve goes to it. 

  

  

Polyline 
It is a spatial polyline consisting of straight line segments, sequentially connecting a set of specified points. 

This is a special case of a spline by broken line of the 1st degree. 

 

 

For a polyline, a rounding can be specified with a total value for the entire 

section or separately for each given point. 

The rounding dragger is available for any given point of the section except 

the start and end points. Moving the dragger changes the value of the 

rounding radius at the selected point. 
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Segments Based on Geometry of Existing Objects 
The construction of sections of the route based on the geometry of existing objects involves the use of the 

following types of elements: 

 Based on paths/edges; 

 Based on surfaces/faces. 

When building a route based on paths or edges, the created section will coincide with them completely. 

You can change the position of the section, its starting and ending points using the following draggers 

(the numerical values of the draggers can be set in the properties window). 

 Location. Specifies the shift from the ends of the selected object. 

 

 

 Offset. Specifies the shift of the segment of the path from the selected object. 
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 Starting angle. Specifies the angle of rotation around the selected edge/path. Located at the start 

point of the path section. 

 

 

 Twist angle. Specifies the angle of rotation of the end point with respect to the start point of the 

path section. 

 

 

When creating a route by a set of edges (paths), it is necessary to add a separate section for each of them. 
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When creating a route based on faces or surfaces, the starting point of the section is created on the surface 

of the object at the point of the mouse click. After that, after adding a new point, you can move it using 

the manipulator or by setting the coordinates U, V in the properties window. 

  

 

The created curve can be moved along the normal to the surface, and an equidistant to the section lying 

on the surface is created.  It is allowed numerical values in the properties window. 

 

 

 

Despite the difference in construction methods, the areas can be mated with each other, forming a single 

spatial 3D path. In addition, it is allowed to combine several 3D paths into one, as well as break the existing 

one into smaller ones. 

When mating several sections of different types in one route and when several routes join, a transition 

zone is constructed between sections in the form of an additional curve which is connecting them. 

Moreover, the smoothness of the first derivative of polynomials is ensured by the equality of the values of 
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the parameters Tangency on Start, Tangency on End of the points being connected. In addition, the 

system allows you to automatically provide the smoothness of all transition zones, selecting the optimal 

values of the above parameters for all mating sections by the Create smooth path parameter. 

 

  

If a newly created route starts at the extreme point of an already existing route, then the system allows 

them to be smoothly mated, while at the same time allowing you to change the direction of tangency 

using the Reverse outer tangent parameter. 

 

When combining the selected section with the following, both of them should be of the same type. The 

resulting curve will inherit the parameters of the first section. 
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The section is divided into two sections by the selected point, the route is divided into several routs - by 

the selected section.  

The system allows you to change the direction of the created sections to the opposite.  

Using context menu in work with the manipulator 

When selecting the manipulators the following commands will become available in the context menu: 

 for translation along the axis 

 

 for translation in the plane 

 

 for translation along three axes 

 

 for rotation around the axis 

 



Route 

317 

The option of the Settings menu defines the step with which the distance and the angle change 

upon translations and rotations of the manipulator. 

 

Additional features 

For convenience and clarity of work with the command, the system offers a number of options. 

 Pipe Diameter. The option allows to 

dynamically display a preview of the route 

in the 3D scene by setting the curve 

thickness (increases convenience when 

working with a large number of 3D paths 

in the scene). 

 Mark points with curvature less than. 

Displays diagnostics in the 3D scene about 

points of the 3D path in which the radius 

of curvature is less than the specified one. 

 Mark breaks. Displays diagnostics in the 

3D scene about the points in which the 

direction of a curve changes in such a way 

that zero curvature and an infinitely large 

radius appear. 

 Check self-intersections. Displays 

diagnostics in the 3D scene about the self-

intersection points of the 3D path. 
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CREATING OF ROUTE  

To create the route there is a separate command: 

Icon Ribbon 

 

3D Model → Construct → Route 

Keyboard Textual Menu 

<3PP> Construction > Route 

The same command is invoked from the pipeline creation command with the help of the option of the 

automenu: 

 <B> Create/edit route 

 

The Type parameter allows you to assign a communication group to 

which this route will belong. This allows you to eliminate errors when 

creating pipelines, when there are several communication groups in 

the assembly at once. 

More information about the communication groups can be 

found in the chapter “Communications”, section “Typing of 

communications”.  

Creating and editing points 

After invoking Route command the first section with the start point is automatically created. This point 

becomes active. A point is considered active when it is highlighted in the list of points in the properties 

window. A manipulator of the active point appears in the 3d window. 

By default the following option is active in the automenu: 

 <F> Select a point 

 

This option allows you to bind route points to geometric 3D points 

of the model (3D nodes, vertices, etc.). In this case, the parent 

geometric object will be displayed in the list of points next to the 

point name in parentheses. 
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Deleting a point binding to a geometric object is implemented using the following automenu option: 

 <L> Delete linking of Point 

After deleting the link, location of the point is stored in absolute coordinates 

The system offers two modes of adding points, the choice between which is done by the auto-menu 

buttons: 

 <H> Add Note at the end of Path 

 <J> Add Note at the beginning of Path 

In the case of adding points before the active point, new points are added to the beginning of the section. 

Change the location of the active point by using the manipulator in the 3d window. The absolute 

coordinates are shown in the properties window. For points of the section by surface fields the U, V, N 

coordinates are filled in. For points of the section by edge the U, V, R coordinates are filled in. Coordinate 

values can be changed manually. 

When creating or editing a point it is often more convenient to 

specify the values of the shifts but not their absolute coordinates. For 

input of this data the group of parameters Offset is used. When 

creating the new point its location initially coincides with the point 

created just now. By specifying the value of the shift, we translate the 

active point with respect to the previous one. If the shifts are 

specified upon the editing of the point, then the result will be its 

translation relative to its current location. 

 

If the Offset flag is set for a point, then it is not recommended to bind this point to a geometric 

object. The point should be free from geometric binding. 

Segment points can be specified in the coordinates of an arbitrary LCS. To select\cancel LCS in automenu 

use options: 

 <C> Select LCS 

 <V> Cancel LCS selection 
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After selecting a coordinate system, it will be used for the current 

point and all points that are created after the current one. LCS 

deselection transfers the coordinates of the current point to the 

global coordinate system. Section of the path can contain any 

combination of coordinates definition. 

 

 A new point creation is performed using the automenu option: 

 <Enter> Finish point Editing and create new Point 

The new point is initially located in the same coordinates as the point created just now. 

To delete the active point, you need to use the automenu option: 

 <Del> Delete Point from Path 

In the properties window next to the list of points there are the buttons, which also allow us to add the 

points before  or after  the active point, delete the active point , delete link of points , split 

section into two at the active point , and import points from external file*.txt and *.csv . 

Depending on the selected curve type, the corresponding point parameters are activated. 

Parameters of points are set in the corresponding tab of the properties window depending on the selected 

type of the section of the path. 

The Rounding parameter allows you to specify the rounding radius of a Polyline type area at a selected 

point. 

The Tangent parameter sets the same value of the first derivative of the polynomials of the curve before 

and after the selected point. To set different values, disable the Symmetric flag. 
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The Reverse outer tangent parameter is used to change the direction of one route when smoothly mating 

with another. 

The Tolerance parameter is used for the Spline through points segment type. To set the maximum 

deviation of a curve from a point, it is necessary to disable the Interpolation Point flag (the other 

parameters of the point will not be available). 

 

The Weight parameter determines the degree of influence of the selected point on the segment of the 

Spline by Polygon type. 

Creating and Editing Sections 

The list of sections of the route is displayed in the corresponding tab 

of the properties window. To add a new section, use the Add...  

and Add to End  buttons. To delete the current section use the 

Delete  button.  

When deleting a section from the middle of the list, the previous and 

the following section are connected by a transition zone. 

The Merge with Next  button allows you to combine two sections 

of the same type into one. 

The division of the area is carried out at the selected point using the 

Split  button.  

The parameters Tangency on Start and Tangency on End allow you to provide a smooth conjugation 

between the transition curve and the mating sections.  The option Create smooth path provides automatic 

smoothing of all transition zones between sections. The option is located in the Options tab of the 

properties window. 

The Reverse Curve Direction parameter allows you to change the direction of the section to the opposite. 

This is useful when adding new sections to provide the same direction of the curve in all sections of the 

route. 
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For a section of the route built on specified points, the type that 

determines how to build it is selected in the drop-down list on the 

Sections tab in the properties window. 

The parameters of the curve section, depending on its type, are set 

in the corresponding tab of the properties window. 

The Spline Degree parameter is used for the Spline through points 

and Spline by Polygon section types. 

The Radius of Rounding parameter sets the total rounding value for 

all points of the section of the Polyline type. 

The Offset parameter sets the value of the movement of the section 

created by the path/edge and the surface/face, along the normal 

from the object. 

The Straighten by Chord parameter allows setting the value of the 

maximum deviation of the curve shape from the chord between the 

interpolation points in the corresponding field for a Spline through 

points type. 

 

 

To create a section based on paths or edges, use the option: 

 <E> Create segment by path/edge 

After activating the option, you should specify an object of one of the types: 
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The selected object will set the trajectory of the created section. The positioning of its starting and ending 

point is performed with the help of manipulators or by setting the coordinates U, V in the properties 

window. The R field duplicates the value of the Offset parameter. 

 

To create a section based on faces or surfaces, use the option: 

 <S> Create segment by surface/face 

After activating the option, you should specify an object of one of the types: 
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The start point of the section is created at the place of the mouse click. After that, having added the new 

point, it can be translated with the help of the manipulator or by specifying coordinates U, V in the 

properties window. Coordinate N duplicates values of Offset parameter. 

 

Route Editing 

To combine the created route with the existing one, use the option: 

 <M> Merge two paths 

After activating the option, you should specify the target route to combine with. If the routes do not have 

common points, a transitional curve will be created between them. 

To divide the route into two, use the option: 

 <D> Split Path 

The separation of the route is performed from the current section. After separating the path, the transition 

zone between the sections is deleted, and the system proceeds to editing of the newly created route. 

The construction of the route, smoothly mated at the point with the existing one, is performed by setting 

the Tangency on Start flag and selecting the direction of tangency using the Reverse outer tangent 

parameter.
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3D AXIS 

The command creates 3D axes on the basis of rotation surfaces and edges. Axes created in such a way 

preserves associative links with the initial elements. 

 

GENERAL INFORMATION AND OPPORTUNIT IES  

This command allows you to create straight axes on the basis of surfaces of rotation (cylindrical, conical, 

toroidal), as well as circular edges. As additional elements for specifying the dimensions of the created axis, 

you can select any other model elements. 

The 3D axis object may be used in the following ways: 

 You can use it as a rotation axis or direction element when creating various operations (extrusion, 

rotation, array, etc.); 

 You can use it as an object for setting 3D dimensions (between axes, from axis to plane, edge, etc.). 

Any 3D path or track can be converted into a 3D axis object using the Convert to Axis command of the 

context menu or enabling the corresponding parameter in the parameters dialog box. 
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3D axis is automatically created based on the center graphic lines or sketch lines of work planes and 

projections. 

  

Also, the 3D axis can be used as an object to project. See the “2D Projections. Creating 2D Drawings of 3D 

Models”. 

 

3D  AXIS CREATION  

Use the 3PX: Create 3D axis command to create a 3D axis: 

Icon Ribbon 

 

3D Model → Constructions → 3D Axis 

Keyboard Textual Menu 

<3PX> Construct > 3D Axis 
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You can select the element for a 3D axis creation using the automenu: 

 

 <M> Main element 

 

This option becomes active immediately upon entering the command. It contains a list of 3D element 

selection filters. The elements can be used as the basis for a 3D axis creation. You should pay attention to 

the active filters when selecting elements. For more information about working with these filters, see the 

chapter “Basic 3D Terms and Concepts of Modeling with T FLEX CAD”. 

To select the main element you should point the cursor to the 

required object. The object will be highlighted and the hint with the 

element name will appear. You should press  to select an element. 

The selection of the main item is canceled by clicking the Clear  

button in the corresponding list in the properties window or by 

clicking . 

Perpendiculars dropped from the extreme points of the selected 

element on the axis are used as limits of the 3D axis. If you select a 

round edge as a main element, a 3D axis of zero length will be 

created. The 3D axis will be extended from the both sides according 

to the Overhang parameter value. 

 

To extend a 3D axis from one or both sides, you should select additional elements. The elements will define 

the length of the axis. Use the following option for this purpose: 

 

 <G> Additional Elements 

 

The selected elements will be automatically added to the corresponding 

list in the properties window. Use the following buttons to edit the 

elements list: Collapse , Delete Element from the List , Clear . 

In this case, the perpendiculars dropped from the extreme points of the 

additional elements to the axis will be used as limits.  

In this case, the perpendiculars will be the limits of the 3D axis, dropped 

from the extreme points of the additional elements on the axis, taking into 

account the value of the Departure parameter. The Overhang parameter 

is also considered. 
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By default the Overhang parameter units are millimeters. You can change units by clicking on the 

corresponding units icon. 
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SECTIONS 

The 3D section is an auxiliary 3D construction element in T-FLEX CAD. It is used as a secting object when 

creating 2D projections (for obtaining local area views and sections) in the "Cut by section" operation. The 

3D section can be used when viewing objects of the 3D scene, helping quickly examine the inner model 

structure without changing it. 

 

The section is displayed in the 3D scene by dotted lines indicating the boundaries of the 3D section. The 

arrows on the image of a 3D section indicate the view direction. The view direction of the 3D section defines 

the part of the model that would remain as a result of applying the section to a 2D projection, a model in 

the 3D scene or when cutting by section. 
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MAIN APPROACHES TO CREATING 3D  SECTIONS  

3D section can be defined by the following methods: 

 With an octant (trihedral angle); 

 With a planar angle (dihedral angle); 

 On the basis of a plane; 

 With a parallelepiped 

 As a result of extrusion of the specified curve in a certain direction. The initial curve can be 

specified: 

̵ based on a 3D view; 

̵ based on 2D constructions on the workplane; 

̵ based on a 2D projection. 

3D section by octant and planar angle 

To create a 3D section with an octant and a planar angle, it is sufficient to indicate the location of the 

secant trihedral or dihedral angle in the space. To specify the location of the section, use the special 

manipulator in the form of the LCS to which the view of the secant angle is attached. Position of the secant 

angle can be snapped to points of the 3D model and also to LCS. 

The created 3D section is displayed in the 3D scene in the form of a dashed rectangle coinciding with the 

X-Y plane of the manipulator of the section. The boundaries of the rectangular section are imaginary and 
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only used to display the section in the 3D scene. The direction of the sight is parallel to the Z-axis of the 

manipulator of the section and has an opposite direction.  

3D section based on a plane 

When creating a 3D section of the given type, the location of the secant plane is specified with the help of 

the special manipulator. It constitutes the LCS to which the “draft” of the secant plane is attached. The 

location of the secant plane can be specified and controlled with the help of the manipulator and 

commands of its context menu. 

The secant plane can also be specified by simply indicating the 3D object that defines the required 

geometric plane (planar face, planar edge, workplane, etc.).  

The view direction of the 3D section is set by the system arbitrarily, and the user can change it, if necessary. 

The boundaries of the 3D section in the 3D window are purely imaginary and are used solely to display the 

section in the 3D scene. The model is slashed by such section throughout the entire range of the section 

plane. Direction of the sight of the 3D section is determined by the system arbitrarily but the user has 

always a possibility to modify it. 

3D section based on a parallelepiped 

To create a 3D section with a parallelepiped it is sufficient to indicate dimensions and location of the secant 

parallelepiped. Note that when applying the section of the given type everything that is situated outside 

the parallelepiped will be cut off. 

To specify location of the section, the special draggers in the form of LCS are used to which two opposite 

vertices of the parallelepiped are snapped. Location of the secant parallelepiped can be snapped to points 

of the 3D model, and also to LCS. 

Created 3D section is displayed in 3D scene as a dotted parallelepiped. 

3D section as a result of extrusion of specified curve 

3D section can also be specified as a list body obtained as a result of extrusion of the specified curve (line 

of the section) in a certain direction. To do so, it is possible to use one of the three variants of creation of 

3D section: 

 based on 3D view; 

 based on 2D constructions on a workplane; 

 based on 2D projection. 

These approaches differ in the way of defining the source curve of a 3D section and the direction of its 

extrusion. The view direction of a 3D section is arbitrarily defined by the system, regardless of the creation 

technique, however, the user can always flip it. 

The boundaries of such 3D sections are imaginary only in the direction of extrusion of the initial curve. The 

extents of the section in the other direction are precisely determined by the boundaries of the source curve. 
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Therefore, when creating a 3D section, make sure that the base curve fully intersects the 3D model. 

Otherwise, only a portion of the model will be sected that is intersected by the base curve of the 3D section. 

The 3D sections, created based on 2D projection and 2D constructions on a workplane, by default 

are not displayed in the 3D scene. To make such section appear in the 3D window, set the flag Show 

Image in 3D View in the section parameters. 

3D Section Based on 3D View 
The curve that guides creation of a 3D section is specified by a set of 3D points (3D nodes or body vertices). 

The selected 3D points are joined by straight segments. The 3D section is constructed by extruding the 

resulting polyline in the normal direction to the screen (at the time of selecting the first point). 

Before creating a 3D section, you need to a pointing and the 3D scene to make it perpendicular to 

the desired direction of the section creation. This can be done, for example, by using the command 

3VP: Set View Parameters, selecting the desired view position with its help. Or, if the 3D section is 

to be made perpendicular to some face or flat edge of the model, you can use the command 3VN: 

Rotate Normal to Selected Element. 

A section, created based on 3D view, is displayed only in the 3D window. 

3D Section Based on 2D constructions on a Workplane 
The base curve of a 3D section is defined by 2D elements lying on workplane: 

 a set of 2D nodes (two and more nodes); 

 a 2D path; 

 a view notation (2D section), created by the command SE: Create Section. 

The resulting flat curve as extruded perpendicular to the workplane, that is referenced by the source 2D 

elements. 

When using 2D nodes, the curve is created as a polyline (the specified nodes are connected by straight 

segments). The 3D section will be composed of planar segments in this case.  

If a 2D path is selected, the base curve of a 3D section will exactly follow the path shape. The 2D path can 

be of arbitrary shape. Therefore, 2D paths allow creating 3D sections, containing segments of selected 

circle or spline surfaces. 

The 3D sections, created based on 2D nodes and 2D paths, are displayed in the 2D view window by a 

dotted line with the arrows at the ends, indicating the view direction of the section. 
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A view notation is commonly used, when the 3D section is created based on existing 2D drawing. The base 

curve of the 3D section will repeat the shape of the 2D section, created in the command SE: Create Section. 

Such 3D section is not displayed in the 2D window. You can find out about its presence in the drawing 

from the 3D model tree or from the context menu for the 2D section. 

 

There are two additional options for this method of creating a section in an automenu. 

 
<O> One-sided section 

 
<D> Switch direction of one-sided section 

When the One-sided section option is activated, the part of the model that is below (or above) the 

Workplane onto which the element (s) was selected, the specifying section will not be cut off. The option 
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Switch direction of one-sided section changes the part of the model that is not cut off: either under the 

Workplane or above it.  

  
 

Without options 
  and  

 

Creation of 3D Section Based on 2D Projection 
This way of the section creation is almost exactly identical to creating the section based on workplane. The 

section is constructed perpendicular to the direction of projecting the source 2D projection. The base curve 

of a 3D section is defined by 2D elements one the projection: a set of 2D nodes, 2D path, view notation. 

Such 3D section can be created automatically in the 2D projection creation command when 

constructing a local view or section based on a 2D view notation. 

Selection of Objects of the Section 

When creating a section, it is possible to specify a set of objects of the section. The Bodies, operations, 

welded joints can be selected as such objects of the section. The selected set of objects can be used in one 

of the three modes: 

 section is applied only to the selected  objects; 

 section is applied to all elements of the model except the selected ones; 

 section is applied to all elements of the model (the specified set of objects is removed). 

Applying Section to 3D Model 

A 3D section can be used for viewing a 3D model. This helps quickly examine the inner structure of the 

model and evaluate the shape of the model of the setting with this 3D section. 
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When viewing a model with the help of 3D section, the body is “slashed” by the 3D section into two parts. 

The 3D scene displays only the portion have the disappointed up by the view direction arrows of the 3D 

section. In this way, no actual separation is performed, the model itself is left unchanged, what is changed 

is just the way of its rendering in the 3D scene. 

 

To apply a section to the model, call the command View > Apply Section. A dialog box will be displayed, 

listing all sections existing in the document. Select the desired section in the list (it will become highlighted 

both in the 2D window and in the 3D scene) and press the button [OK] in this dialog. The section will be 

applied to the model. 

 

There is another way of calling this command. In the command waiting mode, right click  in the 3D view 

window. In the coming up context menu, select the command Apply Section…. As a result, the described 

dialog box will appear. 

 

A section can also be applied to the model from the context menu of the particular 3D section (by right 

clicking ). In this case, you do not have to select the section. The section will be applied to the model, 

whose context menu was called.  

The Apply Section… command is unavailable for complex 3D sections built by extrusion of the 

specified curve (on the basis of a 3D view, constructions on the workplane or a 2D projection). If 

such a section consists of several segments, the section can not be applied to the 3D model.  

Canceling section is done by the respective command that can be launched from the context menu of the 

3D section (by selecting it in the 3D window or in the 3D model tree). 

CREATING SECTION  

to create a section, use the command 3SE: Construct Section: 

Icon Ribbon 

 3D Model → Construct → Section 

Keyboard Textual Menu 

<3SE> Construct > Section 

Upon calling the command, the automenu will offer both the general system options and the options for 

selecting a method of creating the 3D section: 

 <W> Construct Section using Workplane 

 <V> Construct Section using 2D Projection 

 <R> Construct Section using 3D View 
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 <L> Create Section by Plane 

 <O> Create Section by Octant 

 <A> Create Section by Plane Angle 

 <B> Select Bodies for Section 

 <E> Construct Section by Parallelepiped 

Creation of 3D Section by Octant/Planar Angle 

After selection of the  or  options, in the 3D scene a preliminary image of the secant angle with the 

manipulator in the form of the LCS at the base appears. Location of the secant angle is defined by 

translation/rotation of the manipulator. 

 

The manipulator constitutes a view of the coordinate system. The coordinate axes are connected with each 

other by colored arcs and rectangular “areas”, the center of the manipulator is marked with a sphere. 

Different parts of the manipulator are the active elements intended for specification of the following 

transformations: 

 

 the axes of the manipulator are intended for specification of translations along individual axes; 

 rectangular “areas” connecting axes of the manipulator in a pairwise manner are intended for 

translations across the XY, XZ or YZ planes; 

 arcs of the manipulator are intended for specifying rotations; 

 the center of the manipulator is used for an arbitrary translation (without fixing to axes). 

 

When pointing at the coordinate axis, the user can proceed to specifying a translation along the selected 

axis. When pointing at the arc, the system prompts the user to specify a rotation in the corresponding 
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plane. In the latter case, in addition to that, the axis of the manipulator closest to the cursor is selected so 

that the user could specify the rotation by directing the selected axis at the specific element of the model. 

When clicking the center of the manipulator, the manipulator itself and the secant angle that is linked to 

it start to dynamically move following the cursor. 

 

To specify a transformation with the help of the manipulator, the user must choose the active element of 

the manipulator by pressing . Next, without releasing the pressed button, the user can move the cursor. 

Transformation will be specified when the mouse button is released. It is also possible, after selection of 

the manipulator, release the mouse button, move the cursor and select a new element (specify a location 

in the space), to fix the transformation, by clicking again. 

 

To snap the secant angle to LCS the following option of the automenu is used:  

 <F> Select coordinate system  

After invoking the option it is required to indicate the desired LCS. 

The context menus of the elements of the manipulator offer additional capabilities of defining orientation 

of the secant angle. For example, with their help it is possible to direct the selected axis of the manipulator 

at a 3D point or translate the axis up to the specified surface. The option that is common to all menus – 

“Settings…” – invokes the dialog for specifying the step of the translation of the manipulator. 
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After specifying the required location of the secant angle in the space, it is required to confirm its creation 

with the help of  in the properties window or in the automenu. 

Creating a 3D section based on a plane 

After selecting the option , the following two options will appear in the automenu: 

 <L> Select Plane 

 <Tab> Switch view direction 

 <F> Select LCS  

 <B> Select Bodies for Section 

The green plane  –  a «workpiece» of the secant plane, and the special manipulator in the form of the LCS 

for controlling the location of the plane appear in the 3D scene. With the help of the manipulator and 

commands of its context menu, it is possible to specify and control the location of the secant plane. 

 

To fix the secant plane to an already existing 3D element (a face, a plane, etc.), it is possible to use the  

option. The drop-down list of the option  contains the filters to select 3D objects that define a plane. It 
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is also possible to fix the plane to different 3D points when moving the dragger by using double pressing 

of the mouse. 

 The option  toggles the view direction of the 3D section being created. 

Once the plane and the view direction of the section are selected, confirm the section creation by clicking 

 in the properties window or in the automenu. 

Creation of 3D Section with Parallelepiped 

After selection of the  option, will appear a preview image of the secant parallelepiped with two 

draggers in the form of LCS in the lying opposite vertices. To specify the required location and size of the 

parallelepiped it is required to translate/rotate the draggers.  

 

The master vertices of the parallelepiped can be snapped to different 3D points when moving the draggers 

by double pressing of . 

To specify the initial coordinate system, one of the vertices of the parallelepiped can be snapped to LCS 

with the help of the option: 

 <F> Select coordinate system  

The dragger of the vertex will be superposed with the selected LCS.  

Coordinates of the second vertex of the parallelepiped (associated with a second dragger) are measured 

with respect to the coordinate system. 

Creating Section Based on 3D View 

Upon selecting the option , the automenu will provide the additional options for selecting 3D points, 

the source curve of the section being created, and for switching the view direction of the section. 

3D points can be selected by the following options: 
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 <N> Select 3D node 

 <V> Select Vertex 

You can select as many 3D points as necessary using these options. If some point was minced when 

specifying the points, cancel the selection and define the points anew. To cancel the selection of a set of 

points, use the option: 

 <K> Eliminate all Section Nodes 

To flip the section view direction, offered by the system, use the option: 

 <Tab> Switch view direction 

Upon selecting 3D points and view direction of the section, confirm its creation by the option  in the 

properties window or in the automenu. 

Creation of Sections Based on 2D constructions on a Workplane 

A section can be constructed in this way either in the 2D window (on the page of the 2D drawing related 

to the workplane), or in the 3D window on the activated workplane. 

Upon activating this mode by the option , select 2D elements defining the source curve for the section. 

This can be done by the following automenu options: 

 <N> Select Next Section Node 

 <C> Select 2D Path 

 <M> Create 2D Section for creating 3D Section 

The workplane used as the base for the 3D section construction, is automatically selected by the system. 

In the cases, when another workplane can be selected (for example, if several workplanes are located on 

the given 2D page), the automenu will provide the option for changing the workplane: 

 <W> Select Other Workplane 

To flip the view direction of the section, as in the previous case, use the option: 

 <Tab> Switch view direction 

Upon selecting the source curve, the workplane and view direction of the section, confirm its creation by 

the option  in the properties window or in the automenu. 

Creation of Section Based on 2D Projection 

Creation of a 3D section in this way is done by the option . Creating such section is exactly identical to 

the previous method (creating a 3D section based on workplane). 
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The 3D section based on 2D projection can be created by the system automatically (without calling 

the command 3SE: Construct Section) within the command of creating the 2D projection when 

constructing a local area view or section based on a 2D view notation. 

Selection of Objects of Section 

The set of objects of a section is specified with the help of the properties window. 

The list of objects can be specified both directly when entering the 3SE: Construct section command 

(before selection of the section creation method), and during the stage of creation of the 3D section 

of any type. In the former case, the specified set of objects is automatically applied to all sections 

that are created during the current session of work with the command. In the latter case, the 

specified set of objects acts only for the specific section. 

Place the cursor into the “…” line and press . The command automatically 

transfers to the mode of selection of objects of the section. In the automenu 

the following option will become active: 

 <B> Select Bodies for Section 

The drop-down menu of this option contains the list of filters of the objects 

being selected (Body/operation/welded joint).  

 

Objects can be selected in the 3D window or in the tree of the 3D model. 

 

 

The way of interpreting the specified set of objects (Apply to all elements; 

Apply only to selected elements; Apply to all elements except selected ones) 

is set up with the help of the drop-down list Apply to. 
 

Defining Parameters of 3D Section 

Defining parameters of a section is done by the parameters dialog (the option ). 

Body color. When this flag is turned on, then the 

surface generated as a result of applying the 

section will be displayed in the same color, as 

the model. When the flag is cleared, color is 

used specified in this dialog. 

Show on 3D View. Defines the display of the 

section plane in the 3D view. 

Section color.. This color is used for drawing the 

section in the 2D and 3D windows. 

Additionally, this color is used for painting 

surfaces resulting from slashing the model, 

when the Color from solids flag cleared. 
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Body material. Section is displayed using the material of the body according to material’s texture, 

color and other characteristics. 

It is possible to get different colors when sectioning multicolor assemblies. If parameter value is set to 

"Body Material", the visual properties of material including texture will be used.  
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PROJECT ELEMENTS 

The Project Elements command becomes available in the workplane. 

 

Icon Ribbon 

 

Workplane → Modes → Project Elements 

 

The command allows projecting 3D scene elements onto the active workplane: Nodes, Patches, Profiles, 

Vertices, Edges, Faces, the intersection with the active workplane of these elements,  surfaces outlains. 

Lines or points obtained when projecting can be used to create 3D elements, or to position other lines 

based on which 3D elements will be created. In the latter case, the line obtained when projecting should 

be made Auxiliary. 

All created projection lines and points are associatively rearranged as the projected 3D elements 

change.  

You need to start drawing on any workplane or on a face (when drawing on a face, a workplane is created 

automatically) in order for the command of projecting elements to become available in the Ribbon. In 

other words, you should make an existing or new workplane active. 

  

In the mode of drawing on the active workplane, the group “Modes” appears in the Ribbon. The Project 

Elements command is available in the group. 

 

The Project Elements command has three basic ways to create projected lines and points based on 3D 

elements. Each option for creating projection lines and points has its own icon in the dialog. 

 
Projection to Workplane 

 
Intersections with Workplane 
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Projection of Elements Outline to Workplane 

To complete the command and construction lines according to the specified parameters, you need to press 

the automenu command  or <Ctrl + Enter>. 

Often when working with the command, it is convenient to change the view on the active workplane. To 

freely rotate the 3D scene in the active workplane mode, click the  Rotate Scene icon. The icon is located 

on the right on the View Toolbar by default. If the scene rotation mode is active, the created constructions 

on the workplane will be inaccessible for editing properties. To turn off the Rotate Scene mode, click the 

icon again. If any command for creation of 2D elements was selected, the Rotate Scene mode will 

automatically turn off.  

In the mode of drawing on the active workplane, other view control 

commands are available (which are also on the View Toolbar):  

 Rotate Normal to Selected Element and View Point. Usage of these 

commands helps to see the orientation of the projected element. 

 

In the Ribbon, three more view control icons are available  in the Modes group. 

The first icon  orients the direction of view along the normal to the active 

workplane. 

The second icon  makes a cut of the 3D model along the active workplane. 

 

 

Pressing the icon  again restores the initial display of the 3D model.  

The third icon  centers the view on the profile that is created on the active 

workplane. When you click the icon, a list of all profiles that have been created 

on the active workplane appears. The view will be centered on the selected 

profile. 
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PROJECTION TO WORKPL ANE  

You can project a Face, Edge, Vertex, Profile, Patch, 3D Node on the plane while in the mode of drawing 

on the active workplane. To do this, call the Project Elements command in the Ribbon and select the 

Projection to Workplane option (active by default). 

The filters toolbar displays a list of all possible 3D elements for projecting in this way  by default. 

 

 

You should select the projection option in the command 

parameters (in this case, the first one). The active 

workplane and elements are automatically selected. The 

list of selected items can be completely cleared using the 

icon , or cancel selection of any element using  . 

The following two options are also available: Create 

Auxiliary Lines and Project Direction. In the first option is 

enabled, all lines created using projecting will be auxiliary. 

 

If the second option is disabled, then the projection is 

performed along the normal to the workplane. If the 

option is enabled, then it is necessary to specify the 

direction of projecting the element on the workplane. The 

direction may specified by an edge, a normal to a face or 

an axis of a cylindrical surface. 

For example, you can project the edges of the nozzle 

flange in the direction of its axis. Then in the Project 

Direction option field you need to select a cylindrical face: 

the axis of the cylindrical face will set the direction of 

projection. 
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As a result, projection lines will be created on the active workplane. In this case, the auxiliary lines are 

created as the appropriate option was enabled.  
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Normal projection (without using Project Direction 

option) 

Projection by Direction (using the Project Direction 

option) 

INTERSECTIONS WITH WORKPL ANE  

Using this option of the Project Elements command, elements that are formed when the active workplane 

intersects edges, edges, profiles, paths or other workplanes and work surfaces can be projected on the 

active workplane. The specified list of elements corresponds to the filter option. 

 

When the active workplane intersects edges, profiles, or other workplanes and work surfaces, they are 

projected as lines. When the active workplane intersects edges or paths, they are projected as points. 

For example, you can get the line of intersection of the nozzle faces with the workplane passing through 

the body of the nozzle. To do this, you need to make the workplane active, select the Project Elements 

command in the Ribbon and specify the Intersections with Workplane option. Next you need to select the 

faces of the nozzle. If you select the outer faces - the outer contour of the nozzle section by the workplane 

is created. 
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If you select both outer and inner faces, the complete contour of the nozzle section by the workplane is 

created. 

 
 

Several selected faces are specified twice in the list of elements, as it can be seen from the example. For 

example, "Face_28". 

 

The intersection of the element "Face_28" with the workplane forms two edges, and, therefore, you can 

create two projection lines. 



Project Elements 

349 

  

  

If you need to project only one intersection line, you can disable the All Components option. Then only 

the intersection that is closer to the cursor at the moment of selecting the face will be projected. Another 

way is to remove an extra element from the list using the icon . 

If you select the edges of the intersection of the nozzle faces then the result of the command will be points 

projections. 

  

As can be seen from the example, two selected edges create projections of four points, since each edge 

has two intersections with the active workplane. If you need only one intersection point of several, then 

you need to act by analogy with the previous example: Do not use the All Components option or remove 

items from the list using .  
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PROJECTION OF ELEMENTS OUTLINE TO WORKPL ANE  

With this option,  you can project an outline of a body along the normal on the active workplane. Only 

faces are available in the filter of this option. 

 

For example, you can project the outline of the inclined cylindrical face of the nozzle on the horizontal 

workplane. To do this, you need to make the workplane active, select the Project Elements command in 

the Ribbon and specify the Projection of Elements Outline to Workplane option.  

 

 

In this case, the active workplane can either intersect or not intersect the face. In any case, a complete line 

of the outline projected onto the face along the normal will be constructed. 
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If you need only one specific element of the projection of the outline, then you can disable the All 

Components option. In this case, only the element that was closest to the cursor at the moment of the 

face selection will be selected. 

 

 

You can remove all excess elements using  icon. 

Not only the outer contours of the faces dimensions are projected, but 

also the inner lines of the outlines of the faces, which the face itself does 

not obscure. This is well illustrated by an example of a projection of an 

outline on a cylindrical face of a nozzle flange. The red lines correspond 

to the outline of the face on the upper edge, the green lines correspond 

to the outline of the face on the lower edge. Turquoise lines correspond 

to the outline of a cylindrical surface.  

The colors of the lines have been changed specifically to clarify the 

principle of projection - such color gradation is not an option of the 

command. 

 

 

COMBINING PROJECTION METHODS  

Variants of projection can be combined to obtain the necessary constructions on the workplane. For 

example, you can obtain a profile that will be part of the outline of the face of an inclined nozzle. The 
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nozzle is located under the workplane that intersects the specified face. To do this, you need to activate a 

workplane that intersects the inclined cylindrical face of the nozzle. 

 

Select the Project Elements command in the Ribbon and specify the Projection of Elements Outline to 

Workplane option. Select the nozzle face. The options All Components and Create Auxiliary Lines are 

active. 

  

Create projection lines using the specified parameters  or <Ctrl + Enter>.  

Next, select the Intersections with Workplane option in the Project Elements command and select the 

nozzle face again. The All Components and Create Auxiliary Lines options should be active. 
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Create a projection line using the specified parameters  or <Ctrl + Enter>.  

Next, in the automatic hatching creation mode , we hatch the area as shown in the figure. This area 

will correspond to the projection of the face outline, which is under the active workplane.  

  
 

On the created hatching, you can create a profile for further work. 

AUTOMATIC CREATION OF PROJECTION L INES  AND POINTS  

In some cases, it is convenient to automatically create projections of 3D scene elements on the active 

workplane.  

Automatic Creation of Projection Lines 

When you select the Draw on Face command, projection lines of face contours are created on an 

automatically created workplane. 
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The lines are always auxiliary by default. 

 

Automatically created projection lines of a face contour have all the properties of projection lines: they are 

associatively rebuilt when the face is changed, they can be made basic, they can be used to create profiles 

and other 3D elements. Constraints can be created between projection lines and other lines.  Automatically 

created projection lines can be deleted. If necessary, they can be re-created using the Project Elements 

command and its Projection to Workplane option. 
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Automatic Creation of Projection Points 

When creating sketch lines and construction lines, the  Snap to 3D Elements icon is available in the 

bindings toolbar. With the active icon, you can bind to the projections of points of 3D elements. The centers 

of the edges (circles) and the midpoints and extreme points of the edges (segments and arcs) are projected. 

The points are projected along the normal to the active workplane, on which a 2D point is automatically 

created. On the workplane, 2D points created on the basis of the projections of 3D elements are indicated 

by a red triangular icon .  

 

Bindings of sketch lines and construction lines to such points is preserved without creating constraints. The 

projected points are associatively rebuilt when the 3D model is changed. 

If you need to perform more complex binding of constructions to 3D elements, you need to apply the 

Project Elements command and use constraints.



 

 

BASIC OPERATIONS OF 3D 

MODELING 
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EXTRUSION 

Extrusion operation creates solids by sweeping the shape-defining element – the extrusion contour. 

Extrusion is a most popular operation across solid modeling systems. 

The operation supports two types of extrusion: extruding along an arbitrary vector, and extruding in the 

normal direction to the base contour surface. The extrusion type determines the direction assignment and 

the ways of extrusion creation. 

The extrusion contour can be made of wire or sheet geometry objects. The result of extruding is a sheet or 

solid body, depending on the type of the contour geometry. 

The extrusion length (or extrusion start and end) can be defined by various means, including bounding by 

other model elements. 

MAIN CONCEPTS .  OPERATION CAPABIL IT IES  

Extrusion Contour 

The extrusion contour can be made of wire and sheet geometry objects. Several elements can be selected 

simultaneously. In this case, the elements are joined first, and then extruded together. However, only same-

type objects are allowed in the selected group of elements, either all wire or all sheet objects. These include 

3D profiles and faces, or paths and edges. 

The result of extruding a wire contour is a sheet body. Extrusion of a sheet contour makes a solid body. 

              

Extrusion Direction 

The trajectory of sweeping the contour for extrusion is defined by the extrusion direction. Depending on 

the extrusion type, the direction can be defined by the normal to the original contour surface or an arbitrary 

vector. 

In either case, there are the forward and reverse directions of sweeping the contour. The forward direction 

coincides with the normal direction or the extrusion vector. Reverse is the direction opposite to the forward 

one. Two-sided extrusion is also supported, in which the contour is swept in both directions. By default, 

the system creates extrusion in the forward (“first”) direction. 
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Extruding in normal direction 
Extruding along the normal is the system default when selecting a sheet or flat wire contour. Each point 

on the contour is swept along a separate line defined by the normal direction to the contour surface at the 

point. In this case, extrusion can be described as an offset from the original contour defined by the specified 

length of the extrusion. 

In real life, flat contours are extruded most often, with the same normal direction at all points of the 

contour. For practical purposes, one can think of the flat contour in this case being translated parallel to 

its original position along one common line defined by the single normal to the contour plane. Therefore, 

extrusion normal to the flat contour can be viewed as a special case of extruding along an arbitrary vector. 

                     

Extruding along an arbitrary vector 
When the extrusion direction can’t be defined by the normal (for example, if a non-flat wire contour was 

selected) or extrusion is desired in a specific direction, then its definition may include an arbitrary direction 

vector. 

The vector of the extrusion direction can be defined in two ways: 

1) By specifying a pair of 3D points (the vector start and end); 

2) By selecting some element of the 3D model suitable for defining a vector in the desired direction 

(regardless of the length).  

Two 3D points define the start and end of the extrusion direction vector. 3D points can be defined by 3D 

nodes and vertices. One can also select other elements defining the desired point. For example, one can 

select an edge – in this case, the edge midpoint will be used as the 3D point. Selecting a coordinate system 
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defines the point at the origin. Selection of a face, which is part of a sphere or torus – yields the point at 

the center of the sphere/torus, and so on. 

    

In the latter approach, the selected 3D object defines the vector of extrusion direction. The suitable kinds 

of objects are flat curved edges, workplanes, flat faces, surfaces (the direction is determined as the normal 

to the selected element), straight edges (the vector coincides with the selected edge), coordinate systems 

(the direction is one of the axes), faces/surfaces that are part of a cylinder or a torus (the direction of the 

vector is the direction of the face/surface axis). 

 

Defining Extrusion Length 

The length of an extrusion can be specified in one of the three ways:  

 By the length of the defining vector of the extrusion direction; 

 By an arbitrary numerical value, measured from the original contour position; 

 By an offset from a 3D point or a plane; 

 By extrusion bounds. 

Defining extrusion length by length of direction vector 
The extrusion length can be derived from the length of the defining vector of the extrusion direction in the 

cases when the direction is defined by two 3D points or a straight edge. The length of the extrusion vector 

in this case is defined by the distance between the specified points or the length of the selected edge. 

Extruding is performed from the original contour position straight by the amount equal to the vector 

length. The length of extruding in the reverse direction, if necessary, can be defined by an arbitrary number 

or set equal to the length of extruding in the forward direction. 
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Defining extrusion length by numerical value 
Regardless of the ways of defining extrusion direction, the extrusion length in the forward direction (from 

the original contour position) can be defined by an arbitrary numerical value. The extrusion length in the 

reverse direction, if necessary, is defined by an arbitrary numerical value or is set equal to the length of 

extruding in the forward direction. 

 

Defining extrusion length as an offset from a 3D point or a plane 
An extrusion length can be defined as an offset from an arbitrary 3D point or a plane only in the case of a 

flat contour being extruded in the normal direction. The extrusion is performed from the original contour 

position to the position defined by the offset. 

 

Defining extrusion length by extrusion bounds 
When specifying the extrusion length with the help of bounds the extrusion is performed from one 

boundary to another. 
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Types of Bounds 

The bounding conditions can be of the following types: 

Offset from the original contour plane  
The body being created is bounded by a plane parallel to the 

original profile, at the specified distance from it 

Bounding by a point The body being created is bounded by the specified 3D point 

To surface The body being created is bounded by the specified surface 

To face The body being created is bounded by the specified face 

To body 
The body being created is bounded by the specified solid 

body 

To nearest face 
The body being created is bounded by the nearest face of 

the specified solid body in the given direction  

Through all body 
The body being created is bounded from both sides by the 

specified solid body 

Through all body by direction 

The body being created is bounded on one side by the 

original profile position, whereas on the other side - by a 

specified solid body 

To sheet 
The body being created is bounded by the specified sheet 

body 

For the extrusion to be created successfully to the specified bounds, make sure that the extrusion 

contour fully reaches the 3D element specified as an extrusion bound. 

Offset from the original contour plane 
An offset from the original contour plane can be specified as one of the extrusion bounds. In this case, the 

extrusion is bound by the specified distance from the original contour. 
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Bounding by point 
A geometric 3D point can be specified as a bound of extrusion in the straight or reverse direction. As a 3D 

point, it is possible to specify a 3D node, a vertex of the body, the midpoint of an edge or any other 3D 

object that is capable of defining a point. 

The extrusion being created will be bounded by the given point. 

                       

Bounding by surface 
One of the bounds can be defined by a workplane or surface. Also allowed is a face, flat edge or simple 

body (a body with all faces on one surface) – in this case the extrusion bound is defined by the geometrical 

surface where the selected element belongs.  

The extrusion being created is bounded by the whole surface. If the surface was identified by an element 

belonging to it, the surface is extended beyond the element limits whenever possible. Some complex 

surfaces, such as an underlying surface of a body face defined by a spline, like those created in the “Loft” 

operation, can’t be extended. In this case, the surface limits coincide with the limits of its defining object. 
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Additionally, one can impose an offset from the specified surface (positive offset is at the outer side of the 

surface). 

      

Bounding by face 
If “to face” bound is selected, the body being created is extruded in the specified direction and is bounded 

by the specified face. If the contour only partially intersects with the selected face, the adjoining faces are 

used for bounding as well. 

       

Bounding by body 
A solid body can be specified as an extrusion bound. The body being created is extruded in the specified 

direction until it intersects with faces of the specified body. Bounding of the extrusion is done in the same 

way as in the case of a specific face bound. 

If the bounding body intersects with the body being created several times, the intersection is processed 

that was nearest to the position of the cursor when clicking the body for selection. 
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Bounding by body is a more robust technique then bounding by a specific face, because different faces 

may act as the extrusion bounds upon changes in topology of the selected object. The face selected as a 

bound at the time of extrusion creation may later shift or disappear altogether. 

   

Bounding by nearest face 
A special case of extruding to body is extrusion to nearest face of the body in the specified direction. In 

this case, it is always the first intersection with the selected body in the specified direction of extruding 

(forward or reverse). 

The following conditions need to be observed when defining this kind of bounding: 

1) The specified extrusion bounds (at least one of which is the “To nearest face”) must be on 

different sides of the original contour. An exception from this rule is the case when the second 

extrusion bound is defined by an offset from the original contour plane. 

2) The body, whose nearest face will be the extrusion bound, must be in the forward direction from 

the original contour, when it defines the first bound, and in the reverse direction, when defining 

the second bound. 
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Through all body 
Yet another variation of extrusion bounding by intersection with a solid body is “Through all” bound type. 

What is special in this case is simultaneous definition of both extrusion bounds and required simultaneous 

imposing of Boolean subtraction or intersection. The amount of extruding is defined by the size of the 

selected bounding body. This body will be used as the target body for the Boolean. This technique can be 

used, for example, when creating through holes in a body. 

          

Through all body by direction 
This method of bounding an extrusion is very similar to the previous one. The only difference is that in this 

case the extrusion is performed only in the forward direction from the source contour position. Therefore, 

the resulting body is bounded on one side by the source contour position, whereas on the other side - by 

the selected bounding body. As in the previous case, this method requires a simultaneous Boolean 

subtraction or intersection. 
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Bounding by sheet body 
 

Bounding of an extrusion by a sheet body is done similar to the 

general case of bounding by a solid body. An operation (surface), face 

or a 3D profile can be selected as an extrusion bound. The body being 

created is extruded in the specified direction until the intersection with 

the specified sheet body. 

If the sheet body intersects with the one being created several times, 

the intersection is processed that was nearest to the position of the 

cursor when clicking the body for selection. 
 

Add-on Extrusion Features 

Creating tapers 
Tapers can be applied automatically on the side faces while creating an extrusion. All side faces of the body 

being created are slanted from the original position by the specified angle. 

The direction of tapering depends on the specified angle and body type. If the resulting extrusion is a solid 

body then positive angle values correspond to tapering toward the inside of the body. For the opposite 

result, specify a negative tapering angle. 

                 

When creating a sheet body, the choice of taper direction is left out to the system. If the system choice is 

different from the desired, simply change the angle sign. 

The taper angle can be defined either separately for each extrusion side (if the extrusion length was defined 

by a numerical value or direction vector length), or once for the whole extrusion (if the extrusion length 

was defined by specifying bounds). 
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Creating blend 
While extruding, the created side edges can be instantly blended. In the case of solid body extrusion, 

rounds or chamfers can also be applied at the end faces of the resulting extrusion. 

             

Creating thin walls 
Use of an additional mode of thin wall element creation yields a different extrusion. As a result, a body is 

created similar to that created by the “Shell” operation. This mode is only available when extruding flat 

contours. 

As any flat contour is extruded in the thin wall mode, a sheet body extrusion is created initially. Thereafter, 

it is processed depending on the selected wall type: 

 No thickness – the resulting extrusion is left as is (used for creating a sheet body based on a sheet 

contour; for a wire contour, the result is the same as in regular mode);  

                       

 With thickening the side walls by various means (inward, outward, symmetric, double-sided with 

different thickness in the outward and inward directions from the original face) – this creates a thin-

wall solid body from the sheet body by thickening the walls.  

 

The new faces in the thin-wall body are created by extruding an offset contour of the original one. The 

shape of the faces depends on the choice of handling the gaps when creating an offset contour: 

By curve – The offset curves of the original contour are prolonged until intersect.  
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By line – The offset curves of the original contour are extended at their free ends by tangent 

line segments. 

Round – The free ends of the neighboring offset curves are connected by rounds. 

                         

Creating “bottom” and “top” 
As a thin-walled body is created, only side walls exist. If necessary, one can automatically add “bottom” 

and “top” – the capping walls of specified thickness to the resulting body. 

                  

                   

This feature is not available when boundaries are specified for the extrusion. 

Using created body in Boolean operation 
To speed up modeling, an option is provided for combining an extrusion being created with a simultaneous 

Boolean operation.  
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CREATING EXTRUSION OPERATION  

Extrusion operation is created by the command 3X: Create extrusion. The command can be called in one 

of the following ways: 

Icon Ribbon 

 

3D Model → Create → Extrusion 

Keyboard Textual Menu 

<3X > Operation > Extrusion 

The automenu and the property window are used together in the command. These work together and 

enhance each other. The state of the automenu depends on the current step in defining the operation and 

on the purpose and type of the objects being selected. 

The following steps are to be done to create the operation: 

 Select extrusion contour 

 Define extrusion direction (optional when extruding in normal direction) 

 Define the length or extrusion bounds (optional in some cases) 

 Define additional parameters (taper, blend, thin-wall mode, create Boolean operation) (optional) 

 Confirm operation creation 

Selecting Extrusion Contour 

To create the operation, first define the extrusion contour. Upon calling the command, the following option 

automatically activates in the automenu: 

 <R>  Select Contour 

This option contains a list of filters for selecting 3D element allowed as extrusion contour: loop, edge, face, 

3D profile and other wire and sheet objects. When selecting elements, pay attention to the active filters. 

Use of filters is described in details in the chapter “Basic 3D terms and principals of modeling with T-FLEX 

CAD”. 
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To define the extrusion contour, move the cursor over the desired element in the 3D window. The pointed 

at element will be pre-highlighted, and the cursor gain a tooltip with the element name. Click  to select. 

3D profiles that are based on hatches can be selected by picking the original hatch in the 2D window. 

Upon selecting the extrusion contour, the option will appear in the automenu for rejecting the contour: 

 <H>  Cancel contour selection 

Calling the command with automatic contour selection 
A slick way of handling an extrusion is calling the command with automatic selection of the extrusion 

contour.  

Enter the “drawing on workplane” mode (see the chapter “Workplanes”) and draw the extrusion contour. 

 

 

Then, without leaving the active workplane mode via , call the command 3X: Create extrusion. 

The system will then automatically create a 3D profile based on the “continuous”-type graphic lines or a 

hatch, and will select it as the extrusion contour. 

Defining Extrusion Direction 

Upon selecting a sheet or flat wire contour, the system automatically offers 

to create an extrusion in the normal direction. This is indicated by the 

wireframe preview of the body being created, displayed on the 3D scene. 

There is no need in this case for defining the extrusion direction. The user 

can alter the kind of extrusion simply by defining a different extrusion 

direction by specifying a direction vector. 
 

If a preview is not displayed on the 3D scene, extrusion in the normal direction can’t be created from this 

contour. 
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The following option lets define extrusion direction vector by a 3D model element: 

 <D> Select Direction 

This option lets select a 3D element suitable for defining the extrusion direction vector. The pull-down list 

under this option contains filters for selecting respective objects. When selecting elements, pay attention 

to the active filters. 

The following automenu options let define the extrusion direction vector by two 3D points (activate 

sequentially): 

 <F> Select starting Point of Extrusion 

 <S> Select ending Point of Extrusion 

 

A 3D point can be defined by selecting a 3D node, a vertex on a body, profile 

or path. Besides, selecting an edge yields the edge midpoint as the 3D point 

(for straight edges) or the center (for edges that are full circles, arcs or 

ellipses). Selecting a face that is part of a sphere or torus yields the 

sphere/torus center as the point. A coordinate system selection yields the 

origin as the 3D point. 

The set of the elements allowed for selection is defined by the state of the 

selection filters in the pull-down lists of the mentioned options. 

Besides the automenu options, directions can be defined via the property 

window dialog. The  button in the dialog helps quickly change the 

direction of the selected vector or the surface normals to the opposite. 

The last option in the direction-defining group of the automenu rejects the 

vector selection: 

 

 

 <K>  Reset Direction selection 

Defining Extrusion Length 

The means of defining the extrusion length is selected in the section General Parameters of the command 

property window. This section contains two groups of parameters – First Direction and Second Direction. 

Each group contains a list of options for the ways of defining the length in the specified direction or the 

types of bounding conditions. 

Manipulator of extrusion 
To specify the length and also the direction of the extrusion, it is possible to use the special manipulator 

in the form of a large two-directional arrow colored in two colors. Positive direction of the extrusion is 

marked with red color, negative – with blue color. Manipulator has the context menu (invoked by pressing 
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) in which the additional options are available: 

 setting the step of the manipulator; 

 displaying additional elements of the manipulator – small spheres at the arrow ends (used for 

specifying the direction of the extrusion with two 3D points); 

selection of the type of the extrusion bounds (of the bounding surface, face, Body). 

 

 

All elements of the manipulator (the axis of the arrow, arrow ends in the form of cones or the hidden by 

default points-spheres at the arrow ends) have their own functionality. Clicking the sphere at the arrow 

end transfers the command into the mode of specifying the first and the second points of the extrusion 

direction. Clicking the axis of the arrow transfers the command into the mode of selection of the extrusion 

direction. Clicking the arrow end (cone) or dragging the arrow allows us to specify the bounds of the 

extrusion by the numerical value or via fixing to a geometric point. 

Defining extrusion length by direction vector length or numerical value 
The default option for extruding in the first (forward) direction is “Automatically”. It allows the system to 

automatically choose a means of defining the extrusion length in the first direction (depending on the way 

of defining the extrusion direction). 
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When defining the extrusion direction by a vector, the system tries to 

define the extrusion length in the first direction by the vector length. 

This is possible only when the vector is defined by two 3D points or a 

straight edge. The input box of the extrusion length in the first 

direction becomes inaccessible for editing. The numerical value 

displayed in this box reflects the value derived from the vector length. 

To override this mode, one can force the extrusion length input mode 

(in the first direction) by a numerical value. To do this, simply change 

the option of defining the length to By value. 

When defining the direction vector by other means (for example, by 

the axis of a cylindrical face or normal to a surface), as well as in the 

case of normal extrusion, the extrusion length can’t be defined by the 

length of the direction vector. In this situation, the system will offer to 

enter the extrusion length as a numerical value. The Length input box 

will become accessible for input. In it, specify the desired value of the 

extrusion length (in the first direction).  

 

 

 

By default, extruding is not performed in the second direction. The 

Second Direction group has the option No set in this case. The input 

boxes of the extrusion length and taper in the second direction are 

inaccessible. 

To perform extruding in the second direction, select another option of 

defining the length from the list. To have the extrusion length in the 

second direction equal to the extrusion length in the first direction, 

select the option Symmetric. The Length input box stays inaccessible 

in this case.  

To define the extrusion length in the second direction by an 

independent numerical value, select the option By value. The value 

input box will become accessible. 

The wireframe preview on the 3D scene shows the resulting extrusion 

with the specified parameters. Besides, it can also be used for inputting 

the value of the extrusion length both in the first and in the second 

direction. 
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As the cursor approaches the preview of the body being created, 

it gets marked as  (for extruding in the first direction) or  

(for extruding in the second direction). Dragging the mouse with 

the depressed  dynamically changes the extrusion length. The 

numerical value of the current length is reflected in the property 

window. 

The sampling of mouse input depends on the amount of zoom 

into the object. For example, by zooming in one can refine the 

sampling step by 10 times. 

 

Note that in the mode of defining the length of for extrusion in the first direction by the length of the 

extrusion vector, the wireframe preview on the 3D scene allows to change dynamically only the length in 

the second direction. In the case of the extrusion length in the second direction being defined by the 

option “Symmetric”, the length in that direction can’t be modified by the mouse either. 

Defining extrusion bounds 
The mode of defining the length by boundaries is represented with the following items in the lists of 

methods to define the extrusion length: Through All, Through All by Direction, To Surface, To Face, To 

Body, To Sheet, Offset, To Nearest Face. 

Defining extrusion bounds is done by combined use of the 

property window and the automenu. In the general 

parameters of the property window, select the type of 

each bound in the first and second direction. Parameters 

of each bound can also be defined there, if necessary. 

The names of the groups (“First Direction”, “Second 

Direction”) for specifying bounds are essentially 

arbitrary. The bound positions are generally not 

related to the extrusion directions. The exception 

here is the bounding condition of the “To nearest 

face” type that is defined for a particular extrusion 

direction. 

After selecting the bound types, one of the following 

options become available in the automenu: 

 

 

 <T> Select 1st limit of extrusion 

 <B> Select 2nd limit of extrusion 
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These options are used for selecting 3D elements defining the bounding conditions. These options may 

have pull-down lists containing filters for selecting 3D elements. The presence and contents of a list are 

determined by the specified type of the respective bound. 

The last option in this automenu group rejects the selection. Depending on the state of the command, this 

may be one of the following icons of rejecting a bound: 

 <U> Discard 1st extrusion limit 

 <U> Discard 2nd extrusion limit 

 <U> Discard extrusion limits 

The option  is available while defining the first bound (under the active option ). The option  is 

available while defining the second bound (under the active option ). In other states of the command 

(for example, under the option of contour or direction selection), the option is displayed for rejecting both 

bounds . 

When using bounds, the extrusion direction vector is displayed in the 3D window by a blue arrow. The 

elements selected as bounds are also outlined (by default, in blue color).  

 

The wireframe preview of the extrusion being created won’t be displayed in this case. To preview the 

resulting operation, use the preview option in the automenu or the respective button in the property 

window:  

 <F5> Preview Operation Result 

The type of the first bound can be selected among extrusion parameters in the first direction. The following 

options can be selected from the list: 
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Offset. This is the condition type “Offset from the 

original contour plane”. In the extrusion 

parameters, enter the value of the offset from the 

original contour plane in the “Offset” input box. 

To surface. This is the condition type “To surface”. 

On the 3D scene, select a worksurface/workplane, 

face, flat edge, simple body or profile. The list of 

elements allowed for selection is defined by the 

state of the filters of the option . 

If necessary, one can enter the value of the offset 

from the specified surface in the Offset input box. 
 

To face. This is the condition type “To face”. On the 3D scene, select a bounding face for the 

extrusion. 

To body. This is the condition type “To body”. On the 3D scene, select a bounding body for the 

extrusion. If the bounding body intersects with the extrusion several times, the intersection is 

processed that was nearest to the position of the cursor when clicking the body for selection.  

To nearest face. This is the condition type “To nearest face”. On the 3D scene, select a body with 

the nearest to the extrusion face serving as the extrusion bound. 

The specified body must be located properly. For the first bound, the selected body should be in 

the first extruding direction from the extrusion contour. For the second bound, the body should be 

in the second direction. 

Through all, Through All by Direction. These are the conditions of the types “Through all body” 

and “Through all body by direction”, respectively. These boundary conditions do not require the 

second bound definition. 

If any of these types of boundary conditions is used, then the mode of creating a Boolean 

operation (“Subtraction” or “Intersection”) is enabled automatically. The body, whose extents 

define the extrusion length, is treated as the target body for the Boolean. 

To sheet. This is the condition type “Bounding by sheet body”. On the 3D scene, select a sheet 

body, face or 3D profile. The list of elements allowed for selection is defined by the state of the 

filters in the option . 

The type of the second bound is defined among the extrusion parameters in the second direction in the 

same way. The list of 3D elements allowed for selection for each type of the bounding condition is defined 

by the state of the option . 

Defining extrusion length by an offset from a 3D point or a plane 
This method of defining an extrusion length is used, if the From Base item is chosen in the properties 

window or one of the following options is selected in the automenu: 
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 <Ctrl+N> Select Starting Point of Extrusion 

 <Ctrl+P> Select Plane setting starting position of Extrusion 

 

Both options have drop-down lists with the filters to select geometrical objects defining a 3D point or a 

plane. 

A point or plane selection can be canceled using the option: 

 <Ctrl+F> Cancel selection of Extrusion Base 

Defining Add-on Operation Features 

The result of add-on extrusion features is not reflected on the preview of the body being created on the 

3D scene. To preview those, use the option . 

Creating tapers 
The value of the taper is entered in the property window. 

In the case of defining the extrusion length by an arbitrary 

numerical value or by the length of the direction vector, 

the separate values are specified for the tapers in the first 

and second direction. 

To create a taper in either extruding direction, check the 

Taper item in the respective group (First Direction, 

Second Direction). The input box then becomes accessible 

for entering a numerical value for the taper. 

If the extrusion length is defined by bounds then tapering 

is uniform across the extrusion extents. Its numerical value 

is defined in the group of the first extrusion bound (the 

First Direction group). 

 

Creating edge blends 
The parameters of various blends can be defined in the Blend Parameters section of the property window: 
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The Target Blend and Source Blend groups define 

blending parameters on the end faces of the extrusion. To 

create a blend, check the respective item, select a blending 

type from the list – Round or Chamfer and specify the 

amount of blending. 

The source face is considered the first end face 

when moving through the extrusion along the first 

extruding direction. 

The Fillet flag sets the mode of rounding side edges of the 

extrusion. The rounding radius is defined by the Radius 

parameter. 

 

Creating thin walls, “bottom” and “top” 
The parameters of the thin-wall extrusion can be defined in the section Thin Wall of the property window. 

To turn on the mode of thin-wall body creation, check the item Thin Wall. With the item checked, the 

following parameters of this mode become accessible: 

Thickness. Defines the way of thickening the walls of the 

thin-wall body being created. The following options can 

be selected from the list: 

No. Without thickening of the side walls (the resulting 

extrusion will be a sheet body). 

Outward, Inward, Symmetric, Double sided. Define 

various ways of thickening. The result of using each of 

these options is shown on the diagrams. The wall thickness 

is defined by the parameters Value 1 and Value 2.  
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The ways of handling the gaps between the created offset faces are defined by the parameter Gap: By line, 

Round, By curve. 

To create the “bottom” and “top”, check the respective items in the dialog and specify the desired thickness 

of these elements. 

Using the created extrusion in a Boolean 
To create a Boolean operation, do the following: 

Turn on the Boolean creation mode by the automenu option: 

 <Ctrl+B> Select original body for Boolean operation 

A Boolean is created when the icon is pushed. 

Select the type of the operation from the pull-down list under the above option: 

 <Ctrl+'+'> Addition 

 <Ctrl+'-'> Subtraction 

 <Ctrl+’*’> Intersection 

 <Ctrl+l> Smart mode 

Operating principles of the Smart mode: 

 If the body being created and the existed selected body have intersection of volumes - the type 

of Boolean operations: subtraction. 

 If the body being created lies entirely within the selected body - the type of Boolean operations: 

subtraction. 

 If the body being created touches and selected body touch each other - the type of Boolean 

operations: addition. 

 If conditions set out above are not met, or a selected body lies inside the created, or error 

occurred determining the type of penetration, then, Boolean type is not defined - the Boolean 

operation will not be created. 

Select the target body for the Boolean (optional in some cases), using the automenu option: 

 <Ctrl+T> Select Target Body for Boolean 

If only one body exists in the scene, it is selected automatically. The new body created by the extrusion 

operation becomes the tool body of the Boolean. 

Upon confirming operation creation, first the body is created by the extrusion operation, and then the 

specified type Boolean is performed. 
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ROTATION 

Rotation operation creates solids by rotational sweeping of the shape-defining element – the rotation 

contour about an axis in space. The surface of the profile can be arbitrarily positioned with respect to the 

axis, but is not allowed to intersect the axis. Flat contours may not be orthogonal to the axis of revolution. 

The rotation contour can be made of wire or sheet geometry objects. The resulting rotation is a sheet or 

solid body, depending on the type of the contour geometry. 

The axis of revolution can be defined by any suitable 3D elements: 3D nodes, edge, axis of a surface of 

revolution, coordinate axis, etc. 

MAIN CONCEPTS .  OPERATION CAPABIL IT IES  

Rotation operation has much in common with the extrusion operation, since both operations belong in 

kinematical operation group. Both operations have the same rules of selecting the original contour, create 

bodies of the same types and share the same additional functionalities. Therefore, in this chapter we won’t 

be concerned with the rotation operation capabilities that are common to both operations and were 

already described in the “Extrusion” chapter. 

Rotation Contour 

The rotation contour can be composed of one or several wire or sheet objects. If selecting several objects, 

only same-type objects are allowed, either all wire or all sheet objects. 

The result of rotation of a wire contour is a sheet body. Extrusion of a sheet contour makes a solid body. 

           

Axis of Revolution 

The axis is represented by the vector. The specified contour is rotated about this axis. The direction of 

contour rotation is defined by the right-hand screw rule: rotation is counter clock-wise as watched in the 

arrow direction. 

The axis can be defined either by a pair of 3D points for the axis to pass through or by selecting some 3D 

model element, suitable for defining a line. 
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If a 3D node was selected as the first point that was based on a 2D node, then only one point is enough. 

In this case, the direction is defined by the normal to the workplane hosting the 2D node. 

The axis can be defined explicitly by following 3D objects: flat curved edges that are arcs (in this case the 

axis of the arc edge is used as the axis of revolution), straight edges (the axis coincides with the edge), 

coordinate systems (one of the axes is used), surfaces/faces that are part of a cylinder or torus (the axis of 

the surface/face is used as the axis of revolution), various curves (the axis is defined by the normal or 

binormal to the curve at the specified point). The direction of the axis is defined by the direction of the 

selected element. 

                  

Angle of Contour Rotation 

Rotation is performed from the original contour position by the angle specified by the user, no greater 

than 360 degrees (full turn). Additionally, the start angle of rotation can be specified. In this case, the 

contour will be rotated about the axis starting from the position defined by the start angle of rotation, for 

the amount of the specified rotation angle.  
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The start angle and the rotation angle are defined either by numerical values in the operation parameters 

dialog or by specifying additional 3D points. 

Add-on Features of Rotation Operation 

Additional features of the rotation operation include: 

 Filleting of side edges of the resulting body. Besides, for bodies created by rotating by less 

than 360 degrees, rounds or chamfers can be applied on the end faces; 

 Thin-wall body creation mode; 

 Using created body in Boolean operation. 

Detailed description of these features is provided in the “Extrusion” chapter. 

CREATING ROTATION OPERATION  

To create a body by rotation operation, use the command 3RO: Create Rotation. The command can be 

called as follows: 

Icon Ribbon 

 

3D Model → Create → Rotation 

Keyboard Textual Menu 

<3RO> Operation > Rotation  

The following steps are to be done to create the operation: 

1. Select Rotation contour; 

2. Specify axis of revolution; 

3. Define the start angle and rotation angle (optional in some cases); 

4. Define add-on feature parameters (optional, performed as described in the “Extrusion” 

chapter); 

5. Confirm operation creation. 
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Contour and axis of revolution selection can be automatic if calling the command in the active workplane 

drawing mode. In this case, the system will automatically create a 3D profile based on the continuous 

graphic lines or a hatch and select it as the rotation contour. If only a single dash-dotted line was created 

on the workplane, it will be automatically selected as the axis of revolution. 

Rotation Contour Selection 

To create the operation, first define the rotation contour. Upon calling the command, the following option 

activates automatically in the automenu: 

 <R>  Select Contour 

To select a contour for the rotation, move the cursor over the desired element in the 3D window. The 

pointed at element will be pre-highlighted, and the cursor gain a tooltip with its name. Click  for selection. 

3D profiles based on hatches can be selected by picking the original hatch in the 2D window. 

After selecting the rotation contour, the option will appear in the automenu for rejecting the contour: 

 <H>  Cancel contour selection 

Defining Axis of Revolution 

After selecting the rotation contour, define the axis of revolution.  

To define the axis by an arbitrary 3D model element, use the automenu option  

 <A>  Select axis of revolution 

This option allows selecting a 3D element, suitable for defining the axis of revolution. The pull-down list of 

this option contains appropriate filters for selecting various objects. Pay attention to the active filters when 

selecting elements. 

To define axis of revolution by two 3D points, use the following automenu options (activate sequentially): 

 <F>  Select 1st Point of axis 

 <S>  Select 2nd Point of axis 
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A 3D point can be defined by selecting a 3D node, a vertex of a 

body, profile or path. Besides, an edge can be picked – in this case, 

the 3D point will be defined by the edge midpoint (for straight 

edges) or center (for edges that are arcs, circles and ellipses). 

Selecting a face, which is part of a sphere or torus, yields the point 

at the sphere/torus center. A coordinate system selection yields its 

origin as the 3D point. 

The set of elements allowed for selection is defined by the state of 

selection filters in the pull-down lists of the d270escribed options.  

The axis can be defined by a single point by selecting as the first point a 3D node based on a 2D 

node. In this case, the axis is defined by the normal to the workplane hosting the 2D node. 

Upon defining the axis, a wireframe preview of the resulting rotation 

is displayed in the 3D window, with an arrow showing the position 

and direction of the axis of revolution. 

 

Defining Start Angle and Rotation Angle 
 

The start angle and rotation angle are defined in the 

command property window in the section Rotation 

Parameters. By default, the system offers a 360-degree 

rotation (full turn of the contour) and zero start angle (the 

contour will be rotated from its original position). 

If necessary, the default parameters can be modified. The 

rotation angle is defined by the parameter Angle. To 

change the start angle of the rotation, enter the desired 

value in the Start Angle input box. 
 

The wireframe preview on the 3D scene shows the resulting 

rotation with the current parameters. Both the start angle 

and rotation angle can be defined directly on the 3D scene. 

As the cursor approaches the preview of the body being 

created, it gains a mark  (for the start angle) or  (for 

the rotation angle). Dragging the cursor with  depressed 

dynamically sets the value of either angle. The numerical 

value of the angle is displayed in the property window.  

Rotation parameters can be defined by additional 3D points selected with the help of the following 

automenu options: 
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 <1>  Select starting point of Rotation 

 <2> Select ending point of Rotation 

These options become sequentially accessible after defining the axis of revolution. Both options contain 

pull-down lists with filters for selecting elements suitable for defining a 3D point. 

 

When using 3D points, consider the type of the rotation contour. If the contour is flat then the specified 

points define the start and end positions of the contour plane in the rotation (the contour plane will be 

passing through the specified points in these positions). Therefore, the first point defines the start angle, 

and the combination of the two – the rotation angle. One can only specify the first point, and then enter 

the rotation angle numerically in the parameters dialog box. 

When using 3D points for a non-flat contour, always define both points. Note that in such case, the point 

positions define the rotation angle only, as the start angle is always set to zero (the rotation starts at the 

original contour). 

 

After defining the 3D points, dynamic angle modifications are no longer available on the 3D scene. The 

respective parameter input boxes also become inaccessible in the command property window. 

Selection of 3D points can be cancelled by the automenu option: 

 <K> Cancel selection of points for Rotation 

Using the created rotation in a Boolean 
To create a Boolean operation, do the following: 

Turn on the Boolean creation mode by the automenu option: 

 <Ctrl+B> Select original body for Boolean operation 

A Boolean is created when the icon is pushed. 

Select the type of the operation from the pull-down list under the above option: 

 <Ctrl+'+'> Addition 

 <Ctrl+'-'> Subtraction 

 <Ctrl+’*’> Intersection 

 <Ctrl+l> Smart mode 

 

 

Operating principles of the Smart mode: 
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 If the body being created and the existed selected body have intersection of volumes - the type 

of Boolean operations: subtraction. 

 If the body being created lies entirely within the selected body - the type of Boolean operations: 

subtraction. 

 If the body being created touches and selected body touch each other - the type of Boolean 

operations: addition. 

 If conditions set out above are not met, or a selected body lies inside the created, or error 

occurred determining the type of penetration, then, Boolean type is not defined - the Boolean 

operation will not be created. 

Select the target body for the Boolean (optional in some cases), using the automenu option: 

 <Ctrl+T> Select Target Body for Boolean 

If only one body exists in the scene, it is selected automatically. The new body created by the rotation 

operation becomes the tool body of the Boolean. 

Upon confirming operation creation, first the body is created by the rotation operation, and then the 

specified type Boolean is performed.
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BOOLEAN OPERATION 

Boolean operation creates a new body based on two or more existing bodies. As a result of the operation, 

a new body is created that is a combination of the source bodies.  

GENERAL CONCEPTS .  OPERATION CAPABIL IT IES  

Types of Boolean 

There are three types of Boolean operations:  

 Addition. This operation results in a body which is the union of all pieces of the bodies participating in 

the operation. 

 Subtraction. This operation subtracts one body from another body. 

 Intersection. This operation results in the body which is the intersection of the participating bodies, 

being their common part. 

                      

Boolean Operands 

The bodies combined in a Boolean are called operands of the Boolean operation. Operands of a Boolean 

are the target and the tool. The bodies that are worked on are called “Target” of a Boolean. The bodies 

used for the manipulations are called “Tool”. Different result is obtained, depending on which of the body 

was the target and which was the tool. 

  

A Boolean can also be defined on a set of bodies, some of which are selected as the target and other as 

the tool. In such an operation, all targets are united in one body, and all tools are united in another one. 

Then, a Boolean is performed on these bodies. This results in a single multiple-connected body. 
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Results of Boolean Operations 

Operands can be either solids or sheet bodies. By selecting various combinations of operands and using 

different options, you can get a variety of results of a Boolean operation. 

 

Note that in certain cases, inadmissible combinations of operand types in a Boolean will not produce 

a valid result. 

Below, we review common operand combinations and results of the respective Boolean operations. 

Selecting type of the resulting body 
In some cases, a Boolean can produce either a solid or a sheet body. The user can select the type of the 

resulting body with the help of the parameter “Create body”. 

 

This complementary option allows selecting one or another type of the resulting body, if possible 

under the rest of conditions. If the selected body type cannot be generated by the operation, this 

parameter setting will be ignored. 

Sheet body treatment 
A sheet body used as an operand in a Boolean, can be treated in the command as the sheet body proper 

or as a semi-space. Different results will be obtained, depending on the treatment of the sheet body and 

on whether it is used as the target or the tool. 

 

If a sheet body operand is treated as a semi-space, then the vectors normal to the sheet body surface will 

be displayed in the scene. Direction of those vectors specifies which semi-space is selected, determining 

the operation result.  
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“Addition” operation 
The following are the results of the Boolean “Addition” per different operand type combinations: 

Target Tool Result 

solid solid solid  

sheet  

(semi-space) 
solid sheet 

solid sheet (semi-space) solid  

sheet 

(semi-space) 

sheet 

(semi-space) 

sheet 

(with corners) 

sheet sheet 
sheet 

(sewn) 

 

Solid + Solid 

If both the target and the tool are solid, then the operation results in a single body uniting all parts of the 

bodies subjected to the operation. 

 

Sheet + Solid 

The operation results in a sheet, which is “stamping” of the sheet with a portion of the solid body. 

Depending on the selected semi-space, the “stamping” is created either on the bottom or on the top part.  

Note that the sheet must fully intersect with the solid. 
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Solid + Sheet 

If a solid is selected as the target, while a sheet - as the tool, then the default result of the Boolean 

“Addition” will be a solid. The faces of the sheet body will create an additional volume for the solid. 

The sheet body must be defined as a semi-space in this instance of the command. 

Note that this type of the Boolean operation requires, that the sheet body formed a closed volume 

when united with the solid. Otherwise, the operation cannot create a valid result.  

When selecting a sheet body, pay attention to the normal vectors direction. An invalid result can be 

produced due to certain normal directions. In such a case, you need to specify the other semi-space by the 

parameter “Operands treatment”. 
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Sheet + Sheet 

Adding two sheet bodies results in a sheet. For successful operation creation, the faces of the sheet bodies 

must either have a common edge or coincide within some region. This functionality is similar to the “Sew” 

operation. The difference is in that the Boolean “Addition” does not eliminate gaps between the bodies, 

while the “Sew” attempts to create a new continuous surface. 

               

 “Subtraction”operation 
Following are the results of the Boolean “Subtraction” for different operand type combinations: 

Target Tool Result 

solid solid solid  

sheet solid sheet 

solid sheet (semi-space) solid  

sheet 

(semi-space) 

sheet 

(semi-space) 

sheet 

(with corners) 

Solid - Solid 

The result of the Boolean “Subtraction” of one solid from another one will be the target body with the 

removed tool portion of the volume.  
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When creating the Boolean “Subtraction”, the system guards from a situation in which the target 

body would have portions with zero-thickness walls. This would break the model topology. 

 

Sheet - Solid 

When a solid is subtracted from a sheet, an opening is created in the sheet body, repeating the shape of 

the solid tool. 

 

 

Solid - Sheet (semi-space) 

Subtracting a sheet body from a solid leaves a part of the solid body cut off by the sheet. In this case, the 

sheet body must be defined as a semi-space. Depending on the selected semi-space, either the upper or 

the lower portion of the solid remains. This type of the Boolean is analogous to the “Cut” operation. 
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“Intersection”operation 
The results of the Boolean “Intersection” operation on various combinations of the operand types are: 

Target Tool Result 

solid solid solid  

sheet solid sheet 

sheet 

(semi-space) 
solid solid  

solid 
sheet 

(semi-space) 
solid  

sheet 

(semi-space) 

sheet 

(semi-space) 

sheet 

(with corners) 

 

Solid ∩ Solid 

The result of intersection of two bodies is the body that is the common part of all operands. 

 

Sheet (semi-space) ∩ Sheet (semi-space) 

If sheet bodies coincide within some region, then their common portion is left as a result of the Boolean 

“Intersection”.  
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Sheet ∩ Solid 

If a sheet is selected as the target while a solid as the tool, then the Boolean “Intersection” operation will 

result in creation of a sheet which is the common part of the two operands. 

 

                     

Solid ∩ Sheet (semi-space) 

The result of performing the Boolean “Intersection” of a sheet body treated as a semi-space, and a solid, 

will be the portion of the solid body cut off by the sheet. The result of performing this operation is similar 

to the result of the Boolean “Subtraction” of a sheet (semi-space) from a solid. The difference is in that the 

result of the “Intersection” operation is the other part of the solid. Note that the order of selecting operands 

does not affect the result. 
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Boolean operations on sheet bodies (semi-spaces) 
One indication to using Boolean operations on sheet bodies is creation of corners. In this case, the sheets 

specified in the command must intersect and be treated as semi-spaces. Depending on the normal 

directions of the sheet surfaces and the type of the used Boolean operation, different sheet bodies are 

produced as a result.  Note that the normal directions are preserved on the resulting body. 

 

If one sheet does not fully intersect the other one, the Boolean won't work. To fix the situation, an option 

is provided among the Boolean operation parameters for extending edges of the target or the tool up to 

the next edge or the body boundary. In this case, the intersection line between these two bodies will be 

extended tangentially up to the selected edge or to the boundary of one of the operands. 

 

Global and Local Boolean Operations 

If sheet or solid bodies are selected as operands, we will call such instances of the Boolean operation 

“Global”. When creating such a Boolean operation, the system automatically determines which faces of the 

bodies are involved in the operation, and finds their intersections. If a Boolean involves geometrically 

complex bodies or the large number of operands, then the search for all intersections may noticeably delay 

the command execution.  

Besides the “Global” Boolean operation, T-FLEX also introduces the “Local” Boolean operation. Unlike the 

“Global” Boolean operation whose operands are always bodies, the “Local” Boolean operation allows 

selecting faces, besides the body operands. The operand faces can be selected with the help of the tab 
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“Faces” in the operation’s parameters. In some cases, use of the “Local” Boolean operation saves 

considerable time on the model regeneration, as compared with the “Global” Boolean operation, since the 

intersections will be searched only among the specified faces when processing the operation. For example, 

to make a hole in a rather complicated body, you can specify the faces to be intersected in the operation 

parameters if you know in advance that just few faces will be intersected. 

You need to be careful when selecting faces for the “Local” Boolean operation. An invalid body may 

result from incorrect selection of faces. 

 

Selecting specific faces for the operands of a “Local” Boolean operation with the option “Cut by Faces of 

First Operands” turned on, allows creating bodies like those shown on the diagram below. In this case, the 

intersection lines between the operands’ boundaries will be determined first, and then closed loops will be 

formed along these intersection lines and the boundaries of the target operands’ faces, in order to create 

a Boolean operation. 

 

In some cases, the option “Use Neighbor Faces” can be conveniently used for the target or the tool. All you 

need is select one face of an operand, and the system will automatically define the neighboring faces in 

such a way, that the intersection lines between the operand faces form closed loops. In this case, changes 

in the number of faces making a closed loop due to operand modifications, will not invalidate the result of 

the Boolean operation. 



Boolean Operation 

397 

 

Selective Boolean Operations 
 

When intersected, operand faces create common edges. Those edges 

divide the bodies of the operands into pieces. There are inner pieces 

(shared by the operands) and outer pieces of operands. When creating 

a Boolean operation, you can specify the outer pieces of the operands 

that will be left in the resulting body, or, on the contrary, excluded from 

it. 

A piece of an operand is defined by topology elements, such as vertices, 

edges are faces. To select a piece of an operand, you need to specify 

one of such elements in the operation parameters on the tab 

“Selections”.  

 

The diagram below shows an example of using a selective Boolean “Addition” operation, whose execution 

results in a body containing only selected pieces of the tool. 

 

In some cases, the selected topology element does not explicitly defines the desired piece. For example, 

as shown on the diagram below, the selected face belongs to several outer pieces of the tool. To uniquely 
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determined the desired piece, one needs to create a 3D node on this face, and then select this 3D node by 

the option “Select point that indicates part of operand”. In this case, you do not have to select the face. 

 

   

Setting Element Matches 

In the cases when the operands have coinciding regions, the command provides the function of 

additionally specifying topological correspondence of the operands’ regions. The command will select the 

appropriate algorithm for creating the Boolean operation based on this information. 

This function allows: 

 

 Speed up regeneration of the Boolean operation due to the particular specified type of contact. 

 Successfully create the Boolean operation in the cases when this would be impossible without 

knowing the match. An example of such situation is a contact between a spline and an analytical 

surface (a Boolean on a cylinder and a face of a helix on the diagram below). 

The command has provisions for four types of matches: 

 

 Exact match – the boundaries of topological elements coincide within the specified tolerance. 

 Contained – the boundary of the second element lies fully within the extents of the first element’s 

boundary.  

 Overlap – the boundary of one element partially coincides with the boundary of the other element. 

 Imprinted – the boundaries of the imprinted topological elements coincide. 

The table below presents the description of match types for operands of various topology: 

Match 

Contact type 
Exact match Contained Overlap Imprinted 
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Vertex  

Vertex 
– – – 

Projections of 

operands’ 

vertices coincide 

Edge  

Edge 

Edge curves coincide 

within specified 

tolerance. Respective 

vertices of edges 

coincide within 

specified tolerance. 

Edge curves coincide 

within specified 

tolerance. 

Extents of the second 

edge are fully within 

the first edge 

– 

Imprinted 

operands’ edges 

coincide 

Face  

Edge 
– 

Edge curve lies on the 

surface of the face 

within specified 

tolerance. Edge lies 

fully within the extents 

of a face. 

Edge curve lies on 

surface of the face 

within specified 

tolerance. Edge may 

intersect the face 

boundary (edges). 

– 

Face  

 Face 

Surfaces of faces 

coincide within 

specified tolerance. 

Each edge of first 

face has matching 

edge on second face. 

Inexact coincidence 

of edges is allowed. 

Surfaces of faces 

coincide within 

specified tolerance. 

Second face is fully 

contained within first 

face. No edge of 

second face intersects 

boundaries of first 

face. Edges may 

coincide. 

Surfaces of faces 

coincide within 

specified tolerance. 

Boundary of one face 

may intersect boundary 

of the other face. Edges 

of the faces may 

coincide. 

– 
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A match can be exact or approximate. An exact match implies that the operands have only the described 

contacts and no more overlaps or intersections. If the inexact (“tolerant”) matching is set, the system will 

be searching for other intersections of operands, besides the specified contacts. This type of processing 

takes more time, compared to the exact matching; however, in some cases this is the only possible way of 

creating a Boolean operation.  

The diagram below illustrates defining a match in a Boolean “Addition” operation on a semi-sphere and a 

cone with the common base. If the match is defined as coincident faces at the base, and the exact option 

is used, then the Boolean operation will not be possible to create, since there is another common edge in 

the intersection of the operands, which is not described among the matches. In this case, the only option 

is use of the inexact matching that will find this other intersection during the processing.  

 

Blending New Edges 

Another capability of Boolean operations is blending new edges. By new edges, we mean the edges created 

as a result of intersecting faces of the operands. As the operands’ geometry changes, the system will 
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automatically track the increasing or decreasing number of new edges and create blending. You can select 

the type of blending in the command: round or chamfer, and specify the blending radius.  

 

Missing Operands 

When creating a Boolean operation, you can turn on the option “Allow missing operand”. This technique 

is often used in parametric models, when one of the model's elements needs to be excluded in some 

instances. As shown on the diagram below, a nut can be in two instances: with and without grooving. To 

realize both instances in one model, one can suppress the tool, while maintaining the rest of the 

consequent operations based on the Boolean (in the example, this is the cosmetic thread on the face of 

the Boolean operation). 

If this option is turned off, then an error will be output when recreating this Boolean operation with the 

operand suppressed. 

 

CREATING BOOLEAN OPERATION  

The Boolean operation creation command can be called in one of the following ways: 



Three-Dimensional Modeling 

402 

Icon Ribbon 

 

3D Model → Create → Boolean 

Keyboard Textual Menu 

<3B> Operation > Boolean  

The automenu and the property window are used together in the command. These work together and 

enhance each other. The state of the automenu depends on the step of defining the operation and on the 

purpose and type of the objects being selected. 

The following steps are to be done to create the operation: 

 Select Boolean operands; 

 Select the type of the Boolean operation; 

 Specify operands’ pieces for creating a selective Boolean operation (optional); 

 Define element matches (optional); 

 Define additional parameters (if necessary); 

 Define blending parameters (optional); 

 Confirm operation creation. 

Main Operation Parameters 

Selecting operands 
Selecting operands of the global Boolean operation 

To select operands of a global Boolean operation, use the following option: 

 <1> Select Boolean operands  

At this point, the options become available in the automenu: 

 <F> Select 1st body 

 <S> Select 2nd body 
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As one of these options is activated, the input focus switches to the 

respective pane of selecting targets or tools in the property window. Vice 

versa, as you switch the focus between the selected operands panes in the 

property window, the respective options activate in the automenu. 

Target and tool bodies can be selected either directly in the 3D scene or in 

the 3D model tree. Target bodies are highlighted green in the scene, tools 

– yellow. An operand selected in the property window is highlighted blue in 

the scene. 

To delete any operand from the list, select it in the “Properties” window, and 

then press the button [Delete]. 

 

To cancel selection of all operands, use the option: 

 <D> Cancel selection of all operands 

Once the Boolean operation is created, the operand bodies will be removed from the scene, with only the 

resulting body left. For each operand, you can turn on the option “Keep source body”. In this case, the 

body of the operand with this option engaged will be left in the scene upon creating the operation.  

If a sheet is selected as an operand, you need to specify the treatment 

for this body. There are three ways of treating a sheet body: as a sheet 

proper, or as an upper or lower semi-space. Depending on its definition 

by the system, the resulting Boolean operation will be created 

differently. 

A sheet body’s treatment can be defined by selecting the appropriate 

value in the combo box of the operands’ treatment parameters. 
 

Selecting operands for the Boolean operation 

To enter the mode of selecting faces for creating a local Boolean operation, one can use the automenu 

option: 

 <3> Select local faces  

Alternatively, to activate this mode, you can switch to the “Faces” tab in the “Properties” window. 

At that time, the following options become available in the automenu: 

 <F> Select local faces for first Operands 

 <S> Select local faces for second Operands 
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Once the operands are selected, you can proceed with selecting bodies’ 

faces for creating a local Boolean operation. You can do this in the scene 

by the mentioned automenu options or by focusing on the pane of the 

“Faces” tab. 

When creating a Boolean operation, you can skip selecting operands and 

directly proceed to the mode of selecting faces. In this case, the bodies, 

whose faces are selected, will be automatically added as operands on 

the respective tab in the operation parameters. 

Highlighting of the target and tool faces is analogous to that of the 

bodies-operands. To remove a face, select it in the list on the “Faces” tab, 

and then press the button [Delete]. 

In some cases, you may need to turn on the option “Cut by Faces of 

Target Bodies” to insure the correct operation result. 

To cancel selection of all local faces, use the option: 

 

 

 <D> Cancel local faces selection 

 

When creating a local Boolean operation, you can engage faces adjacent 

to the selected face. To do this, select the respective entry in the combo 

box of the Use Neighbor Faces parameter. 
 

 

 

Selecting Boolean type 
Selection of the operation type is done either via the parameter “Operation Type” in the property window, 

or by the following options in the automenu: 

 

 

 <+> Addition 

 <-> Subtraction 

 <*> Intersection 
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When the Boolean operation is called first time in a session, the Boolean operation type “Addition” is 

automatically set in the automenu. On subsequent calls to the Boolean, the default button will be the type 

used in the previously called Boolean. 

Selecting operands’ pieces 
To create a selective Boolean operation, use the following option: 

 <2> Select parts of operands  

Alternatively, to activate this mode, you can switch to the Selections tab in the “Properties” window. In this 

case, the following options become available in the automenu: 

 <F> Select element that indicates part of operand 

 <H> Select point that indicates part of operand 

 <D> 
Cancel selection of elements that indicate parts of 

operands 

 

 

With these options, you can select the elements defining the operands’ 

pieces. The names of the selected elements will be added to the list on the 

“Selections” tab in the “Properties” window.  

On the same tab, you can select the action for the selected pieces of the 

operands: leave those in the resulting body, or exclude. The selected action 

will work on all selected pieces of the operands.  

Setting element matches 
To define element matches, use the option: 

 <4> Select matches 

Alternatively, to activate this mode, you can switch to the Matches tab in the “Properties” window. Then, 

the following options become available in the automenu: 

 <F> Select first match Element 

 <S> Select second match Element 

 <D> Cancel match selection 
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Use these options to select pairs of elements for defining matches. 

The names of the selected elements are displayed on the “Matches” 

tab in the “Properties” window. Each pair of elements can be 

assigned the exact or approximate (“tolerant”) matching option. The 

type of match is selected from the “Type” combo box on this tab.  

Note that the set of match types in this combo box can vary, 

depending on the particular combination of element topologies in a 

pair (see the table in the topic “Setting element matches”). 

The matching tolerance can be specified on this tab. 

   

 

Preview of Boolean Operations Results 
 

To preview the result of a Boolean operation and also the changes introduced by a Boolean operation it is 

required to use the preview option in the automenu or a similar button in the properties window: 

 <F5> Preview result of operation 

 <Ctrl+F5> Preview changes introduced by operation 

Additional Operation Parameters 

Extending operands’ edges 
If sheet bodies defined as semi-spaces are used as operands in the command, then edges may need to be 

extended to achieve intersection of the operands in order for the command to succeed with the Boolean 

operation creation. To do this, select the type of the object, up to which the edges of the target or tool 

body are to be extended. This can be done using the respective additional parameters. 

 

Selecting the type of resulting body 
If a Boolean operation permits either the solid or the sheet result, then the desired type can be set by the 

option “Create body” in the additional operations parameters.  
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By default, the command will create the resulting body of the preferred type. 

 

As was mentioned earlier, this option is complementary. If the selected type of the resulting body is 

impossible, this parameter setting will be ignored. 

Use Pattern Copying 
If a 3D array is used as one of the operands, you can significantly reduce the time of executing the Boolean 

operation by turning on the parameter “Use Pattern Copying”. 

 

Provision for a missing operand 
By turning on the “Allow missing operand” parameter in the Boolean being created, you will be able to 

suppress one of the operands in the future, and still keep the result of the Boolean operation. 

 

Material of newly created faces 
To determine the material to which the result of the Boolean operation is applied, the combination of 

parameters is used. In addition to material parameters found on the “General” tab and common for all 

operations (the “Source”, “Main”, “Covering” parameters), the material assignment parameter for the new 

faces, which are created as a result of applying Boolean operation, is also taken into account. This 

parameter is located on the “Parameters” tab and is called Material of new faces. 

 

This parameter can take one of the three values: 

 Material of 1st operand. In this case the main material or the material of the covering (if it is 

specified) will be assigned for the new faces according to the parameters of the first operand. 

If there are several first operands and they are with different materials, then on the new faces 

the material of that operand which participated in formation of these faces will be saved; 

 Material of 2nd operand. For this value of the parameter, on the new faces of the resulting 

body the material will be transferred from those faces of the second operand which 

participated in their formation. This can be either the main material or the material of the 

covering (if it is specified), and even the material of the Material overlap operation. For 

example, as a result of execution of the Boolean operation “Subtract” between the first 

operand with the material steel and the second operand with the material black plastic, the 

material black plastic will be put on the created faces of the resulting body. If there are several 
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second operands and they are with different materials, on the new faces the material of that 

operand which participated in formation of these faces will be saved.  

 

                                      

 “Basic material of 1st operand”. The action of this parameter is 

analogous to the first parameter (“Material of first operand”), 

except the case when the material of the covering is specified. In 

this case the material of the covering is not used on the new 

faces. For example, if in a part with the main material “Steel” and 

with covering “Copper” we create a hole with the help of the 

Boolean operation, the hole inside will appear as steel in 

accordance with the main material. 
 

Blending new edges 
To turn on the mode of blending newly created edges resulting from the intersection of the target and 

tool bodies, turn on the parameter Blend New Edges. After that, a group of parameters becomes accessible 

for selecting the blend type (“Round”, “Chamfer”) and amount of blending (the parameter “Radius”). 

 

 

Specifics of Handling Boolean Operations 

Boolean operation representation in “3D Model” window 
Upon creation, a Boolean operation is put in the “Boolean” folder in the “3D model” window. An icon is 

displayed before each Boolean operation, denoting the operation type (  Addition,  Subtraction,  

Intersection).  

Booleans appear in a special way in the 3D model tree. When expanding the Body’s structure, the Boolean 

appears as an icon before the tool body. The diagram on the right hand side shows “Boolean_2”: an 

intersection of the target “Extrusion _0” and the tool “Extrusion_1”. 
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Upon right clicking  the icon before a tool operand in the model tree, the Boolean operation context 

menu appears. Alternatively, the Boolean context menu can be accessed as the context menu of the tool 

body in the model tree. 

  

Creating Boolean operation in the 3D model tree 
You can create a Boolean in the 3D model tree without explicitly calling the creation command. 

Select a body in the 3D model tree, and then Drag&Drop it to another body 

by dragging the mouse with the left button depressed. This would 

automatically create the Boolean “Addition”. By additionally holding down 

the <Ctrl>  key, the Boolean “Subtraction” will be created. If, instead of 

<Ctrl>, you hold the <Shift>  key, the Boolean “Intersection” will be created. 

The dragged body is the tool, and the body, to which the other is dragged, 

is the target. 
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Automatic Boolean creation combined with creating other operations 
Numerous operations of T-FLEX CAD allow automatic creation of a Boolean. The body being created in 

those operations is always the tool of the Boolean. The target is selected among all existing bodies of the 

3D model. 

 

 

It should be noted that when creating these operations the preview displays the result of the 

automatic Boolean only upon creation of the operation. When editing the operation the preview is 

not displayed. If the Boolean operation created automatically does not have a result, then only the 

operation being created will be seen on the preview.  

To create a Boolean operation, do the following: 
Turn on the Boolean creation mode by the automenu option: 
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 <Ctrl+B> Select original body for Boolean operation 

A Boolean is created when the icon is pushed. 

Select the type of the operation from the pull-down list under the above option: 

 <Ctrl+'+'> Addition 

 <Ctrl+'-'> Subtraction 

 <Ctrl+’*’> Intersection 

 <Ctrl+l> Smart mode 

Operating principles of the Smart mode: 

 If the body being created and the existed selected body have intersection of volumes - the 

type of Boolean operations: subtraction. 

 If the body being created lies entirely within the selected body - the type of Boolean 

operations: subtraction. 

 If the body being created touches and selected body touch each other - the type of Boolean 

operations: addition. 

 If conditions set out above are not met, or a selected body lies inside the created, or error 

occurred determining the type of penetration, then, Boolean type is not defined - the Boolean 

operation will not be created. 

Select the target body for the Boolean (optional in some cases), using the automenu option: 

 <Ctrl+T> Select Target Body for Boolean 

If only one body exists in the scene, it is selected automatically. The new body created by the 

operation becomes the tool body of the Boolean. 

 

Upon confirming operation creation, first the body is created by the operation, and then the specified type 

Boolean is performed. 

Deleting Boolean operation 
If a Boolean is at the top level of the tree, then, upon its deletion, the operand bodies of this Boolean 

operation will be left in the model. However, if a Boolean operation already has dependents, then the 

“Delete Element” dialog box will be launched upon its deletion. If you select the option “Exclude selected 

elements from Model Tree” in this dialog box, then another dialog will be launched, “Select operation to 

reassing child operation”, that offers selecting one of the Boolean's operands on which all dependents of 

the Boolean would be transferred.  
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The diagram below shows the structure of the Body_1. First, a Boolean “Subtraction” of “Circular Array_1” 

from the “Rotation_1” operation was done, and then the “Thread_1” was applied on the Boolean's face. 

Suppose, you attempt to delete the “Boolean_1” with the option of excluding the element from the model 

tree. Now, if you select the “Rotation_1” operation in the “Select operation to which all references will be 

re-assigned” dialog box, then the operation “Thread_1” will become a child of the “Rotation_1” operation. 

 

     

When one of the operands is deleted and the element excluded from the model tree, the Boolean 

itself will also be deleted. 

Boolean operations on 3D fragments 
Use of 3D fragments as operands is a unique feature of T-FLEX CAD. This significantly expands capabilities 

of creating parametric 3D models and assemblies. At the time of inserting a 3D fragment into an assembly, 

there is a provision of creating a Boolean with the assembly’s bodies. For details on capabilities of using a 

3D fragment as an operand, refer to the chapter “3D Assemblies Creation” and its topic “Preparing a T-
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FLEX CAD document for use as a 3D fragment”, and the chapter “Customizing drawing”, the topic “The tab 

‘3D’”. 

 

When you insert a 3D fragment with option for automatic Boolean operation creation, the preview displays 

not only the inserted fragment, but also the result of the Boolean operation. 

 

Applying thread by Boolean operation  
If a cosmetic thread is applied on a face of one of the operands, and this face is in contact with the faces 

of the other operand, then it is possible to automatically create a cosmetic thread on the face of the 

resulting body. For example, as shown on the diagram below, a body with a cosmetic thread on its face is 

subtracted from a base body. In this case, a cosmetic thread is automatically created on the newly created 

face of the resulting body. 

Note that the thread on the face of the tool operand must be “Inner” in order for the thread in the 

hole of the resulting body to be created “Inner” as well. 
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BLENDING EDGES 

The edge blending operation makes transition between two or more adjoining surfaces belonging to one 

solid body. Blending can be performed on both solid and sheet bodies.  

There are several types of blend: 

- chamfer (offset; length-angle); 

- rounding; 

- variable-radius rounding (circular, elliptical). 

As the result of the operation, the edge where two faces meet is replaced by an additional surface (the 

blend surface) providing the required transition from one face to the other. 

In the edge blending operation there is a special diagnostics mode available which allows a user to 

promptly estimate possibility and causes of error appearance. 

MAIN CONCEPTS .  OPERATION CAPABIL IT IES  

The object of the edge blending operation is the edges of the sheet or solid body. Additionally, some 

vertices may be selected on the involved edges in order to specify particulars of the intended shape. The 

set of the automenu options allows selection of various objects, besides the edges, such as loops, faces, 

vertices and  

operations. This helps selecting certain common combinations of 

edges. Thus, for instance, by selecting a vertex, we select all the 

edges meeting at that vertex. Selecting a loop by the definition 

means selection of the sequence of edges making this loop. 

Selecting a face results in selection of all its surrounding edges 

(single or multiple loops). Selecting a solid automatically makes 

selected all its edges appropriate for blending. 

It is very important to understand how the information is 

maintained about the original elements subjected to blending. 

These original elements selected for blending are remembered in 

the model history. Thus, in case a face was selected, a reference to 

this face is recorded in the model tree. In this case, the set of edges 

to blend is built anew at each regeneration. This way of selecting 
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brings the advantage of having a quite robust operation. If 

topology of the selected object changes (for example, the number 

of edges changes), the operation will be correctly regenerated with 

the new set of edges of the involved object. Otherwise, if a specific 

edge were selected that would later disappear, then the system 

would output an error. 

Each selected edge has a direction indicated by an arrow. Other 

blend-defining conditions depend on this direction. The arrow tail 

defines the edge start. According to an agreement, the surface on 

the right-hand side of the edge, as looked in the arrow direction, is 

conventionally called the first blend surface, and the one on the 

left-hand side – the second. 

 

Types of Blend 

Rounding 
Rounding is a most commonly used type of blending. A surface is created along the selected edge, 

providing a smooth transition from one face to the other. A condition holds that any normal cross section 

of this surface with respect to the edge is an arc of the specified radius.  

To easily realize how the rounding surface is generated, imagine a ball of the specified radius rolling along 

the selected edge, touching the faces adjacent to the edge. The trace of the ball represents the blend 

surface for the given edge. The surface may be defined in a single or multiple passes, particularly, if different 

edges are rounded with different radii. Complex spline surfaces may be constructed to join multiple edge 

blends. 

The operation may add or remove material, depending on whether the angle between the faces of the 

blending edge is convex or concave. 

    

The rolling ball must be touching at least one of the adjacent faces. Otherwise, rounding will fail and the 

system will output an error. 

Variable-radius rounding 
This type of rounding creates a surface of a variable radius. A list of critical points is defined. A certain value 

of the rounding radius can be set at each of these points. Each point position is defined as percentage of 

the total edge length. Initially, this list contains two points at 0% and 100% of the edge length.  
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If several edges are selected, then the point positions are defined as percentage of the total chain length 

for all consequently adjoined edges. The edge joints are not required to be smooth. A single direction is 

used for the whole chain of edges. It is defined by the direction of the first edge in the chain. 

When defining this type of blending along a closed loop of edges, always make sure that the start 

and end point radii are equal. 

The change in the rounding radius between points can be linear or smooth. In the linear case, the change 

in the radius is described with a broken line (the radius changes linearly from one point to another). In the 

smooth case – the change in the radius is specified by a curve having a horizontal tangent at the start and 

end points. 

   
 Linear change of radius Smooth change of radius 

A special mode is provided for processing certain cases, which allows specifying own variable rounding 

parameters for each individual edge. When processing a smooth chain of edges in this mode, make sure 

the radii are equal at the meeting ends of the adjacent edges.  

Variable-radius elliptical rounding 
This type of rounding allows creation of advanced blend surfaces. The sizes and shape of the blend surface 

is defined by the offsets from the first and the second faces (as conventionally denoted), and by the rho 

(convexity) value. 

                      

Depending on the rho value of the surface cross section, all resulting surfaces are divided in three groups: 

 The first group is with a rho value between 0 and 0.5, excluding the bounds. This results in 

elliptical shape of the surface cross section. 

 The second group is limited to the surfaces with a rho value of 0.5. This rho value corresponds 

to the parabolic shape of the blend surface cross section. 
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 The third group lies in the range from 0.5 to 1 (exclusive). In this case, the blend surface has 

hyperbolic shape. 

 

The shape of the surface can be defined at any point on the edge or on the chain of edges. The list is 

managed in the same way as in the case of the circular variable-radius rounding. The change in the 

rounding radius between points can be also linear or smooth as in the circular variable-radius rounding. 

The offsets from the faces define the boundaries of the blend surface. The algorithm of constructing the 

blend surface is common for elliptical rounding and offset chamfer. It is illustrated on the following 

diagrams: 

                  

 An offset surface is constructed at the distance Offset_1 from the second face.  

 Another offset surface is constructed at the distance Offset_2 from the first face.  

 The intersection line between the two offsets is projected on the original faces, thus defining 

the boundaries of the blend surface. 

In the special case of blending two flat orthogonal faces, this means the distance from the blended edge 

to the side boundary of the blend surface is equal to the value of the offset. 

Chamfer 
A chamfer can be constructed along a selected set of edges. A chamfer can be defined by two offsets from 

the adjacent faces or by the slant angle and the radius. The algorithm of constructing a chamfer by an 

offset and an angle is illustrated on the following diagrams: 
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The second offset is computed based on the angle, by multiplying the value of the first offset by the 

tangent of the angle. Further computations follow the algorithm of constructing a chamfer by two offsets.  

When creating a chamfer, the faces are not required to be flat and the edges straight. They can be of 

various geometrical shapes (see the diagrams below). 

     

Specifics of Blending Sets of Edges 

Automatic vertex blending 
A single operation can be used for rounding all edges meeting at one vertex. The edges can be of either 

the convex or the concave type. Simultaneous rounding of edges automatically involves rounding of the 

vertex where the edges meet. 

                

The form of the blending geometry at the vertex can be modified by selecting a different order in which 

the blending of edges is performed: By default (the order of the blending of edges is determined by the 

system itself), At first concave, At first convex (the order of the blending of convex edges is not 

determined), At first with minimum convexity, At first with maximum convexity. It is important to note 

that in order to control the form of the blending at the vertex, when creating the blend it is required to 

select, in addition to the edges, the vertex itself. 
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To avoid the vertex blending, do the edge blending by two blending operations, first blending any two 

edges meeting at a vertex, and then the third edge. The result in this case will look as shown here: 

                                       

Sometimes it is impossible to blend all edges at once, and the system outputs en error. In this case, try 

creating the intended blends by steps. 

The above implies that proper handling of the operation leads to successful blending of practically any 

edges of any model. 

It is recommended to use as few operations as possible when blending several edges of one solid. 

Prefer blending a set of edges by one operation, rather than by a number of operations one edge 

at a time. With this approach, the model regeneration is much faster, and the rounding algorithm 

most likely performs best. 

Blending two of three edges meeting at a vertex 
When blending a pair of edges of the same convexity, two blend surfaces are constructed – one per edge. 

The vertex is not blended in this case; rather, new edges are created at intersections of blend surfaces.  

However, when blending a pair of edges of opposite convexity, the vertex where the edges meet is 

automatically blended. 
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Processing of vertices joining edges of different convexity 
Consider the special case when three edges of different convexity meet at a vertex.  

Should it have been just two edges of the same convexity, one could use the option of also blending their 

common vertex. This would require selecting the vertex as well. The results would have looked like on the 

diagrams below: 

                 

Blending a group of edges with an offset from the vertex 
When rounding a group of edges meeting at a vertex, one can specify an offset from this vertex. The 

following diagrams demonstrate how this offsetting affects the shape of the resulting blend: 

                                         

One can see that the offset defines a zone of smooth transition from one blend surface into the other. The 

specified radius of rounding is not guaranteed in the transitional zone. Transitional zone can be formed by 

using transitional surfaces or without them. 

  

Blending with the use of transitional surfaces Blending without transitional surfaces 



Blending Edges 

421 

The “Offset” parameter can be specified at any edge start and end. However, offsetting can be done only 

for a set of three or more edges meeting at a vertex. Some of the meeting edges may be directed away 

and some towards the vertex. That said, make sure the offsets are defined on the vertex side for all edges. 

If an edge connects two vertices, each subject to offsetting, then the offsets are to be defined for both the 

edge start and end. 

In some cases, T-FLEX CAD system allows automatic synchronization of the “offset” parameters for the 

edges with opposite direction. This happens, for instance, when selecting a group of edges by picking a 

vertex. (Detailed description of the steps for defining offsets follows).  

Special dynamic draggers are provided for marking offsets on the edges while defining the operation 

parameters. Their presence and location help easily realize the offset parameters and modify, if necessary, 

by the mouse. 

Special Processing of Edge Blends 

Y-shape 
Suppose, two edges of opposite convexity are tangent at a vertex with three or more faces meeting there. 

In such a case, a special procedure is available for blending the vertex - the so-called Y-shape blending. In 

this way, surfaces come out lesser curved in the transitional zone around the vertex, then in the 

conventional way of blending. 

                  

The presented way of processing a vertex is only applicable for creating constant-radius or variable-

radius rounds. 

Topology deletion 
In the cases when the rounding surface completely embraces other topological entities, two ways are 

possible of processing the operation. The system can keep all topological entities, trimming or extending 

all necessary pieces of the surfaces involved. Alternatively, only the blend surface can be left, with all 

embraced objects deleted. 

                    

Overflow processing 
In real situations, an overflow may quite often occur between the rounding surface and some elements of 

the solid geometry that are not the adjacent faces of the rounded edge. In such cases, the system may use 

special options for processing various types of overflow. Four types of overflow are processed: 
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 Smooth overflow – when the rounding surface smoothly merges into another rounding belonging to 

the solid body being processed. The surface is deformed in the transition zone in order to provide 

tangency to both the original face and the surface being merged into. 

 Keep cliff edges – when the rounding surface “creeps” over an edge not subject to rounding. The 

rounding surface is constructed near the zone of contact with the edge by the rolling ball method. The 

surface is swept by a ball rolling on top of the “constraining” edge, touching one of the original faces. 

When processing an overflow that keeps cliff edges, you can additionally engage or disengage the 

algorithm for processing the cases when only a portion of the surface being blended (on the sides - 

cliff end) “creeps” on the cliff edge. Disengaging more complex algorithms that are not required would 

allow speeding up to some extent the model regeneration. 

 Notch – the rounding is constructed in such a way that the element affected by the overflow is ignored. 

The rounding surface is not deformed in this case, and the surfaces of the notch element are trimmed 

or extended to the rounding. 

 Inside tight – some portions of the model subjected to blending are represented by the surfaces with 

so small curvature radius that the blending ball of the specified radius cannot roll through while 

maintaining contact with the sidewalls. In such a case, the system can use special processing for 

providing blending with the specified radius in the curved zone: 

- Tight blends – in this case, the system will process the curved zones using the fastest 

algorithm. The algorithm assumes that the surfaces in these zones are created solely by 

blends of constant radius. If the type of the original surface is different and the new blend 

cannot be created, an error is output. 

- Tight faces – the system processes the curved zones, assuming, that the zone of small 

curvature radius fully extends through some face of a sidewall. 

- Tight partial – this is the most complex, but also versatile, algorithm. It allows processing 

the cases, when the zone of small curvature radius covers the portion of a sidewall of the 

blend. In this case, the blend surface is additionally subdivided in order to provide correct 

processing. 

With an option engaged, the system processes the respective type of overflow when occurs. If various 

types of overflow occur between the rounding being created and several other rounds then the system 

finds an optimum solution. The order of applying possible solutions in this case will be first the smooth 

overflow, then the overflow with cliff edges, and, finally, the notch. The type of processing of the curved 

zones depends on the selected algorithm. 

The user can control the system behavior when overflow occurs. The user usually gets involved when the 

results are different from expected. You can set the overflow options in any desired combination. 

The system attempts applying all three types of processing overflow in the presented order. If any 

of the overflow types is turned off, it is excluded from the list and is not applied. 

If all three options are turned off when rounding overflow occurs against the body faces and edges, then 

the system gives up rounding and outputs a message about a failing rounding.  
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The following set of examples demonstrates the operation capabilities when using various types of 

overflow processing: 

 Overflow processing example: switching the smooth overflow option on and off. The “Notch” option 

is not applicable in this example.  

 

 Overflow processing example: switching on/off the option “Keep cliff edges”. The “Smooth overflow” 

option is not applicable in this example.  

 

 Example of constructing a blend surface with the option “Keep cliff edges” turned on. This is the 

situation when the blend surface of the specified radius cannot be made tangent to both faces of the 

edge being rounded. If the option is turned off, the system will output a message about a failing 

rounding. 

             

 Examples of processing zones of small curvature radius on blend sidewalls based on various algorithms. 

In the areas where the blend radius is created then the curvature radius of a sidewall of the blend, the 

system makes a correction of the blend surface. 
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Unprocessed original                       “Tight blends” processing 

                        
Unprocessed original                                “Tight faces” processing 

                   

Unprocessed original                    “Tight partial” processing 

Explicit specification of intact edges 
When the blending is created, it is possible to specify the edges of the body which must remain intact 

upon blending. As a result, the blend surface will contain these edges.  

      

Specifying bounding geometry 
Specification of the bounding geometry allows us to bound the blending by the geometry of an 

arbitrary face, a plane or a list body. This functionality allows us to perform the blending in various 

complex configurations. 
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Specifying the order of creation of blending when blend surfaces overlap on 

several edges 
When the blend surfaces overlap on several edges of different convexity, it is possible to achieve the 

desired behavior of these surfaces by changing the order in which the blending will be performed. The 

order of the blending is determined by the selected priority of the edge processing: at first concave 

or at first convex. 

 

Specifying chamfer at the vertex 
For a vertex at which three edges meet it is possible to create a chamfer without 

specification of the blending on adjacent edges. This option works without 

specification of radii of the blending; it works simply by selection of the vertex 

with three edges. It constructs the triangle through the points that are shifted 

from the vertex at a given distance and cuts off the body with this triangle. This 

mode also works for the vertices at which more than three edges meet. In this 

case, if it is possible, a plane is also created, and if it is not possible – a smooth 

surface covering the domain. 

 



Three-dimensional modeling 

426 

RULES OF DEFINING OPERATION  

The command “3DE: Create Blend” is used for blending edges: 

Icon Ribbon 

 

3D Model → Create → Blend → Edge 

Keyboard Textual Menu 

<3DE> Operation > Blend >Edge  

The command can also be called from the context menu on the right-click  after selecting any of the 

elements appropriate for blending. These are faces, edges, loops, vertices and operations. 

 

The following sequence of actions is to be done for creating a blend operation: 

 Select elements to blend. 

 Define blend parameters. 

 Confirm the operation. 

How to Select Objects 

Upon launching the command, a general-purpose option is active in the automenu. It allows selecting any 

appropriate objects for the operation: 

 <E> Select Faces, Edges, Vertices 
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The drop-down list of the given option contains the filters for selection 

of various 3D objects: edges, faces, loops, 3D vertices and bodies. 

Selection of elements is done in the 3D window. Move the cursor over 

the desired object. The element to be selected will then get pre-

highlighted, and a tooltip will pop up next to the cursor identifying the 

element. Click  to select. 
 

Let us consider, in more detail, the use of each selection filter from the list of the  option: 

Select Edge . This option sets the system for edge selection. It can be used together with the smooth 

chain selection mode, activated by the option: 

 <S> Smooth edge chain selection mode 
 

A smooth chain is a set of edges making an open or closed continuous smooth curve (a C2 curve). 

When using this mode all edges are selected automatically that can make a smooth chain together with 

the edge being selected. 

Select Vertex . This option sets the system for selection of vertices. When selecting a vertex, all edges 

meeting at this vertex are selected. The zero offset from the selected vertex is automatically defined for 

the thus selected group of edges. If the directions of the meeting edges disagree, the Start and End 

parameters are synchronized so that for all edges the offsets are defined in the selected vertex. 

This filter can be used in the mode of selection of vertices without automatic selection of edges. This is 

necessary for creating some special cases of blend, such as Y-shape blend and processing of vertices 

joining the edges of opposite convexity. Here is the option turning this mode on and off:  

 <Z> Allow vertex selection without edge selection 

In this way, selecting a vertex does not cause selection of edges. The selected vertex is added to the list of 

elements for blending. 

Select Loop (a closed contour) . The system prompts us to select the closed contour of edges (loop). 

The user is not required to define start and end of the edges belonging to a closed loop. In this case, the 

blending parameters are set simultaneously for all edges. Individual parameters can’t be defined for any 

single edge in the loop. By the convention, the first face of the blend is considered the face surrounded by 

the loop. This will be also the first face for each edge in the loop. Remembering this convention is important 

when creating chamfers. 

Select Face . The system prompts us to select the faces. As in the previous case, same parameters are 

used for all edges of the selected face. The selected face is also considered the first face of the blend for 

each edge. 

Select Solid . The system prompts us to select the bodies (operations). Upon selecting an operation, 

all edges of the solid appropriate for blending are added to the selected list. This is a very different way 
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from the two previous options. It allows defining individual settings for different edges of one selected 

solid. 

The objects selected for blending are added as a list to the special fields of the dialog of the operation's 

properties. Edges, faces and loops are added to the list on the “Edges” tab. Vertices selected with the help 

of the  option (without selection of edges) are added to the list on the “Vertices” tab. 

The user can cancel the selection of objects for blending with the help of the [Delete] button in the 

command's properties window or by repeated selection of elements in the 3D window. 

    

Defining Operation Parameters. Using Draggers 

The operation parameters can be defined at any step of creating the operation. The operation parameters 

can be defined in the property window, which supports the transparent input mode, or the parameters 

dialog box, that requires confirmation before the changes take effect. The property window works together 

with helper graphic widgets called “draggers”.  

The property window of the “Blend Edge” operation consists of three sections: General Parameters, 

Overflow Processing, Options. Some of the controls in the parameter window may get hidden or replaced 

by others. This depends on the type of blending or the type of the element being processed (edge or 

vertex). 

We recommend to begin defining parameters after selecting the elements for blending. As was mentioned 

above, the selected edges, faces, and loops are displayed in the list on the “Edges” tab. The vertices selected 

with the help of the  option (without selection of edges) are added to the list on the “Vertices” tab. 

Blending parameters can be defined for a particular object by selecting it from these lists. Originally, blend 

properties are set same for all elements. This is signaled by the flag “Common Properties”. Individual 

blending parameters can be defined for each element in the list after clearing this flag. 

The blend type can be selected from the pull-down list. Depending on the blend type, the appropriate 

controls appear for defining parameters attributed to this type.  

 

Using draggers 
Draggers are helper graphic widgets for dynamically defining main numerical parameters of the blend in 

a transparent fashion. Draggers appear automatically once the objects for blending have been selected. 
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Their quantity, look and size depend on the type of rounding, the kind of selected objects and the type 

and values of the parameters modified by the draggers.  

The draggers are displayed in various colors. By default, the active dragger (the one being manipulated by 

the mouse) is drawn red, all the rest (inactive) are yellow. 

Using draggers for blending of many edges at once may cause delays in system responses, 

especially on low-performance computers. To speed up the system in such cases, the draggers can 

be turned off. This is controlled by the respective checkbox item in the “Options” section of the 

property window. 

The following paragraphs describe all kinds of manipulators for each blend type. 

 

Defining constant-radius rounding 
 Select objects for rounding. It is convenient to do this first. However, if necessary, objects can be 

selected at any step of defining the operation. 

 Set the type of blend to Rounding in the pull-down list. 

 Set the radius of the rounding. Initially, it can be roughly set by the draggers. 

The draggers for marking and modifying the rounding radius are displayed at each selected edge: 

one per a straight edge, two per a curved edge, and four on each closed edge. 

   

Initially a single value of the radius is set for all edges processed by one operation. Moving one 

dragger results in all the rest instantly adjusting by the same amount. To define individual 

properties of some edge, select it in the list and unset the flag “Common Properties”. Then, an 

individual value of the radius can be entered in the “Radius” input box. The radius-controlling 

draggers on this edge will become independent from the rest. 

 Confirm the operation creation with the button . 

 

Defining variable-radius circular rounding 
 Select edges for rounding. 
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 Select the type “Variable (circular)” in the pull-down menu of the property window. The 

necessary controls will appear for defining the rest of parameters. 

 Next, the set of intermediate points needs to be defined, and radii specified in each point. 

Important: initially, the system tries to compose one chain (not necessarily 

smooth) of all selected edges. If this is impossible, then several chains will be 

composed. Within each edge chain, the set of points is distributed along the 

full length of the chain.  

The system can automatically compose the chains from the edges marked 

with the flag “Common Properties”. If the flag “Common Properties” is off 

for some edge then the whole set of points will be distributed along this edge 

only, and stay strictly specific to this edge. 

If several edges are processed simultaneously that make a smooth 

chain, while the “Common Properties” flag is off, make sure the radii 

on each side of the edge joints are equal. 

The list of points defining the radii is input in the  pane. Initially two points 

exist in the list – “Start” and “End”, at 0% and 100% of the edge (chain) length 

respectively. These points are always present, and their positions are not 

modifiable. 

 

To add a new intermediate point, press the [Add] button. A new dragger will appear on the edge 

controlling the new point position and the blending radius at this point. By moving the dragger handles, 

one can vary both parameters of the point being processed. 

   

The current position of the intermediate point is displayed in the Position (%): input box. An exact value 

can also be entered here from the keyboard.  

To adjust the radius value at an intermediate point, first select this point from the Position list. Then, the 

radius value can be entered in the Radius: field. 

Position of the points may be specified with the help of a graph. Use  button in the properties dialog 

for this purpose. This button will open the graph editing window. The range of definition by X is 0-100 
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corresponding to the percentage from the length. The value area is limited with positive numbers only. 

See more details on operations with graphs in chapter “Graphs”. 

 

 Specify the type of the radius change – Linear, Smooth, or a special option – Auto; 

The type of the radius change is selected from the drop down list of the parameter Interpolation. 

The option Auto is set by default. In this case: 

 

a. if for the current rounding only start and end points are specified, the radius change will 

be calculated by the linear algorithm; 

b. otherwise (when internal points are specified) a smooth algorithm of the radius change  

is applied. 

 Confirm the operation creation by pressing the button . 

Defining variable-radius elliptical rounding 
 Select edges for rounding. 

 

 Select the type “Variable (ellipse)” in the pull-down menu of the property window. The necessary 

controls will appear for defining the rest of parameters. 

 

 Next, the set of intermediate points needs to be defined, along with the offsets and rho 

(convexity) values at each point. 

 

Elliptical rounding is based on special points, just like the previous, variable-radius, rounding. The 

point defining techniques are similar to those described for the variable-radius circular rounding 

(excluding possibility of setting positions of intermediate points with a graph). The difference of this 

blend type is in the ways of defining the shape of rounding. 

In this way of blending, two offsets are defined at each point defining boundaries of the blend at the given 

cross section, and the rho (convexity) value of the cross section curve.  
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In general, without use of draggers, the following procedure is recommended for defining the blend 

surface parameters at the points:  

 Select the desired edge in the list of selected elements. 

 Enter the point list pane. 

 Add required number of intermediate points; define their position on the edge or chain of edges. 

 Go through the points of each edge, defining the offsets and rho (convexity) values. 

 Specify the type of the radius change – Linear, Smooth, Auto (in the same way as for creating 

variable-radius circular rounding); 

 Confirm the operation creation by pressing the button . 

Defining chamfer 
 Select edges for the chamfer. 

 Select the blend type “Chamfer (Offsets)” or “Chamfer (Length+Angle)”. 

 Define chamfer parameters. The set of parameters is different for various chamfer types. The 

easiest way is to roughly set up values using the chamfer dragger. Exact values can be entered in 

the property window.  
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When defining the offset chamfer, one dragger handle defines the first offset, the other second. 

The edge direction determines which side of the edge is the first, and which is the second. The 

edge direction can be flipped by toggling the “Reverse” flag. This flag works individually on each 

edge and does not depend on the “Common Properties” setting. 

When defining chamfer by angle, the second dragger handle will be driving the “Angle” 

parameter. A special flag can be set in the property window against the “Angle” item that will 

block angle modification by the second dragger handle. In this way, moving either dragger 

handle will drive the first offset while keeping the angle fixed. 

 Confirm the operation by . 

Manipulating the special blend options 
Topology deletion. A special flag “Delete elements” in 

the property window controls topology deletion. This 

functionality is available for all types of blend. 

Overflow Processing. Processing overflows is defined by 

the respective flags at a separate section of the window. 

All these flags are turned on by default. With such 

settings, the system attempts to apply all possible 

overflow processing types in the order the options 

appear. 

An algorithm of processing zones with small curvature 

radius is selected from the combo box.  
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Propagating blend on tangent edges. The smooth chain selection functionality is available for all types of 

rounding. The edges smoothly adjoining to the selected one will be also blended. Blend propagates in the 

order of the elements on the “List” pane. This functionality searches for a smooth continuation of the 

currently blended edge. A smooth chain may exist originally or form as new edges are created on the blend 

boundary. In the case of successfully defining a smooth chain the system attempts to propagate the blend 

along the whole chain. 

The option  described above has a similar purpose. However, when selecting an edge with this option, 

all elements of the identified chain are placed on the “List” pane. When using the “Propagate” flag, the 

list may not contain all edges of the blended chain, rather, could be just one edge. This is important in view 

of possible topology changes of the model when the smooth chain contents may change. In this way, one 

can select just a single “most stable” edge of the whole chain to be blended.  

Defining Y-Shape blend 
 Select edges subject to blend. 

 Select the vertex intended for the Y-Shape blending. To select a vertex without selecting edges 

use the automenu option: 

 <Z> Allow vertex selection without edge selection 

 In the list on the Vertices tab highlight the vertex and set the Y-Shape flag for it. 

If Y-Shape blend can’t be constructed in the given vertex, the system will attempt conventional 

blending, ignoring the Y-Shape flag. 

 Specify the blending radius for the edges. This can be done by using the respective draggers or 

by entering in the “Radius” input box that becomes accessible after highlighting the edge in the 

list of selected edges on the “Edges” tab. 

         

 Confirm the operation by . 

Defining chamfer at the vertex 
To create a chamfer at the vertex, it is the most convenient to follow the algorithm described below: 
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 Select a vertex for a chamfer. All edges that adjacent to the vertex will be selected on the Edges 

tab. 

 You should specify offset for the edges. 

The Start parameter will be active for two edges, and End will be active for one edge. You should 

specify the value for the offset in the field near the parameter. 

 

Manipulators that display offset values will be displayed in the scene near the selected vertex. 
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 On the Vertex tab you should select a vertex for the chamfer. You should activate Chamfer flag 

for it. 

      

 Confirm creation of the operation by . 

 

Defining a blend with spherical vertices and offsets form vertices 
The vertex offset parameters can be defined for all types of edge blends, except chamfer. The following 

steps are recommended if planning to make a blend with vertex offsetting: 
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 Selection of objects for blending (the edges) is to be done by vertex 

selection where the vertex offsets are expected. Make sure to turn off 

the option  to allow edge selection when selecting vertices.  

The zero offsets from the selected vertex are automatically pre-set 

when selecting edges in this way. This is indicated by the special 

draggers displayed near the vertex.  

The list of selected edges on the Edges tab lists only the edges 

adjacent to the vertex. The vertex itself is not in the list. 

 Specify the offset values. This can be conveniently done using the 

offset-driving draggers.  

 

Initially, the flag Common Properties is set for all edges. This allows entering equal offsets for all 

edges meeting at the vertex. Modifying one offset causes all the rest edges assume the same 

value. This is seen by the appearance of all offset-driving draggers.  

To define different values of the offsets, turn off the flag Common Properties. This does not have 

to be done for all edges at once. Individual properties can be set only for some particular edges 

by turning off only their flag Common Properties. For the rest, the common properties will still 

be used. 

   

The offset values are displayed in the property window under the items Start or End - depending 

on where on the edge is the offset. Exact values can be typed in these input boxes as well. Before 

each item there is a checkbox activating the Offset parameter at the start or at the end of the 

edge. As we were selecting the edges in the described way (by selecting the vertex), the system 

was automatically flagging the appropriate ends for the edges meeting at the vertex. This was 

done according to each edge orientation in the group. Some edges have the offset at start, others 

at the end, so that all of them have the offset from the vertex where they meet. 

For ultimate control, one can manually define the offset parameters using the described flags. 

Meanwhile, draggers can be used for previewing offset characteristics. 
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 Define the radius values for the edges to blend. Any blend type is supported, except for chamfer. 

The blend parameters are assigned to edges in one of the described above ways, depending on 

the blend type. 

 If it is required to construct the blending without transitional surfaces, it is necessary to 

additionally select the vertex itself. This can be done by enabling the  option. The selected 

vertex will be added to the list on the “Vertices” tab. For the selected vertex the Use Collar faces 

flag will become. 

 

                 

 Confirm the operation by . 

Processing vertices joining the edges of different convexity 

This special processing is only applicable for constant-radius rounding.  

Suppose, three edges meet at a vertex, two of the same convexity, and the third one of the opposite. To 

blend the two edges of the same convexity with vertex processing, additionally select this joint vertex. To 

select the vertex alone, use the following special option, 

 <Z> Allow vertex selection without edge selection 

With the option active, select the vertex. The vertex will be added to the list on the Vertices tab of the 

property window. The rest of parameters are defined in the way described for the Rounding blend type. 

Defining the order of blending of edges upon blending of vertices 
 To enforce automatic blending of a vertex, in the general case, it is necessary to select all edges meeting 

at the given vertex. This is sufficient for creation of blending. However, if the option for selection of the 

order of blending of edges is expected to be used, it is required to additionally select the vertex itself with 

the help of the  option. For the selected vertex, the Edge processing order parameter will become 

accessible. 

An approximate algorithm for creation of the blending in this case is the following: 
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 Select objects (edges) for blending. It is possible to select the 

edges explicitly or indicate the vertex at which they meet, when the 

 option is disabled. 

 Specify the value of the radius for the edges to be blended. 

Specification of parameters of blending for edges is carried out 

according to the general rules described above for the type of 

blending being employed. 

 If the form of the blending geometry at the vertex is expected to 

be controlled, it is necessary to additionally select the vertex itself. 

This can be done by enabling the  option. The selected vertex 

is added to the list on the “Vertices”.  

 For the selected vertex the Edge processing order parameter will 

become accessible. From the drop-down list it is possible to select 

one of the following options: By default, At first convex, At first 

concave, At first with minimum convexity, At first with maximum 

convexity.  

 Confirm creation of the operation by . 

 

Defining intact edges  
To specify intact edges, use the option:  

 <L> Select intact edges 

Selected edges are added to the list on the Boundaries tab.  

 

Defining bounding geometry 
To specify bounding geometry, use the option:  

 <T> 
Select element defining the surface or the cut-off 

plane 
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The drop-down list of this option contains a combination of filters for selection of various 3D objects that 

are capable to define the cut-off surface. The selected object is added to the list on the Cutoff tab. 

         

Additional flag called Reverse direction allows us to change the location of the blending being created 

with respect to the specified bounding plane/surface. 

Defining the order of creation of blending when the blend surfaces overlap on 

several edges 
The order in which the overlapping blend surfaces are created can be controlled with the help of the At 

first concave  flag on the “Edges” tab of the command's properties window. 

 

Diagnostics Mode 

The special diagnostics mode in the edge blending operation allows a user to determine the possibility 

and causes of the error appearance while creating the blend. 



Blending Edges 

441 

The absence of errors in the diagnostics mode is the necessary but not the sufficient condition  for 

successful blend creation. The absence of errors in the diagnostics mode does not guarantee the 

successful completion of the operation creation. 

The following option of the automenu is used for entry into the diagnostics mode: 

 <D> Diagnostics 

This option is available for selection right after selecting the objects for blending. 

In the preview mode and in the mode of viewing the changes made by the operation the option for 

starting the diagnostics mode is also available if, in these modes, the problems arise upon the model 

regeneration. 

When entering into the diagnostics mode, the system automatically analyzes the specified objects and the 

blend parameters. The objects, the blending of which may cause problems, are marked in the list with a 

exclamation point – . 

In the diagnostics mode in the system's properties window all fields except the list of the blend 

objects are locked. 

When selecting a marked object (edges, vertices, faces) from 

the list, the edges identified with the selected object are 

highlighted on the model in the 3D window. Also, a marker 

with the text describing the error appears. In some cases, the 

geometric element of the 3D model creating the problem is 

marked additionally. A user can select several objects at once 

to evaluate several problems simultaneously. To do it, make 

the selection with the help of <Shift>+ , <Ctrl>+ . Upon the 

entry into the diagnostics mode, all problematic objects are 

selected. 

 

The blendable edges are shown with green 

color, whereas the geometric element of 

the model leading to a problem is shown 

with yellow color 

If in the diagnostics mode several faulty objects are selected from the list, then selecting the marker with 

the help of  without moving it at a significant distance will cancel the selection of the remaining objects. 

When exiting the diagnostics mode, the marking of the faulty elements with the special icons in the list is 

retained for convenient correction of the discovered problems.
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BLENDING FACES 

The face blending operation lets create a blend surface between one set of smoothly meeting faces to 

another. The sets of the blended faces are not required to have common edges (intersect). Blending can 

be done over solid bodies, as well as sheet bodies. The command has numerous options for controlling 

the shape of the blend surface, defining trimming conditions, bounds, etc. Do not consider this operation 

as an alternative to the edge blending operation. These two approaches have their advantages and 

limitations, well complementing each other. 

MAIN CONCEPTS .  OPERATION CAPABIL IT IES  

The two sets of faces for blending are conventionally called the right and the left wall. In most general case, 
these can be arbitrarily positioned in space and have arbitrary geometry of the surface. The system 
constructs the blend surface between the right and the left wall in several steps.  

 
Step 1 Step 2 Step 3 

First, the set of planes is computed for holding the blend cross sections. The position of each plane depends 

on the existence and the shape of the auxiliary direction guide, as well as on the computational algorithm 

of a particular blend type. One can specify various blending effects by manipulating the orientation of the 

cross section planes.  

Next, two points are defined on each plane that will be the bounds of the future blend surface. One point 

belongs to the right wall, the other – to the left. These will be referred to as the points of contact of the 

blend surface. The sets of the points of contact on the right and left walls make the two lines of contact. 

The position of the points in each cross section depends on the shape and mutual situation of the walls, 

as well as on the computational algorithm of the particular blending mode.  

Finally, the system computes each cross section of the blend surface spanning the two points of computed 

in the previous step. The shape of the blend cross section depends on the positions of the points of contact 

and on the selected geometrical algorithm. 

The final result may also be affected by a number of additional functions and boundary conditions. 
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Direction Guide 

The direction guide defines positions of the blend cross-section planes. 3D paths can be used as guides. 

The direction guide is used for constructing most types of blends. Often, when all parameters appear to 

be defined yet the confirmation button is inaccessible, most probably the direction guide is needed.  

If the guide is too short for constructing the whole blend surface, the system extends the guide by straight 

segments tangent to the 3D path at the ends. If the guide is longer than required, the system will attempt 

automatically define the necessary portion if the 3D path. 

Sometimes, the operation can be created without use of a guide, as in the case of simple rolling ball 

blending. 

Blend Types 

There are two types of blends. Each type involves its own algorithm of constructing cross section planes 

for computing the blend surface. 

Rolling ball blend 
In this type of blending, the cross section planes are made orthogonal to the right and left walls. This blend 

type does not require a guide in the “Constant radius” and “Constant width” modes.  

In the “Constant radius” mode, a notional ball of the specified radius defines the points of contact as it 

touches the right and left walls. This ball “rolls” all the way along the right and left wall and leaves two lines 

of contact. The cross section planes pass through the points of contact and the center of this notional ball 

at a given instant. 

Rolling ball blend is the only type supporting the “Constant width” mode. In this case, the system 

automatically positions the cross section planes for best fit to the requirements of the specified blend 

mode. The guide is not required in this case either. 

The “Variable radius” mode always requires using a guide. A current point on the guide is used to define 

the nearest points on the blended surfaces. Normals to the right and left wall surfaces are constructed at 

these points. The cross section plane passes through the current point on the guide. The plane normal is 

computed as a cross product of the two surface normals from the above. In the special case of flat wall 

surfaces, true to say that the cross section plane passes through the current point on the guide and is 

oriented orthogonal to either wall. 

Disc blend 
A plane is constructed orthogonal to the guide through each point on the guide. A current blend surface 

section is computed in each such plane. 
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Rolling ball blend Disc blend 

Isoparametric blend 
This is an advanced type of blend. Isoparametric blend is a special type provided for turbine design. It is 

used to make a blend between a turbine blade and a base.  The isoparametric blend is best for this kind of 

parts. 

The isoparametric blending is similar to the disc type. However, the blend cross-section planes are oriented 

along the isoparameter lines of the blade surface in this case. Because of this, the blade surface ought to 

be necessarily the first set of faces (the left wall). 

The direction guide must lie on the left wall (the one that defines the isolines). A dependency is established 

between the points on the guide and the blade surface. Then the specified cross-section blend surface is 

constructed tangent to the current isoline. 

     
Rolling ball blend Isoparametric blend 

The diagram on the left-hand side shows a rolling-ball blend with self-intersection zones. The right-hand 

side diagram demonstrates an isoparametric blend with no flaws.  

Blend Modes 

Blend modes define the ways of computing the blend surface bounds in the current cross section. Only 

the bounding points (points of contact) are computed in the cross sections of the blend surface. What will 

be constructed in between the bounding points depends on the chosen shape of the blend surface. 
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Constant radius 
In this mode, the blend surface is constructed of the constant shape across the extent of the blend. The 

term “radius” in the mode name is just a convention. In fact, variations of this type include, besides the 

conic-shape roundings, chamfers and surfaces of smooth curvature (see below “Shapes of blend surfaces”). 

This depends on the specified blending shape. With the conic shape of the cross section selected, a surface 

is constructed with each cross section being a circular arc of a specified radius. 

Variable radius 
This blending mode supports blend surfaces with the shape parameters varying across the extent of the 

blend. All cross section parameters are controlled via special auxiliary points distributed along the blend 

surface. The points of contact are computed in the variable-radius mode based on two ranges defined for 

each such auxiliary point. The same approach is used for computing the points of contact by the ranges, 

as in the command “Blend Edge”. The same chapter (see the topic “Variable-radius elliptical rounding”) 

describes and illustrates the approach in details. The following is different in variable-radius blending by 

the “Blend Face-Face” operation from the variable-radius elliptical rounding by “Blend Edge”. First, it is the 

way of constructing the cross section planes. Second, it is availability of other cross section shapes (besides 

the conic one). 

Constant width 
In this blending mode, the blend cross sections are constructed based on the constant chordal width 

condition. These are the chords connecting the points of contact in cross sections. This type of blending is 

especially desirable when the angle between the blended faces varies across the extent of the blend. In 

this case, one may want to specify approximate amount of cross section additional material to be 

maintained along the blend. 

    

“Constant width” mode only works with “rolling ball” type blend. 
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[In this blending mode, the parameters of the shape are the chordal width and the ratio of the ranges for 

the bounding points of the blend surface. A ratio of ranges other than 1 makes a blend with a constant 

chordal width and asymmetrical cross section. 

In constant width mode, the system automatically determines the shape of a conic cross section. 

Shapes of Blend Surfaces 

Three different shapes of blend surfaces are supported. 

Conic 
Conic is one of the shapes found in sections of a cone by a plane. These are a circle, an ellipse, a parabola 

and a hyperbola. In the constant radius mode, if “conic” shape is selected then the blend cross sections are 

arcs of the specified radius. In the variable-radius mode, the shape of a cross section is dependent on the 

“skew” parameter representing the rho value of a conic. Different values of this parameter yield an ellipse, 

a parabola and a hyperbola. 
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Chamfer 
The chamfer-type blend cross section is defined as follows. The points of contact, computed in each cross 

section, are connected by a straight line. Chamfer is supported for all blend types and blending modes. 

 
 

Continuous curvature shape 
This way of blending provides continuity of the surface curvature where the blend surface meets the walls. 

In other words, the blend surface has the same curvature at the points of contact as the respective wall. 

In “Constant radius” and “Constant width” blending modes the shape of the surface depends on a single 

“Softness” parameter controlling the smoothness of the transition from one wall to the other. 

     

The value of the softness greater than zero is allowed, with the maximum unlimited. With the softness 

values approaching 0, the blend cross section becomes closer to a chamfer. However, if a true chamfer is 

required then the “Chamfer” setting for the blend shape is recommended instead. 

The Variable radius mode provides two parameters for controlling the blends with continuous-curvature 

cross sections – “Offset” and “Depth”.  
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These two parameters together define the deepest point on the current blend cross section – the “Depth 

point”. The “Offset” defines the position of the “depth point” between the two contact points. The 

parameter varies from 0 to 1, exclusive. The depth point approaches the left wall, as the offset approaches 

zero and the right wall with the offset approaching one. The “Depth” defines the position of the “depth 

point” between the chord connecting the two points of contact, and the intersection of the wall tangents. 

The parameter varies between 0 and 1, exclusive. With values near 0, the “depth point” approaches the 

chord between the points of contact, while with values approaching 1 – the intersection of the right and 

left wall tangencies. 

Special Capabilities  

Notch 
Sometimes, the walls to be blended may include topology insertions (Notches) that cross the line of contact 

of the blend surface. A special option “Notch” helps identify such insertions and let blending extend in the 

affected area trimming the blend surface with the faces adjacent to the wall. Without this option, the 

blending would stop before the affected area, where the line of contact is crossed. 
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Tangent propagation 
This blend option allows extending the blend surface on the adjacent faces smoothly connected to the 

selected walls. This simplifies the operation definition by letting select just one face per a wall. The system 

will attempt propagating the blend surface on all adjacent faces as far as possible. 

     

Propagate option can’t be used for disc and isoparametric blend types. 

Propagate option is applicable when defining boundary conditions (see details below). This allows 

specifying just one edge for defining boundary conditions if all bounding edges connect in a smooth chain. 

 

Trimming with planes 
Flat faces and workplanes can be used for limiting the blended area. One limit plane divides the blend 

surface into two parts leaving just one part in the scene. Total of two limit planes can be defined. The two 

planes will surround from the two sides the central portion of the. 
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It is important to keep in mind that by dividing the blend surface the limit plane is not trimming it. The 

blend surface is divided along a cross section plane at the point of intersection between the limit plane 

and the blend spine.  

Blend end trimming 
When creating a face-face blend, there is a choice of trimming options for the end boundaries of the blend 

surface. The geometry of the walls themselves is not disturbed by trimming the blend surface. Total of four 

trimming options are available: 

No trimming. When trimming is off, the blend surface is extended beyond the ends of either wall.  

Short trimming. The blend surface is trimmed by the end boundaries of the shorter wall.  

Long trimming. The blend surface is trimmed by the end boundaries of the longer wall.  

Faces to wall trimming. The blend surface is trimmed by the end boundaries of both walls. Meanwhile, the 

side edge of the blend surface is constructed such as to provide tangency with both side edges of the 

trimming walls. 

First three options can be used for blending sheet bodies only. 
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Wall trimming 
In addition to blend surface trimming, the walls can be trimmed as well along the line of contact. 

 

   

Selecting the resulting topology 
The face-face blend operation can be stored in the model structure in several topological variations. The 

choice of a topological solution is combined with the wall-trimming interface (the previous topic). Total of 

four solutions are available: 

“Separate body” means neither wall will be trimmed and the blend surface will stay as a standalone sheet 

body. The objects selected for the walls to blend will remain in the model structure in the original state. 

The blend operation will be represented by a separate sheet body – the blend surface. 

“Trimmed on both walls” trims both walls along the line of contact without attaching the blend to any wall. 

This solution has a practical meaning only for sheet bodies.  

The model structure will reflect the face-face blend operation alone at the top level. The operations whose 

faces were selected as walls will be written in the model history one level deeper. Meanwhile, the blend 

operation will be represented by three sheet bodies. This means that if, for instance, the operation “3SD: 

Divide Solid” is applied to the blend then three separate sheet bodies will be created, the two trimmed 

walls and one blend surface. 
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“Attach to the left wall” trims both walls and attaches the blend surface to the walls. If blending was done 

between two different sheet bodies then these bodies are united into one by the blend. The operation 

used as the left wall will further be used as the reference in the model structure. 

“Create body” trims both walls, adds the blend to the walls and creates a solid body if possible. This solution 

can only be used together with the “Faces to wall” trimming option. This option is similar to the previous. 

The specific of this option is the system attempting to create a solid body. This is done if a check is satisfied 

for the resulting geometry to form a closed volume. 

Solution using an adjusting point 
In some cases, several blend surfaces can be constructed for the same set of walls. One can accept them 

all. However, a particular solution can be specified. The system accepts the solution nearest to a selected 

node. 

  

Processing curved zones (Inside tight) 
The algorithm's for processing curved zones allow creating blend's in the areas where the value of the 

curvature radius of the sidewalls is less than the blend radius. This option is available only for rolling ball 

blending by a conical section of a constant radius. This functionality is described in more details in the 

chapter “Edge blend”. 

Boundary Conditions 

Tangency to faces 
In the cases when a blend surface overflows beyond the blended faces (of the right or left wall) then the 

system can adjust the blend surface to keep edges overflown by the blend surface. This results in shifting 

the line of contact of the blend surface in the area of the edge overflow to actually make it coincide with 

the edge. The blend surface adjustment is done while maintaining the tangency condition at the wall 

surface in the points of contact.  

If the blend surface can’t be fit within the extent of the walls, two types of constraints can be specified - 

“One-face tangent” or “Two-face tangent”. 

The boundary condition is defined by selecting an edge or a set of edges belonging to one or another 

wall, called “holdline”.  
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If one face tangency is elected then the opposing line of contact of the blend surface is not disturbed. It 

will satisfy the defining rule of the shape of the surface (as, for instance, the radius). If two-face tangency 

is elected then the opposing line is distorted symmetrically.  

 

Inverted tangency to faces  
The boundary condition is defined by an edge or a set of edges belonging to one of the walls (the holdline). 

With too small radius values, when the blend surface can’t be constructed, the system shifts the line of 

contact to the holdline. The blend surface is tangent to the faces of the wall along the line of contact. If 

the back tangency to one face is elected, then the opposing line of contact of the blend is not disturbed. 

It will satisfy the defining rule of the surface shape (as, for instance, the radius). If inverted tangency to two 

walls is elected then the opposing boundary is distorted symmetrically. Thus, the blend surface is no longer 

defined by the radius. Rather, it is deformed by the boundary conditions wherever imposed. 

 

Cliffedge 
This is the “sharp edge” overflow, when tangency is not maintained at the bounding edge.  

The edge overflown by the blend surface is left unchanged. The blend surface is constructed without 

distortions in such a way that the cross section spans between the wall and the line of contact of one side 

and the cliffedge on the other side, without altering the guiding rule of the cross section shape. 

To understand this, consider a simple example of a spherical blend with a constant radius. Imagine a ball 

of the given radius rolling on one wall, keeping contact with the sharp edge on the other wall.  
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With this constraint, tangency is not provided for the blend surface along the cliffedge, however, the shape 

of the sections is not distorted and is constructed by the specified rule across the blend surface. 

OPERATION DEFINING STEPS  

The operation creating command can be called via one of the following ways: 

Icon Ribbon 

 

3D Model → Create → Face-Face 

Keyboard Textual Menu 

<3DF> Operation > Blend > Face-Face  

The property window and the automenu are used for handling the command and defining necessary 

components. These work simultaneously and enhance each other. The state of the automenu depends on 

the operation defining stage and on the purpose and type of the objects being selected. The object 

selection modes can be manipulated via either the automenu or the property window. 

To create the operation, follow the following steps: 

 Select first set of faces (the left wall) 

 Select second set of faces (the right wall) 

 Specify blend type (if necessary) 

 Select the spine (if necessary, depending on the blend type) 

 Specify blending mode (if necessary) 

 Specify the shape of the blend cross section (if necessary) 

 Specify geometrical parameters of the blend cross section  

 Specify boundary conditions and overflow processing (optional) 

 Confirm operation creation 

Using Draggers and Decorators 

As the face-face blend operation is being defined, the parameters can be specified and various objects 

selected in the 3D window with the help of auxiliary elements. These elements help quickly review and 
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modify the configuration of the operation being created. Their quantity, shape and size depend on the 

defined properties of the operation, on the purpose of the selected objects and on the type and values of 

the parameters controlled thereby. The elements that control parameters dynamically are called 

“Draggers”. The elements that merely display some or other operation properties are called “Decorators”. 

Draggers are displayed in various colors. By default, the active dragger (the one driven by the mouse at 

the moment) is drawn red, all the rest - yellow. Decorators are drawn blue by default. 

Draggers are used for quick reviewing of the result and correcting it, therefore, the shape follows the actual 

blend surface with limited accuracy. Dragger does not make an account of all details of the cross section 

in the case of the surfaces with continuous curvature and is not responding to such settings as “Convexity”, 

“Softness”, etc. 

Using draggers with numerous active objects on a low-performance computer may cause delays in 

the system response. To speed up workflow in this situation, the draggers may be turned off. The 

off switch for the draggers is located in the Options section of the property window. 

The following topics review all types of manipulators and decorators for each flavor of face-face blend. 

Selecting a Set of Faces 

Normally, the operation is defined beginning with selecting the sets of faces between which the blend will 

be constructed. The left and right-wall sets are formed when one of the following automenu options is 

active: 

 <L> Select left-wall Face 

 <R> Select right-wall Face 

Switching between the options is done by pressing an icon button in the 

automenu. 

Turning on an option automatically activates the respective tab on the 

property window. The list of selected faces of the right or left wall is displayed 

in the provided pane under the tab tag. Switching between the tabs of the 

property window also activates the appropriate options for face selection. 
 

Face selection is done using the mouse in the 3D view window. 

The selected faces of the left wall are highlighted in green by default, the right ones - yellow. Settings of 

the highlighting colors are done in the system customization dialog box. The current face highlighting 

color is reflected in a color box on the tab tag for each set. 

A decorator is drawn in the middle of each face, shaped as an arrow, marking the side of the face adjacent 

to the blend surface. In a general case, two walls make four quadrants, each being suitable for constructing 

a blend surface. The blend is created in the quadrant pointed at by both arrows. 
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For solid bodies, the direction of an arrow is determined automatically. For sheet bodies, the direction of 

faces has to be controlled manually by the user. For flipping the system default direction, set or clear the 

“Reverse” flag. 

To exclude a face from a wall set, simply select it in the list in the property window on the respective tab 

and press [Delete] button. 

Blending Mode Selection 

A blending mode can be defined (modified) at any step into the operation setup. The name of the mode 

is selected in the pull-down menu in the property window. Three modes are available: “Constant radius”, 

“Variable radius” and “Constant width”. 

 “Constant radius” mode settings 
 

In the “Constant radius” mode, the user needs to additionally specify 

the  “radius” of the blend surface. The “radius” input box appears in the 

property window right after selecting this mode. By default, the system 

sets the radius equal to 10 units. 
 

This field is synchronized with the draggers. Depending on the selection of the blend surface shape, the 

dragger is drawn as an arc or as a line segment (only for chamfer creation). The number of manipulators 

depends on the number of faces in the right and left wall sets. All manipulators update simultaneously and 

relate to the same parameter, the “radius”. 

 “Variable radius” mode settings 
The “Variable radius” mode brings more additional controls in different parts of the property window.  
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At the bottom of the property window there are standard controls for manipulating intermediate points 

for variable-radius blend. The special item “Positions” manipulates the list of auxiliary points. The points 

Start and End are always included. Other points are named as they are created. Adding and deleting points 

is done using the buttons [Add] and [Delete]. A point position is specified in a special input box by 

percentage of the total length of the blend surface. 

 
 

The “Variable radius” mode requires setting two offsets for each auxiliary point. Initially, the system sets 

the second offset equal to the first one, as indicated by the checked box before the second offset in the 

property window. With this setting, the two offsets change simultaneously. If the setting is cleared, an 

individual value can be defined for the second offset.  

Positions of the auxiliary points and their offset values can be defined by draggers (see the diagram below).  

 

 “Constant width” mode settings 
 

The “Constant width” mode requires two numerical parameters – “Width” and “Ratio”. By default, the 

system presets the width of 10 units and the ratio equal to (-1). 

These fields  are synchronized  with  the  respective dragger. Depending on  the blend shape selection, the 

dragger is drawn as an arc or as a line segment (for chamfers only). The number of draggers depends on 

the number of faces in the right and left walls. 
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Blend Type Selection 

The type of the blend operation can be selected from the pull-down list in the property window. One can 

select any of the three choices: Rolling Ball, Disc,Isoparametric. The system sets the rolling ball type by 

default. 

 
 

Spine selection 
To turn on the spine selection mode, activate the following automenu option, 

 <S> Select 3D path as guide curve 

 

1Selection of a 3D path is done in the 3D window or in the model tree 

by the mouse. The name of the selected 3D path is displayed in the 

property window.  
 

 

Only one 3D path can be used as a guide. If, say, by a mistake, a wrong path was selected, another one can 

be selected right away. Selection of a new 3D path cancels the previous, and the last selected path will be 

used as a guide. 

To reject a 3D path selection, use the automenu option: 

 <W> Cancel Selection of 3D Path as a guide curve 

Defining the Shape of Cross Section 

 
 

The shape of the cross section can be selected from the pull-down list 

in the property window. The list contains three choices: Conic, Chamfer 

and Continuous curvature. By default the conic cross section shape is 

defined. 

Depending on the blending mode and the selected shape of the cross 

section, 

 

additional controls may appear or hide in the property window for controlling the cross section shape and 

its geometrical parameters. 
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Conic cross section settings 
When using the “Constant radius” blending mode, no additional settings are requires. In this mode, 

defining a conic shape makes the blend cross sections become arcs. 

An additional Rho parameter is defined in the “Variable radius” mode 

for conic cross sections. The parameter value is defined separately for 

each characteristic point of the variable blend. By default, the value of 

0.5 is assigned  

to this parameter. In this case, the cross section is a parabola. With smaller values the cross section becomes 

an ellipse, with greater ones – a hyperbola. This parameter may not be 0 or less and 1 or more. 

In the “Constant width” mode the shape of the conic section depends on the definitions of the mode itself, 

in particular, on the “Offset” parameter. If the offset ratio is defined equal to 1, then the blend cross section 

will become a circular arc, otherwise it will be a parabola. 

Chamfer settings 
No additional settings are required for this shape of the cross section in any blending mode. The points of 

contact, computed for each cross section according to the chosen mode, are connected by a straight line. 

Continuous-curvature cross section settings 
The continuous-curvature cross section can only be realized under the rolling-ball blend type. Therefore, 

selecting this shape for the cross section automatically switches the system into the rolling-ball blend type. 

In the “Constant radius” and “Constant width” modes, the shape of the 

cross section is controlled by the single parameter Softness. The 

softness value must always be greater than zero The system default for 

this parameter is 1. 
 

In the “Variable radius” mode, the shape of the continuous-curvature 

cross section depends on two parameters – Offset and Depth. Both 

parameters vary in the range from 0 to 1, exclusive. The default value 

is 0.5. The values of the parameters are defined separately for each 

characteristic point of the variable blend. 
 

Defining Boundary Conditions 

All types of boundary conditions are defined along the specially selected edges. To get the edge selection 

mode, engage the following automenu icon: 

 <C> Select edge to specify limitation 
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Turning on this option automatically activates the Constraint tab of the 

property window. The provided pane under the tag displays the list of 

selected edges. Switching to this tab of the property window from any other 

mode activates the edge selection mode as well. 

The type of boundary conditions can be selected from the pull-down list. Five 

choices are available: tangent, conic, inverted tangent, inverted conic and 

cliff. The default offered by the system is “tangent”. 

Each constraining  edge  requires  individual setting of  the  boundary  

condition  

 

type, in a certain order. First, you need to select a constraining edge in the complete list of edges, and then 

define (if required) the boundary condition type using the pull-down list. 

To remove an edge from the list of constraining edges, press [Delete] button in the property window on 

the “Constraint” tab. 

One should keep in mind that constraints can work only in connection with compatible geometrical 

parameters of the blend surface that are defined by the blending mode and cross section shape. 

Thus, if the cross section parameters prevent the blend surface from reaching a holdline then the 

tangency condition on one or both walls is impossible. Vise versa, if an “inverted tangent” constraint 

is imposed, then the appropriate “radius” of the blend surface is such that the blend is not reaching 

the holdline or the wall itself in the zone of the constraint validity. 

 

It follows from the above that often draggers stop working on a blend surface constrained to certain 

boundary conditions. For example, when creating an “inverted tangent” blend surface that does not reach 

the walls initially, the draggers are not displayed. Vise versa, when creating a “tangent to walls” blend 

surface that does not fit amid the walls then the dragger reflects the largest arc fitting amid the walls. 

Overflow Settings 

Notch. Tangent propagation 

Attributes are provided in the property window for turning on notch 

handling and tangent propagation. These parameters are accessible for 

use with all types of blend. 
 

Limit plane setup  
Engage one of the following automenu options in order to select the primary or secondary limit plane: 

 <F> Set first limit plane 

 <D> Set second limit plane 

Upon activating the option, workplanes and flat faces will become selectable in the 3D window. Select 

either in the 3D window or on the model tree using the mouse. 
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When selecting a limit plane, its decorator is displayed in blue color. The decorator is a rectangle drawn 

on the limit plane. The size of the rectangle is computed according to the sizes of the right and left walls. 

Normal arrows are drawn in the corners of the rectangle, pointing toward the side of the blend surface to 

keep. 

 

             

After selecting first or second limit plane, the property window displays 

the “Reverse” checkbox instead of the previous “Not selected” status, 

for flipping the “keep” side as indicated by the arrows.  

If only one limit plane is to be used then define only the First plane. Both the First and Second limit 

planes should be defined only when two limit planes are to be used simultaneously. 

 

The following automenu options are provided to reject use of limit planes: 

 

 <Z> Cancel Selection of First Limit Plane 

 <X> Cancel Selection of Second Limit Plane 

End trimming options 
The end trimming options for the blend surface can be selected from 

the pull-down list in the property window. Four choices are available: 

Faces to wall, No trimming, Long trimming, Short trimming. By 

default, the “Faces to wall” option is set.  
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Defining topology of the resulting geometry 
A choice of the resulting topology is selected from the pull-down list in the property window. Four options 

are available: Separate body, Trim walls, In Left Walls and Create new body. The system default is In left 

walls. 

 
 

Adjusting solution by a node  
If a blend operation results in several sets of blend surfaces, a 3D node can be selected to define the blend 

set to keep. Selection of the 3D node is done by activating the following automenu option: 

 <E> 
Select 3D Node, that defines only one nearest surface 

as result 

 

Upon selection, the name of the node is entered in the blend operation 

property window. Next, the user needs to explicitly specify whether to use the 

solution by the 3D node, or use all obtained solutions. The type of the solution 

is selected in the pull-down list, containing just two items: All and Use 

adjusting point. This switch helps quickly alter the solution type without 

giving up the selection of the adjusting 3D node.  

 

 

 

The following automenu option is provided to reject a 3D node selection: 

 <N> 
Cancel Selection of 3D Node that indicates the nearest 

result 

CREATING A "WIRE-FACE"  BLEND  

To create a "wire-face" blend you must specify: 

 set of faces of solid/sheet body as a left or right wall of the blend. The second wall is not 

defined; 

 set of smoothly conjugate edges of the wire body (3D profile, 3D path) as a boundary 

condition; 

 radius of the blend; 

 option for the final result topology (only the "Separate body" or "In left wall"). 

All other parameters of the operation in this mode are not used. 
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As in the general case, for selecting faces it is necessary to either activate one of the tabs "Left/Right" in 

the properties window, or use one of the automenu options: 

 <L> Select left-wall face 

 <R> Select right-wall face 

The set of edges is defined as a boundary condition. To select the edges, you must activate the "Bounds" 

tab in the properties window  or automenu option: 

 <C> Select edge to specify limitation 
 

Do not change the type of boundary condition. 

Option for the final result topology is determined by the "Result" drop-down list  in the properties window. 

For this mode of blend, you can use only two options: "Separate body" and "In left wall." 

Option "In left wall" can only be set if the original set of faces belongs to a sheet body. In this case, the 

resulting body is attached to the original sheet body, regardless of which wall has been set in operation - 

the left or right. 
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THREE-FACE BLEND 

The three-face blending operation creates a blend surface from 

one set of smoothly connected faces to another such set. The 

blend surface will be constructed tangent to yet another, third set. 

A typical situation addressed by this operation is creation of a 

smooth transitional surface between two opposite faces and 

along the narrow strip of the side surface of thin-wall parts. The 

sets of faces for blending are not required to share common 

edges (intersect).   

Blending can be performed over solid bodies as well as sheet 

bodies. This operation can be considered as a special case of the 

face-face blend, separated into a dedicated command. Since the 

three-face blend shares many concepts with the face-face blend, 

first refer to the “Blending faces” section for details on certain 

terms and concepts. 

 

MAIN CONCEPTS .  OPERATION CAPABIL IT IES  

General Operation Concepts 

Three sets of faces make the basis of the “Three-face blend” operation. These are called “right”, “left” and 

“center” walls. The sets of faces of the left and right walls should have between themselves smooth mates, 

a set of faces of the middle wall can be mated at a small angle (not more than 5 °). The walls themselves 

are not required to connect smoothly with each other. All sets of faces can belong either to the same solid 

body or to one, two or three sheet bodies. Three-face blends can’t be created between walls belonging to 

different solid bodies or mixed sheet and solid bodies. 

Blending Form 

There are two types of blending of three faces: spherical and disk. 

For a spherical type, the blending surface is formed by moving an imaginary sphere inscribed between the 

walls along the entire length of the walls, forming a smooth tangential conjunction at the points of contact 

with them. The cross-sectional shape of the blending surface is calculated as a spline. 

For disc type, the blending surface is formed on the basis of a set of cross-sectional planes and a guide. 

Planes are built perpendicular to the guide and contain three points of contact where the blending surface 

touches the walls. The cross-sectional shape of the blending surface in the plane is always calculated as a 

circular arc that fits in such a way as to ensure a tangency to each wall. 
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Original configuration Resulting blend 

The guide spine is always represented by a 3D path. The spine may not have sharp corners. If the spine is 

too short for defining all cross sections, it is extended by straight segments tangent at the ends. If the 

length of the guide is redundant, then the system tries to choose the part of the 3D path it needs. 

       
The figures show blend surface geometry dependency on the guide spine 

If the left and center walls are adjoining then their common edge (the set of edges) may be used as 

the guide spine. In this case, selection of the guide spine is optional. 

In the case of the use of disk-type construction of the blending surface, when the edge between the left 

and middle walls has a complex shape, to ensure a successful result between the faces, it is necessary to 

create a new guide of a simpler shape in comparison with the edge, which approximately repeats its shape. 

Let's consider two typical examples. 

Example 1. It is required to create a blending of the side 

part of the fan blade with the use of disk construction 

type. In this case, the system may not use the edge 

between the left and center walls due to the following 

reason. The edge has a too small radius in the circled 

area. The blend cross sections would intersect each 

other if constructed normal to the edge. An additional 

spine (a 3D path) helps creating a blend in this case that 

approximately repeats the shape of the edge yet avoids 

the mentioned traps.        
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Example 2. In this example, the left and right walls are 

cone fragments. The part gets wider in the middle. At 

the first glance, the edge radius is not too small. 

However, due to the widening part and edge curving in 

the opposite direction, the system considerably 

increases the radius of the blend surface that again 

results in self-intersections. Using a flat spine of the 

shown shape helps easily create the blend surface. 
    

Adjacent Smoothing 

The mode of selecting consecutively paired faces allows the system to automatically select a connected 

sequence of smoothly adjoined faces of the required wall when specifying one of the faces included in this 

sequence. 

  

If the adjacent faces of the middle wall are conjugated at an angle, the system allows you to set the angle 

at which these faces will participate in blending. 

  

Result 

When blending three faces of a solid body, the result will always be in the form of a solid body.  

When blending three edges of the sheet body, or three sheet bodies, the system allows to determine the 

type of the resulting blending: 

 No Trim. The blending surface does not join the walls; walls are removed. The result is a sheet body. 
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 Trim Both. The left and right walls are cut off at the points of contact with the blending; the 

blending surface does not join the walls. The result is individual sheet bodies. 

 Trim and Sew. The left and right walls are cut off at the points of contact with the blending surface; 

blending surface joins the walls. The result is one sheet body. 

 Create Solid. The left and right walls are cut off at the points of contact with the blending surface; 

blending surface joins the walls and forms a closed space. The result is a solid body. 

 Auto. The system independently selects the optimal blending result. 

     
The Initial Set of 

sSheet Bodies 

No Trim Trim Both Trim and Sew Create Solid 

The system also provides the ability to create a blending in the form of a separate body, while maintaining 

the topology of the original bodies. 

    
The Initial Set of sSheet 

Bodies 

Result Original solid body Result 

Sometimes situations arise when several blending surfaces may exist for a selected set of walls. You can 

leave them all or specify one specific solution. The system selects the solution closest to the selected 3D 

point. The 3D point can be a 3D node, a vertex or a middle of an edge. 

   
Source body All solutions 3D node solution 
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Trimm Blending Surface 

Using flat edges or work planes, you can set a restriction of the blending zone. One bounding plane divides 

the blending surface into two parts, leaving one of them in the scene. In total, no more than two bounding 

planes can be specified. Two planes can limit the central part of the blending surface from two sides. 

  

 

The orientation of the blending boundary depends on the bounding 

plane and the chosen method of the blending shape. When the 

Trimming parameter is set, the blending boundary passes along the 

boundaries of the bounding plane. Otherwise, the blending boundary 

passes perpendicular to the direction of the blending surface through 

a point formed in one of the following ways:  

 The intersection of the bounding plane and the top blending 

(for spherical shape blending); 

 

 The intersection of the bounding plane and the given guide (for 

the disk shape blending). 

 

Trimming by walls (Ends processing) 

When creating blending faces, you can choose how to trim the edges of the blending surface. The 

geometry of the walls themselves when cutting the blending surface is not broken. Total 
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There are four ways to trim: 

 No Trim. In this case, the blending surface is extended beyond the boundaries of all walls. 

 By Both Walls. The blending surface is cut along the borders of the left and right walls. In this case, 

the side edge of the blending surface is formed in such a way as to ensure contact with the side 

edges of the trimming walls. 

 By Short. The blending surface is trimmed along the least distant wall edges. 

 By Long. The blending surface is cut along the most distant edges of the walls. 

     
The Initial Set of 

sSheet Bodies 

No Trim By Both Walls By Short By Long 

Additionally, the system makes it possible not to take into account the middle wall when creating a 

blending surface. For example, the option may be useful when creating a body with trimming along the 

wall in the By Short mode or By Long. 

   
The Initial Set of sSheet Bodies By short, taking into account the 

middle wall 

By short, without taking into 

account the middle wall 

   
The Initial Set of sSheet Bodies By long, taking into account the 

middle wall 

By long, without taking into 

account the middle wall 

The methods of trimming No Trim, By Short, By Long can be used only if the end result is obtained 

in the form of a sheet body. 
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OPERATION DEFINING STEPS  

The operation creating command can be called via one of the following ways: 

 

Icon Ribbon 

 

3D Model→ Create → Blend → Three Face 

Keyboard Textual Menu 

<3DT> Operation > Blend > Three Face  

The property window and the automenu are used for handling the command and defining necessary 

components. These work simultaneously and enhance each other. The object selection modes can be 

manipulated via either the automenu or the property window.  

To create the operation, follow the following steps: 

 Select first set of faces (the left wall) 

 Select second set of faces (the center wall) 

 Select third set of faces (the right wall) 

 Set blending type (if necessary) 

 Select a guide (if necessary, depending on the type of blending) 

 Set result parameters (if necessary) 

 Select trim elements (if necessary) 

 Set the trim parameters by the walls (if necessary) 

 Confirm operation creation 

Selecting a Set of Faces 

Normally, the operation definition begins with selecting the sets of faces between which the blend will be 

constructed. The left and right-wall sets are formed when one of the following automenu options is active: 

 <L> Select left Face 

 <C> Select center Face 

 <R> Select right Face 

Switching between the options is done by pressing an icon button in the automenu. 
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Turning on an option automatically activates the respective 

tab on the property window. The list of selected faces of the 

right or left wall is displayed in the provided pane under the 

tab tag. Switching between the tabs of the property window 

also activates the appropriate options for face selection. 

Face selection is done using the mouse in the 3D view 

window. The current face highlighting color is indicated by the 

colored box on the tab tag for each set. 

 

To automatically select a linked sequence of smoothly conjugate faces, you need to enable the option: 

 <S> Smooth face chain selection mode 

After enabling this option, it is enough to specify any face of the required wall that is included into the 

required sequence. The remaining faces will be added automatically.  

You can deselect all items at once using the option: 

 <K> Cancel selection 

A decorator is drawn in the middle of each face, shaped as an arrow, marking the side of the face adjacent 

to the blend surface. The blend is created on the side pointed at by all three arrows. 

    

 

Control over the arrow directions is done via the provided “Orientation” item 

under of the face list pane on each tab in the property window. Selection is 

made in the pull-down list. For solid bodies, the direction of an arrow is 

determined automatically. In this case, the “Auto” option is set for all faces. For 

sheet bodies, the direction of faces has to be controlled manually by the user.   

To change the system default arrow direction, select one of the other two available orientation settings, 

Normal or Reverse. 

To exclude a face from the wall set, simply select it in the list in the property window on the respective tab 

and press [Delete] button. 

To ensure the participation of adjacent edges of the middle wall 

conjugated at an angle in the blending creation, it is necessary to set 

the flag in the Propagate field in the corresponding tab of the  
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properties window and set the maximum conjugation angle of these 

faces. 

Choice of Blending Form 

The selection of the type of blending is carried out using the corresponding icons in 

the properties window. By default, the system sets the spherical type of blending. 

 

Spine Selection 

To turn on the spine selection mode, activate the following automenu option. 

 <W> Select guide spine 
 

Selection of a 3D path is done in the 3D window or in the model 

tree by the mouse. The name of the selected 3D path is displayed 

in the Guide Spine box of the property window.  

 

Setting Result Parameters 

Multiple Solution 
The selection of an auxiliary point to refine the result in the case 

of the formation of several blending surfaces is performed after 

the Multiple Solution flag is checked in the properties window. 
 

To do this, activate the corresponding field and select the desired 3D point in the 3D window. The selection 

of the auxiliary point is canceled using the button . 

Select Type of Walls Trimming 

The selection of the type of wall trimming is carried out using 

the corresponding buttons in the properties window. By default, 

the system sets the type to Auto. 
 

To create a blending surface in the form of a separate body, you should select the corresponding flag in 

the properties window. 
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Selection of Trim Elements 

To select the elements that limit the blending zone, it is 

necessary to use the Trimming tab in the properties window. 

Then determine the mode of selecting items: topological 

(planes, surfaces, straight lines) or geometric (faces, cycles, 

edges). 

Elements are selected using the mouse in the 3D window after 

activating the Element field. 

The direction of the resulting blending surface is determined 

by the value of the Orientation drop-down list. 

To delete a bounding element, simply select it in the list of the 

properties window and click the [Delete] button. 

The Trimming flag allows you to determine the position of 

the blending boundary relative to the guide. 

 

Trimming by Walls 

The way to trim the edges of the blending surface is selected 

from the drop-down list of the Trimming by Walls option in 

the properties window. By default, the system sets the By Both 

Walls trimming method. 

In order for the middle wall not to be taken into account when 

creating the blending surface, it is necessary to check the flag 

in the Ignore Middle Wall field. 
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LOFT 

This operation creates solid bodies of complicated shapes. The Loft operation can be built on practically 

any model elements based on one of the three principal geometry types, “point”, “wire” and “sheet”. 

Depending on the geometry type of the base elements, the result may be obtained in the form of a solid 

body or a set of surfaces. The resulting spline surfaces are constructed based on the specified set of 

sections and guides subject to the imposed boundary conditions. An optimization module is available 

among the operation settings that forces generation of simple analytical surfaces whenever possible. 

MAIN CONCEPTS .  OPERATION CAPABIL IT IES  

“Point” in the three-dimensional space can be defined by a 3D node, a 3D vertex, or a “position” parameter 

on an object. The “wire” geometry elements (the ones with length/perimeter but without area) include all 

linear objects – edges, 3D paths, loops and some types of 3D profiles. Some times, the system can 

automatically extract geometry of the required type from the sheet objects, such as faces. “Sheet” objects 

(with area, but without volume) include all types of surfaces, faces and 3D profiles created from a closed 

contour. Sometime an operation is accepted as a sheet object, if the operation results in a surface (a set of 

surfaces). 

While selecting elements, always pay attention to the active object 

selection filters. These are convenient, as, generally, pointing the 

cursor to a group of elements may not identify the specific desired 

element. Thus, for example, if we need to select just an edge on the 

profile rather than the whole profile, the filter should be set up for 

edge selection. 

To turn on the necessary filter, one can use the pull-down list under 

the currently active option of the automenu. The options possessing 

such pull-down lists are marked by a black triangle in their lower-

right corner. The list of the available filters under a particular option 

is accessed by pressing and holding . A simplified set of the 

available filters is simultaneously displayed on the system toolbar in 

the form of the respective buttons. 

To turn on one filter and simultaneously turn off all the rest, 

push the filter button with  while holding the <Ctrl> key. 

 

 

Sections 

Sections define the surface shape along the first direction. To create a simplest instance of the operation, 

at least two sections need to be selected. 

A section can be represented by either a sheet or a wire object. A wire object may be either closed-loop 

or open. One section can be composed from several pieces that can be freely added and removed during 
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the operation setup. The set of objects making one section must have same-type geometry. For example, 

one section can be composed of a set of paths and edges, or, alternatively, of a set of adjoining faces. 

 

The contours of all sections used for creating the resulting surface must be of the same type – either open 

or closed. Exception is the case of a “clamped tube” body. In that case, most sections are defined by closed-

loop sections, while the first or last section is defined by an open “wire”. In order to successfully create 

such a body, follow precisely the set of conditions listed below. 

   

Multi-contour profiles can be used as sections, if they have same topology. For example, these can be 

similar profiles or copies of the same multi-contour profile. In this case, no other parameters may be 

specified (guides, matches, boundary conditions). 

   

A point can be used as the first and last section. In this case, the surface will collapse in the selected end 

points. 
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A section possesses such a property as the direction of the contour traversal. When defining the operation, 

an arrow is drawn on the selected section indicating the contour direction The contour direction is used 

for computing the surface, it should match for all selected sections. In most cases, the system can 

automatically determine the contour directions for successful creation. However, if necessary, it can be 

flipped by the user for each individual section. 

Match Points 

The match points help defining the direction of the surface propagation between the characteristic points 

of different sections. Always there is at least one match between the points in the sections. Originally, it is 

set between the start points of the sections. New sequences of match points can be added by the user 

manually. Any sequence of match points, including the start points, can be edited. The preview of the 

operation in the 3D window displays each set of match points connected by straight lines as soon as the 

elements get selected.  

In the case of open contours, the start points can only be defined at the start or end of a section. 

Each set of matching points includes one point from each section, except for the end sections defined by 

a single point The match points can be defined by 3D nodes, section vertices or the points defined on a 

section edge by the “position” parameter.  
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If the end sections are open with the rest closed (as in the “clamped tube” body type), then the following 

conditions must be met when defining the match points: 

 At least two sequences of match points must be defined passing through the start and end of 

the first and last open wire. 

 The closed profiles should not have “free” vertices, that is, the vertices not used as match points 

in any sequence. 

 All match point sequences must meet at the start or end of the first and last open wires. 

Guides 

Guides are similar to sections and are used for defining the shape of the resulting surface in the second 

direction. As opposed to sections, the guides can be made of wire geometry only. If a sheet object is 

selected, its perimeter will be used instead. All objects must have continuous first derivative, that is, the 

“wire” should not have any sharp corners. Another condition is the requirement for a guide to intersect 

with all sections, including the ones defined by a single point. One guide can be composed of several 

smoothly connected linear objects. 

   

Guides can be closed or open. Closed guides are used for creating closed bodies. 

Instead of guides, one 3D path can be used, as if replacing multiple guides passing through all section 

points. The path defines the boundary conditions for t and he entire resulting surface. Therefore, other 

boundary conditions are not subject to being defined when the guide is defined. The only exception is the 

option of specifying the tangent direction with respect to the surface being created as derived from the 

path at the point where it intersects the section defined by the 3D profile (see below). A path is not required 

to intersect with the sections. The diagrams following below demonstrate the operation created with 

neither a path nor guides (left) and the one using a 3D path (right).  
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Boundary Conditions 

Boundary conditions impose additional constraints on the shape of the resulting surface.  

The following boundary conditions can be defined for all sections and guides, except for the case of using 

a single 3D path as a guide: 

 Faces – these help define the first derivative (the direction) at each point of the section edge 

and at a segment of a guide, or the second derivative (the curvature) only for a section edge. 

The direction is derived from the face at the tangency point between the face and the frame 

edge. The face specified for defining the condition must end at an edge of the section or 

guide on which the condition is being imposed.  

   

 Vectors – these are used for defining the first derivative (direction) of the resulting surface at 

an arbitrary point on a section contour or guide.  
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The following boundary conditions are applicable at the start and end 

sections: 

 Normal (outside) – the resulting surface is constructed 

orthogonal to the section plane. The normal vector is 

computed automatically and always points outside of the 

body to be created. 

 Normal (to profiles) – same as the above. The normal 

vector is derived from the profile. This is a legacy 

functionality of earlier T-FLEX versions. 

 Tangent – the resulting surface is constructed tangent to 

the section plane. 

 

The above three conditions can be defined only for sections that are planar or are actually a part of 

a plane. 

 Body – the body providing the tangency condition. The body must directly adjoin the section 

by one of the faces, with the face preferably matching the section The tangency condition 

(the directions) is derived from the side faces of the body.  

   

The boundary conditions for the start and end sections – points can be defined as a normal vector of a 

plane passing through the point. The resulting surface will be made tangent to thus defined plane.  

 



Three-dimensional modeling 

480 

All boundary conditions for sections listed above are mutually exclusive. This means, the same area or point 

may not be assigned several boundary conditions. No conditions are allowed on the end sections in the 

case of a closed surface. 

Different boundary conditions may conflict. Only one face should correspond to a section edge or guide. 

If more than one face relates to an edge then the boundary condition is ignored, and the system outputs 

an appropriate warning. A boundary condition may not be defined by a vector at the intersection of a 

section and a guide. Two vectors should not be defined in the same point either. 

If a single 3D path is defined instead of guides, then only one type of boundary conditions can be specified 

for the surface being created, which is the 'tangent to path' condition at the point of the path's intersection 

with the section. The section to which this condition applies must consist of a single 3D profile. The 

boundary condition is defined by selecting a face of the profile, on which the section definition was based. 

 

  

LOFT OPERATION DEFINING STEPS  

The operation creating command can be called via one of the following ways: 

 

Icon Ribbon 

 

3В Model → Create → Loft 

Keyboard Textual Menu 

<3SL> Operation > Loft  

The property window and the automenu are used for handling the command and defining necessary 

components. These work simultaneously and enhance each other. The state of the automenu depends on 

the operation defining stage and on the purpose and type of the objects being selected. The object 

selection modes can be manipulated via either the automenu or the property window. 

The surface of the operation is computed based on the element skeleton and specified boundary 

conditions. The skeleton elements are sections and guides. 

To create the operation, follow the following steps: 

 Define sections 



Loft 

481 

 Define guides (optional) 

 Define match points (optional) 

 Define boundary conditions (optional) 

 Confirm operation creation 

Section Selection 

The operation is always defined beginning with selecting the sections. For successful operation creation, 

at least two sections are required. Any system object may be used as a section that contains wire or surface 

geometry.  

To start the section selection mode, focus (click) at an empty line in the “Sections” pane. This area is on 

the [Sections] tab of the property window. The automenu will then automatically switch to section selection 

mode.  

The following options become active. 

 <U> Select Sections 

This option is responsible for section selection mode. 

 <R> Select 3D Profile  

This option provides fine tuning of the filters for selecting objects. 

The black triangle in the lower-right corner of the icon indicates 

availability of the pull-down list. 

Then, proceed with selecting objects in the 3D window. Each selected 

element will be appended in the end of the sections list as another 

section. Sections can be moved up and down the list with the help of 

the respective dialog buttons. To remove any object from the list in all 

three panes of the dialog, highlight the object in the list and press the 

[Delete] button or the <Del> key. 

RESTRICTIONS: The start and end sections may not be moved 

around the list if these are defined by points, or if boundary 

conditions are defined there specific to the start and end 

sections. 
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Each section may be composed of several objects of the same type. The 

“Composition” pane shall be used for defining such complex section. 

This pane displays the list of names of the selected elements for each 

particular section. To add to the section contents, focus (click) at the 

“Composition”, pane and then select additional objects. 

RESTRICTIONS: A section may be composed only of the objects 

of the same geometry type. 

 

If for some reason the system runs into an error while composing a 

section contour, this section will be marked by the “*” symbol. This may 

happen due to various reasons. For example, gaps were produced 

during model regeneration, or elements disappeared that were part of 

a section. 

 

By default, the smooth edge chain selection mode is turned on. In this mode, selecting one edge 

automatically results in selection of smoothly adjoining edges to the selected one, that is, making the 

selected edge continuation with the continuous first derivative, with no sharp corners. Turning the mode 

on/off is done via the respective automenu option: 

 <G> Smooth edge chain selection mode 

Point objects – 3D nodes and vertices can be selected as the ending sections (start or end). To define such 

section, activate the following automenu option: 

 <E> Select 3D Node 

By switching between the selector filters one can select any objects defining a point in the three-

dimensional space: a 3D node, 3D vertex, center of an arc, center of a sphere, a coordinate system. The 

new section – point will always be at an end, in the beginning or the end of the list of sections. 

Operation skeleton display when defining sections 
The elements selected as sections are highlighted in green by default. The active section is highlighted in 

red. Active considered the section that is being currently manipulated. For example, working on a section 

composition makes it active. Settings of the highlighting colors are done in the system customization 

dialog box. 

The colored square on the [Sections] tab is filled with the color of the current highlighting setting 

of the sections. 
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A start point is set for each selected section. The set of start 

points makes the first match sequence. If sections are closed 

then the start point is set in the nearest to the cursor vertex 

of the section. For open sections, the start point is set in the 

nearest end of the “wire”. If the system-defined configuration 

of the section starts is not suitable, it can be changed, or new 

matches can be added. The detailed description of section 

matching follows below. 

An arrow is displayed at each section start indicating the 

contour direction. The same direction should be defined in all 

sections for successful operation creation. A contour 

direction can be flipped by toggling the Reverse flag. 

Toggling the flag moves the start arrow to the opposite end 

of the contour. 

 

 

In the case of closed contours, the system attempts to synchronize the contour directions automatically, 

using the Autoreverse option. 

Defining Match Points 

Once the sections are defined, the system needs to relate them with each other. One needs to define how 

to configure the surface. One match sequence is automatically created from the start points once the 

sections are defined. In complicated cases, however, this may not be enough.  
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The sections are divided into sectors by the match points. 

Some of the generatrices of the surface being created pass 

exactly through the match points. The space between the 

sectors is divided into an equal number of elements for the 

primary generatrices to pass through. Should there be at 

least one vertex within a sector between any two match 

points on a section, the system subdivides the respective 

matching sectors in all sections in the same proportion. This 

is done to achieve an equal number of sectors in all 

sections. This may lead to creation of additional, sometimes 

undesired, edges and faces. Therefore, an optimum 

solution is to define match points in the vertices of the 

sections. This way of defining the match points should be 

favored whenever possible. 
 

To switch to match point defining mode, go to the [Matches] tab of the operation property window. This 

tab hosts two related panes with the lists of sequences and the respective match points. Each sequence 

contains one point per a section, except for the single-point sections. The points are ordered from the start 

to the end section. The contents of the sequence can be viewed in the second pane, named “Points”. 

To define a new sequence, place the cursor at an empty line in the “Matches” pane. The system is now 

ready for defining the points. The following options get activated in the automenu: 

 <C> Define match points 

This option sets the mode of match point selection. 

By default, all three types of points are selectable in the command. The automenu lets setting up a filter 

for selecting just one type of object: nodes only, vertices only, or points on edges. The following automenu 

options are used for such setup: 

 <A> Select All Points 

 <N> Select 3D Nodes 

 <X> Select Vertices 

 <K> Select Points on Edges 

The first section is activated and is automatically highlighted in red (by default) in the 3D view window. 

Once a point is selected on the first section, the second section gets highlighted, and so on, until points 

are selected in all sections. All vertices of the active section are highlighted as well. The object snapping 

turns on, helping to bind a point to a section vertex or a 3D node on the section.  
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If snapping to vertices and nodes is not required then the point can be placed on a section edge. In this 

case, the point position on the edge will be defined by a parameter varying from 0 (at the edge start) to 1 

(at the end of the edge). The edge direction is same as the contour traversal direction.  

A point can be selected by pointing the cursor to the desired object and clicking . Object selection  occurs 

per current filter settings. 

The Automatic flag is used for automatic placement of the match points. The automatic match points can 

only be defined for flat closed contours under the condition that at most one section is allowed to have 

the discontinuous first derivative (a sharp corner). As the “Automatic” flag is cleared, the points created 

automatically are converted to the modifyable objects. 

RESTRICTION: Intersecting match point sequences are not allowed.  

To edit a sequence or point object, simply select it in the property window, after which redefine it by 

selecting another object in the 3D window. Thus, to edit a whole sequence (say, the start point one), select 

the object Start points on the matches tab, and then pick one by one the desired points on each section. 

Highlighting and object snapping work just as at the initial sequence definition. To edit a particular point 

in the sequence, first select this point in the list of the “Points” pane, and then select another object in the 

3D window. The respective section is highlighted while editing a point.  

Upon finishing editing of the selected object, the system proceeds with the next object in the list – a point 

or a sequence, or offers to define a new sequence, if the edited object was last in the list. 

To remove any entry from any pane, select it and press the <Del> key or the [Delete] button. 

Guide Selection 

The guides are side elements of the operation skeleton. Guide definition is mostly similar to the section 

definition procedure. 

To switch to the guide definition mode, go to the [Guides] 

tab of the property window. Just like the Sections tab, this 

one hosts three panes, Guides, Composition and 

Tangency. The latter will be used when defining boundary 

conditions (see below). If an error occurs while composing 

the contour, then the guide is marked by “*”. 

To select a new guide, click at the new line of the Guides 

pane. The new line is marked by an ellipsis. Upon switching 

to the tab, the automenu enters the mode of guide 

selection. The necessary options become available. 
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 <V> Select Guides 

This option sets the guide selection mode. For convenience, the necessary object selection filters can be 

set up. The filter buttons are located on the system toolbar or in the pull-down lists of the appropriate 

automenu options. 

 <R> Select 3D Profile 

This option provides fine tuning of the filters for selecting objects. The black triangle in the lower-right 

corner of the icon indicates availability of a pull-down list. 

By default, the smooth edge chain selection mode is turned on. 

 <G> Smooth edge chain selection mode 

The elements can be selected in the 3D window or in the model tree. 

RESTRICTION: A guide must intersect with all sections, including the single-point ones. 

Operation skeleton display when defining guides 
The elements selected as guides are highlighted in yellow by default. The active guide is highlighted in red. 

A guide becomes active as it is selected in the list of guides. Settings of the highlighting colors are done 

in the system customization dialog box. 

The colored square on the [Guides] tab is filled with the color of the current highlighting setting of 

the sections. 

An arrow is displayed on each guide indicating the traversal direction. The direction should be from the 

start to end section for successful operation creation. The direction is defined automatically for open 

guides. The traversal direction of a closed contour can be flipped by using the “Reverse” flag. When closed 

contours are used, the system tries synchronizing the directions in the “Autoreverse” mode. 

3D paths used instead of guides 
The direction of the loft surface construction can be defined in each section.   

This functionality is kept primarily for compatibility with older versions. When creating a loft 

operation anew, guides and boundary conditions should be used for full control over the shape of 

the surface. 

To enter the mode of path selection, click the mouse inside the “3D path” pane. The option will activate in 

the automenu: 

 <W> Select 3D Path for Sections orientation 
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Then a 3D path can be selected in the 3D window or in the model tree. 

The specified path affects the body shape as follows: Vectors are defined 

for all match points of all sequences from a match point to the nearest 

point on the path. The body surface is then computed using the 

minimum twist algorithm. 

To successfully create the operation, it is necessary that the selected 

path is oriented from the first section to the last one. If the “Sync” flag 

is set in the properties window, the system will automatically change the 

direction of the selected path as necessary. 

To reject a path selection, place the cursor in the “Path” pane and press 

the <Del> key or the [Delete] button on the dialog. 

 

The second direction can be defined by either guides or a path, and not both. If a path is used, the guide 

selection is blocked. Vise versa, if at least one guide has been specified, then the “Path” pane becomes 

inaccessible. 

Defining Boundary Conditions 

Different boundary conditions can be defined for different operation components. These are defined in 

order to achieve a surface closely matching the design intent, including various blending features. 

Conditions on ending sections 
These boundary conditions are specific to and can only be defined for the start and end sections, if these 

sections are based on flat contours. The geometrical information contained in a flat contour is sufficient to 

determine the rules of the surface construction in the area near the given section. 

A choice of only two conditions, how the surface meets the section, is available – orthogonal or tangent to 

the section plane. The degree of surface twisting is defined by a number representing the vector length. 

The following steps are to be done in order to define such 

boundary condition: 

 Select the desired ending section in the full list 

of sections. The selected section becomes active 

and is highlighted in red. 

 If the geometry of this section is appropriate 

then the list will become accessible on this same 

tab of the dialog containing the following four 

conditions: No, Normal (outside), Tangent, 

Normal (to profiles). Select the desired 

condition. 
 

 Enter the desired numerical value in the Length box. 
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The value is entered in the absolute model units. Therefore, the required value depends on the size 

of the model. Large models require greater values for achieving the same expected result. 

  

Boundary conditions on the ending sections can be defined by tangency to bodies. The spline surface will 

be created in this case tangent to the faces of the selected bodies adjoining to the section. 

To define such boundary condition, do the following steps: 

1. Select the desired ending section in the full list of sections. The selected section becomes 

active and gets highlighted in red. 

2. Click the mouse at the Tangency pane. If an ending section was selected then the body 

selection option activates in the automenu (another available option in the automenu for face 

selection is described below). 

3.  

 <B> Select Solid for setting beginning condition 

 <B> Select Solid for setting ending condition 

The option appearance depends on whether the start or end section is active. 

4. Select a body. The section being processed must match with a face on the body. The surface 

being constructed will be made tangent to the adjoining faces of the body. 

 

Conditions for sections defined by single 3D point 
A plane can be constructed through a single point section. The surface collapsing at an ending single-point 

section will be made tangent to this plane. To define the plane in space, an additional object is required to 

define the direction of the plane normal. The surface curvature is defined by the vector length. 
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The following steps are to be done in order to define this boundary 

condition: 

 Select the desired ending section in the full list of sections. 

 Click at the Tangency pane. If a single-point section is 

selected then the following options become available in the 

automenu for selecting new objects : 

 <S> Select first point of pyramid 

The first option sets up the filters for selecting points (3D 

nodes, vertices etc. 

The second option is designated for selecting direction-

defining objects, such as straight edges, paths, profiles, axes 

of revolution for rotation operations, coordinate systems, 

etc. 

 <D> Select Vector Direction for End Point  
 

 

 Using one of the options, select a point or direction in the 3D window. Upon selection, the 

name of the selected object will be displayed in the “Tangency” pane. 

 Specify the vector length. Do this by entering a value in the “Length” input box. 

Conditions for arbitrary sections and guides 
The boundary condition can be defined for any sections and guides by faces. Subject to certain restrictions, 

such condition may define the direction (the first derivative) or the curvature (the second derivative) of the 

surface being created in the area near the currently active element. 

To specify a boundary condition by faces, do the following steps: 

 Select the element subject to the boundary condition being defined. The sections are selected 

from the Sections pane on the [Sections] tab, while the guides are from the Guides list on 

the [Guides] tab. The selected element becomes active and is highlighted in red. 

 Click the mouse at the Tangency pane. The option for selecting tangency surfaces activates 

in the automenu: 

 <F> Select Tangent Faces 

 Select a face in the 3D window that will define the boundary condition at the section or a 

guide. If several faces adjoin the skeleton element, select them all. While doing so, keep in 

mind the following restrictions: 

 The current element (a section, a guide, or a segment thereof) must fully lie on the 

selected face 

 The selected face must end at the active element 
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 If two skeleton elements intersect, their respective faces must define the same direction. 

This means, if guides are defined in the operation then this boundary condition is not 

acceptable for a whole section. In some special cases, when open sections are used, the 

system allows using this boundary condition when one guide is present. 

In the case of violating these restrictions, the tangency condition is ignored and a respective 

message is output in the diagnostics window. 

It follows from the above that the considered 

boundary conditions can only be specified at 

certain segments of a guide. The guide 

meanwhile must be defined by a set of smoothly 

connected elements. 

The selected faces are highlighted in green (by 

default). 

 Enter the value in the “Length” input box for 

the selected tangency surfaces. This value 

determines the degree of the boundary 

condition influencing the curvature of the 

surface being created in the area near the 

current skeleton element. 

 Turn on an additional flag “Retain curvature” 

(optional). This will insure existence of 

second derivatives in the area where the 

current skeleton element meets with the 

selected faces. Without this, only first 

derivatives are guaranteed. 

 

Please note that when using a single 3D path definition, the face boundary conditions can be specified 

only for the sections defined by the 3D profile. In this case, you can only select the face of that 3D profile 

as the face definition. 

Boundary condition vectors 
A boundary condition can be defined by a vector at any point on the skeleton elements of the Loft 

operation, such as a point, a section, a guide or a match point. 

Vectors are defined in a special dialog box launched be pressing the [Vectors] button in the operation 

dialog. This button is present on all three tabs of the operation dialog. The Vectors dialog box will stay up 

even when switching between the tabs of the operation dialog. Its contents change depending on the 

operation mode and on what operation element is currently active. 

I. Defining vector on skeleton elements 

The following steps need to be done in order to define a vector based on a section or a guide: 
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1. Select the skeleton element to base the vector upon. For this, switch to the respective tab of the 

operation dialog and select the skeleton element from the list. Upon selecting a section or a 

guide, this skeleton element becomes active and gets highlighted in red. 

2. Call the vectors dialog box by pressing the [Vectors] button. 

3. Click the mouse over an empty line with the ellipsis symbol in the Boundary Conditions Vectors 

pane of the vectors dialog. The system enters the vector-defining mode. All vertices of the active 

section/guide get highlighted. The following filter tuning options appear in the automenu: 

 <A> Select All Points 

 <N> Select 3D Nodes 

 <X> Select Vertices 

 <K> Select Points on Edges 

The first option is active by default. 

4. Define the vector in space. There are several ways of defining a vector. The difference is in the 

ways of defining the start point, direction and the length of the vector. 

The start point can be defined as follows: 

 At a vertex on the section/guide. Pick with the cursor 

one of the section/guide vertices. The name of the 

vertex is entered in the “First Point” box of the Vectors 

dialog. 

 In a 3D node constructed on an edge of the section or 

guide. Pick a 3D node with the cursor on the section 

(guide). The name of the 3D node is entered in the 

“First Point” box of the Vectors dialog. 

 At any position on any edge of the section (guide) by 

defining the parameter of the point position on the 

edge. The point is created by picking anywhere on the 

section (guide) edge. The edge name is entered in the 

“First Point” box. The position of the point is defined 

by the parameter along the edge. The parameter takes 

values from 0 to 1 and can be modified.  

The vector-indicating arrow is drawn from the selected point on the skeleton in the 3D window.  

Upon specifying the start point, additional parameters become accessible in the Vectors dialog box for 

defining the vector direction. The direction of the vector can be defined in one of the following ways: 

 In absolute coordinates, assuming that the start point of the direction vector is located at the origin, 

<0,0,0>. With optional selection of a local coordinate system, the direction is computed in the relative 

coordinates. 
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 In spherical coordinates. Two angles must be specified to define the vector direction. 

 

 By selecting the end point. Select an object defining a point in the three-dimensional space – a 3D 

node, a vertex, an arc center, etc. When switching to the direction defining mode by the second point, 

the automenu provides the following option with a pull-down list of filters: 

 

 <S> Select Second Point of Vector 

 From a direction-defining element. This can be an edge, an arc, a face, a flat 3D path or 3D profile, a 

surface of revolution, a coordinate system. The direction is derived from the element itself. It can be, 

for example, the normal direction to a flat element, or the direction along an axis of revolution. 

 

The following option activates in the automenu when defining the direction from an element: 

 <D> Select Vector Direction 

 

To define a local coordinate system, click in the LCS: box. The following option will appear in the automenu: 

 <L> Select LCS 

Select a local coordinate system in the 3D window or in the model tree. This will let you define coordinates 

of the direction vectors relative to the selected coordinate system. A separate coordinate system can be 

defined for each vector. 
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5. A section allows vector conditions of two types. 

The type of a condition is defined for all vectors 

constructed on one skeleton element 

simultaneously. The selection is done from the 

list in the Vectors dialog box: 

 Vector length definition. 

 Scale factor definition. In this case, the 

operation automatically computes the 

absolute value of the derivative along the 

specified direction and multiplies it by the 

scale factor. 

 

6. (Optional). More than one vector can be defined for a single skeleton element. To define a new 

vector on a skeleton element that is already in use, proceed to the item 3. 

II. Defining vectors at match points 

The vector is defined at a match point according to the same rules as the ones described above for the 

skeleton elements.  The  only  difference  is  that  the  match  point  selected  for  defining  a  vector 

becomes 

automatically the start point of the vector. Do the following steps to 

define a vector at a match point: 

 Switch to the [Matches] tab of the operation dialog. 

 In the Matches list, select the desired sequence of match points. 

 In the Points list, select the desired match point. 

 Call the Vectors dialog box by pressing the [Vectors] button. 

 Set the Vector at Point flag. This creates a new vector in the 

selected match point. 

 Define the vector direction and length (see above).  

Using the created loft in a Boolean 
To create a Boolean operation, do the following: 

Turn on the Boolean creation mode by the automenu option: 

 <Ctrl+B> Select original body for Boolean operation 

A Boolean is created when the icon is pushed. 

Select the type of the operation from the pull-down list under the above option: 

 <Ctrl+'+'> Addition 

 <Ctrl+'-'> Subtraction 
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 <Ctrl+’*’> Intersection 

 <Ctrl+l> Smart mode 

 

Operating principles of the Smart mode: 

 If the body being created and the existed selected body have intersection of volumes - the 

type of Boolean operations: subtraction. 

 If the body being created lies entirely within the selected body - the type of Boolean 

operations: subtraction. 

 If the body being created touches and selected body touch each other - the type of Boolean 

operations: addition. 

 If conditions set out above are not met, or a selected body lies inside the created, or error 

occurred determining the type of penetration, then, Boolean type is not defined - the Boolean 

operation will not be created. 

Select the target body for the Boolean (optional in some cases), using the automenu option: 

 <Ctrl+T> Select Target Body for Boolean 

If only one body exists in the scene, it is selected automatically. The new body created by the loft 

operation becomes the tool body of the Boolean. 

Upon confirming operation creation, first the body is created by the loft operation, and then the specified 

type Boolean is performed. 

Setting Additional Operation Parameters 

The “Periodic” flag is used for creating closed bodies or surfaces. If this flag is set, the end section will be 

connected with the start. This parameter can be set if the start and end sections are not single-point 

sections and if no special conditions are defined for the start and end profiles.  

  

If guides are used together with the “Periodic” attribute then the guides must be closed. 



Loft 

495 

      

The Linear flag – if set, ruled surfaces are created, splines otherwise. A 

ruled surface is produced by sweeping a straight-line generatrix 

between two sections.  

The flag Thin-walled. If sections are defined by elements of sheet 

geometry then this attribute defines creation of a surface instead of a 

solid body. 

 

 

Keep initial splitting. When the option is enabled, boundaries of body surfaces are created based on the 

initial splitting of sections. The option allows you to create an unfolding of the body without using 

additional commands. 

 

Optimization Parameters 

The Tolerance parameter specifies the maximum allowed gap between profiles and guides. Thus, for 

example, setting rough (large) tolerance in some cases allows handling a situation when the sections and 

guides do not intersect, but pass near each other. The tolerance defines the distance between them that 

the system can ignore by assuming that the guides and sections do intersect. Besides, the tolerance affects 

the minimum size of a profile edge that is defined as ten times the tolerance value. Consequently, the same 

limit is used as the minimum distance between two distinct match points on a profile, as well as between 

start points of boundary conditions defining vectors. The lower tolerance limit is 10-8. However, keep in 

mind that a too small tolerance may slow down the system operation. The system default tolerance is 10-

5.  
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The Simplify geometry flag is used for simplifying the geometry and topology of the resulting surface. 

With this flag on, analytical surfaces are created instead of splines whenever possible, such as a torus, a 

cylinder, a sphere and a plane. 

 
 

Blend Parameters 

If the resulting body is solid then it can be applied blend and chamfer options. Blending and chamfer 

creation can be done on the source and target surfaces independently. 

Source blend. Setting this attribute defines the mode of edge blending on the original surface, that is the 

surface on the side of the start section. Blending is done in the way of “Round” or “Chamfer”. The parameter 

of the blend is defined in the next box. 

Target blend. Setting this attribute defines the mode of edge blending on the target surface, that is the 

surface on the side of the end section. Blending is done in the way of “Round” or “Chamfer”. The parameter 

of the blend is defined in the next box. 
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SWEEP 

Sweep operation allows creating a solid body by sweeping a contour along a spatial path. This operation 

belongs to the family of so-called “kinematic” operations, as it results in creating a body swept by the 

original contour as the latter is moved along a guiding path. Depending on the type of original contour 

geometry (the contour can have wire or sheet body geometry), the operation will yield a sheet or solid 

body. As the contour is being swept along the path, its orientation, twisting and scaling can be controlled. 

OPERATION MAIN CAPABIL IT IES  

Contour 

Any object with wire or sheet body geometry can be used as the original contour. A multi-contour 3D 

profile can be used as well. Sweeping a contour means placing its multiple instances along the selected 

path. A contour instance will be referred to as an intermediate section. To define an intermediate section, 

the system calculates orientation of the coordinate system of that intermediate section. The original 

coordinate system is calculated as the reference for the original contour orientation. A contour instance 

creation is done by transforming the original contour to the calculated coordinate system of a given 

intermediate section.  

    

The original coordinate system is calculated at the start of the path. Two of its axes are set perpendicular 

to the path, and one is tangent to the path at the start point. The original contour position is fixed with 

respect to the original coordinate system. The contour sweeping is done by placing the original coordinate 

system together with the contour in other points of the path, in which the coordinate systems are defined 

for the intermediate sections. 

Control Over Contour Orientation 

Different geometry can be created, depending on the position of the intermediate sections with respect to 

the path. One of the three types of the contour orientation can be specified when creating the operation: 

- Perpendicular to the trajectory. The X-Y plane of the intermediate section coordinate system is 

always oriented perpendicular to the trajectory. The tangency vector at the point of the section 

creation defines the Z-axis of the local coordinate system. 

This mode is primarily for flat contours. When defining the operation, the plane of a flat contour is always 

oriented perpendicular to the guiding path in each intermediate point.  
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In case of non-planar contour the system automatically calculates some “mean normal” that is used for 

orienting the contour. We recommend using additional correction of the original contour position (see 

section “Correction of Contour Original Position”) in order to get a predictable result. 

When using non-planar trajectory, condition of perpendicularity is not sufficient for obtaining a desired 

result due to twist of the profile around the trajectory. In these cases it is possible to additionally define 

fixing direction. Specifying fixing direction can change the method of constructing coordinate systems of 

intermediate sections. The variant of a change depends on the selected method of interpretation of the 

fixing direction: fixing by path and direction, fixing of rotation. 

Vector fixing the direction should not coincide with the tangent to the trajectory at any point of the 

trajectory. 

Fixing by path and direction: tangent to the trajectory at each point of the trajectory is projected onto the 

plane perpendicular to the fixing direction. The coordinate system of the intermediate section is 

constructed from obtained projection of the tangent to the trajectory and fixing direction. 

Fixing of rotation: the coordinate system of the intermediate section is constructed by the tangent to the 

trajectory at the given point of the trajectory and by the cross product of the fixing direction vector and 

the tangent. 
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- Parallel to the original profile. The coordinate axes of each intermediate section are oriented 

parallel to the axes of the original coordinate system. Sweeping in this way results in the parallel 

translation of the original contour. 

   

- By guides. The operation is created by sweeping a contour along the trajectory while orienting 

the contour towards the points on the additional guides. At the same time, one of the guides 

also defines the contour scaling law. In this way, the guides are required to be smooth (no 

corners). This is a special way of creating the operation that will be discussed in a separate topic 

(see below). In some particular cases faces can be used for defining only orientation (direction) 

of the intermediate sections. 

Trajectory and Guides 

To define this operation, specify the trajectory path and, optionally, one or two guides. The contour is 

swept along the trajectory path, which must always be defined. 

Any object with wire geometry can be used as the trajectory path. Most commonly, the trajectory is defined 

using a 3D path. However, one can also use 3D profiles, a chain of edges, loops, etc.  

Two additional guides are necessary for defining particular twisting and scaling laws for intermediate 

sections. 

Correction of Contour Original Position 

The original contour position can be additionally corrected by selecting one or three additional 3D points. 

One point defines the contour snapping to the start of the path. Contour orientation in this case depends 

on the selected orientation method. If the option “Profile is perpendicular to path” is set, the plane of the 

flat profile is reoriented orthogonal to the path at the start point. When using non-flat contours, the system 

automatically calculates some “mean normal” that is used for orienting the contour “plane”. If the option 

“Profile is parallel to source profile” is set, the contour is moved to the start point of the trajectory path by 

parallel translation. 
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In some cases, one point may not be enough for correcting the original contour position since it does not 

fix the contour rotation about its normal. One can select two additional points in order to specify additional 

contour rotation about the normal. The second selected point, together with the first one, will determine 

the original orientation vector (similar to a 2D fragment fixing vector). The third selected point, together 

with the start of the trajectory, will define the target orientation vector. The projection of this vector on the 

“plane of the contour” will determine the angle of additional rotation of the contour. If a non-flat contour 

is used, the “plane of the contour” is determined by the calculated “mean normal”. 

                    

This drawing is located in the library “Examples”, in the folder “3D Modeling\Sweep\Drawing 3.grb”. 

When using non-flat contours, even three-point contour positioning does not guarantee the 

expected result. In such a case, we recommend setting up the desired contour orientation before 

starting the operation “Sweep”. For example, one can create the contour in the desired position 

from the beginning or, if that is not feasible, use coordinate system-based copying. 

Contour Twist 

One can define additional contour twist along the sweeping trajectory path. The rotation angle of the 

intermediate sections can be defined by table or by using additional geometry – a guide path or surface. 

This approach allows quite different ways of calculating the contour rotation angle. 

When using a table for defining twist, rotation by the specified angle of 

each intermediate section is done about the Z-axis of the calculated 

coordinate system. The table appears as a set of trajectory points, whose 

position is defined in percent of the trajectory length, with a fixed value 

of rotation angle entered against each point. When setting up the table 

of rotation angles, one can use special draggers. This functionality is 

convenient, for example, for creating sweeps with the surface twisted as 

a spiral. 
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The choice of a path or surface is determined by the specifics of a particular task. For example, if the 

contour is expected to trace a specified curve throughout sweeping, use a guiding path. Alternatively, if 

one needs to create an auxiliary surface touching another surface, staying tangential to that other one, 

then a surface can be selected for the swept contour orientation. In this way, the tangency condition will 

be maintained between any intermediate section and the surface. 

       

       

When creating bodies using contour twisting (defined by a guide or surface), make sure of the 

correct original position of the contour. Thus, in the first example the contour must be originally 

directed towards the start point of the additional guide. In the second example, the contour shall 

make tangential transition to the adjacent surface in the original position. 

The system uses an additional guide or surface for calculating auxiliary vectors defining a rotation angle 

for each intermediate section. The rotation angle is calculated as the angle between the directions of the 
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auxiliary vector at the start point of the trajectory and at the current point, for each intermediate section. 

If the calculated auxiliary vector does not lie in the X-Y plane of the coordinate system of an intermediate 

section, its projection on that plane will be used. 

When a surface is used for calculating the auxiliary vector, its direction is calculated in a general case as 

follows. A point is identified on the surface that is nearest to the origin of the coordinate system of an 

intermediate section. The sought direction is a tangency direction constructed at this point. Therefore, best 

results are achieved when the used surface is closest to the trajectory. In this case, the trajectory can be 

defined by using, for example, edges of the surface. 

If a guide is used for calculating rotation angles of intermediate sections, you can select one of the four 

methods for calculating the auxiliary vector. The methods for calculating auxiliary vectors by additional 

guides are described in a separate topic (see below). 

Contour Scaling 

When sweeping the contour, one can define an additional law for scaling the contour with respect to the 

origin point of a section coordinate system or any other point in the space, related with the section 

coordinate system and moving together with it. The scale factor can be specified in a table or by using an 

additional guide. 

The table appears as a set of trajectory points, with a fixed value of the scale factor entered against each 

point. In the rest of the points along the trajectory path, the value of the scale factor is interpolated by the 

system automatically. 

     

When using an additional scaling guide, the scale factor of an intermediate section is calculated as a ratio 

of the vector length in the current point of the trajectory to that in the first section. The methods for 

calculating auxiliary vectors by additional guides are described in a separate topic (see below). 
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When using a scaling reference point, the way of scaling the contour with respect to that point can be one 

of the following: 

 Scale the distance from the origin on the trajectory to the reference point, keep the contour snapped 

to the reference point, but don’t scale the contour; 

 Scale the contour only; don’t change the distance between the reference point in the trajectory; 

 Scale both the contour and the distance to the reference point. 

    

Sweep Creation by Guides 

Creating a body by guides requires a contour, a trajectory and at least one additional guide. The first 

additional guide is used for calculating the first auxiliary vector for each intermediate section. The 

intermediate points for defining auxiliary vectors on the trajectory and additional guides are always 

calculated “by parameter”. This vector is simultaneously used for scaling an intermediate section and for 

orienting it (by calculating the direction of one of the axes of the intermediate section coordinate system). 

The direction of the second axis of the intermediate section coordinate system can be calculated 

automatically (as the cross product of the calculated auxiliary vector and the tangent to the trajectory at 

the origin point of the intermediate section coordinate system).  

To define an intermediate section orientation other then offered by the system, one could use a second 

additional guide. That will help the system calculate the second auxiliary vector for each intermediate 

section. The two auxiliary vectors will define the X-Y plane of the intermediate section coordinate system. 

The Y-axis of the intermediate section coordinate system will be oriented in the direction closest to that of 

the second auxiliary vector. 

The approach to solid body creation by using an additional guide or guides serves certain specific goals, 

such as closing a gap between two curves by a surface obtained by sweeping a specified contour. Creating 

this kind of bodies assumes that the original contour will rest at one of its ends on the start point of the 

trajectory path, and at the other end - on the start point of the additional guide. In theory, some kind of a 

result can be obtained by using various orientations of the original contour, however, the result will be 

rather hard to predict. 
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If, for example, the original wire contour rests at its ends on the start points of the trajectory and an 

additional guide, the resulting surface connecting the trajectory and the additional guide will follow the 

shape of the original contour. 

  

Faces can be used instead of the first and second additional guides. Orientation of the intermediate 

sections will be defined by auxiliary vectors calculated as perpendiculars to surfaces at points nearest to 

trajectory points. In practice surfaces adjacent to trajectory are mostly used. The use of surfaces for defining 

contour twist is applicable when the first two methods of contour orientation (“Perpendicular to the 

trajectory” and “Parallel to the original profile”) cannot be employed. The following example demonstrates 

sweep operation when the contour-segment is oriented perpendicular to the auxiliary surface in every 

point of the trajectory. 

  

Methods for Calculating Auxiliary Vectors by Guides 

Auxiliary vectors are used by the system for orienting coordinate axes of an intermediate section (rotating 

the section) or for calculating the scale factor for an intermediate section. When using an additional guide, 

the auxiliary vector calculation is done as follows. The auxiliary vector of each intermediate section starts 

on the trajectory –  at the origin of the coordinate system of the intermediate section.  The  end point  of 

an auxiliary 
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vector, that defines its direction, is located on the 

additional guide. Calculation of such end point 

for defining auxiliary vector can be done by one 

of the four methods. 

By minimum distance. The end point of the 

vector will be the point on the guide nearest to 

the vector start on the trajectory. 

 

Perpendicular to the path. A plane is 

constructed through the start point 

perpendicular to the trajectory. This plane must 

intersect the guide. The end point is defined as 

the intersection of the plane and the guide. If no 

intersection is found between the plane and the 

guide for some point on the trajectory, an error 

in operation regeneration is output. 
 

Follows are examples of using options “Perpendicular to the path” and “By minimum distance”: 

 
Defining elements 

 
Operation created by the 

option “Perpendicular to 

the path” 

 
Operation created by the option “By 

minimum distance” 

Guide

Calculated 
vector

Trajectory

Vector end point

Vector start point

Guide

Calculated vector

Trajectory

Start point

End point

End point 
defining plane

Plane normal, tangent
to trajectory at the start point
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By parameter. Position of any point on a curve can be 

defined by a parameter – a value defining the point 

position in percent of the curve length (0 – at the start of 

the curve, 1 – at the end of the curve). The point on the 

guide is defined by the same parameter value as the vector 

start point on the trajectory. This method of calculating an 

auxiliary vector is least demanding on the orientation and 

length of the guides. 

This option is automatically used when orienting sections 

“By guides”. The user can also turn it on manually when 

defining the 

 

scaling or twisting law, for example, in situations, when the additional guide is shorter than the trajectory, 

or other methods are inadmissible. Here is an example of using the option “By parameter”: 

 
Defining elements 

 
Operation created with option  

“By parameter” 
 

By offset. First, the length of the trajectory portion is calculated from 

the start of the curve to the auxiliary vector start. The vector end is 

then found by the same length on the guide from the origin. In this 

method, the length of the additional guide must be greater than or 

equal to the length of the trajectory. 

This option can be used when, for example, only a portion of the 

additional guide shall be used that is equal to the total length of the 

trajectory.  

Follows is an example of using the option “By offset”: 

Trajectory

Guide
Calculated vector,
parameter = 0

Calculated vector,
parameter = 0.5

Calculated vector,
parameter = 1

х1
х2

х1

х2

Trajectory

Guide

Calculated 
vector
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Defining elements. 

The contour is swept parallel to the original position 

 
Operation created by the option 

“By offset” 

STEPS OF OPERATION CREATION  

To create the operation, use the command 3SW: Create Sweep: 

Icon Ribbon 

 

3D Model → Create → Sweep 

Keyboard Textual Menu 

<3SW> Operation > Sweep 

The general algorithm of the operation creation is as follows:  

 Select an option of contour orientation. 

 Select a contour. 

 Select elements defining the path. 

 Define correction of the contour original position. (Optional) 

 Defined additional guiding paths or a surface. (Optional) 

 Define operation parameters. (Optional) 

 Confirm operation creation. 

Selecting an Option of Contour Orientation 

We recommend defining the contour orientation first, since that will determine the set of options offered 

by the system in the following steps.  

Option selection is done in the property window of the operation, in the provided combo box with a pull-

down list. The pull-down list contains all three possible ways of orienting the contour – “Profile is 

perpendicular to path”, “Profile is parallel to source profile”, “By guides”. The first and, apparently, the most 

often used setting is the system default. Therefore, if the contour is to be oriented perpendicular to the 

path, the contour orientation option selection can be skipped. 
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Selection of the first two options produces an automenu with options for selecting trajectories, defining 

the correction of the original contour position and selecting twist and scale guides. Selecting the option 

“By guides” leaves in the automenu the options for defining the correction of the original contour position 

and selecting first and second guides. 

Contour Selection 

The first option that turns on automatically in the automenu upon entering the command is the contour 

selection: 

 <R> Select Contour 
 

The option contains a set of selector filters helping selection 

of the desired objects. There is a pull-down list behind the 

icon that appears after prolonged pressing . A contour can 

be defined by any object with sheet or wire geometry, such 

as a 3D profile, 3D path, edge, face, surface, etc. 

The element selected for defining the contour is highlighted 

in green (by default). 

 

 

Trajectory Selection 

After defining the contour, the system automatically activates the option for the trajectory path selection. 

 <T> Select trajectory 
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The option also contains a set of selector filters 

helping selection of the desired objects. In the pull-

down list, you can define what objects with wire 

geometry shall be selectable for defining the 

trajectory, such as a 3D profile, 3D path, edge, face, 

surface, etc. 

The element selected for defining the trajectory is 

highlighted in green (by default). 

 

Once a trajectory is selected, the operation confirmation icon  becomes accessible. The specified data 

is already enough to create the operation. The selected contour will be swept from its current position 

along the trajectory “perpendicular to the path” or “parallel to the source contour”. 

Defining Correction of the Contour Original Position 

Once the trajectory is selected, the system offers to define correction of the contour original position. If 

this step is not necessary, you can proceed to further steps by manually selecting the respective automenu 

options.  

The system will first offer selecting the first point of the contour attachment: 

 <F> Select 3D Node as profile starting location 
 

Various suitable objects can be used for defining the point. The 

option contains a pull-down list for tuning the system for selecting 

objects of the desired type. 

Once the point is selected, the new image of the contour snaps to 

the start of the trajectory. The image is oriented according to the 

selected contour orientation option and is snapped to the start of 

the trajectory at the selected point. 

 

After selecting the first point, proceed to further steps. By default, the system offers more correction 

options, activating those for defining the second and third points: 

 <S> Select second 3D Node for locating Profile 

 <O> Select 3D Node for locating Profile 

After selecting the second point, nothing is updated on the screen. The system waits for the third point 

selection. After selecting the third point, the image of the corrected contour will be rotated to snap to the 

third point according to the rules described in “Operation main capabilities”. 
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Specifying Fixing Direction and Contour Orientation Fixing Method 

Specifying fixing direction is not a necessary operation and can be omitted. 

Fixing direction can be specified only if the contour twist was not defined (in a table form or with 

the help of guides). 

To specify the vector fixing the direction, the following automenu options are used: 

 <L> Select direction 

 <1> Select First Point of Direction  

 <2> Select Second Point of Direction 

The option  allows the user to define the vector fixing the direction by specifying one 3D element (edge, 

straight path, etc). Options  and  are used for specifying the direction vector with help of two 3D 

points. 

The choice of fixing (fixing by path and direction, fixing of rotation) is 

selected from the drop-down list in the dialog of the properties window.  

Defining Contour Twist 

Contour twist can be defined by a table or by using auxiliary geometry. Let's review all approaches. 

Twist definition by table 
Twist is defined with the help of the controls on the tab “Angle” of the property window. 

To enter new contour twist parameters, press the 

button . The first time you push it, two special 

entries are created, “Start” and “End”. Subsequent 

pushes add new intermediate points along the 

trajectory. Numerical data for each defining point is 

entered in the property window. Each point position is 

defined in percent of the trajectory length. The section 

rotation angle is entered in the “Angle” box, in degrees. 

To delete a defining point, select it, and then press the 

button . 

 

Position of the intermediate points may be specified with the help of a graph. Use  button in the 

properties dialog for this purpose. This button will open the graph editing window. The range of definition 

by X is 0-100 corresponding to the percentage from the length. The value area is not limited. See more 

details on operations with graphs in chapter “Graphs”. 

To facilitate definition of twist parameters, auxiliary elements are displayed in the scene – draggers and 

decorations. 
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A decoration is an image of an intermediate section for each defining point, together with an arrow 

specifying the direction and the rotation angle. Arrows are positioned along a spiral, showing the full 

rotation angle. This is convenient when the rotation angle exceeds 360 degrees. Decorations of an inactive 

point are drawn in the yellow color, while the decorations of the point being currently manipulated – in 

the red. 

The dragger is a pair of blue segments indicating the zero angle and the current angle. There are two 

handles at the ends of one dragger segment. Dragging those by the mouse with the depressed bottom  

modifies the value of the rotation angle and the point position on the path. As the pointer approaches a 

dragger handle, it assumes a specific shape. 

Use of auxiliary geometry for defining twist 
A twist-defining guide can be selected by the option: 

 <W> Select guide for defining twist law 
 

Any object with wire geometry can be used as a guide. 

After selecting a guide, the dialog in the properties window is automatically 

switched to the display of the pull-down list from which the method of 

calculation of rotation vector can be selected. You can choose from four 

options: “Minimal distance”, “Normal to path”, “By parameter”, “By offset”. 

You can select a twist-defining surface by the option:  

 <N> Select surface for twist law 

The surface can be defined by a face, a sheet 3D profile or a surface operation. 

When using auxiliary geometry, draggers and decorations are not available. 

 

Defining Contour Scaling 

Contour scaling can be defined by a table or by using auxiliary geometry. Let's review all approaches. 

Scale definition by table 
Scaling is defined with the help of the controls on the tab “Scale” of the property window. The way of 

defining parameters is the same as that of defining the twist by table. 

The scale law as well as the twist law can be defined with a graph. Use  button in the properties dialog 

for this purpose. The range of definition by X is 0-100 corresponding to the percentage from the length. 

The function values must be positive only. See more details on operations with graphs in chapter “Graphs”. 

Additionally, the property window has a pull-down list for adjusting parameters of scaling with respect to 

the attachment point. 

When defining the scaling law by table, draggers and decorations are also displayed in the scene. 

A decoration is an image of an intermediate section for each defining point. Decorations of an inactive 

point are drawn in the yellow color, while the decorations of the point being currently manipulated – in 
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the red. Additionally, two circles are drawn – a blue one, and a red or yellow one (depending on whether 

the given point is active). The circles help quickly evaluate the amount of scaling. The size of the blue circle 

is maintained constant, while the other circle changes according to the scale factor. A provided dragger is 

a red or yellow arrow along the radius of the second circle. Two handles at the ends of the arrow allow 

changing the position of the point and the value of the scale factor. 

Selection of scaling guide and reference point 
A scale-defining guide can be selected by the option: 

 <A> Select guide for defining scale law 

Any object with wire geometry can be used as a guide. The system can be tuned for selecting a certain 

type of objects by using the pull-down list behind the option. The selected object will be highlighted in 

green (by default). Once the guide is selected, a combo box in the property window becomes available for 

selecting a scale vector defining option. 

The scaling reference point can be defined by the option: 

 <V> Select scale point 

You can select any objects suitable for defining a 3D point. 

Once the reference point is selected, a combo box becomes accessible in the property window for selecting 

an option of scaling with respect to the point. You can choose from the three items – “Maintain size”, 

“Maintain distance”, “Change size and distance”. 

Sweep Definition by Guides 

The difference of the “By guides” approach from “Perpendicular to path” and “Parallel to source contour” 

is that you select a single guide for defining both twisting and scaling. In this way, you can’t select the 

method of vector calculation or the scaling point. Instead, you define the correction of the original profile 

orientation by one or three points. The correction makes the system work in the same way as under the 

option “Perpendicular to path”.  

The first guide is selected by the option activated automatically upon choosing “By guides” type: 

 <W> Select guide for defining scale and twist 

Any object with wire geometry can be selected. However, the guide must be smooth for successful 

operation creation. The selected object is highlighted in green (by default). 

The guide surface that defines the twist law can be selected with option: 

 <Ctrl+W> Select guide surface for defining twist 

The surface can be defined by a face, a sheet 3D profile or a surface operation. When using auxiliary 

geometry, draggers and decorations are not available. 
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If additional refinement of the intermediate section orientation is necessary, you can select a second guide, 

using the option: 

 <A> Select guide for defining orientation 

Contour orientation by means of the guide surface can be defined with option: 

 <Ctrl+A> Select guide surface for defining orientation 

Additional Operation Capabilities 

Reverse Directions. When turning on this flag the direction of the trajectory 

is changed to reverse. 

Start at Source Contour. This setting is provided for the cases of using a 

closed trajectory without a well-defined start point. When the flag is turned 

on, as a start point (the point from which the body will be constructed along 

the trajectory), the point of the trajectory closest to the contour is 

automatically selected. 

Simplify Geometry. This setting forces creation of analytical surfaces (planes, 

cylinders, spheres and tori) wherever possible. If the flag is cleared, exact 

spline surfaces are constructed. 

Tolerance. This parameter sets the tolerance for the surface being created – 

deviation of the resulting surface from the exact solution. The units are 

meters. 

Check Self-intersections. This parameter allows the user to correct certain 

cases of self-intersections occurring upon operation creation. 

 

 “Sweep” operation belongs to the family of kinematic operations. Therefore, when defining this operation, 

one can use several additional features supported by majority of kinematic operations: 

 Thin element creation instead of a solid. 

 Thickening walls of a body being created by the specified amount. 

 Blending of the side edges at the start or the end face. 

More details on those capabilities can be found in the chapter “Extrusion”. 

Using the created sweep in a Boolean 
To create a Boolean operation, do the following: 

Turn on the Boolean creation mode by the automenu option: 
  

 <Ctrl+B> Select original body for Boolean operation 
  

A Boolean is created when the icon is pushed. 

Select the type of the operation from the pull-down list under the above option: 
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 <Ctrl+'+'> Addition 

 <Ctrl+'-'> Subtraction 

 <Ctrl+’*’> Intersection 

 <Ctrl+l> Smart mode 

Operating principles of the Smart mode: 

 If the body being created and the existed selected body have intersection of volumes - the 

type of Boolean operations: subtraction. 

 If the body being created lies entirely within the selected body - the type of Boolean 

operations: subtraction. 

 If the body being created touches and selected body touch each other - the type of Boolean 

operations: addition. 

 If conditions set out above are not met, or a selected body lies inside the created, or error 

occurred determining the type of penetration, then, Boolean type is not defined - the Boolean 

operation will not be created. 

Select the target body for the Boolean (optional in some cases), using the automenu option: 
  

 <Ctrl+T> Select Target Body for Boolean 
  

If only one body exists in the scene, it is selected automatically. The new body created by the sweep 

operation becomes the tool body of the Boolean. 

Upon confirming operation creation, first the body is created by the sweep operation, and then the 

specified type Boolean is performed. 

CREATE OPERATION USING FORMING BODY  

There is a possibility to use solid body as the source object, which is moving along selected trajectory in 

the Sweep operation. The body spins around the predetermined axis during movement. The resulting 

“trace” model left by the swept body can be used in further, for example, in Boolean operation. 

Thus, it is possible to simulate trace that leaves a milling cutter when machining. 

The general algorithm of the operation creation is as follows:  

 Select forming body , 

 Select trajectory , 

 Select axis direction of forming body , 

 Select fixing point of axis , 

 Select fixing direction , point for starting position  and used faces of the body  (optional). 
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Operation Options 

Use the following option to select a forming body: 
  

 <M> Select forming body 
  

You may select only solid body as a forming body. You can’t select a sheet metal body or a faceted model. 

It does not matter where the forming body is located with respect to the trajectory. 

The operation will not be created if overall sizes of the forming body are too large in compare with 

the trajectory. It can lead to self-intersections and inability of the operation creation. 

After the body selection, you need to select a trajectory, along which the body will move, using option: 

 <T> Select trajectory 

You can select a planar path or 3D path as a trajectory.  

The trajectory may be closed. You should specify a starting position point on closed vertex to create the 

operation. 

The trajectory should lie in a plane orthogonal to the forming body axis, unless a fixing direction controlling 

the orientation of the forming body is supplied. 

The body will spin while moving along the trajectory. So that you need to select an axis direction using 

option: 

 <A> Select axis direction of forming body 

You should specify an axis fixing point, after selection of the axis.  

 <S> Select fixing point of axis 

The fixing point will determine axis location according to the trajectory. The fixing point lies on the 

trajectory when the body moves along it. 

 

Fixing direction controls the orientation of the forming body according to the trajectory. 

Use the following option to select a fixing direction of the forming body: 
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 <L> Select fixing direction 

You can also define fixing direction by two points using options: 

 <1> Select 1-st point of fixing direction 

 <2> Select 2-nd point of fixing direction 

 

The fixing direction should not have to be in the same direction as the forming body rotation axis. 

If the fixing direction is not the same as the direction of forming body axis, you should additionally specify 

a starting position point. 

 

A 3D trajectory should match the following requirement: all curves of the trajectory should be 

analytic curves, a C2 non-rational b-curves or a helical curves created by a Parasolid function. 

Fixing direction should not coincide at any point with the tangent to the trajectory. 

More information about fixing direction can be found in the “Operation main capabilities” section. 

 

То specify a point for starting position of the forming body use option: 

 <V> Select point for starting position 

Location of the point on the trajectory affects the overall shape of the resulting body. 
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You can select body faces of the forming body using option  Select used body faces for simplification.  
  

 <F> Select used body faces for simplification 
  

Only selected faces will be used for the operation. If Reverse flag is set, the selected faces will not be used 

for the operation. 
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The resulting body can be used for Boolean operation.  

More information about Boolean operations can be found in "Boolean operation" chapter. 

If the forming body should be at some distance from the trajectory, you should disable the Align fixing 

point of the body rotation with trajectory starting point flag. 

 

In this case, after you set all the basic parameters of the operation, it is necessary to choose a fixing 

direction and a point for starting position. 

If the forming body does not lie on the trajectory, the trajectory should be G1 continious. 

 

For example, the fixing direction may match the direction of the axis of the forming body rotation and the 

point for starting position may be chosen at the beginning of the trajectory. 
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Example of Operation Creation using Solid Body  

For example, you can model a groove on the door using the operation. For this purpose a trajectory on 

the treated body and forming body of the desired shape were created: 

Trajectory on the treated body: 

 
Forming body: 

 

After command activation, you need to select a forming body and a trajectory: 
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For the forming body you need to define axis of rotation  and fixing point of rotation axis . 
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When the forming body is moved along the predetermined trajectory, it simultaneously rotates around 

the defined axis, thereby forming the groove. The Boolean operation of Subtraction is applied after that. 

The result is the following: 

 
 

The example can be found in: "Examples \Release 15 new features\Sweep solid body along path" file 

"Sweep solid body along path.grb".
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PARAMETRIC SWEEP 

MAIN CONCEPTS  

A parametric sweep is a variation of a common sweep. This operation is used for creating bodies with 

complex surface geometry. The resulting body is obtained by “sweeping” a profile along an arbitrary or 

specially defined spatial trajectory. In this case, the system allows defining the variation of the profile 

parameters as a function of its position. 

“Sweeping” of the profile is realized by multiplicating the original profile. The thus created set of profiles 

shapes up the resulting body. The body can be closed. Depending on the profile geometry type (sheet or 

wire), the resulting body may be a solid or a sheet. 

  

The driving parameter of the operation is the profile instance number (“copy number”). Numbering of 

profile instances (“copies”) starts from 1 and is automatically incremented by 1 per an instance as the 

operation creation progresses. 

The so-called current instance coordinate system is computed for each instance of the profile. Each 

instance of the original profile is carried over from the original coordinate system to the computed 

coordinate system of the current instance. The user can select one of the model’s local coordinate systems 

as the original coordinate system. If no local coordinate system is selected, then the global coordinate 

system is used as the original coordinate system. 

The origin and orientation of the coordinate axes of the current instance can be done in two ways. One 

can specify the rules of varying the coordinate system parameters by an expression. The other way implies 

the use of a 3D Path or another body surface for positioning the coordinate system of the current instance 

in space. Each way will be described in details below. The user controls the position and orientation of each 

profile instance by manipulating the respective coordinate system. 

The operation parameters dialog box provides controls over the coordinate system parameters of an 

instance. The two main types of the operation parameters are - driven parameters and driving parameters. 

Driven parameters – are those whose values are computed automatically as the operation creation 

progresses. Independent variables can be used for reading the values of such parameters.  

Independent are those system variables that are assigned a specific value, rather than an expression. 

Those do not depend on other system variables. On the contrary, some of the parameters of 2D or 

3D constructions may depend on such variables, as well as other driven, or dependent, variables.  
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A name of an independent variable used with driven parameters is always selected from the list of 

already existing independent variables in the system. 

The parameter Number of Copy is always driven. Always use an independent variable to read this 

parameter for getting the current copy number as the operation creation progresses. 

How to use driven parameters? 

You can enter the name of an independent model variable in a driven parameter value box to establish a 

relation between the parameters of positioning an instance in the space and the parameters defining the 

shape of that profile instance. After computing the position of the coordinate system of the current profile 

instance, the independent variables assigned to the driven parameters are updated with the respective 

current values. If an assigned independent variable is somehow involved in defining the profile geometry, 

then, at each instance creation, the values of the driven parameters will be passed through that variable 

on to the related model parameters. Thus, the shape of the profile will be recalculated depending on the 

values of the driven parameters. 

The variable that reads the current copy number can be bound to record numbers in a database. 

Driving parameters are the fields whose values are defined by the user. An arbitrary expression can be 

entered in the input box of a driving parameter. Such an expression can include any system variable. For 

example, you can include the variable that represents the copy number. In this case, you will get a 

dependency of the parameter on the copy number via that specified expression. 

The computations on the way of the operation creation are performed in the following order: the instance 

counter (“copy number”) is incremented; the driving parameters are computed; the driven parameters (if 

any) are computed; the original profile is recalculated with the current values of the variables; the thus 

obtained instance is positioned.  

STEPS OF OPERATION CREATION  

Follows are the means of calling the command: 

Icon Ribbon 

 

3D Model → Create → By Parameters 

Keyboard Textual Menu 

<3SA> Operation > By Parameters  

The following icons become available in the automenu: 

 <R> Select Contour 

 <F> Cancel contour selection 

 <1> Select Curve defining position of coordinate system 

 <2> Select Curve defining X direction of coordinate system 
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 <3> Select Curve defining Y direction of coordinate system 

 <4> 
Select Surface defining X direction of coordinate 

system 

 <5> 
Select Surface defining Y direction of coordinate 

system 

 <6> Select source LCS 

 <7> 
Cancel selection of elements defining coordinate 

system 

Depending on the way of defining the coordinate system of the current instance, some parameters may 

appear as driving or driven. In this case, there are two main approaches to creating a body with 

parametrically varying profile: 

 The approach of free instance orientation 

 The approach of orienting instances by paths or surfaces 

In each case, different automenu options are used, and a different sequence of steps is involved for defining 

the necessary elements and operation properties. Follows are the descriptions of each approach presented 

separately.  

Free Instance Orientation Approach 

To create a parametric sweep, simply select a 3D profile, specify the number of instances and assign an 

independent variable to the parameter “Number of Copy”. Using the variable that follows the instances 

enumeration, one can create certain dependencies for the driving parameters, as well as for 2D or 3D 

constructions, which, in turn, define the shape and position of the 3D profile. 

One can select the 3D Profile by using the respective option in the automenu: 

 <R> Select Contour 

The number of profile instances can be specified in the operation parameters dialog box on the tab 

Operation. 
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Besides the “Number of Copies” parameter, this tab also contains an accessible option “Closing”. 

With this option on, the body being created from the set of the sections (the set of the instances of 

the original profile), will be smoothly closed, as if the first section was selected twice. 

After defining the number of instances, one can proceed to the tab “Variables”. This tab has two types of 

parameters, grouped under the names “driving parameters” and “driven parameters”. 

 

When creating the operation following this approach, the only driven parameter is the copy number, while 

the driving are the parameters responsible for positioning the current profile instance in space. For 

convenience, four groups of driving parameters are defined: Position, X axis direction, Y axis direction, Z 

axis direction. 

The Position group controls the X, Y, Z coordinates of the point defining the origin of the current instance 

coordinate system. 

The rest of parameters define the three vectors used for orienting the coordinate system of the current 

instance.  

You can explicitly describe the position of the current instance coordinate system as a function of the copy 

number. To do this, define the required dependency in the group of driving parameters (by entering the 

names of existing variables that directly or indirectly depend on the copy number). 

Each vector defining the direction of a coordinate system axis of an instance is defined by two 

points. The first point coordinates are <0,0,0>. The coordinates of second points of the direction 

vectors for the current instance’s coordinate system axes are defined by the parameters X, Y, Z from 

the respective group of driving parameters. 

In the case when the vectors defined by the user are not orthogonal or do not make a right-oriented 

coordinate system, the system refines the definition automatically. Axes definition is done in the order: X, 

Y, Z. The X-axis direction is left unchanged, the Y-axis is rotated to yield the 90 angle in the XY plane, and 

then the Z-axis is defined. 
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In the case when only two vectors are defined (for example, the X and Z-axes), then the order of defining 

vectors changes, and the third vector (of the Y-axis) is defined last. 

Each profile instance is obtained by carrying a copy of the original profile from the global coordinate 

system to the computed at the given step coordinate system of the current instance. 

 

Additionally, one can select a local coordinate system by using the automenu option: 

 <6> Select source LCS 

In this case, the selected coordinate system will be used instead of the global one when carrying over the 

copies of the original profile. 

When creating a parametric sweep following the described 

approach, the system computes the position and orientation of 

the current instance of the profile in the following order: 

1. The variable reading the copy number is incremented. 

 

 

2. The absolute coordinates are computed of the origin of the 

current instance coordinate system. The computation is based 

on the expressions entered in the driving parameters fields (the 

group Position). 

 

 

3. The coordinates of the vectors are computed, defining the 

directions of the current instance’s coordinate system axes. The 

computation is based on the expressions entered in the driving 

parameters fields (the group “Direction”) 

4. The coordinate system of the current instance is created in the 

computed point of the origin, oriented according to the 

computed direction vectors.  

5. If the geometry of the 3D profile depends in some way on the variable that reads the current copy 

number, then the profile will be recalculated with the current variable value.  

6. The original profile’s copy is carried over from the original coordinate system to the obtained coordinate 

system of the current instance. If the original coordinate system was not specifically selected, then the 

global coordinate system is used as the original when carrying over a copy of the profile. 
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After computing all instances of the original profile, the result is united in one solid or sheet body using 

spline surfaces. 

Example 1 
 

As a first example, let's create a rather simple model (see the diagram 

on the right hand side). Let's skip the details of creating the auxiliary 

2D and 3D construction elements. Instead, let's briefly review the 

technique itself.  

The file corresponding to this example is located in the library 

“Examples”, the folder “\3D Modeling\By parameters\ By 

parameters 3.GRB”. 

This model can be created by sweeping a 3D profile in the space that 

is indirectly tied to several guides. Let's use four guides in the 2D 

view, two of which will define the elevation view, and the other two 

- the left side view. Three guides are straight lines, and one is a spline.  

   

The horizontal construction line is drawn. The position of this line is defined by the expression  

“H-1”. Therefore, it depends on the variable “H”. 

Since the Number of Copy parameter values sequence begins from one, sometimes a correction (–

1) is required in the expressions where the variable Number of Copy is entered. In this example, the 

first instance of the profile should be located at the base, that this at the coordinate Y=0. 

 

Four 2D nodes are constructed at the intersections of the horizontal line and the guides. These nodes can 

drive the length and width of the profile if attached to vertical lines. A 3D node is created based on one of 

the 2D nodes in order to fix the profile plane. The grooves on the sides of the profile are constructed in 

such a way to always divide its side in four equal parts. The grooves radius linearly depends on the length 

of the profile. 
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We will need two workplanes – the elevation view and the plan view. The first one is needed for 

constructing the 3D node, the second - for the profile. The coordinate system origin is located at the model 

base level (see the diagrams). A straight line is constructed from the origin at the angle of 45 to the 

horizontal. This line is necessary for establishing the projective relation between the guides on the left side 

view and the profile hatch on the plan view. 

 

All constructions are interlocked so that varying the variable “H” causes the following chain of 

modifications: the horizontal line changes its position, that affects the position of the 2D nodes referencing 

the line. The next link in the chain is modification of the profile hatch geometry and repositioning of the 

3D node, to which the 3D profile plane is snapped. Consequently, the 3D profile itself will move in the 

space. 

 

Among the operation parameters, the variable “H” should be assigned the copy number. Specify the 

number of copies in the Operation tab, corresponding to the type of the model, amended as (150+1=151). 

 

It is not necessary to describe the rule for adjusting the instance’s coordinate system, since the original 

profile adjusts its position due to a direct dependency on the copy number. As a result, each instance’s 

coordinate system coincides with the global coordinate system, and, therefore, the current copy coincides 

with the original profile in the position and geometrical parameters. What matters is how the original 

profile moves with variations of the variable “H”, that is, with respect to the copy number. 

The described approach is convenient for using two-dimensional drawing data for constructing a complex 

model. 

 

Example 2 
The second example demonstrates the approach to the model creation, when the exact rule is defined for 

the profile movement. 
 

This example is located in the library “Examples”, the folder 

“\3D Modeling\By parameters\ By parameters 1.GRB”. 

The original data for creating this operation are: a 3D profile; 

a local coordinate system constructed in the center point of 

the profile and oriented with respect to the profile as shown 

in the diagram (the Z-axis lies in the profile plane and is 

directed towards the groove); several independent 

variables.  
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The expressions should be entered in the operation parameters fields, as shown in the following diagrams: 

 

 

The expressions in the “Position” group define the helical trajectory with changing radius. The radius is 

varied by the cosine function. 
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The number of copies (profile instances) is equal to 360 due to the following reason: the 360-degree period 

is used in the expressions of trigonometrical functions. 

The diagram shows that the Z-axis of the original profile coordinate system should always be directed 

towards the center of the spiral (with the groove towards the center), the X-axis – in the opposite direction 

to the Z-axis of the global coordinate system. The expressions describing these rules are entered in the 

respective fields of the driving parameters. The Y-axis is defined automatically.  

The Approach of Orienting Instances by Paths or Surfaces 

Since it is not always possible to describe the rules of the profile instance's parameter modifications by 

expressions exactly, it is sometimes convenient to use 3D paths or surfaces from other bodies for defining 

the position and orientation of the current instance's coordinate system. 

The origin of the current profile instance’s coordinate system is snapped to a 3D path. The position of the 

origin on the paths can be controlled in two ways. 

The X- and Y-axes can be oriented using other 3D paths or surfaces from other bodies.  

Selection of a 3D path for snapping the coordinate system origin of the instances is done by the option: 

 <1> Select Curve defining position of coordinate system 

Selection of elements for defining the orientation of the X and Y-axes is done by the following automenu 

options (the Z-axis is defined automatically): 

 <1> Select Curve defining position of coordinate system 

 <2> Select Curve defining X direction of coordinate system 

 <3> Select Curve defining Y direction of coordinate system 

 <4> 
Select Surface defining X direction of coordinate 

system 

 <5> 
Select Surface defining Y direction of coordinate 

system 

When creating the operation using 3D paths, the operation dialog tabs “Operation” and “Variables” are 

somewhat different from the described above: 
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Accessible in this tab are various options for controlling the axes directions. Which group is accessible 

depends on how many paths were selected altogether: one (for defining the instance's coordinate system 

origin only) or two (for defining the instance’s coordinate system origin and orientation of the X and/or Y-

axes). 

The group Axis direction (for single Path): 

By curvature. The X-axis coincides with the direction of the path's curvature vector. If the 3D path is a 

straight line, then the axis is oriented along the X-axis of the global coordinate system. 

By minimal twist. The X-axis is directed so to provide smooth rotation from the curvature vector direction 

at the path start to the curvature vector direction at the path end. 

The Z-axis is always directed along the tangent to the path at the point of the coordinate system origin of 

the current instance. 

The Y-axis direction, if not defined, is determined automatically based on the X- and Z-axes. 

The group Axis direction (for two Paths): 

By minimal distance (between the paths at the origin). A vector is 

constructed from the instance's coordinate system origin on the first path 

towards the nearest point on the second path.  

 

 

Orthogonal (to the path). A plane is constructed orthogonal to the first 

path tangent direction in the coordinate system origin. The axis direction 

is defined by the intersection point between the plane and the second 

path. If such point can’t be constructed, an error message is output. 
 

 

By parameter/By offset. An expression entered in one of these boxes is 

evaluated to define the point on the second path that determines the 

axis direction. 

 

 

If a face is selected for defining the axis direction, then, in the general 

case, a point is identified on the face that this nearest to the coordinate 

system origin located on the path. The normal to the face’s surface in this 

point determines the axis direction. The result will be best when the 

coordinate system origin lies in the surface. Therefore, use of a face for 

orienting the axes of the profile instance is recommended in the cases, 

when the first 3D Path lies on that face.  
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The thus constructed X- and Y-axes may not be orthogonal (if those are parallel, the system will output an 

error message). In this case, the Y-axis will be additionally reoriented to become orthogonal to the X-axis 

in the plane defined by the two axes. The Z-axis will be determined automatically. 

If a path or face is specified for the X-axis and not for the Y-axis, then the Z-axis will be directed tangent 

to the path defining the position of the coordinates origin, while the Y-axis will be determined 

automatically. If the X and Z-axes are not orthogonal, then the X-axis is additionally reoriented in the way 

described above. 

Let’s examine the Variables tab: 

 

As shown in the diagram, the group of driven parameters now includes not only the parameter Number 

of Copy, but also the groups Position in Path, X axis direction, Y axis direction and Z axis direction. There 

are now additional parameters Parameter on Path and Offset by Path.  

The group of driven parameters Position in Path allows reading the absolute coordinates of the current 

instance's coordinate system origin. The driven parameters from the groups X/Y/Z axis direction provide 

the coordinates of the instance's coordinate system axes. You can use the information about the position 

and orientation of the current profile instance in the space for defining relations with other model 

parameters. 

The group of driving parameters includes Parameter on Path and Offset by Path. Parameter on Path and 

Offset by Path serve the same purpose – to define the point position on a path by various means. Therefore, 

you can’t simultaneously define both the Parameter on Path, and Offset by Path. Parameter on Path varies 

in the range from 0 (at the start of the path) to 1 (at the end of the path); Offset by Path is measured in the 

model units and is equal to the length of the portion of the path from the start to the desired point. 

Once you defined the Parameter on Path driving parameter, you can assign the driven parameter 

to the Offset by Path only, and vice versa. 
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Example 3 
 

Let's review a parametric sweep creation using 3D paths 

on an example of the model of a drill bit’s cutting tip. The 

file with this example is located in the library “Examples”, 

the folder “\3D Modeling\By Parameters\ By minimal 

distance.GRB”. 
 

Create a new document using the template with 

workplanes. 

The next step is creation of the 3D profile. For this purpose, 

activate the workplane “Top view” and draw a contour as 

shown in the diagram.  

For convenience, try to construct the profile in such a way, 

that its center is located at the global coordinate system 

origin. In this case, you do not have to construct the local 

coordinate system for tying instances of the profile to the 

3D path during the operation creation. 

 

Next, we need to create two 3D paths for positioning the 

profile in the space when creating the parametric sweep. 

The path defining the profile position is a straight line 

coinciding with the axis of the bit. It can be created by two 

3D nodes constructed on the axis of the bit. The length of 

this path defines the length of the cutting portion of the 

bit. The other path defines the profile orientation in space 

and is represented by a spiral line. The second path can be 

easily constructed using a cylindrical worksurface.  
 

In the valuable editor, create an independent variable for storing the value of the copy number. In this 

example, the created variable was named s. 

After calling the operation creation command, select the 3D profile, the 3D path defining the profile 

position and the 3D path defining the direction of the X-axis. On the Operation tab of the operation 

parameters dialog, define the number of copies equal to 101 (with the correction) and select the option 

By minimal distance for the two paths. 

On the Variables tab, select the variable s to assign the copy number. This is the only necessary driven 

parameter in this example. 

Enter the expression in the driving parameter Parameter on Path 

input box, that will define the profile position along the path 

depending on the copy number. Remember that the Parameter on 

Path varies in the range from 0 to 1.   
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ROUTING 

GENERAL INFORMATION  

T-FLEX CAD provides a set of commands for wire cables, pipelines and ventilation systems design. 

The commands allow to: 

 build space routes manually or automatically; 

 create elements of engineering communications according to certain technical 

requirements; 

 specify compatibility for routing elements to eliminate design errors; 

 set routing elements styles to specify similar elements connection only. 

Commands for creating different routing types are divided into the following groups: Pipeline, Electricity 

and Ventilation. The commands allow to control compatibility of different elements. 

You need to activate Routing tab to gain access to the commands. Click  icon. 

 

Select Routing item in the drop-down list. Here you can find the commands for each routing type and 

some service commands. 

 

 

You can select one of the three groups Pipeline, Electricity or Ventilation in the left part. Commands for 

the selected routing type become available. 
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Each routing type has its own library of fittings. 

    

Fitting is a specially designed connecting part with the predefined behavior for certain modeling 

situations such as branching, turns and transitions from one diameter to another. The fitting 

behavior is specified with parametric tools and macro – API-based small programs built-into model 

document. 

More information about fittings can be found in “Fittings” section.  

The routing trajectory is specified in command 3PP: Create Route.  

More information about routings creation can be found in “Routings” section.  

Functionality of the Electricity, Pipeline and Ventilation commands of Routing group is similar. Only types 

of allowed connection points, routings and fittings are different for each type. 

For example, pipeline parts can be connected only with another pipeline parts. Thus we can avoid mistakes 

when working with various routings types within one project. 

Elements without any specified type can be connected with any routing and fitting type. 

More information about creation of routings types can be found in “Connectors types” section.  

Use the following command to create routings without any specified type: 

Icon Ribbon 

 

3D Model → Create → Pipeline 

Keyboard Textual Menu 

<3PI> Operation > Pipeline 

The command allows usage of connections and endings from different routings types. 

Description of common commands without dividing into different routings types will be given in the 

following sections. 

P IPEL INE CREATION  

Using general methods and steps for creating pipeline routing model described below you may create 

routing designs of other types as well.  

To create a pipeline model you may select Tools > Routing > Pipeline > Pipeline item from the text menu.  
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The operation creates a pipe which will be presented as a solid 3D body. The body will be resulted from 

sweeping of selected contour along a trajectory (route). The route can be created using one of the 

commands from the Routing section: Laying Route  or Route . It can be also specified as a model 

edge or any other element that determines wire geometry. 

 

The pipe profile shape and dimensions are specified without additional constructions. They are set in the 

Properties window that appears after the command activation.  

More information about the pipeline properties can be found in “Pipeline parameters” section. 

 

You can create a pipe along the whole route or its part. 

 

To define the operation, follow the steps: 

 Select 3D curve defining the trajectory. 

 Select starting 3D point of the pipe (optional). 

 Select ending 3D point of the pipe (optional). 

 Define operation parameters (pipe diameter, wall thickness, etc.). 

 Confirm operation creation. 

 

Pipe can be created using one of the two ways: 

 In the first approach, the trajectory of the pipe is divided into separate segments – straight lines, 

circular arcs and splines. A separate body will be constructed for each segment. Depending on the 
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segment type, this can be a cylinder or a torus, or a spline. The resulting operation consists of multiple 

bodies. If necessary it can be subjected to the 3SD:Divide Solid operation for getting individual 

bodies – the pipe segments. 

 In the second approach, the trajectory is treated as a single path. The pipe profile will be swept 

along this trajectory. The result is a single body whose surface consists of a set of spline faces and 

faces of revolution (cylinder, torus). In some cases, system can simplify the resulting body geometry 

by replacing (wherever possible) spline surfaces with analytical ones (portions of cylinders or tori). 

The first approach is used by default. It is faster than the second and reduces overall regeneration time. 

However, pipe operation created in this way may behave incorrectly under certain operations (for example, 

when creating 2D projections or in Boolean operations) because it is made of multiple bodies. If this is your 

case you may apply the second approach (creating the single body pipe), however, the model regeneration 

time may increase. 

Pipeline Command Automenu 

Upon calling the command, the following option is activated in the automenu automatically: 

 <T> Select trajectory 

The option allows to define a trajectory (3D curve) for the pipeline being created. When the option is active, 

you need to select a 3D object that presents wire geometry. The object will define a trajectory for the 

pipeline. 

If trajectory is presented as a 3D path based on 2D elements, then it can be also selected in the 2D 

window.  

The selected 3D curve and its defining elements will highlight. 

 

You may use a route as a trajectory.  If the route does not exist or existing route must be edited, use option: 

 <B> Create/Edit Route 

More information about routes creation can be found in “Route” chapter. 

When the route creation is finished press button . You will return to the pipeline creation command. 

 

The pipeline parameters can be specified in the dialog window called via: 
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 <P> Set entity parameters 

More information about pipeline parameters is given in “Pipeline parameters” section. 

 

You can define additional 3D points that specify pipeline limits – starting and ending points, using options: 

 <L> Select starting point for pipe 

 <M> Select ending point for pipe 

The options allow selection of any 3D object that can define a point as a corresponding pipeline end. 

System creates a “cutting” plane, which is perpendicular to the pipeline routing. This plane becomes a 

bound of the pipeline. 

Pipeline ends cannot be located beyond the selected route. 

 

You can edit location of starting and ending points of the pipeline using options: 

 <S> Edit start position 

 <E> Edit end position 

Transformations window appears after selection of one of the options. The current location of bounds is 

displayed there. The value can be changed manually. 
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You can also define pipeline limits using manipulators. Point 

the cursor at the pipeline bound manipulator and move it with 

pressed . Starting point is specified from the start of the path 

and has symbol “+”. Ending point is specified from the end of 

the path and has symbol “-”. 

Current offset value is displayed on the system toolbar. 

  

To create a pipe insert, operation that modifies pipe for inserting other parts, use option: 

 <O> Select operation for pipe insert 

The option allows you to select body for the pipe insert.  

Insert allows system to consider the pipeline as a singular object even if there are fittings that divide 

it into parts. It is necessary for further pipelines quantity and length correct calculation. 

The pipe inserts are displayed in Pipe inserts section of the Properties window. 

 

 

You can cancel source path and end points selection via option: 

 <K> Cancel selection of trajectory and end points 

You can use the following option for the standards editing: 

 <G> Edit standards list 

The Pipeline Standards window appears after its activation. Parameters of pipeline profile can be specified 

here according to existing standards. 

 <С> Library Configuration 
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More information about configurations can be found in “Holes” chapter. 

The pipeline creation can be used in combination with the further Boolean operation. For this, you need 

to select first the type of Boolean operation. 

 

Then select a body using option: 

 <Ctrl+T> Select target body for Boolean 

More information about Boolean operations can be found in “Boolean Operation” chapter. 

PROPERTIES W INDOW  

You can specify the following properties in Parameters window: 

Pipeline Parameters 

The pipeline profile properties are specified in the Parameters section. 

Profile Type. You need to select one of the profile types from the drop-down list: Round, Rectangular, 

Select Standard. According to the selected profile type, you can specify its dimensions. 

Round profile 

Pipe Diameter. By default, it defines the outer diameter of the pipe. If the switcher is in Outwards mode, 

the parameter defines inner diameter. 

            

Wall Thickness defines the difference between the outer in the inner diameters of the pipe. By default, the 

value is put inside the pipe (switcher is in Inwards mode). 

You can change pipe diameter and thickness using manipulators in the 3D scene. Current value of the 

parameter can be set on the system toolbar. 
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If smooth transition disappears between the two straight pipe segments when creating a pipe, then 

you must fix correlation between the rounding radius and the pipe diameter. 

Rectangular profile 

         

Width, Height, Radius of Rounding specify parameters of outer pipe profile by default. If the switcher is 

in Outwards mode, the parameter defines inner profile. 

 

Permitted values for Radius of Rounding are from “0” (without rounding) up to half of the minimum 

dimensions: length or height. 

 

If the radius is not within the value or the rounding cannot be created because of other reasons, the 

system displays the diagnostic message. 

Wall thickness. By default, the value is put inside the pipe (switcher is in Inwards mode). 

 

You can change rectangular profile dimensions using manipulators. Current value of edited 

parameter can be set on the system toolbar. 

Select standard 

If the profile type is specified by a standard, values of parameters are defined from the predefined list. All 

parameters are divided into control and dependent. 

 

Permitted values of a dependent parameter are defined according to the selected value of the control 

parameter. 

 

For the round profile type, diameter is the control parameter. Dependent parameters are walls thickness, 

fixation of inside dimension and option for creating one body. 

 

For the rectangular profile type, height and width are the control parameters. Dependent parameters are 

walls thickness, fixation of inside dimension and blending. 
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You can manage the standards list using Standards window. 

More information about the window can be found in “Standards” section. 

If the specified value of any parameter does not match the standard, when you edit pipe profile defined 

by a standard, the system will display a diagnostic message. 

 

Common parameter 

The following parameters are available for all profile types: 

 

Create one Body. Parameter specifies the way of pipeline creation. When the flag is not set, the first way 

(separate segments) is used. The resulting operation consists of multiple bodies. When the flag is set, the 

second way is used – the resulting operation will present a single body. 

Don’t create Solids. When the flag is set, the operation will be created but it won’t be displayed in the 

3D scene. It is useful in models with large number of pipes. 

Simplify geometry. With this parameter set, the geometry of the resulting body will be simplified by 

replacing (wherever possible) spline surfaces with analytical ones (cylinders or tori). 

Tolerance. This parameter defines the accuracy of pipe construction, resulting with particular number of 

intermediate steps when sweeping pipe profile along the spline trajectory to ensure the required accuracy 

of surface. 
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Profile Orientation  

It is possible to specify rotation of profile while sweeping using flag Rotate Profile (available only for 

rectangular profile).  

The profile orientation is the full angle of rotation according to the axis directed along the tangent 

to the path. It is specified at the pipe ends with two parameters-angles: 

 

Starting Angle is defined as an angle between Y axes of base LCS and source LCS. 

Source LCS - X axis is directed along the tangent to the path, Y axis is defined by the principal normal to 

the path. 

Base LCS – LCS (connector or connection point) which is located on the pipe bound (starting or ending). 

The X axis is directed along the tangent to the path, the origin merges with the the bound of the pipe 

(starting or ending). 

Ending Angle is specified in the Properties window or using manupulator in 3D scene. 

 

When you use manipulator, the current rotation angle is displayed on the system toolbar. 

 

 

Endings and Connections 

There is possibility to set endings and connectors types in the Pipeline command by inserting library 

fragments into the model. Bevels, flanges, threads and so on can be used as such fragments. 

In the 3D Model window such pipeline is displayed as a single object, but physicaly in the model it consists 

of several fragments (start, middle and end). If you edit any of these fragments the Edit Pipeline command 

activates automatically. 
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Ending or connection type can be selected either from the quick access drop-down list or by clicking the 

corresponding icon. If you select type from the list and it is not presented among the icons below, the new 

icon will replace the last right icon.  

Item “Select” in the drop-down list allows you to select element from custom libraries added to selection 

list. 

The content of the selection list is linked with the value of the Standard field and will update accordingly. 

 

The elements of endings and connection are created as adaptive fragments. They are stored in 

folder “..\Libraries\Routing”. If necessary, library can be supplemented with custom elements. 

To define selection from the predefined set of ending and connection elements use Standard data field. 

Use button  Edit variables to set external values of fragment variables. The Variables section appears 

after pressing the button. 

 

System checks for correctness of endings insertion and displays message if it is impossible to perform the 

operation. It can happen if, for example, the ending length is greater than the pipeline length. 
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You can select ending or connection library using option: 

 <B> Library configuration 

More information about configurations can be found in “Holes” chapter. 

Pipe Inserts 

This section of Properties window displays elements, used in option  Select operation for pipe insert 

and elements, used to define  shape of cutting from the pipe. 

These elements are not added to the 3D Model window.  

You can delete them using button  if necessary. 

  

L IST OF STANDARDS EDITOR  

This editor provides functionality for creating list of pipe standards. Here you can set main parameters of 

a standard as well as define control and dependent parameters. 

The editor is called via automenu option: 

 <G> Edit list of pipe standards 

In the left part of the window there is the list of all available standards and pipeline parameters, which are 

defined by the standards. In the right part you may see the detailed description of the standard. 

The list of standards and parameters is stored in file PipeStandards.xml inside folder “..\Program”. 
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You need to specify available parameters values and dependencies between them. Press  to 

show list of availabale values to the left from the standard name. 

 

 

After selecting any parameter in the right part of the window you will see the list of available values. The 

dependent parameter also has the list of dependencies. The dependencies show, which values the control 

parameter can take according to the particular value of dependent parameter or in the specified interval.  

The editor allows to change current standards and add the new ones. To add a standard you need to press 

button , select standard type (ISO, DIN and so on) from the drop-down list  and fill in all 

necessary fields: Name, Route Type, Profile Type, Comment, etc. 

Buttons on the toolbar will help you to cut , copy , insert  , and delete   a standard. 

You can specify the following parameters for pipline standard: 
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Name – name of standard that will be displayed in the list. 

Route Type – defines type of route that may work with this standard. 

Profile Type – sets round or rectangular profile. 

More information on profiles types can be found in “Parameters” section. 

 Inwards, Outwards. You can select type of thickness increment Note that in this case 

changing method of thickness increment (Inwards/Outwards switcher in the Properties 

window) will be undesirable. I.e. the way of increment can be changed but it will lead to the 

diagnostic message.  

 Use wall thickness. If the flag is set, the Thickness appears in the standards list. Without active 

flag you cannot specify walls thickness. 

 

 Create one body. The flag is identical sonamed flag from the pipeline parameters. It defines 

the way of body creation for the current standard. 

More information about the flag can be found in “Pipeline parameters” section. 

After selecting parameter of standard in the left part of window, you can set its values and dependencies 

in the right part. 

 

 

The parameter values can be set using button , dependencies are specified using button . 

To delete values and dependencies use buttons  and  or <Delete> button. To edit previously 

created dependency use button . After pressing the button the following dialog box will appear. 
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In the Dependency window you can set value or interval of the values for control and dependent 

parameters. To define interval you need to set flag in corresponding field.  

Changes in standard 

If the standard for some reason has been changed, it will not affect existing pipeline models based on this 

standard. But in this case special comment “from document” will appear near the name of the standard in 

the pipe parameters.  

 

Import/Export of Standards 

There is possibility to export and import lists of standards from XML-files using commands File >> Import, 

File > Export from the menu. 

 

There are two options available for import: 

Replace. The current list will be replaced with the list from the external file. 

Add. You can select standards that will be added to the list. Selection list will not display standards that 

already exist in the list.  
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Icons at the bottom of the window allow you to perform the following actions with the list of standards: 

 - select all standards. 

 - cancel selection of all standards. 

 - invert standards selection. 

F ITT INGS  

Fitting is a connecting part of pipeline, which is usually located at branching places, turns and transitions 

to another diameter. Fittings are used for sealed overlap of the pipeline and other auxiliary purposes. 

It is convenient to use smart-fragments as fittings. Smart-fragments adapt to objects already existing in 

the model and affect geometry of connected fragments.  

For example, when you insert a cross fitting between two pipes, the crossing pipes will be automatically 

divided each into two parts. Their ends will be automatically transformed according to the requested 

connection type.  

Special variables, connectors, LCS and macro provide an automatic link with parameters of other routing 

elements. The macro is included into the fitting document file. 

When you need a new fitting you have to create a 3D model file with a special macros that will be used as 

a 3D fragment. Creation and usage of each fitting type is described below. 
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Ready to use library fittings files include “Smart” suffix in their names. You can enlarge set of such elements 

if it is necessary. 

 

Fitting gets part of external variables values from the pipeline parameters. For example fitting can get the 

pipe diameter. Fitting can also pass parameters values to the pipe, if it is set in the fitting file. 

There are following fittings types defined by default: Cap, CornerFracture, CornerRadius, Tee, Crossing, 

Adapter, Clamp, CornerEnd, Inset. 

Fitting Insertion 

It is easy to use drag’n’drop mechanism for fitting insertion.  

Options for defining fitting  location appears right after drag’n’drop of the fitting. 

 <P> Select path 

 <T> Select pipe 

When option  is selected, the fragment is placed on the selected path point. When you select ,  

system defines appropriate point for fixing on the selected pipe (for example, crossing), if necessary. 

There is a different set of options for each fitting type. It appears after path or pipe selection. 

 <R> Rotate fragment along main axis 

 <T> Rotate fragment along alternative axis 

 <V> Select next fixing point 

Options  and  allow to rotate the fragment around main and alternative directions, changing 

location of trunks and branches. 

Option  is available if the fragment is located on the crossing of two pipes/paths.  

If the fragment (tee or crossing) is located at the crossing point of paths, you can’t rotate or translate 

it using manipulator. 
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For CornerFracture, CornerRadius, CornerEnd: 

 <R> Rotate fragment 

 <F> Select next fixing point 

The next suitable fixing point for fitting will be automatically found after pressing of  or  options. 

The points will be cyclically searched upon further continuous option usage. 

The corner can be located on trunks and endings of the pipe. 

For Inset, Clamp: 

 <D> Select pipe for Y direction 

 <R> Rotate fragment 

When the option  is active you need to select pipe, related to which the Y direction will be defined. 

For Cap, Adapter: 

 <R> Rotate fragment  

This type of fittings limits pipe on endings. 

For all inserted smart-fragments the following options are available: 

 <E> Wireframe 

 <N> Insert new fragment after confirmation 

Wireframe. Allows to switch between wireframe mode and rendering mode of the model. 

 

Wireframe mode Rendering mode 

 

Insert new fragment after confirmation. A new fragment similar to the inserted one will be added after 

confirmation button pressing. 
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Fittings Basic Highlights 

When you insert a fitting at the beginning or end of the pipe, the pipe is not divided. When you change 

fixing type the pipe will be divided into two parts if possible. The original parameters of pipe endings will 

be restored. 

 

After the fitting insertion or replacement system determines necessity of the pipe dividing. Unused 

pipe part will be suppressed and removed after exiting the command. 

Special manipulator is used to define fitting position. It allows to move fitting and rotate it around the axis.  

 

If fitting does not match the pipe, the corresponding message will appear.  
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Special window Action appears when you edit a fitting. Here you can select option for editing the current 

fitting, selecting a new fitting to replace the current or cancel editing.  

 

To replace a fitting choose option <Select from library> and select necessary library fragment in Fitting 

Selection window. After selection, you need to press [Replace] button. 

After fitting selection the system exit from edition command automatically. 
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When you delete a fitting, linked pipes won’t be deleted. 

 

 

 

 

Fittings Parameters Names 

Table of external key variables of smart-fragment.  
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Variable name Usage Description 

DiameterIn1 Manages input diameter of main 

direction fitting 

Is necessary for Cap, 

CornerXxx, Tee, Crossing, 

Adapter, Clamp 

DiametrOut1 Manages output diameter of main 

direction fitting 

Is necessary for CornerXxx, 

Tee, Crossing, Adapter 

DiametrIn2 Manages input diameter of alternative  

direction fitting 

Is necessary for Crossing 

DiametrOut2 Manages output diameter of 

alternative direction fitting 

Is necessary for Tee, Crossing 

 

External variable Diameter *** is responsible for link between the respective diameters of fitting and pipe. 

Due to the variables, macro can get diameter of pipe to which fitting is attached and set the appropriate 

diameter of  fitting. 

When creating a smart fragment it is possible to use from one (lug, cross with identical diameters of all 

branches) to four (cross with four different diameters) external variables, depending on the number of 

input and output fitting diameters. 

           

Table of smart-fragment key LCS. 
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Object Description 

LCS_1 The fragment source LCS must be set as LCS 

by default in the fragment document 

parameters. 

C_In1, C_Out1, C_In2, C_Out2 Connectors names of input/output main 

and alternative directions   

 

 

LCSs listed in the table are responsible for cutting pipe for which fitting is inserted. 

 

LCS_1 responsible for position of fitting on the pipe is the main LCS that must be created for joining fitting 

with the fragment. The remaining four LCSs are responsible for joining pipes of appropriate diameter and 

the emergence of the connecting elements (flange and thread) at coupling place of pipe with fitting. These 

LCSs are considered in macro. 

 

Table of key connector parameters that define smart-fragment insertion logic: 

 

Parameter name Usage Description 

autoFilePipeEnd Pipe ending/beginning if 

connector is located on pipe 

end.  

Can be omitted. 

Template of the parameter value: 

<library>file_name.grb 

Parameter functions: 

- creates cosmetic thread on the pipe 

- cuts the edge for  weld 

- creates flaring 

autoLength The fragments name in the 

connector direction 

Sum of input and output connector 

lengths is equal to the length of the 

direction (main or alternative) 

autoDiameter Pipe diameter will be taken 

from  fitting 

If missed the original pipe diameter is 

used. 

autoThickness Pipe thickness will be taken 

from fitting 

If missed the original pipe thickness is 

used. 

Auto – manages the command operating logic when the smart-fragment with this connector is 

inserted. 

The above parameters allow you to specify additional options when you insert the fitting. 
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Fittings Smart-fragments Behavior in Pipe Systems 

Variants of interaction with other fittings 

1. Y-shaped bend  Creates inner cosmetic thread on pipe 

 Creates outer cosmetic thread on pipe 

 Divides pipe segment into two segments 

 Divides pipeline into more than two segments 

 Modifies pipe diameter from larger to smaller and back 

 Cuts edge for weld 

 Inserted in the middle of pipe segment  

 Inserted on pipe ends 

 Inserted on pipe rounds  

 Inserted on pipe corners 

 Interaction with a single pipe 

 Interacts several pipes 

 Interacts other fittings 

 Interacts intersecting branches of pipeline 

2. Adapter  Creates inner cosmetic thread on pipe 

 Creates outer cosmetic thread on pipe 

 Divides pipe segment into two segments 

 Modifies pipe diameter from larger to smaller and back 

 Inserted on pipe ends 

 Inserted in the middle of pipe segment  

 Interaction with a single pipe 

 Interacts several pipes 

 Interacts other fittings 

 Interacts with parallel branches of pipeline 

 Makes the flaring of pipe/tube/hose 

3. Branch 

 

 Creates a hole in pipe 

 Cuts edge for weld 

 Inserted in the middle of pipe segment  

 Interaction with a single pipe 

 Interacts with several pipes 

 Interacts intersecting branches of pipeline 

4. Bushing  Creates inner thread on pipe 

 Creates outer cosmetic thread on pipe 

 Divides pipe segment into two segments 

 Modifies pipe diameter from larger to smaller and back 

 Cuts edge for weld 

 Inserted on pipe ends 

 Inserted in the middle of pipe segment  
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5. Lock nut  Creates outer cosmetic thread on pipe 

 Inserted in the middle of pipe segment  

 Interaction with a single pipe 

6. Set-off pipe bend  Creates inner thread on pipe 

 Creates outer cosmetic thread on pipe 

 Cuts edge for weld 

 Inserted on pipe ends 

 Cuts second part of pipe 

 Modifies pipe diameter from larger to smaller and back 

 Cuts edge for weld 

 Inserted in the middle of pipe segment  

 Interaction with a single pipe 

 Interacts with several pipes 

 Interacts with parallel branches of pipeline 

 Interacts other fittings 

7. Valve  Creates inner thread on pipe 

 Creates outer cosmetic thread on pipe 

 Divides pipe segment into two segments 

 Cuts second part of pipe 

 Modifies pipe diameter from larger to smaller and back 

 Cuts edge for weld 

 Inserted on pipe ends 

 Inserted in the middle of pipe segment  

 Interaction with a single pipe 

 Interacts with several pipes 

 Interacts other fittings 

 Interacts intersecting branches of pipeline 

8. Bend  Creates inner thread on pipe 

 Creates outer cosmetic thread on pipe 

 Divides pipe segment into two segments 

 Cuts second part of pipe 

 Modifies pipe diameter from larger to smaller and back 

 Cuts edge for weld 

 Inserted on pipe rounds  

 Inserted on pipe corners 

 Inserted in the middle of pipe segment  

 Interaction with a single pipe 

 Interacts with several pipes 

 Interacts other fittings 

 Interacts intersecting branches of pipeline 
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9. Crossing  Creates inner thread on pipe 

 Creates outer cosmetic thread on pipe 

 Divides pipe segment into two segments 

 Cuts second part of pipe 

 Modifies pipe diameter from larger to smaller and back 

 Cuts edge for weld 

 Inserted on pipe ends 

 Inserted in the middle of pipe segment  

 Interaction with a single pipe 

 Interacts with several pipes 

 Interacts other fittings 

 Interacts intersecting branches of pipeline 

10. Coupling  Creates inner thread on pipe 

 Creates outer cosmetic thread on pipe 

 Divides pipe segment into two segments 

 Modifies pipe diameter from larger to smaller and back 

 Inserted on pipe ends 

 Inserted in the middle of pipe segment  

 Interaction with a single pipe 

 Interacts with several pipes 

 Interacts other fittings 

11. Cap  Creates inner thread on pipe 

 Creates outer cosmetic thread on pipe 

 Cuts second part of pipe 

 Inserted on pipe ends 

 Interaction with a single pipe 

 Interacts other fittings 

12. Pipe clamp  Changes geometry of the 3D path 

 Interacts with several pipes 

 Interacts intersecting branches of pipeline 

 Interacts with parallel branches of pipeline 

 Interacts intersecting branches of pipeline 
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13. Reducer   Creates inner thread on pipe 

 Creates outer cosmetic thread on pipe 

 Divides pipe segment into two segments 

 Modifies pipe diameter from larger to smaller and back 

 Cuts edge for weld 

 Inserted on pipe ends 

 Inserted in the middle of pipe segment  

 Interaction with a single pipe 

 Interacts with several pipes 

14. Tee  

 

 Creates inner thread on pipe 

 Creates outer cosmetic thread on pipe 

 Divides pipe segment into two segments 

 Cuts second part of pipe 

 Modifies pipe diameter from larger to smaller and back 

 Cuts edge for weld 

 Inserted on pipe ends 

 Inserted on pipe rounds  

 Inserted on pipe corners 

 Inserted in the middle of pipe segment  

 Interaction with a single pipe 

 Interacts with several pipes 

 Interacts other fittings 

 Interacts intersecting branches of pipeline 

15. Seal  Interacts other fittings 

16. Flange  Divides pipe segment into two segments 

 Inserted on pipe ends 

 Inserted in the middle of pipe segment  

 Interaction with a single pipe 

 Interacts other fittings 

17. Pipe housing  Inserted in the middle of pipe segment  

 Interaction with a single pipe 

 Inserted on pipe rounds  

 Inserted on pipe corners 

 Interacts with several pipes 

 Interacts with parallel branches of pipeline 

 Interacts other fittings 
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18 Compensator  Divides pipe segment into two sections 

 Cuts edge for weld 

 Interaction with a single pipe  

 Inserted on pipe ends 

 Inserted in the middle of pipe section  

 Interacts other fittings 

Macros Creation 

When you create a new fitting a standard macro text is added into its file. One of the fittings types that 

were listed above is specified in the macro.  

Here is example of typical macro text for the “Crossing” type. 

using System; 

using FittingImport; 

 

namespace FittingImportNamespace 

{ 

 public class FittingImportClass 

 { 

  public static void Fitting_InsertAsFragment() 

  { 

   FittingImport.TFFittingImport.Create(FittingType.Crossing); 

  } 

  public static void Fitting_EditFragment() 

  { 

   FittingImport.TFFittingImport.Edit(FittingType.Crossing); 

  } 

  public static void Fitting_DeleteFragment() 

  { 

   FittingImport.TFFittingImport.Delete(FittingType.Crossing); 

  } 

 } 

}   

 

More information about macro can be found in “Macros” chapter. 
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Also you need to set three message handlers “Fitting_InsertAsFragment”, “Fitting_EditFragment”, 

“Fitting_DeleteFragment”. 

 

 

To compile the macro you need to add link to the FittingImport in the project. 

 

Smart-fragment Creation Example 

General steps for successful creation of a smart-fragment are listed in this example.  

For convenience, the smart-fragment creation is divided into four stages: 

 Body for fitting creation 

 Body for creation of the cutout shape in pipe 

 Fitting parameters managing 
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 Macro creation 

Smart-fragment “Examples\ 3D Modeling\Routing\Gauge boss (smart)” was used as an example. 

There are special rules for LCS, connectors and variables when you create a fitting. Names of variables and 

LCSs and their description are listed in “Fittings parameters names” section. 

Fitting Body Creation 

To begin with, you need to create a fragment body. The 3RO:Rotation and 3AT:Thread were used to create 

the boss.  

 

More information about the rotation and thread operation can be found in “Rotation” and “Thread” 

chapters. 

 

Fitting Hole Body Creation 

The next step is creation of a fitting hole body.  

Body for defining an insert in pipe is a fitting element that defines the form and shape of a hole in 

pipe, in which the fitting is inserted. After insertion, this body disappears. 

 

You need to specify input diameter of main direction fitting “DiameterIn1” and main LCS “LCS_1” for the 

boss creation. 

More information about variables names can be found in “Fitting parameters names” section. 

 

Setting Diameter Variable 

The diameter is specified in the variables editor. The variable defines diameter of pipe in which the fitting 

is inserted and specifies fitting location. 
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You can set any value for diameter variable. The macro automatically identifies pipe diameter and add its 

value to the variables, when the fitting is inserted into an assembly. 

You need to set External variable flag for the variable. 

LCS Creation 

Construction line was created in the example to specify LCS location. The line is at distance “DiameterIn1/2” 

from the face of the boss cylindrical part. The pipe diameter is half divided that’s why the boss will be 

located on the pipe.  

 

  
Line that defines LCS location Boss location on the pipe 

 

 

The LCS is renamed to LCS_1. The name was taken from the “Key smart-fragments objects” table. 

There is no need to create connectors (C_In, C_Out) because there are no fitting elements to connect with 

the boss. 

 

In this case, the fitting will not join any piping elements or other fittings, so  the creation of additional 

connectors (C_In, C_Out), diameters (DiameterIn2, DiameterOut), or their parameters are not 

required. 

Body Creation 

The next step is to create a body to define shape of the cutout in pipe. Contour of the body should 

follow the shape of the cutout in pipe, so that when you insert fitting there is no intersection of 

the fitting and the pipe. 
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Without intersection 

 
With intersection 

 

Length of body should depend on LCS_1 position. This is done in order to be able to adjust the 

position of the fitting on the pipe depending on the pipe diameter. 

It is better to have the body with the most simple geometry - a box or cylinder. This will 

reduce the time of the pipeline regeneration. 

If the body is not created, a cutout will have the form of the inserted fragment. 

In this case, the body is obtained by rotating profile around  axis. 
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Body to set the shape of cutout in the pipe should be hidden in the 3D scene and on the drawing. In order 

to hide it you need to do the following. 

 In the editor of layers, create a new layer and name it - "Invisible" and put mark in the 

Visible only when inserted in assembly. 

 

 

 

 In the parameters of created body on the General tab, you must specify the previously 

created layer "Invisible", then the body will be hidden in the 3D scene 

 

Adjusting Fitting Parameters 

After creating the fitting body it is necessary to set the parameters for its insertion into assembly as a smart 

fragment. To do this, use ST: Set Document Parameters command, go to 3D Fragment tab. 

In the window that appears you must: 

 Set Type of Fragment Insertion – Smart Fragment (macro). System will use macro created in 

Macro Editor when inserting this body. 
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 In the Automatically create Boolean operation section you should select operation type 

Subtraction from the drop-down list, so that the body create a cutout in the pipe, and in the 

drop-down list Create operation with select the name of the body that will be used for Boolean 

operations. In this case - "Fitting_hole_body". 

Setting the above parameters allows system to automatically execute macro to create Boolean operation 

when you insert the smart fragment. 

After performing Boolean operation body used as a cutout in the pipe disappears. It will be referenced in 

the section Pipe Inserts in the Properties window for the selected element of the pipeline. 

 

Macro Creation 

The following is the sequence of actions to create a macro for inserting a smart fragment: 

 Use macro editor to create a new macro. Macro text for various fittings differs only in the 

type indicated in parentheses. In this case, this is type "Inset". 



Three-dimensional modeling 

568 

 

 The you need to define three message (event) handlers:  

 Inserting as a fragment (Fitting_InsertAsFragment),  

 Editing (Fitting_EditFragment),  

 Deleting (Fitting_DeleteFragment). 

To set the handler you must select the project and from the context menu choose Message 

Handlers .... 

 

In the window that appears choose one after another three lines "Delete Fragment", Edit 

Fragment, "Insert as a Fragment" and select them using the macro button [Set]. 
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Since the main macro has been previously created in the macro editor, the list will appear from which you 

can select the desired part of the macro. Macro can be set manually, if necessary, by pressing [Set 

Manually]. 
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 In order to successfully compile the macro add link to FittingImport in the project. 

 

After completing all the above items, the fragment file must be saved. Now the created fitting can be used 

for insertion into assembly using Drag’n’Drop method. 

More information about creating macros can be found in the "Macros" chapter. 

 

Example of creating pipe endings and connections 

When you create models for pipe middles and endings you should considered a set of rules. 

To add new models for pipe middles and endings into the library use command: 

 <С> Library Configuration 

More information about configurations can be found in “Holes” chapter. 

In the fragment file you must create the following variables: 

 Diameter or D - pipe diameter (permissible values range from 0 to 10000) 

 Thickness or T - pipe wall thickness (permissible values range from 0 to 10000)-  

 InnerDiameter or InnerD – flag for usage of internal diameter (possible values 0 or 1) 
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Note. Variable InnerDiameter (D)  can be used for the suppression of one of the bodies in the 

fragment file. One body will be visible when using internal diameter, the second - using external. 

Guidelines for creating fragment of ending and connection 

After creating 3D model, you need to: 

 Create external 3D node (there must be only one). This node will limit the adjoining pipe. It 

should be placed on the "inner end" of fragment body. 

 

 

 Create external LCS. This LCS should be placed on the "outer end" of fragment body. It will 

be used for fixing the fragment. It must be assigned as a primary fixing LCS in the 

document properties command on the 3D tab, button [Fragment]. 

 

More information on how to create LCS can be found in the chapter "Local Coordinate Systems". 
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 Create custom dialog for entering values of external variables (optional step). This dialog is 

automatically embedded in the Properties window when you call editing of ending variables 

in the command of pipeline creation/editing. 

 

Learn how to create a dialog in the chapter "Controls. Creation of Custom Dialogs." 

 

 

 Create icon with the command Tools > Special Data > Icon. (Optional step). 

 

 

Learn how to create icons in chapter "Document Preview and Icons." 

 In the variable editor add diagnostics for invalid combinations of variable values. 

Read more about diagnostics functions in chapter “Variables”. 
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Guidelines for creating fragment of the middle part of pipe 

When you need to create some specific pipe geometry like corrugated pipe you may use 

special mechanism for defining pipe “middle” using fragment. 

In the fragment file you must create variables described in the beginning of this section: Diameter, 

Thickness, InnerDiameter. 

To create a 3D model of the middle of the pipe, you can use any convenient operation, such as 

sweeping along a path. It is important that the body is based on a 3D path. 

After creating 3D model, you must set parameters in Adaptive Fragment command. This will create 

a pipeline using any selected route. 

Read more about how to create adaptive fragments in chapter "Adaptive 3D Fragments." 

 

Name. Parameter specifies the name of operation, which will be assigned to the pipe using this fragment. 
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Geometrical parameters: 

- Path (3D path or route). Element that defines the path of the pipeline. 

- 3D pipe start node 

- 3D pipe end node 

 

It is important to comply with sequence of geometrical parameters in the list. The first must be path, 

and then the start and end points. 

Creation of icons and dialog of external variables for the fragment is not a mandatory action. 

Name that appears in the list of endings and connections in the command of pipeline creation can be set 

in command File >> Properties >> Summary. 

 

After performing all the above steps, you must save the file. 

UPDATING ROUTING MODELS  

After changing pipe parameters it is necessary to call the command Update Routings because full model 

regeneration does not apply to the chain of pipelines and fittings. 

Keyboard Textual Menu Icon 

<3PC> 
Tools > Routing > Update 

Routings  

Command "Update Routings" called from the context menu for the selected segment of a pipeline, updates 

fittings locally, i.e. only at the ends of the selected segment. 

 

Command 3PC: Update Routings performs updates throughout whole pipeline structure. 

TYPING OF ROUTINGS  

In order to automate routings design process, objects can be associated with certain types. Types allow 

you to exclude mistakes in operations of connecting routing elements to each other. 
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For description of objects compatibility rules and assignment of types use command TI: Connection Types. 

There, you can assign a valid correspondence between the routes and fittings, between the different types 

of routes. 

It is possible to create objects with basic typing. The basic types include Wiring, Ventilation, Pipeline. 

For these basic types menu Routing has commands to create connection points, routes, harnesses, routing 

objects, as well as command for filling route with style. 

 

When you call command Route from one of the three groups of Routing text menu, system opens dialog 

of route command with the corresponding value of Type parameter (Wiring, Ventilation and Pipeline). To 

clarify type use option Select type in the drop-down menu. It will offer you types, which are the children 

of the base type. 

 

If Route command is called using text menu Construct > Route, by using "Select type" option you can 

select type from all types available in the library.  
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In the drop-down list displays the 10 most recently used types. When you call one of the commands 

with the base typing you will get types derived only from this base type. When you use the general 

Route command you will get all used types. 

To adjust compatibility of different types you can use Editor of Connection Types.  

Editor of Connection Types 

With the help of editor of connection types you can set compatibility rules for various types of 

routings. Compatibility rules help to avoid mistakes when working with various libraries and routings 

within the same project. For example, avoid accidental connection of low-voltage and high-voltage 

cables in the design process. 

 

Editor can be called using Connection Types command of the Routing text menu.  

Keyboard Textual Menu Icon 

<TI> Tools > Routing > Connection Types …  

 

In the left pane there is a tree of types. It consists of two main parts: "Objects" and "Routes". 



Routing 

577 

 

Above the tree of types there is a toolbar for its editing. 

 Create. Allows you to create a new type. Object will be added to the selected type from the list. 

Parameters of a new type are described below. 

 

 Cut. The selected object will be cut from tree.  

 Copy. Allows to copy type 

 Paste. Allows to insert type. Works with with options Cut and Copy. 

 Delete. Allows to delete selected type. 

 Editor of Physical Parameters. Provides access to the internal directory of the physical parameters. 

Work with the directory is described below. 

Parameters of type 

The right pane displays the set of parameters of the selected type. 
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Type. In this field you can specify unique name of the type to which the object belongs. Type name will 

appear in the list on the left side of the Editor of Connection Types and the drop-down list of types when 

you create objects (connection points and routes). 

Object Name. Specifies the name of objects for a given type. This name will be displayed in the model 

tree. Names can be the same for different objects. 

Style. Specifies the number of axes required for the proper connection of objects. 

 

For example, such connection as "plug - socket" requires two axes to 

match. 

Style is taken into account when creating connection points and 

routes. 

 
One axis Two axes Three axes 

Icon. It allows you to set icon to be displayed to the left of the type. For selecting icon for the file you can 

use the button . In the window that appears you can see the available standard icons. To remove  

element icon, use the button . 

 

Comment. In this field you can enter a comment to the selected element. The number of characters 

available for comment is displayed above the field. 

For each element you can set a group of parameters. 

 

Parameter Name. If two objects of the same type of parameter names coincide, these parameters are 

compared. When incompatibility is found, you cannot connect the objects. 
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Condition. Condition can be selected from the drop-down list. 

Value. Is taken into account when comparing parameters. 

Physical Parameter. From the drop-down list you can select the physical parameter. Physical parameters 

are set in the Editor of Physical Parameters. 

For more information about editor of physical parameters refer to section "Physical Parameters" 

below. 

Unit. After selecting the physical parameter you can use set the corresponding unit. 

 

On the right side of the dialog there is a set of buttons to control the inheritance of parameters. By default, 

objects inherit all parameters of the upper level objects. 

Button  shows parameters that selected type inherits. To change the inherited parameters use option 

.  

   - options allow you to add or delete parameters from the list. 

 

Compatible types can be set in the bottom of the window. 

 

Options  and  allow you to add compatible types and routes from the list. Options  and  

allow you to delete previously added types and routes.  

Option  allows you to control inheritance of parameter types. When enabled, all objects within a type 

inherit all of its compatible elements. After disabling the option, you can delete all but one inherited 

compatibility. 

Only compatible types can be set for the routes. 
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The tree structure and description of types is contained in ConnectorType.xml file. To manage this file from 

the "File" menu, use the following commands: 

- Save (active, if any item in the tree has been changed): saves ConnectorType.xml file in 

“C:\Users\User_name\AppData\Local\ Top Systems\ T-FLEX CAD 3D…” folder. 

- Import: replaces the contents of the current ConnectorType.xml file with the contents of the imported 

file. If ConnectorType.xml file has been modified before importing, system would prompt to save it under 

another name. 

 

When importing tree of types there are two options: 

 

- With replacement: current list will be completely replaced by the list from external file. 

- With addition of: the user will be prompted to select the types that need to be put in the current list. The 

import list will be filtered not displaying the types that already exist in the current list. 

- Export: saves ConnectorType.xml file to the specified location. If desired, you can specify a different name 

for the file. 

Compatibility Tree 

Command “Tools/Compatibility Tree” of the “Editor of Connection Types” displays compatibility rules in 

a separate window. For the element selected in the left part of window systems shows on the right side all 

compatible objects and routes. Tree allows to see the current structure of compatibility. 
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Compatibility Check 

Command Tools/Compatibility Check of the “Editor of Connection Types” allows you to check  

compatibility of any pair of elements in the list of objects and routes. Select item in the left pane and item 

in the right pane. Message in the bottom will tell about the presence or absence of compatibility. 

 

Physical Parameters 

Command Edit\Editor of Physical Parameters of the “Editor of Connection Types”   displays the internal 

directory of physical parameters for the editor of connection types. For each parameter there is a list of 

units with the name and the short name. 

 

Flag Base sets the default measurement unit. For other units of measure there is Multiplication factor for 

conversion to the base unit. List of parameters and units of measurement can be edited using the following 

commands: 

 

 - Add parameter 

 - Add unit 

 - Delete 
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HARNESSES  

Harness is part of the hierarchical structure of the route, uniting a group of routes or other harnesses. For 

example, harnesses may be used in automatic laying of routes. 

To create a harness it is necessary first to build routes, which will then be combined into harnesses. 

Call to create a harness command is carried out from Routing menu. Every new harness is set with the base 

type. 

Icon Ribbon 

 

Routing → Construct → Harness 

Keyboard Textual Menu 

<> Tools > Routing > Pipeline > Harness 

 

After activating the command, specify the routes, which will be combined into a harness. Selection of routes 

is available with option  in automenu. 

Obligatory condition of combining two routes into a harness is the presence of at least one point 

of intersection of two adjacent segments. 
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All selected routes are displayed in the Properties dialog in Compound Elements section. 

 

To complete the creation of harness press . 

 

CONNECTION POINTS  

To automate connection of routing elements to each other you may use connection points - connectors. 

They represent LCS, which have certain types. 

 

If the LCS type does not exist in the used hierarchy of types,  next to the LCS there will be "from 

document" note. 

 

When you create connectors, for their positioning you may use only objects with compatible type, or 

objects with no type assigned. When typed element is added to a model, system checks whether a given 

connection point may be used for connecting element, i.e. checks objects for compatibility. 

 

For more information about creating connectors refer to chapter "Local Coordinate Systems". 
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AUTOMATIC LAYING OF ROUTES  

Routing command performs automatic laying of route between selected nodes. To set path of the middle 

route segment you can use also harnesses. 

To access the command: 

Icon Ribbon 

 

Routing → Construct → Routing 

Keyboard Textual Menu 

 Tools > Routing > Routing 

The algorithm of working with the command can be represented as follows: 
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Consider an example. 

The route will go between the two LCSs. Part of the route will pass through the harness. 

After calling the command, the following options are available: 

 <F> Select start point 

 <S> Select end point 

 <D> Cancel start and end points 

 <L> Select harness 

 <C> Cancel harness selection 

 <N> Next 

 <P> Back 

 <R> Resume command operation after applying changes 

In Parameters dialog you can set parameters of the route being created: 

 

- Tangency Offset – specifies the distance by which the segment of the route offsetss from the intersection 

point with another segment to build tangential coupling between them. 
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- Rounding Radius – sets radius of rounding at the route break points. 

- Route Type: polyline, spline by points, spline by polyline - can be set separately for each route segment. 

- Color – sets route color by default. 

Laying the route takes place in several stages. At each stage a segment of the route is constructed. 

The segment is laid along the edges of the manipulator-box or rectangle. This manipulator appears 

for each route segment. You can select edges, by which the route will be laid, and set the length of 

the edges. 

After the initial data for constructing the route - start LCS  ,  end LCS   and harness  - are 

set press button   Next.  

 

After that you will see manipulator-box, with which you need to specify the variant of the route approach 

to the first point along axis X. To specify the variant, you must select appropriate edges of the manipulator. 
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Length of edges can be changed either directly with manipulator or in the Properties window. 

After selecting necessary variant, press  and repeat the steps for the second point. At the next two 

steps, system automatically finds the nearest points for connecting with harness and provides a way to 

define path segments for these points. The action is performed similar to the previous one, by selecting 

edges of the box. Similarly, you can construct path for  the route without using harness. 

 

The final step - a preview of the result. You can confirm the creation of the route by pressing , or with  

option  return to the previous steps to adjust any settings. 
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After creation the route is available for editing by standard tools of editing routes: you can change the 

types of segments, add rounding, etc. 

 

ROUTING ST YLES  

Style is a group of settings designed for automatic filling of routes with the routing objects. Styles usually 

correspond to standards that are commonly used in the routing design. For example, parts of the pipeline 

must often comply with certain requirements in length and diameter; in addition, these parts should 

include fittings of certain materials. 

Style definitions are managed in the editor of Styles. With the editor, you can view, add, edit, and delete 

styles. The definitions of styles can be also imported and exported using file in .xml format. You can change 

any of the default styles, or use them as the basis for creating new custom styles. In addition, custom styles 

can be created based on the empty style. 

Editor of styles can be called from the Routing menu: 

 

Icon Ribbon 

 

Routing → Options → Styles 

Keyboard Textual Menu 

 Tools > Routing > Styles 
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After calling the command you will see the dialog of Routing Styles editor. 

 

There is a toolbar in the upper part of the dialog: 

 Create Catalog creates new folder-catalog for styles. 

 Create Style creates new style in the current catalog. 

 Copy Style copies selected style. 

 Paste Style paste copied style into selected catalog.  

 Delete deletes style or catalog. 

 Update information about fittings – updates information about routing objects (fittings). 

On the left there is a list of catalogs and styles availabe for usage. 

Created styles can be exported and imported in *.xml format with the appropriate commands in the File 

menu. 
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Parameters of the selected style are displayed in the right pane. 

Properties tab  

Name. In this field you can set the name of 

style that will appear in the list in the left pane. 

Catalog. The drop-down list contains catalogs 

that may include the selected style. You can 

create a new catalog by selecting the 

appropriate menu item from the drop-down 

list, if desired. 

Weld length (default). When the flag is active, 

you can set the default weld length. 

Use flange. Defines the usage of flanges for 

style. 

Minimal and Maximal diameters define the 

permissible routing diameters. 

Components window displays the list of 

fitting types and their corresponding files. 

 

 

You may use the following button when working with the Components dialog: 

 Delete Component. Deletes selected file from the list. 

 Select Component. Adds file to the list. 

 Delete All Components. Deletes all files from the list. 

After mouse click in the <select> field or pressing button , the following window appears: 
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This window displays all library files available for selection. 

If the fragment name is highlighted in red, it cannot be selected. 

Rules tab. 

Minimal pipe length, Maximal pipe length 

- set the minimal and maximal length of the 

pipeline segment. 

Increment of pipe length. You can specify 

the length of increment. Increment of length 

is a step with which the system takes into 

account the above conditions. 

Use Pipe operation to fill indirect path 

segments.  

When the flag is set the pipeline will be bent 

with a given style. 

 

List of libraries for selection consists of libraries marked as available for selection. Use Tools > Libraries 

command of Routing Styles dialog menu to mark necessary libraries in the list of all system libraries. 

  



Three-dimensional modeling 

592 

 

Filling Route with Style 

To apply styles, use command route Fill route with style, available for all types of routings. 

Icon Ribbon 

 

Routing → Construct → Fill route with style 

Keyboard Textual Menu 

 Tools > Routing > Pipeline > Fill route with style 

 

The following actions are available in automenu after activating the command: 

 <P> Select Route 

 <B> Select start point on route 

 <E> Select end point on route 

 <D> Cancel start and end points 

 <A> Select alternative routes 
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 <L> Cancel alternative routes 

 <N> Next 

 <M> Back 

 <C> Clear Route 

 <R> Resume command operation after applying changes 

 Upon activation, you need to select the main route to create routing. 

 

 and  allow to set limit for routing. Element will be generated or deleted on the specified segment 

of the route. 

 Cancels selection of the start and end points. 

 Allows you to choose alternative the routes. These routes must be connected with the main route. 

 Cancels selection of all alternative routes. 

 Provides preview of the operation result. After the first press preview is done on the main route , 

after the next pressing – on alternative . 

 Returns to the previous preview step. 

 Deletes all routing components of a route - nodes, LCS, fragments. 

 Allows you to create a new routing immediately after the creation of the current routing. 

 



Three-dimensional modeling 

594 

In the Properties window, you can specify parameters for 

the created element. 

Pipe Style - one of the styles for filling routes can be 

selected from the drop-down list. The list stores up to ten 

previously used styles. 

Diameter – pipeline diameter is set here. Diameter should 

be in the range specified in the parameters of the selected 

style. 

Internal Diameter - when checked, the defined diameter is 

treated as internal. 

Wall Thickness - allows you to specify thickness of the pipe 

wall. 

Weld / length – this  field defines the gap between the 

components for welding. 

Pipe bend. If library does not have appropriate fitting for 

rounding, then this option will bend the pipe. When you 

bend pipe weld option is not taken into account. 

Material of components. This list contains materials used 

in the current model. 

Color of components. Color of shading for pipeline 

elements. 

Green and red colors in the data fields show the 

possibility of correct usage of the entered value. 

 

 

 
Original route Route filled with style 
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3D PICTURES 

Unlike fragments, a 3D picture is a hull of a three-dimensional object, without parametric properties and 

relations between the picture elements. 3D pictures are used for creating three-dimensional assembly 

structures.  

3D pictures cannot be used as the references for creating other elements, since their faces cannot be 

selected. You cannot use 3D pictures in Boolean operations either. Their 2D projections cannot be created. 

The command “Exploded View” cannot be applied to 3D pictures. 

You can insert into a T-FLEX CAD document the 3D picture files in the following graphic formats: grb (T-

FLEX CAD files), wrl (VRML files), iv (Open Inventor files), x3d, 3ds, ply, obj, stl, dxf, dwg.  

To save a 3D picture is part of a T-FLEX CAD document, that already contains a 3D model, set the parameter 

Save 3D Picture on the Save tab of the Document Parameters dialog box.  

To save a 3D picture in a separate file in the iv, wrl, 3d, ply, obj, stl formats, use the command File > Export. 

Remember: storing a 3D picture inside a T-FLEX CAD file noticeably increases the file size. The size 

of the 3D picture itself depends on the mesh density defined in the Document Parameters at the 

time of the picture creation. 

CREATING 3D  P ICTURES  

To insert a 3D picture into a model, use the command 3I: Insert 3D Picture: 

Icon Ribbon 

 

3D Model → Modify → 3D Picture 

Keyboard Textual Menu 

<3I> Operation > 3D Picture 

Upon calling the command, you get the access to the following actions: 

 <Q> Repeat existing 3D Picture 

 <S> Select or create source LCS 

 <T> Select or create target LCS 

 <F> Select 2D Fragment 

 <O> Select file 

 <R> Repeat previous 3D Picture 

 <I> Multiple iterated insertion of 3D picture  
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To insert a 3D picture into an assembly, you need to do the following steps: 

 Select a 3D picture.  

The selection can be done in three ways: 

 By applying a new 3D picture (the option ); 

 By selecting an already inserted 3D picture (the option ). 

 By selecting an already inserted 2D fragment, using its 3D model (the option ). 

 Select or create the 3D picture's source coordinate system (the option ). 

 Select or create the target coordinate system (the option ).  

 Define the 3D picture parameters (optional). 

 Finish inputting the 3D picture (  in the automenu or in the property window). 

Files can be selected either from the T-FLEX CAD library or from any folder on the disk. 

In the drop-down list of option  you can choose one of the three sources for the 3D picture. 

 

When you select option Select and make embedded, inserted 3D picture will be stored in the current 

document, not in an external file. Option Select embedded document appears only for files with 

embedded documents. 

The name of the selected/internal document will be shown in the command's properties window (to the 

left of the button ). Grey (not accessible for editing) field, located a little below is informational and 

shows the absolute path to the file from which the picture is taken. 

 

If you press button  after selection of the pathname, the drop-down list will appear: 
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The first three options are the same as for option . Option Make external allows uploading of 

the embedded picture to an external file. Option Clear allows quick removing of the pathname. 

After adding 3D picture, you can change its position in space with special manipulator that appears 

in 3D window. By default, the origin of the manipulator is located in the center of the bounding box. 

If necessary, you can change the position of the manipulator by using option  Select or create 

source coordinate system. Unlike the creation of 3D fragment, the original coordinate system of the 

3D picture cannot be bound to the picture, because it has no geometric data. In the rest, the process 

of selection/creation of source and target coordinate systems is similar to the process of inserting 3D 

fragments. This process is described in the Chapter Assigning Transformations to 3D Entities. 
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3D  P ICTURE PROPERTIES  

Transformations of 3D picture (translations and rotations) are displayed in the Transformations. Optionally 

section of the properties window. Optionally, you can specify exact values for any transformation in the 

list. 

 

For the inserted 3D picture can be specified the units of measurement. After that, its size will be 

automatically recalculated. This function is useful for formats, which do not contain data about source 

measurement units of the picture. In this case, system will use measurement units specified in section 3D 

of Document Parameters command. 

  

In the properties window, you can specify the scale of 3D picture. The scale may be uniform along all 

axes or can be set separately for each axis. To specify a non-uniform scale it is necessary to remove the 

flag Uniform scale. 

 

 

In section Options you can set flag Create internal document. If the flag is active, the picture file is saved 

in the current document. This allows you to increase the speed of data loading. Otherwise, when you open 

a document, the system loads an external picture file. 

 

Option  allows to reinsert previously created picture. 
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Option  starts multiple insertion of previously created picture. The insertion is repeated until it is 

interrupted. 

USE OF 3D  P ICTURES FOR CREATING LAYOUTS  

When creating layouts based on objects with fixed dimensions, we recommend using 3D pictures. When 

rebuilding such 3D assembly models, 3D picture regeneration is much faster than assemblies consisting of 

3D fragments. 

The layouts using 3D pictures are created in the same way as those based on 3D fragments, with the only 

difference that the 3D picture is not created automatically when inserting a 2D fragment. The 3D picture is 

inserted manually by selecting the 2D fragment. 

When inserting a 2D fragment for creating a layout using 3D pictures, make sure that the flag is 

turned off, Create 3D Fragments automatically, on the Fragments tab of the command SO: Set 

System Options (“Customize > Options…”). 

You can get the detailed description of this system capability in the chapter “3D Assemblies Creation” (the 

section “Assembly creation from 3D fragments. ‘Bottom-up’ design technique”) with the corrections for 3D 

pictures. 

Only 2D fragments that were saved with enabled option “Save 3D Picture data in model file”, can 

be used for layouts. Note also that only rendered views may be created as 2D projections of 

assemblies built from 3D pictures. 

USAGE OF COATING MATERIALS  

 You can apply coating material for 3D pictures. There are two ways to do it. 

The first way is to apply the coating material to the 3D picture using drag'n'drop function. For this purpose, 

you need to open window Materials and to use the coating material from the list of model materials or 

from the Coatings library. 

The second method is to choose the coating material in the properties window of 3D picture. To do this, 

press option  in automenu and choose the tab “General”. Then, in the drop-down list of field Source 

select option From document. After that, the field Material becomes available. In this field, you can select 

the coating material for 3D picture. 
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It is important that the coating material can be applied only for the entire 3D picture, because it 

represents a single object. 

The option Apply by UV coordinates is available in the parameters of 3D Image. The option allows to apply 

material by UV coordinates that are stored in the 3D image file. 

 

3D  P ICTURES EDITING  

To edit a 3D picture use command: 

Keyboard Textual Menu Icon 

<3EI> Edit > Operations > 3D Picture  

More information about this command can be found in the chapter Editing. 

When editing a 3D picture it is possible to replace it with another one. This new picture can be either 

loaded from a file or can be defined by selecting other existing picture from the scene. For the last case, 

you need first to use option: 

  <F4> Execute edit command  

Next you need to select option  in automenu and click on any existing 3D picture in the scene. Current 

3D picture will be replaced with it.
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EXTERNAL MODEL 

This command is intended for inserting 3D models in the Parasolid, STEP, ACIS , IGES, Siemens NX 

(Unigraphics), Creo/ProE, SolidWorks, Catia V5, Catia V4, Autodesk Inventor, Solid Edge, Rhino, I-Deas, JT, 

PRC, VDA-FS formats. The model inserted in this way becomes a normal operation of T-FLEX CAD. 

Remember, however, that an external model that is made of several operations becomes a single object 

upon inserting in T-FLEX CAD. To do further manipulations over a separate body of such model, you first 

need to use the operation Divide Solid. 

Inserting an external model resembles creation of a 3D fragment, however, with limited capabilities. Thus, 

for example, you cannot set the values of external variables. Neither can you select the original attachment 

coordinate system (the model global coordinates are used instead). 

MODES OF WORKING WITH EXTERNAL MODEL  

When inserting an external model, the current document keeps the reference to its file and its original 

geometry. In the future, the user can select one of the two modes of working with the external model: 

 In the first mode, the system tracks all changes to the external model file. If the file modifies, the external 

model adjusts in the current document. 

 In the second mode, the changes to the external model file are ignored. When working with the model, 

the geometry is used that was stored in the current document upon the last exchange with the model 

file. Nevertheless, the reference of the model file is saved in the current document anyway, which allows 

reverting to the first mode. Use of this mode provides fast handling of the current document with less 

memory required, however, it increases the size of the document when saved on the disk. This mode 

supports working with the document with an external model inserted in it, even when the external 

model file is absent. 

The second mode is turned on automatically, if the system fails to find the external model file. 

EXTERNAL MODEL INSERTION  

To insert a Parasolid-format model, use the command 3MO: Insert External Model: 

Icon Ribbon 

 

3D Model → Modify → External model 

Keyboard Textual Menu 

<3MO> Operation > External Model  

To insert an external model, you need to do the following steps: 

1. Select external model file. The selection of the external model file is done in the command 

property window or by the option: 
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<1> Select External Model 

 

There are two additional information fields in the external model properties dialog below the file name 

input field. One of them displays the full path to the selected external model file, the other one - the 

external model source file (that is, the file based on which the model was created). 

The source file data is displayed on the condition that the source file contains the respective 

information. 

The Open Source File command will be available in the context menu of the created external model. 

This command opens the source file if it exists in the path specified, by using the application 

matching the given file type. 

2. Select or create source coordinate system.  

Selection or creation of source coordinate system can be done by option: 

 <S> Select or create source LCS 

Coordinate system of external model is used by default. 

3. Select or create target coordinate system.  

Selection or creation of target coordinate system can be done by option: 

 <T> Select or create target LCS 

This option is set automatically upon selecting the external model. Selection of the target 

coordinate system amounts to selecting an LCS at which the external model’s coordinate system 

should be placed. If no coordinate system is selected, the global coordinate system is used by 

default. 

Selection of the target coordinate system can be undone by the option: 

 <3> Reset target LCS 

The process of selection/creation of source and target coordinate systems is described in the 

Chapter «Assigning Transformations to 3D Entities». 

4. Define the external model parameters (optional). 

The following parameters can be defined in the operation property window: 
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Update geometry. This parameter defines the mode of working with the external model. When 

the flag is set, the first mode is used (tracking all changes in the model file). Unsetting the 

flag turns on the second mode.  

Use imported materials. This parameter supports use of the original materials of the external 

model. 

The external model parameters can be defined in the common operation parameters dialog box 

called by the option: 

 <P> Set entity parameters 

5. Complete operation creation (  in the property window or in the automenu). 

While creating an external model, the system runs the consistency check on the imported model. If there 

are errors in the model, then a window is displayed with the error message and suggestions for possible 

actions. 

An external model can also be created by executing the command IM: Import Drawing Or Model 

(see the chapter “Exporting and importing documents” in the two-dimensional design and drafting 

user manual). 

EXTERNAL MODEL EDIT ING  

To edit an external model use command: 

Keyboard Textual Menu Icon 

<3EI> 
“Edit > Operations > External 

Model”  

You can change position of chosen external model or replace it with another one, loaded from a file with 

the help of this command. 

More information about this command can be found in the chapter Editing. 
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ARRAYS 

An array is an operation in T-FLEX CAD for creating copies of already existing 3D objects.  

The placement of created copies (array elements) depends on the array class: linear, circular, array by 

points, array by path, parametric array. Array elements can be positioned along the direction vector, at the 

specified step (linear array), on a circle about the specified axis (circular array), along a path (array by path), 

at the specified 3D points (array by points) or following the prescribed parametric law (parametric array). 

The source objects for creating an array (copy objects) can be selected among 3D construction elements, 

operations, Bodies and faces. The set of objects replicated in the array can contain several elements, 

however, of the same type.  

The arrays are divided into the following types, depending on the type of the objects to copy: arrays of 

construction elements, arrays of operations, arrays of Bodies and arrays of faces. All arrays of the same 

class share in creation and editing techniques, regardless of the array type. 

The copies resulting from any array except array of Bodies can be used in subsequent operations. The 

result produced by an array of Bodies can only be used for creating another array. 

ARRAY TYPES .  SPECIF ICS OF EACH TYPE  

All arrays are distinguished by the types of the copy elements as follows: 

 Arrays of construction elements; 

 Arrays of operations; 

 Arrays of Bodies; 

 Arrays of faces. 

Creation of any array begins from selecting its type.  

Array of Construction Elements 

An array of construction elements allows creating a special type of 3D elements – an array of 3D 

constructions. Arbitrary 3D construction objects can be selected as the objects to be arrayed, except 

sections, light sources and cameras. Those could be 3D nodes, 3D paths, 3D profiles, workplanes, etc. The 

same array can combine construction objects of different types, such as, for example, 3D profiles and 3D 

paths.  

When creating an array of workplanes of any class, 2D drawing pages of the type “Workplanes” are 

automatically created for each array element. 
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The source construction elements are not included in the array. A “blank” is created in place of the source 

element (elements) in the array. However, an additional copy can be included in the array, coinciding with 

the position of the source element. 

                  

Array of Bodies and Array of Operations 

Arrays of Bodies and arrays of operations create copies of bodies already existing in the scene. The source 

object for arrays of these types is an operation. 

An array of operations copies results of a particular operation only. If another operation is created on top 

of that one, such as, for example, blending an edge, the array will not be affected. On the other hand, an 

array of Bodies replicates the whole Body, created by using the selected operation. If this Body is modified 

in the future, the array will be regenerated, accounting for new operations included in the Body history. 

                       

When an array of Bodies is built, a new 3D Body is created which is actually the array. The source Body 

(Bodies) is not included in the array (its place in the array is filled by a “blank”).  

An array of operations requires a specific setting regarding whether or not to include the source operation 

in the array composition. If the source operation is included in the array, it will be subjected to all 
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parameters defined for this array, such as the material, system-wide parameters (level, layer, color), 

transformation parameters, etc. Besides, if the operation selected for array creation is the last operation in 

the history of a Body, then this Body disappears upon the array creation, being replaced by the array.  

In the cases, when the source operation is not included in the composition of the array, then the operation 

itself and the Body that it creates will remain independent objects of the 3D model. The array in this case 

will have a “blank” in the position corresponding to the source operation location (just like in the case of 

creating a construction array). 

The following additional manipulations can be applied when creating any Body arrays and operation arrays: 

 Separate to Solids – the created array is automatically divided into separate Body copies; 

                     

 Combine Result to one Solid – all array elements are merged together by the Boolean addition. 

     

Array of Faces 

The main purpose of any array of faces is to add holes and protrusions to the existing Bodies of the 3D 

model, repeating design features already present in the given Body. Therefore, an array of faces is always 

created based on one particular Body in the model: all copied faces must belong to that Body. The set of 

copy faces resulting from the array creation will also be included into the source Body.  
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No array of faces creates a new 3D Body; rather, the existing one is altered by the array. 

                

An arbitrary set of faces can be selected for creating an array, except that it has to fully define the geometry 

of the hole, slot or protrusion of the part being copied. The copies must be created within the bounds of 

the source body.  

Creation of an array of faces may not affect the topology of the source body. Therefore, arrays should be 

created in such a way, that the copies of the faces intersected with the faces of the source body in the 

same way as the faces of the source set.  

                 

When specifying the set to array, you can select: 

 Edges surrounding a set of faces. A set of edges defines two possible sets of faces (we will call them 

the “inner” and “outer” sets with respect to the specified chain of edges). The system can automatically 

select the set to copy (judging by the least area) or let the user choose. 

 

The selected edges must make one or several close sequences (loops). 

 All faces to be included in the source set of the array; 

 The operation that created the desired set of faces (for example, the operation “Hole”). In this case, the 

array will keep a link to the selected operation. If in the future the geometry of such operation will 

change, the 3D array will regenerate accounting for the changes. 
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The following optional modes can affect the resulting array of faces: 

 Copy to one face. Use of this mode considerably reduces the array regeneration time. However, this 

mode can only be used when all elements of the array being created lie on the same face as the source 

set; 

 Extend Faces (used only in combination with the “Copy to one face” mode). This mode allows lifting up 

the requirement of "similar intersection" of the source set of faces and all arrayed copies with the faces 

of the source body. The system will be automatically extending or trimming the copied faces in order 

to insure their correct connection to the body. 

 Use of this mode is possible only in the case when all copies are located 

within the range of the same body faces, as the source set. 

     

 Check Intersection with other Faces (used to avoid body self-intersections). When using this mode, the 

system checks face copies for intersections with already existing body faces. If such an intersection is 

encountered, then array creation is aborted. 
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 Do not check body’s boundaries (enabled by default). When using this mode correctness of 

the resulting array is checked once after creation of all copies. While doing so the system 

checks the resulting copies only according to the following criterion: they must lie within the 

limits of at least one of the body’s faces. This check does not exclude entirely appearance of 

errors in cases when the faces-copies lie on the faces boundaries but nevertheless reduces 

by several times the construction time of a large array.  

When the “Do not check body’s boundaries” mode is disabled the system before the start of 

copying checks whether the result of copying is situated outside the boundaries of all body’s 

faces. If so, these faces-copies are just not created. The second stage of checking is carried 

out after copying – the created faces-copies are checked for intersection with the boundaries 

of that face of a body onto which they were copied. If this intersection for a copy is found, 

this copy is removed from the array. This work mode provides for larger reliability of the array 

construction mechanism but significantly increases its construction time. 

ARRAY CL ASSES .  SPECIF ICS OF EACH CL ASS OF ARRAYS  

All 3D arrays created in T-FLEX CAD can be distinguished by the way of copying into the following classes: 

 Linear; 

 Circular; 

 By Points; 

 By Path; 

 Parametric. 

Linear Array 

The linear array is created by placing copies of the source objects along one or two direction vectors. 

Depending on the number of the direction vectors, it will be either one-dimensional or two-dimensional 

array. All elements of the linear array lie in one plane. 
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The direction vectors of a linear array are defined either by two 3D points (in this way, the vector will be 

directed from the first selected point to the second one), or by a single 3D object suitable for defining a 

vector in the space. 

The array size along each direction is characterized by the number of copies, the placement step and the 

total length of the array in the given direction. To define an array, you need to specify just two of the three 

parameters. Depending on the mode used, it can be: 

 Number of copies and step; 

 Total length and step; 

 Number of copies and total length. 

In any of the modes, one of the specified parameters (the array step or the total length in the given 

direction) can be automatically calculated by the system based on the length of the direction vector and 

the value of the other parameter. 

 

The number of copies along each direction vector always includes the source object being copied (even if 

it is not included in the composition of the array). For example, the array shown on the above diagram 

contains 4 copies in the first direction and 3 copies in the second direction.  

A linear array allows creating copies not only forward, but also backward along each direction vector. The 

backward copies are created with the same step as the forward-going copies along the given vector. The 

number of copies in the backward direction can either be the same as in the forward direction along this 

vector, or specified by a separate numerical value. 
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Circular Array 

In the circular array, the copies are placed on a circle about the array axis. The axis of revolution of a circular 

array is defined, just as the direction vectors in a linear array, by selecting two 3D points or one 3D element 

suitable for defining a vector in the space. 

 

The position of array elements about the axis is determined by the number of copies, the rotational step 

per copy and the total angle of elements rotation about the axis. The copy rotational step determines, by 

what angle to rotate the source body about the axis to place the first copy. The second copy is created by 

rotating the first one by the same angle, and so on. The rotation is done in the clockwise direction, as 

watched along the array axis.  

Backward rotation is possible, including simultaneous creation of copies in two directions – forward and 

backward. The backward rotation is done with the same step as the forward one, while the number of 

copies may differ. 

 

To define an array, you need to specify two defining parameters out of the three, for example: 

 Number of copies and step; 
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 Total angle and step; 

 Number of copies and total angle. 

The third parameter is calculated by the system automatically. 

The rotation step or the total angle of the arrayed elements can be defined by two additional 3D points. 

The sought angle will be equal to the angle between the planes passing through the rotation axis and the 

respective 3D point. 

When copies are created, there are two possibilities for a copy’s orientation: rotated and parallel-translated. 

In the first case, a copy is created by actually rotating the source body about the array axis. In the second 

case, the source body is copied without rotation about the axis (meaning that orientation of each copy in 

the space is the same as the source body orientation). 

                 

The circular array also allows creating copies in the second direction: in the radial direction of the array. In 

this case, array elements will be located in one plane, making up a pattern of concentric circles. 

Alternatively, the second direction can be chosen along the axis, with the array elements put on a cylinder. 

                    

The number of copies along the second direction is specified in the same way as in the linear array. 

Array by Points 

To create a 3D array by points, select the base 3D point on the array’s source object, and an arbitrary 

number of target 3D points (into which the source object will be copied). The arrayed elements will be 

placed in the specified 3D points. 
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The target points are defined with successive selection of single 3D points (3D nodes, vertices, etc.) or 

arrays of 3D nodes. The list of target points of an array may contain both 3D points and arrays of 3D nodes. 

Array by Path 

In the array by path, the placement of the array elements is defined by one or two 3D curves. Such an array 

can be considered analogous to the linear array, however, with the copies placed along one or two spatial 

curves rather than straight lines. Those curves can be represented by arbitrary 3D curves (3D paths, 3D 

profiles, curvilinear edges, etc.). If a closed 3D curve is selected, you need to additionally specify a 3D point, 

whose projection on the selected curve would determine the start of the array curve. 

Use of a single guide curve results in a one-dimensional array, two guide curves – in a two-dimensional 

array by path. For simplicity, let's first review creation of an array by one guide curve. 

                            

The placement of copies (array elements) along the guide curve depends on the following array 

parameters: number of copies, step and total length of the array along the given curve, and, additionally, 

the copies’ placement option.  

Number of copies, step and total array length along the guide curve are interrelated parameters. To define 

the array, you need to specify just two parameters out of the three. The omitted parameter will be 

calculated by the system automatically. The total array length can be evaluated by the guide curve (the 

system will determine the curve length, and then take the resulting value as the length of the array in the 

given direction). 

The total array length may not exceed the length of the guide curve. 
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The placement option determines: 

- The position of the copies’ placement points (array elements) along the guide curve. Depending 

on the used placement option, the step of the array by path determines either the distance along 

the path between the fixing points of the copies or the path’s chord length. 

- The orientation of copies in the space. The position of copies in the space is determined by 

bringing the target coordinate system of each copy over the source coordinate system of the 

object being copied (that case, the source object of the array). The source coordinate system is 

created at the start of the guide curve, while the target – at the fixing point of the particular copy. 

The axis orientation of either coordinate system is defined by the copy placement option. 

There are the following copy placement options: 

 With offset by path. The target coordinate 

systems of all copies are placed along the path 

according to the specified step and “number of 

copies” parameters. The axis orientation of 

those coordinate systems is fixed and does not 

depend on the 3D path geometry.  

This placement option can be used, if you need 

to put copies of the source body along the guide 

curve, preserving the spatial orientation of each 

copy as that of the source body. 

 

 

 With minimum twist by path. The X-axis of the 

target coordinate system of each copy is 

determined as to provide smooth rotation of the 

curvature vector from the start to the end of the 

path. The Z-axis always points in the direction 

tangent to the path at the origin of the current 

copy's coordinate system.  

An example using an array by path with minimum 

twist by path as a model of a conveyor belt. 

 

 

This example can be found in the library “Examples”, in the folder “\3D 

Modeling\Arrays\Conveyor.grb”. 
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 By span. To find the position of the first copy, a sphere 

is created with the center at the path start and the 

radius equal to the array step. The copy will be placed 

at the intersection point of the sphere and the 3D path. 

Next, another sphere is constructed with the center at 

this point, and so on. This is how attachment points of 

all copies are determined. The target coordinate 

systems of the copies are placed in those points. The 

X-axis of a target coordinate system is oriented by the 

incoming chord of the 3D path. A path chord is defined 

by the attachment points of two neighboring copies. 

 

 

The source coordinate system is located at the start of the path. 

Its X-axis points toward the first copy’s position. With this copy 

placement option, the array step is the chord length of the 3D 

path. 

This placement option can be successfully implemented, for 

example, in caterpillar belt and chain drive design. 

 

 

A caterpillar belt design example is provided in the library “Examples”, in the folder “\3D 

Modeling\Arrays\Track.grb””. 

The two-dimensional array by path is created similarly. The set of parameters is defined for the second 

guide curve in the same way, including the step and total length of the array in that direction and the copy 

placement option. Note that the source object in the second direction will be the complete set created by 

the one-dimensional array along the first guide curve. 

              

Parametric Array 

The parametric array uses a universal approach that allows creating an array by parametric copying of the 

source element. The same approach is used in the “By Parameters” operation and in one of the 3D path 

creation modes. The algorithm of face approach is described in details in the “Parametric sweep” chapter. 

Therefore, the current topic just briefly touches upon the algorithm description and the typical examples. 
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A parametric array can be an array of bodies, operations or construction elements only. Parametric 

arrays of faces cannot be created. 

To create a parametric array, you need to define the law of calculating the so-called coordinate system of 

the current copy. The copying of the array source object is done in the direction from the source 

coordinate system to the calculated target coordinate system of the current copy.  

The user can select one of the model's local coordinate systems as the source coordinates. If no local 

coordinate system was selected, then the global coordinate system is used as the source coordinates. 

The coordinate system of the current copy (particularly, its origin and axis orientation) can be defined in 

one of the two ways:  

 Free copy orientation. Modifications of the coordinate system parameters of the current copy 

are described by expressions.  

 Copy orientation by 3D curves or surfaces. To define the spatial position of the current copy’s 

coordinate system, use the appropriate 3D curves or surfaces of other bodies. By managing 

the copy’s coordinate system, you control the position of each copy. 

The position of a copy’s coordinate system is controlled by the array parameters. All parameters are divided 

into two types - driven parameters and driving parameters. 

Driven parameters are the parameters whose values are calculated automatically during element creation. 

One can introduce independent variables to read the values of such parameters.  

Driving parameters are the entries whose values are specified by the user. The entries for the driving 

variables permit arbitrary expressions including any system variable. For example, including a variable 

keeping the copy ID number, in such an expression, will make the given parameter depend on the copy 

ID. 

Some array parameters can be sometimes driving, and sometimes driven. The leading parameter “Number 

of copy” is always driven. It definitely requires assignment of an independent variable that will be tracking 

the current copy ID number during the operation processing. The copy number is automatically 

incremented through the array calculation, starting from 1, up to the specified quantity, with the step equal 

to 1. 
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The calculation is done in the following order: the copy number is assigned the next ordinal number, then 

the driving parameters are calculated, then the driven parameters are calculated (if any), and, finally, 

copying is done. 

 

When using the free copy orientation option, just select the array source object, specify the number of 

copies and assign independent variable to the “Number of copy” parameter. By using the variable assuming 

the current copy number, one can introduce certain relations in the entries of driving parameters, as well 

as in 2D or 3D constructions, and make the geometry of the original body, in turn, depend on those 

relations. 

 

An example of a parametric array with free copy orientation is a model of a spiral staircase, as shown on 

the diagram at the beginning of this topic. 

 

The copy orientation option by path or by surface is convenient in the cases when defining the expression 

for the exact law of the copy parameters modification is not feasible. In such cases, it is convenient to use 

various 3D curves or surfaces for specifying the position and orientation of the current copy’s coordinate 

system. 

L IMITATIONS AND EXCLUSIONS  

Limitations and exclusions are used to exclude some of the created copies from an array. 

Limitations 

Setting a limitation means defining a subset of the 3D space to which copies creation is limited – limitation 

scope. When in this mode, all copies that are created per the main array parameters are checked by the 

system for falling in the limitation scope. If a copy fully falls within the scope, it will be included in the 

resulting array. If a copy is located outside the limitation scope or fits in but partially, it is not included in 

the resulting array. 

 

Limitations may not be available with all classes of construction element arrays, and are not available 

with any parametric arrays. 

The limitation scope is defined by a 3D object with sheet geometry – a face, 3D profile or a sheet body. 

The selected object is swept from both sides along the limitation axis for the infinite distance. The resulting 

swept area will be the limitation scope of the array.  
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If the limitation scope is defined by a flat 3D object, then the limitation axis coincides, by default, with the 

normal of the selected object’s plane. If necessary, you can specify an arbitrary direction of the limitation 

axis by defining the axis directions by two 3D nodes or one 3D object suitable for defining a straight line. 

In the cases when the array limitation scope is described by a non-flat sheet 3D object, the limitation axis 

must be explicitly specified. 
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The limitation scope can also be defined by multiple sheet 3D objects. All objects are swept in the same 

direction. The limitation scope will be the sum of the scopes swept by each of the selected object. 

             

Exclusions 

Exclusions, or excluded elements are the array elements that shall not be included in the resulting array. 

Any array elements can be excluded, except the source object. 

Exclusions can be defined for the following array classes: linear, circular and array by path. 

An exclusion is specified by its position in the original array, that is, the column and the row in the array, 

at whose intersection this element is located (in the cases of the circular array and array by path – 

generalized “row” and “column”). The dimension of the array in the first direction defines the number of 

rows, in the second the number of the array columns. 

Rows and columns in arrays are numbered as follows:  

- 0, 1, 2, …, N-1 – in the forward direction (N is the number of copies in a row/column in the 

forward direction) 

- -1, -2, …, -M+1 – in the backward direction (M is the number of copies in a row/column in 

the backward direction). 

Note that the column and the row numbers, in which the source object of the array is located, are 

0. This is important when defining exclusions. 

You cannot exclude the array element with the coordinates (0,0) from the array of Bodies. 
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Instead of the number of particular rows/columns, one can use descriptive characteristics defining their 

position in the original array: 

- Starting row/column is the row/column in which the source object of the array is located (the 

number 0); 

- Last row/column is the row/column, which is the last in the forward direction of array creation; 

- Last in Opposite Direction row/column is the row/column, which is the last in the backward 

direction of array creation; 

This way of specifying exclusion locations is convenient for removing elements of the outer rows/columns 

from the arrays of variable size, especially when the array dimensions are defined by the total length and 

the step, or the total length and the number of elements. Suppose, for example, that you need to exclude 

an element in a linear array of size 5x4, that is located at the intersection of the last row and the last column 

of the array (assuming that the copies are created in the forward direction only along both vectors). One 

can simply specify the element at the intersection of the row number 4 and column number 3 as the 

element to exclude. However, should the array grow (for example, to 6 rows and 5 columns), the excluded 

element will have the same exact coordinates (the last row will be now number 5, and the column – number 

4). Instead, to have specifically the last element of the array always excluded, the exclusion should specify 

the element at the intersection of “the last” row and “the last” column. 
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Each specified exclusion can be subjected to the following additional options: 

 Whole row exclusion. Use of this option causes exclusion of the whole row with the specified element 

from the array; 

 Whole column exclusion. With this option, the column with the specified element is excluded from the 

array; 

      

 Cyclical Iteration. The result of applying this option depends on whether the previous options are used. 

If those are not used, then use of this option will cause deletion of not only the original exclusion, but 

also the elements following it after the same number of rows and columns from the start of the array. 

If this option is used together with the previous ones, the whole cyclically repeating rows or columns 

will be excluded. 
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MODIFYING NUMBER OF COPIES  IN ARRAY .  REFERENCING ARRAY 

ELEMENTS  

When the number of copies of any array changes, then additions or deletions of elements occur 

immediately before the last array copy in the given direction. The IDs of geometrical components in the 

elements of the outmost array rows and columns do not change through such additions or deletions 

(outmost are the first and the last elements in any direction).  

Therefore, any operation created on an element of the first or the last row (the first or the last column) of 

the array stays intact through any changes in the array dimensions. For example, an edge blend created 

on an element of the last row in an array of Bodies or operations, will regenerate correctly, regardless of 

increases or decreases in the number of rows in the array. 

Operations created on “inner” copies of the array could run into regeneration errors, as the array 

dimension is decreased. 

        

CREATING 3D  ARRAYS  

The following commands are used for creating an array: 
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Keyboard Textual Menu Icon 

<3AL> Operation > Array > Linear 
 

<3AR> Operation > Array > Circular 
 

<3AN> Operation > Array > By Points 
 

<3AP> Operation > Array > By Path 
 

<3AA> Operation > Array > Parametric 
 

 

The user interface of the above commands is similar. Therefore, the further description applies to 

all arrays, unless specifically mentioned. 

To create any array, upon calling the respective command, do the following steps: 

 Select the type of the array to be created (array of construction elements, array of operations, 

array of Bodies, array of faces); 

 Select source objects of the array; 

 Select the guiding elements and define the main array parameters (the actions performed at 

this step depend on the type of the array being created); 

 Define advanced array parameters. The set of available modes controlled by those parameters 

depends on the array class – see the section “Array classes. Specifics of each class of arrays”; 

 Define limitations and exclusions (if necessary and possible); 

 Confirm array creation (  in the automenu or in the properties window). 

Selecting Array Type and Array Source Objects 
 

The array type selection is done in the properties 

window of the respective command. The section 

“Common” of the properties window begins for all 

arrays with a combo box for selecting the required type. 

The item “Array of faces” is not available in the 

combo box of the parametric array. 

Depending on the selected type, one of the following 

options for selecting the array source objects will be 

provided in the automenu:  

 

 <N>  Select construction 

 <N> Select source 3D operation (for arrays of operations) 
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 <N> Select source 3D operation (for arrays of Bodies) 

 <N> Select faces to copy or their boundary edges or loops 

 

The selected objects will be put into the list of the array source objects in the operation properties window. 

To resume selection of source objects at any stage of array creation, simply focus on the pane of 

the source elements list. The selection option will turn on automatically. 

To undo selection of some of the selected objects, click it in the list and press the button . 

Note that once the first object to be arrayed is selected, the entry defining the array type becomes 

inaccessible. To change the array type, you need to remove all 3D objects from the list of the array 

source objects. Only after that, you will be able to select another array type. 

3D construction elements and operations are selected by 

simply picking those either directly in the 3D scene (by 

) or in the model tree. 

To select a 3D Body, you can pick any of the operations 

contributing to this Body (again, either in the 3D scene, if 

that is possible, or in the 3D model tree). The Last 

operation of the given Body will be automatically put in 

the list of the selected objects.  

Selection of source objects for an array of faces requires more close consideration. 

Selecting source set of faces for array of faces 

The pulldown list of the option for selecting a set of faces to copy  allows choosing the way of selecting: 

direct selection of faces, selection of their bounding edges, selection of the operation (the same filters are 

duplicated by the system toolbar). 

 

The first item of the pulldown list  turns on all filters simultaneously. 

 

To select the operation that created the desired set of faces, activate the filter . This filter has higher 

priority than other filters in the list. Therefore, if any other filter is turned on simultaneously with the 

operation selection filter , such as, for instance, the face selection filter , then the operation will be 

put in the list of the source objects for arraying, regardless of what was selected by the user – an operation 

or a face. That means, if a face is picked in the 3D scene, then the whole operation that created that face 

is put into the list of objects to array. This property of the  filter allows quick selection of operations by 

a pick on an edge or face. 
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To enable selection of individual faces for the set to array, the  option should be turned on, while the 

option  – off. 

To select edges (or a chain of edges at once) surrounding the 

desired set of faces, turn on the filters  (for individual edge 

selection) and/or ,  (for selecting a whole chain of 

edges). Meanwhile, the option  must be turned off. 
 

Which set of faces from the two possible sets, defined by the specified chain of edges, will be selected as 

the source object for the array, is determined by an additional flag Alternative Face Selection in the 

properties window.  

 

The flag has three states: on by default , on  and 

off .  

To let the system choose the set of faces automatically 

(by the least area condition), set the flag in the default 

state . If the further manipulations with the 3D model 

will alter the balance of the areas, the system will 

automatically switch to the other set of faces as the 

source object of the array.  

In the cases, when you want to specify one of the two possible sets of faces explicitly, use the two other 

states of the flag (on  and off ). Each of those will correspond with a particular set of faces. Which set 

of faces corresponds to which particular state of the flag is arbitrarily defined by the system upon specifying 

the set of edges. In this case, no future changes in the model will affect the set of faces being arrayed. 

 

Defining the Guiding Elements and Main Array Parameters 

Linear array 
To define the direction vector of a linear array in the first direction, use the following automenu options: 

 

 <D>  Select first direction 

This option allows defining the direction vector by one 3D element (a straight edge, a face, etc.). 

 

The options below allow defining the direction vector by two 3D points: 

 

 <F> Select first direction starting point 
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 <S> Select first direction ending point 

 

Undoing selection in either case is done by the option: 

 

 <K> Reset first direction selection 

 

Similar options are provided in the automenu for defining the second direction vector: 

 

 <J>  Select second direction 

 <T> Select second direction starting point 

 <O> Select second direction ending point 

 <L> Reset second direction selection 

 

The array size is defined in the operation properties window 

similarly for both direction vectors. The array parameters in the 

first direction are defined in the section First Direction (Rows), 

in the second direction – in the section Second Direction 

(Columns). The buttons  in each section help quickly flip the 

direction of the respective vector without redefining it. 

The first entry in each section is a combo box for selecting the 

parameters to define: Number of copies and step, Total length 

and step and Number of copies and total length. Depending on 

the choice you have made, the following entries for defining the 

respective parameters will be provided below: Number – allows 

defining the number of copies in in the given direction, Step and 

Length – define, respectively, the step and the array length in the 

given direction. 

To have the step or the array length be automatically calculated 

from the vector length, set the flag next to the respective 

parameter. In this case, the input box becomes inaccessible.  

To create array copies in the backward direction along the direction vector, set the flag Reverse  direction  

in the properties window section corresponding to the desired vector. In this case, the switch becomes 

accessible for defining the number of copies in the backward direction. To have as many copies as in the 
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forward direction, choose Symmetric. To define a different number of copies in the backward direction, 

switch to Number and enter the desired number of copies. 

Circular array 
To define the axis of a circular array, you can use the following automenu option: 

 <A> Select axis of rotation 

This option allows defining the array axis by selecting a single 3D element. 

The following options allow defining the axis by two 3D points: 

 <F> Select 1st Point of axis 

 <S> Select 2nd Point of axis 

To cancel selection in either case, use the option: 

 <K> Cancel axis of rotation selection 

The array size is defined in the operation properties window. The array parameters in the first direction 

(rotation about the axis) are defined in the section Rotation (Rows), in the second direction – in the section 

Transfer (Columns). 

Parameters of the circular array in either direction are defined in the same way as the respective parameters 

of the linear array. The only difference is the additional flag Parallel offset. When the flag is cleared, the 

array is created by rotating copies about the axis. To create an array with copies parallel-translated, turn 

on this flag. 
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To define the rotation step or the total angle of the array by two additional 3D points, use the following 

automenu options: 

 <T> Select starting point of Rotation 

 <O> Select ending point of Rotation 

Those options become accessible after specifying the array axis. Once the points are defined, the respective 

parameter input boxes become inaccessible (the step or the total array angle). 

 

Selection of the additional points can be canceled by the option: 

 <L> Cancel selection of points for Rotation 

Using draggers in linear and circular arrays 
You can use draggers to define array parameters (number of copies, step and total length of the array in 

each direction) in both the linear and the circular arrays. Those allow, depending on the way of defining 

array parameters, setting either the number of copies, or the step, or else the total length (total angle) of 

the array. 
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The draggers appear as array elements painted Red 

(by default). As the pointer approaches a dragger’s 

image, it changes to  or  (depending on the 

parameter controlled by the dragger). If at this 

moment you start dragging the mouse with the  

button depressed, then the wireframe preview of 

the operation being created will start 

rubberbanding, while the value of the respective 

parameter will be adjusting in the properties 

window. 

 

Array by points 
The base point on the source object of the array is specified by the automenu option: 

 <S> Select point of source position 

This option automatically activates upon selecting the source object of the array. 

Once the base point is selected, the option for defining the target points becomes active: 

 <T>  Select point of target position 

 

The option allows sequentially picking an arbitrary number of target points. The selected points are put in 

the Target points list in the operation properties window. 

 

Array of 3D nodes can be selected with option: 

 <A> Select Array of 3D Nodes as Target Points 
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Selection of points can be undone in two ways. All selected points can be rejected by the command 

automenu option: 

 <K> Cancel points selection 

Any point can be removed by clicking it in the list of target points in the properties window and pressing 

the button . 

Array by path 
The first guide curve of an array by path is selected by the option: 

 <T> Select first guide curve 

The starting point on a closed curve is specified by the following automenu option: 

 <S> Select start point on closed path 

To undo a point selection, you can simply select another point or use the option: 

 <K> Cancel start point on closed path 

 

The similar set of options is used for defining the second guide curve: 

 
<O> Select second guide curve 

 <F> Cancel selection of second guide curve 

 <B> Select start point on closed path 

 <R> Cancel start point on closed path 

The array size is defined in the operation properties window. The array parameters in the first direction 

(along the first guide curve) are defined in the section First Direction (Rows), in the second direction – in 

the section Second Direction (Columns). 
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The array by path parameters in either direction are defined similar to those in the linear array.  

Placement option in each direction is defined by selecting the desired choice from the combo box located 

at the bottom of each section. 

When using the orienting method By span, the array size in the given direction can be defined only 

by the option Number of copies and step. 

Parametric array 
The following options are provided in the automenu for creating the parametric array (those become 

accessible after selecting the source object of the array): 

 <1> Select curve defining position of coordinate system 

 <2> Select curve defining X direction of coordinate system 

 <3> Select curve defining Y direction of coordinate system 

 <4> 
Select surface defining X direction of coordinate 

system 

 <5> 
Select surface defining Y direction of coordinate 

system 

 <6> Select source LCS 
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 <7> 
Cancel selection of elements defining coordinate 

system 

As was mentioned earlier, creation of a parametric array is similar to creating a parametric sweep. This 

technique was described in details in the chapter “Parametric sweep”. Here, we will review the array creation 

on the example of a spiral staircase. 

The example files are located in the library “Examples”, in the folder “\3D Modeling\Array\Winding 

Stairs.grb”. 

The model is built as a parametric array with free orientation of copies based 

on the 3D fragment of one step of the staircase. 

When creating an array in this way, just select a body, specify the number of 

copies and assign an independent variable to the parameter “Number of 

copy”. By using the variable assuming a copy’s ordinal number, you can 

define certain relations in the driving parameters input boxes, as well as in 

the 2D or 3D constructions defining the position and geometry of the source 

body. 

In this example, a step of the staircase is copied with a change in the height 

and rotation angle about the staircase axis. For convenience of handling the 

model, the following variables are created in the variable editor: 
 

  

The step of the spiral staircase is inserted in the document as a 3D fragment. This fragment is inserted in 

such a way, that the axis of the staircase coincides with the global Z-axis. If the fragment were located 

arbitrarily, then one would have to select a local coordinate system, using the option: 

 <6> Select source coordinate system 

Its Z-axis must have been directed along the staircase axis. 
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In this example, the expression defining the position of each copy depending on the copy count number 

can be entered in the input boxes of the driving parameters. The array parameters can be defined in the 

properties window or in the operation parameters dialog box. 

    

Positions of copies will be calculated by the linear law along the global Z-axis with the step defined by the 

variable h. The X-axis of the current copy’s coordinate system will be rotated about the axis of the staircase. 

This moment of the X-axis is defined by the X-axis position parameter group. The Z-axis direction of a 

copy’s coordinate system coincides with the staircase axis and with the global Z-axis. The Y-axis direction 

of a copy’s coordinate system should be calculated automatically, therefore all driving parameters in this 

group are set to zero.  

Defining Optional Array Parameters 

Optional parameters of all arrays are defined in the section Options of the respective operation’s properties 

window. What parameters are available in the section depends on the array type. 

The following flags are available for arrays of construction elements, 

operations and bodies: 

Include source operation (available for arrays of construction 

elements and operations only). If this parameter is set, then the 

source objects are included in the array. The parameters assigned to 

the array (color, material) also affect the array source objects. 

Separate to Solids (available for arrays of Bodies and operations). 

Setting this flag turns on the mode of dividing the array into separate 

bodies (each array copy is automatically turned into a new Body). 

 

Combine Result to one Solid (available for arrays of Bodies and operations). With this flag set, the 

array copies are merged together by the Boolean addition operation. 
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Additional parameter Include in product structure is relevant only for arrays based on 3D 

fragments. It determines what will be put into product structure: 

Always Source. Only source fragment will be included into product structure  regardless of array 

parameters. Results of array creation are not taken into account in product structure; 

Array results. The results of array creation are included into product structure. Depending on the 

status of the flag Source, the result can be either all copies of array (when the flag is activated) or 

copies of array and the source object (flag is turned off). 

 

The optional parameters of the array of faces are different from the parameters of other arrays: 

Copy to one face. Set this flag to turn on the “Copy to one face” 

mode. 

Extend Faces. Turns on the mode of extending faces. This is 

always used together with the previous flag. 

Check Intersection with other Faces. This flag turns on the mode 

of checking for intersections of the created array copies with 

the existing body faces. 

Don’t check body boundaries. This flag turns on the identically-

named mode. By default the flag is enabled. 

 

Defining Limitations 

To specify a 3D element defining the limitation scope, activate the following option in the command 

automenu: 

 <Alt+C> Select limiting elements 

3D elements are selected in the 3D scene by clicking . 3D profiles and operations can also be selected in 

the 3D model tree. The selected objects are put in the list of limiting objects in the section “Limitations” of 

the operation properties window.  

To cancel selection of some of the specified objects, click those in the list of the limiting objects and press 

the button . 

 

To start defining limitations, you can simply focus on the respective entry of the operation properties 

window. The option for specifying the limiting objects will be activated automatically. 
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If a flat 3D object was selected, the limitation scope will be hinted in the 3D scene as a sweep along the 

normal direction of the selected object. If non-flat the limiting objects are specified, the limitation scope 

will be created only upon specifying the limitation axis. 

 

To define the limitation axis by a single 3D object, use the option: 

 <Alt+D> Select auxiliary direction of limits 

To define the axis by the start and end points, use the options: 

 <Alt+F> Select first point of auxiliary direction of limits 

 <Alt+S> Select second point of auxiliary direction of limits 

To reject selection of the limitation axis, use the option: 

 <Alt+K> Cancel selection of auxiliary direction of limits 

Defining Exclusions 

To specify the array elements to be excluded, activate the following automenu option: 

 <ALT+X> Select elements to Exclude 
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To select an element to be excluded, just click its preview image in 

the 3D scene by the . The selected element will be highlighted Gray 

in the 3D scene and added to the list of elements to exclude in the 

“Exclusions” section of the properties window. 

The list of excluded elements is made into a table that displays the 

numbers of the rows and columns of the selected exclusions. To 

remove an exclusion from the list, pick it in the list and press the 

button .  

 

The position of the elements specified by selecting in the 3D scene, is entered in the table using numerical 

notations for the row and the column. The button  allows defining an exclusion by using descriptive 

characteristics of its position. Upon pressing the button, a dialog box appears for specifying an element to 

exclude. 

In this dialog, specify, at intersection of which row and 

column lies the element to exclude, by setting the Row and 

Column switches in the desired states. Besides the 

descriptive characteristics, you can also use here they 

numerical notations of rows and columns. To do this, select 

the In Position choice and enter the number of the 

row/column. 

Upon closing the dialog box by pressing the [OK] button, 

the specified exclusion will appear in the list of the 

elements to exclude. 

 

 

To use the mode of excluding a row/column in the mode of cyclical 

repetitions for one of the specified exclusions, select it in the list of the 

elements to be excluded in the properties window and set a flag for it, 

representing the desired mode: 

- Whole row – sets the row exclusion; 

- Whole column – sets the whole column exclusion; 

- Cyclical Iteration – sets cyclical repetitions of the exclusion.  
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3D COPYING 

3D copy – operation of the T-FLEX CAD system which allows a user to copy existing operations, Bodies, 3D 

construction elements and even collections of faces. 

Parameters of copying are determined by specifying two LCS: source coordinate system of copying and 

target one. The transformation is performed by moving the source coordinate system along with 

connected with it objects to the location occupied by the target coordinate system. 

The operation of creating 3D copy allows a user upon copying to symmetrically reflect selected elements 

with respect to one of the planes of the target coordinate system. 

When creating 3D copy of operations, it is possible to automatically combine the created copy with the 

source operation, and also, use the move mode (when the source bodies are removed upon copying). 

MAIN PRINCIPLES  

Objects of Copy 

The collection of copied objects of a single operation can contain several elements of the same type (only 

operations, only Bodies, only faces, etc.). Depending on the type of the 3D copy (i.e. on the type of the 

selected objects of copy), parameters and capabilities of the operation will be changing (see section “Types 

of 3D copies”). 

 

Source and Target Coordinate Systems 

Any existing LCS can be selected as the source and the target coordinate systems.  

If the required LCS (source or target) is not found in the 3D model, it can be created automatically when 

defining the 3D copy. To do this, just select a 3D point as the origin for the LCS being created. A new 3D 

element – LCS will be created at this point. The axes of the newly created LCS will be directed along the 

axes of the world coordinates. 

 

General Principles of Copying 

The position the copy being created is defined in a general case by carrying the source coordinate system 

over the target one. 
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The copy being created can be additionally subjected to symmetry (mirroring) about one of the principal 

planes of the target coordinate system. 

 

When creating a copy with additional mirroring, one can specify just the source LCS. In this case, the system 

assumes that the source and the target LCS coincide. 
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The additional mirroring of the copy produces the result similar to that of the 3D Symmetry operation. 

Such copies can be used, for example, for creating symmetrical parts. You create the half-part first, then 

do copy with mirroring, and, finally, the Boolean addition of the two halves. 

TYPES OF 3D  COPIES  

Copy of Operations 

3D copy of operations allows a user to copy existing 

operations of the model. As a result of creating the 

copy operation, new Bodies appear – copies of the 

source operations.  

In the structure of the model the result of 3D copy 

of operations is shown in the following way: if for 

creating the copy only one operation was selected, 

then the last operation of the created Body-copy will 

be the 3D copy operation itself. On the other hand, 

if the 3D copy was created for several objects 

simultaneously, then the references to the copy 

operation will serve as the basic operations of the 

new Bodies. 

Optional mode of copying with union automatically 

combines the created copy with the body of the 

source operation. If the collection of the objects of 

copy contains more than one operation, then each 

created copy is combined with the corresponding to 

it source operation. 
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3D copy of operations can work in the move mode. In this case, the body of the source operation is 

removed, and only created copy remains in the 3D scene and in the tree of the 3D model. 

         

Copy of Bodies 

3D copy of Bodies is created in the same way as the copy of operations. But while the 3D copy of operations 

copies only results of specific operations, the copy of Bodies copies the whole Body obtained by using the 

selected operation. If this Body is modified in the future, the 3D copy will be regenerated, accounting for 

new operations included in the Body history (similar to arrays of Bodies). 
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Copy of 3D Construction 

The copy operation allows a user to create copies 

of any 3D construction elements. 

In the tree of the 3D model, the created operation 

is put into the special folder 

“3D Construction\Copies”. The elements-copies, 

obtained as a result of using this operation, are also 

put into the corresponding folders of the tree. For 

example, when creating the copy of a 3D profile, 

the resulting profile-copy will be put into the folder 

“3D Construction/3D Profiles”. 

When copying workplanes and LCS, the additional 

transformation of symmetry can not be applied to 

the created copies. 

 

 
The tree of the 3D model before and after creating 3D 

copy of construction elements 

Copy of Faces 

Copy of faces allows a user to add to the bodies present in the 3D model the holes and raised portions 

which duplicate already exiting structural elements. 

3D copy of faces is always created on the basis of a single body of the model: all faces being copied have 

to belong to the same body. The outcome of creating the copy operation – collection of faces-copies – is 

also included into the source body. 

                  

The collection of faces selected for creating 3D copy can be arbitrary, but it has to fully describe the 

geometry of the copied structural element of the part. Faces-copies have to lie within the bounds of the 

source body and intersect with its other faces in the same way as the faces of the original collection. 
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When creating the copy with the symmetry, one more additional condition is imposed on the source 

collection of faces: all edges bounding the collection of faces being copied have to be belong to the same 

“base” (not included into the list of copied faces) face of the body. 

         

Specifying the initial collection of faces is carried out in the same way as in the arrays of faces by: 

 Selection of closed sequence of edges bounding the desired collection of faces. 

 Direct selection of all desired faces; 

 Selection of the operation that created the desired collection of faces. 

The outcome of creating the face copy operation can be also affected by the following additional modes: 

 Copy to one Face. Use of this mode considerably reduces the copy regeneration time; 

 Extend Faces (used only in combination with the “Copy to one face” mode). The system will be 

automatically extending or trimming the copied faces in order to insure their correct connection to the 

body; 

 Check Intersection with other Faces (used to avoid body self-intersections). 

Mode detailed description of these modes can be found in the chapter “Arrays”. 

Limitations of Copy Operation 

When creating and editing copy operations the following limitations exist: 

 If at least one of the source objects of 3D copy was used for creating the body (including 3D weldment), 

then the mode “Move” will be locked; 

 If at least one of the objects-results of the operation was used for defining any other object of the TFLEX 

CAD model, then upon editing 3D copy, the option of modifying the collection of the source objects will 
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be locked as well as the option of turning on/off the mode of copying with union (for 3D copy of 

operations); 

These limitations are relevant to the 3D copies of all types except the copy of faces. 

Moreover, when copying the workplanes or LCS, the additional transformation of symmetry cannot be 

applied to the created copies. 

COPY CREATION  

To create a 3D copy use the command 3CP: Create Copy: 

Icon Ribbon 

 

3D Model → Create → Copy 

Keyboard Textual Menu 

<3CP> Operation > Copy  

To perform the copy operation, do the following steps: 

 

 Select the source objects of copy; 

 Select the source coordinate system; 

 Select the target coordinate system; 

 Specify parameters of copy; 

 Finish the operation creation. 

 

Selection of Copy Type 

The type of the operation being created is selected in the 

command's properties window with the help of drop down list: Copy 

of Operations, Copy of Construction, Copy of Bodies, Copy of 

Faces.  

 

Depending on the type of copy selected in the list, the set of options in the command's automenu and the 

set of parameters in the properties window will be changing. 

Selection of Source Objects of Copy 

For selection of the source objects of copy, one of the following options will be available in the automenu 

(depending on the type of operation selected): 



Three-dimensional modeling 

644 

 

 <N>  Select source 3D operation 

 <N> Select source 3D operation 

 <N> Select Construction 

 <N> Select Faces to Copy or their boundary Edges or Loops 

Selection of Source Objects for Copying 3D Operations, Bodies, 3D Construction 

The objects can be selected directly in the 3D scene or in 

the model tree. The selected objects will be put into the 

list of the copy source objects in the operation properties 

window. 

To select a 3D Body, you can pick any of the operations 

contributing to this Body (again, either in the 3D scene, 

if that is possible, or in the 3D model tree). The Last 

operation of the given Body will be automatically put in 

the list of the selected objects. 

 

Note that after selection of the first object (operation, construction element), the option / /  will 

be automatically turned off, and the system will move to specifying the source coordinate system. For 

selecting several objects of copy, a user has to independently reactivate the option for selection of the 

objects of copy in the command's automenu or place the cursor in the row “…” in the list of the selected 

objects (in the command's properties window). 

To deselect any of the previously selected objects, indicate it in the list and press the button . 

Note that once the first object to be copied is selected, the entry defining the copy type becomes 

inaccessible. To change the copy type, you need to remove all 3D objects from the list of the copy 

source objects. Only after that, you will be able to select another copy type. 

Selecting source collection of faces for copy of faces 
Selection of the source collection for copying faces is done 

in the same way as selection of the source faces for the array 

of faces, described in the chapter “Arrays”. 

The pull-down list of the option for selecting a set of faces 

to copy  allows choosing the way of selecting: direct 

selection of faces, selection of their bounding edges, 

selection of the operation (the same filters are duplicated 

by the system toolbar). 
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Details on the work with filters from the pull-down list of the option  are given in the chapter 

“Arrays”, when describing creation of the array of faces. 

Selection of operations, bounding edges or the faces themselves is done in the 3D window. Operations 

can be also selected from the tree of the 3D model. 

When specifying the collection of faces with the help of bounding 

edges, an additional flag Alternative Face Selection shows which of 

the two collections of faces defined by the specified collection of 

edges will be chosen as the source object of copy. The flag has three 

states: 

On by default . The system selects the collection of faces 

automatically (by the least area condition). If the further 

manipulations with the 3D model will alter the balance of 

the areas, the system will automatically switch to the other 

set of faces as the source object of the copy; 

On /Off . Each of these two states will correspond to a 

specific collection of faces (correspondence is determined 

by the system itself). With any further modifications of the 

model, the collection of faces being copied does not change. 

 

When creating the copy of faces, the option  remains active until a user independently activates the 

option for selection of the source/target coordinate system. 

Selection of Source Coordinate System 

Selection of an existing LCS as a source coordinate system is done by using the option: 

 <S> Select source LCS 

For automatic creation of an LCS, use the option: 

 <F> Select Point for creating Source LCS 

This option allows selecting an arbitrary 3D element suitable for defining a 3D point that will be the new 

LCS origin. 

Selection of Target Coordinate System 

Selection of the target coordinate system is done similar to selecting the source coordinates. An existing 

LCS is selected by the option: 

 <T> Select target LCS 

A new LCS can be created at a 3D point by using the option: 
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 <W> Select Pont for creating Target LCS 

To  refuse the selection of LCS, use the option: 

 <C> Cancel selection of target coordinate system 

Specifying Parameters of Copy 

The necessity of applying the symmetry transformation to the copies being created is specified in the 

command's properties window with the help of the flag Symmetry Using LCS Plane. The plane of the 

target coordinate system, with respect to which the symmetry will be performed, is selected with the help 

of the toggles: XY, XZ, YZ. 

In the dialog of the operation's parameters invoked by the option 

, it is also possible to specify parameters for transformation of the copy. 

Displacements and angles of rotation specified there will be applied 

with respect to the target coordinate system of the copy. 

Additional flag Count Copies in product structure is used only when 

copying 3D fragments included in the BOM. When checking this flag, 

the copies of the fragments will be also taken into account in the 

product structure. When this flag is turned off, only the original 

fragment is included in the product structure. 
 

Flag Separate to solids is used when copying several operations at once. A separate Body-copy is created 

for each of them. 

When creating 3D copy of operations, the copy mode is selected with the help of a toggle Mode in the 

group Options in the properties window of the command: Move, Copy, Copying and Unite. 

The optional parameters of the copy of faces are different from the parameters of other copies: 

Copy to one face. Set this flag to turn on the “Copy to one 

face” mode. 

Extend Faces. Turns on the mode of extending faces. This is 

always used together with the previous flag. 

Check Intersection with other Faces. This flag turns on the 

mode of checking for intersections of the created array 

copies with the existing body faces.  
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3D SYMMETRY 

3D symmetry – operation of the T-FLEX CAD system which allows a user to symmetrically reflect selected 

3D objects with respect to a given plane. 3D construction elements, operations, bodies, faces can be 

selected as source objects for creating the symmetry (objects of symmetry). 

When creating the symmetry of operations, it is possible to automatically combine the created copy with 

the source operation as well as use the move mode (when the source bodies are removed upon copying). 

SYMMETRY TYPES .  GENERAL INFORMATION  

The collection of copied objects of a single operation of symmetry can contain several elements of 

necessarily the same time (only operations, only Bodies, only faces, etc.). The result of execution of the 

operation and its parameters depend on the type of the initial data of symmetry. 

Symmetry of Operations 

Symmetry of operations allows a user to symmetrically copy the existing operations of the model. As a 

result, new Bodies appear – symmetrical copies of the initial operations.  

In the structure of a 3D model, the result of symmetry of operations is shown in the following way: if for 

creating the symmetry only one operation was selected, then the last operation of the created Body-copy 

will be the symmetry operation itself. On the other hand, if the symmetry was created for several operations 

simultaneously, then the references to the symmetry operation will serve as the basic operations of new 

Bodies. 
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Optional mode of copying with union automatically combines the created copy with the body of the source 

operation. If the collection of the symmetry objects contains more than one operation, then each created 

symmetric copy is combined with the corresponding to it source operation. This mode can be useful for 

designing the assemblies with large number of symmetric parts. 

       

3D copy of operations can work in the move mode. In this case, the body of the source operation is 

removed, and only created copy remains in the 3D scene and in the tree of the 3D model. 

               

Symmetry of Bodies 

Symmetry of Bodes is created in the same way as the symmetry of operations. But while the symmetry of 

operations copies only the results of specific operations, the symmetry of Bodies copies the whole Body 

obtained by using the selected operation. Later when this Body is modified, the symmetry will be 

regenerated taking into consideration new operations entered into the Body history. 
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Symmetry of 3D Construction 

The symmetry operation allows a user to symmetrically copy any 3D construction elements except 

workplanes and LCS. As in the previous case, in the framework of a single operation, several 3D 

construction elements can be simultaneously subjected to the symmetry. 

In the tree of the 3D model, the 

created operation is put into a special 

folder “3D Construction\ Symmetry”. 

The elements-copies, obtained as a 

result of using this operation, are also 

put into the corresponding folders of 

the tree. For example, when creating 

the symmetry of the 3D profile, the 

resulting profile-copy will be put into 

the folder “3D Construction\3D 

profiles”. 
  

The tree of the 3D model before and after creating the 

3D symmetry of construction elements 

Symmetry of Faces 

The symmetry of faces, as well as of the array of faces, and 3D copy of faces, allows a user to add to the 

bodies present in the 3D model the holes and raised portions which duplicate already existing structural 

elements. 

All copied faces of a single symmetry operation have to belong to the same body. The outcome of creating 

the symmetry operation – collection of faces-copies – is included into the source body as well. 

                    

The collection of faces selected for creating the symmetry has to fully describe the geometry of the copied 

structural element of the part. Faces-copies have to lie within the bounds of the source body and intersect 

with its other faces in the same way as the faces of the original collection. 
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Specifying the initial collection of faces is carried out in the same way as in the arrays of faces by: 

 Selection of closed sequence of edges bounding the desired collection of faces. 

 Direct selection of all desired faces; 

 Selection of the operation that created the desired collection of faces. 

In addition, one more additional condition is imposed on the source collection of faces of symmetry: all 

edges bounding the collection of faces being copied have to belong to one “base” (not included into the 

list of copied faces) face of the body. 

         

The following additional modes can affect the outcome of the face symmetry operation: 

 Copying to one face. The use of this mode significantly reduces the symmetry regeneration time; 

 Extend surfaces (is used only along with the mode “Copying to one face”). The system will automatically 

extend or trim the faces being copied for assuring their proper insertion into the body; 

 Check intersection with other faces (is used to prevent creation of self-intersecting body). 

More detailed description of these modes can be found in the chapter “Arrays”. 

CREATION OF SYMMETRY  

For creating symmetry operation, the command 3SY: Create 3D Symmetry is used: 



3D Symmetry 

651 

Icon Ribbon 

 

3D Model → Create → Symmetry 

Keyboard Textual Menu 

<3SY> Operation > Symmetry 

For creating the operation of symmetry, these steps have to be followed: 

 Select the source objects of symmetry; 

 Select the plane of symmetry; 

 Select the parameters of symmetry (for example, the mode of symmetry); 

 Finish creation by pressing  in the automenu or in the command's properties window. 

Selection of Symmetry Type 

The type of the operation being created is selected from 

the command's properties window with the help of drop-

down list: Symmetry of Operations, Symmetry of 

Construction, Symmetry of Bodies, Symmetry of Faces. 

Depending on what type of the symmetry is selected from 

the list, the set of options in the command's automenu and 

the set of parameters in the properties window will be 

changing. 

 

Selection of Source Objects of Symmetry 

For selection of the source objects of symmetry, one of the following options will be available (depending 

on the type of symmetry selected) in the automenu: 

 <N> 
Select source 3D operation (for symmetry of 

operations) 

 <N> Select source 3D operation (for symmetry of Bodies) 

 <N> Select Construction 

 <N> Select Faces to Copy or their boundary Edges or Loops 
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Selection of Source Objects for Creation Symmetry of 3D Operations, Bodies, 3D 

Construction 

The objects can be selected directly in the 3D scene or in the tree of the 3D 

model. Selected objects are put into the list of the source objects of symmetry 

in the operation's properties window. 

For selection of a 3D Body (also either in the 3D scene, if it is possible, or in the 

tree of the 3D model) any operation taking part in the creation of the given 

Body can be chosen. The last operation of the given Body will be automatically 

put into the list of the selected objects. 
 

After selection of the first object (operation, construction element), the option / /  will be 

automatically turned off and the system will move to specifying the symmetry plane. For selecting several 

objects of symmetry, a user has to independently reactivate the option for selection of the objects of copy 

in the command's automenu or place the cursor in the row “…” found in the list of the objects of copy (in 

the command's properties window). 

To deselect any of the previously selected objects, indicate it in the list and press the button . 

After selection of the first object of copy, the entry for specifying the operation type will be 

inaccessible for editing. To change the type of the copy, it is necessary to remove all 3D objects 

already put into the list of the source objects. Only after that, another operation type can be 

selected. 

Selection of Source Objects for Faces Symmetry 
Selection of the source collection for copying faces is done in the same way as selection of the source faces 

for the array of faces (see the chapter “Arrays”). 

The drop down list of the option for selection of the collection of 

faces to copy  allows a user to specify the selection approach: 

selection of the faces themselves, selection of the edges 

bounding the faces, selection of the operation (the same filters 

are duplicated in the system toolbar). 

Selection of operations, bounding edges or the faces themselves 

is done in the 3D window. Operations can be also selected in the 

tree of the 3D model. 

 

When specifying the collection of faces with the help of bounding edges, the flag Alternative Face 

Selection shows which of the two collections of faces defined by the specified sequence of edges will be 

selected as the source object of symmetry. The flag has three states: 
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Turned on by default . The system itself chooses 

the collection of faces (from the least area 

condition). If during the process of subsequent 

manipulations with the 3D model, the balance of 

the areas changes, the system will automatically 

change the original collection of faces; 

Turned on /Turned off . Each of these two 

states will correspond to a specific collection of 

faces. The collection of faces corresponding to a 

specific state of the flag is chosen by the system 

arbitrarily after specifying the collection of faces. 

With any further modifications of the model, the 

collection of faces being copied does not change. 

 

When creating the symmetry of faces, the option  remains active until a user independently activates 

the option for selection of the symmetry plane. 

Note! To receive correct model, faces-copies have to lie within the bounds of the source body and 

intersect with its other faces in the same way as the faces of the original collection. 

Selection of Symmetry Plane 

Symmetry plane is selected with the help of the following option of the automenu: 

 <S> Select reflection plane 

When creating symmetry of 3D operations, Bodies, 3D construction elements, this option is turned on 

automatically after selection of the first object of symmetry. If at that moment a user turns off this option 

(for selecting several objects of symmetry), then after selecting all desired objects, a forced activation of 

this option will be required. 

 

When creating the symmetry of faces, the option  always requires independent activation by the user. 

The option  contains the drop-down list of filters for selecting 3D objects capable of defining the plane. 

Selection is performed in the 3D window or in the window of the tree of the 3D model. 

 

To cancel selection of the symmetry plane, the following option can be used: 

 

 <K> Cancel selection of reflection plane 



Three-dimensional modeling 

654 

Specifying Symmetry Parameters 

Specifying Parameters for Symmetry of 3D Operations, Bodies and 3D 

Construction 
The mode of symmetry is selected with the help of a toggle 

Mode in the group Options in the properties window of the 

command: Move, Copy, Copy and Unite. 

 

In some cases, the options “Move” and “Copy and Unite” 

may not be accessible (see section “Limitations of 

Symmetry Operations”, as well as description of features of 

various types of symmetry). 

 

 

Additional flag Count Copies in product structure is used only when copying 3D fragments included in 

the product structure. When checking this flag, the copies of the fragments will be also taken into account 

in the BOM. When this flag is turned off, only the original fragment is included in the product structure. 

 

Flag Separate to solids is used when copying several operations at once. A separate Body-copy is created 

for each of them. 

 

Specifying Parameters for Symmetry of Faces 
Optional parameters of symmetry of faces differ from the parameters of symmetry of other types: 

Copy on one Face. This flag is set on when the mode 

“Copying to one face” needs to be turned on. 

Extend Faces. This flag turns on the mode of the 

same name. It is always used along with the 

previous flag. 

Check Intersection with other Faces. This flag 

allows a user to turn on the mode of checking for 

intersections of the created copies with already 

existing faces of the body. 

 

Don’t check body boundaries. This flag allows to create symmetry of faces without checking self-

intersection and correctness of created geometry. It significantly increases performance. This option should 

be used only if you are sure in the correctness of the resulting model.
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CUT BY SECTION 

The cut by section operation allows creating a 3D body by cutting some portions off the original body, or 

getting two new bodies by cutting the original body into two parts. Operation can be applied either to 

solid or to sheet bodies, resulting in a body(s) of the same type. 

 

DEFINING CUT BY SECTION OPERATION  

The cut by section operation is called by the command 3CU: Cut By Section: 

Icon Ribbon 

 

3D Model → Modify → Cut by section 

Keyboard Textual Menu 

<3CU> Operation > Cut by Section  

Upon calling the command, the automenu provides both the general system options and the specific ones 

for creating a cut by section and a separation: 

 

 <B> Select 3D operation 

 <S> Select section 

 <W> Select intersecting Workplane 

 <P> Select intersecting Profile 

 <K> Cancel selection of cutting surfaces 

 <Tab> Switch view direction 

 <M> Separate into two Solids 
 

Creating a Cut by Section 

The cut by section operation definition includes the following steps: 

 Selection of a body (the option  is activated automatically). Select a body to subject to the 

cut by section operation in the 3D view window or in the 3D model tree. The selected body will 

be highlighted. 
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 Selection of the cutting element or set of such elements. 

You can use the following cutting elements: a 3D section, a worksurface, a workplane, a 3D 

profile, a face of a body or a sheet body. The body is slashed along the surface of the cutting 

element.  

You can specify a set of cutting elements. The set can include faces, 3D profiles, sheet bodies 

(selection of several 3D sections or workplanes is not allowed). In this case, the elements are 

sewed first into one sheet body, and then the cut by section is performed over the original body 

by the resulting sewed body. When using a set of cutting elements, the necessary conditions on 

these elements are: first, it should be possible to sew the elements; second, the resulting sewed 

body should fully intersect the original body. 

Selection of the cutting elements is done using the automenu options. The 3D section and the 

workplane are selected using the options  and , respectively. The set of cutting elements 

(faces, 3D profiles, sheet bodies) is defined by the option . A stand-alone 3D profile (face, 

sheet body) is specified as a set consisting of one element. 

Upon selecting the cutting element, arrows are displayed on its sides pointing towards the 

portion of the body that will be left in the scene upon performing the cut by section. The 

direction of the arrows can be flipped by the option <Tab> (the icon ). 

 Definition of the general operation parameters (optional) by the option . The detailed 

description of the general operation parameters is provided in the chapter “General parameters 

of 3D elements”. 

 Confirmation for the operation creation (  in the automenu or in the property window).  

Upon confirming the operation creation, the new 3D body will be displayed in the 3D view window. 

Making Body Separation  

To divide a body into two parts, additionally set the option: 

 <M> Separate into two Solids 

In this case, two cut by section operations with identical parameters are created automatically on the 

original body. Editing of such operations is also done jointly. To define parameters of one of the operations 

separately, call its parameters dialog box without entering the editing mode (for example, by using the 

context menu for this operation). The two operations are deleted separately. 
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EXAMPLES OF CREATING THE OPERATION  

Cutting Body by 3D Section 

 

     

This drawing is provided with the library “Examples”, the folder “\3D Modeling\Cut operation\ Cut 

by section.GRB”. 
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Cutting Body by Face 

Defining the body cutting operation by a cutting face provides interesting opportunities. Let's review the 

following example: 

        

This drawing is provided with the library “Examples”, the folder ““\3D Modeling\Cut operation\ Cut 

by surface.GRB”. 

The drawing shown on the diagram represents an intersection of two pipes. The 3D bodies were created 

by two Rotation operations. Next, the required cut was made along a face belonging to one of the bodies.  

Cutting Body by Set of Cutting Elements 

The drawing shows an example of cutting the body of a plate by two front faces of a pyramid. 

          

This drawing is provided with the library “Examples”, the folder ““\3D Modeling\Cut operation\ Cut 

by set of faces.GRB”. 

Separation of Body in Two Parts 

The diagram below shows the original body along with two resulting bodies after the Separation operation 

(for clarity, the resulting bodies were moved apart in the space using the command Tools > 

Transformation). 



Cut by Section 

659 

                     

This 3D model is located in the folder “\3D Modeling\Cut operation\ Cut with separation into two 

solids.GRB”. 
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DIVISION INTO BODIES 

This command is intended for dividing operations into separate bodies, that unite several bodies (solid 

and sheet bodies alike). Thus, for example, the result of creating a linear or circular array or a Boolean 

operation will be divided by this operation into geometrically separate components. The command can 

also be used when handling a model imported from another system, that consists of several bodies. 

DEFINING D IV ISION  

To divide a body, use the command 3SD: Divide Solid: 

Icon Ribbon 

 

3D Model → Modify → Divide 

Keyboard Textual Menu 

<3SD> Operation > Model Composition > Divide 

 

There is yet another way of calling the command: move the cursor to one of the model operations and 

right click , then in the coming up menu select the item “Create”. The list of available commands will 

appear, that can be called while that operation is selected. Select the item “Divide Solid”, at this moment 

the selected body will be highlighted. Selection can be redone. 

The operation is created by selecting an object uniting several bodies. The object will be divided into these 

bodies. You need to confirm the division.  

The object selection is done by the option: 

 <F> Select Solid 

This option is turned on automatically upon calling the command. The examples of an object to be divided 

are: the result of the array or circular array operation, a Boolean operation, an import operation from other 

systems. As a result, the selected object will be divided into several separate bodies. The division is done 

by creating copies of all bodies making up the original operation. The copies are actually displayed in the 

3D window. The respective entries in the 3D model tree appear as follows: 
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The diagram 1 below shows a model made up by a linear array. As we know, all bodies in the array are 

actually a single body. When pointing to one of the array bodies, the whole array is highlighted, as can be 

seen on the diagram 2. The diagram 3 shows the result of the division. In this case, after pointing to one 

of the bodies, only this body is highlighted. 

                            

D IV IS ION PARAMETERS  
 

No parameters are explicitly defined for the operation. 

However, the resulting bodies (copies) of the operation 

can be assigned their own parameters by calling the 

respective dialog box. In this case, the dialog box can be 

called upon completing the division operation from the 

context menu by right clicking  over the desired body 

(copy) in the 3D window or in the 3D model tree.  

The produced dialog box is typical across various system 

operations. In it, you can define the general system 

parameters and specific parameters, as well as the 

transformation parameters. 

 

Operation Name. The following names are automatically created for the bodies resulting from the “Divide 

Solid” operation: Reference Operation_1, Reference Operation_2, etc.
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MODEL SIMPLIFICATION 

The command «Simplify Model» serves for deleting extra edges or vertices from the specified operation 

body, as well as for simplifying the geometrical base of faces and edges. The extra entities can occur in the 

process of modeling, while performing certain operations. Presence of such elements in a model is not an 

error; however, deleting those can be helpful in certain situations. This operation is specifically intended 

for tackling problems in complicated cases, when extra edges or vertices obstruct the target design (for 

example, in blend creation); additionally, this functionality can be used for simplifying the contents of 

imported models.  

GENERAL INFORMATION  

Deleting Extra Entities 

When model is being simplified, only vertices or edges can be deleted. An extra vertex can usually be 

excluded from the model when it belongs to a single closed edge (usually this would be an edge of a 

surface of revolution) or belongs to two adjacent edges lying on one curve. An edge is usually deleted if it 

is a part of an isolated open chain of edges within one face, or if it is an edge between two adjacent faces 

lying on one surface. 

 

The operation allows selecting for processing vertices, edges, faces and operations. The admissible entity 

types are processed as follows: 

 a vertex will be deleted if it is identified as extra; 

 if an edge is identified as extra, it will be deleted. If vertices of this edge are also identified as 

extra, then those will be deleted along. 

 upon selecting a face, any extra edges on it must be deleted. The extra vertices are then 

deleted as well. 

 if an operation is selected, all extra edges and vertices are subsequently deleted up until no 

such are left.  If the operation’s body contains spline faces or curves lying on one surface or 

one curve, then those are merged to one face or one edge. 

If the user selected an entity, which the system cannot exclude it from the model, it will be ignored. 
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Simplifying Topology 

Along with deleting extra topology, certain topological elements can be simplified. If spline edges or faces 

lie on simple curves or analytical  surfaces (plane, cylinder, torus or sphere),  then the geometrical base of 

those elements is substituted by simpler one. This functionality is identical to the option «simplify 

geometry» that is available in certain operations (for example, «Sweep» or «Loft»). 

As the input data for such processing, the user can select separate faces or a whole operation (as for 

processing together). 

WORKING WITH THE COMMAND  

The command is called by the following means: 

Icon Ribbon 

 

3D Model → Modify → Simpify 

Keyboard Textual Menu 

<3SI> Operation > Model Composition > Simpify 
 

This operation allows turning on each type of processing separately – either 

the model simplification or deletion of extra elements – with the help of the 

appropriate flags in the properties window. A specific list of entities to be 

processed can be composed for each type of processing. If a processing is 

disabled then this type of processing is not performed and the entities list is 

inaccessible. 

For processing together, the user can select a whole operation 

(recommended). To select an operation, you can use the automenu option: 

 <O> Select Operation 

The name of the operation appears in the «Operation:» field. The entities list 

for all types of processing will remain empty in this case. If a list for 

processing is empty, that means the system will investigate all topological 

elements of a given operation when performing the processing.  

If the list of «Simplify geometry» processing is empty, the option «Separately» is accessible in the properties 

window. Enabling this option activates a special mode that allows performing subsequent simplification of 

a set of faces lying on one geometrical surface. Otherwise, simultaneous processing of all faces is 

performed. For example, consider a set of faces lying on a geometrical spline surface that is close to planar 

within a certain area. During the separate processing, the system would be able to simplify the faces that 

happen to be within the «planar» area. In the simultaneous processing, the system would not be able to 

simplify any face. 
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In certain cases, it might be possible for the user to do local changes to the model topology. The list of 

entities for various processings are composed by the automenu options:  

 <R> Select element to delete redundant 

 <G> Select face to simplify geometry 

An entity can also be selected by placing the pointer in the list pane in the properties window. The 

respective automenu option will turn on automatically.  

 

To cancel all elements selection use command: 

 <F> Cancel selection 

The command also provides a useful feature for watching what model entities among the currently selected 

are extra or simplifyable. The following automenu option is used for enabling such view: 

 <V> Show elements to be removed or simplified 

While in this mode, the system will highlight all edges, their cases and faces of the selected operation that 

can currently be subjected to processing. Deletable and simplifyable entities are highlighted in different 

colors.  

The described mode is mostly useful for analyzing geometry of an operation as a whole. After 

analyzing topology of the whole operation, the user would be able to use capabilities of local 

processing with more confidence, if necessary at all. 
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FACE TAPER 

This operation allows the user to taper one or several selected faces at a specified angle, with automatic 

correction of the adjacent faces. 

Face taper can be used, for example, for designing parts manufactured by casting method under pressure. 

Addition of tapers to the part enables easy extraction of the part from the mold. 

GENERAL CONCEPTS AND OPERATION CAPABIL IT IES  

Taper Direction 

The direction, in which the taper (slant) angle of the faces is counted, is determined by a vector. This vector 

can be defined in two ways. 

 The first way requires selecting an object, whose geometry will determine the taper direction: 

a normal to a face, a flat edge, etc. 

 Alternatively, the vector can be defined by two 3D points. The second 3D point defines the vector 

direction. 

When designing parts made by parts made by molding, it is necessary to specify the direction of the taper 

along the direction of the mold separation. 

Fixed Edge/Fixed Taper Face 

For each tapered face, it is required to specify a fixed edge or a face.  

A fixed edge defines a fixed taper line – a line, lying on a tapered face, which does not change its position 

when creating a taper. Construction of a taper surface takes place with respect to a fixed line. A fixed edge 

must belong to the same body as a tapered face. 

 

Instead of an edge, it is possible to indicate a fixed face. Intersection of the selected face with the tapered 

face defines a fixed taper line. 
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Unlike the fixed edge, the fixed face can be selected on a 

different body. Once the fixed face is selected, the 

command creates the plane based on that face, and 

projects it to the intersection with the face to taper. The 

intersection line between this line and the face being 

tapered is the fixed line about which the face tapering will 

occur. 

A fixed face can be adjacent to the tapered face. In this case 

the common edge will be a fixed edge with respect to which 

the face will be tapered. 
 

 

Fixed edges and fixed faces are defined separately for each tapered face. 

Instead of collection of fixed edges, it is possible to specify one workplane. It will define a fixed line for all 

tapered faces of the current operation at once. A fixed line of each tapered face will be defined as an 

intersection of selected workplane with the given face. 

 

Calculating Taper Angle 

Taper angle of face can be evaluated according to the following algorithm: 

 A normal to the face to taper is constructed at each point of the fixed edge. 

 The taper direction vector is translated to that point. 

 Based on those two vectors, a plane is constructed, in which the taper angle will be counted. 

 Next, the vector is determined, that sets the zero taper angle. 

 The taper angle is counted from the formerly described vector in the plane. This angle defines 

the resulting vector, through which the surface of the tapered face will be passing. 
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Processing of Junctures between Tapered and Adjacent to Them Faces 

When creating a taper, there is a possibility of creating a gap between the tapered and adjacent to them 

non-tapered faces. To process these gaps, it is possible to use two methods: 

 Creating auxiliary flat faces; 

 Extending the surface of the non-tapered face. 

 

The first way implies creation of an additional flat face for patching the 

gap at the connection. The second way allows preserving transition 

between those faces. In this way, a portion of the tapered face will be 

trimmed by the surface created by extending the adjacent face. 

In some cases, creation of the additional face is the only possible way 

of closing the gap at the faces connection. This exact case is shown on 

the right-hand diagram. 
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Processing of Junctures between Tapered Faces 

When the adjacent faces are tapered at different angles, a gap can be created between them. For correcting 

this situation, it is possible to use the following methods: 

 Creating additional flat faces; 

 Extending the surface of non-tapered face; 

 Preserving smooth connection. 

 

Methods of Creating Taper 

The operation provides various methods of shaping up the tapered face: 

 Standard; 

 By offset; 

 By curve; 

 By surface (see section below “Taper by Offset ”). 

 By default, a standard method for creating tapers is used. It allows you to construct the tapered 

surface exactly matching the shape of the original surface and a specified taper angle. 

In several cases, the standard method does not allow you to create a required taper. In these cases it is 

possible to use methods “By curve” and “By surface”. These types of taper match the shape of the original 

tapered face in a less stringent manner which permits you to construct the taper in cases when the standard 

method of taper creation does not work. Methods “By curve” and “By surface” differ by the method of 

resolving ambiguity upon creating the tapered surface. In the first case, for constructing a taper, a tangent 

to the curve of the fixed edge is utilized, in the second case – the normal to the tapered surface. The tapers 

“By curve” and “By surface” are usually used for giving a part more aesthetic shape. 

In many cases the methods “By curve” and “By surface” give similar outcome. For example, in the example 

on the figure below, the difference between these methods is noticeable only upon repeated use of the 

taper operation. 
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ADDITIONAL CAPABIL IT IES OF TAPER  

Taper of Face Relative to Multiple Fixed Faces/Edges 

The operation allows tapering the selected face relative to multiple fixed faces or edges. As a result of such 

operation, the tapered face will be split into two parts. The edges of the resulting faces will have the 

specified taper angle. 

 

Tapering All Adjacent Faces 

The mode of tapering all faces adjacent to the fixed one is provided for quick taper creation. In this case, 

all you need is just to select the fixed face. The command will automatically determine all adjacent faces 

for tapering.  
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Combined Processing of Adjacent Faces 

The mode of combined processing of adjacent faces allows the user to create a simultaneous taper for a 

pair of adjacent faces, when one of the tapered faces serves as a fixed face for another. In a standard mode, 

an attempt to create such a taper will lead to an error.  

On the figure below an example is shown in which it is desired to simultaneously taper two faces: Face 1 

and Face 2. For the face Face 1, the edge Edge 1 is selected as a fixed edge. For the Face 2 a fixed line has 

to be defined by the face Face 1 or the edge Edge 2. But both Face 1 and Edge 2 will be modified upon 

taper creation. In this situation, the mode of combined processing of faces can help. By turning it on and 

indicating Face 1 as a fixed object for the face Face 2, the user can obtain a correct taper of two faces at 

the same time. 

             

Splitting Faces 

This parameter is used in cases when it is necessary to create a taper 

of the curvilinear face. The command splits the face into patches 

defining the position for which it is possible to create a taper surface. 

The tapered patches will pass tangentially to the remaining curvilinear 

part of the face at a specified angle to the taper direction. 
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COMPLEX FORMS OF FACE TAPER  

Step tapering 

For creating step tapering, the user specifies: 

 Taper direction; 

 Fixed face or workplane; 

 Tapered face; 

 A continuous sequence of edges, lying on the tapered face, whose geometry must be preserved 

upon taper creation. All edges of the specified sequence must be non parallel to the taper direction. 

For adding the edge to the tapered face, the command 3ZS: Imprint Elements can be used. 

As a result, the tapered face “turns around” relative to the fixed face/workplane. Along the line generated 

by a specified sequence of edges, a “step” is formed. Additional faces forming the “step”, can be created 

by two methods: perpendicular to the original face or at a specified taper angle. 

 

When creating a step tapering, it is possible to create a two-sided “step”. 

 

A step tapering can be created simultaneously on several faces of the body. 
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Taper by offset 

The method of specifying the taper “by offset” allows the user to determine the magnitude of a taper not 

by an angle but by an offset of the tapered face with respect to the initial position. 

The algorithm of creating the taper “by offset” method is as follows:  

 A fixed face or edge is mapped along the taper direction on the plane selected for defining 

the face offset. 

 A specified-distance offset from the mapped face or edge is constructed. In this case, the taper 

parameter is the offset distance.  

 The resulting surface will be passing through the offset off the fixed edge’s mapped image. 

  

CREATING FACE TAPER  

The command for creating “Face Taper” operation can be called by one of the following means: 
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Icon Ribbon 

 

3D Model → Modify → Face Taper 

Keyboard Textual Menu 

<3TA> Operation > Taper > Face Taper 

Creating Face Taper 

After invoking the command for creating a taper (except a step taper and a taper by an offset) it is required: 

 Indicate taper direction; 

 Specify a required number of pairs fixed line/tapered face;  

 Specify taper angle (or a set of taper angles when tapering several faces); 

 Select method of tapering (if necessary); 

 If required, specify additional parameters (the way of filling the juncture between the tapered and 

non-tapered faces; between the faces tapered at different angles); 

 Complete operation creation with the help of . 

Specifying taper direction 
For specifying a taper direction by one 3D object, the following option is used: 

 <D> Set tapering direction 

 

This option allows selecting objects in the scene, whose geometry is suitable for 

defining the taper direction vector. Once an object is selected, its name appears 

in the properties window. 
 

For defining a taper direction by two 3D points, the following options are used: 

 <1> Select first point of tapering direction 

 <2> Select second point of tapering direction 

 

The selected elements are also entered in the properties window. The taper 

direction is marked by a vector in the 3D scene. 

To cancel the direction selection, use the option: 

 
 

 

 <X> Cancel direction selection 
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Specifying Fixed Object and Tapered Face 
After defining a taper direction, the command will prompt you to define a fixed line of the first tapered 

face. The following automenu options are used for that: 

 <T> Select fixed Face 

 <E> Select fixed Edge 

 <W> Select Workplane 

 

After selecting the respective element, it will be added to the list 

“Fixed/Tapered” of the command’s properties window. 

 

Then the system will prompt you to select a tapered face. The following option will become active in the 

automenu: 

 <F> Set faces to be tapered 

 

Selected tapered face is also added to the list “Fixed/Tapered” next to the 

corresponding to it fixed object. 

A fixed line (edge, face, workplane) and a tapered face are specified in 

pairs. Each tapered face must correspond to a fixed object, and vice 

versa. 
 

Further action of the command depends on the type of the selected fixed object. If it was a fixed edge, 

then the system will prompt you to select the next fixed edge. If it was a face or a workplane, the system 

will wait for specification of one more tapered face. Selected earlier face/plane will be, by default, 

considered as a fixed object for all subsequently selected tapered faces. To select another fixed object, it 

is necessary to manually activate the corresponding option (  or ), select a desired object (face or 

edge), and then specify a tapered face. 

Note that in the framework of a single operation, it is possible to specify only one workplane – it 

will become a fixed object for all tapered faces. 

For creating the taper of all faces adjacent to a single fixed edge, it is sufficient, after selection of the fixed 

edge, turn on the following automenu option: 

 <A> Select all adjacent faces for tapering 

All faces adjacent to a specified fixed face will be automatically selected as tapered. 
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To modify already selected fixed objects or tapered faces, it is necessary to select a desired pair in the list 

Fixed /Tapered, turn on the option of selecting a desired object ( ,  or ) and select an object 

again. 

It is possible to delete a specified pair fixed object/tapered face by selecting them in a list, pressing the 

button [Delete] or key <Del>. 

It is also possible to cancel selection of the workplane with the help of the option: 

 

 <X> Cansel workplane selection 

Defining taper angle 
The taper angle is defined by a numerical value in the operation parameters. It can be common across the 

whole set of pairs of fixed objects and tapered faces, or be defined individually for each pair. By default, 

the common angle is used. 

If for a certain pair fixed object/tapered face, it is desired to define a value of 

the angle different from the common, it is necessary to perform the following 

steps: 

 In the properties window, click the desired pair of the fixed and tapered 

objects. 

 Clear the check mark on the option Common angle. 

 Specify the angle value for the selected pair. 
 

The command provides draggers for easy setting of the face 

taper angles. By using the draggers, you can dynamically 

modify the taper angle value. 

In certain cases the draggers may not be displayed. 

A dragger for defining face taper angles appears as two 

vectors connected by an arc. Both vectors originate from the 

fixed object (a face or an edge). The direction of the first 

vector coincides with the taper direction. The direction of the 

second vector defines the resulting position of the tapered 

face. The taper angle is set by dragging the tip of the second 

vector. 

 

A separate dragger is provided for each pair fixed object/tapered face in the 3D scene. If a common angle 

is used for all pairs fixed object/tapered face, then you can modify the taper angle by any of the draggers. 

If the “Common angle” option is turned off for any of the pairs, then the dragger position will affect the 

angle of this pair only. 
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To change the face taper direction, either enter a negative angle value or push the  button in the face 

taper parameters dialog. 

Creating Taper by Offset 

For creating face taper by offset it is required: 

 Specify a taper direction; 

 Indicate a fixed taper line; 

 Indicate a tapered face or a collection of faces; 

 Select a face in the plane of which the offset will be created; 

 Specify the offset of the tapered face; 

 If necessary, define additional parameters (the method of filling the junctures between the 

tapered and non-tapered faces, between faces tapered at different angles, etc.); 

 Complete operation creation with the help of . 

Taper direction, fixed taper line and tapered face are specified in the same way as for the standard taper. 

For specifying the face in the plane of which the offset will be created, it is necessary to turn on the 

following automenu option: 

 <O> Select Face for creating taper by offset 
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The name of the selected face will be displayed in the command’s properties 

window (the field Offset face). The offset is specified as a numeric value of the 

parameter Offset. 

When specifying the face for defining the offset, the parameter Method is 

automatically assigned to the value Taper by offset. 
 

Creating Step Tapering 

For creating step tapering of faces it is necessary: 

 Specify taper direction;  

 Specify a fixed taper line; 

 Specify a tapered face or a collection of faces; 

 Specify a sequence of edges on the tapered face;  

 Specify taper angle (or a set of taper angles in case of selecting several tapered faces); 

 Specify the method of creating additional faces (by normal or with a taper); 

 Complete creation of operation with the help of . 

 

Taper direction, fixed taper line and a tapered face are specified in the same way as for the standard taper. 

For specifying the edges of a step taper, it is necessary to turn on the option: 

 <G> Step tapering 

When activating this option, the command switches to the mode of selection 

of edges, with respect to which the step taper will be formed. 

 

Selected edges of the step taper will be added to the corresponding list of 

the command’s properties window. The user can remove selected edge by 

selecting it in the list and pressing the button [Delete]. 

 

The method of creating additional edges forming the “step” is selected with 

the help of the list Edges of step taper. If the value Normal is chosen, the 

edges will be formed perpendicular to the original face. For the value Tapered 

the faces will be formed at a specified taper angle. 
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Advanced Operation Parameters 

Taper creation method 
The method of forming the taper is selected from the drop down list of 

the parameter “Method”. 

The taper creation method “By offset” can be set automatically when 

turning on the option of selecting the offset face (see section “Creating 

taper by offset”). 
 

Processing connection between faces 
You can select a method for connecting the tapered face and its adjacent 

faces, using the parameter Faces Connection/Tapered and Non-tapered in 

the properties window. 

 

Similarly, you can select a method for connecting the tapered faces. 

 

 

Processing faces together 
For combined processing of two adjacent faces, it is required to select one of 

them as a fixed face for another, and turn on the flag Multiple in the dialog 

of the command’s properties.  

In the same way, it is possible to create a taper for three and more 

faces. 

 

Splitting face 

For creating the taper with face splitting, the user has to specify a face 

which is to be split as a fixed face (a tapered face in this case is not 

specified) and activate the flag Split Faces. 

 

Note that the functionality of splitting faces remains in the command for compatibility with earlier 

versions of T-FLEX CAD. The currently available 3ZS: Imprint Elements command provides various 

ways of dividing a curvilinear face into pieces for further tapering. 
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BODY TAPER 

Body taper operation allows the user to create two-sided tapers of faces of a body relative to a specified 

taper direction and a parting body. A parting body divides the original body into two parts: “top” and 

“bottom”, which are tapered with respect to each other. A sheet body is usually specified as a parting body, 

but solid bodies can be used as well. 

For “top” and “bottom” tapers, the operation enables specifying different taper angles. If necessary, it is 

possible to specify only “top” or “bottom” angle, that is, create a one-sided taper of a body. 

The use of body taper operation allows the user to significantly simplify the process of designing cast parts 

and their molds. The parting body corresponds to the surface of separation, and the taper direction - to 

the direction of the mold separation. 

GENERAL CONCEPTS AND OPERATION CAPABIL IT IES  

General Concepts 

For creating a body taper, first of all it is necessary to indicate a tapered body itself, a parting body, the 

sets of “top” and “bottom” fixed edges of the tapered body, taper direction and angle. 

Taper Direction 

Taper direction is an oriented in space vector, relative to which the taper angles of the faces will be 

measured. 

Taper direction vector can be defined by two methods: 

 by one 3D object whose geometry can define a vector; 

 by two 3D points defining the start and end points of a vector. 

Parting Body 

A parting body is used for dividing the original body into two parts, each of which can be tapered 

individually. When tapering faces at both sides from the parting body, a two-sided taper is created. When 

tapering faces located at one side from the parting body, a one-sided taper is created. 
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Both sheet and solid bodies can be used as a parting body. In most cases, a sheet body is used as a parting 

body. After executing the operation, a parting body is remained in the 3D scene. 

The parting body may not have through holes. Additionally, the parting body must be large enough to 

fully intersect the target body in the taper direction.  

If a solid was selected as the parting body, then use of the “Body Taper” operation will result in one body 

obtained by merging the tapered and the parting body. 

 

The source body itself can be used as the parting body. On the figure below, an isoclinal line of the faces 

of the original body was selected as the source edges for creating the taper. The original body itself serves 

as the parting body. 

               

Fixed Edges/Faces 

For creating two-sided tapers of a body, it is required to specify two sets of edges: “top” edges and 

“bottom” edges. 
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The so-called “top” and “bottom” sets of base edges are respectively those located above and below the 

"parting body", with respect to the taper direction. The edges define the faces for which a taper needs to 

be created, and also define the fixed lines of these faces. 

 

It is possible to select only one set of fixed edges (“top” or “bottom”). In this case, a one-sided taper will 

be created. 

Instead of source edges, the user can specify the source faces themselves. For example, when creating a 

body taper, it might be impossible to select base edges of the “top” and “bottom” sets. Those edges might 

either not exist, or have the geometry that would not allow creating a body taper. In this case, for creating 

a taper the user indicates the sets of source faces based on which the virtual edges for constructing the 

body taper are defined. If, for example, a face was selected as “top”, then the command will automatically 

find the uppermost point on this face with respect to the taper direction. A virtual edge is defined at this 

point, passing tangentially to the edge of the selected face and perpendicular to the taper direction vector. 

 

Taper Angle 

Taper angle is specified separately for the “top” and “bottom” set of edges, i.e. for the “top and “bottom” 

faces. Within each set, all faces will have identical taper angle. 
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Corner Connection 

As a result, of performing a two-sided taper, along the line separating the tapered faces of the body, a 

gap-step can be created due to non-uniform displacement of the “top” and “bottom” faces. It is possible 

to avoid creation of this step by using the mode of corner connection.  

When creating an corner connection, the system automatically adjusts the displacements of the “top” and 

“bottom” tapered faces in such a way that they have a common edge (on the parting body). Correction of 

displacements is always carried out by adding material. 

A corner connection can be created only upon constructing a two-sided taper with the sheet parting body. 

                      

              

Creating the corner connection can be performed by one of the following methods: 

  “From edge” – the material is added from the edge determining the given face. The 

boundaries of the corrected face will include the source edge specified for this face (or a part 

of the edge); 

 “Tangent to face” – the material is added in such a way that the corrected surface becomes 

tangent to the adjacent faces (where it is possible). Simultaneously, the original edges may 

be deleted and replaced with the new edges created on the basis of the line of intersection 

of the corrected face and adjacent face; 
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 Combination of first two aforementioned methods – depending on the geometry of the 

resulting body, the system itself selects the method of creating the corner connection for 

each tapered face needing the correction. Priority is given to the method “From edge”. If, for 

some face, this method cannot be used, another method “Tangent to face” is employed. 

On the figure below, an example of creating an corner connection with the use of 

combination of two methods is shown. The “top” set of taper edges is non-closed, and it is 

impossible to employ the method “From edge” for the lateral cylindrical face. Thus, for 

creating a corner connection on the lateral faces of the tapered body, the method “Tangent 

to face” was used. On the end faces, the correction is carried out by the method “From edge”. 

 

By default, in the mode of corner connection, the system adjusts the displacements of all tapered faces. If 

necessary, it is possible to suppress the displacement correction for any of the tapered faces. 
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Taper creation method 

The following methods of creating the body taper exist in the command: 

 “Standard” – allows constructing the taper surface exactly matching the form of the source surface and 

a specified taper angle. 

 “By curve”, “By surface” – matches the form of the source tapered faces in a less stringent manner, 

which allows constructing the taper in cases when the standard taper construction method does not 

work. 

These algorithms are described in more detail in chapter “Face Taper”. 

By default, the standard taper creation method is used in the operation. If necessary, it is possible to apply 

another method of tapering to the entire tapered body as well as to each tapered face individually. 

Concave Edge Correction 

In some cases while creating the taper with the corner connection, concave angles are created on the body, 

which can interfere with successful creation of taper operation. 

         

To avoid such a situation various methods of processing the concave angles exist in the operation: 

 No correction – created concave angles remain unchanged; 
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 Cylindrical surface – concave angles are “covered” 

with a surface of cylindrical type. Simultaneously, in 

the plane of a parting body the projection of the 

concave angle is replaced with the circular arc of 

specified radius.  

 Mixed surface – the concave angles are “covered” 

with the surface of mixed type. In the plane of a 

parting body, the projection of an angle is replaced 

with a circular arc of a given radius and lines tangent 

to the surface of the tapered body.  

        

Processing Connections of Tapered Faces 

When creating a taper, the command provides options for selecting a method of processing connections 

between tapered faces. Two processing methods are available: 

 Extend surfaces – in this case, the adjacent tapered faces will be extended to achieve an intersection. 

 Create plane – in this method, a flat face will be created between two adjacent tapered faces. 

 

Edge Replacement 

In some cases, keeping the shape of edges defined as fixed leads to creation of redundant faces on the 

tapered body. To improve results of the operation, the user can allow replacement of certain “fixed” edges. 

Use of edge replacement guards in some cases from creation of extra tapered faces. The replacement 

edges are created in such away as to make a single slanted face. 
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Taper with Undercut 

In some cases, creation of a taper requires not the addition but the removal of the material of a tapered 

body. In this situation, it is necessary to use the option of creating an undercut. Otherwise, creation of a 

taper will be impossible. 

     

BODY TAPER CREATION  

The “Body Taper” command can be called by one of the following means: 

Icon Ribbon 

 

3D Model → Modify → Body Taper 

Keyboard Textual Menu 

<3TB> Operation > Taper > Body Taper 

To create a body taper, do the following steps: 

 Select the source body. 

 Select the parting body. 

 Define the taper direction. 
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 Select the top set of edges. 

 Select the bottom set of edges (required for the two-sided taper). 

 Define the top and bottom taper angles. 

 Define additional parameters of a taper (the method of creating a taper, the method of 

processing connections between tapered faces, an corner connection, etc.); 

 Complete operation creation with the help of . 

 

Main Input Data for the Operation 

Selecting source body 
The default mode of selecting the source body is activated automatically upon entering the “Create Body 

Taper” operation: 

 <S> Select source body 

 

This source body can be selected either in the scene or in the 3D model tree. 

After selecting the source body, the properties window will display the 

respective operation of the source body. 

 

Selecting parting body 
Upon selecting the source body, the system proceeds to the mode of selecting the parting body. To enable 

selection of a solid or sheet as a parting body, the following options are provided in the command 

automenu:  

 <A> Select parting body 

 <H> Select parting sheet body 

 

When using one of those options for selecting the parting body, the selector is 

tuned up accordingly. For example, in the sheet body selection mode, the 

following parting objects can be selected: a face, a 3D profile, an operation-

surface. Moreover, filters for choosing the objects can be also customized with 

the help of the drop-down list of the option . 

In the solid body selection mode, only objects with solid geometry can be 

selected for parting. 
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The name of the object used as the parting body appears in the properties window. 

 

Defining taper direction 
The next step in the operation creation is selecting an element defining the taper direction. This can be 

done by the option: 

 <D> Set tapering direction 

 

As common across other operations, the option for 

selecting the taper direction allows selection of various 3D 

elements capable of defining a directional vector. The 

direction-defining object is displayed in the properties 

window. 

To change the taper direction to the opposite, check the 

parameter Reverse Direction. 

 

Alternatively, the taper direction can be defined by two 3D points. The following options are provided for 

this purpose: 

 <1> Select first point of tapering direction 

 <2> Select second point of tapering direction 

 

Selected elements are displayed in the “Properties” 

window. 

To cancel the direction selection, use the option: 
 

 

 <K> Cancel direction selection 

Selecting fixed edges 
Selection of the set of edges is done directly in the 3D window. To create a one-sided taper, select just the 

top set of edges. For the two-sided taper, additionally select the bottom set of edges. To do this, use the 

following options: 

 <T> Select top edges 

 <B> Select bottom edges 
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Each selected edge will be added to the list of edges in the properties window. 

Switching between selecting the top and bottom sets of edges can be done 

either by the automenu options or by clicking the respective tabs in the 

properties window dialog. To remove an edge from the list, select it in the list, 

and then press the [Delete] button or <Del> key.  

Options  and  can be used in combination with the mode of selecting a sequence of smoothly 

connected edges, which can be activated by the option: 

 

 <G> Smooth edge chain selection mode 
 

Let us define a sequence of smoothly connected edges as a set of edges forming closed or non-

closed continuous curve which does not have sharp turns (the first derivative is continuous). 

When using the given mode, all edges capable of making a smooth sequence with the chosen edge are 

automatically picked. 

To cancel selection of all edges, use the following option: 

 <R> Cancel selection of all edges 

Selecting non-fixed faces 
The following options are provided for selecting bottom and top faces: 

 <U> Select top faces 

 <O> Select bottom faces 

 

You can activate selection of top or bottom faces by clicking an empty 

line on the respective tabs of the “Top and Bottom Faces” section in the 

properties window. Selection of faces, just like edges, is done in the 3D 

window. The selected faces will be added to the list of faces in the 

properties window. To remove a face from the list, select it in the list, 

and then press the [Delete] button or <Del> key.  

To cancel selection of all faces, use the option: 

 <Z> Cancel selection of all faces 
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Defining taper angles 
The command allows defining taper angles for the top and bottom 

faces of the source body. The angles can be defined by specifying 

values in the properties window. 

To modify taper angle values, you can also use draggers. Once the 

edges are defined, with respect to which the body taper will be 

constructed, the draggers appear in the 3D window for modifying the 

angles. Those draggers work the same way as the draggers defining 

taper angles in the command 3TA: Create Face Taper. 
 

 

    

 

At this stage, the option becomes available in the automenu: 

 

 <Y> Finish input 

Advanced Operation Parameters 

Selecting Method of taper creation 

The method of creating a taper is determined by the value of the parameter 

Method. To change the value of this parameter, a drop down list is used. The 

standard method is used by default. 
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For all selected fixed taper edges, the flag Common method is set by default. 

This means that the value of the parameter “Method” is unique for all 

selected fixed taper edges. When changing the value of this parameter, the 

taper creation method is changed for all tapered faces. 

To specify for some tapered face another tapering method (different from 

the one specified for the rest of the body) it is required: from the list of edges 

to select the edge corresponding to the given face, turn off the flag 

“Common method”, and with the help of parameter “Method” specify the 

required taper method. 

 

Creating corner connection 
Parameter Miter controls creation of corner connection. By default, it 

is assigned the value No, which signifies that the corner connection is 

not created.  

In order to create a corner connection, the user needs to select one of 

the following values: From Edge, Tangent to Face, or Both from the 

drop down list. Difference between these three options was described 

above. 

A corner connection can be created only upon constructing a 

two-sided taper with the sheet parting body. 

By default, the corner connection is created for all tapered faces of the 

body. To exclude any of the faces from the corner connection, the user 

needs to select the edge corresponding to the given face from the list, 

and, for the selected edge, take off the flag Miter. 
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Selecting Method of Correcting Concave Angles 
Parameter Concave is responsible for correcting concave angles arising upon 

creation of a taper with a corner connection. By default, this parameter is 

assigned the value No, which means that concave angles remain intact. 

 

For automatic correction of concave angles it is required to select another 

value from the drop down list: 

 

- Radius – a concave angle is covered with a surface of cylindrical 

type. In addition, the radius of the surface must be specified in the 

parameter Radius; 

- Mixed Surface – a concave angle is covered with a surface of 

mixed type. The radius of cylindrical segment of the surface is 

specified with the help of the parameter Radius. 

 

 

Controlling Edge Replacement 

The flag Replace Edge controls the capability of replacing fixed edges upon 

creation of taper. By default, replacement of all selected taper edges is 

suppressed (flag is turned off for all edges). 

To permit replacement of any of the edges, the user should select it in the 

list of edges and set the flag “Replace Edge”. 

 

 

Closing gaps between adjacent faces 
The method of processing the connection between tapered faces is 

selected with the help of parameter Corner. 

  

Specifying Undercut 
The mode of creating an undercut is activated with the help of the flag 

Undercut. By default, this flag is turned off. 
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Keep source body 
The operation of creating the body taper allows the user to keep the source 

body in the 3D scene. For that, it is sufficient to set the flag Keep Source 

Body. 
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SHELL 

MAIN CONCEPTS  

The operation “Shell” allows creating offset bodies and shells based on solid bodies. A shell is a hollow, 

thin-wall body with walls of the specified thickness. When creating a shell, some of the source solid body’s 

faces can be removed. 

    

The operation “Shell” is based on the following principle: an offset surface is created for each face of the 

source sheet or solid body, at the specified offset distance. Depending on the user preference, the offset 

can be outwards or inwards of the surface of the processed body (directional or counter-directional to the 

normal). The offset surfaces can be used as a self-contained result – for creating offset bodies. Alternatively, 

offsets can be used for making a shell by confining a portion of the inner volume of the source solid body. 

SHELL CREATION  

The command 3SH: Create Shell is called by one of the following means: 

Icon Ribbon 

 

3D Model → Modify → Shell 

Keyboard Textual Menu 

<3SH> Operation > Shell 

To create a shell, do the following set of steps: 

 Select a face to remove or a whole solid body; 

 Select a face whose wall thickness is to be defined separately (if desired); 

 Define parameters (optional action); 

 Finish input. 

To create an offset body, do the following set of steps: 

 Select the source sheet or solid body; 

 Activate the mode of creating offset body; 

 Define parameters (optional action); 
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 Finish input. 

Selection of a Face or a Body to Remove 

To create a solid shell with one or multiple face removal, use the option: 

 <R> Select Face to be removed 

This option activates by default upon calling the command. It 

allows selecting a face or a set of faces to be removed when 

creating the shell. The parent body of the first selected face 

to be removed is also selected. The body is highlighted in this 

case and selected face is highlighted with color. 

The faces selected for removal are added to the list in the 

provided pane in the property window on the tab [Removed].  

Placing cursor in the list pane in the property window 

activates the option for selecting faces to remove. 

The thickness of other walls of the shell being created is 

defined in the input box “Thickness” of the property window. 

The default value is 1.  

This means the walls of the faces left in the body will be 1 mm 

thick (the measurement units depend on the document 

settings). 

 

 

Enlargement of the shell wall may be performed inside, symmetric and outside according to the initial 

body. The corresponding direction selection is performed by clicking the corresponding button in the 

properties window. 

    

The wall thickness may have positive or negative value. If you specify negative value, a shell will be 

performed in the opposite direction. 

To create a shell without removing any faces, upon entering the command switch to the automenu option: 

 <O> Select Solid 

This option allows selecting a solid body to create a hollow body with the specified wall thickness. 
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Selection of Faces with Individually Defined Wall Thickness 

To define the wall thickness individually for one or several faces, select such faces with the help of the 

automenu option: 

 <T> Select Face with different wall thickness 

 

The option is available only when a body or 

removed face is already selected. The selected 

faces are called different and are listed on the 

Different tab. You can specify thickness and 

direction for each of the faces separately after 

selecting one or several faces in the list. 
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Including and Excluding Additional Faces 

If it is required to include an additional body to the 

shell, you need to combine the existing shell and 

the target body using Boolean command. You 

should call Shell command and specify the face to 

delete. On the Additional tab, you should select 

faces that should be included into the shell. In the 

drop-down list select the Include faces mode. The 

displacement value of the additional faces is 

specified in the Thickness field. 

 

                

If there are faces of the body that should not be 

used during a shell creation, you should select the 

excluded faces on the Additional tab and enable 

Exclude faces mode in the drop-down list.  

 

 

                

The following option is used to cancel selection of removed, different or additional faces. 
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 <K> Cancel selection of Faces by pointing to them 

To cancel a selection, point the mouse at a selected face and click . Faces can also be unselected by 

manipulating the respective list in the property window. For this purpose, the graphic button [Delete] is 

provided with each list. 

All faces can be unselected at once by the option: 

 <F> Cancel selection of all Faces 

You can confirm the operation creation as soon as the option becomes accessible in the automenu:  

 <Y> Finish input 

As a result, a shell body will be displayed in the 3D window. 

Additional Operation Parameters 

You can set additional operation parameters in the 

properties window using the corresponding 

options: 

 

 

 Pierce Smooth Surface. The option allows to create a shell in the cases, when the removed face 

is tangent to the non-planar faces. For example, it can be a rounding (radius chamfer).  

  

 Create Offset Body. When the flag is set an equidistant (non-hollow) body is created. The body 

faces will be shifted relative to the faces of the original body by the specified amount. This mode 

can be useful for creating workpieces with an allowance for processing. 

You can use sheet bodies when you create an offset body in the Shell command. 
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 Keep Source Body. The option allows keeping source body and the resulting body in the scene. 

It may be useful when you need to preserve two models. For example, the body with an allowance 

and the initial body. 

 Blend Convex Edges. The option allows blending convex edges formed by proportional 

displacement of adjacent faces. The amount of displacement determines the thickness of the 

resulting wall of the shell. 

  
Blending of convex edges when the faces are 

shifted inward 

Blending of convex edges when the faces are 

shifted outward 

Only edges the thickness of the adjacent walls of which will be equal to the radius of rounding 

will be blended. 

  

Edge blending with adjacent wall thickness equal 

to 10 (rounding radius 10) 

Edge blending with adjacent wall thickness equal 

to 20 (rounding radius 20) 
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 Faces extension type. The option 

allows you to determine which face 

will be ignored in case of 

overlapping faces. 

 

 

 

   
Auto - movable and fixed faces do 

not overlap 

Extend moved – moved faces 

overlap fixed  

Extend fixed – fixed faces overlap 

moved 

Dynamic Preview 
In the process of setting/editing shell parameters, the future result of the current operation is dynamically 

displayed in the 3D window. To increase performance, you can disable the dynamic preview by disabling 

the Dynamic Preview checkbox in the “Options” section of the command properties window. 

Draggers Usage 
Draggers are special graphics elements, which are convenient to use to specify main numerical parameters 

of a shell during dynamic preview. Draggers appear after elements selection. 

There are two draggers types for the operation: 

 Dragger for specifying general shell thickness appears upon a body or removed face selection on 

the largest (not selected) face of the model; 

 Draggers for specifying thickness of different faces. 

Draggers may specify face offset both inward and outward. They are synchronized with the parameters of 

the direction of the faces offset. 

Using draggers while working with a large number of objects on a computer of low performance 

may cause a significant system slowdown. In this case, you can disable draggers using the Use 

draggers option in the “Options” section of the properties window.  
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Troubleshooting 

When creating “Shell” operation, the system may fail to calculate the result in some cases. A reason for a 

failure could be particulars of the source body geometry. Let's review most typical situations: 

1. Degenerate faces. When creating an offset, some faces may disappear. The system may handle 

some of the cases. However, if there are too many such faces, or several adjacent faces disappear, 

the system outputs an error. 

 

2. Offset faces do not intersect. Upon creating offset faces, the system constructs intersection lines 

between adjacent faces for generating the resulting body. In some cases, two adjacent offset 

faces may not intersect.  
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SPRINGS 

The operation Spring creates a 3D body as a conic or cylindrical helix-shape spring with round profile. The 

body is created by sweeping a circular profile along a helical curve defining the spring trajectory. 

                           

For speeding up modeling, a capability is provided for creating a Boolean operation together with spring 

creation. (This capability was described in details in the chapter “Extrusion”.) 

MAIN CONCEPTS AND OPERATION CAPABIL IT IES  

Spring Axis 

The helical curve used for sweeping the circle profile is centered about the spring axis. The axis is defined 

by two 3D points: the start point and the end point. 3D points can be defined by 3D nodes, as well as by 

any 3D object suitable for defining a point in the space. The vector defining the spring axis will be directed 

from the first point to the second one (those also defines the start and the end of the spring, respectively). 

The shape of the curve is defined by the spring parameters. The swept profile will be normal to the original 

curve. 

 

Spring Main Parameters 

The shape of the body resulting from this operation is defined by the following parameters: 

 The radius of the spring strip – defines the radius of the circular profile, whose sweeping forms the 

body; 

 Mean spring radii at the ends – the radii of the helical curve at the start and end of the spring (mean 

start and end radii are equal in the case of a cylindrical spring); 

 The step (pitch), the number of coils and the free length of the spring; 
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 Spring coiling direction: Clockwise (right) or counterclockwise (left). 

The free length of the spring can be defined as the distance between the 3D points defining its axis. In this 

way, it is sufficient to define just the pitch or just the number of coils – the other parameter will be 

calculated by the system automatically. In the cases when both the pitch and the number of the spring 

coils are defined, the spring length will be defined solely by those parameters. 

                                    

Initial Position of Spring Profile 

Initial position of the spring profile is set arbitrarily by the system. It can be modified by defining the desired 

position with the help of an additional 3D point – the start point of the profile – or by specifying the 

numerical value of the profile rotation angle (with respect to the original position). 

Once the start point of the profile is specified, it will snap to the plane passing through the selected point 

and the spring axis, along the specified start radius vector. 

                

When both the angle of the start point and the numerical value of the rotation angle are specified, the 

latter is evaluated with respect to the profile position defined by the start point. 
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Compression and Grinding of Spring Ends 

If necessary, the end coils of the spring can be compressed (closed) and ground. The diagram below shows 

a spring with one coil compressed at the start, and one coil compressed and 3/4-circle ground at the end. 

 

Spring Position with Respect to Start and End Points 

If the spring length is defined by the pitch and the number of coils, you can force the spring alignment by 

the start or the end point. 

  

Aligning by start point  Aligning by end point  

SPRING OPERATION CREATION  

To create the operation Spring, use the command 3SP: Create Spring: 

Icon Ribbon 

 

3D Model → Modify → Spring 

Keyboard Textual Menu 

<3SP> Operation > Spring 

To create a spring, do the following steps: 

 Define spring axis; 
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 Define spring parameters (the radius of the wire strip, the spring main radius, etc.); 

 Select the start point for the spring profile position (optional); 

 Confirm operation creation. 

Spring Axis Definition 

The start point of the spring axis is defined by the following automenu option: 

 <F> Select starting Point of Axis 

The end point of the axis is selected option: 

 <S> Select ending Point of Axis 

The options activate one after another. Selected 3D objects are highlighted. Once the second point is 

selected, a vector will be displayed in the 3D scene, defining the axis of the spring, the helical guide and 

the profile circle. (Initially, those are assigned the default parameter settings.) Additionally, a radius-vector 

will be displayed, representing the mean radius at the spring start. 

 

At this stage, you can already complete the spring operation by pressing  in the property window or in 

the automenu. 

The spring parameters can be defined in the command property window or in the operation parameters 

dialog box, accessible by the option . 

Spring Operation Parameters Definition 

You can define main parameters of the spring in the top section of the property window – (non-optional) 

Parameters. Those are wire (strip) radius, the mean radii of the spring and the direction of coiling.  

To have the spring length calculated by the distance between the axis-defining 3D points, set one of the 

flags: Coils from Spiral Length or Pitch From Spiral Length. In this case, the system will automatically 

calculate the value of the parameter with the respective flag set (either the number of coils or the pitch). 

At the same time, you have to specify a numeric value of the other parameter (either Coils or Pitch). If none 

of the flags is set, you will have to specify both the number of coils in the spring and the pitch. 

The radius of the spring strip (wire) is specified in the box Wire Radius. The winding direction of the spring 

is controlled by the radio group Direction of Coiling. 
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The start and end mean radii of the spring are defined by the parameters Mean Coil Diameter/Start and 

Mean Coil Diameter/End. To create a cylindrical spring, specify equal values for both radii. 

 
 

Selection of the Start Point for Spring Profile Position 

The start point of the spring profile can be specified by the following automenu option (the option activates 

upon selecting the second axis point): 

 <B> Select 3D Node as profile starting location 

To undo a 3D point selection, simply select another one with the same option, or cancel the selection by 

the option: 

 <К> Delete starting 3D Node 

The profile will then revert to its original position. 

You can enter a numerical value of the profile rotation angle with respect to 

the original position in the operation property window, by the parameter 

Offset Angle ((non-optional) Parameters section). 
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Defining Compression and Grinding of Spring Ends 

Parameters for compression and grinding of end coils of the spring are 

defined in the other section of the property window – in Optional 

Parameters. 

To compress coils at the spring start, set the flag Start/Compress and enter 

in the adjacent box the desired number of coils (for example, “0,75” or “1”). 

Setting the flag Start/Ground allows defining the portion of the first coil to 

grind. The compression and grinding parameters at the end of the spring are 

defined in a similar way – by using the flags End/Compress and End/Ground. 
 

Spring Alignment by Start or End Point 

To align the spring by the start or end point, set the following flag in the property window: Align with 

Starting 3D Node or Align with Ending 3D Node. In the case of ambiguity (when both flags are set), the 

system aligns the spring by the start point. 

Using the created spring in a Boolean 
To create a Boolean operation, do the following: 

Turn on the Boolean creation mode by the automenu option: 

 <Ctrl+B> Select original body for Boolean operation 

A Boolean is created when the icon is pushed. 

Select the type of the operation from the pull-down list under the above option: 

 <Ctrl+'+'> Addition 

 <Ctrl+'-'> Subtraction 

 <Ctrl+’*’> Intersection 

 <Ctrl+l> Smart mode 

Operating principles of the Smart mode: 

 If the body being created and the existed selected body have intersection of volumes - the type of 

Boolean operations: subtraction. 

 If the body being created lies entirely within the selected body - the type of Boolean operations: 

subtraction. 

 If the body being created touches and selected body touch each other - the type of Boolean 

operations: addition. 
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 If conditions set out above are not met, or a selected body lies inside the created, or error occurred 

determining the type of penetration, then, Boolean type is not defined - the Boolean operation will 

not be created. 

Select the target body for the Boolean (optional in some cases), using the automenu option: 

 <Ctrl+T> Select Target Body for Boolean 

If only one body exists in the scene, it is selected automatically. The new body created by the 

spring operation becomes the tool body of the Boolean. 

Upon confirming operation creation, first the body is created by the spring operation, and then the 

specified type Boolean is performed. 
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SPIRAL 

The operation Spiral creates a 3D body as a conic or cylindrical helix-shape spring with arbitrary profile. 

This functionality is mostly similar to the Spring operation functionality. Spiral is created by sweeping an 

arbitrary closed 3D profile along a helical curve. The profile can be oriented perpendicular to the spiral 

trajectory or perpendicular to the helical curve. 

                           

For speeding up modeling, a capability is provided for creating a Boolean operation together with spiral 

creation (this capability was described in details in the chapter “Extrusion”). 

MAIN CONCEPTS AND OPERATION CAPABIL IT IES  

Spiral Axis 

The helical curve used for sweeping the profile is centered about the spiral axis. The axis is defined by two 

3D points: the start point and the end point. 3D points can be defined by 3D nodes, as well as by any 3D 

objects suitable for defining a point in the space. The vector defining the spiral axis will be directed from 

the first point to the second one (this also defines the start and the end of the spiral, respectively). The 

shape of the curve is defined by the spiral parameters. The swept profile will be normal to the original 

curve. 

 

Spiral Profile and its Orientation in Space 

You can select any closed single-contour 3D profile as the spiral profile.  

The profile position in the space is defined by a fixing vector. The spiral fixing vector is defined by two 3D 

points fixing the profile. The profile fixing vector will be directed from the first 3D point to the second one. 

If the profile is defined by 2D constructions, the profile fixing vector can be defined by two 2D points in 

the profile plane. 
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Once the spiral is created, the first point of the profile fixing vector is snapped to the end point of the 

radius vector at the spiral start. The direction of the vector is collinear with the radius vector. 

 

After that, the profile is rotated about the fixing vector to achieve one of the following orientations: 

perpendicular to the helical curve, perpendicular to the axis or parallel to the axis. 

                 

If necessary, the profile of the spiral can be rotated about the radius vector by 180 degree. 

          

Spiral Main Parameters 

The main spiral parameters are: 

 Mean spiral radii at the ends – the radii of the helical curve at the start and end of the spiral; 

 The step (pitch), the number of coils and the free length of the spiral; 

 Spiral winding direction (hand of coiling): Clockwise (right) or counterclockwise (left). 
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The free length of the spiral can be defined as the distance between the 3D points defining its axis. In this 

way, it is sufficient to define just the pitch or just the number of coils, while the other parameter will be 

calculated by the system automatically. In the cases when both the pitch and the number of the spiral coils 

are defined, the spiral length will be defined solely by those parameters. 

                         

The radius of the spiral can also be calculated automatically by the system. It will be equal to the distance 

from the spiral axis to the first profile attachment point. 

Initial Position of Spiral Profile 

The initial position of the spiral profile is defined by the system as follows: The spiral start radius vector lies 

in the plane passing through the spiral axis and the closing point of the original 3D profile. If necessary, a 

different starting position can be specified. The desired starting position can be defined with the help of 

an additional 3D point – the start point of the profile – or by specifying the numerical value of the profile 

rotation angle (with respect to the original position). 

Once the start point of the profile is specified, it will snap to the plane passing through the selected point 

and the spiral axis, along the specified start radius vector. This capability was described in the chapter 

“Spring”. 

When both the angle of the start point and the numerical value of the rotation angle are specified, the 

latter is evaluated with respect to the profile position defined by the start point. 

Tapering 

If necessary, the ends of the spiral can be tapered at a specified rate. This capability is provided for defining 

thread tapering when using Spiral operation for creating thread bodies. 

 

When tapering, the spiral profile reduction is done against the direction of the profile fixing vector. 
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STEPS OF SPIRAL OPERATION CREATION  

To create a Spiral operation, use the command 3SR: Create Spiral: 

Icon Ribbon 

 

3D Model → Modify → Spiral 

Keyboard Textual Menu 

<3SR> Operation > Spiral 

To create a spiral, do the following steps: 

 Define the spiral axis by two 3D nodes. 

 Select a 3D profile. 

 Define the profile orientation in the space. 

 Define the starting position of the profile (select the start point for the profile position – optional). 

 Define spiral parameters (the spiral radius, etc.). 

 Confirm the operation creation (  in the property window or in the automenu). 

The spiral parameters are defined in the command property window or in the operation parameters dialog 

box, accessible by the option . 

Spiral Axis Definition 

The start 3D point of the spiral axis is defined by the following automenu option: 

 <F> Select starting Point of Axis 

The end point of the axis is selected option: 

 <S> Select ending Point of Axis 

The options activate one after another. Selected 3D objects are highlighted. Once the second point is 

selected, a vector will be displayed in the 3D scene, defining the axis of the spiral, the helical curve and the 

radius vector indicating the radius at the start of the spiral. 

Spiral Profile Selection 

Upon defining the spiral axis, the following options become available in the automenu: 

 <C>  Select 3D Profile 

To select the spiral profile, in the 3D view window move the pointer to a 3D profile and click . To select a 

3D profile based on a 2D hatch, you can pick the original 2D hatch in the 2D view window (or on the 

activated workplane). 
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Defining 3D Profile Orientation in Space 

The 3D points of the profile fixing vector are defined by the following automenu options: 

 <R> Select First Attachment 2D Node 

 <T> Select Second Attachment 2D Node 

To define the fixing vector by 2D nodes (in the case of the 3D profile based on 2D elements), use another 

pair of options in the command automenu: 

 <N> Select first attachment 2D Node 

 <A> Select second attachment 2D Node 

Selected 3D points (or 2D nodes) are highlighted; however, the profile fixing vector is not displayed in the 

scene. 

The way of orienting the profile is defined in the operation parameters, in the 

group “Profile Orientation”. The combo box contains the following options: 

Parallel to Axis – the spiral profile plane stays parallel to the spiral axis 

as it is swept along the helical trajectory; 

Orthogonal to Axis – the spiral profile plane stays perpendicular to 

the spiral axis; 

Orthogonal to Path – the spiral profile plane stays perpendicular to 

the helical trajectory. 

 

 

To rotate the spiral profile about the radius vector by 180 degree, set the flag Reverse Profile. 

At this stage, you can already complete the spiral creation by pressing  in the property window or in 

the automenu. 

Spiral Parameters Definition 

The main spiral parameters are defined in the first section of the property window – Parameters. Those 

include the number of coils and the pitch, the start and end mean spiral radii, the spiral direction, etc.  

To have the spiral length calculated by the distance between the axis-defining 3D points, set one of the 

flags: Coils from Spiral Length or Pitch from Spiral Length. In this case, the system will automatically 

calculate the value of the parameter with the respective flag set (either the number of coils or the pitch). 

At the same time, you will have to specify a numeric value for the other parameter (either of Coils or Pitch). 

If none of the flags is set, you will have to specify both the number of coils in the spiral and the pitch. 

The winding direction of the spiral is controlled by the radio group Direction of Coiling. 

The spiral radius will be calculated automatically (by the distance between the axis and the first attachment 

point of the spiral profile), if the flag is set, Coil Radius from fixing Node. To define an arbitrary radius at 

the spiral start and end, cleared the flag and enter the desired values in the boxes Start and End. 
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Selection of the Start Point for Spiral Profile Position 

The start 3D point of the spiral profile is defined by the following automenu option: 

 <B> Select 3D Node as profile starting location 

To undo a 3D point selection, simply select another one with the same option, or cancel the selection by 

the option: 

 <К> Delete starting 3D Node 

 

The profile will then revert to its original position. 

You can enter a numerical value of the profile rotation angle with respect to 

the original position in the operation property window, by the parameter 

Offset Angle (Parameters section). 

 

 

Using the created spiral in a Boolean 
To create a Boolean operation, do the following: 

Turn on the Boolean creation mode by the automenu option: 

 <Ctrl+B> Select original body for Boolean operation 

A Boolean is created when the icon is pushed. 

Select the type of the operation from the pull-down list under the above option: 
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 <Ctrl+'+'> Addition 

 <Ctrl+'-'> Subtraction 

 <Ctrl+’*’> Intersection 

 <Ctrl+l> Smart mode 

Operating principles of the Smart mode: 

 If the body being created and the existed selected body have intersection of volumes - the type of 

Boolean operations: subtraction. 

 If the body being created lies entirely within the selected body - the type of Boolean operations: 

subtraction. 

 If the body being created touches and selected body touch each other - the type of Boolean 

operations: addition. 

 If conditions set out above are not met, or a selected body lies inside the created, or error occurred 

determining the type of penetration, then, Boolean type is not defined - the Boolean operation will 

not be created. 

Select the target body for the Boolean (optional in some cases), using the automenu option: 

 <Ctrl+T> Select Target Body for Boolean 

If only one body exists in the scene, it is selected automatically. The new body created by the 

spiral operation becomes the tool body of the Boolean. 

Upon confirming operation creation, first the body is created by the spiral operation, and then the specified 

type Boolean is performed.
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THREAD 

T-FLEX CAD supports creation of cosmetic threads on cylindrical and conic faces of a three-dimensional 

model. A cosmetics thread is not the exact geometrical representation of an actual thread that can be 

created in the command 3SR: Create Spiral. Nevertheless, it is quite suitable for most of the tasks arising 

in thread modeling, while consuming much less computational resources. 

A cosmetic thread is a texture applied to the selected face. The simulated image reflects the pitch, direction 

and boundaries of the thread. 

When creating drawings by projecting cosmetic threads, the standard thread notation is automatically 

generated on the projections. 

  

MAIN CONCEPTS .  OPERATION CAPABIL IT IES  

Cosmetic threads are created based on a special database “Threads.mdb”, located in the folder …\Program. 

The database contains geometrical parameters of standardized threads according to the engineering 

standards. If necessary, the database can be appended with custom threads. You can also create 

nonstandard threads directly in T-FLEX CAD, without using the database. 

When creating a cosmetic thread, you need to select the base face (cylindrical or conic), define the thread 

type (standard) and side (outer or inner) and the main parameters. To define the thread parameters, use 

either the property window or the standard parameters dialog box. All of the thread parameter values can 

be defined using variables. Additionally, you can specify the thread offsets from the ends of the base face 

or from an arbitrary 3D object. The position of the thread end can also be defined relative to its start, by 

actually specifying the thread length. 

The parameters of the standard thread – the pitch, the working profile height and the class – can either be 

set by the system automatically or manually defined by the user. 
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In the Autoadjust mode, the system sets the thread parameters from the database, based on the diameter 

of the base face. When the base diameter is modified, the thread parameters are adjusted automatically. 

In the manual mode, the user defines the thread parameters by numerical values or by using variables. The 

entered values are checked against those in the thread database. If the input diameter or pitch is not 

defined for the respective thread type, the value will be taken from the database nearest to the specified 

one. In this case, the thread parameters will not adjust to the base face diameter modifications. When 

creating a nonstandard thread (not existing in the thread database), all its parameters are defined manually. 

The combination of parameters and the thread behavior depends on its property – being an outer or an 

inner thread. For an outer thread, the base face diameter is considered the outer diameter, while for an 

inner thread it is the inner diameter. For the same base face diameter, the system-defined parameters will 

be different for outer and inner threads. The thread side (outer or inner) is a characteristic constant and 

can be defined in two ways.  

In the first way, the thread side is defined automatically at creation. 

Inner threads are created on concave faces, while outer ones – on the 

convex faces. If the face later changes from convex to concave or vice 

versa due to Boolean operations or other body modifications, the 

thread will disappear. The automatically defined thread side is suitable 

for most of threads. In the second way, the thread side is explicitly 

defined by the user at creation, regardless of the current geometry of 

the base face. This may be necessary, for example, when creating 

fragments of holes. 
 

In the fragments, the thread is applied to the convex face, yet is marked as inner. Upon assembling the 

fragment, performing a Boolean subtraction makes the base face of the thread concave. Thus, after the 

Boolean operation the thread is carried over to the resulting inner cylindrical face of the hole. 

When creating a 2D projection, the necessary graphic lines are created automatically to mark the thread. 

The parameters of such graphic lines are defined separate from the rest. 

CREATING THREAD  

To create a thread, use the command 3AT: Create Thread: 

Icon Ribbon 

 

3D Model → Modify → Thread 

Keyboard Textual Menu 

<3AT> Operation > Thread 

 

First, you need to select a cylindrical or conic face in the 3D window to which the thread will be applied. 

Upon entering the command, the following automenu option is active: 
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 <F>  Select cylindrical face 

 

Upon the selection, a schematic image of the thread spiral is displayed 

on the face, along with the marks for the thread start and end. By 

default, the thread is applied to the full extent of the selected face. The 

arrow on the thread image shows the direction of cutting the thread. 

The cutting direction is defined by the face selection: the thread start 

is set at the face end nearest to the pointer at the time of clicking  for 

face selection. It is necessary to know the cutting direction in order to 

correctly define the boundaries of the thread. 
 

Upon selecting the first face, the option  stays active, allowing to select another face of the same type 

and diameter for extending the thread. This allows creating a thread spanning several faces. 

Defining Main Thread Parameters 

Among thread parameters (in the property window or the parameters dialog box of the option ), select 

the thread standard: one of the standards provided in the database, or non-standard. An input box next 

to the combo box of the thread the standards allows defining the thread standard, using a numerical value 

or a variable (this number corresponds to the record number of the thread in the database). 

The parameter Side defines the thread property being outer or inner. One of 

the three choices can be selected from the combo box: 

Current. The side of the thread is determined by the type of the base face at 

the time of the thread creation. If the type of the base face changes to the 

opposite later in modifications (for example, as a result of a Boolean 

operation), the thread will be deleted as inappropriate for the face. 

Outer. The thread is considered outer (regardless of the type of the base face). 

When using automatic setting of parameters, the face diameter is considered 

the outer diameter of the thread. 

Inner. The thread is considered inner (regardless of the type of the base face). 

When using automatic setting of parameters, the face diameter is considered 

the inner diameter of the thread. 

 

The preferred setting for most threads is “Current”. The choices “Inner” and “Outer” should be used 

on faces, whose type is expected to flip later. For example, when creating fragments of holes that 

are subtracted from the base body when assembled, the “Inner” thread is created, even though it is 

the outer face in the fragment. 

When selecting the nonstandard thread type, all its parameters, including the notation on the drawing, are 

always defined by the user manually by numerical values or by variables. 
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For standard threads, Autoadjust mode is turned on by default (the flag Autoadjust). In this case, the thread 

parameters are set according to the diameter of the base face. The nearest to the actual diameter value is 

picked from the set of diameters of the specified thread. Should two satisfactory values be found, the one 

is picked with the higher priority according to the standard guidelines. Then, the most suitable pitch is 

picked among the ones corresponding to the chosen diameter (for a metric thread, this will be the large 

pitch, for other threads – the one recommended by the respective standard). 

The Autoadjust mode is not limited to the thread creation. When modifying the diameter of the base face 

with the Autoadjust mode turned on, the thread parameters will be adjusting automatically as well. 

The selected diameter and pitch are displayed in the respective boxes of the parameters dialog (Diameter, 

Pitch). The box Height reflects the height of the thread working profile for the given pitch. If necessary, 

you can select another pitch from the system-offered list. In this case, when performing automatic 

adjustment of the face diameter modifications, the nearest to the manually defined pitch will be set, rather 

than that recommended by the standard. 

When the Autoadjust mode turned off, you can specify arbitrary parameter values or variable names for 

the standard thread parameters in the parameters dialog box. Nevertheless, even in this case, the thread 

parameters are taken from the database. The values are selected nearest to those input by the user. Such 

parameters do not change with modifications of the base face diameter. 

The additional “Class” field allows defining a tolerance or a precision 

class for the thread (in some standards). The value of this parameter can 

be selected from the pull down list, if the respective tolerance or class 

of precision values were defined in the thread database. The contents 

of such list are based on the values entered in the database, respective 

to the thread type and standard. 

The field Number of threads defines the number of thread sets.  

The threads are created right-handed by default. If you need to create a left-handed thread, turn on the 

flag Left-handed. The input box on the right of the flag allows controlling its state by using a numerical 

variable (the value “1” means the flag is on, “0” – off). 

The Notation field displays the thread notation that will be used on a projection.  
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Defining Offsets 

By default, the thread is applied to the whole 

extent of the selected face. That means, zero 

offsets from the face ends are used. If necessary, 

you can specify a different offset value or modify 

the way of defining the offsets – with respect to 

the face ends, relative to an arbitrary 3D object, 

etc.  

The offset values can be defined either by a 

numerical value in the property window or by 

hand in the 3D view window. In the latter case,  

 

move the pointer to the dragger defining the position of one of the 

thread ends. The pointer will change to  (at the start of the thread) 

or  (at the end of the thread). After that, you can define the new 

position of the respective thread end by dragging the mouse with the 

depressed . The property window will be reflecting the current offset 

value. If necessary, it can be adjusted by entering a new value. 
 

The way of defining the thread offsets can be modified either in the parameters dialog box or by using the 

automenu options: 

 <A> Select thread start type 

 <D> Select thread end type 

Each of the options contains an enclosed list of choices for defining the thread start and end, respectively. 

To define the start boundary of the thread, you can select: 

From face start. This is the default setting. The offset for the thread 

start is counted from the start boundary of the base face. The start is 

considered the end of the face nearest to the pointer position of the 

time of selecting the face.  
 

From object. The thread start offset will be counted from the additionally selected 3D object. Upon 

selecting this option, you need to specify the desired object. 

Define the end boundary of the thread as: 

From face end. This is the default setting. The offset for the thread 

start is counted from the end boundary of the base face. 

From thread start. The offset is counted from the start of the thread, 

thus defining the actual thread length.  

From face start. The offset for the thread end is counted from the start boundary of the base face. 
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From object. The offset for the thread end is counted from an additionally selected 3D object. Upon 

selecting this option, you need to specify the 3D object. 

The mode of defining From object can only be set by the automenu options.  

In the bolt example, one of the thread parameters is its length, counted from the end of the bolt stem. 

Often, the thread is applied to a face already trimmed by a chamfer. To account for the chamfer when 

defining the thread length, use the option “From object” for the start boundary and select the end face of 

the bolt stem or an element belonging to this face (such as a 3D node) as the object. The end boundary of 

the thread can be defined in this case as “From thread start”, entering the value of the exact thread length 

as the offset. 

The amount of default offsets is defined among the model units (the 

command ST: Set Document Parameters, the tab “3D”). It is possible to 

define the offsets in percent of the face length or of the distance 

between the start of the thread and the end of the face (if using the 

option “From thread start” for the end boundary of the thread).  

When selecting any of the thread boundaries in the option “From object”, the options for selecting 3D 

objects become accessible in the automenu: 

 <V> Select points 

 <L> Select lines 

 <U> Select planes 

 

You can select any 3D elements as the object, that 

define a point, line or plane. Any of those options 

contains a list of filters for selecting 3D elements, 

that tune the selector for picking the desired 

geometry type. Use of those filters is described in 

details in the chapter “Basic 3D Terms and 

Concepts of Modeling with T-FLEX CAD”. 

To select a different object for defining the 

position of the thread boundary, simply repeat 

the selection. You can cancel relations between 

thread boundaries and selected objects by 

modifying the thread offset option in the 

automenu or in the property window. 
 

To cancel the selection of the base face and the reference objects for the thread boundaries in one move, 

use the automenu option: 

 <R>  Cancel selection of all Faces  
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Complete the thread creation by pressing the option . The thread will 

then be schematically displayed on the selected face. 

 

THREAD D ISPL AY ON 2D  PROJECTIONS  

By default, the thread-marking lines are automatically created on 2D projections of bodies with threads. 

The line display is controlled via the projection properties, the tab “Lines”. 

 

When dimensioning the thread lines, the thread notations are applied automatically. To cancel this mode 

(of creating a normal dimension), set parameter “Value” to “Auto”. By default the value is set to “From 

lines” for dimensioning the thread lines. 

 

Hidden threads can be displayed on 2D projections by dashed lines, when the “show hidden lines” mode 

is turned on. When creating a section or a local view, the thread is displayed in the usual way. In those 

cases, thread notations can be applied automatically when dimensioning thread lines. 
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Sections of the threaded connections require setting of the “Fill Element Outline” flag in 2D Projection 

parameters (see more details in “2D Projections. Creating 2D Drawings of the 3D Models” chapter). When 

flag is set, lines of the section view will be constructed correctly. Otherwise projection lines of bolts and 

holes will overlap each other due to interpenetration. 
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HOLES 

The operation “Hole” helps creating standard holes of various types. The operation capabilities span from 

creating isolated holes in a single body to cutting holes or their arrays through multiple separate bodies. 

When threaded holes are created, cosmetic threads are applied automatically. 

MAIN CONCEPTS AND OPERATION CAPABIL IT IES  

The operation “Hole” creates a set of holes. All holes in a set will be of the same type, size and depth. A set 

may consist of one or more holes. 

For each hole in a set, you specify an attachment point, in the body face where creating the hole. The face 

hosting the attachment point is called base face of the hole. 

Base faces of the holes in one set (that is, holes belonging to the same operation instance) can be same or 

different, or even belong to different bodies.  

A set of holes on several bodies yields a single multi-body operation. To use each body separately 

in the future, apply Divide operation after creating the holes. 

Holes in one set can have different orientation. Hole orientation means orientation of the hole axis in the 

space and the hole rotation angle about its axis. 

The fixing point and orientation of any element in a set can be modified at the operation creation or 

editing. Any hole can be deleted from a set. 

Hole Templates 

Two mechanisms are used for holes creation: primitives or fragments (templates). 

Primitives – a mechanism that creates a special operation to define the shape of the hole. No external 

objects are used. 

When using a template mechanism, hole creation is realized as an automated process of inserting a special 

3D fragment – a hole template.  

A template has a set of parameters that define the type and dimensions of a hole created with its help. 

Hole templates are stored in the parametric library “Hole Features”, among "Utilities". If necessary, the user 

can add custom elements to this library. 

If inch units are set in the command ST: Set Document Parameters, on the tab “3D”, then the library 

“Hole Features Inch” is used for creating holes. 

The standard library includes hole templates of the following types: 

 Holes for check screws (Type 1, 2, 3); 

 Threaded; 

 Center hole (shape A, B, C, E, F, H, R, T). 
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To add custom holes to the library, create a template for the new hole type in a separate document, 

following certain rules, and add it to the respective library (“Hole Features” for those using metric units, 

“Hole Features Inch” - inches). 

 

Нole type table part 1 

Type   

Hole for fasteners 

 

Threaded hole 

 

Type   

Hole for fasteners 

 

Threaded hole 

 

  

Through all 

  

For given length 
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- 

 

 

- 

 

 

  

- - - 

 

Нole type table part 2 

 

Square hole for fasteners 

 

Oblong hole for fasteners 

  

Through all 

  

For given length 

  

Through all 

  

For given length 
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Нole type table part 3 

Center hole 

Shape А Shape B Shape C Shape E 

    

Shape F Shape H Shape R Shape T 

  
  

 

Hole Attachment Point 

To specify position of holes being created, specify an attachment point for each hole, one at a time. One 

hole is associated with one point. The base face of each hole is defined by the system automatically. By 

default, the axes of the holes are normal to the respective base faces. 

Attachment points of the holes can be defined by one of the following 3D elements. 

 Face of a body. The specified face becomes the base face of the hole; the hole center will be positioned 

in the location of the mouse click that selected the face. 

 3D node which is either on the face of the body or outside of it. 

 -If the 3D nod is on the face, this edge is chosen as the bearing one, the hole centre coincides with the 

given node. 

 -If the 3D node is outside of the face, it is necessary to choose a body (or several ones), then the 3D 

node. The hole is built normal to the closest body face. If it is required to build the hole otherwise, the 

direction should be given. If the system cannot calculate the hole depth, a corresponding notice will 

be given. 

 Circular edge on one of the body faces. The face with the plane of the chosen circular edge will be 

chosen as the bearing one; the hole centre is associated with the circular edge circumference centre. 
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 The hole edge. The circular hole edge locates the centre and the bearing edge of the hole at the given 

length from the template. 

To quickly define a set of holes, you can select an array of 3D nodes for the attachment points. Holes will 

be automatically created at each 3D node of the array. 

                   

The attachment point of any hole in a set can be modified by one of the following means: 

1. Define a totally new attachment point (new base face or new attachment 3D element for the 

hole center); 

2. Modify the hole position on the current face (maintaining same base face) – by defining offsets 

of the hole center from the two side edges of the base face. The hole center will be attached 

to the point on the base face, defined by the specified offsets. 

            

3. Create coaxial hole with automatic adjustment of the hole position on the base face (see the 

topic “Coaxial holes”). 

Coaxial Holes 

Any hole can be created as coaxial (using the same axis) with an arbitrary cylindrical or conic face. A hole 

can also be created coaxial with an existing round hole.  
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The location of the base face should permit creating a coaxial hole. For example, when creating a hole 

coaxial to another hole, the two holes may not be placed on the same face. 

The axis directions of the new hole will coincide with that of the source face. 

                          

Hole Orientation 

By default, all new created holes are placed by the system in such a way, that the axis of each hole (X-axis 

of the hole template coordinate system) is directed along the normal to the base face at the attachment 

point. The orientation of the hole cross section is set by the system arbitrarily. (This is the angle of the hole 

cross section rotation about the Y-axis of the hole coordinates.) 

If necessary, you can modify orientation of each hole in a set separately. A hole’s orientation can be 

modified in one of the two ways: 

 By auxiliary LCS – a specified LCS is used for defining the direction of the axes of the coordinate system 

of the hole (existing in its template). The hole is rotated in such a way that its coordinate system axes 

all get aligned with the direction of the respective axes of the selected LCS; 

                 

 By 3D nodes. In this case, the hole’s orientation and the angle of rotation about its axis are defined 

separately. You can modify just one of these parameters, for example, only rotation of the hole about 

the axis, in order to turn a non-round hole about its axis. In this case, the axis itself can be left 

unchanged (in the system default position). 

When using a 3D node for orienting the hole axis, the axis will be directed from the hole 

attachment point to the 3D node. When specifying rotation of the hole by a 3D node, the Y-

axis of the hole coordinate system will be turned so as to point at the selected node. 
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When orienting by an LCS, you can do this to a whole set of holes simultaneously. 

                    

Hole Depth 

Depth of a set of holes can be specified by a numerical value or calculated automatically, depending on 

the current mode: 

 To next face. Holes are cut up to the intersection with the next face.  

 Through all. Holes are cut throughout the selected body (a set of bodies). 

 For given length (depth). The depth of the holes is defined by a numerical value. 

 To specified face. Holes are cut up to the specified face. (The selected face must intersect with the holes 

being created.) 

              

The holes for check screws and center holes of the shape A, B, C, E, R, T permit the option “For given 

length” only. 
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If a hole axis is not perpendicular to the intersected faces of the body, or if faces intersected by a hole are 

not flat, additional manipulations may be required to get a correct hole entry. In such a case, we 

recommend using the mode of considering (handling) non-planar faces. In this mode, holes are extended 

by an allowance amount at either side, and then trimmed by body faces. 

 

                 

Holes through Multiple Bodies 

Holes can be cut through several solid bodies at once. Such sets of holes create multi-body operations. 

 

To use each model body separately in the future, use Divide operation after creating the holes. 

                      

 

You can create coaxial holes in several bodies or fragments and such holes will not be united in one 

resulting body. Use the Create coaxial holes option for this purpose. 
  

 <H> Create coaxial holes 
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A separate hole will be created for each of the bodies. 

 

 

Parameterization is via the common variables. Thus if you specify hole parameters using variables, they will 

be retained for each of the holes. 
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Create Holes With Specifies Direction 

Nodes for the holes are located on the boundary of two or more faces. It is required to create holes on the 

nodes according to certain direction. Since the system cannot automatically determine the direction, it 

selects the first appropriate solution. However, the user can independently set the direction by performing 

the following sequence of actions. 

In this example, we will build an array of holes using the nodes created on the edge of the body. The nodes 

are already created. 

Step 1. Select the face for the hole. The face will define the direction for the hole.  

 

Step 2 – Select A: Enter hole center command and select one of the nodes for which holes should be 

created. The system will construct holes according to the selected face. 
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Step 3 - Select the rest of the array. 

 

HOLE CREATION  

To create standard holes, use the command 3H: Create Hole: 
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Icon Ribbon 

 

3D Model → Modify → Hole 

Keyboard Textual Menu 

<3H> Operation >Hole 

 

To create a hole, do the following steps (the order of steps may vary): 

 

 Select the type and main geometrical parameters of the set of holes to be created; 

 

 Define attachment points for the holes; 

 

 Specify the desired hole depth; 

 

 Modify default axis orientation and rotation angles of the holes (optional); 

 

 Finish hole creation (use  in the automenu or in the property window). 

Selecting Type and Main Geometrical Parameters of Holes 

Select the type of the holes being created in the operation property window. The list of holes contains all 

elements in the hole utility library (“Hole Features” or “Hole Features Inch”). 

 

Type of a hole can be selected either from the quick access drop-down list or by clicking the corresponding 

icon. If you select type from the list and it is not presented among icons below, the new icon will replace 

the last right icon.  
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Item “Type” in the drop-down list allows you to select element from custom libraries added to selection 

list. 

The content of the selection list is linked with the value of the Standard field and will update accordingly. 

You can select holes library using option: 

 
<B> Library configuration 

More information about configurations can be found in section “Library configuration”. 

A schematic chart of a hole of the selected type is provided in the lower portion of the property window, 

with input boxes for all its geometrical parameters. To specify any dimension, just placed the cursor in the 

respective input box in the chart and type in the desired value (or select one from the list). Variables may 

be used as values. In this case the value of parameter will be assigned to the nearest value from the 

appropriate list. 

Hide Connectors. Flag allows hiding connectors of created holes. 

Retain material. When active, body’s basic material will be applied to the created hole faces. Otherwise, 

the coating material will be used. 
 

Use Document Parameters. The option is used for holes created using the fragments mechanism. If this 

option is enabled, the hole uses document parameters, for example, the units. If this option is disabled, the 

hole will use parameters from the fragment. 

 

 

Reach-through asymmetric hole (e.g. with one side 

chamfer) may be turned upside-down by its axis direction 

with option “Turn over”. Often this flag is used for mold-

base design. Note that this flag will affect all holes from 

the set being created. 

The initially defined type and dimensions of holes can be 

modified at any time while creating or editing holes 

(before the confirmation by pressing ). 

Defining Attachment Points of Holes 

Hole attachment points can be defined upon activating the automenu option (the option is active by 

default upon entering the command): 

 <A>  Enter hole center 
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With the option active, simply select the desired face, 3D node or a 

circular edge on a face in the 3D window. The parent body of the 

selected element is highlighted, and a wireframe preview of the hole 

being created is displayed. 

 

After defining the attachment point for the first hole, the option  

stays active. This helps creating a set of holes without additional 

actions. Just keep picking attachment points after selecting the first 

one. 

As a result of defining a number of attachment points, a preview of a 

set of holes is displayed in the 3D scene. The type and geometrical 

parameters of all elements are the same. 
 

Creation of a set of holes from an array of 3D nodes is done with the option: 

 <M>  Add Hole Array 

Upon activating the option, specify the source array of nodes. You can select an array either in the 3D 

model tree or directly in the 3D scene by clicking any array element with . 

Notice! When you create a holes array, you need to set maximum number of the array elements. If 

this rule is not met, offset or disappearance of new holes in array can occur after the holes number 

increase. 

Defining Hole Depth 

The desired mode of defining the hole depth is controlled by the following automenu options of the 

command: 

 <E>  To next face 

 <F> Through all 

 <J> For given length 

 <S> To specified face 
 

For some types of holes, certain options may not be available. 

Selecting the first two modes does not require any additional actions. The depth of the holes will be 

determined by the system automatically. 

When in the mode , the hole chart presents additional items for defining the hole depth. 
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Appearance of property window in the case of “Hole 

for fasteners” hole type when defining depth 

“Through all”, “To specified face”, “To next face” 

Appearance of property window in the case of “Hole for 

fasteners” hole type when defining depth “For given 

length” 

In the last mode (the option ), you need to additionally select a face in the 3D scene, up to which the 

holes will be cut. The selected face will be highlighted (by default - red). 

The additional mode of handling non-flat faces is turned on by the 

flag Consider non-planar faces in the lower portion of the operation 

property window. Setting the flag brings up an additional item in the 

property window, Extend by, where the amount of allowance for the 

hole extension is to be input. 

 

Creating Holes through Multiple Bodies Simultaneously 

Additional bodies can be selected by the option: 

 <K>  Select additional bodies 

The bodies can be selected either in the model tree or directly in the 3D scene. 

Selection of bodies can be canceled by the option: 

 <L>  Cancel additional bodies selection 

Hole Selection for Modifying Hole Position and Orientation 

Attachment points and orientation can be modified separately for each hole in a set being created. The 

hole currently available for editing is highlighted in the 3D scene. The default highlighting color is yellow. 

Other holes in the set are highlighted green. 
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Normally, the last created hole is instantly made available for editing. A different hole in the set can be 

selected by the option: 

 <D>  Select Hole for edit 

Upon activating this option, simply point the mouse at one of the created holes and click . The selected 

hole will be highlighted. 

The selected hole can be deleted by the option: 

 <X>  Delete selected Hole 

Modifying Hole Attachment Point 

To define a new attachment point from scratch, use the option: 

 <R>  Change Hole position 

Upon calling this option, select a new attachment point for the hole being edited. 

A hole position can be modified within the current base face by the option: 

 <C>  Set offsets for Hole 

Upon activating this option, more options will appear in the automenu for selecting edges to offset from 

and for defining the offset itself: 

 <D> Select Edge that sets the first offset 

 
<F> Select Edge that sets the second offset 

 <G> Set Hole offset 

 

To define offsets, subsequently select two side edges of the base face in the 3D 

scene by the options  and . The offset values can be defined by simply 

clicking the mouse at the desired position of the hole center on the face (with 

the option  active) or by entering exact numerical offset values in the 

operation property window. 

To quit the mode of defining offsets, use the option: 
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 <R> Cancel offset definition for Hole 

Modifying Hole Orientation. Creating Coaxial Hole 

To reorient a hole, use the following option in the command automenu: 

 <T> Set Hole direction 

Upon activating this option, additional options appear in the automenu for defining new orientation of the 

hole being edited. 

A hole can be oriented by an LCS by the option: 

 <L> Select LCS to define Hole direction 

Upon calling the option, specify the desired LCS. The hole being edited will be oriented by the axes of the 

selected coordinate system. 

A hole axis can be oriented by a 3D node with the help of the option: 

 <F> Select 3D Node for Hole direction 

Rotation of a hole about the axis in its current position is done by the option: 

 <G> Select 3D Node for Hole turn angle 

To quickly reorient all holes in a set, use the option: 

 <A> Select LCS to define directions of all Holes 

A hole coaxial with any cylindrical/conic face is created by the option: 

 <O> Select Hole to create coaxial Hole 

Upon activating this option, select a face in the 3D scene, whose axis is to be used for creating the coaxial 

hole. 

To undo a defined orientation, use the following options: 

 <D> Cancel Hole turning 

 <Q> Cancel turning for all Holes 

To quit the mode of defining offsets, use the option: 

 <R>  Return from setting Hole direction 
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Library configuration 

Library Configuration  option displays structure of libraries that are used in the current operation. The 

option allows to select fragments that will be added to the selection drop-down list. Also it allows to add 

custom libraries that contain additional fragments.  

Configurations window appears when you call the option with the tree that contain the following 

configurations folders: 

Configuration name. Corresponds to the current operation that we configure. 

Standard. Defines subset of libraries that will be linked to this standard. 

Library. Contains files of fragments that will be added to the selection list. 

There are “Favorites” and “Library elements” groups inside each library. 

All fragment files that exist in the selected library are displayed in its “Library elements” group. The 

fragments that are included in the quick access drop-down list are displayed in the “Favorites” group. 

 

 New library. Add Library window appears when you call the option. 

You need to select configuration, standard and the library that will be added. There are two standards by 

default: metric and inch. To add a new standard you need to enter its name in the Standard field. Drop-

down list in the Library field includes all libraries, that are displayed in the Documents Menu window. 
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 Delete element. Deletes selected configuration, standard or library. 

 Add/delete fragment as an element by default. Allows to select fragments that will be added to the 

quick access drop-down list and in the “Favorites” group. 

 Export library configuration. Allows to export configurations in external *.xml file. 

 Import library configuration. Allows to import configurations from external *.xml file. 

 Save changes. Allows to save changes in the configurations.
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DEFORMATION 

The deformation operations allow a user to perform modification of solid and sheet bodies by various 

means: skewing, bending, scaling/twisting etc. 

When creating deformation operations, a function producing volume deformation of the given body is 

formed in the model on the basis of parameters specified by the user. This function can be defined over 

the entire volume of the given body or only its part. Applying this function in a continuous manner deforms 

the entire volume of this body (or its part). Topology of the deformed part of the body does not change. 

The number of faces, edges, vertices, etc. remains the same. If necessary, faces and edges of special type 

(planes, segments, cylinders, arcs of circles etc.) are automatically replaced with spline surfaces and curves. 

Commands of deformation can be applied to both solid and sheet bodies (surfaces). 

In the process of specifying all parameters of deformation operations, the future result of applying the 

current operation is dynamically displayed in the 3D window. To speed up the work, this dynamic view can 

be turned off. 

SKE W  

General Information 

In the skew deformation, the deformation function is specified by 

displacing the vertices of the bounding parallelepiped of the 

given body. The bounding parallelepiped is calculated with 

respect to the axes of the global coordinate system or 

additionally-specified LCS. 

The offset of vertices of the bounding parallelepiped can be 

realized along any axis of the coordinate system (the axis with 

respect to which the bounding parallelepiped is constructed), 

along the edges of the bounding parallelepiped, along the face 

diagonals of the bounding parallelepiped. For specifying the 

offsets in the command, the draggers as well as the dialog of the 

command's properties can be used. 

 

The magnitude of the vertex offset for a bounding parallelepiped can be specified both in absolute units 

– units of model and in relative units – in fractions of length (in percents) of the bounding parallelepiped 

along the respective axes. The relative coordinates can be used in cases when it is necessary to preserve 

proportions of the deformed model no matter what changes in the source operations are made. For 

example, the picture below shows how the deformed model will be modified when changing the length of 
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the source extrusion depending on in which units the offsets of the vertices of the bounding parallelepiped 

have been specified. 

 

The vertices of the bounding parallelepiped can be snapped to the 3D points. In this case the offset does 

not depend on modification of the deformed body or on what units of length have been chosen for 

specifying the offsets. 

 

When attaching the vertex to a 3D point, the offsets of the vertex with respect to the selected 3D point can 

be specified additionally. 

Creation of Skew Deformation 

Skew deformation is performed with the help of the command 3DRS: Skew Deformation: 

Icon Ribbon 

 

3D Model → Special → Deformation → Skew Deformation 

Keyboard Textual Menu 

<3DRS> Operation > Deformation > Skew Deformation  

For specifying this deformation it is necessary: 

 Select a body being deformed; 
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 Define LCS with respect to which the bounding parallelepiped will be formed (optional step); 

 Specify the required offsets of the vertices of the bounding parallelepiped; 

 Complete the operation creation by pressing . 

Selection of Deformed Body and LCS of Deformation 
For selecting the deformed body, the following option of the automenu is used: 

 <O> Select Body to Deform 

This option is turned on by default upon the entry into the command. The deformed body is selected with 

the help of  in the 3D window or in the tree of the 3D model. The selected body is highlighted, and the 

contour of the bounding parallelepiped appears. 

By default the bounding parallelepiped is calculated with respect to the axes of the global coordinate 

system. It is possible to select another coordinate system for calculation of the bounding parallelepiped 

with the help of the option: 

 <L> Select source LSC 

After choosing the LCS, the bounding parallelepiped will be automatically reconstructed in accordance 

with the axes of the LCS. 

Cancellation of the selected LCS can be done with the help of the option: 

 <C> Cancel LSC selection 

Specifying Offsets for Nodes of Bounding Parallelepiped of Deformation 

After constructing the bounding parallelepiped, in the 3D window a user can select the nodes of the 

parallelepiped in any order and specify their offsets (with respect to initial position). To specify the nodal 

offsets, the 3D draggers are used.  
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The offsets of the vertices of the bounding parallelepiped (with respect to 

their initial position) can be also specified in the dialog of the command's 

properties. After selecting the deformed body, the list of all vertices of the 

bounding parallelepiped will appear in the dialog. Under the list, there will 

be entry fields for input of the offset values (the parameters group Offset). 

To specify the offsets, it is sufficient to select the desired node-vertex from 

the list (it will be highlighted in the list and in the 3D window), and specify 

the offset values along the axes X, Y, Z in the entry fields of the group Offset. 

Units in which the offsets of vertices are specified are controlled by the status 

of the flag Relative Value, %. By default this flag is turned off, and the 

specified offsets are absolute (i.e., are measured in units of model). If the flag 

is enabled, the specified offsets will be recalculated in relative units. 

Additional parameter Tolerance specifies the value of the precision used in 

evaluations of the deformation function.  

For fixing a vertex of the bounding parallelepiped to a 3D point, select the desired vertex (in the 3D window 

or in the list of vertices in the dialog of the command) and turn on the following option of the automenu: 

 <Z> Set Fixing to Point 

After activating this option, 3D fixing point has to be selected. The drop down list of this option contains 

filters for selecting various 3D objects capable of defining a 3D point. The selected 3D object is specified 

in the list of vertices next to the name of that vertex of the bounding parallelepiped whose location is 

defined by the object. 

For a vertex of the bounding parallelepiped fixed to a 3D point, the offsets entry fields in the properties 

window will remain accessible. The offsets specified in these entry fields will determine the vertex offset 

with respect to the 3D fixing point. The offsets with respect to a fixing point can be also specified in the 

3D window with the help of the draggers. 

To cancel a fixing to a 3D point, select the desired vertex (in the 3D window or in the vertices list in the 

dialog of the command) and invoke the following option of the automenu 

 <D> Cancel Fixing to Point 

After invoking this option, the vertex is untied from the 3D point. Note that the offset of the given vertex 

does not change at that. The vertex will remain in the position specified by the 3D point. However, later, 

when modifying the original model or location of the 3D point, the offsets of the given vertex of the 

bounding parallelepiped will be recalculated as if they were specified by numeric values from the 

beginning. 
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SCULPT DEFORMATION  

General Information 

In the sculpt deformation, the deformation function is defined by displacing the nodes of the regular mesh 

on one of the faces of the bounding parallelepiped of the deformation area. 

 

The bounding parallelepiped, as in the previously considered deformation type, can be built with respect 

to the axes of the global coordinate system or additionally-specified LCS. 

By default, the parallelepiped of the deformation area spans the entire body. If necessary, its dimensions 

can be modified, thus altering the deformation area. The offset of the faces of the parallelepiped relative 

to their initial position can be defined by specifying both an absolute and relative value and also by 

snapping to a 3D point. 

 

The regular mesh is automatically created on a face of the bounding parallelepiped which is selected for 

creating deformation. Dimensionality of the mesh is specified by the user. Any node of the mesh can be 

displaced from its initial position by the user-specified value. Several nodes can be selected and moved 

simultaneously. 
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As a result of displacing the nodes of the mesh, the flat face of the bounding parallelepiped is transformed 

into a space spline surface which forms the required transformation law of the body. The spline surface 

being formed can be of two types: control polyhedron type (the nodes of the mesh are used for 

constructing the control polyhedron of the surface) and interpolation type (going directly through the 

nodes of the mesh). 

 

The sculpt deformation has three modes: 

 One side – only the nodes located on the selected face of the bounding parallelepiped are 

displaced; 

 Both sides – the nodes located on the selected and the opposite faces of the bounding 

parallelepiped are displaced. The nodes on the face opposite to the selected one are displaced 

in the same direction by the same distance; 

 Symmetric – the nodes located on the selected and the opposite faces of the bounding 

parallelepiped are displaced. The nodes on the opposite face are displaced symmetrically with 

respect to the symmetry plane of the parallelepiped. 
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The value of the mesh points offsets from their initial position can be specified both in absolute units – 

units of model and in relative units – in fraction of length (in percents) of the bounding parallelepiped 

along the respective axes. The relative coordinates can be used in cases when it is necessary to preserve 

proportions of the deformed model no matter what changes in the source operations are made. The 

picture below shows how the deformed model will be modified when changing the length of the source 

extrusion depending on in which units the offsets of the mesh points have been specified. 

 

A snap to 3D points can be also specified for the nodes of the mesh. In this case the offset is determined 

by the location of the 3D snap point and does not depend on modification of the deformed body or on 

units in which the offsets are specified. 
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When fixing the node of the mesh to a 3D point, the node's offsets with respect to the selected 3D point 

can be specified additionally. 

Creation of Sculpt Deformation 

For creating this type of deformation, the command 3DRC: Sculpt Deformation is used: 

Icon Ribbon 

 

3D Model → Special → Deformation → Sculpt Deformation 

Keyboard Textual Menu 

<3DRC> Operation > Deformation > Sculpt Deformation  

After invoking this command, a user has to: 

 Select the deformed body; 

 Define LCS with respect to which the bounding parallelepiped will be formed (optional step); 

 Define the deformed face of the bounding parallelepiped; 

 Specify the boundaries of the deformation area (of the bounding parallelepiped of the 

deformation area) (optional step); 

 Specify mesh parameters on the selected face (optional step); 

 Specify the mode of deformation: one-sided, symmetric or two-sided deformation (optional step); 

 Define the desired displacements for the nodes of the mesh; 

 Complete the operation creation by pressing . 

Selection of Deformed Body and LCS for Deformation Area Construction 

For selecting the deformed body, the following option of the automenu is used: 

 <O> Select Body to Deform 

This option is turned on by default upon the entry into the command. The deformed body is selected with 

the help of  in the 3D window or in the tree of the 3D model. The selected body is highlighted, and the 

contour of the bounding parallelepiped appears on the screen.  

By default the bounding parallelepiped is calculated with respect to the axes of the global coordinate 

system. It is possible to select another coordinate system for calculation of the bounding parallelepiped 

with the help of the option: 

 

 <L> Select Source LSC 

After choosing the LCS, the bounding parallelepiped will be automatically reconstructed in accordance 

with the axes of the LCS. 
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Cancellation of the selected LCS can be done with the help of the option: 

 <C> Cancel LSC selection 

Selection of Deformed Face and Deformation Mode 

After specifying the bounding parallelepiped, the user has to indicate the face which will be subject to 

deformation. To do it, it is sufficient to bring the cursor to the desired face (it will be highlighted) and press 

. The option of face selection will become active at this moment in the automenu: 

 <T> Select Face  

The mesh will appear on the selected face (by default it is a 3x3 mesh). The mesh parameters can be 

changed in the command's properties window (parameters group Mesh Size). The maximum allowable 

size of the mesh – 20x20. 

 

 

By default, the deformation is created in the one-sided mode, i.e. only the 

nodes of the selected face of the bounding parallelepiped are displaced. 

The mode can be also changed in the command's properties window with 

the help of the parameter Mode. 
 

Modifying Size of Deformation Area 

The bounding parallelepiped of the deformation area initially spans the entire body. To modify the size of 

the deformation area, the following option of the automenu is used: 

 <D> Change Deformation Box 

After invoking this option, the command will turn to the mode of modifying the boundaries of the 

deformation area. Highlighting of the deformed face and the mesh temporarily disappear from the screen. 
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The list of the faces of the deformation area  bounding  parallelepiped appears  in the command's  

properties 

window. 

The offsets for the faces of the bounding parallelepiped can be 

specified directly in the 3D window or in the command's properties 

window (with the help of the list of the faces). 

For moving the face in the 3D window, it is sufficient to point at it with 

the help of  (the selected face will be highlighted) and, without 

releasing the pressed mouse button, shift the face to the desired 

position. When selecting the face in the 3D window, it will be 

automatically highlighted in the list of faces in the properties window. 

The offset specified for the face will be shown in the entry field of the 

parameter Offset.  

The position of the face of the bounding parallelepiped can be also modified in the properties window just 

by selecting the face from the list (in the 3D window the selected face will be highlighted in color) and by 

entering the desired offset into the entry field of the parameter Offset. 

To specify the offsets of the faces in relative units (relative to the initial size of the deformation area 

bounding parallelepiped, that is the size of the bounding parallelepiped of the deformed body), set on the 

flag Relative Value, %. 

To fix a face to a 3D node, use the option: 

 <Z> Set Fixing to Point 

After invoking this option, define a 3D point to which the selected face of the deformation area bounding 

parallelepiped should be fixed. Any 3D object capable of defining a point (3D node, the vertex of the body, 

etc.) can be used for specifying this point. The selected 3D object is specified in the list of faces next to the 

name of that face of the bounding parallelepiped whose location is defined by the object. 

A user can also specify the offsets for the face fixed to a 3D point – in this case these offsets will be relative 

to the 3D point to which the face is fixed. 

To cancel the snap of the face to a 3D point, use the option: 

 <H> Cancel Fixing to Point 

After canceling the fixing, the face location does not change. However, the offsets of the face will be 

subsequently recalculated with respect to the body's overall size and will not depend on the location of 

the former fixing point for the given face. 

For quick cancellation of all modifications of the deformation area, the following option can be used: 

 <W> Set Deformation Box by Body Size 

This option cancels all specified offsets for the faces of the deformation area bounding parallelepiped. 

To exit the mode of modifying the size of the deformation area, in the automenu turn off the option . 
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Specifying Offsets of Deformation Mesh Points 
Offsets of the mesh points can be specified both in the dialog of the properties window and directly in the 

3D window. 

For specifying offsets in the 3D window, select successively the nodes (or group of nodes) and with the 

help of the dragger in the 3D window move them to the desired location. 

For selecting one mesh point, it is sufficient to bring the cursor of the mouse to it and press . The selected 

node will be highlighted, and the dragger in the shape of the coordinate system will appear at the node. 

The offset of the node is specified by moving the dragger along one or two axes at once (the work with 

such dragger is described in detail in chapter “3D Nodes”). 

There are several ways of selecting simultaneously several mesh points. For example, it is possible to 

successively select the desired nodes while keeping the key <Ctrl> pressed. In this case, the dragger will 

be drawn at the last selected node of the group. When moving the dragger, all points of the group will be 

shifted in the same direction by the same distance. 

All nodes lying on the same mesh line can be selected quickly just by pointing at this line with the help of 

. While doing that, all nodes lying on the given mesh line will be selected, but the dragger will not appear. 

To activate the dragger, point with the  at one of the selected nodes. If while pressing the key <Ctrl>, a 

user successively defines two mesh lines, all nodes on the defined mesh lines will be selected, etc. 

When editing, you can quickly select a rectangular group of points with <Shift>. 

In the Interpolation mode, you can add new grid line: hold <Alt> and select one of the existing horizontal 

or vertical lines in the scene. The deforming principle will not be changed. 

 

For specifying the offsets of the mesh points in the properties window, a table in the parameters group 

Mesh Size is used. Each cell of this table corresponds to one mesh point. The symbol “0” is displayed in 

the cell if the offset is not specified for the respective node. For the displaced nodes, the specified offsets 

are shown in the format (X,Y,Z), where X – the node's offset along the X-axis, Y – the offset along the Y-

axis, Z – offset along the Z-axis. 

To specify offset of any mesh point, in the table select the cell corresponding to the desired node. While 

doing that, the parameters of the group Offset will become accessible for editing below the table. They 

will define the offsets along the X-axis, the Y-axis and the Z-axis. When modifying the offset values, the 

node will be moving in the 3D window. 

As with the work in the 3D window, it is possible to specify offsets at once for a group of nodes. For 

selecting several nodes (that is, several cells in the table of nodes), use +<Ctrl>. 

The units in which the offsets of the mesh points are specified are controlled by  the status  of the  flag 

Relative Value, %. By default it is turned off, and  the specified values are absolute (i.e., are measured in 

units of model). If the flag is enabled, the specified offsets will be recalculated in relative units. 
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To fixing a mesh point to a 3D point, select the desired node (in the 3D window or in the nodes table in 

the dialog of the command) and turn on the following option of the automenu: 

 <A> Set Fixing to Point 

After activating this option, select a 3D point to which the current node of the mesh should be fixed. The 

drop down list of this option contains the filters for selecting various 3D objects capable of defining a 3D 

point. The selected 3D object is inserted into the Fix to an object: field of the parameters group Offset. 

For the mesh point fixed to a 3D point, it is possible to additionally specify the values of the node's offsets 

relative to the selected 3D point (with the help of the dragger in the 3D window or in the properties 

window). 

To cancel a fixing of the mesh point to a 3D point, select the desired mesh point (in the 3D window or in 

the nodes list in the dialog of the command) and invoke the following option of the automenu: 

 <B> Cancel Fixing to Point 
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After invoking this option, the current mesh point is untied from a 3D point. Note that the offset of the 

given node does not change at that. The node will remain in the position specified by the 3D point. 

However, later, when modifying the original model or location of the 3D point, the offsets of the given 

node of the deformation mesh will be recalculated as if they were specified by numeric values from the 

beginning. 

The type of the formed spline surface (by control polyhedron or by mesh points) is determined by the 

status of the flag Interpolation. When this flag is disabled, the spline surface is created by the control 

polyhedron, and when the flag is enabled – the created spline surface will go through the nodes of the 

mesh. 

Additional parameter Tolerance specifies the value of the precision used in evaluations of the deformation 

function. 

SCALING/TWISTING  

General Information 

Scale/Twist Deformation is always specified with respect to the coordinate system of deformation (defined 

with the help of LCS). Twisting is performed only around the X-axis of the coordinate system of 

deformation, scaling is possible along all axes. 

The deformation function is determined on the basis of the parameters (angle of twist and deformation 

scales) specified for several sections of the deformed body located along the X-axis of the coordinate 

system of deformation. For different sections a user can specify different scales and angles of twist along 

the axes of the coordinate system of deformation. For each section the scales along different axes can be 

also different. The value of any parameter (except section position) can be assigned to a variable. 

                           

The deformation function is calculated over the specified domain of the deformation function along the X-

axis. The domain of the deformation function is defined by the start and end boundaries along the X-axis. 

The domain of the deformation function can include into itself the entire deformed body, only its part or 

extend beyond the boundaries of the body. 

The computed function is applied to the part of the deformed body defined by the deformation area. By 

default, the deformation area is constructed as the bounding parallelepiped of the deformed body (in the 

axes of the selected coordinate system of deformation). If necessary, the size of the deformation area can 
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be modified by moving the faces of the deformation area parallelepiped. It is possible to specify location 

of the faces by snapping to a 3D point. 

               

Creation of Scale/Twist Deformation 

To create the scale/twist deformation, use the command 3DRT: Scale/Twist Deformation: 

Icon Ribbon 

 

3D Model → Special → Deformation → Scale/Twist 

Deformation 

Keyboard Textual Menu 

<3DRT> 
Operation > Deformation >  

Scale/Twist Deformation  

After invoking this command, it is necessary: 

 Select the deformed body; 

 Define the LCS with respect to which the parameters of deformation will be specified (optionally); 

 Select the domain of the deformation function; 

 Select the deformation area (if necessary); 

 Define the location of the sections of deformation; 

 Specify parameters for the sections of deformation; 

 Complete the operation creation by pressing . 

Selection of Deformed Body and LCS of Deformation 

For selecting the deformed body, the following option of the automenu is used: 

 <O> Select Body to Deform 
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This option is turned on by default upon the entry into the command. The deformed body is selected with 

the help of  in the 3D window or in the tree of the 3D model. The selected body is highlighted. 

When you select body for the operation, the system is creating LCS for the deformations automatically. 

Selection of the coordinate system of deformation is done with the help of the option: 

 <L> Select Source LCS 
 

It is recommended to create the LCS of deformation in such a way that its X-axis is directed along 

the axis of the body since the twist of the body will be performed exactly around the X-axis of the 

coordinate system. 

Cancellation of the selected LCS can be done with the help of the option: 

 <C> Cancel LCS selection 

Specifying Domain of Deformation Function and Deformation Area 
The domain of the deformation function is specified in the command's 

properties window (the group of parameters Deformation Area). 

Parameters Start and End define the distance from the origin of the LCS of 

deformation to the start and end boundaries of the domain of the 

deformation function. The distances are measured along the X-axis of the 

LCS in units of modal. The system puts the default values into these entry 

fields so that the domain of the deformation function spans the entire 

deformed body. A user can narrow or expand the deformation area by 

specifying other values in these entry fields. 

 

When the flag Whole body is enabled, the domain of the deformation function is computed automatically 

in accordance with the current deformation area. 

 

The bounding parallelepiped of the deformation area initially spans the entire body. For modifying the size 

of the deformation area, as in the sculpt deformation, the following option of the automenu is used: 

 

 <D> Change Deformation Box 

Modifying the deformation area is performed similarly to the sculpt deformation (see above). To exit the 

mode of modifying the size of the deformation area, in the automenu turn off the option . 

 

Creating Sections of Deformation 
After selecting the LCS, the 3D draggers to control location and parameters of the sections of deformation 

will appear on the screen. By default, only two sections are created: at the start and at the end of the 

deformation area. These sections cannot removed, their location cannot be modified. 
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In the dialog of the command's properties in the field Position the list of all sections specified for the given 

deformation is created. The work of the properties dialog is synchronized with the sections' draggers in 

the 3D window. When selecting the dragger of some section in the 3D window, the same section is 

automatically selected in the list. And vice versa: the section selected in the field Position, will automatically 

become active in the 3D window. Selected for editing (active) section is marked in the 3D window with 

color. 

 

To add a new position click the left mouse button on the line that connects centers of two existing 

positions. 

 

The buttons  and in the dialog of the command's parameters allow a user to create new sections of 

deformation and delete existing ones. The new section by default is placed after the section which is active 

at the moment of pressing the button . The exception is the case when at the moment of pressing the 

button , the active section is the end section – in this case the new section will be placed before the end 

one. 

 

Moving/Scaling along the X-axis is now performed with respect to the origin of the applied coordinate 

system. Move/scale manipulator is available for both primary ellipses. 

Local coordinate system manipulator can be hidden using the appropriate flag in the Options tab. 

Specifying Parameters of Sections 
For specifying parameters of some section, first it is necessary to make it active by selecting it from the 

sections list in the properties window or directly in the 3D window. After that, the section parameters can 

be specified in the Transformations section. 
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To specify the section parameters in the 3D window, the special draggers of the active section are used. 

Upon bringing the cursor, the dragger is highlighted. For modifying any parameter of the section 

connected with a certain dragger, bring the cursor to the desired manipulator, press  and without 

releasing the mouse button, move the cursor to the desired location of the dragger. 

 

 

The dragger of the scale also allows a user to simultaneously change the scales along the two axes (Y and 

Z). To do it, bring the cursor to an arbitrary point of the active section, press  and without releasing the 

pressed mouse button move the cursor to the desired location. 

 

Additional parameter Tolerance specifies the value of the precision used in evaluations of the deformation 

function. 

 

BENDING  

General Information 

Bend deformation allows us to bend a selected body with respect to the selected axis by a specified angle. 

To create this deformation, a user has to specify the deformed body, the origin and the direction of the 

bend axis, the angle and the bend radius.  
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To specify the bend axis, the angle and the bend radius, it is possible to use the special multi-element 

manipulator in the form of LCS with additional elements for specifying the angle and the bend radius.  

 

 

 

For all elements of the manipulator of the operation, are available the context menus with the set of 

additional options that simplify positioning of the manipulator and specification of the parameters of 

bending. 
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The angle and radius of bending can be specified both with the help of the manipulator and as the numeric 

values in the dialog of the command's properties window.  

The bend radius defines the position of the “neutral” surface. For the source body, this is the plane 

that turns into the cylinder on the bent body. The points lying on this surface do not undergo the 

tension or compression deformation.    

In this operation, it is possible to quickly change the part of the body being deformed, and also, create 

two-sided bending (with respect to the dividing plane). 

As in the sculpt deformation, in the bend deformation it is also possible to modify the size of the 

deformation area (the size of the deformation area bounding parallelepiped). By default, it spans the entire 

body. 
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The deformation area spans the entire body The deformation area spans only a part of the body 

Creating Bend Deformation 

For creating the bend deformation, use the command 3DRB: Bend Deformation: 

Icon Ribbon 

 

3D Model → Special → Deformation → Bend Deformation 

Keyboard Textual Menu 

<3DRB> Operation > Deformation > Bend Deformation  

After invoking this command, follow these steps: 

 Select deformed body; 

 With the help of the manipulator, specify the location of the zone of bending and of the bend 

axis; 

 Select deformation area (if necessary); 

 Specify the bend radius and the bend angle (with the help of the manipulator or in the 

command's properties window); 

 Select the mode of creating deformation (deformation of the selected part of the body, 

deformation of the opposite part or two-sided deformation); 

 Complete the operation creation by pressing . 

Selection of Deformed Body 

To select the deformed body, the following option of the automenu is used: 

 <O> Select Body to Deform 

This option is turned on by default upon the entry into the command. The deformed body is selected with 

the help of  in the 3D window or in the tree of the 3D model. The selected body is highlighted. 
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Selection of Bend Axis and Body-Dividing Plane 
After selection of the deformed body, the manipulator for specifying parameters of bending appears in 3D 

scene. By default, the axes of the manipulator are oriented along the sides of the bounding parallelepiped 

of the bent body. The axis of bending coincides with the X-axis of the manipulator. The plane that separates 

the bent and unbent parts of the body is defined as the X-Y-plane of the manipulator. 

The work with the manipulator of the bending deformation is similar to that of analogous manipulators in 

other commands of T-FLEX CAD. 

Specifying Bend Angle and Radius 
A user can specify the numeric parameters of bending deformation – bend 

angle and bend radius – in different ways. The exact values of these 

parameters can be specified in the dialog of the command's parameters 

(parameters Radius, Angle). Or they can be defined by using the draggers in 

the 3D window. 

To specify the values of the angle and radius with the help of the draggers, 

bring the cursor to the corresponding dragger, press  and without releasing 

the pressed mouse button, move the dragger to the desired location. It is also 

possible to press  after selection of the corresponding manipulator. In this 

case, the manipulator will start follow dynamically the cursor. To fix the 

desired position of the manipulator, it is required to press  again. 

In the context menu of the manipulators for specifying the angle and the 

radius, are also accessible the commands for specifying the values of the 

radius and the angle with the help of 3D points. 

 

With the help of the button  in the dialog of the command's properties, a user can quickly change the 

direction in which the bend angle is measured. 

Selection of Bending Mode. Modifying Size of Bending Area 
The mode of creating deformation is specified in the command's properties 

window with the help of the drop down list Mode. By default, the value One 

Side is set, which means that the deformation will be applied only to one 

part of the initial body (the part which is chosen by the system by default).  

If a user wants to apply the deformation to another part of the body, he 

should turn on the option Opposite Side. 

 

For creating two-sided deformation, that is bending of both parts of the body, the option Symmetric 

should be used. 

The bounding parallelepiped of the deformation area initially spans the entire body. For modifying the size 

of the deformation area, as in the sculpt deformation, the following option of the automenu is used: 

 <D> Change Deformation Box 
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Modifying the deformation area is carried out similarly to the sculpt deformation (see above). To exit the 

mode of modifying the size of the deformation area, in the automenu turn off the option . 

DEFORMATION BY SURFACE  

General Information 

In the deformation by surface the deformation law is defined by two surfaces: the source and the target 

one. The deformation function is constructed in such a way that the source surface is reflected onto the 

target one. 

In general case, the source and the target surfaces may not belong to the deformed body. In practice, 

however, it is often convenient to choose one of the faces of the deformed body to be the source surface. 

In this case, the deformation function is constructed in such a way as to provide the «bend» of the 

deformed body onto the target surface. 

         

A solid or a sheet body can be selected as the deformed body. 

The source and the target surfaces can be specified by face, 3D profile or a sheet body. The sheet body, 

specified as the source body, must consists of one face. For defining the target surface, the polyhedral 

sheet body can be used, however, its faces must have a continuous joint on the tangent plane. 

For a source surface, it is not recommended to select surfaces with a complicated geometry, for 

example, faces with a picture “pressed out” on them. When transforming such face to the target 

one, the loss of the face geometry may occur. In such cases, as a source surface, it is better to define, 

for example, the 3D profile drawn in the plane containing the boundaries of the complicated face. 

For defining the deformation function more precisely, base points are specified on the source and the 

target surfaces. For each surface, three points lying on the surface are specified. The points can be specified 

with the help of 3D nodes, vertices or other 3D objects capable of defining a 3D point. The specified points 

are not supposed to lie on the same line. The order in which the points on the source and the target 

surfaces are specified has to coincide. 

Two transformation methods are used when performing the deformation by surface: 
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- By parameters – transformation with superposition of the base points of the surfaces. With that 

deformation method, the points on the source surface exactly go into the points on the target 

surface. When using this method, the target surface cannot have more than one face; 

- With minimal distortions – transformation with preserved geometric distances between points 

of the source surface. This method gives minimal distortions, if the distances between the first 

two points on the source and the resulting surfaces coincide. If the distances do not coincide, 

the distances are recalculated with the corresponding similarity factor. The distances are 

measured as the lengths of the normal sections. 

The method “with minimal distortions” can be applied in cases when the target surface consists 

of a collection of faces (sheet body). It provides the superposition without irregularities which 

are common for the interior surface parametrization. 

 

When creating the deformation by surface, the offset from the target surface can be specified. In this case, 

upon forming the deformation function, the source surface will be transformed not to the target surface, 

but to the equidistant to it surface with the specified offset. 
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As a result of the deformation, the resulting body may turn out to lie on either side of the target (or 

equidistant to it) surface. The placement of the body can be quickly changed with the help of the button 

in the dialog of the command's properties. 

 

Creating Deformation by Surface 

For creating deformation by surface, the command 3DRF: Deformation by Surface is used: 

Icon Ribbon 

 

3D Model → Special → Deformation → Deformation by 

Surface 

Keyboard Textual Menu 

<3DRF> Operation > Deformation > Deformation by Surface 

To create deformation by surface, it is necessary: 

 Select deformed body; 

 Select the source surface of deformation; 

 Define the base points on the source surface; 

 Select the target surface of deformation; 

 Define the base points on the target surface; 

 Specify deformation method (“By parameters” or “With minimal distortions”); 

 Specify offset (if necessary); 

 Complete operation creation by pressing . 

Selection of Deformed Body and Source Surface 
After invoking the command, in the automenu the options for specifying necessary initial data will appear. 

For selection of the deformed body, the following option is used: 

 <O> Select Body to Deform 

This option is turned on by default upon the entry into the command. The deformed body is selected with 

the help of  in the 3D window or in the tree of the 3D model. The selected body is highlighted. 
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After that, the system will prompt the user to select the source surface of deformation: 

 <T> Select Source Surface 

The drop down list of this option contains the list of 3D elements capable of defining the source surface 

of deformation: face, sheet body, 3D profile. The selected surface will be marked in the 3D scene. 

Selection of Correspondence Points on Deformed Body and Source Surface 
After selection of the source surface, the options for selecting three base points of the source surface will 

be successively activated in the automenu: 

 <L> Select First Point on Source Surface 

 <K> Select Second Point on Source Surface 

 <G> Select Third Point on Source Surface 

The drop down lists of these options contain filters for selection of the 3D elements capable of defining a 

3D point. 

For specifying the target surface, the following option of the automenu is used (it becomes active 

automatically after specifying the base points of the source surface): 

 <M> Select Target Surface 

This option also has a drop down list with the filters for selection of the different types of the 3D elements 

capable of defining a surface. 

After selection of the target surface, its base points need to be specified successively: 

 <R> Select First Point on Target Surface 

 <F> Select Second Point on Target Surface 

 <B> Select Third Point on Target Surface 

Specifying Deformation Parameters 

The deformation mode is selected with the help of the parameter Mode in 

the dialog of the command's properties. 

The offset of the source surface with respect to the target one is specified 

with the help of the parameter Offset. The placement of the deformed body 

with respect to the target surface can be changed with the help of the button 

 found in the dialog of the command's properties (to the left of the 

parameter Offset). 

Additional parameter “Tolerance” defines the value of the precision used in 

evaluations of the deformation function. 
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DEFORMATION BY CURVE  

General Information 

The law of the deformation by curve is determined by two space curves (source and target). The source 

curve is identified with the deformed body in its initial state; the target curve – in the resulting state. The 

space transformation law is constructed in such a way as to provide the transformation of the source curve 

to the target one. 

In general case, the source and the target curves can have arbitrary shapes. Most often, a line (for example, 

one of the edges of the deformed body or a straight 3D path) is used as the source 3D curve. 

When constructing the deformation law, in each point of the two curves the auxiliary LCS1(s) and LCS2(s) (s 

– the curve parameter) are calculated whose pairwise superposition allows a user to define more precisely 

the space orientation of the resulting body. The auxiliary LCS are computed by the system in the following 

way: the tangent to the source/target curve at the current point is taken as the X-axis, the normal to the 

auxiliary surface at the given point of the same curve is taken as the Y-axis, the Z-axis is the vector product 

of the X and Y axes. 

The auxiliary surfaces for the source and target curves can be constructed differently depending on the 

selected algorithm of the deformation by curve: 

- 3D Curve – 3D Curve; 

- Curve – Spiral; 

- Pair of Curves – Pair of Curves. 

3D Curve – 3D Curve 
When using this algorithm, a user specifies an auxiliary direction vector for each of the curves (source and 

target). For this purpose, a user defines the LCS one of the axes of which will define the direction vector. 
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The auxiliary surface for both curves (source and target) is formed by moving the direction vectors along 

the corresponding curves by using the minimum twist method. 

As an example of using this algorithm, consider one of the typical problems solved by this algorithm  – 

wrapping the source body into a ring. The resulting body can be closed. 

                     

 

3D Curve – Spiral 
This algorithm is based on the assumption that the target curve resembles a “spiral”, that is, there is a space 

axis around which this curve is “wound”. The use of this algorithm of the deformation by curve allows a 

user to “wind” bodies around the axisymmetric curves in the most natural way. 

In this algorithm, a user defines an additional direction vector for the source curve (by selecting LCS and 

one of its axes). The auxiliary surface for the source curve is formed in the same way as in the previous case 

by moving the given direction vector along the curve by using the minimum twist method. 

A user also defines the axis of the target curve by selecting the LCS and the desired axis. For the target 

curve the auxiliary surface is formed as a set of vectors directed from each point of the curve at the axis 

along the shortest distance. 

  

Pair of 3D Curves – Pair of 3D Curves 
In this algorithm, for each of the main curves (source and target) an additional 3D twist curve is specified. 

When calculating the transformation law, the auxiliary surfaces for the source and target curves are formed 

as the set of vectors directed from each point of the source/target curve at the corresponding to it point 

of the twist curve. 
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Creating Deformation by Curve 

For creating deformation by curve, the following command is used 3DRV: Deformation by Curve: 

Icon Ribbon 

 

3D Model → Special → Deformation → Deformation by 

Curve 

Keyboard Textual Menu 

<3DRV> Operation > Deformation > Deformation by Curve 

The first step after invoking this command is the selection of the deformed body: 

 <O> Select Body to Deform 

 

This option is turned on by default upon the entry into the command. The 

deformed body is selected with the help of  in the 3D window or in the tree 

of the 3D model. The selected body is highlighted. 

After selecting the deformed body, in the command's properties window the 

desired deformation algorithm has to be selected. To do it, use the drop 

down list of the parameter Type. 

Depending on the deformation algorithm selected, the following steps 

sequence will vary. 

 

Creating Deformation of Type “3D Curve – 3D Curve” 

If in the list of the parameter “Type” a user selects the value “3D Curve – 3D Curve”, then in the automenu 

the following option becomes active: 

 <O> Select Body to Deform 

This option is turned on by default upon the entry into the command. The deformed body is selected with 

the help of  in the 3D window or in the tree of the 3D model. The selected body is highlighted. 

After that, the system will prompt a user to select the source curve: 
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 <T> Select Source Curve 

The drop down list of this option contains the list of the 3D elements capable of defining a 3D curve. The 

selected curve is marked in the 3D scene. 

Cancellation of the source curve selection can be done with the help of the option: 

 <H> Cancel Source Curve Selection 

After selecting the source curve, a user needs to specify the LCS one of the axes of which will serve as the 

direction vector for the source curve: 

 <L> Select Source LSC 

 

In the command's properties window, specify the axis of the LCS which will 

serve as the direction vector for the source curve (parameter Source 

direction). In the dialog one or two axes of the LCS can be unavailable for 

the selection which means that the selection of the corresponding direction 

vector will not be possible for the selected source and target curves.  

On the basis of the defined direction vector the system automatically 

computes the auxiliary surface for the source curve and the auxiliary LCS at 

each point of the curve. For clearness, in the 3D window the auxiliary LCS will 

be shown for the start point of the source curve. 

The button  allows a user to change the direction of the obtained 

direction vector of the source curve, and, therefore, the orientation of the 

auxiliary LCS.  

To cancel the selection of the LCS, which specifies the direction vector of the source curve, the following 

option is used: 

 <C> Cancel LSC selection 

The target curve and its direction vector are defined similarly with the help of the following options: 

 <B> Select Target Curve 

 <D> Cancel Target Curve Selection 

 <M> Select Target LSC 

 <N> Cancel LSC selection 

By changing axes which specify the direction vectors for both curves as well as the directions of these axes, 

it is possible to find the desired choice of the transformation. For obtaining the desired result, it is also 
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possible to use the button [  Reverse Target Curve], which allows a user to change the direction of the 

selected target curve. 

Creating Deformation of Type “Curve – Spiral” 

If in the list of the parameter Type a user selects the value “Curve – Spiral”, then in the automenu the 

following option becomes active: 

 <O> Select Body to Deform 

The deformed body is selected with the help of  in the 3D window or in the tree of the 3D model. 

After that, the system will prompt the user to select the source curve: 

 <T> Select Source Curve 

Cancellation of the source curve selection can be done with the help of the option: 

 <H> Cancel Source Curve Selection 

After selecting the source curve, a user needs to specify the LCS the axis of which will serve as the direction 

vector for the source curve: 

 <L> Select Source LSC 

 

In the command's properties window, specify the axis of the 

selected LCS which will serve as the direction vector for the source 

curve (parameter Source Direction). In the 3D window the auxiliary 

LCS will be shown for the start point of the source curve. 

The button  allows a user to change the direction of the 

obtained direction vector of the source curve. 

To cancel the selection of the LCS, which specifies the direction 

vector of the source curve, the following option is used:  

 

 <C> Cancel LSC selection 

The target curve and its axis are selected similarly with the help of the following options: 

 <B> Select Target Curve 

 <D> Cancel Target Curve Selection 

 <M> Select Target LSC 
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 <N> Cancel LSC selection 

As in the previous case, for obtaining the desired result, it is also possible to use the button [  Reverse 

Target Curve], which allows a user to change the direction of the selected target curve. 

Creating Deformation of Type “Pair of Curves – Pair of Curves” 

When choosing the option “Pair of Curves – Pair of Curves”, the following option becomes active in the 

automenu: 

 <O> Select Body to Deform 

The deformed body is selected with the help of  in the 3D window or in the tree of the 3D model. 

After that, the system will prompt the user to select the source curve: 

 

 <T> Select Source Curve 

Cancellation of the source curve selection can be done with the help of the option: 

 <H> Cancel Source Curve Selection 

After that, it is necessary to define the twist curve for the source curve of deformation: 

 

 <K> Select Source Twist Curve 

This curve is selected in the 3D window or in the tree of the 3D model. 

To cancel selection of the source twist curve, use the option: 

 

 <L> Cancel Source Twist Curve Selection 

The target curve and its twist curve are selected similarly with the help of the following options: 

 <B> Select Target Curve 

 <D> Cancel Target Curve Selection 

 <M> Select Target Twist Curve 

 <N> Cancel Target Twist Curve Selection 
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In addition, in the dialog of the command's properties the button 

[  Reverse Target Curve] is available, which allows a user to 

change the direction of the selected target curve. 

 

 

OPTIONS IN DEFORMATION OPERATIONS  

In the process of specifying/editing parameters of deformation, the 

future result of the current operation is dynamically shown in the 3D 

window. For speeding up the work, the dynamic preview can be turned 

off by taking off the flag Dynamic Preview in the command's properties 

window. 

 

An additional parameter Mesh Density controls accuracy of the mesh 

used for visualization of the result of the deformation. The increase in 

the mesh density leads to slower regeneration of the bodies in the 

scene but increases accuracy of the drawing. 

 

 

If you disable option Mark body, the body is no longer highlighted in the scene, which simplifies visual 

perception of the deformed object. 
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On Off 

 

The Live update option allows to watch deformations of the body in real time. Deactivating the option 

accelerates recalculation because solid body updating is not required. 

 
On (the result is displayed) Off (the result is not displayed, only decorations 

update) 
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WELDS IN 3D MODEL 

The weld modeling commands of T-FLEX CAD allow creating welds not only in a 2D drawing, but also 

within a 3D model. Welds appear in the 3D scene as special “cosmetic” bodies with a specific texture. 

 

You can make an annotation for a 3D weld just like you do for a weld in a 2D drawing The annotation can 

be created directly in the 3D model (it will be a 3D leader note), or on a 2D projection of such model. 

When you create the table of welds on one of 2D pages of a given document, the 3D welds are entered in 

it along with the 2D welds. 

BASIC INFORMATION ABOUT 3D  WELDS  

A 3D weld can be created by various means. All methods of creating 3D welds can be classified in groups: 

 3D welds created on faces of the 3D model; 

 3D welds created by guides: “by one guide” and “by three guides”; 

 3D welds created on edges, 3D paths, 3D profiles, and operations; 

 3D welds created by already existing 3D welds. 

For 3D welds created by edges and by guides a new “cosmetic” body is created in the 3D scene. These 

welds do not influence the remaining part of the 3D model and are not entered in the 3D model history. 

In the 3D model tree, a 3D weld body is put into a separate “Welds” folder. 

The “WeldMaterial” material from the standard T-FLEX CAD materials library is used for the weld 

body. 

If a 3D weld is created by other methods, the new body will not be created. The weld will be represented 

in the 3D scene by the model elements on which it is based. 

By using various methods of creating 3D welds in T-FLEX CAD, you can simulate various types of welds in 

the 3D model. 
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For any 3D weld it is possible to specify to which weld type it belongs. The type determines all basic 

characteristics of the weld (type of weld joint, structural elements, annotation). The type of the weld does 

not depend on the way the weld was created. 

The weld type is created as a separate model element. The weld types defined in the current 

document are common across both the 2D and 3D welds. A detailed description of weld types is 

available in the “Weld” chapter of the “Fundamentals. Two-Dimensional Design” manual. 

You do not have to specify the type of a 3D weld. Such a 3D weld would be called nonstandard. A 

nonstandard 3D weld is not entered in the welds table. Besides that, nonstandard 3D welds are not 

displayed in the welds tree of the “Welds” window.  

 

The nonstandard 3D welds can be used to decorate the 3D model. For example, suppose, the user wants 

to draw a weld on the model simply to make it look more realistic, without an intention to create weld 

documentation in the future. In such a case, it may not be justifiable to spend time on creating a weld type. 

You can simply define a nonstandard 3D weld in the 3D model. 

Please distinguish between the “nonstandard” 3D weld and a 3D weld created by the nonstandard 

weld type, whose parameters were custom-defined by the user. The 3D weld of a nonstandard type 

is entered in the welds table. 

METHODS OF CREATING 3D  WELDS  

Creating 3D Welds on Faces 

There are three methods to create a 3D weld on faces of the 3D model:  

 Creating a continuous fillet weld; 

 Creating an intermittent fillet weld; 

 Creating a butt weld. 

In all such cases, the weld is created based on two sets of faces being welded. The sets define the faces 

that must be “connected” by the weld. The number of faces in the sets doesn't have to match. The selected 

faces must belong to one or two Bodies. 
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Continuous Fillet Weld 
When creating a continuous fillet weld, you need to select two sets of faces being welded, the size of weld 

and the contour type (flush, convex, concave). The result will be a weld between the surfaces of the 

specified sets of faces, whose size will correspond to the defined size of weld. 

    

The size of weld is counted from the line of faces' intersection (see the figures). The weld contour being 

created is specified as the maximum deviation of the curved face line of the weld being created from the 

straight line. A positive deviation value means convexity of the weld, whereas negative – the concavity. 

Zero value corresponds to the “Flush” contour. 
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Intermittent Fillet Weld 
An intermittent fillet weld is a kind of a fillet weld in which the continuity is broken by recurring unwelded 

spaces. Therefore, it is generally created in the same way as a continuous fillet weld. Additionally, you need 

to specify the length of weld and pitch. Please note that for some types of welds, these parameters may be 

predefined by the type itself (if so required by the applicable standards, such as GOST). In this case, the 

values defined for the weld, override the values prescribed by this weld type. 

               

Butt Weld 
A butt weld connects the entire surface of the two sets of faces being welded. To ensure the correct 

orientation of the butt weld, you need to additionally specify the top and bottom faces for each set of faces 

being welded. Those define the required correspondence to construct the weld body. Specify the top and 

bottom faces by picking ones among those having common edges with the faces being welded. 

For example, when creating a butt weld between two pipes of the round section shape, you select the 

outer cylindrical faces of both bodies as the top faces. The bottom faces in this case will be the inner 

cylindrical faces. Or, you can do the opposite, as far as the outer face of one body matches with the outer 

face of the other body, and so do the inner faces. 

 

 

When creating a butt weld between two pipes with a noncircular section shape, select all outer faces of 

both pipes as the top faces, and all inner faces - as the bottom faces. At the same time, if several top faces 

are specified on each of the bodies, then the order of selecting faces on one body must match the order 

of selecting faces on the other body. The same is true in the case of selecting several bottom faces on each 

of the bodies. 
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When creating a butt weld between two plates, you select the top and bottom faces as the ones, along 

which the weld will go. Please note that the top face on one plate must be on the same side as the top 

face on the other plate.  

 

In the case of the butt weld, you can specify the contour type (flush, convex, concave) on either side of the 

parts being welded (that is, on the sides of the top and bottom faces). The weld contour from each sides 

of weld is specified as the maximum deviation of the curved face line of the weld from the straight line.  

 

Creating 3D Weld by Guides 

Weld Created by One Guide 
When creating the weld by one guide, the body of the weld is created by translation of the weld’s profile 

along the arbitrary guide. The guide of the weld can be closed. 
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As a guide, the user can select edges, 3D paths, 3D profiles, etc. It is also possible to define the guide by a 

group of 3D elements (edges, paths, etc.) on condition that all selected elements form a continuous 

sequence. 

The shape of the profile is selected from two options offered by the system: circle or isosceles triangle. For 

the circular profile, the user defines the radius, for the triangular profile – the size of the leg and the size 

of the angle between the legs. 

For specifying precise orientation of the triangular profile, the user has to define direction of the profile’s 

orientation and the angle of the profile’s rotation with respect to this direction. When creating the weld, 

the vertex of the triangle is superposed with a point on the guide, and one of the sides of the triangle is 

superposed with the given direction vector, and after that the profile is rotated through a required angle. 

 

The length of the created weld is equal to the length of the guide. In cases where it is desirable to create 

the weld longer than the guide, the user can specify the magnitude of extensions at the ends of the guide. 

The body of the weld will be elongated along the tangent to the guide at its end points by a specified 

extension length. 

                

Weld Created by Three Guides 
For creating the weld of this kind, three guides must be specified. The body of the weld, triangular in cross-

section, is formed in such a way that its lateral edges coincide with the guides. 
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For the guide, the user can select edges, 3D paths, 3D profiles, etc. It is also possible to define the guides 

by a group of 3D elements (edges, paths, etc.) on condition that all selected elements of one guide form a 

continuous sequence. 

The length of the created weld is equal to the length of the first guide. In cases where it is desirable to 

create the weld longer than the guide, the user can specify the magnitude of extensions at the ends of the 

guide. The body of the weld will be elongated (by a parallel shift of the end sections) by a specified 

extension length. 

For the weld by three guides it is possible to specify the contour type (flush, convex, concave) for the side 

lying between the first and the second guides. 

               

Creating 3D Welds on Edges, 3D Paths, 3D Profiles, and Operations 

A 3D weld created on edges, 3D paths, 3D profiles, and operations, can be used in the cases when the 

required appearance of the weld cannot be achieved by building it on the model faces. It serves to indicate 

that some existing 3D model elements represent welds. The supply more information with the created 

composite weld, you can specify, what parts it connects. Please note that such a 3D weld cannot be 

nonstandard. 

When the 3D weld is created, no additional “cosmetic” weld body is created in the 3D scene. You can still 

“see” such a weld – as you select it in the welds window, the respective 3D objects will be highlighted in 

the 3D scene. 

If necessary, you can manually assign the “WeldMaterial” material to the body representing a 3D 

weld. 

A 3D weld created on edges, 3D paths, 3D profiles, and operations, is entered into the table of welds along 

with other types of welds. The length of a composite weld is determined in the automatic calculation mode 

as the sum of the perimeters or lengths of all 3D model elements that are involved in it, except bodies 

(operations). The bodies that are involved in a composite weld, are not accounted for when automatically 

calculating its length. 

As an example, consider creating a flange-face weld. Suppose, we need to create a weld that connects 

three parts (see the figure below). Neither the fillet nor the butt 3D weld is suitable in this case. We will 

therefore create a 3D weld on two edges, and will additionally specify what bodies must be connected by 

this weld. 
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Creating 3D Welds by Existing 3D Welds 

A 3D weld can be created based on a set of already existing 3D welds. Such a weld cannot be nonstandard. 

Just like in the previous case, no additional body is created in the 3D scene when such a 3D weld is created.  

As an example of creating such a weld consider creating in T-FLEX CAD a two-sided Tee-weld. A Tee-weld 

can be imitated by a pair of fillet welds. To make this pair of welds work as a single weld in the future, you 

need to additionally join them into one weld.  

 

To add more information to the created composite weld, you can specify, what parts it connects. 

The length of the composite weld in the automatic calculation mode is determined as the sum of all 3D 

welds that it includes. The properties of a composite weld created from a set of 3D welds are determined 

by the type specified for this composite weld. The parameters of the source welds are ignored. Please also 

note that the table of welds generally includes both the source 3D welds and the resulting weld, which is 

based on them. To avoid duplicates, we recommend using nonstandard 3D welds as the source welds. In 

this case, those will not be entered in the welds table. 

CREATING 3D  WELD  

A 3D weld is created with the command W3: Create 3D Weld: 
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Icon Ribbon 

 

Assembly → Assembly → Weld → Weld 

Keyboard Textual Menu 

<W3> Tools > Weld >3D Weld 

To create a 3D weld, you need to: 

 define type of the weld being created; 

 select the method of creating the weld; 

 select the source geometrical objects for the weld (depends on the weld creation method); 

 define the weld length (if necessary); 

 define additional weld parameters (the size of weld, the contour type or any other parameters 

depending on the weld type); 

 confirm the weld creation. 

Selecting Type of 3D Weld 

The type of the weld being created is selected in the command's properties window, in the Weld Type 

drop-down list. The list contains all types of welds created in the current T-FLEX CAD document. 

If the required weld type is not yet created, you can use the button [Add…]. 

Clicking this button starts the command of the new weld type creation. When 

the type is created, the system returns to the weld creation command. The 

created weld type will be automatically selected. 

If no weld types are defined in the current document at the time of starting 

the W3: Create 3D Weld command, then the weld type creation command 

will be launched automatically. 
 

How to create a new weld type is described in the “Weld” chapter of the “Fundamentals. Two-

Dimensional Design” manual. 

Besides the weld types that the user created, the “Weld Type” list contains an additional option Non 

Standard. It is used to create nonstandard 3D welds. 
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Selecting the Method of Creating a 3D Weld 

You select a method of creating a 3D weld using the Weld Type 

drop-down list in the command's properties window.  

 

To create a 3D weld on model faces, you need to select one of the 

following entries in the list – Continuous Fillet Weld (creation of a 

fillet weld), Intermittent Fillet Weld (creation of an intermittent fillet 

weld), Butt Weld (creation of a butt weld).  

 

Welds by one guide or three guides can be created by selecting, from 

the list, the options By Curve and By Three Paths, respectively.  

To create a 3D weld based on existing entities of the 3D model 

(except faces) you shall select the option Compound Weld. 
 

The “Compound Weld” option is not available in the list, if the “Weld Type” field specifies “Non 

Standard”. 

Selecting the Source Geometrical Objects of a Weld. Advanced Weld Parameters 

The source geometrical objects selection for the weld being created, as well as additional weld parameters, 

depend on the method of creating this weld. Therefore, we will review different methods of creating a 3D 

weld separately. 

 

Welds on faces. Continuous and intermittent fillet welds 
As you select the “Continuous Fillet Weld” or “Intermittent Fillet Weld” item in the list, the following options 

become available in the command's automenu to select the two sets of faces being welded: 

 <1> Select Faces of First Set 

 <2> Select Faces of Second Set 

The selected faces are entered in the lists “Faces of First Set” and “Faces of Second Set”. To remove some 

face from a selected set, pick it in the respective list by clicking , and then click the button . 

The size of weld can be defined using the same-name parameter in the properties window.  

The contour type of the weld defined by parameter “Convexity”. This parameter define the value of 

maximum deviation of the curved face line of the weld from the straight line. A positive deviation value 

means convexity of the weld, whereas negative – the concavity. Zero value corresponds to the flat contour. 

In the case of an intermittent fillet weld, you can additionally specify pitch and length of weld. 
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Welds on faces. Butt Weld 
 

The two sets of welded faces in the butt weld are selected using the same options  and , as in the 

fillet welds. Additionally, there will be the options in the automenu to select the top and bottom faces of 

the bodies being welded: 

 <T> Select Top Faces of First Set 

 <B> Select Bottom Faces of First Set 

 <Y> Select Top Faces of Second Set 

 <N> Select Bottom Faces of Second Set 

 

The selected faces are entered in the lists Top 1, Top 2, Bottom 1, Bottom 2. To remove some face from 

the selection, pick it in the respective list by clicking , and then click the button . 

 

In the case of the butt weld, you can also specify Convexity on Face Side (that is, the contur type of the 

weld on the side of the top faces) and Convexity on Back Side (the the contur type of the weld on the side 

of the bottom faces) in the properties window. 
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Weld by Created by Guide 
For creating the weld by a guide, the user should select the option “By Path” found in the list “Weld type”. 

After that in the automenu the option for selecting the guide will be available: 

 <T> Select 1st Guide 

The pull down list of this option contains the filters for selection of 3D objects 

– loops, edges, 3D paths, 3D profiles, etc. The objects selected as the elements 

of the guide are put into the list Path 1 in the command’s properties window. 

To cancel selection of a 3D object, select it in the list with the help of  and 

press the button . 

If you want to cancel selection of the guide entirely, press the button  in 

the properties window or use the following option of the automenu: 

 <D> Cancel Selection of 1st Guide 

If the selected guide is not long enough, it is possible to increase the weld’s 

length by specifying the magnitude of the extensions. This can be done with 

the help of parameters of the group End Extensions found in the command’s 

properties window. 
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Parameters’ group found in the lower part of the section Weld of the 

properties window allows the user to select the type of the weld’s profile: 

Round (circle) or Triangular. When selecting the circular profile it is necessary 

to indicate its radius. 

For triangular profile you need to specify the length of the lateral side of the 

triangle (parameter Size of Weld), angle between the sides of the triangle 

(Angle) and the angle of rotation with respect to the direction of the profile 

orientation (Rotation). 

 

The direction of the triangular profile orientation can be specified with the help of the following option of 

the automenu: 

 

 <R> Select guide for defining profile orientation 

To cancel selected direction, use the following option: 

 

 <U> 
Cancel selection of guide for defining profile 

orientation 

Weld Created by Three Guides 
For creating the weld by three guides, the user should select the option “By Three Paths” found in the list 

“Weld type”. After that in the automenu the following options for selecting the guides will be available: 

 <T> Select First Guide Curve 

 <D> Cancel Selection of First Guide Curve 

 <W> Select Second Guide Curve 

 <K> Cancel Selection of Second Guide Curve 

 <A> Select Third Guide Curve 

 <M> Cancel Selection of Third Guide Curve 
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Selected objects are put into the list Path 1, Path 2, Path 3 in the command’s 

properties window. 

The length of the created weld is equal to the length of the first guide. You 

can increase the length by specifying the magnitude of extensions at the ends 

of the path with the help of the parameters of the group End extensions. 

In the dialog of the properties window for the weld created by three guides, 

it is also possible to specify the contur type of the weld (Convexity). 

 

 

Welds on edges, 3D paths, 3D profiles, operations, and 3D welds 
To create a weld on edges, 3D paths, 3D profiles, operations and other existing 3D welds, you need to set 

the option Compound Weld in the “Weld Type” list. After that, the options to select the 3D model source 

objects will become available in the automenu: 

 <C> Select weld elements 

 

The drop-down list of this operation contains the filters to select 3D objects 

– 3D welds, edges, 3D paths, 3D profiles, and operations. 

The objects selected as the members of the 3D weld are entered in the 

“Elements” list in the command's properties window. To remove some 3D 

object from the selected, you need to pick it in this list by clicking , and 

then click the button . 

The parts that will be connected by this created weld can be specified with 

the option: 

 

 

 

 <D> Selected Weldment Parts 

You can additionally specify that the composed weld makes a closed loop, by setting the flag Closed 

Contour. 
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Defining Weld Length 

The method of calculating the weld length is determined by the state of the Length flag. When the flag is 

off, the weld length is calculated by the system automatically. When the flag is enabled, the length value 

is defined by the user in the input box next to the flag. 

CREATING 3D  WELD ANNOTATION  

A 3D weld annotation is created by the same command as an annotation for a 2D weld: 

Icon Ribbon 

 

Assembly → Assembly → Weld → Weld Annotation 

Keyboard Textual Menu 

<WN> Tools > Weld > Weld Annotation 

Working with this command is described in the “Weld” chapter of the “Fundamentals. Two-Dimensional 

Design” manual. 

A 3D weld annotation is a 3D annotation, whose text is automatically generated based on the weld 

parameters. 

 

The 3D weld annotation can also be applied on a 2D projection as a 2D annotation, when it is selected 

within the command of creating the annotations for the projection line of the 3D weld. 

CREATING WELD TABLE  

How to create a weld table is described in the “Weld” chapter of the “Fundamentals. Two-Dimensional 

Design” manual. Here, we will just remind that the table of welds is created using the command WT: Create 

Weld Table: 
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Keyboard Textual Menu Icon 

<WT> Tools > Weld > Weld Table  

By using this command you can create the table of welds in the current T-FLEX CAD document, or export 

it into an MS Excel document. 

All 2D welds and the standard 3D welds are entered in the welds table.
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PRIMITIVES 

MAIN CONCEPTS AND CAPABIL IT IES  

Commands united in the Primitives group allows to create basic geometric bodies: Box, Cylinder, Cone, 

Sphere, Torus, Prism and Pyramid without additional construction elements creation.  

You can specify location and general dimensions for primitives and apply Boolean operation for them 

immediately. This allows you to quickly create models based on primitives. 

 

CREATING OPERATION  

A drop-down list of commands for primitives’ creation can be found in the Primitives group: 

Icon Ribbon 

 

3D Model → Special → Primitives 

Keyboard Textual Menu 

 Operation > Primitives 

There is also an additional Ribbon tab for primitives: 
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When you select a command from the list the corresponding body appears in the 3D scene. 

 

 

 

Translation and rotation manipulators and manipulators for geometric parameters specifying are available 

for the bodies. 

 

All transformations that are perfored using translation and rotation manipulators are displayed 

in the properties window in the Transformations section. 

Special manipulators are used to change diameters of rotation bodies. 

 

“Quick manipulators” are available for the Primitives group in the Select operations on the faces built 

mode, when the chosen operation is available for editing by means of the manipulators at once. 
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OPERATION OPTIONS  

Commands for LCS creation and transformation are available in the automenu of each primitive type. 

Source LCA is associated with the primitive and allows you to set its position in the scene. Source LCS can 

be merged with target LCS, which already exists in the scene. Their axes will be combined. 

 

More information about LCS transformation  and manipulators for translation and rotation can be 

found in “Translations” chapter. 

 

Symmetry  option exists in automenu for all commands from Primitive group, except Pyramid 

command. A single body that consists of two symmetric parts is created after its activation. Additional 

symmetry operations are not performed in this case. Source coordinate system of the primitive is moved 

to the center of the body. The option is active for Sphere and Torus by default. 
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Thin-walled element option is available for all commands of the Primitives group. Setting parameters of 

the bed and the cover of a thin-walled element is available in this option for the commands Parallelepiped, 

Cylinder, Prism and Pyramid (truncated one with the second setting diameter not equal to zero). 

         

More information about thin wall elements can be found in “Extrusion” chapter. 

For the Sphere and Torus commands it is only possible to create a thin-walled element without bed and 

cover options. 

 

 

For the Cone command it is only possible to create a thin-walled element with the variant No thickness 

with the help of automenu option  Thin-walled element. In this variant the cone basis is removed and 

a conic surface is the result of the command execution. 

The automenu option  Thin-walled element is also available for all other commands of the Primitives 

group and it works similarly: the bases of the primitive are removed and the surface is the result of the 

command execution. 

 

You can change way of primitive translation in the scene using Move option. If the option is enabled, the 

primitive follows the cursor. If the option is disabled, you need to use draggers for primitive translation. 
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 <8> Move 

 

Options for Boolean operation creation are also available in the automenu. 

 

More information about Boolean operations can be found in “Boolean operation” chapter. 

ADDITIONAL FEATURES  

Link Dimensions to Existing Geometry 

There is possibility to link primitives’ dimensions to the existing geometry.  

For this purpose use you need to  on the corresponding manipulator of the parameter and to select a 

point on the existing geometry using . 
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A primitive will transform according to the changes in the linked body. 

You can break a link using special option. The option appears near the linked parameter. 

 

You cannot create a link if a source coordinate system of the primitive has been changed using 

Select or Create source LCS option. Warning appears in this case. 

Create Driving Dimensions 

You can create driving dimensions for primitive using option Create driving dimensions in the Options 

section.  

 

Driving dimensions can be created for box, cylinder and prism primitives. 
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PRIMIT IVES GROUP OPERATIONS  

Unique set of parameters is displayed in the Properties window for each operation from Primitives group  

When you change primitive dimensions using 3D manipulators in the scene, corresponding parameters 

are also changed in Properties window. Value of changed dimension is displayed in the top of the window 

upon manipulator movement. 

 

Box 

You can set the following box parameters: Length, Width, Height. 

When the Cube flag is set only Length parameter field can be changed. You can specify length of all cube 

sides here. 
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Cylinder 

You can specify Diameter and Height for the cylinder. 

 

Cone 

It is available to specify Diameter, Height, Angle and Diameter 2 for the cone. Diameter defines cone apex 

diameter. Angle and Diameter 2 values depends on each other. Angle value depends on height. 
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Sphere 

You can specify diameter for the sphere. 

 

Torus 

It is available to specify two diameters for the torus. 
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Prism 

You can specify Diameter, Height and Sides for the prism. The maximum number of sides is 100. 

 

 

 

Pyramid 

You can specify base diameter, apex diameter, height and number of sides for a pyramid. The maximum 

number of sides is 100. 
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RIB 

A rib is an element that is obtained by extension of a contour in the given direction until intersection occurs 

with the faces of the initial body.  

Ribs can be created on the basis of closed as well as open contours. The result of execution of this operation 

is a solid body obtained with a Boolean operation of union of created rib with the initial body. 

    

The user specifies direction of extension of the initial contour and its thickness. After selection of several 

contours a grid of ribs can be created. In this case the thickness for several objects is specified immediately 

for the entire grid. 

 

Contour may consist of several parts. In this case one direction to solid body is specified for all parts of the 

contour. 
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It is not necessary to limit rib contour with solid body walls. In most cases system can automatically 

determine the boundaries of the created edge. On the picture below the rib is limited with planes of the 

solid body faces. 

 

Note that if borders can’t be automatically determined the construction of the rib will not be 

possible. 
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CREATION OF RIB  

Before construction of a rib, it is required to create a contour that will define the shape of this rib. 

To create a rib we use the 3ST: Create rib command. This command can be invoked via: 

Icon Ribbon 

 

3D Model → Modify → Rib 

Keyboard Textual Menu 

<3ST> Operations > Rib 

To create the operation, it is required to execute the following sequence of actions: 

 Select the source body; 

 Select  forming contour; 

 Select direction of extrusion of the rib; 

 Specify thickness of rib;  

 Specify additional capabilities of the operation (not a necessary step); 

 Confirm creation of operation.  

Selection of Source Body  

To create a rib it is firstly required to select the source body. After invoking this command the following 

option will automatically be activated in the automenu: 

 <S>  Select body 

Selection of contour 

After selection of the source body the option of selection of the contour that defines the form of a rib 

being created is activated.  

 <С>  Select forming contour 

As a contour we can select 3D profiles, faces, edges, paths, loops. If there is only one profile in the scene, 

it will be selected automatically. 

After the first contour has been selected this option remains active, and if necessary you can select several 

contours. 

When contour extends beyond the limits of the source body it is cut to the required size. 
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If the contour is open, it is extended until intersection occurs with the model, and the entire space between 

the surfaces of the part and the given contour will be filled with the material of the given thickness. 
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Contour, which consist of several parts, may create two ribs and more. 

 

Entire contour. When flag is set, rib can be created outside of the body using the closed contour. 

  

All of the selected contours are displayed in the «Forming contours» tab in the command’s properties 

window. 

 

The  button removes selected contour from the list. 
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Direction of Extension of Rib 

Extension of a contour can be carried out in two directions: 

 In the plane of contour  

 Perpendicular to the plane of contour  

Direction Position and shape of rib Result of construction 

Perpendicular to plane of 

contour 

Surface of a rib is formed by extension 

of contour in the direction 

perpendicular to its plane 

 

In the plane of contour 
Surface of a rib is formed by extension 

of contour in the direction of its plane. 

 

To choose the method of contour’s extension it is required to use the «Main parameters» tab of the 

command’s properties window. 

 

Direction of contour extension is displayed in the scene as arrow- manipulator. 
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Contour Direction for a Straight Segment 
If forming contour is specified by a straight segment, its positioning plane is determined automatically by 

the following rule. If segment presents part of a profile, system will use plane of the profile creation. If 

segment presents part of a path, positioning plane is defined by rotating the segment in global coordinate 

system to the nearest plane the segment coincides. 

 Contour extension direction is created according to the determined positioning plane. 

To select contour extension direction manually, you need to use option: 

 <D>  Select contour direction 

Next you need to select an auxiliary element. If you select object that specifies plane – face, workplane, 

etc., then the direction will be a normal to this plane. Alternatively, you can select object that specifies 

direction – edge, coordinate axis, etc. 

Specified contour extension direction will affect all selected contours defined by the straight segments. 

To cancel direction selection use option: 

 <K>  Cancel direction selection 

Direction to Solid  
In addition to contour extension direction, you can specify direction to solid. It determines which part of 

the half-space, created by contour, will be transformed into the rib.  

 

Special manipulator is used to specify direction to solid. It indicates direction inside the rib body from the 

point located on the contour. If contour is open, the point is located in the center of the contour line. For 

closed contour, the point position is chosen arbitrarily. For convenience you can move this point along the 

contour. 

 

Direction to solid can be defined individually for each contour. To change direction you need to move the 

manipulator, pulling one of its arcs. 

 

The manipulator allows you to set the direction to solid manually. Thus, system does not need to determine 

correct direction automatically. 

 

After the operation creation, all space between the walls of the source body and the contour in determined 

direction is converted into the solid rib of specified thickness. 
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Thickness of rib 

When forming a rib, new solid material is added in the direction perpendicular to contour extension plane. 

The value of thickness can be specified in appropriate field of the Main Parameters tab of the command’s 

properties window or by means of manipulator. 

 

The direction of thickness adherence must also be specified for a rib: 

 Forward direction. Direction coincides with the direction of the normal to the contour’s plane. 

 Back direction. Direction is opposite to the direction of the normal to the contour’s plane. 

 Symmetric. Thickness is added to the rib equally in both directions with respect to the plane of the 

contour. 
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Symmetric Forward direction Back direction 

Direction of thickness adherence can be selected from the drop down list on the Main parameters» tab: 

 

In case if the specified value of the thickness parameter becomes larger than the value of the 

contour’s length, the corresponding field will be renamed to height. 

Additional capabilities of operation 

 Taper of Rib’s Faces. If it is required that the faces of the rib have a taper, the following actions must 

be executed: 

 Select direction of a taper by using the option: 

 <T>  Set tapering direction  

When this option is enabled the geometric element is selected that specifies the direction of the 

taper. 

 Enable the Taper flag on the Main parameters tab of the command’s properties window. 
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 Enter the value of the tilt angle in the field next to the flag. 

 

In the example the normal to the selected face serves as a geometric element that specifies the direction 

of the tilt. 

To cancel selection of tapering direction use option: 

 <R>  Cancel taper direction 

 Blending ribs. To specify parameters of ribs blending it is required to use the Blend parameters tab in 

the command’s properties window. 
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To smooth out the side faces of a rib on its ends it is required to enable the Edges flag and input the 

required value of blend radius in the field next to the flag. 

 

To smooth out intersections of a rib with the source body it is required to enable the Intersections flag 

and input the required value of blend radius in the field next to the flag. 

 

Separate body. Allows to create a rib as a separate 

body. 

The option, in particular, allows you to create 

welded structures using ribs. 

This method may be used for example when 

modeling welded structure of flange and pipe. 
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In the Option section, you can set options for displaying auxiliary elements.  

 

Option Use draggers allows you to enable/disable the display of manipulators that specify the direction 

to solid and rib thickness. 

Option Show labels allows you to enable/disable the display of the labels that output rib thickness. 

 

R IB  EDITING  

To edit a rib use command: 

Keyboard Textual Menu Icon 

<3EST> Edit > Operations > Rib  

To reset thickness and direction to solid, you need to select the rib in edit mode, and then use option: 

 <F4> Execute edit command 

In the “Forming Contours” section of the properties window, select contour and reset its parameters. 

 

More information about this command can be found in the chapter Editing.
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3D ASSEMBLIES CREATION 

This chapter describes the process of creating three-dimensional assemblies in T-FLEX CAD. To design a 

three-dimensional assembly, you may need to use various commands and operations. Here we describe in 

details the techniques of working with 3D Fragments, Parts and Configurations.  

GENERAL INFORMATION  

What is a Three-Dimensional Assembly? 

A three-dimensional assembly in T-FLEX CAD is a model that incorporates geometry of other 3D models 

stored in separate files. An assembly component can be a 3D model created in T-FLEX CAD, or a model 

from another system imported in T-FLEX CAD in one of the supported data exchange formats. To be clear, 

the engineer may think of an assembly (by its definition) as a model built from elements-operations within 

one document, rather than composed of separate part files. T-FLEX CAD does support such functionality. 

However, we will not call such document an assembly, since it does not refer to geometry taken from other 

documents. 

An assembly document always maintains relations with assembly element (part) documents. As you work 

with an assembly, the system constantly tracks the state of the involved files. In the event of changes in an 

assembly component file, the system queries the user for updating the data. Each updated component will 

be regenerated and reloaded into the assembly. An assembly cannot be used without its components, 

while the each file involved in the assembly can be a fully independent document and, in turn, be an 

assembly itself. The number of nested levels of subassemblies is unlimited in the system. 
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Use of Parametric Models 
Any model in T-FLEX CAD can be built in such a way, that it can be modified by using variables. Using such 

a model as an assembly component brings significant benefits. This is particularly effective, when such 

model is entered multiple times in one or several assemblies with different sets of external variable values. 

The same parametric part file can serve several assemblies at once. Parametric components of the assembly 

can be managed from within the assembly document. 

   

Creating BOMs 
Each assembly component may contain data within for automatic creation of various kinds of reports and 

Bills of Materials (BOMs). However, this chapter will not concentrate on creating BOMs. Detailed 

information on this topic can be found in the chapter “Bill of Materials”. 

Body Intersection Check 
One of the typical tasks that require creation of an assembly is checking the model for assembling 

compatibility, checking all bodies of the assembly against mutual penetrations. T-FLEX CAD provides 

special tools for solving such tasks. You can start checking two selected bodies or all bodies in the model 

for intersections, using such tools. You can also measure particular geometrical elements or relations. For 

detailed information on this topic, refer to the chapter “Model Geometry Analysis”. 

Assembly Design 

There are two main techniques to creating an assembly distinguished by the way of creating their 

components. 

In many cases, it is convenient to take an already prepared model and insert it in the assembly by defining 

its position in the assembly. This assembly design technique is conventionally called “bottom up”. In this 

framework, the components of a T-FLEX assembly are called 3D fragments. This approach is convenient 

for designing complex assemblies or standardized mechanisms made to large extent of standard parts. 

The inherent advantages of this approach are as follows. 
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 Designing parts in a separate file allows simplifying and subdividing the overall design process of 

a complex product. 

 The same 3D fragments are available for reuse in different assemblies and for including into libraries 

of frequently used parametric 3D fragments. 

 3D fragments can be created with the provision for automatic positioning in the space based on 

2D fragments and the workplane (so-called “layout”). 

Nevertheless, it is often easier and clearer to design a part once you have the idea about its position in the 

assembly, and its size, based on geometrical elements of other parts in the assembly. We will call this 

design technique top-down, while the assembly components, whose geometrical base is within that same 

assembly - Parts. An assembly model can be created “from scratch”, as the engineer defines the general 

layout of the assembly unit. In the next step, separate elements are identified and refined, either in separate 

files or in the assembly context. This approach in some cases simplifies defining element attachments to 

each other, providing parametric relations between those. Use of the “top-down” technique sometimes 

allows avoiding use of external variables. The part parameters in this case are defined by references. 

Changes at low levels of the hierarchy of the related parts trigger automatic adjustment of all child parts 

in the assembly. Besides, the values of the original parameters of the model can be derived directly from 

the assembly context, based on the reference elements. For example, one can make holes in the cap based 

on the holes in the body. In this way, the engineer deals with elements belonging to the fragments, while 

seeing the part surroundings and having access to elements belonging to the assembly. This mode will 

further be referred to as working in the assembly mode. 

The inherent difference in the two approaches does not prohibit combining both when creating assembly 

documents. 

ASSEMBLY CREATION FROM 3D  FRAGMENTS .  “BOTTOM-UP”  DESIGN  

How 3D Fragments Work 

In the approach “from part to assembly”, the assembly is composed of 3D fragments. In this case, it is 

implied, that the bulk of work on creating the part model is already done, and what is left is just assembling 

it. The main steps for assembling a 3D fragment are as follows: 

1. Select the 3D model file to use as the 3D fragment.  

2. Attach the 3D fragment to the assembly model.  

3. Define the values of the fragment external variables and parameters. 

Next, let's review the main concepts of 3D fragment insertion. 

Relation Between Assembly and 3D Fragment File 
There are two ways of selecting a 3D model file. The first is by explicitly selecting the model file. The second 

way allows using the existing 2D fragments within the assembly drawing, that have the respective 3D 

models. This is possible in the case when the 2D fragments were already used in the current document, as, 

for instance, for initial creation of the drawing assembly. 
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The system always maintains the relation between the 3D fragment file and the assembly file. The assembly 

file keeps, among each 3D fragment parameters, the reference to the 3D fragment file. T-FLEX CAD 

automatically tracks changes in the 3D fragment files. If necessary, it reloads the 3D fragment data into the 

assembly. To do this, the 3D fragment is searched using the store the reference. The reference path to the 

fragment file can be full or relative. To provide greater system flexibility, especially when porting models 

from one file system to another, we recommend using relative paths for the references. When writing the 

relative paths, the assembly file and its location in the file system are used as the guide. Another way of 

creating relative references relies on library configurations. 

Fragment with Variable Reference 
Just like in the case of using 2D fragments, a textual variable can be used as the reference path for 3D 

fragments being assembled. The value of such variable is the path to the file of the currently used 3D 

fragment. Depending on some conditions, this value can vary, becoming the reference to a different 3D 

fragment file. This allows creating assemblies with changing elements. There is one limitation on use of 3D 

fragments. All 3D fragments used in this scheme must have the original coordinate systems with the same 

name or be defined in the world coordinates. 

  

3D Fragment Attachment 
To insert a 3D fragment model in the assembly model, you need to decide on the attachment. Attaching a 

3D fragment means defining two coordinate systems – the source and the target one. One of the systems 

belongs to the 3D fragment, while the other - to the assembly. The 3D fragments geometry positioning is 

fully defined in the space upon placing the source coordinate system over the target one. The source and 

the target coordinate systems are usually represented by assigning or explicitly creating a Local Coordinate 

System (LCS) at the time of assembling the 3D fragment. If no LCS is specified, then the World Coordinate 

System is used instead. 



Three-dimensional modeling 

820 

  

Create source LCS by selecting edge Create target LCS by selecting cylindrical face 

In complicated cases, when fixing by coordinate systems cannot provide correct positioning of a 3D 

fragment, we recommend using Mates mechanism (see below the detailed description of the Mates 

mechanism). 

There is yet another way of defining the position of the 3D fragment based on the 2D fragment. This is a 

technique called “layout”. In this case, the 3D fragment orientation is done according to the 2D fragment 

fixing vector. The fixing vector must reference a workplane. This results in two coordinate systems. The 

source system is defined based on the fixing vector and its related workplane in the fragment document. 

The target coordinate system will be defined based on the final position of the fixing vector in the page of 

the assembly drawing and the selected workplane. 

 

The X-axis of the coordinate system coincides with the fixing vector and lies in the workplane. The Z-axis 

is normal to the workplane. The Y-axis is the cross product of the two. In this way, no new LCS is created 

for attachment. The three-dimensional data for the 3D fragment are loaded from the same 2D fragment 

file. This means, the 2D fragment is used for creating the plan (the drawing), while the 3D fragment - for 

building the three-dimensional model. This technique is convenient in some special design cases, when 

you need to place several three-dimensional objects on one level (plane). This can be, for instance, the task 

of placing furniture in premises or equipment in a workshop. The three-dimensional objects placing can 

be controlled in this case directly from the drawing by moving the respective 2D fragments in the plan. 

Z

YX

"Top"

"Front"

Workplane 
"Top view"

Fixing vector

3D fragment source coordinate 
system based on fixing vector 
(not displayed in scene)
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If the 2D fragment is created on a page without workplane, then the system will automatically 

perform the transformation for carrying the X-axis over the page of the selected workplane. 

Meanwhile, the fixing vector can be thought of as if carried over the page of the workplane with the 

same coordinates in the page as it had in the original page of the document. Further constructions 

are done as usual. 

 

This capability can also be successfully used when creating common assembly drawings. The following 

diagram shows a trivial model based on a two-dimensional assembly, whose fragments were attached 

using the fixing vectors. No coordinate systems for attaching 3D fragments were created in the fragment 

files. Neither were target coordinate systems created in the assembly drawing. The model was created by 

using the 3D layout technique. Try to realize the steps of building this model independently, in order to 

check your understanding of this paragraph. 

      

This drawing can be found in the folder “\Examples\3D Assemblies\3D Fragments\Assembly 3.grb”. 

 

Additional transformations 
Every 3D fragment can use Additional transformations as an auxiliary tool for making fragment location 

more precise or, in some cases, even as an independent positioning type. These transformations represent 
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themselves translations along the coordinate axes of the insertion coordinate system and rotations about 

these axes. The value of any additional transformation can be defined via constants, variables or 

expressions as well as by snapping to geometric objects of a 3D model. 

 

3D Fragment Variables 
Parametric relations of a 3D fragment are controlled by its external variables. When regenerating a 

fragment, the required geometrical relations and data are loaded from the original file first, then the values 

of the external variables are copied from those stored in the assembly for this fragment, and, after that, 

the regeneration starts. Thus, the original file stays unchanged. The same assembly document may have 

several instances of the same 3D fragment with unique sets of values of the external variables. For example, 

the same bolt can be used in the assembly with different diameter and length. 

 

Using 3D connectors 
3D connector is a special type of LCS which lets us automatically link external variables for jointed 

parametric elements of assembled 3D models. Connectors significantly simplify parts positioning and 

fitting of parameters upon design of the assemblies. When a 3D fragment is attached to a 3D connector, 

the values of the variables are automatically transferred from the connector to the fragment model, which 

is followed by model regeneration. Preliminary image of a 3D fragment immediately takes the sizes 

corresponding to the values of the 3D connector variables. 

 

For example, a nut М10 needs to be put on a bolt M10. When the bolt of size M10 is inserted into the 

assembly, its connector automatically remembers this diameter. Upon insertion of the nut, a required 

connector for attaching the nut is automatically chosen at the moment when the bolt elements are being 

selected. For a variable taking over the nut diameter, instructions are given – ask the connector the value 

of the variable. If the names coincide, the bolt connector passes the value М10 to the nut. Thus, right after 

connector selection, location, parameters and image of the nut are brought in accordance with the required 

bolt. 

A user can create 3D connectors independently while preparing the 3D fragment model (See section “Local 

Coordinate Systems”). The elements of service libraries and standard parts, supplied with the system 

(Fasteners, Holes etc.) already have embedded 3D connectors. 
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Insertion rules, which remain active upon selection of the given connector in the assembly for attaching 

the fragment, can be defined for a 3D connector. The insertion rule is a mandatory additional way of 

defining fragment location by moving it along one of the coordinate axes or by rotating it with respect to 

the axis (see Additional transformations). 

 

External geometrical parameters of a 3D fragment 
External parameters of a 3D fragment can be not only external variables, but also geometrical elements (a 

solid, 3D node, 3D path, 3D profile, workplane, LCS, vertex, edge, face, loop). Such 3D fragment is called 

adaptive. Normally, such 3D fragments are most often used for direct modeling (grooving, drilling 

nonstandard holes and similar elements), rather than for creating assemblies; therefore, all information 

related to handling adaptive 3D fragments is separated into a dedicated chapter in this book (see the 

chapter “Adaptive 3D Fragments”). 

 

Using 2D-fragment as «projection» for 3D fragment 
 It is possible to insert 2D fragments that present projection of corresponding 

3D fragment. This mechanism of operating with assemblies is useful when designing plans to deploy 

industrial equipment. It helps you to create drawings of floor plans, plans of rooms, etc. 

  

 To create a 2D fragment as projection of the existing 3D fragment you have 

first to specify workplane when creating a 2D fragment. This workplane helps to position future 2D 

fragment correctly. Then after selecting 3D fragment that will be used as source for the new 2D 

fragment you need to define the type of presentation for this 2D fragment. This may be done in «2D 

Projection» dialog where you can chose either type of projection or fixing vector associated with 

some predesigned 2D drawing. In case of fixing vector it must follow condition of correspondence 

to the workplane selected on the first step. In case of projection it will correspond to direction 

defined by the workplane. As result you will get the 2D fragment that will match source 3D fragment. 

Location of both fragments (2D and 3D) will be interdependent. 
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Relation between 2D and 3D fragments 
When inserting a new three-dimensional fragment, the system always creates the respective 2D fragment 

referencing the same file. There is always an inherent relation between the 2D and 3D fragments. Both 

fragments use the same data related to variable values, as well as some settings – the file name, the way 

of including in a BOM, the status settings. Usually, the 2D fragment is not necessary when creating a 3D 

assembly model; therefore, the system hides it by default. The 2D fragment can be selected only by using 

the dedicated command for editing 2D fragments. Using this command may be convenient, for example, 

when you need to modify a bulk of references to fragment files, since the command provides convenient 

tools for simultaneous management of lists of the fragments. A 3D fragment document may contain the 

two-dimensional drawing along with the three-dimensional geometry. This drawing can be used for 

automatic creation of the assembly drawing, by following certain rules. In this way, the image of each 2D 

fragment will be put in the first page of the assembly document with the same page coordinates as those 

of the image in the original file. 

3D Fragment Management 

The command for inserting a 3D fragment is 3F: Insert 3D Fragment. The command is called as: 
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Icon Ribbon 

 

Assembly → Assembly → 3D Fragment 

Keyboard Textual Menu 

<3F> Operation > Insert 3D Fragment 

To insert a 3D fragment into an assembly, you need to do the following steps: 

Select 3D fragment. 

The selection is done by one of the following ways: 

 insert a new 3D fragment by selecting a file; 

 select an already inserted 2D fragment and use its three-dimensional model; 

 if the symbol of the model file is dragged from the Windows Explorer or from the service window 

of the T-FLEX CAD libraries to the 3D window, the 3D fragment insertion command will be started 

automatically and the given file will be selected for insertion. 

Select or Create Source LCS for the fragment. Selection can be done automatically if the 3D fragment has 

exactly one or a specially designated LCS. 

Select or create target coordinate system in the assembly. 

Define the values of the fragment external parameters. 

This step is skipped when using an existing 2D fragment or if the 3D fragment does not have external 

variables. 

The values of the variables can be set automatically upon attaching 3D fragment to the connector of 

another 3D fragment. 

Define fragment parameters (optional). 

Finish input. 

3D fragment selection 
3D fragment can be selected with the help of the option: 

 <F> Select File 

The fragment is selected using the standard File Open dialog. The fragment file can be selected either from 

a folder on the disk or from a library. 

In the transparent mode the following option is available: 

 <A>  Select 2D Fragment 

At this moment it is enough to select existing 3D fragment or a file from a library opened in the Library 

Explorer, and the system chooses an indicated element for insertion as the new 3D fragment. Upon 

selection of an existing 2D fragment in a 2D window the system will use its three-dimensional model.  
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After insertion of a 3D fragment, the path to its file will be stored in the operation properties. The path can 

be complete relative to the file of the assembly or relative to the library being used. 

In some cases, the system may automatically record the relative path to a reference with respect to the 

assembly file. Detailed information on the format of the relative links (references) can be found in the 

chapter “Assembly Drawing”. 

 

External Variable Value Definition 
Upon selecting the file, the properties window is filled with parameters of the 3D fragment. One of its 

groups deals with external variables. The external variables can be displayed as a list – just as in the variable 

editor. If a custom dialog was created for managing external variables, it will be automatically built in the 

3D fragment properties window. If necessary, you can switch between the two modes of displaying the 

external variables. This is done by toggling the flag “List of Variables” in the properties window. 

                   

The information about external variables is displayed as long as the 3D fragment creation command is 

active. You can modify at any time the values copied from the fragment file. To update the 3D window for 

the changes in the properties window, use the provided button . 

If you find it inconvenient to modify the values of the external variables in the property window (as, for 

instance, because of the large size of the custom dialog), you can put the group of variables into a separate 

window and enter changes there. Calling the separate window is done by using a special button  at the 

upper right corner of the group. 

If the 3D fragment model does not have any external variables, then, upon executing the 3D 

fragment insertion command, no tools are displayed for managing external variables. 

When a 3D fragment is attached to a connector, the values of the fragment variables can be assigned 

automatically. (See section «Using 3D connectors».) 
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Parametric Relation Definition 
Defining relations between parts is the main task for designing parametric assemblies. It demands from 

the engineer understanding of the T-FLEX CAD tools for maintaining such relations. The first tool that you 

need to master is the variable editor. The variable editor itself or similar environment is used by the system 

in multiple occasions, as, for instance, when defining the values of the fragment external variables. Working 

with the editor, variables, functions and such is described in the chapter “Variables”. 

Here, let's review a simple showcase for relating part parameters in order to control them from the 

assembly model. Here we will skip the description of the steps that are not related to the parametric 

assembly creation (the description of creating part files, attachment, etc.). 

 

Consider the task – to create a switchboard that includes the mounting plate and a set of switches. The 

switches can be of two types. The types of the switches differ in some dimensions, however, can be 

composed from the same parametric parts. The switch lever must snap to two positions “On/Off”. The 

switch itself is made of the following separate parts - the body, the pin and the lever. These parts are 

parametric, as they rely on the necessary external variables. By using those we can create a parametric 

model of the switch, whose external parameters define the switch type and the lever position. We need to 

create a switchboard assembly by using this parametric model of the switch. 

 

 

 

The left-hand side diagram shows the parts of the switch. Tables to the left of each part contain the 

respective external variables. Originally, the tables appeared in the respective dialogs defining external 

variables for each 3D fragment being inserted. You can see that the respective assembly variables were 

entered as the values of the fragment external parameters (which is the switch file at this step). The diagram 

in the right-hand side shows the switch assembly and the table as appears in the variable editor. You can 

see on the diagram how the switch parameters are managed: the variables <R> and <h> change 

depending on the variable <T> value that defines the switch type. The former two define geometrical 

characteristics of the contributing parts. The variable <a> is responsible for the lever position and defines 

the model property “On/Off”. The external variable <r> will relay the pin radius value to the next assembly. 
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The next step is building the assembly (the switchboard) from the created parametric model of the switch. 

The left-hand side diagram shows the model of the switch and the two tables of its external variables with 

different values assigned when composing the assemblies. You can see from the diagram, that the variables 

<T> and <a> are assigned numerical values, while the variable <r> is related, instead of a value, to the 

variable <r> of the assembly. This is how the parametric assembly is built. The variable editor of the 

switchboard provides control over the value of the switch pin radius. Other switch parameters are left fixed. 

To modify those in the future, you could call the command for editing 3D fragment variables.  

 

When connectors are used, parametric relations between two parts can be established directly, 

skipping the step of creating the common variable in the assembly. At the same time, the variables 

of the new part, attached to the connector of another part already inserted into the assembly, will 

depend only on the values of the first part's variables (see “Using 3D connectors”). 

Selection/Creation of the Source Coordinate System 
The automatic sequence of the system steps for attaching a 3D fragment depends on whether predefined 

local coordinate systems existed in the 3D fragment model, and, if so, how many: 

 

 If there is exactly one LCS in the 3D fragment model, and its properties state that it can be 

used for attaching the 3D fragment, it will be automatically selected by the system as the 

source coordinates. The system will then proceed to the next step - defining the target 

coordinate system. If there are more than one LCS in the 3D fragment document, but only 

one of them is specifically designated as the source coordinates, the system behavior will be 

the same. (Refer to the topic “Preparing document for use as a 3D fragment” for details.) 

 If a 3D fragment model contains several LCS all suitable for fixing the 3D fragment, then T-

FLEX CAD picks up the default fixing (by the global coordinate system) and proceeds to 

defining the target coordinate system. To select a coordinate system, you need to switch to 

the special mode of selecting/creating the source coordinate system. 
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 If no local coordinate systems exist in the 3D fragment model, then T-FLEX CAD picks the 

default fixing (by the global coordinate system) and proceeds to defining the target 

coordinate system. To create a new source coordinate system, you need to switch to the 

special mode of selecting/creating the source coordinate system. 

Mode of Selecting/Creating Source Coordinate System is operated in a separate 3D window, in which the 

3D fragment model is loaded. This 3D window is launched forced from the 3D fragment creation command 

by the option: 

 

 <S> Select or Create the Source LCS 

After opening the new window, in addition to standard options, the following options can be initially found 

in the automenu: 

 

 <1> Select 3D node or vertex as LCS origin 

 <2> Select point to Define Direction of X-axis 

 <3> Select point to Define Direction of Y-axis 

 <C> Reset target LCS 

 <A> Rotate LCS around X-axis by 90° 

 <O> Rotate LCS around Y-axis by 90° 

 <Z> Rotate LCS around Z-axis by 90° 

 <9> Change LCS axes orientation 

When the  option is selected the user is returned to the assembly and the mode of the target LCS 

specification is enabled. The  option is used for transitioning to the actions related to specification of 

adaptive fragment’s geometric parameters (more detailed description can be found in the Adaptive 3D 

fragments chapter). 

 

When the  option is enabled selection of the existing LCS is carried out in 3D window or from the list 

in the properties window. 
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The system allows creating a new LCS based on the 3D fragment's geometry. To activate the mode of 

creating new source LCS, the first element for determining the origin of the coordinate system has to be 

selected in a 3D model. At the same time, it is possible to select any appropriate elements of the model in 

accordance with the active filters of the selector on the system toolbar. After choosing the origin of the 

new source LCS, the remaining options for defining LCS will appear in the automenu. Creation of the 

coordinate system is carried out by the same principles as in the specialized command for creating LCS 

3O: Construct coordinate system. Similar options and tools are used in both cases. The center and 

direction of the LCS axes are prescribed. In addition, the options for cyclical rotation and rotation of axes 

by 90 degrees are available. In this chapter we will omit detailed description of the LCS creation process. 

When creating a new LCS, keep in mind that it is 

not created in the 3D fragment file. Rather, it 

belongs to the current “3D fragment” operation 

and is stored in the assembly document. The 

created source coordinate system cannot be 

displayed in the assembly. To modify it, you need 

to call the 3D fragment editing command and 

enter the mode of selecting/creating the source 

LCS.   

When the new source LCS is being created, the new line «Fixing by Fragment» will appear in the Source 

LCS list for the fragment. Also, in the fragment properties window there is going to be a temporary section 

Coordinate System Parameters which enables to control objects selection during LCS creation. 

To exit the mode of selecting/creating the source LCS, use the button  

Selection/Creation of the Target Coordinate System 
The mode of selecting or creating the target coordinate system is turned on by the automenu option: 

 <2>  Select or create target LCS 
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In most cases this option is activated automatically after choosing the fragment file and after exiting the 

mode of creating the source LCS. If a suitable LCS is found in the assembly model then the user actions 

amount to selecting the LCS in the assembly, to which the fragment source coordinate system should be 

snapped. If no LCS is selected in the assembly, then the assembly world coordinates will be used as the 

target coordinate system.  

One can also create a new target coordinate system based on 3D model elements. The target coordinate 

system is constructed using the same tools as those for constructing the source one. The main difference 

is in that the all actions are performed in the main 3D window for the current assembly. The 3D fragment 

model is positioned in the space according to the properties of the target coordinate system being defined.  

The options for defining elements of the new target coordinate system appear after selecting the origin 

point of the LCS. Upon selecting the origin, you can proceed with orienting X and Y axes. 

In case you couldn't orient the LCS as desired from the beginning, you can use the tools for coordinate 

system redefinition. Those allow quickly rotating an existing LCS around its axes by 90 degrees ( , ,

), cyclically reassign the axes of the coordinate system with the fixed origin (pressing  switches the 

axes assignment). 

       

Fragment position in absolute 

coordinates  

Fragment position after selecting 

an edge for target LCS 

Fragment position after using the tool 

of rotating X-axis by 90. 

To reset all data currently used for defining the target coordinate system, use the automenu option: 

 <C> Reset target LCS  

Choosing 3D connectors 
3D connector can be chosen in the mode of selecting or creating target coordinate system activated 

automatically right after entering the fragment insertion command (option ). In this mode it is necessary 

to make sure that the selector's filter for choosing connectors  is activated on the system toolbar. 
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For searching connector on some part, bring the cursor to one of the elements associated with the 

connector. In standard elements, for example, in bolts, the screw-threaded faces of the bolt shaft can be 

chosen as an associated element. Already upon bringing the cursor to such element, the connector is 

highlighted. Press  for choosing connector. 

Assigning additional transformations 
Controlling additional transformations is carried out with the help of a dragger in the 3D window, group 

Transformations of the properties window and the Transformations Groups dialog of the Main 

transformations section of the properties window. The dragger is always present upon insertion of a 3D 

fragment, if the option Use Draggers is turned on in the properties window. 

The dragger enables to define an unlimited number of translational transformations 

along the indicated axes, in-plane shifts or rotations of selected axes by a required 

angle in the required plane. The dragger represents itself an image of the coordinate 

system. The coordinate axes are connected to each other by color arcs; adjacent planes 

are connected with each other via conditional small color squares, the dragger center 

is marked by a grey ball. Different parts of the dragger are the active elements 

intended for defining certain transformations: 

 

 the dragger axes are intended for defining translations; 

 the dragger arcs are used for defining rotations; 

 the images of coordinate planes are used for translation in the planes XY, XZ, YZ; 

 the dragger center is used to manually enter the mode of dynamic snapping. 

 

Upon bringing the cursor to different active parts of the 

dragger the cursor changes its appearance prompting to set 

the corresponding types of the additional transformations. 

Next to cursor there is going to be a tooltip providing 

information about the type of offered transformation. The 

selected element of the dragger is highlighted with a different 

color. When a user points at the axis he can move to setting 

the translation along the chosen axis. Upon pointing at the arc, 

the system prompts to set rotation in the corresponding plane. 

At the same time, the closest to the cursor axis of the dragger 

is also selected so that a user could define a rotation by 

directing the selected axis towards a specific element of the 

model. 
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When specifying the coordinate plane’s image the user can 

start defining the shift across the selected plane. 

When selecting one of the dragger’s elements mentioned 

above the following commands become available in the 

context menu: 

 - for translation along the axis; 

 - for translation in the plane; 

 - for rotation about three axes; 

 - for translation along three axes. 

 

  

 

The Settings option of the menu defines the step in the change of the distance and angle upon translations 

and rotations of the dragger. 

 

For defining transformation with the help of the dragger a user has to choose an active element of the 

dragger by pressing . Then, without releasing the mouse button a user can move the cursor. The 

transformation will have been set upon releasing the mouse button. 

 
Begin with inserting a 

fragment (the minutes arm) 

by selecting the edge on 

the arm pin to define the 

target LCS (of the arm 

fragment position) 

Turn the arm. To do this, 

select the desired element 

of the dragger and depress 

the left mouse button 

Drag the mouse whilst 

holding the mouse 

button down. Turn the 

fragment about the 

axis 

Complete the 

transformation definition 

by releasing the mouse 

button 

Also, after dragger's selection it is possible to release the mouse button, shift the cursor and choose a new 

element (indicate a new point in space) for fixing transformation by pressing  twice. 
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Start inserting the 

fragment (the 

bearing) 

Select the round edge to 

define the target coordinate 

system (the fragment's 

position) 

Click to select the 

dragger's axis to define 

the translation along the 

axis 

Select the round edge to 

define the final point of 

the translation 

Click at dragger center signifies transition to operations for modifying the target coordinate system. 

Simultaneously, the mode of dynamic snapping gets activated. In this mode, the fragment image is 

attached to the cursor. Upon bringing the cursor to the elements of the model, the fragment image will be 

immediately put in a position showing the location of the fragment in case the element is selected. In this 

mode it is possible to click at the free spot in space or choose an element of the model for attaching. In 

the first case, new additional transformations for placing the fragment at the spot of a click are created. 

After choosing the new element of the model for attaching, all previously defined transformations may be 

deleted. 

Group «Transformations» in the properties 

window can be used for controlling, correcting 

numerical values, creating or deleting 

transformations of a 3D fragment. In the special 

field the list of all additional transformations, 

defined at the moment for a 3D fragment, is 

shown. Each transformation is marked by a special 

symbol, denoting its type (translation or rotation 

about some axis). If the value of the 

transformation is set via a constant, then this value 

is shown next to the symbol. If the transformation 

was attached to the element of the model, then 

the name of the element is indicated next to the 

symbol. The elements of the list  are shown in the 

order in which there were created. Several 

successive transformations of similar type are 

automatically summed up. 
 

Below the main list of transformations there is a field for entering and editing the values. 
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To the right of the transformation list there are graphics 

buttons. The button  is intended for adding new 

transformation. When it is pressed, the list of available 

transformations, from which a desired type is offered for 

selection, will appear. After choosing the type in the list of 

transformations, a new line will appear. In the field for entering 

the values, one can put the value of the transformation. For 

saving transformation press [Enter]. Moreover, for assigning 

the values it is possible to shift to the 3D window and use the 

dragger, which is moved in accordance with the chosen 

transformation type. 

 

 

Upon pressing the button  the last transformation in the list 

is removed. 

When pressing the   buttons the order of 

transformations executions will change. 

 

The user has also a capability of creating individual transformations groups for 3D fragments. Classifying 

transformations into groups allows the user to create simultaneously several variants for the 3D fragment 

locations in the assembly. 

For example, let us suppose there is a variant of the room’s 3D layout. It is required that the fragment 

(barrel) change its location depending on the location of walls and addition of new objects to the layout. 
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To do so, in the properties window of the 3D fragment (barrel) in the Main Transformations section we 

find the Transformations Groups dialog. With the help of the  button we add the transformations 

group, namely we specify the values for translations along the X and Y axes and rotation around the Z-

axis. 

It is important to remember that by default all transformations for a 3D fragment are created in a 

single transformations group. 

Each transformations group has it name. The elements of the list are shown in the order that correspond 

to their creation. 

 

To control visibility of various locations of the fragment there is the Suppress flag. Next to the flag there 

is a field where the numbers can be entered or the numeric variables can be written down. If the value 

different from zero is entered into the field, the transformations group becomes suppressed. To make the 

work in the assembly more convenient let us specify the visibility of the fragment’s locations with the help 

of the variable. 
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After specifying several positions of the fragment (barrel) with the help of the transformations group we 

obtained the capability of manipulation of its translation in the easiest and fastest way. 

In this case for displaying the changes in the transformations in the 3D window it is required to use the 3D 

model update button . 

 

The graphics buttons are located to the right of the list of transformations group. 

The  button allows us to add a new group to the transformations group. 

When pressing the  button the last group of transformations in the list is removed. 

The  button allows us to remove all transformations groups. 

When pressing the    buttons the order of execution of transformations groups changes. 

Upon attaching a fragment to the connector, the system can automatically move to defining 

additional transformation, if the corresponding instructions are set in the connector (see chapter 

“Local Coordinate Systems”). 

After insertion 3D fragment all prescribed additional transformations are recorded in the common 

transformations list of the 3D fragment. A separate record is generated for each additional transformation  

in the transformations list of the 3D fragment. 

 

Fragment updating 

 Update 3D fragment automatically in case of changed parameters. If option is set, a fragment will 

be automatically updated when its variables or adaptive parameters are changed. 
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Also you can update fragment manually by pressing update button in the upper part of the Properties 

window. 

 

 

Working with 3D Model Structure 
In the course of working with an assembly, you may need to access auxiliary information about the state 

of 3D fragments. This can be querying their position in the assembly tree, reviewing existing errors, etc. 

Various tools are provided for this purpose. We will review those tools within the current topic. 

 

3D fragments and Parts are displayed in the “3D model” window. This window shows the complete 

hierarchy of the assembly model. It allows finding the place of each 3D fragment in the model structure 

among other 3D operations and construction elements. 3D fragments can be displayed at the root of the 

model structure, along with Bodies and Arrays. If a 3D fragment is an assembly itself, containing nested 3D 

fragments, the structure of all its nested elements is reflected in the general 3D model tree as well. To 

ensure the full support of handling the nested 3D fragments, you need to bring into the editing 

environment the subassembly that hosts the fragment of interest.  
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In the window 3D Model for 3D fragments, besides the name of the file and the operation, various 

additional information can be shown, if needed, – file path, identifier, memory size allocated for mesh, 

memory usage for geometry, recalculation time, the name and notation for specification. The amount of 

displayed information can be set in the dialog box of the command Appearance. This command can be 

called from the context menu by pressing  in the window 3D model. 
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If errors are detected in the model, the affected elements are marked in the model tree with the 

special symbols: 

 If an error was detected within a 3D fragment model or its coordinate systems, a mark is displayed. 

 The 3D fragments, whose files were not found by the specified reference, are marked by a red cross. 

 

 The suppressed 3D fragments are marked by a blue cross.  

Detailed information about all errors is displayed in the “Diagnostics” window. Right clicking  over a 

message brings up the context menu. If the message refers to a 3D fragment of the first level, then you 

have access to all commands for handling that 3D fragment. If the message reports an error within nested 

fragments, then the only command for handling the fragment is Show fragment structure. 

 

 

The fragment, within which the error was identified, is automatically highlighted, showing the branch of 

the assembly tree that includes the failing fragment. The right pane of the window displays the information 

about variables used in the fragment: their names, values and comments. To fix the error in the fragment 

file, you can open the file by pressing the button [Open]. For example, the error in the fragment model can 
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be caused by an invalid variable value. To open the fragment with the current variable values, use the 

button [Detail]. 

Normally, the assembly tree displays only its contributing 3D fragments. To view the full assembly structure, 

use the “Assembly Structure” Window. 

Layout Creation 
To create a 3D fragment using the layout technique, use the following option in the main automenu of the 

3D fragment insertion command: 

 

 <G> Create 3D Fragments by Workplane (Layout) 

Upon calling this option, the mode of selecting 2D fragments is activated, as indicated by the glyph 

attached to the pointer and the pushed icon in the automenu. Now, you need to select a 2D fragment or 

a set of 2D fragments to use for creating the 3D layout.  

 

Upon selecting 2D fragments, specify the workplane on which the 3D fragments will be placed. The 

workplane for the 3D fragment orientation can be defined anew, regardless of the workplane that was 

hosting the 2D fragment. The workplane selection is done by the option: 

 

 <W> Select Workplane to set view direction of projection 

The selection can be done either in the 2D or in the 3D window, provided, that the display of the workplane 

in the 3D window is turned on. 

 

Upon confirming the selection by pressing , the 3D layout will be displayed in the 3D scene, created 

based on the 2D fragments. 

 

If errors occur when creating a layout, for example, if the vector of the 2D fragment was not associated 

with the workplane, the system positions the 3D fragment in the absolute coordinates without a possibility 

for attaching to an LCS until the fixing vector is associated with the workplane in the fragment document. 

Besides, a warning is displayed, “Can not find associative Workplane in Fragment document”. 

There is a capability of controlling location of the 3D fragment directly in the 3D window domain. To 

change location of the 3D fragment in the 3D window domain it is required to use the option in the 

automenu of the 3D fragment insertion command: 

 

 <L> Layout mode 
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When the layout mode is enabled only the axes of the workplane are displayed on the dragger. All 

transformations with 3D will automatically be transferred onto the 2D drawing after pressing . 

Transformations with translation of 3D fragments are displayed on 2D only with the layout mode enabled. 

 

It is also possible to edit location of a 3D fragment when choosing configuration of the selector View /3D 

operation Elements. 

 

 

The layout mode is used only for 3D fragments with fixing vector. 

For the 3D fragments for which a 2D fragment has a fixing 

vector, when choosing the source coordinate system there is 

an option of fixing by the workplane. 

Orientation of the source coordinate system of the fragment 

snapped to the workplane coincides with the orientation of 

the fixing vector on 2D. 
 

3D Fragment Parameters 
Detailed setting of many parameters for a 3D fragment can be accomplished at any moment in the 

parameters dialog box. It is called with the help of the option of the command for creating and editing the 

fragment, and, also, from the context menu by selecting operation: 

 

  <P> Set entity parameters 

The dialog contains three tabs. The tab [General] contains common parameters for all 3D elements.  

Most of the parameters on the tab “Operation” are already described in the chapter “Assembly Drawing” 

of the two-dimensional design manual, as those are used when inserting 2D fragments. Exception is the 

following two parameters. 
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Configurations can be used for defining the values of the external variables in 3D fragments. For this 

purpose, the properties window provides a control for selecting the current configuration. The user can 

select any existing configuration, or the setting “(No configuration)”. 

 

Use as. This parameter can take one of the two values: “One Solid” or “Separate Solids”. With the value 

“Separate Solids” used, the additional operation “Divide Solid” is applied for dividing the fragment into the 

separate bodies. This is necessary in the cases when the 3D fragment itself is made of several bodies, while 

just one of them should be used, for instance, in a Boolean operation with another assembly element. It 

will be impossible to select a particular body of the 3D fragment without dividing into separate bodies. 

Instead, you will be always getting the whole operation “3D Fragment” selected as one object. The 

operation “Divide Solid” can also be done manually after inserting the 3D fragment, with the same result. 
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Use only in 3D. This flag allows turning off the display of the two-dimensional representation of the 

fragment in the 2D view window. 

 

Use Fragment Mates. When a different assembly unit, in which the mates have been created and the 

degrees of freedom have already been defined, is inserted into the assembly, there is a possibility to 

transfer the entire mechanism into the new assembly by using only operation of insertion of a 3D fragment. 

To insert such fragment-mechanism into the assembly, the option of using the fragment «As Separated 

Bodies» and the option «Use Fragment Mates» have to be turned on simultaneously. 

 

Autosave. When changing the values of external variables of the fragment in the assembly the fragment’s 

file is resaved according to the new values. The fragment’s file is updated at the moment of saving the 

assembly file. This flag can be conveniently used for obtaining detail drawings. If projections are used in 

the file of the fragment, then for their recalculation during autosaving the mode of automatic update must 

be selected in the projection’s properties. 

 

Save file of fragment to assembly folder. If this flag is enabled, then next to the assembly file the folder is 

created, which has the name of the assembly file, and the fragment’s file is saved into the folder. The 

relative path for the fragment is created. 

 

Don’t use parametrization. When this flag is enabled, external variables of the fragment cannot be 

changed. The “Variables” window is not invoked from the context menu of the fragment and does not 

appear during the fragment editing. 

 

Hide connectors. When this flag is enabled connectors of the fragment are not shown in 3D scene and in 

the tree of a 3D model. 

Hide coordinate systems in model tree. When this flag is enabled external coordinate systems of the 

fragment are displayed in 3D scene, but are not shown in the tree of a 3D model. 
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Via the tab [Transformations], it is possible to work with list of all geometric transformations which have 

been applied to the given operation of a 3D fragment. Among those, there could be: 

 additional transformations defined upon creating or editing 3D fragment; 

 transformations, assigned in the command “3EG: Transform Element” (working with this 

command is described in the section Assigning “Transformations” to 3D Entities»); 

 transformations for the «Exploded View» mode; 

 specific service transformations for performing the functions of attaching a 3D fragment. 

Any transformation can be applied either permanently or only in the special mode of exploded view for 

the assembly. This is controlled by the corresponding flag in the settings of each transformation. 

3D fragments and Parts can be subject to a special type of a transformation called “Attachment…”. Instead 

of somehow transforming the body of a 3D fragment in the space, this type of transformation merely 
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defines the attachment by the coordinate systems. This transformation is introduced automatically by the 

system upon inserting each 3D fragment. Its name depends on the attachment type of the 3D fragment: 

 “Fix by Fragment LCS” - is the 3D fragment attachment transformation in which the 

fragment LCS was used as the source coordinates.  

 “Fix by Assembly LCS” - is the 3D fragment attachment transformation in which the source 

coordinate system was created on the fly in the transparent mode when inserting the 3D 

fragment.  

 “Fix by Workplane” - is the 3D fragment attachment transformation in which the attachment 

is defined by the 2D fragment (layout). 

 

When suppressing the transformation defining a 3D fragment attachment, the fragment model is 

positioned in the scene by snapping the 3D fragment world coordinate system to the assembly 

world coordinates.  

To disable any transformation, set the flag Suppress in its properties. The input box next to the flag check 

box allows entering numerical values or non-textual variables. The transformation is considered suppressed 

whenever the entered expression is not equal 0. 

 

3D fragments possess another special type of transformation, providing for the automatic 3D fragment 

exploding data copying from the properties of its source coordinate system. The respective chapter about 

local coordinates reads: if you plan to use a given LCS as the source coordinates for attaching a 3D 

fragment, then you can define, among its properties, the necessary translation/rotation for future 

exploding. This transformation is called Source LCS Transformation. It only becomes available, when the 

source LCS of the 3D fragment actually has those properties defined. Such transformation cannot be 

modified in any way.  

 

If the exploding transformation was not defined for the source coordinate system, then the system may 

try to automatically assign some transformations at the time of the 3D fragment creation. The numerical 

values of the offsets will be automatically calculated based on the overall dimensions of the 3D fragment 

model. A new transformation named “Transformation_<No.>” will be added to the list of existing 

transformations at this time. This transformation will have the flag Only for exploded view set. You can 

turn off the system’s automatic appending of the exploding transformations upon 3D fragment creation. 

The setting is accessible in the system options on the tab “3D” (the command Customize > Options…, the 

parameter Explode assembly (3D Fragments) automatically). 

 

A special flag Apply exploded view transformation of base elements allows exploding a given 3D 

fragment with respect to its fixing point, accounting for exploding transformation of the base elements. 

That means, turning on the flag additionally moves the fixing point of this 3D fragment per the 

transformation of the base element. 
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Creating Boolean Operation Based on 3D Fragment 
 

Just like other operations, 3D fragments can be used in 

Boolean operations. For example, you can subtract the 

body of a 3D fragment from another part. If necessary, you 

can define a property in the 3D fragment document, that 

will specify what type of the Boolean operation will be 

automatically performed upon inserting this document 

into an assembly (see the topic “Preparing a T-FLEX CAD 

document for use as a 3D fragment”). If such property is 

defined, then, upon inserting the 3D fragment, you need 

to select one of the bodies in the assembly. If the assembly 

consists of a single body, it is selected automatically. This 

body will be used as the target body in the Boolean 

operation. The tool body will be one of the bodies of the 

3D fragment, or the fragment altogether, depending on 

the property setting.  

 

The option can be useful, for example, when inserting holes into the body of a part, or in mold design, 

when subtracting the part body from the block yields the stamp or master form. 

 

The following options are used for selecting the target body of the Boolean and for undoing the selection: 

 

 <B> Select 1st body 

 <D> Cancel operand selection  

Reference Update 
Let us explain the use of the option Update fragment data. 

When inserting a 3D fragment, the system internally creates a copy of the fragment three-dimensional 

model in the assembly drawing. Upon a new regeneration of the assembly, the system no longer loads the 

3D fragment geometry data; rather, it uses the saved data. To maintain the assembly up to date, the system 

constantly tracks the file. The latter changes if the fragment file was edited and saved. If files changed, the 

system instantly offers updating the references to the documents, that is, loading new geometry data of 

the modified 3D fragments. 
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Pressing the button [Yes] refreshes the data of all 

modified fragments. If the assembly contains a 

significant number of fragments, the updating 

procedure may take significant time, even though 

only one fragment actually required update. 

Therefore, you can press the button [No] instead, 

and then select a specific fragment and refresh 

only its respective data.  

Local update of a selected 3D fragment is possible 

with the command Update of the context menu 

coming up upon right clicking  over the 3D 

fragment operation. 
 

Updating of all modified fragments can be forced 

by the command File > Fragment > Refresh Files. 

However, if some of the 3D fragment files were not 

modified, then the 3D fragments are regenerated 

neither upon the full regeneration nor upon 

refreshing the 3D fragment references. To 

guarantee the regeneration of the full assembly 

with all its member 3D fragments, use the file 

converter with the parameter set, “Don’t Check 

Documents Versions (Resave All)”. The detailed 

information on working with the converter is 

provided in the chapter “Converting Documents 

Created in Earlier Versions of T-FLEX CAD”. 
 

Preparing a T-FLEX CAD Document for Use as a 3D Fragment 

Any T-FLEX CAD document can be customized to simplify in certain circumstances its usage in assemblies 

as a 3D fragment.  

Customizing Document Status 
3D fragment tab in ST: Set Model Parameters command provides possibility to specify default LCS used 

for fragment fixing, specify type of insertion, set parameters for automatic Boolean operation. 
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Automatically create Boolean Operation 

When inserting a 3D fragment, one can automatically create a Boolean operation of a specified type. The 

target body will be the selected body in the assembly, while the tool body - one of the bodies of the 3D 

fragment, or all fragment bodies at once. 

Setting up automatic creation of Boolean operation is performed with the help of several parameters: 

Operation Type. This parameter defines the type of the Boolean operation (addition, subtraction, 

intersection) that will be created upon inserting the fragment in the assembly. The type can be 

selected from the list. 

Create operation with: 

Use the whole Model. With this option checked, the whole 3D model of the fragment will be used 

as the target body of the Boolean operation. 

Use single operation. Selecting this option makes the Boolean use just a single operation within 

the fragment. The desired operation can be selected from the list of all existing operations. 

In the case when a body is used in the Boolean, that is not visible when working with the document 

of the 3D fragment, it is possible to place it in a special layer marked as “Visible only when model 

is used as a Fragment”. 

Let’s review an example of automatic creation of a Boolean operation on inserting a fragment. Suppose, 

there is a 3D model of a building wall, and we need to insert a window in it as a fragment. To do so, let’s 

create the window model in a special way. Create a tool block as a dummy for cutting the opening in the 

wall for inserting the window. Then call the “Insertion of 3D Model as Fragment” dialog box (see above). 

Set the operation type – Subtraction, Use single operation. From the list of operations select the one that 

created the tool block. 



Three-dimensional modeling 

850 

         

 

3D Fragment 

Fragment name. This parameter defines the name with which the fragment will be displayed in the 

assembly’s model tree. 

 

Folder Name. This parameter specifies the name of the folder into which the fragment will be placed in 

the assembly’s model tree. 

 

Fragment’s name and folder’s name are read from the fragment’s file only upon creation of the new 

fragment. If the values of these parameters are changed, then upon update of the fragment in the 

assembly the name and the folder will remain the same. 

Type of Insertion. From the drop-down list one of the options can be selected: 

 

 Standard. Upon insertion into the assembly the translation of the fragment is possible only with 

the help of the manipulator of LCS  (dynamic translation is disabled); 

 

 Fastener. When inserted into the assembly the fragment dynamically moves after the cursor of 

the mouse; 

 

 3D Placement. This method of insertion is used for quick creation of the arrangement in 3D scene. 

In the fragment’s file special attachments to the floor, walls, ceiling, horizontal surfaces must be 

created. These attachments are defined by means of connectors with the specific parameters; 

 

 By points. A fragment can be fixed to the selected in the 3D scene points upon insertion. Its size 

changes according to the distance between the points. 

 

 Smart fragment (macro). This method of insertion is used for parametric fragments whose 

insertion scenario is described in the program (macro) stored directly in the file of the given 

fragment or in the external module (DLL). When inserting the file as a fragment the user-specified 

macro will be executed. 
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 “Default LCS used for Fragment fixing” is selected from the list. The list contains all local coordinate 

systems of the model that have the flag “Use for Fragment insertion” set. When inserting such document 

as a 3D fragment, the thus defined coordinate system will be automatically offered as the source LCS. 

 

If necessary, the permitted degrees of freedom can be set in the properties of the prepared coordinate 

system, which will insure the correct behavior of the given 3D fragment in an assembly in the mode of 

moving mated elements (see the chapter “Mates and degrees of freedom”). 

 

For uncomplicated parts, which can be conveniently inserted into the assembly in the mode of dynamic 

snapping, the given mode can be turned by default. 

 

Insert 3D fragment on layer. This parameter defines the name of the layer onto which the fragment will 

be placed upon its insertion into the assembly. If in the fragment’s document the “Insert on layer” 

parameter is enabled, but upon insertion of the fragment into the assembly this layer does not yet exist, 

then this layer is created automatically upon request. 

Don’t show the message “Fragment doesn’t have bodies”. By default this parameter is disabled. In this 

case the system does not allow for insertion, into the 3D assembly, of the fragment in which the 3D model 

is absent or suppressed. The corresponding message in the diagnostics window appears as comments. 

When this flag is enabled the system allows for insertion of “empty” fragment without issuing any 

messages. 

You can define options for section views on 2D projections on the Sections tab. 

 

For some models (future components of assemblies) it can be helpful to define special settings for 

preventing their cutting when used in section views of 2D projections. For example it is known that bolts 

should not be cut on section views of assembly drawings. This option will help to avoid time consuming 

manual customization of 2D projection parameters for assemblies that contain such parts. 

 

New condition can be created with the help of  button. Section Application Condition section will 

appear with the lists of conditions and LCS names.  
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Conditions are organized in relation to the alleged source fragment LCS that exists in a document of a 

future 3D fragment. For example a part may remain uncut if a section plane goes through a specified axis 

of the source LCS, or coincides with one of the main LCS planes. 

Assembly Variable Definition 
You can assign an assembly variable counterpart for any external variable of the current document. This 

can be done in the case, when the external variable drives, for instance, a characteristic parameter (such 

as, say, diameter), while the assembly variable name has already been defined (for example, D). When 

assembling this document as a fragment, this assembly variable name will be automatically substituted for 

the fragment variable in the dialog for defining external variable values (provided that this variable exists 

in the assembly). 



3D Assemblies Creation 

853 

The assembly variable name can be defined in the variable editor. The command is called from the editor 

textual menu: Variable > Assembly Variable Name…. Detailed information on working with the variable 

editor is available in the chapter “Variables”. 

"TOP-DOWN"  ASSEMBLY DESIGN  

Operation Principles 

When you use "Top-down" design, you can create parts in an assembly based on the geometry of other 

parts of the assembly. This is a fundamental difference from "Bottom-up" design, where parts are edited 

separately, independently of other parts in the assembly. That's why we will see how parts in the assembly 

will contact with each other only when we have finished editing the part and updating the assembly. In 

"Top-down" design, an assembly defines the dimensions, position, and contact elements of its parts and 

subassemblies, which means that top-down design requires top-down communication: the relation 

between an assembly and assembly fragments. The relation between the assembly and the assembly 

fragments is performed by the Reference Element. Reference Element borrows geometry from assembly to 

part. The Reference Element may borrow major elements of the model and topological elements. Control 

of relations between fragments and their relations with the assembly, the fragments variations, navigation 

through the assembly are performed in "Assembly Structure" window. 

The Top-down design principle and the Reference Element mechanism allow you to solve problems that 

arise in the development of complex assemblies. For example, the user can borrow the geometry of 

elements from the elements of higher-level fragments in the assembly structure, or from fragments located 

in "parallel" subassemblies. The user can receive changes of the uploaded geometry from the source 

document or update the source document in accordance with the changes in the uploaded file at any time.  

Thanks to the Reference Element mechanism, it is possible to work effectively in a team, where each user 

performs his task. For example, when designing an excavator cab, the cab body parts are developed by 

one user, and other users do not have access to this file. The geometry of the cabin can be uploaded to a 

separate document so that several users can work in parallel.  



Three-dimensional modeling 

854 

 

 

On the basis of these unloaded elements another user can create equipment in the cabin, having full data 

on the current dimensions of the cabin. In this case, it is possible to snap to the unloaded geometry and 

update the unloaded geometry in accordance with the changes in the source file of the cabin. Then the 

changes made in the cab may be transferred to the general assembly.  
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The "Top-down" design method cannot be considered suitable for all assembly design cases. It has a 

number of limitations: 

 a more complex scheme of the organization in comparison with "Bottom-Up" method; 

 less resistance to topological changes in the 3D model; 

 parts are less convenient when using the same 3D model in different assemblies; 

 higher requirements to computer resources. 

"Top-down" and "Bottom-up" design methods can be combined. The "Bottom-up" design method is useful 

when adding standard parts to an assembly, parts with strictly defined geometry. The "Top-down" design 

method is preferably used in the design of parts and assemblies that provide interconnection and fastening 

in the assembly of structural elements that have a strictly specified geometry.  

Create Assembly Features Using "Top-down» Design 

The commands for creating assembly elements. 

 <3F> Insert 3D Fragment. Allows you to insert a fragment by LCS. It is used during "Bottom-up" 

designing. 

 <FM> Create 3D Fragment. Allows you to create a fragment in the structure of an existing 

assembly. It is used during "Top-down" designing. 

 Detail. Detail>Create and Detail > Unload. Allows you to create a fragment on the basis of a body 

in the assembly. Creates a detail file that depends on the body or fragment in the assembly. The 

command is available in the context menu of the fragment or body. 

 <3RE> Reference Element. Allows a fragment to borrow geometry from an assembly or another 

fragment. Reference elements carry out the relationship on which the principle of "Top-down" 

design is based. You can only create reference elements in the context of an assembly (except for 

internal references to resolve recursions – see the "Reference element" subsection). 

 Open in Context: The command is available in the context menu of the fragment or body. Edit in 

Context: the command is available in the Create 3D Fragment command dialog.  

 <Alt+7> Assembly Structure. The command opens the "Assembly Structure" window. The window 

is required to navigate the assembly and control assembly changes. 
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Various options of these commands, their combination when creating assembly elements, allow you to 

create assemblies with complex hierarchical relationships. Fragments can depend on both the assembly 

and other fragments in different ways, you can combine the "Top-down" design principle with the "Bottom-

up" design principle. The types of fragments and how they relate to each other and to the assembly are 

described in the section "Variations of fragments relations with assembly when designing ’Top-down’". 

Create Assembly Structure in "Assembly Structure" Window 
You can create an assembly structure both during operation and in advance. The recommended way to 

operate using "Top-down" design is to create a structure of hierarchically related fragments, and then edit 

them, starting with fragments that are independent of others, moving on to the fragments that will be built 

on the basis of those that have already been created. It is difficult to fully guess the final structure, so you 

can create only part of it, and to supplement the structure in the process. 

To create a hierarchical assembly structure, you should create an assembly file.  

 

Then you should save the assembly file. Open the Assembly Structure <Alt+7> Assembly Structure 

window. 

 

Next, in the "Assembly Structure" window, you should call the context menu for the created file. 
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Select the Create 3D Fragment command. In the appeared dialog, specify the name, and do not enable 

Edit in Context option, because first you need to create the assembly structure. You can edit the fragments 

both in context and not in the context of the Assembly later, when the user begins designing. After you 

finish working with the fragment creation dialog, the fragment file will be saved in the specified folder. By 

default, the new fragment file will be saved to the folder where the Assembly file is located. 
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Working with the fragment creation dialog is described in the corresponding section below.  

Similarly, by calling Create 3D Fragment command from the context menu, you can create a structure of 

any complexity for the fragment for which you want to create a nested fragment. 
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After you have finished creating the structure, you need to save the main Assembly file in which you worked 

to create the structure. Next, you need to fill the fragments with geometry. This should be done in the 

context of the Assembly if you want to create Reference Elements.  

Working in Context of Assembly 
When you edit a fragment in the context of an Assembly, the 3D scene of the fragment is combined with 

the 3D scene of the Assembly from which the fragment editing in the context was invoked. 3D scenes are 

combined with the transformations that the fragment received in the Assembly. While operating in the 

context of an Assembly, we are in a fragment file. All the changes we make only affect the fragment file. 

The 3D Model window displays the construction elements a fragment file. "Assembly Structure" window 

shows the structure branch starting from the Assembly in the context of which you are working. Working 

in the context of an Assembly has two main functions. 

 It allows you to understand the position and dimensions of the fragment directly in the Assembly. 
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 It allows you to create Reference Elements. 

The main tool for linking an Assembly to fragments in "Top - down" design is the Reference Element. 

Reference Elements can be created automatically or manually. More information about the cases in which 

a reference element is created automatically is written in the "Reference Elements" subsection. You only 

need to create reference elements manually in the context of an Assembly using <3RE> Reference 

Elements command.  

In order to open a fragment in the context of an Assembly, you need to double click   on it in "Assembly 

Structure" window or in the context menu of the fragment to choose the  Open in Context command. 

The context menu of the fragment can be called in the "3D Model" window or in the "Assembly Structure" 

window. 

 

The fragment will be opened in the context of the Assembly we are in when we call edit a fragment 

in context. The "Assembly Structure" window displays the Assembly structure starting with the 

Assembly we are in when we call the open command in the context of the Assembly. 

When you open a fragment in the context of an Assembly, all Assembly constructions will be semi-

transparent, except for the body of the edited fragment. In the upper right corner of the 3D scene, you will 

see a menu with the most important commands in the context.  
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Apply 

 
Cancel (exit without saving changes) 

 
Select Assembly Elements 

 Create geometric adaptive parameters for reference element 

 
Reference Geometry Source  

The edit mode in the context of an assembly is primarily required to create reference elements, that's why 

Select Assembly Elements, Create geometric adaptive parameters for reference element, and Reference 

Geometry Source options refer to the creation of reference elements. 

If the  option is active (icon on a blue background), then during the creation of the geometry of the 

fragment, constructions of the assembly will be available. It can be constructions related to the fragments 

of subassemblies a level lower, and to fragments of the same level as the edited fragment, and to fragments 
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a higher level. In other words, all build constructions regardless of which fragments or bodies they belong 

to. 

If a construction from the assembly was chosen to perform any operation when editing a fragment 

in the context of the assembly, a Reference Element will be automatically created for this geometry. 

The options for creating reference elements with automatic updating and selection of a source document 

will be described in the subsection “Reference Element”. 

Exit context with saving  (Apply). When editing a fragment in the context of an assembly, we work in a 

fragment file. If we exit context, we close the fragment file. We can close the file with saving or without 

saving changes. If we exit without saving - then you need to use the icon  (Cancel). Saving when 

working in context, with the command <Ctrl+S> Save – will save the fragment file. To save an assembly, 

you need to exit the context and save assembly. 

All assemblies of the upper level, which includes the fragment edited in the context of the assembly, will 

be marked in italics in "Assembly structure" window. This will simplify the search for the edited fragment. 

 

Filling an Assembly with Geometry 
As mentioned above, when working with assemblies "Top-down", design is performed from an assembly 

to its parts. The part geometry is defined by a set of parts included into the assembly. That is, the geometry 

of some parts is determined by others, taking into account their position in the assembly. As a rule, there 

are parts or subassemblies that do not depend on other parts – these are parts of large frameworks, various 

cases, frames, fuselages, etc. This details should be created first. They will fill the assembly with geometry, 

on the basis of which it will be possible to design from assembly to parts.  

Consider a simple example. You should design a Box, the geometry of the Box Body is determined by the 

required volume, dimensions, wall thickness and method of the cover fixing. Box Body defines all other 

parts of the assembly, while other parts do not affect the geometry of the Box Body, respectively, the 

design of the Box should start with the "Box Body" part. Create an assembly, which is a fragment of the 

Box Body. There are two ways to do this. 

 Create a new document from "3D Model" prototype and build a Box Body, then create another 

document of the "3D Model"  prototype (Box file) and set the fragment Box Body into an assembly 

Box using the command <3F> 3D Insert Fragment.  

 Create a new document from the "3D Model" prototype, then use <FM> Create 3D Fragment 

command to create a new fragment, and then create a box Body in the context of the assembly or 

not in the context of the assembly (in this case it does not matter, because Box Body does not 
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depend on other constructions). Before you create a case, you can create the entire Box assembly 

structure at once. 

The first method corresponds to "Bottom-up" principle of design, the second to "Top-down" principle. In 

this case, both the first and the second way will lead us to exactly the same result. In General, when you 

create assemblies, you can apply both design principles at the same time. 

Let's use the second method. Create an assembly file. Save it and call it "Box". Select command <FM> 

Create 3D Fragment. In the appeared dialog box, enter the description of the part, or Part Number, or 

both. Working with the fragment creation dialog is described in the "Fragment creation dialog" section 

below. Select the "3D Model" prototype. The Edit in Context flag can be omitted, because there are no 

other bodies in the assembly at the moment and there is no need to create reference elements for the 

body. 
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After clicking "OK " you are still in the "Box Body" file. In the "Assembly Structure" window is shown that a 

fragment has appeared in the assembly. Its icon  indicates that the fragment is not adaptive. To edit a 

fragment, open its context menu and select Open. In the file there are no constructions, the coordinate 

system of the file coincides with the coordinate system of the assembly. Create a body Box Body on the 

basis of the primitives or by creating the required standard workplanes. 

 

 

Two Basic Ways to Create Parts in Assembly 
Creating a primary hierarchy of subassemblies and parts is already considered above. The recommended 

and convenient way to work is to create an empty detail file using the <FM> Create 3D Fragment 

command, and then fill it with geometry and create Reference Elements in the context of the assembly. In 

T-FLEX CAD terminology, in General, any subassembly and any part is called a fragment. Therefore, the 

creation of the fragment may mean the creation of subassemblies and the creation of the part (if there are 

no other parts in the part).  

It may happen that you need to create a fragment based on the body in the fragment for the correct 

assembly structure. The fragment with the body will become an assembly, the created fragment - a part in 

the assembly. The fragment with the body may already contain other fragments, i.e. already be an 

assembly. To create a part based on a body in a fragment, there is a set of options for the Detail > Create 

command. This is the second way to create parts in "Top-down" design. Consider these two ways to create 

parts in a simple example. 
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Create Detail Using the Create 3D Fragment Command 

We have already discussed the command <FM> Create 3D Fragment in the previous section, now let's 

look at how to use it to create a fragment that will depend on the assembly by reference elements.  

Create a Box Cover for Box Body. Go to the assembly file "Box" (creation of which is described in the 

previous section). Select the Create 3D Fragment command. 

 

If you set the Edit in Context flag in the appeared dialog, then after saving the file to disk, the created 

fragment will be automatically opened in the context of the assembly. Then all the elements that are 

currently in the assembly will be available for constructions creation. In this case, only the geometry of the 

"Box Body" fragment will be available, because there are no other fragments in the assembly yet.  
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We want to set the relationship between Box Body and Box Cover: between the upper face of the body, its 

centering edge and the mate parts on the cover. This should be done using Reference Elements. You need 

to create Reference Elements in the context of the assembly – so specify the Edit in Context flag.  

In the create fragment dialog specify the name of the file and select the prototype "3D Model". 

In the "Fragment Name" field, change the default name to "3D Fragment_2", because in our case the box 

Cover fragment will be the second in the assembly. In General, the logic of naming fragments in the 

assembly is up to the user, because neither the formation of the assembly structure nor the structure of 

the part is affected by the name of the fragment. 

Since the Edit in Context flag was specified, the assembly geometry will become semi-transparent, and a 

special panel will appear in the upper right corner of the 3D scene to control the main options of the 

fragment in the context of the assembly.  
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In the Ribbon, on the "Assembly" tab, select the <3RE> Reference Element command (more information 

about this command can be found in the "Reference Element" subsection). Select two faces of Box Body: 

the top defines the centering edge of the body, the bottom – the surface on which the cover leans. In the 

command properties window, you can see a list of faces. To expand the list of reference elements, click the 

icon next to the field indicating the number of reference elements. 
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The Create geometric adaptive parameters option flag means that the created reference element will be 

placed in the geometric parameters of the fragment, and the edited fragment will become adaptive. Create 

Geometric adaptive parameters is only possible when specifying the source geometry in the assembly. 

If the option flag Do not update geometry when recalculating is not set, the Reference Elements will be 

automatically updated when you recalculate the references from the "Assembly Structure" window.  

 

Geometry Source - Assembly (for more information about variants, see the subsection "Geometry Source"). 

If a Reference Element is created between the assembly and the first level fragment (as in this case, because 

we specified Geometry Source: Assembly) the default reference will be the geometric parameter, and 

when recalculating the assembly will change the fragment without updating the Reference Elements, but 

only in the assembly. The geometry of the fragment inside its file will remain unchanged until the link is 

updated: manually or through the "Assembly Structure" window. You can learn more about the options for 

linking fragments to an assembly in the corresponding section below. 



3D Assemblies Creation 

869 

Click the icon  to exit the fragment editing in the context of the assembly with saving the changes in 

the fragment file. 

It is important to pay attention to the "Assembly Structure" window. The icon of the fragment Box Cover 

 differs from the icon  of the Box Body . The box Cover fragment is adaptive, because it has geometric 

parameters, the Box Body fragment is non-adaptive, because do not contain the geometric parameters. 

 

Further creation of the box Cover geometry can be carried out both in the context of the assembly and 

simply by opening the fragment file. On the basis of reference geometry, you need to use three-

dimensional modeling commands to create a Box Cover geometry.  

 

If you work with the fragment file in the context of the assembly, it is better to disable the Select Assembly 

Elements  option. In this case you will not create links accidentally. After the completion of the 

constructions creation you should exit the context of an assembly by clicking the icon . 

If you create the fragment geometry outside the context of the assembly, you should update the assembly 

after you save the fragment file. When you open the assembly file, in the dialog that appears automatically 

when you edit and save the assembly fragments, you must specify the update of the assembly. 
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Now, to explain the work of Reference Elements and Geometric Parameters, let's change the geometry of 

the Box Body. 

Open the fragment "Box Body". You can open a fragment in the context of an assembly or simply open 

the fragment file. Open the fragment in the context of the assembly. To do this, in the "Assembly Structure" 

window, call the fragment using  . Change the length of the Box Body. 
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A fragment of Box Body has changed its length, Box Cover-did not, because the assembly does not know 

about the changes. Only after we leave the context  the changes in the box Body fragment will be 

saved. After leaving the context, you are back in the Box assembly file. In the assembly file, the reference 

to the Box Body file is automatically updated,and the assembly will already have the modified body 

geometry. The Box Cover fragment automatically changed the geometry, and Box Cover corresponds 

exactly to the new geometry of the case: after we changed the length of the container body - the source 

geometry of the adaptive reference elements was rebuilt, and a new value was assigned to the geometric 

parameters of the box Cover fragment in the assembly.  

Open the Box Cover file separately. In the Box Cover file, the geometry has not changed (if we open the 

cover fragment in the context of the assembly, its geometry in the assembly will be displayed, not the 

geometry in the source file). This behavior of the fragment is caused by the fact that its reference elements 

are geometric parameters, which means that the geometric parameters in the assembly will be set 

according to the values of the geometric parameters in the assembly, and in the source file geometric 

parameters will have the value before the changes. In this case, the Reference Element, which is a geometric 

parameter, behaves as an External Variable that can take a value in the assembly other than the value that 

takes in the source file.  
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When creating Reference Elements, you did not specify the Do not update geometry when recalculating 

option flag - then you can update the Reference Elements through the "Assembly Structure" window. You 

can update all links, but only in a separate fragment. In this case, there is no difference, because only one 

fragment of the assembly contains reference elements.   

 

Open the Box Cover fragment file again. 



3D Assemblies Creation 

873 

 

Reference Elements were updated (a new version of the source geometry was borrowed), the Box Cover 

geometry was automatically recalculated and saved. 

 

Create Detail Using Detail > Create Command 

One of the features of the Detail > Create command is to create a detail based on the bodies in the source 

file. The source file will become an assembly for the created detail. 

Let's continue with the example of Box creation. Let's consider the user has built the body of Box Clip in 

the file Box Cover. We do not recommend this way, but it is acceptable. 

 

 

It is necessary that the box Cover fragment contain only one body – Body Cover, and the Body Clip and all 

related constructions should be in a separate file. In addition, the Body Clip should be a fragment in the 

Box Cover file. 

Call the context menu for the Body Clip using . Select the Create command.   
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The create detail dialog is described in detail in the "Create detail dialog" section. You need to specify Part 

Number and Description (or fill in only one of the fields). By default, the new file will be saved to the folder 

where the file in which we use the Create command is located. Select the way to create an adaptive 

fragment (Create Adaptive Fragment), so that the created fragment of Box Clip is also adaptive (like the 

fragment of Box Cover) and contains reference elements in the geometric parameters. 

 

As a result, a fragment appeared in the "Assembly 

Structure" window and the "3D Model" window of 

the Box Cover file. The fragment has a Reference 

Element for those builds that cannot be retrieved 

from the source file. A fragment of Box Clip has an 

icon  of adaptive fragment, which has geometric 

parameters. The geometric Parameters of this 

fragment can be seen in the corresponding tab of the 

"Assembly Structure" window. Automatically created 

reference elements are added to the geometric 

parameters, because you have specified the option 

of an adaptive fragment creation.  
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The Geometric Parameters Tab. 

 

When you use the Detail > Create command, the generated fragment relative to the original assembly will 

always be a fragment of the first level, so its reference elements will always be geometric parameters, in a 

case that we have chosen the option of creating an adaptive fragment. 

In the general case there are several options of how a detail is created on the basis of the body of the 

assembly. 

 Reference Elements will be created (see "Automatic creation of reference elements" for details). 

 Derived objects will be created (see "Automatic creation of Derived objects" for details). 

 Both Reference Elements and Derived objects will be created. 

 Neither Reference Elements nor Derived objects will be created. This will happen if the body can be 

completely extracted from the assembly. 

As you can see in the "Assembly Structure" window of the Box Cover file, after executing the Detail > 

Create command, the resulting structure is similar to the one we got in the previous case when we used 

the method of creating a detail in the context of the assembly. However, in this case, the reference element 

was created automatically.  

The ability to receive a detail with automatically created reference elements and fully editable model 

tree in the detail file, after it was built in the assembly is used to correct the user error, when user 
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creates bodies in the assembly file. Therefore, using the command Detail > Create instead of the 

command Create 3D Fragment using references is not recommended. 

When you save a body in a separate file and rearrange it in the assembly, Reference Elements and (or) 

Derived objects are automatically created, the number of which and the geometry contained in them we 

do not control when creating.  

When you try to select a complex body from the assembly as an adaptive fragment, recursions may 

occur that will be eliminated by additional internal Reference Elements or by creating additional 

subassemblies.  

Detailed information about troubleshooting recursions with the help of reference elements you can find 

out in the section "Eliminationg recursions using reference elements". 

"Top-down" design requires the user to understand the dependencies of the fragments on each other, it 

is not recommended to use methods to create fragments that complicate the understanding of the 

relationships in the assembly and complicate the structure of references in the assembly. 

The created fragment in the general 

assembly "Box" became a fragment of the 

second level. For fragments of the second 

level (and below) in the "Assembly 

Structure" window, you cannot see the 

geometric parameters, but we can see the 

reference elements. 

If you create a fragment using the 

command Detail > Create, an update is 

available for its automatically created 

reference elements during recalculation. 

Therefore, the fragments created in this 

way will update the geometry in the 

fragment file when you update the 

references from the "Assembly Structure" 

window.   
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Tab of geometrical parameters. 

 

If you make changes to the geometry source reference elements in the assembly "Box" that will change 

the geometry of the fragment "Box Cover" (because the Cover is a fragment of the first adaptive level for 

general assembly). The fragment "Box Clip" will also change his position and (or) the geometry, because it 

is adaptive relative to the assembly "Box Cover". 
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You can create a serial chain of adaptive fragments "Assembly → Fragment of the first level" where 

each subsequent fragment has a reference element a level higher in the geometric parameters. 

Multi-level Assemblies 
In the previous section, on the example of creating a chain of adaptive fragments, you have already seen 

an example of creating a second level part. However, the above example is an example where each 

subsequent fragment is created in the context of an assembly a level higher. This is not always possible. 

For example, if we want to create a second-level part (or lower), we need to rely not only on the geometry 

of the subassembly at a higher level, but also on the assembly at two or more levels higher. There are two 

main ways to create multi-level assemblies. 

 Create an assembly structure in the Assembly Structure window by using the <FM> Create 3D 

Fragment command (see "Creating an assembly structure") and then work with the selected 

fragment in the context of the general assembly. 

 Create first-level fragment chains by creating and editing fragments only in the context of an 

assembly at a higher level (see "Two basic ways to create parts in an assembly"). In this way, you 

can create adaptive fragment assemblies. 

Since the example of creating a chain of fragments of the first level were  already considered above, now 

let's consider an example of working with fragments in the context of the assembly at two or more levels 

above. 

Create a Box Clip in the context of the general Box assembly. We assume that the structure of the assembly, 

in which the clip is a part of the assembly unit Box Cover is preferable for us, but to create a Box Clip is 

more convenient for us both on the basis of the faces of Box Cover, and on the basis of the faces of Box 

Body. Both fragments (Box Body and Box Cover) are available only in the general Box assembly. 

Open the previously created Box assembly. The assembly already contains fragments of Box Body and Box 

Cover, and the fragment of Box Cover is an adaptive fragment of the first level. Create a Box Clip part in 

the Box Cover subassembly. To create a part in a subassembly, you need to open the context menu of the 

selection fragment, in which you can select the Create 3D Fragment command. Call the context menu of 
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the Box Cover fragment. Select the Create 3D Fragment command, its dialog window appears. Enter 

Description: Box Clip, enable the option Edit in Context flag . Editing will be performed in the context of 

the assembly in which we are at the moment. In our case, the created fragment will be opened in the 

context of the Box assembly. For the Box assembly, the created fragment is a second-level fragment. 

 

In the "Assembly Structure" window we can see the resulting structure: the generated fragment is a second-

level fragment for the assembly in the context of which we are editing the fragment. The chain of 

fragments, from the edited fragment to the assembly, is italicized. This way of representation allows you 

to better understand the position of the edited fragment in the general hierarchy. 
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Create Reference Elements. Choose two faces on the Box Cover and the two faces of the Box Body. Two 

faces on the Box Cover will set the position of the clip axis and its width. The two faces of the Box Body are 

the dimensions of the groove. That is, you just need to create four reference elements. Reference elements 

are created using the Reference Element command. 

 

 

The default settings will be used: specify the creation of geometric adaptive parameters and specify the 

source of geometry in the assembly file, i.e. the source geometry will be located in the "Box" file. Create 

links and exit editing in the context of the assembly with saving . 

In the assembly structure, you can see that the fragment has four reference elements. The file of the source 

geometry for them is a "Box" file, at the same time, despite the chosen option, the geometric parameters 

of the reference elements were not included. This is because the assembly part is a second level fragment, 

and the creation of geometric adaptive parameters is only available for the "Assembly → first-level 

fragment" relationship. 
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Building a Box Clip on the basis of reference geometry can be done both in the context of the assembly 

and not. When working in the context of an assembly, it is recommended to disable the Select assembly 

Elements (the icon  should not be active) option so as not to create random reference elements. After 

the completion of the constructions creation you should exit the context of an assembly by clicking the 

icon . 

If you create the fragment geometry outside the context of the assembly, you should update the assembly 

after you save the fragment file. In the dialog box that appears automatically when you change the 

assembly fragments, you should specify the update of the assembly, when you open the assembly file. 
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Here is a comparative example of changing the fragments of the first level (containing a reference element 

in the geometric parameters) and the second level (not containing reference elements in the geometric 

parameters). 

Change, as before, the length of the Box. The length of the Box depends on the length of the Box Body. 

Decrease the length of the Box Body. 

 

Box Cover is an adaptive fragment and changed its geometry only in the assembly. In the fragment file, 

the geometry remained unchanged until we update the reference elements. Box Clip is a non-adaptive 

fragment (without geometric parameters) and remained unchanged. Update the reference elements for 

the entire model. 
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Confirm the update and save. References have been updated. The geometry of the Box Clip has changed 

in both the assembly and the fragment file. The "Box Cover" fragment file has also changed its geometry. 

 

Assembly Unit Creation 
This command (Create Subassembly) is available in the assembly Structure window and in the context 

menu of the fragments selected in the "3D Model" window. This command allows you to change the 

hierarchy of fragments in the assembly structure: place the fragments in the subassembly by changing 

their level to n-1, where n is the current fragment level.  
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In the "Assembly Structure" window, select the fragments to be placed in a separate subassembly and click 

the Actions  icon, select the Create Subassembly command from the list of commands.   

 

The create detail dialog box appears (for more information, see "Detail creation dialog"). To create a new 

assembly unit, select the option Create Fragment. 
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You can see the assembly structure changes in the "3D Model" Window The selected fragments moved to 

a lower level, and a new assembly unit appeared in their place. 

 

The fragments in the new subassembly will retain their transformations according to the assembly from 

which they were placed in the new subassembly. Reference elements will retain the source of reference 

geometry (Geometry Source) and the source parameters of the document (Documents Get Parameters 

from). 

If the fragment moved to the level down was adaptive to the assembly (subassembly), it will cease to be 

adaptive, because the link "Assembly → fragment of the first level" will be broken. 

Parts That Do Not Depend on Assembly 
The design principle of "Top-down" implies the dependence of the parts from the assembly. However, this 

dependence is not always possible. For example, you may know exactly which geometry elements of one 

fragment will define the elements of another, but  you don't know in which assembly you can make them 

dependent on each other. Such a case is possible when the final structure of the assembly is not yet clear, 

or it is hidden because of the secrecy. Then you can assign a link not through the assembly, but directly 

between the files. In any case, you should specify the link between the fragments via the assembly file. But 

in this case it can be temporary. An example of the use of the temporary assembly files can be viewed in 

the section about transformations of the fragment in the assembly. 

Keep in mind that the use of temporary assemblies, or the unavailability of the assembly when 

editing fragments, should be caused by a real production or design need. In all other cases, it is not 

recommended to apply the temporary assembly and remove the assemblies. The very concept of 

"Top-down" design implies the presence of an assembly that defines all the parts included in it. 

Let's consider the case when the "Box Cover" fragment depends on the geometry of the Box Body 

regardless of the Box assembly. Suppose we have an assembly "Box", in which one fragment is "Box Body". 

Create a new fragment "Box Cover" with the command <FM> Create 3D Fragment, and enable its editing 

in the context of the assembly. Create two reference elements using the <3RE> Reference Element 

command: select the top face that defines the fixing edge and the face on which the cover will rest. In the 

properties window, specify Geometry Source: initial fragment. 
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Exit the context of the assembly with saving . Check through the "Assembly Structure" window how 

the reference elements were created. From the "Assembly Structure" window, you can see that the 

fragment "Box Cover" has two referenced elements. After selecting the update option from the source 

fragment (in this case we could choose the update option from the fragment of the first level, because the 

result would be the same), we specified that Geometry Source is in the "Box Body" file. Source parameters 

(Get Parameters from the Document) is always the assembly file in the context of which the reference 

element was created,  (you can find detailed information in the section about transformations of the 

fragment in the assembly). 

 

When creating a reference element, you did not specify that the geometry source is in the assembly (you 

did not select the Geometry Source option: assembly). In the reference element there is no "assembly → 

fragment of the first level" link and the reference element was not included in the geometric parameters, 

i.e. the generated fragment is not adaptive. As you can see, the Create geometric adaptive parameters 
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for reference element option is not available when you change the geometry source from assembly variant 

to another variant. 

 

Let's create a Box Cover geometry based on the created reference elements. 

If we change the "Box Body" fragment, the "Box Cover" fragment will convert its geometry according to 

Box Body changes only after updating the reference elements. You can do it in the "Assembly Structure" 

window, as shown earlier. 

When the source geometry does not depend on the assembly file, we can delete the assembly file, 

the fragments will not lose their links via the reference elements.  

For example, delete the file "Box" and create a new 

assembly file "Box 2". Insert fragments "Cover 

Box" and "Box Body" into using the <3F> 3D 

Insert Fragment command. 

In the "Assembly Structure" window of the new 

"Box 2" assembly, you can see that the "Box 

Cover" fragment as before contains reference 

elements whose geometry source is the "Box 

Body" fragment. 

 

The source of the document parameters (Get Document Parameters from) is still the deleted "Box" file. 

This means that if we needed to move, rotate, or scale a fragment for correct positioning in the assembly, 

we would have to do it again. In this case, no transformation parameters were passed from the remote 

assembly to the fragment, because we did not move or scale the fragments in the assembly.  
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Change the length of the Box Body in the new "Box 2" assembly, and update the reference elements 

through the "Assembly Structure" window. 

 

The new assembly file "Box 2" has been updated as if we were working in the original assembly file "Box". 

Unload Geometry with Possibility of Subsequent Updates 
If the body was created in an assembly (subassembly of any level), you can unload it by making a part. To 

do this, select the Detail command in the context menu of the body. You should select the third or fourth 

option of the body unload in the Detail > Unload command, for a fragment to be created as a fragment 

with a geometric parameters, but without reference elements 

 Unload a detail (the Detail>Unload command) with the option Create Part Operation (Save Solid 

to File that can be updated when assembly changes). 

 Unload part (the Detail>Unload command) with the Create Associative Part Operation (Save Solid 

to File and replace it with Fragment Operation) option. 
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The build tree is not available in the fragment files created by the third or fourth variant of the 

Unload command. The geometry in the files is an external model. You can edit the geometry of the 

fragments only when you change the geometry of the body in the assembly file. The possibility to 

edit fragment files after they are created on the basis of bodies in the assembly is given by the 

Detail > Create command.  

It is rational to apply the options for the creation of fragments in the assembly described in this subsection 

in the case, when unloading the body using the command Detail > Create leads to recursions (more 

information about recursions and their removing can be found in the section "Eliminating recursions using 

reference elements"). The other case is when you want to make a part dependent on an assembly without 

using reference elements. 

The two ways for creating fragments are not recommended if the fragments you are creating are 

subassemblies. 

Again consider the example, when 

we designed the Box Clip in the Box 

Cover file fragment and want  to 

create a fragment based on Box 

Clip body (this example was already 

discussed in the section "Create 

details using Detail > Create 

command"). 

Call the context menu of the Body 

Clip body and select the command 

Detail > Unload. 

 

 

In the appeared dialog, specify the Create Part Operation (Save Solid to File that can be updated when 

assembly changes) option. The principle of entering the name of the file and the choice of the prototype 

is similar to the principle when working with dialog of fragment creation. In the "Unload Dialog" section 

you can see a brief information about this dialog. 
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As a result of the command, an adaptive fragment will appear. In the "3D Model" window you can see that 

an adaptive fragment appeared in the Body Clip body structure. 

 

A fragment of the first level also appeared in the "Assembly Structure" window of the "Box Cover" file. This 

fragment contains geometric parameter "Imported Solid_1" and does not contain reference elements.  

 

The Reference Elements Tab. 

 

The presence of the "Imported Solid_1" geometric parameter provides the link of the "Box Clip" fragment 

file with the "Box Cover" assembly, i.e. the link with the file from which the geometry was unloaded. You 

can transfer changes made to the source body in the assembly file to the fragment file. To do this, select 

the Update command.  

Only changes made for operations, which are located in the body tree before unloading, will be 

transferred to the fragment file.  

For example, we can change the length of the Box Clip by changing the profile of the extrusion operation, 

which is located before unloading. After changing the geometry of the clip body, call the Update command 

via the context menu. 
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After executing the Update command, the fragment file will be updated according to the body changes in 

the assembly and saved. 

 

You cannot transfer changes in the geometry of the body, performed due to operations that are in the 

body tree after unloading, to the fragment file. For example, if we make a hole in the Body Clip and the 

operation is located after unloading, the Update command will not pass the changes to the fragment file.   
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We can add operations in an unloaded tree of the body. To do this, call the context menu of the last 

operation of the body and select the Rollback Model command. Call a rollback command for the Body 

Clip. 



3D Assemblies Creation 

893 

 

 

Add a hole to the Box Clip geometry. As you can see from the picture, hole was added to the tree of body 

operations. To finish editing the body, you need to call the context menu for body operations or call the 

context menu in the free space of the 3D scene, and select Finish Rollback. 
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A hole created in this way can be passed to the fragment. To do this, select the Detail > Update command 

in the context menu of the clip body. The fragment file will be updated, modified according to the 

assembly, and saved. 

 

We can pass the changes made in the fragment to the assembly. To do this, use the command Detail > 

Restore Associativity.  

Make a hole in the Box Clip, not in the assembly, but in the fragment file. To do this, open the Box Clip 

fragment file and make a hole in it, then save the fragment file. In the "Box Cover" assembly, call the 

command Detail > Restore Associativity in the context menu of the Body Clip body. 

 

As a result of the operation, the changes made in the fragment will be transferred to the assembly. 
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The Detail > Restore Associativity command will be available in the context menu only if changes have 

been made to the fragment file.  

Consider the fourth option to unload Create Associative Part Operation (Save Solid to File and replace it 

with Fragment Operation).  

As in the previous case, call the command Unload through the context menu of the Body Clip body in the 

assembly, but this time specify the fourth option. 
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Displaying the created fragment in the "3D Model" and "Assembly Structure" windows is similar to the 

previous variant of unloading. 

As in the previous case, the fragment has no reference elements and has a geometric parameter ("Imported 

Solid_1"). The Geometric parameter connects the fragment with the assembly. 

As in the previous case, the generated fragment has a link only to the assembly file from which it was 

unloaded. 
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As in the previous case, we can make changes to the body operations that were created before the unload 

and then use the Update command to upload them to the fragment file. 

As in the previous case, we can add operations to the body tree before unloading – using the Rollback 

Model command.  

Unlike the previous unload option, changes made to the fragment will be automatically transferred to the 

assembly. That is, to update the assembly according to the changes in the fragment file, we do not need to 

use the command Detail > Restore Associativity. 

Make changes to the clip fragment: create a hole, then save the fragment. If you open the file "Box Cover" 

then, as in the case of changing all the fragments, you will be asked about updating the assembly. After 

the update is confirmed, the fragment in the assembly will be updated.  

 

Re-insert Part 
Through the "Assembly Structure" window, you can specify to re-insert a part or subassembly.  

Any fragment of any level will be re-inserted as a fragment of the first level for the assembly file 

that we are currently editing.   

Let's continue the example with the Box assembly. We need to insert the Box Clip to all remaining positions. 

A fragment of Box Clip is a fragment of the second level within the subassembly "Box Cover". If we want 

the "Box Clip" fragment to be a second-level fragment included in the "Box Cover" subassembly when re-

inserting, we need to open the "Box Cover" fragment. If we want to position the fragment "Box Clip" only 

on the basis of binding to the geometry of the cover – you can just open the fragment file "Box Cover". If 

you want to bind to all elements of the general assembly when positioning the clip, you should open the 

"Box Cover" fragment in the context of the "Box" assembly. All elements of the general assembly, to which 

was bind a fragment of the "Box Clip", will be reference elements for "Box Cover" fragment.   

Let’s consider both cases. 

Open the "Box" file, open the "Box" fragment in the context of the Box assembly. Turn off the selection of 

assembly elements by making the icon  inactive. In this case, the binding will be only to the cover 

elements.  

In the "Assembly Structure" window, call the context menu for the "Box Clip" fragment and choose the 

Additional>Repeat insertion command. 
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Next, according to the LCS insertion principle, as for the "Bottom-up" assembly, determine the position of 

the fragment. Specify the source LCS on the axis of the Box Clip and the target LCS at the axis of the Box 

Cover foot. Turn around the axes to determine the correct position of the Box Clip. 
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Exit the context of the assembly with saving . The second fragment of the second level appeared in the 

"Assembly Structure" window. It has a link to the same source file of the "Box Clip" fragment and the same 

reference elements, because reference elements belong to the source file of the fragment. 
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Once again, open the "Box Cover" fragment in the context of the assembly. Now turn on the selection of 

assembly elements, by making the icon  active. In the "Assembly Structure" window, use the context 

menu of the fragment to specify re-insertion. Select the source LCS at the top of the rectangular Box Clip 

hole, and the target LCS at the top of the Box Body edge (that is, the assembly element in which you are 

working). Rotations around the axes determine the correct position of the clip. 

 

In the "Assembly Structure" window you can see that a new fragment of Box Clip has appeared. It is 

important to note that the fragment "Box Cover" has a new reference element. This reference element was 

created automatically when the vertex was selected to specify the target LCS when the fragment was 

inserted. Since the vertices of the edge Box Body in the fragment "Box Cover" is not present, it should be 

borrowed from the assembly. A corresponding reference element was created. 



3D Assemblies Creation 

901 

 

Since the "Box Cover" fragment is a first-level fragment of the assembly, the new reference element is also 

a geometric parameter of the fragment. 

 

Detail Duplicate 
The Detail > Duplicate command is available in the context menu of each fragment. The duplicate makes 

both a copy of the fragment in the assembly, with all the values of its parameters (External Variables and 

Geometric Parameters), and a copy of the source file on the disk, also with all the values of the parameters. 

That is, it creates two identical links in the assembly: "fragment in assembly → source fragment file", storing 

parameter values both in the assembly and in the source file. 

Considered an example. You have the Housing assembly, where you already placed all the screws D4хL6. 

Each fragment has the same source file "Pan Head Cross Recess Screw ISO 7045". In addition, there is one 

screw D5хL8, and it also has a source file - "Pan Head Cross Recess Screw ISO 7045".  
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The file "Pan Head Cross Recess Screw ISO 7045" has external variables. The values of variables in the 

source file and in the fragments of screws D4хL6 and screw D5хL8 are different. Create a duplicate link 

"Fragment Screw D5хL8 → Pan Head Cross Recess Screw ISO 7045.grb". To do this, call the context menu 

of the D5хL8 screw fragment in the "Assembly Structure" window. Select the command Detail > Duplicate. 

 

A dialog box appears in which you specify the name of the new source file and its location. 

 

As a result, a new fragment was created, exactly repeating the original, and a new source file, also exactly 

repeating all the parameters of the duplicate. 
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A new fragment will have the same location in the assembly as the original, i.e. in this case, there will be 

two screws in a hole. The position of the fragment, as well as all its parameters, can be changed. 

Positioning, Scaling, and Variation of Fragments in Assembly (Fragment 

Transformations) 
In "Top-down" design, a reference element is created in the context of an assembly based on the geometry 

of the fragments, taking into account the transformations of the fragment in the assembly (i.e., its 

movements, rotations, scaling, and the values of its parameters). Accordingly, each reference element 

needs to "know" not only the Source Geometry but also "know" the transformation of the source-geometry 

in the assembly. Information about the transformations of the fragment, on the basis of the geometry of 

which the reference element was created, is located in the assembly file, since it is the assembly that 

determines the position and execution of all fragments. Therefore, for each reference element, you specify 

not only the source file where the Geometry Source is located, but also the assembly file in the context of 

which the reference element was created. For a reference element, the assembly file is the source of the 

document parameters (Get Document Parameters from).  

The source of the document parameters (Get Document Parameters from) will always be the 

assembly file in the context of which the reference element was created. 

Considered an example. We have the Holder assembly. For example, while you do not understand exactly 

how it should be located Bracket on the Support and do not understand what should be the length of the 

Bracket. Therefore, you set the length of the Bracket using external variable, and the Bracket in the assembly 

is located approximately. 
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You need to design a Hanger. Let's create two Reference Elements that will be edges of Bracket holes. 

Since you have only approximate assembly, then you should specify the file, which will contain the source 

geometry – a fragment of the bracket. To do this, we specify Geometry Source: initial fragment.  

 
 

As a result, the created fragment will have a geometry source of reference elements in the "Bracket" file, 

and the source (Get Document Parameters from) of parameters (transformations) of the fragment will be 

an assembly file "Holder". 
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Let's create a Hanger geometry. 
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Suppose that our assembly was incorrect. The length of 

the Bracket should be different, and its location also 

need to be changed. Create a new "Corrected Holder" 

assembly. 

In the new assembly change the position of the Bracket 

and change its length by changing the value of the 

external variable, which determines the length of the 

Bracket. Insert the fragment "Hanger". 

The fragment will be located according to the location 

in the old assembly. In addition, since the fragment 

"Bracket" changed its geometry only in the assembly 

(according to the value of the external variable), and in 

the source file remained the original length, the Hanger 

is not located correctly along the Support and along the 

Bracket. 

 

 

The example shows that the geometric reference itself is preserved, but the fragment "Hanger" has no 

information about transformations of a fragment of "Bracket" in the new assembly, because  the assembly 

file "Holder" remained the source (Get from Document Parameters) of parameters (transformations) of the 

fragment. 
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This example only shows the importance of the information contained in the assembly. Keep in 

mind that the use of temporary assemblies, or the unavailability of the assembly when editing 

fragments, should be caused by a real production or design need. In all other cases, it is not 

recommended to apply the temporary assembly and remove the assemblies. The very concept of 

"Top-down" design implies the presence of an assembly that defines all the parts included in it. 

Variations of Fragments Relations with Assembly when Designing "Top-down" 
When designing "Top-down", the fragments should depend on the assembly. In T-FLEX CAD, there are 

three mechanisms by which such a relation can be made: 

 Reference Element, 

 Geometric Parameter, 

 External Variable. 

External variables and geometric parameters of adaptive fragments can be used in the "Bottom-up" design, 

and are not a new feature of T-FLEX CAD. The use of external variables and adaptive fragments is described 

in the appropriate subsections: "Parametric relation definition" and "Adaptive 3D Fragments".  

Creating a Reference Element is a feature of T-FLEX CAD that is specifically designed to provide link from 

assembly to fragments (or directly between fragments). The reference element can be placed in the 

geometric parameter of the fragment – then such a fragment becomes adaptive.  

The presence of a Reference Element in the Geometric Parameter makes it possible to receive a new 

adaptive fragment variation when changing the geometry in the assembly, without updating the reference 

elements in the fragment files. 

Consider the possible combinations of reference elements and geometric parameters of the fragments in 

the "Top-down" design.  

 The fragment is non-adaptive, without reference elements (a frequent case when a fragment is 

inserted into an assembly on a "Bottom-up" design basis with the use of LCS). 
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 The fragment is adaptive, containing reference elements in geometric parameters (a frequent case 

when working with fragments of the first level). 

 Adaptive fragment containing geometric parameters (outdated methods of detail unloading) 

 Adaptive fragment containing reference elements both in geometric parameters and reference 

elements not in geometric parameters (a common case when working with fragments in the context 

of different assemblies). 

 The fragment is non-adaptive, containing reference elements (a frequent case when working with 

fragments of the second and deeper levels). 

In the assembly Structure and 3D model Windows, fragments with geometric parameters are specified 

using a special icon. 

The presence or absence of geometric parameters of fragments of the second and lower levels cannot be 

seen in the "Assembly Structure" window. To do this, use the 3D model window, or open a fragment in the 

context of the subassembly for which it is a fragment of the first level.  

 Non-adaptive Fragment or Fragment Containing Only Reference Elements 

 Adaptive fragment containing geometric parameters or reference elements in geometric 

parameters 

 The second and lower level fragment in the "Assembly Structure" window 

External variables of the fragment, its geometrical parameters and reference elements can be seen in the 

"Assembly Structure" window.  
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If the fragment was not created as adaptive, it can be made adaptive by adding a geometric 

parameter.  

If the fragment was created without reference elements, you can add them by opening the fragment 

in the context of the assembly and using the <3RE> Reference Element command. 

If a fragment does not have reference elements in geometric parameters, you can create them by 

opening the fragment in the context of the assembly in which it is a fragment of the first level and 

using the <3RE> Reference Element command.  

Any fragment can be made non–adaptive. To do so, you need to delete all its geometric parameters. 

In other words, we can change the variants of the fragment dependence on the assembly.  

Reference elements-cannot be removed, because they are based on the body of the fragment.  

You can prevent a reference element from being updated (either when it is created, or later through its 

context menu in the "3D model" window).In this case the fragment will behave as a fragment without a 

reference element, since further borrowing of the source geometry for the reference will be prohibited. 

A non-adaptive fragments without reference elements are files with geometry elements (or even without 

them) that do not have Geometric Parameters. 

You can create a non-adaptive fragment without reference elements  in the following ways: 

 Using the <FM > Create a 3D fragment command without using reference elements or other 

geometric parameters of the fragment. 

 Use the Detail > Create command with the Create Fragment option. A construction should not 

depend on other constructions in the assembly.  

 <3F> 3D Insert Fragment is a standard command when designing "Bottom-up". 
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Non-adaptive fragments without reference elements should be created only if the part is not going to 

change. The created fragment should be the main one in the assembly, all other fragments should depend 

on it, and the fragment itself should not depend on changes in other fragments. In the case when changes 

in the assembly are made using "Bottom-up" design.  

The fragment is adaptive and contains reference elements in geometric parameters. Such a fragment can be 

created if the reference element automatically is automatically added to the geometric parameters – 

detailed information is given in the "Reference element in geometric parameters" section. 

The geometric parameters of any adaptive fragment can be seen in the properties window of the 3D 

Fragment command. To call this command for an already created fragment, you can select Edit from 

the fragment context menu. 

 

The fragment is adaptive, containing geometrical parameters. This type of fragment provides a link only 

between the assembly and the first level fragment.  

When designing "Top-down", the primary binding element of the assembly is the reference element. You 

can also use other tools to link a fragment to an assembly: variables and geometric parameters. As 

mentioned above, a reference element can be a geometric parameter, but in this case we consider a 

fragment that does not contain reference elements at all, but contains only geometric parameters. The 

case when during "Top-down" designing the fragment has no reference elements, but has geometric 

parameters can occur if: 

 the user select the last two options of the Detail > Unload command;  
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 the user calls the <FM> Create 3D Fragment command, but does not create reference elements, 

and using the <3U> Adaptive Fragment command, creates geometric parameters for the fragment;  

 the user uses the Bottom-up design principle and inserts a fragment (<3F> Insert 3D Fragment) 

that is created as an adaptive Fragment (<3U> Adaptive Fragment). 

The adaptive fragment is adaptive and contains reference elements in the geometric parameters and in the 

reference elements not in the geometric parameters. Fragments, in which part of the reference elements 

were in the geometric parameters, and part is not is a possible case. Such fragments can be created as 

follows. 

 If you create reference elements for a fragment in the context of different assemblies, one of which 

is a fragment of the first level. 

 When you edit a fragment in the context of an assembly for which the fragment is a first-level 

fragment, you specify Geometry Source in the assembly for part of the reference elements, and 

specify Geometry Source in the assembly for part in the fragments. 

 When you create a reference element in a context of any other assembly (it is not the assembly, 

where the fragment was created) for a fragment received using the Detail > Create command with 

Create Adaptive Fragment option. 

You must remember that adaptive fragments change their geometry according to the value of the 

geometric parameters in the assembly, so the execution of the geometry in the fragment file and the 

execution of the fragment in the assembly may differ. If you want a fragment that has a reference element 

not in geometric parameters, to change its geometry in the assembly, you must update the reference 

element in the fragment file. Accordingly, those reference elements that are in the geometric parameters 

of the fragment will change the geometry of the fragment without updating the references in the fragment 

file, and those that are not in the geometric parameters will change the geometry of the fragment only 

after the update. 

If a fragment contains a part of the references in the geometric parameters, and some – out of 

geometrical parameters, it should be understood that simultaneously two different communication 

methods of a fragment and the assembly are used. If you change the source geometry of reference 

elements you should take care of the changes order and order of the reference elements updates . 
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If you have problems updating the geometry of a 

fragment, you can remove the reference element 

from the geometry parameters. 

To remove a reference element from the 

geometric parameters, open the fragment's 

context menu (via the "3D model" window or the 

"Assembly Structure" window) and select  Edit. 

You should expand the "Geometric parameters" 

tab in the properties window of the fragment and 

delete the geometrical parameter by pressing  

icon. 

 

      

Non-adaptive fragment with reference elements. This variant of the fragment is one of the most common. 

This fragment can be created in the following cases: 

 the user creates a fragment in the context of an assembly for which the fragment is a second-level 

fragment or lower; 

 the user specifies the source geometry not in the assembly, but in the fragments; 

 the user cancels the Create geometric adaptive parameters option when creating a reference 

element; 

 the user selected the Create Fragment option in the Detail > Create command; 

 the user removed reference elements from the geometric parameters of the fragment.  

 

Dialogs for Fragment and Detail creation and Geometry Unload 
Fragment Creation Dialog 

A dialog for a fragment creation appears when you invoke the Create a 3D Fragment command. 

 

Icon Ribbon 

 

Assembly → Assembly → Create 3D Fragment 

Keyboard Textual Menu 

<FM> File > Fragment > Create 3D Fragment 
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Fragment Prototype: "ANSI 3D Model", "ANSI Drawing", "ANSI Sheet Metal Part", "ISO 3D Model", "ISO 

Drawing", "ISO Sheet Metal Part" affects the default commands in the Ribbon and the standard. You can 

switch commands in the Ribbon.   

Part Number and Description automatically generate a file name on disk. You can configure file name 

creation. To do this, click the icon  in the "Name" field and a special "Naming rule" dialog appears. Using 

the icon , you can update the file name according to the selected name rule. 

 

By default, the file will be saved to the folder where the assembly file is located.  

Fragment Name. Defines the first part of the fragment name in the assembly when the fragment is 

displayed in the "3D model" and "Assembly Structure" Windows. The fragment name and file name create 

the full name of the fragment in the assembly. 

Edit in Context. Setting this flag combines the 3D scene of the edited fragment with the 3D scene of the 

assembly in which the file was called for editing. The choice of assembly features for fragment edition is 

available in the context of the assembly. 

Detail Creation Dialog 

The detail creation dialog can be opened for any body (multiple bodies) or fragment via the context menu. 

 

Icon Context menu 

 

Detail > Create 

Keyboard Ribbon and Textual menu 

 Not provided 
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The command allows you to create a fragment based on a body (or multiple bodies) in an assembly, and 

assembly units based on fragments. The command also allows you to open a body or fragment in a 

separate document. 

 You can select a body and place it in a fragment. 

 You can select multiple bodies and place them in a fragment. The selected bodies will be moved to 

the fragment. 

 You can select multiple bodies and a single fragment and place them in the fragment. The selected 

bodies and the selected fragment are transferred to the fragment. 

 If you want to put several fragments in a separate fragment in the assembly, i.e. to create a build 

unit, this action can be performed using the "Assembly Structure” window: Create Subassembly, or 

via the context menu: Subassembly > Create (see section "Assembly unit creation"). The command 

for assembly units creation will be carried out through the fragment creation dialog.  
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Prototype. The option affects the default commands in the Ribbon and the standard. You can switch 

commands in the Ribbon.  

Part Number and Description. The options are similar to the fragment creation dialog. 

Do Not Save. This option allows you to open a body or fragment in a separate document. If necessary, you 

can save the viewed document with <Ctrl+S> Save. 

Create Fragment. The body to which you applied the Create Fragment command is replaced with a 

fragment with a separate source file. All body model tree is moved into the fragment file. If necessary, 

reference element and (or) derived objects will be created (see "Reference element" section for details). 
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Create Adaptive Fragment. The body to which we applied the Create Adaptive Fragment command is 

replaced with a fragment with a separate source file. All body model  tree is moved into the fragment file. 

If reference elements are created during the command execution, they will be added into the geometric 

parameters of the fragment. 

If you create an adaptive fragment (Create Adaptive Fragment) from a body (or bodies), and the 

body can be completely transferred from the source file to the generated fragment file, reference 

elements will not be created. Accordingly, the geometric parameters of the fragment will not be 

created, and the fragment will be non-adaptive.  

Any fragment created with the Detail > Create command (both Create Fragment and Create Adaptive 

Fragment) can then be edited in the context of the assembly and reference elements can be created with 

the <3RE> Reference Element command.  

Open Saved Document. If the flag is enabled, after selecting Create Fragment or Create Adaptive 

Fragment, the created fragment will be opened in T-FLEX CAD.  

Additional options for creating fragments are available in the drop-down list. 

 

Assembly document parameters. When this option is enabled, all parameters from the assembly 

document (the document from which the body is placed in the fragment) that are set in the ST: Document 

Parameters command are passed to the part (the fragment to be created) . 

External variables. When this option is enabled, all variables from the assembly file are passed to the part 

(the created fragment). 

Geometry of the assembly document. This option is used for fragments created in the context of an 

assembly or adaptive fragments. Allows you to unload changes of the geometry on the basis of which a 

fragment was created in the context of an assembly or adaptive fragment. For example, an adaptive 

fragment was added to an assembly. If you have added an adaptive fragment and the geometry of its 

associated features has changed, you can upload the changes to the detail file. If the flag is disabled, the 

part is created based on the geometry that existed when the adaptive fragment was inserted. 

Supplement from assembly document. Allows you to immediately move a fragment or body supplements 

from the assembly to the detail. For example, a fragment was added to an assembly and a hole was made 

in it. The supplement option has been activated for this hole. This supplement can be transferred to the 

part file with the fragment. 

Combine initial operations. If a fragment contains several bodies, they can be combined into one body 

from the assembly. For example, if the bodies of a fragment were supplemented in an assembly in such a 
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way that elements of different bodies were used in the same command, such supplement cannot be 

transferred to the fragment without combining the bodies. 

Unloading Dialog 

The dialog of the detail unloading command can be called for any single body or a single fragment via the 

context menu. 

 

Icon Context menu 

 

Detail > Unload 

Keyboard Ribbon and Textual menu 

 Not provided 

 

 

There are four options for unloading are available in the dialog.  
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The first and second variants of unloading are considered in the section "Save geometry from assembly in 

separate file". 

The third and fourth variants of unloading are considered in the subsection "Unload geometry with 

possibility of subsequent updates".  

Part Number and Description. The options are similar to the fragment creation dialog. 
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Reference Element 

The reference element in the fragment is an element, which constructions tree is not available. The 

constructions tree of the source geometry of the reference element is in another fragment file. This file will 

be called a geometry source file (Geometry Source). Reference Elements allow you to borrow three-

dimensional objects geometry to perform subsequent operations on the edited assembly fragment. The 

basic elements of the model (3D nodes, coordinate systems, workplanes, 3D profiles, 3D paths, bodies of 

various types), and topological elements (edges, faces, vertexes) can be borrowed. 

As mentioned above, a reference element should be created only in the context of the assembly (except 

when you want to create an internal reference to eliminate recursion). 

 

Icon Ribbon 

 

Assembly → Assembly → Reference Element 

Keyboard Textual Menu 

<3RE>  

 

The command allows you to create a top-down relationship, between an assembly and a fragment, or 

between fragments, through geometry borrowed by a fragment from an assembly, or one fragment from 

another fragment.  

Reference Element Creation  
To create a reference element, you should call fragment editing in the context of the assembly (see 

"Working in context of assembly"). Call the <3RE> Reference Element command. Select any available 

assembly element or group of elements. In the "Model Elements" window, you can see the created 

elements list. To expand the list of reference elements, click the icon next to the field indicating the number 

of reference elements. 

 

In the "Reference Parameters" tab you can add a reference element after or before the current one with 

the help of icons  and  correspondingly. Using the icon , you can delete the selected reference 

element, using the icon  you can delete all selected elements. 

When you create a reference element, you should specify: 

 Is it required or not to update the geometry in the recalculation (see section "Updating of reference 

element”); 
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 Is it required or not to create geometric adaptive parameters (for more information, see “Reference 

element in geometric parameters”); 

 The source of the geometry, that is, specify how to update the reference element (for more 

information, see "Geometry source"). 

 

Complete the creation of the reference element using the icon  or <Ctrl+Enter>. 

The reference element always has the source geometry located outside of the fragment (except for internal 

references, eliminating the recursion). Reference elements cannot change their geometry, they can only 

borrow geometry, according to a reference to another file that contains the source geometry. The source 

geometry can be changed in the file where it is located, then the reference element needs to be updated. 

It borrows a new variation of the source geometry.  

Reference elements of the fragment can be seen in the "Assembly Structure" window. The name of the 

geometry to the reference element, the name of the file which contains the source geometry and the file 

name of the source document settings (Get Parameters from the Documents) are shown in the "Reference 

Elements" tab. In this case, the transformation parameters are meant (you can read more in the section 

"Positioning, scaling and variation of fragments in assembly"). The parameter source file is always the 

assembly in the context of which the reference elements of the fragment were created. The source 

geometry file (Geometry Source) you choose when you create a reference element. 
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You can see the reference elements of the fragment in the "3D model" window of the assembly. If the 

assembly is a file that contains the source geometry, you can also see the source geometry of the reference 

element in the "3D model" window. 

 

A reference element can be seen in the "3D model" window of the fragment. 
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Updating of Reference Elements 
You can update reference elements from the "Assembly Structure" window of an assembly, or from a 

subassembly, and only the reference elements that are included in that subassembly will be updated. You 

can update the reference elements of all the fragments in the assembly (subassembly). 

 

You can also update the reference elements of a specific fragment. To do this, select the fragment and 

select the command shown in the figure. 
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You can update one specific reference element only in the "3D model" window of the fragment file that 

contains the reference element by calling the Update Geometry command in the context menu of the 

reference element.  

You can update reference elements through the "Assembly Structure" window only if the reference element 

does not have an option: Do not update geometry when recalculating. If the option is active for the 

reference element, the reference element need to be updated independently. You should use the Update 

the Geometry command in the context menu of the reference element in the "3D model" of the fragment 

file containing the reference element.  
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When creating a reference element, you may or may not specify the Do not update geometry when 

recalculating option. By default this option is not active. When automatically creating reference elements 

using the Detail > Create command, the option is not active.  

By default, all reference elements (except internal references) are created with the ability to update 

when recalculating. 

The Do not update geometry when recalculating option is available in the parameters of the reference 

element when it is created.  
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If you activate the option, the reference element will be fixed and can only be updated manually via the 

context menu of the reference element in the "3D model" window. 

In the 3D model window of the fragment file, you can find out whether its reference element is fixed or 

not. The fixed elements have a different icon (with a picture of a pushbutton), and the Do not update 

geometry when recalculating option is active in the context menu.   

The reference element is fixed: 

 the icon has a 

pushbutton; 

 the Do not update 

geometry when 

recalculating option is 

active. 

This reference element can only 

be updated manually. 

 

Reference element is not fixed: 

 The icon is normal, 

without pushbutton; 

 The Do not update 

geometry when 

recalculating option is not 

active. 

This reference element can be 

updated through the "Assembly 

Structure" window. 

 

Geometry Source 
In order to determine which file will contain the source geometry of the reference element, you need to 

specify one of three options: 

 Assembly, 

 Fragment of first level, 

 Initial fragment. 
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The Fragment of first level is set by default. 

If you specify not set when you select a file that contains the source geometry of the reference element, 

the selected element in the context of the assembly will be used upon the fragment construction, but will 

be fixed and cannot be updated. 

As mentioned above, a reference element can only be created in the context of an assembly. To do this, 

open the assembly file, and then through the "Assembly Structure" window open the fragment for editing 

(for more details, see "Working in context of assembly"). In the "Assembly Structure" window, we see only 

those fragments that are included in the assembly. The entire structure above (if we opened the 

subassembly file) will not be visible to us, neither in the scene nor in the "Assembly Structure" window, and 

do not affect the creation of reference element. 

 

In this case, we mean the current hierarchy of fragments, which determines which file on the disk should 

be accessed in the future to find the source geometry of the reference element. This option is valid only 

once, when creating a reference element. If the file containing the source geometry has a different 
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hierarchy in the final assembly, the system will find it. If the file is deleted, the link will not be updated, 

because the source geometry will not be found.  

Assume that the source geometry to which a reference element refers upon update was specified in the 

assembly. No geometry is created directly in the assembly, all geometry in the assembly is determined by 

the fragments that are included in it. This means that in order for the source geometry of the reference 

element to be available in the assembly, it must contain the fragment in which the source geometry is 

located. Therefore, if you remove a fragment from the assembly, the source geometry will not be found by 

the reference element when you update.  

The edit panel in the context of the assembly (upper 

right corner of the 3D scene) duplicates the option 

to specify the selection of the file containing the 

geometry source.  

 

You should carefully monitor this option when automatically creating reference elements in the 

context of an assembly. 

Automatic Creation of Reference Elements 
Reference elements will be created automatically in two cases. 

 If you edit a fragment in the context of an assembly with the enabled selection of assembly 

elements  (Select assembly Elements), and an assembly element was used during execution of 

any command.   

 If we use the Detail > Create command for the body in the assembly. 

When automatically creating reference elements, the Do not update geometry when recalculating option 

is not active.  

All auto-generated reference elements (except auto-generated internal links to eliminate recursion) 

will be updated during recalculation. 

If necessary, you can disable the update of the created reference element. To do this, in the context menu 

of the reference element (called in the "3D model" of the fragment file) you need to specify the flag of the 

Do not update geometry when recalculating option. 

 

When you use the Detail > Create command on a body in an assembly, reference elements will be created 

for those constructions that cannot be moved to the created fragment file. 
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If there are elements among the parent elements of a body that depend on other bodies, such parent 

elements cannot be taken from the assembly. In this case, a reference element is created. 

For example, a profile is built on the face of the body, which is the parent of the body that we want to save 

to a separate file. This profile cannot be taken from an assembly without the body on which it is built. But 

we do not need the second body in the created file. Then a reference element will be automatically created 

for the profile. In the created file, the specified profile will be a reference element. 

Reference Element in Geometric Parameters 
The presence of a reference element in the geometric parameters allows you to change the geometry in 

the assembly without updating the reference elements in the fragment files to obtain a new execution of 

the adaptive fragment. In this case, the reference element will behave as an external variable: the execution 

of the fragment in the assembly does not depend on the execution of the file fragment. Reference elements 

in geometric parameters allow you to create adaptive assemblies. If the assembly has fragments of the 

second level and below, it is possible to create a chain of adaptive fragments, as it was shown in the 

subsection "Create detail using Detail > Create command".  

The presence of reference elements in the geometric parameters of the fragment is shown in the "Assembly 

Structure" window. 

 

The reference element will be placed by default in the geometric parameters of the fragment if you create 

it in the context of the subassembly for which the fragment is a fragment of the first level (you should 

specify the geometry source in the assembly Geometry Source: assembly), while the subassembly itself, for 

a general assembly, can be a fragment of any level. If the reference element is placed in the geometric 

parameters of the fragment, then, when you change the geometry, the source of the reference element, 

the adaptive fragment will change its geometry, according to the change of the source geometry, but only 

in the assembly. At the same time, there will be no changes in the fragment file where the reference element 

is located. To change the geometry inside the fragment file, you should update the reference element 

according to the change in the source geometry. 
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The reference element will be in the geometric parameters of the fragment if it is created in the following 

ways. 

 Using the <3RE> Reference Element command. The fragment for which the reference element is 

created should be opened in the context of the assembly for which the fragment is a level 1 

fragment, and the Geometry Source: assembly , and the Create geometric adaptive parameters 

options should be specified. 

 

 When editing a fragment of the first level in the context of an assembly with the automatic creation 

of reference elements (when the option  is active and you use the assembly elements in the 

fragment constructions), the Geometry Source: Assembly and the Create geometric adaptive 

parameters options should be selected. 

 

 The reference element is created automatically when you run the Detail > Create command with 

the Create Adaptive Fragment option.  

 

You can cancel the creation of geometric adaptive parameters based on the reference element.  

To do this, disable the Create geometric adaptive parameters option flag in the Reference element 

command parameters when creating a reference.  

 



3D Assemblies Creation 

931 

Control of the Create geometric adaptive parameters option is duplicated by the icon in the panel 

available when working in the context of the assembly (upper right corner of the 3D scene). 

 

If the icon  is active - the created reference elements will be placed in the geometric parameters of the 

fragment (in the case when a source is an assembly ). IF the icon  is disabled, they will not be placed. 

You should carefully check this icon when automatically creating reference elements in the context 

of an assembly. In some cases, the adaptability of the fragments may lead to recursion. 

More information about recursions and their elimination can be found in the subsection below.  

In the case of recursion, you can remove the reference elements from the geometric parameters. To do 

this, call the context menu of the adaptive fragment and select  Edit. Next, in the "Geometric parameters" 

tab, remove the reference element from the geometric parameters using the icon  or remove all the 

geometric parameters using the icon . 

 

Derived Object 
The derived object (derived from object) allows you to transfer the geometry directly from a fragment at 

any level to the assembly file. The basic elements of the model (3D nodes, coordinate systems, workplanes, 

3D profiles, 3D paths, bodies of various types), and geometric elements (edges, faces, vertexes) can become 

derived elements.  

The derived element transfers the geometry from bottom to top. Therefore, all the principles of working 

with assemblies on the "Bottom-up" principle are valid for the derived element.  

If we change the geometry in the fragment, including the geometry referenced by the assembly, 

and then save the fragment, the geometry of the derived element will be updated when the 

assembly is updated. 

In General, an analogy can be drawn between a reference element and a derived one. A reference element 

provides a "Top-down" relationship (and a link between fragments), a derived element provides a "Bottom-

up" relationship. But since the principles of updating the reference elements and derived elements are still 

different, you should not confuse them. 
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Derived object is similar to external element (External) by the principle of operation. You need to transfer 

sequentially on all levels from subassembly to subassembly only the external element, and the derived 

element can be transferred to assembly at once.  

In an assembly, the derived element will be an element whose constructions tree is not available.  

Derived Element Creation  

The command for deriving an element is available in the context menu of any element (listed above). To 

derive an element from a fragment to an assembly (or subassembly), you should first open the assembly 

(or subassembly) file. There are two ways to select the desired fragment element to derive it into the 

required assembly. 

 Open a fragment in the context of an assembly, then open the context menu of the element by 

selecting it in the 3D scene or in the "3D model" window and specifying Derive to assembly. 

 

  

 

 In the 3D model window of the assembly file, expand the fragment constructions, find the required 

element and use its context menu to call the Derive to assembly command. 
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In the assembly file, we can see the derived elements. For an assembly, it will be a reference element, so 

the elements derived from the fragment, in the assembly file, are in the "Reference elements" folder. For a 

fragment, these are derived elements. In the "3D model" window of the assembly file, you can find a list of 

the derived elements in the corresponding folder of the fragment from which you derived the elements.  
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Automatic Creation of Derived Element 

Automatic creation of derived elements is possible when we use the command Detail > Create and create 

a fragment (both adaptive and non-adaptive).  

If there are  parent elements of other bodies among the child elements of a body (which you want to keep 

in a separate fragment) then such elements cannot simply be taken from the assembly. In this case, the 

Derived Object is created. Derived Object will depend on the fragment and will define the geometry of the 

dependent bodies in the assembly.  

For example, on a face of a body (which we want to save as a fragment), a profile is created, which is the 

parent of another body. This profile will be saved with the body to a fragment file. To ensure that the body 

dependent on the profile does not lose the parent element, a derived element will be created. The derived 

element will return the profile that is saved in the fragment file, to the assembly. 

Eliminating Recursions Using Reference Elements 
Upon creating adaptive fragments (the Detail > Create command the Create Adaptive Fragment option) 

may be a recursion if the constructions "pulled" from the assembly depends on each other. Let's explain 

this with a simple example. 

Let's say you have two boxes. Construct circle profiles on one of the faces of each of the boxes. It turns out 

that one profile is a child of the first box, and the second is a child of the second. 
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Extrude the profiles, and then subtract the resulting cylinders from parallelepipeds using Boolean 

operation. You should subtract the cylinder, created by the extrusion profile, which belongs to the first box, 

from the second box. And the cylinder, created on the profile of the second parallelepiped (box) should be 

subtracted from the first box. As a result, it turns out that each of the parallelepipeds has another 

parallelepiped as its parent and its child.  

Call the context menu for the first parallelepiped and choose the command Detail > Create. In the 

command dialog, specify the Create Adaptive Fragment option. 
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Click "OK". A dialog box with a message about recursion appears. 

 

Four variants of recursion elimination are proposed. 
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1) Do not create adaptive parameters. That is, it is proposed not to place reference elements in geometric 

parameters. Reference elements, unlike geometric parameters, are themselves recursive. Recalculation of 

fragment begins with updates of the borrowed geometry, then the rest of the constructions tree of the 

fragment is recalculated. After the fragment is recalculated, the changes appears in the Assembly. Changes 

in the geometry of a fragment causes a change in the source geometry of the reference element of the 

fragment in an assembly, . But this change will only be passed to the fragment the next time it is 

recalculated. This eliminates looping recalculations on themselves.  

In this case, the fragment will be non-adaptive. 

2) Break recursion in assembly element. In this case, an internal reference to the profile will be created 

inside the assembly file, the parent of which is the body in the assembly (the second parallelepiped). 

Therefore, for a fragment reference element, the source geometry will not be a profile in the assembly, but 

an internal reference to that profile in the assembly. Since the source geometry, for the internal reference, 

which is the source geometry for the reference element of the fragment, is in the assembly, the method 

itself is called "Break recursion in assembly". An internal reference that is updated only manually breaks the 

recursion. Since the reference is not updated when recalculating, the geometry of the reference element is 

fixed, and does not depend on the change of the parent element, and there is no recursion when 

recalculating the geometry of the adaptive fragments. For the body of the second parallelepiped, a 

reference element is also created. The source geometry of the reference element is the profile of the first 

parallelepiped derived from the fragment. For the first parallelepiped such element is called derived. 

The fragment will be adaptive in this case: there will be a reference element in its geometric parameters. 
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The internal reference that breaks the recursion is updated only manually. You cannot update it 

from the "Assembly Structure" window. 

You can find out that the internal link is fixed and is not automatically updated by its icon with the image 

of a pushbutton button. To update a link, open its context menu and select Update geometry.  

3) Break recursion in reference element. In this case, an internal reference to the reference element will 

be created inside the assembly file. The source geometry of the reference element is the profile of the 

fragment of the first parallelepiped. For the fragment, such element is called derived. Since the source 

geometry of the reference element to which the internal reference is created, is in the fragment, the method 

itself is called "Break recursion in detail". An internal reference that is updated only manually breaks the 

recursion. At the same time, the fragment itself also has a reference element. The source geometry for the 

reference element is a profile, whose parent element is the second parallelepiped. The body of the 

parallelepiped is in the assembly.  

As in the previous version of the recursion elimination, the created fragment will be adaptive: there will be 

a reference element in its geometric parameters. 
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4) Add depended object to the detail. In this case, the generated fragment will contain both bodies and 

will be non-adaptive (an assembly unit will be created). 

The user himself can eliminate recursions with the help of internal reference elements. To create an internal 

reference element, you need to call the <3RE> Reference Element command while in the edited file (not 

in the context of any assembly) and select the model element from the 3D scene or model tree in the "3D 

model" window.  

Assembly Structure Window 

The "Assembly structure" window provides functionality for managing the multilevel structure of the 

assembly model. Information is presented in the form of a tree structure. When you select assembly 

elements, a list of their variables, geometry, and references is displayed. The Open in Context option is 

available for assembly elements of any level: through the context menu or by double-clicking on the 
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assembly element. All geometry borrowed from other files is displayed on the Reference Elements tab. 

The create 3D Fragment context menu command is available at any level of the assembly structure. The 

command allows you to set the basic parameters of the new assembly component, and, if necessary, go 

directly to its editing in the context of the assembly. Any selected assembly element will be highlighted in 

the 3D scene. 

 

Icon Ribbon 

 

Assembly → Component Links → Assembly Structure 

Keyboard Textual Menu 

<Alt+7> Customize > Tool Windows > Assembly Structure 

 

The top bar of the "Assembly Structure" window allows you to execute commands, customize the display 

of assembly elements, and perform search. 

 

Icon  (Update) updates the assembly structure: displays new items, updates information about item 

relevance, and so on. 

The icon  (Filter) opens the filters menu. You can use filters to customize the display of object types. 

 

The icon  (Actions) opens the menu of possible actions (see the subsection below for details). 

The icon  (Group by Links) changes from the structure display to the references display and back. 

The search bar allows you to find the desired assembly element by its designation, name or fragment 

name. 

 

The icon  (Options) opens the settings menu, where you can choose to display the desired columns (see 

subsection below for details) and customize the display of the options panel. 
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Actions in "Assembly Structure" Window 
The following actions are available in the "Assembly Structure" window: 

 

Update Links. The option updates links to the file fragments. If changes have been made and saved in the 

fragment, the "Assembly Structure" window will show it. An icon  will appear in front of the fragment . 

The icon indicates that you need to update the reference to the fragment file so that the changes made in 

the fragment appear in the assembly. After the Update Links command is executed, the icon will change 

and the assembly will show the changes made in the fragment. 

 

Update Linked Details. If in an assembly, a body or fragment has been saved to a separate file with the 

ability to update (for more information, see "Save geometry with update possibility"), then you can update 

the geometry of the saved details, according to the changes in the assembly, using this command:  
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Create subassembly. The command places the selected fragments in a separate new file with the ability to 

substitute the created assembly unit into the assembly (for more information, see "Assembly unit 

creation"). The new fragment file is part of the assembly structure. 

Update Reference Element Geometry. The command will update all reference elements in the specified 

fragment, recalculate the fragment completely, and save it. 

Update Geometry of all Reference Elements. The command will update all the reference elements of all 

the assembly fragments, completely recalculate the fragments and save them. 

Update Assembly. The command will consequently save all of the fragments from the fragments of the 

lower levels to the upper ones. The command is used to consequently update all changes in fragments 

and save them in all subassemblies.  

Refresh Files. The command will update and save files of adaptive fragment and fragments with external 

variables according to their variations in the assembly.  

If there is a fragment in the assembly, which has multiple variations due to geometric parameters or 

external variables, then when this command is executed, the last of the created variations will be 

substituted inside the fragment file. 

The command is not suitable for creating a detailing if the assembly has fragments with multiple 

executions, i.e. with different values of geometric parameters and external variables. 

Report. Creates a file in the "str" format (you can open it with any program that allows you to open files in 

the "txt" format) The file contains a full path and external variables of each fragment. 

Save All. Saves all the fragments currently open in the system. 

Group by Links 
The "Assembly Structure" window displays the assembly structure by default: that is, the number of parts 

and subassemblies (fragments in an assembly) and their nesting level. 
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An assembly structure may contain many executions of a fragment that has one source file that it 

references. For example, the assembly shown in the figure consists of 14 fragments, and it took only 6 files 

to create it. One of the files is the assembly "Housing.grb". The "Link" column displays links between 

fragments. The figure shows that all screws (except one) in the assembly refer to a single file "Pan Head 

Cross Recess Screw ISO 7045". You can display an assembly not by its structure, but by its references. I.e. 

show the number of source files and which parts refer to these files. To do this, click the icon  (Group by 

Links) on the top panel of the "Assembly Structure" window.  

 

The "Assembly Structure" window now shows the source files. Each file contains links of fragments in the 

assembly to it. Let's open the nested links. 
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You can return the structure display by pressing the icon  again. 

Columns 
There are 15 columns available in the "Assembly Structure" window. Seven of the columns are displayed 

by default. The "Object" column is the main one, and always displayed in this window. The figure shows 

which columns are displayed by default. 
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Link. The column shows the file referenced by the assembly element. 

File Type. The column specifies the file extension. The column is needed to understand whether the 

assembly element is a T-FLEX CAD document or an external model of other formats ("stp", "igs", etc.). 

Link Type. The columns shows type of the link - external or internal. The link is called external when the 

file is saved separately from the assembly. The link is called internal is when the file is attached to the 

assembly file. 

Full Path. The column displays the full path to the assembly element.  

Actuality. The column shows the relevance of an item in the assembly with respect to geometry updates 

in the source file. Icon  - indicates that the link is not current and you need to update the element in 

the assembly. Icon  - indicates that the file is not found. 

Object Type. The column shows the type of an object to which the assembly structure element belongs 

(3D fragment, document parameters, external references, standard elements). 

Modified. The icon  indicates the presence of changes in the assembly element file. 

Mass. The column shows the mass of the detail or subassembly (depending on whether the item is a 

subassembly or a detail) 

Number of Bodies. Specifies the number of fragments and/or bodies within the assembly structure 

element. 

Descriptions. Shows the Descriptions that you specified when creating the assembly element in the 

fragment or detail dialog box. 
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Part Number. Shows the Part Number you specified when creating the assembly element in the fragment 

or deetail dialog box. 

Saved. The icon  - indicates that there are unsaved changes in the assembly element file.  

Visibility in Assembly. Clicking the icon  makes the assembly element invisible. Pressing the icon again 

shows the element in the 3D scene again. 

Transparency in Assembly. Clicking the icon  makes the assembly element transparent. Repeated click 

returns the original display of the element in the 3D scene. 

Parameters Toolbar 
By default, the Parameters Toolbar is located at the bottom of the "Assembly Structure" window. Three 

tabs are available in the options pane for each assembly item. 

Reference Elements. The column shows the number of reference elements in the fragment, the name of 

the reference elements, the source file for the geometry of the reference elements, and the source file for 

the parameters of the reference elements.  

 

Geometric Parameters. In this tab, geometric parameters will be shown for the adaptive fragments. 

 

Variables. If the fragment has External Variables, they will be shown in this tab.  

 

3D  FRAGMENT SUPPLEMENT  

If you have two or more fragments in an assembly that have the same source file, but you want to supply 

the geometry of only one of these fragments, you can supply the geometry of the fragment in the 

assembly. It is important to change the geometry of a fragment in the assembly file without having to edit 

the fragment in the context of the assembly. If you go to edit a fragment in the context of an assembly, we 

will change the source file of the fragment, which means you will change the geometry of all fragments in 

the assembly that refer to the edited file. 
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In the case when you need to supply the geometry of only one fragment of several that have one 

source file – editing mode in the context of the assembly is not suitable. 

Using the 3D geometry build commands, you need to modify the fragment in the assembly file, and then 

re-insert the modified fragment into the assembly using the Detail > Create command with the Create 

Fragment option (or the Create Adaptive Fragment option if you want to place possible reference 

elements in the geometric parameters of the fragment).  

Creation of Body on the Basis of Fragment 

In an assembly, you can apply all available operations to the fragment geometry. In this case, a new body 

is created in the assembly, the construction tree of which will include a fragment. The resulting body can 

be saved to a separate file and automatically inserted as a fragment.  

Considered an example. In the "Box Cover" assembly, there are six identical fragments Box Clip, having one 

source file "Box Clip.grb". 
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Modify the geometry of one of the Box Clip: Make one Clip longer than the Box and add a hole with the 

help of 3D modeling commands. As a result, a new body appeared in the assembly. The edited fragment 

is included into the model tree. 

  

Now re-insert the modified fragment into the assembly. Call the context menu  for the created body 

fragment and choose the Detail > Create command. 

 

The system will ask about the option to save the fragment file.  

 

If you apply, and use the fragment as a workpiece – then operations performed in the assembly will be 

added to the model tree of the fragment file (inside the new fragment file you will get the model tree with 

new operations done in the assembly file). If necessary, reference elements are automatically created. If 

the answer is negative, then the model tree from the assembly will be moved to a new body file: the model 

tree of the created fragment file contains the fragment that was edited in the assembly.  



3D Assemblies Creation 

949 

 

Lets transfer the operations made for the fragment in the assembly-to the fragment model tree (answer 

yes). 

 

In the appeared detail creation dialog (which we have already discussed), specify Create Fragment and 

enter its Description. 

 

As a result of the command execution, a new fragment was created and automatically added to the 

assembly. In the "Assembly Structure" window you can see that instead of the old one, there is a new clip 

fragment with the original file "New Clip.grb". 
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Operations performed in the assembly were added to the model tree of the new fragment. Also, the 

fragment has new, automatically created, reference elements. Reference elements were created for those 

parent elements of operations from the assembly that cannot be transferred from the fragment assembly 

(for more information about automatically created reference elements, see the "Reference element" 

section). 
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Supplement in Special Mode 

You can rework the fragment in the assembly in a special mode: 3D fragment supply mode  option . 

This option is available in the automenu of commands, which can be applied to the fragment: Hole, Blend, 

Boolean (the first operand must be an editable fragment), Rib, Cut, Face Taper, Apply material, Simplify, 

Deformation. 

The3D fragment supplement mode option allows you to avoid creation of the bodies in the assembly on 

the basis of fragments. Starting from the 16th version of T-FLEX CAD there is an opportunity to create a 

fragment based on the body in the assembly, with saving a fragment of the whole constructions tree in 

the file (command Detail > Create). So that this option can be considered outdated.  

For stable operation of the system, it is not recommended to mix the two ways of the fragments 

reworking: standard editing of a fragment in the assembly and editing using 3D fragment 

supplement mode mode. 

As in the previous case, after rework, the fragment can be re-inserted into the assembly. This is necessary 

if you want to create a new source file of the fragment that contains the changes made to the assembly in 

the mode of the 3D fragment supplement mode option. To do this, use the command Detail > Create 

with the option Create Fragment.  

Consider the example of the Box Cover assembly. Add a hole to one of the Box Clip fragments. Call the 

<3H > Hole command. Select a face on the Box Clip fragment.  

 

Once the system has determined that the command is being executed for a fragment, the <Num0> 3D 

fragment supply mode option  icon appears in the command automenu (at the bottom). Let's make 

this option active. Enter the desired hole diameter and finish typing using  or <Ctrl+Enter>. A hole 

appeared in the fragment. In the "3D model" window of the assembly, you can see that that unlike in the 

previous case, a body based on a fragment was not created. But a folder (Supplement) will appear in the 

edited fragment. It contains information about the operations made in the rework mode. 
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You can save the supplemented fragment to a separate file and automatically move it to the assembly. Call 

the context menu for the modified fragment and choose the command Detail > Create. By analogy with 

the previous case, specify the Create Fragment option in the dialog and enter the name "Clip with Hole". 

 

In contrast to the previous version of the fragment supplement, the system will not ask about the use of 

the fragment as a workpiece, because the body was not created in the assembly, and the fragment will be 

saved in a new file with the model tree. The operations made in the assembly will be added to the model 

tree in the mode of 3D fragment supplement mode option. 

As a result of the command execution, a new fragment was created and automatically added to the 

assembly. In the "Assembly Structure" window you can see that a new fragment of Box Clip with the original 

file "Clip with Hole" will appear instead of the old. 
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In the "3D model" window of the fragment, you can see that the hole created in the assembly is added to 

the chain of the body model tree. 

 
 

The 3D fragment supplement mode option, followed by the fragment creation, allows you to achieve the 

same final result as saving the body from the assembly (created on the basis of the fragment) with the 

indication to use the fragment as a workpiece (the first method of supplement described above). The 3D 

fragment supplement mode option requires the user to be careful. it is necessary to specify this option 

when executing the command, in addition, the possibility of the 3D fragment supplement mode option is 

slightly less than the supplement of the fragment with the creation of a new body in the assembly. 

Therefore, using the 3D fragment supplement mode option when editing fragments in an assembly is less 

preferable.   

It should be remembered that any revision of a fragment in the assembly file is justified only when 

there are several fragments with one source file in the assembly, and one of the fragments needs 

to be changed. In all other cases, you should edit the fragment in the context of the assembly or 

simply edit the source fragment file. 

FRAGMENT GEOMETRY CHECK  

To check the current geometry of the fragment, use the command Detail > Create with the Do not Save 

option. The command should be called from the fragment context menu. 

Checking the geometry of a fragment may be necessary, for example, when working with parametric 

fragments (containing External Variables or Geometric Parameters), because their variation may differ from 

the variation in the original fragment file. To view the geometry of the fragment in a particular variation, it 

is convenient to open it in a separate document, without saving it to disk. 

You also need to check the fragment when you have various problems with its recalculation in the 

assembly: you should understand whether the problem is at the fragment level or at the assembly level. 

Another case takes place when the fragment in the assembly was supplied with the help of 3D modeling. 

Sometimes you need to understand how the original fragment looks like and what operations it has. 

For example, make holes in the housing Base fragment of the Housing assembly in the assembly. As a 

result, you get a body (Body_1 Housing with Holes) where one of the operands is a fragment. 
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To make it easier to understand how the fragment and the created body look like,  open the body  as a 

separate document and a fragment as a separate document.  

Call the context menu in the "3D Model" window for the body, call the command Detail > Create, specify 

the option Do not Save. 

 

 

As a result, the body for which the Detail > Create command was called is displayed in a separate 

document. 

You should do the same with the fragment: call the context menu of the fragment and create a detail 

without saving. 
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As a result, the fragment will be opened as a separate document without writing to disk. 

 

SAVING GEOMETRY FROM ASSEMBLY TO SEPARATE F ILE  

To create drawings of details that have different variations in the assembly, it is convenient to save the part 

to a separate file. Detail models saved from an assembly to a separate file can be transferred to other users 

who, for some reason, do not need to work with the entire assembly. Therefore, a mechanism by which the 

bodies or fragments that go into the assembly can be saved to a separate file was implemented. The file 

can be updated according to changes in the assembly, but the changes made in the file will not be 

transferred to the assembly.  

 The Detail > Unload command with the option Save body as a new detail file that will 

automatically update when assembly changes. 

 The Detail > Unload command with the option Export to Parasolid. 

 The Detail > Create command without creating fragments (Do Not Save). 
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In case of changes in the assembly, a file in the Parasolid format should be saved again. Consider these 

options to save the geometry in a separate file. 

If there were drawings in the fragment that was saved as a separate file, they will be changed 

according to the changes in the fragment in the assembly. 

Save Geometry with Update Possibility 

In cases when you want to save a particular variation of a body or a fragment (for fragments with External 

Variables or Geometric Parameters) in a separate file, for example, to create a drawing, or transfer to 

another user, you need to use the Detail > Unload command with the option Save body as a new detail 

file that will automatically update when assembly changes. If you use this command, the model 

constructions tree will not be available to the user. 

Suppose you have a Housing assembly (file 

"Housing.grb") in which there is only one fragment of the 

Housing Base. The fragment has no reference elements 

and no geometric parameters, i.e. it is non-adaptive and 

is created in the assembly using the <FM> Create 3D 

Fragment command. 

Let's say that you started to create a cover in the 

assembly. The side cover should be unloaded to a 

separate file and the changes from the body should be 

transferred to the file. At the same time, you do not need 

to create a correct assembly structure and reinsert the 

saved body as a fragment.  

 

 

 

In the "3D Model " window, call the context menu for the Side Cover body and choose the Detail>Unload 

command . 
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In the dialog that appears, select the Save body as 

a new detail file that will automatically update 

when assembly changes option. A brief description 

of the dialog box can be found in the "Unload 

dialog" section. As a result of the operation, a "Side 

Cover" file was created.grb", and a related item 

appeared in the constructions tree (in the Linked 

details folder). The command did not affect the 

assembly structure, and there will be no changes in 

the "Assembly Structure" window. You can make 

multiple separate files for a single body. 

You can place the generated file as a fragment in an 

assembly by using the <3F> Insert 3D Fragment 

command.  

 

Insert the "Side Cover.grb" file into the assembly. A new fragment appeared in the "3D model" and 

"Assembly Structure" windows. 



Three-dimensional modeling 

958 

 

 

 

Make changes to the Side Cover body and add a hole. 
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To upload changes to the "Side Cover.grb " file you need to use a special command.  

 

Icon Ribbon 

 

 

Keyboard Textual Menu 

 File > Assembly > Update Linked Details 

 

You can call the Update command Linked Details in the "Assembly Structure" window through the 

"Actions" menu (see the section “Assembly Structure window”). 

You can update a specific detail by calling the context menu for the linked detail. In this case, there will be 

no difference because there is one detail. 
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The command adds a hole to the part file, and if you update the assembly, the "Side Cover" fragment also 

changes its geometry. 
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Other context menu commands. 

Delete the link with detail. Allows to break the link to the uploaded detail: the detail is no longer associated 

with the assembly and cannot be updated. 

Open. Opens the detail file. 

Show in Folder. Show the detail file in Windows Explorer. 

 

Maintain Variation of Parametric Fragment Geometry 

Another important feature of the Detail > Unload command with the Save body as a new detail file that 

will automatically update when assembly changes option is the ability to unload different variations of 

parametric fragments, i.e. fragments with External Variables and (or) Geometric Parameters.   

Let's go back to the Housing example. Side Covers are connected with the Housing Base by means of 

screws D4хL6 and with Bracing by means of screws D5хL8.  

 

From the "Assembly Structure" window, you can see that different screw versions (D4xL6 and D5xl8) refer 

to the same file. I.e. a fragment of the screw is parametric (contains External Variables) and allows to 

implement all possible variations according to the standard.  
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If you need to fix some specific variations of parametric fragments (for example, to create a drawing), you 

need to create a separate file with one or another variation of the parametric fragment. However, you don't 

need feedback to this file, but we need to be able to pass changes to the file if the variation of the fragment 

in the assembly has changed. Using the Detail > Unload command, create two files associated with the 

assembly: the first with the D4хL6 variation and the second with the D5хL8 variation.  

In the "3D Model" window or in the "Assembly Structure" window, call the context menu for the D5xL8 

screw fragment. In the context menu, select the Detail>Unload command. Specify the Save body as a new 

detail file that will automatically update when assembly changes option in the dialog box . Call the file 

so that its variation is clear. 
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As a result "Screw D5хL8.grb" file was created. This action does not appear in the "Assembly Structure" 

window.  



Three-dimensional modeling 

964 

In the "3D model" window, you can see 

the created file in the "Linked details" 

folder.  As in the case described above, 

when the command Detail > Unload 

(with the option of unloading) was 

applied to the body in the assembly, you 

have the opportunity to transfer the 

geometry changes from the assembly to 

the created file. 
 

To update the geometry of the "Screw D5хL8.grb" file, according to the changes of the fragment in the 

assembly, you need to use the Update Linked Details command, or in the "3D model" window through 

the context menu of the related part to call the update command for a specific file. 

You can create a file with the variation of the screw D4xL6 in the same way. 

Save Geometry in Parasolid Format 

When you select the first item in the dialog of detail unload: "Export to Parasolid" a dialog for exporting 

part to Parasolid appears. The selected items are saved in a separate Parasolid file (*.x_t). The file does not 

depend on the assembly. The export operation has no effect on the assembly model structure.  

Save Document View 

If necessary, you can save a document that is opened after execution of the Detail > Create command with 

the Do Not Save option. For this, open document and execute the <Ctrl+S> Save command.  

Such actions are required in the case, when you need a model tree in the file of the geometry, saved from 

the assembly. At the same time, the link of such a file with the assembly should be controlled manually. if 

reference elements are automatically created when you run the Detail > Create command, they should be 

updated in the created file if the assembly changes. You can insert the generated file as a fragment in 

assemblies by using the <3F> Insert 3D Fragment command.  

Let's continue with the example of the Housing assembly. Let's say you need to save the Bracing body that 

was created in the Housing assembly, as a separate file. It should be possible to work with the constructions 

tree of the body. In this case, the assembly does not need the changes made in the file, but you need to 

transfer the changes made in the assembly  for the detail file. This is necessary, for example, when Bracing 

has different versions. Then, to create a drawing of the second version of Bracing, you will have a 3D model 

in which, due to the available model tree, you can make the required changes. The Bracing 3D model has 

a link with the assembly by means of the reference elements. In case of changes, Bracing will receive the 

actual geometry when updating the reference elements. You can create as many separate 3D models of a 

single body or fragment as you want. 

Call the context menu for the Bracing body in the "3D model" window. Select the command Detail > 

Create. This dialog box was described above. Select the Do Not Save option. 

Enter Description: "Bracing". As a result, the "Bracing.grb" file was created.  
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There will be no changes in the "3D model" and "Assembly Structure" windows of the Housing assembly 

file. 

 A model tree is available  in the file "Bracing.grb". A reference element for the profile, which parent 

elements cannot be taken from the assembly, was automatically created. The profile depends on the 

assembly and will link the model to the assembly by means of the reference element. To update the 

reference geometry, call the Update Geometry command from the context menu of the reference element. 
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You can edit the constructions and create a new variation of the detail. For example, edit the constructions 

that define the profile and change the number of holes. 
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You can create separate documents not only for bodies, but also for fragments. At the same time, when 

you save the fragment document, the constructions tree will also be available. In this case, you create a 

copy of the fragment file, but only in the variation in which the fragment is in the assembly. 

Save the "Box Cover" fragment from the "Box" assembly into a separate file. 

The "Box Cover" fragment has reference elements. 

 

 

In the "3D model" or "Assembly Structure" window call the context menu for the fragment "Box Cover", 

choose the command Detail > Create, and select the option Do not Save. View the opened document of 

the Box Cover fragment. If the document fragment was opened correctly, save it <Ctrl+S> Save. As a result, 

a separate file is created in which the 3D model Box Cover is located. The whole constructions tree is 

available for the model. The reference elements of the fragment were also saved. They can be updated to 

get the latest geometry from the assembly.  
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3D  PL ACEMENT  

T-FLEX CAD has additional mechanism of 3D fragments positioning – 3D placement. It allows you to 

quickly create arrangements in 3D scene by using special attachments to the floor, walls, ceiling, and 

horizontal surfaces. Attachments are determined with the help of connectors with the specific parameters.  
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Fastenings for 3D Placement  

3D placement fastening – is LCS - connector, which contains the value with special name <prefix>_<type> 

type, where 

 

 

<prefix> substring defines fastening type for the LCS and may take one of the following values: 

 SOURCE (SOURCE_<type>) –initial fastening. This type is specified for objects that will be 

moved in scene (for example, furniture elements). 

 TARGET (TARGET_<type>) –target fastening. This type is specified for objects that define 

attachment planes (for example, wall or floor) or fastenings.  

<type> defines type of connectors that interacts with the current LCS. Acceptable versions of <type> 

depend on the attachment type. 
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There are two available types of attachments: “LCS –planar face” and “LCS-LCS”. 

 “LCS –planar face” – a fragment with the connector SOURCE_ <type> will be moved in the 

plane of object with connector TARGET_<type> if they have the same <type>. 

 

 

 

Sofa moves on the floor plane 

 

 

 “LCS-LCS” – the connector with SOURCE_ <type> fastening will be matched with one of the 

existing in assembly connectors with type TARGET_<type>, if they have the same <type>. 

 

Cupboard is attached to one of the “LCS-LCS” fastenings. 

More information about attachment types can be found below. 
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A single connector can contain several <prefix>_<type> values simultaneously. Thus, it can define several 

fastenings for 3D placement. 

 

SOURCE_<type> fastening will be attached to the TARGET_<type> fastening according to the 

3D placement rules, only if fastening is defined in the document of 3D placement object. You can 

find example of the fastening creation below. 

Fastening TARGET_<type> can be specified based on any connector of the current document. 

Attachment rules 

As it was said above 3D placement objects can be attached according to the “LCS–planar face” and/or 

“LCS–LCS” rules.   

Attachment Rule «LCS–planar face»  
There are the following types of the “LCS–planar face” attachments: <type> = {WALL, FLOOR, TABLE, 

CEILING}. Below are pairs of initial and target fastenings corresponding to these types: 

SOURCE_WALL TARGET_WALL 

SOURCE_FLOOR TARGET_FLOOR 

SOURCE_TABLE TARGET_TABLE 

SOURCE_CEILING TARGET_CEILING 

To specify the “LCS–planar face” attachment it is necessary to define the attachment plane and a set of 

associated faces of the target fastening connector.  

The associated faces are highlighted with yellow color.  

The attachment plane is specified by the center of target fastening LCS and by the attachment axis.  

 

The X-axis of the target fastening LCS is the attachment axis for the WALL type. 

 

The Z-axis of the LCS of the target fastening is the attachment axis for the FLOOR, TABLE and CEILING 

types. In addition, the associated faces of the connector must lie in the attachment plane.  

 

Face outside the attachment plane will not be considered in the placement mode. 

You must follow particular rules for successful result: 

  The Z-axes of all fastenings inside the fragment of 3D placement must be coaxial. The 

placement object orients itself according to the Z-axis of global coordinate system upon 

insertion; 
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 The Z-axes of all other fastenings must be coaxial with the Z-axis of the global coordinate 

system; 

 The initial fastening of every separately taken type “SOURCE_<type>” must be unique in 

the fragment document for the 3D placement. 

Example of Fastening with Target Type Creation  

LCS was created for the “Floor” object. Its Z-axis is coaxial the Z-axis of the global coordinate system. The 

LCS is set as connector. 

 

 

The attachment of target fastening TARGET_FLOOR is set for the connector. Position of LCS center and 

direction of Z-axis specify the plane in which the inserted fragment with SOURCE_FLOOR fastening is 

moved.  

The associated face lying in the attachment plane is specified. The face is highlighted with yellow color. 

System analyzes all “SOURCE” type connectors in fragment’s document when you insert the fragment into 

assembly and selects possible attachments. Only the pairs of connectors with the values of the same type 

can be attached. For example, it can be “SOURCE_WALL” and “TARGET_WALL”. 

If the associated face is not set, the fragment is moved in such way that axis of the LCS of the initial 

and target fastenings coincide and the center of the LCS of the initial fastening lies in the attachment 

plane. 

 

Attachment Rule «LCS–LCS» 
You can specify any name for <type>, when you use “LCS-LCS” attachment rule. The only exception is that 

you can’t specify names used for “LCS-planar face” rule given above. For example, you can specify source 

fastening name SOURCE_POINT. 

You can specify several connectors with the same names. In this case, the set of fastenings will be created 

and the fastening of the inserted fragment will be linked with it. 
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When you insert a fragment with initial fastening, it will be transformed in such a way that the LCS of the 

initial and target fastenings coincide. 

If there are any associated elements specified for fastening, they will be automatically selected when you 

point the cursor on them. 

Source Fastening Creation 

For a fastening creation, you need to follow the next steps: 

 Create a new LCS. Its Z-axis direction should coincide with the Z-axis of the global coordinate 

system. 

 

 Open Parameters window of the created LCS and on the General tab specify it as connector 

for the fragment insertion.  
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 You need to specify the connector name on the Connector Values tab, according to the 

described above rules. In the example, SOURCE_FLOOR name is specified. SOURCE means that the 

initial fastening was created for the chair. The Expression is set to “1” for all fastenings. 

 It is necessary to set Type of fragment insertion – 3D Placement in the status of the 

fragment to insert it using the 3D placement mechanism. You need to activate ST: Set Document 

Parameters and open 3D Fragment tab. 

 

Insert 3D Placement Element  
Fragment insertion is performed using command: 

Icon Ribbon 

 

Assembly → Assembly → 3D Fragment 

Keyboard Textual Menu 

<3F> Operation > Insert 3D Fragment 

If the fragment insertion type is set to 3D placement, the Placement command activates automatically.  

To attach the fragment by the 3D placement method it is required to create source placement fastenings 

(SOURCE_<type>). Target fastenings should exist in the assembly file (TARGET_<type>). They can be 

created directly in the assembly document or be raised from 3D fragments that already exist in the 

assembly. 

The body intersection checking is dynamically enabled when inserting 3D fragments in the 3D 

placement mode to ensure correctness of elements placement. 
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The fragment is moved and rotated using special manipulator, which degrees of freedom depend on the 

attachment type. 3D placement object with the specified single attachment «LCS–Planar face» can be 

rotated around axis of the attachment, if this attachment has the type FLOOR or TABLE. For rotation, it is 

possible to use manipulators or the Angle of rotation parameter on the system toolbar. 

 

You can translate fragment along the attachment plane after clicking  on it. The fragment will follow 

cursor according to the attachment rules. 
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You need to enter its edit mode and to select item Edit in the fragment context menu to activate the 3D 

placement mode for the existing fragment. 

 

 

 

3D Placement Properties 

The 3D Placement properties window appears after pressing button Edit. 
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Objects Tab 

 

You can specify translations for several fragments in assembly 

without exiting 3D placement mode. Selected fragments will be 

added to the Objects list in the properties window. The last 

selected fragment is highlighted with green color. 

You can select fragments from the list again, to continue their 

movement. 

 

All objects movements made in the 3D placement mode are 

stored consequently. When you press , the last performed 

movement will be discarded. 

 

Use button  to delete a fragment from the list and discard 

all its changes. 

3D Placement Tab 
The set of available “LCS–Planar face” attachments is displayed 

in the “3D Placement” list of the properties window. The 

attachments can be single (for example, “Floor”, “Wall”) or 

double (“Wall–Floor”). 

Consider snap borders. The parameter allows to consider 

borders of attachment object. In this case, you cannot translate 

fragment over boarder of the target object. For example, 

movement of a table will be limited by the floor space. 

Consider intersections. When the flag is set, objects can’t 

intersect each other.  

Connection distance. The flag specifies distance between two 

“LCS – LCS” fastenings at which they will be activated.  
 

Automenu Options 

There are following options in the automenu: 

Option  Apply changes appears if at least one fragment was moved. The option allows applying all 

changes to all fragments in the Objects list without exiting command. Currently selected fragment stays in 

the Objects list. 

Option  allows to change location of a fragment manipulator. It is located in the center of bound 

box  by default. The manipulator is placed according to the LCS position when option  is selected. 
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When the option  is active the fragment will be automatically updated after applying changes in 

its variables. 

Positioning of 3D Placement Objects 

Single “LCS–Planar face” attachments are specified by parameters of the connector in the3D fragment 

document. Double attachments are formed by the procedure of insertion of 3D placement object from all 

possible pairs of single attachments satisfying the condition: double attachments can only be WALL–

FLOOR, WALL–TABLE and CEILING-WALL. 

When object is positioned by a single “LCS–Planar face” attachment, it is required to point the cursor of 

the mouse at the associated face of the target fastening of the desired type. In this case, the contour of 

the associated face of the target fastening will be highlighted. 

 

 

It is required to point the cursor at the associated face of the target fastening of the WALL type when 

positioning an object based on the double attachment,. If the face was found, its contour will be 

highlighted.  

The presence of the FLOOR or TABLE target fastening is determined by the positioning procedure. 

If the second attachment is absent, the object will not be positioned based on the double 

attachment. 

Attachments by “LCS–LCS” rule are displayed in the scene only when the attachments by the “LCS–Planar 

face” rule are not used. In this case the Without attachment option is selected for the inserted fragment 

in the Attachments list. All possible target fastenings by the “LCS–LCS” rule are displayed in the scene with 

the green sphere. Upon selection of one of these spheres the connection between the initial and target 

fastenings is established, and the selected target fastening will be highlighted with red color. 
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Attachments by the “LCS–LCS” rule can be used indirectly, when attaching a fragment by the “LCS–Planar 

face” rule. When you move the fragment in 3D scene, system can automatically “grab” the “LCS–LCS” 

attachment. 

When the fragment with connector value TARGET_<Type> is moved, the related fragment will be moved 

too, if attachment “LCS” – “LCS” is set between them. 

MECHANISM «SMART FRAGMENT»  

The Smart Fragment mechanism allows us to develop parametric library elements whose insertion scenario 

is described in the program stored directly in the file of the given library element or in the external module 

(DLL). Settings of T-FLEX CAD macros and also the program interface (Open API) allow us to describe 

settings in such a way that upon insertion of the file as a fragment or upon its editing/deletion the user-

specified macro will be executed. 
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The macro can contain code realizing the required logic of the user’s interface on insertion/editing/deletion 

of the given fragment. For example, the adaptive model «Small groove» was developed that has a set of 

external variables and adaptive parameter – circular edge which must be substituted upon insertion of the 

fragment. 

 

The «Groove.grb» file contains the macro InsertGroove which performs selection of exclusively circular 

edges located at the intersection of the external cylinder and the planar face. Upon insertion of the given 

groove from the library the macro is launched automatically. Instead of regular command of insertion of a 

3D fragment with the full interface, the simplest command is working at this moment that allows us to 

select the edges satisfying the given condition and to change the values of external variables of the inserted 

fragment. 
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The result of insertion of the fragment by this scenario is the small groove on the shaft. 

 

This mechanism allows users-programmers to create the most convenient scenarios of fragments insertion 

in various applied fields.
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MATES AND DEGREES OF FREEDOM 

In the process of designing solid assembly models in T-FLEX CAD, it is often necessary to specify mutual 

position of parts, which may not always be accomplished by the conventional technique of fixing by LCS 

adopted at T-FLEX CAD. This is due to the fact that changes in part positions may have to be reciprocal. A 

given part can simultaneously have multiple contacts with other movable parts. When using the approach 

based on LCS, recursive dependencies of references may occur in such cases (a part’s dependency on itself). 

Such tasks may occur, for example, when building models of mechanical systems (mechanisms). To handle 

such tasks, mates are introduced which are the system elements that allow imposing various dependencies 

on the geometrical objects of two component operations (3D points, axes, curves, planes and surfaces). 

   

A model of a mechanism designed with the use of mates can be animated in the special command, where 

you move its parts by the mouse. 

   

To fix a 3D fragment using LCS, you can specify additional conditions in the way of the permitted degrees 

of freedom. If such a 3D fragment is later attached via an LCS to another constrained element, then it will 

be included in calculations of the constrained mechanism. The method of positioning the selected parts 

by using mates is to be used as an auxiliary way of fixing together with the use of fixing by local coordinate 

systems. The use of mates requires additional computational resources for evaluating solutions. Therefore, 
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we recommend using mates in the cases when other approaches to the described tasks are not suitable 

for some reasons. 

MAIN CONCEPTS  

What is a Mate? 

The “Mates” tool serves for mutual attachment of assembly model elements. It allows positioning those 

according to the specified geometrical conditions. These conditions define the mutual situation of the 

three-dimensional model objects (such as faces, edges, vertices, characteristic points, axes of surfaces of 

revolution, etc.) with respect to each other. The system automatically resolves the specified set of mates 

and situates the objects in the way satisfying the specified conditions. Mates allow precisely positioning 

the parts of the mechanism being designed with respect to each other. Those allow to impose certain 

properties in a mechanism’s model and determine how its components move and turn with respect to 

other parts. Combinations of different mates can be used for more precise definition of the restrictions on 

an assembly element’s position with respect to another element. Relations between pairs of components 

are associative. If one part is moved then another part will move along. For example, if a screw is tied to a 

hole, then relocation of the hole will cause the screw to follow along. 

Mates are imposed on pairs of geometrical objects. Those either connect two components together or fix 

a body to its environment (with respect to a fixed object). A fixed object is an object with all its degrees of 

freedom restrained or a one whose position in the space remains still. It is recommended that at least one 

component be fixed in the space. This creates a “ground” for all other constrained parts and can prevent 

an unexpected dislocation of a mechanism’s components. 

Each mate appears as a model object having its place in the model structure. As a fully functional system 

object, a mate has a name, working properties and is displayed in the 3D model structure. The user can 

turn off some of the mates in order to temporarily exclude those from the general solution. This allows 

experimenting with various types of mates without redefining the mechanism interdependencies. 

Types of Mates 

When defining geometrical ties in the form of mates, you can use only the following geometrical terms: 

3D point, axis, curve, plane, surface. In order to specify the geometrical data, the user selects topological 

elements of the model or construction elements. Use of 3D construction elements is possible under the 

condition that those are constructed based on an operation body. Otherwise, the second component will 

turn out to be bound to the still environment.  

Upon fixing by construction elements, you lose the capability of dynamical articulation of the given 

connection in the constrained mechanism; therefore, if possible, prefer to use the model's 

topological elements (vertices, edges, faces, etc.) 

When creating mates, make sure to understand the difference between the geometrical data used by mates 

and topological objects used for selection. For example, a flat face has boundaries, while the plane used in 
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the mate is infinite. Therefore, the created geometrical relation based on a flat face will still be valid beyond 

the boundaries of this face. 

 

Coincidence 
This type of mate insures full coincidence of one geometrical object with another one. The number of 

remaining degrees of freedom depends on the geometrical type of the objects being joined. For example, 

aligning two points will create a spherical joint that blocks any translation while allowing any rotation. 

Aligning a point and a curve will allow elements to rotate, and also to slide along the curve. The following 

table shows the possible combinations of geometrical elements when using the coincidence: 
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Point + + + + + + + + + + 

Axis + - - - - - + - - - 

Plane + + - - - - + - - - 

Circle - - - - - + - - - - 

Conical surface - - - + - - - - - - 

A point can be aligned to any geometrical object. If two flat faces are selected, those will lie in one plane. 

Coincidence of an axis and a plane will insure the axis’ placement on the plane of a flat face. The condition 

of coincidence between a point and a solid insures the point’s placement being maintained on the solid’s 

surface. 

 

Upon selecting a circle and a conical surface, matching of the selected surface and the circle is realized in 

such a way that the plane of the circle is perpendicular to the axis of the cone. 

 

Using the coincidence in combination with other types of mates allows imitating various mechanical 

connections. For example, coincidence of a pair of 3D points provides for a spherical joint. 
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Parallelism, Perpendicularity 
These types of mates represent a special case of the “angle” mate type. These insure mutual parallelism 

and perpendicularity of the selected geometrical objects. The following table presents the possible 

combinations of geometrical elements when creating parallelism or perpendicularity mates: 
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Axis - + - - - - - - 

Plane - + - - + - - - 

Tangency 
Tangency insures a constant physical contact between two geometrical objects. Depending on the 

geometry type of the interacting objects, a contact may be occurring in one point (example: a plane and a 

sphere) or along a line (a plane and a cylinder). This type of mate can be set between two planes, a plane 

and a surface, two surfaces. Tangency between an arbitrary body and a surface works only for a spherical 

surface. 
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Surface - - - + + + + + 

Plane - - - + + + + + 

Sometimes, there are several possible solutions to connecting the selected objects. For example, if a plane 

and a sphere are selected, then the solution yields two tangency points. In the case of a non-unique 

solution, the system makes a decision automatically. Normally, the nearest point to the current location of 

the mechanism is accepted as the solution. To transit to another solution domain attainable by the moving 

mechanism, use the “dragging” motion mode (see below). 
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In the case of a non-unique solution, it is recommended to bring the components being constrained 

into the area of the desired result before creating the mate. Parts of a constrained mechanism can 

be moved within the command “Move Mated Components”. The components that were not yet 

subjected to mates, can be moved by using the command “Transformation”. 

Concentricity 
“Concentricity” is a special case of the “coincidence” mate type. It insures coincidence of two axes. This 

type of mate is a most commonly used one. Normally, this mate type is engaged in combination with other 

types. For example, to snap a part with an axis to a hole, coincidence (of flat end faces) is used quite often 

in combination with concentricity. To define concentricity, one can select model elements suitable for 

defining an axis (surfaces of revolution, elliptical edges, straight edges, etc.). 

The diagrams show constraining parts of a schematic hydraulic cylinder by concentricity. Other parts of the 

simple mechanism arc connected by local coordinate systems. For viewing convenience, some parts of the 

mechanism are sectioned along the axis. 

  

Distance 
The “distance” mate defines a relation between two objects by fulfilling the condition of maintaining a 

specified distance between two geometrical objects. One can specify the conditions of types “no greater 

than”, “no less than” or “equal” to the specified value. 

The following table presents the possible combinations of geometrical elements when creating the 

“distance” mate: 
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Distance 
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Point + + + + + + + + 

Axis + + - - + - - - 

Surface + - - + - - - - 

Plane + + - + + - - - 

This type of mate can be used, for example, for defining an object’s shift or for restricting mutual 

penetration of faces. To define a restriction on mutual penetration of faces of different parts, you just need 

to specify the distance condition “no less than” zero. This can be used for mechanisms whose operation 

relies on physical contact (collision) of its parts. 

Continuing with the hydraulic cylinder example, let us show how to use the “distance” mate. The 

mechanism created at the previous step will operate incorrectly in certain motions, because some parts of 

the hydraulic cylinder may penetrate each other. This problem is resolved by the “distance” mate. One can 

specify the condition that the distance between the respective faces of the piston and the cylinder must 

be greater than or equal to zero. When mates are dragged kinematically, this will yield the correct 

representation of the mechanism's behavior. 

   

Angle 
This mate defines angular distance between two geometrical objects. The turn angle can be used for 

rotating a component referencing the desired position. Just as in the “distance” case, this mate type 

supports use of conditions. When defining such connection, normally there are two or more solutions. 

The following table shows the possible combinations of geometrical elements when creating the “angle” 

mate: 
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Angle 
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Axis - + - - + - - - 

Plane - + - - + - - - 

«Gear-Gear» Transmission 
This type of mate serves for creating conditions for the interaction of two bodies spinning about their 

respective axes. The conditions are specified as a transmission ratio between two spinning objects, that is, 

the number of revolutions made by one of the components while turning the other one. Upon introducing 

such a mate, a two-sided relation is formed. This type of mate is convenient for monitoring mechanisms 

that incorporate dented wheel or belt drives.  

Remember that this type of transmission relation, just like any other 

transmission mate, merely tells the system the mutual ratio of 

angular (in this context) velocities. Also note that each component 

must be fully fixed in its place by the time of creating a transmission 

mate and be assigned all required degrees of freedom and 

constraints. 

To create such a mate, select two axes of revolution and specify the 

transmission ratio. In this case, the shape of the dented wheel is not 

significant for the system, as the wheel dents can be created for «cosmetic» 

purpose only. The law of the mechanism's movement will be defined solely 

by the mate conditions. 

 

«Gear-Rack» Transmission 
This type of mate serves for creating the conditions for two interacting bodies, in which one component 

spins, while the other one moves about one or multiple axes. This type of mate allows modeling, for 

instance, a nut being picked up by a screw, a transmission link of the type «pinion-rack», etc. The mate 

conditions are defined as the amount of the distance traveled by the movable component along the 

specified axis while the other component makes one full turn. A two-directional relation results from 

creating this kind of mate. 

To create a mate, you need to define the axis for each of the two components and specify the distance in 

the model units that one component would travel while the other component rotates by 360 degrees. The 

first one defines the «pinion» axis, the second one - the «rack» axis. 

«Linear Movement» Transmission 
If there are two objects in the model moving in their respective axial directions, then you can specify a ratio 

using the mate being described, that would characterize the mutual displacement of the two objects. With 

such a relation established, the travel distance of the second component will be calculated by multiplying 

the first component’s travel by the specified ratio. The relation can work in the reverse direction as well 
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(from the second component to the first one); in this case, the system will use the ratio which is the 

reciprocal of the specified one. This type of mate helps modeling the mechanisms representing systems of 

pulleys, hydraulic mechanisms, etc. 

 

To create a mate, you need to define the axes for each of the two components, and enter the value of the 

velocities ratio of the moving components in the provided input box.  

Attaching 3D Fragment by LCS 
A 3D fragment inserted in an assembly using local coordinate systems can also be involved in a 3D model 

built on mates. To define a 3D fragment's behavior with respect to the fixing LCS, the permitted degrees 

of freedom are specified in the fragment's parameters. There are total of 6 DOF's – distributed as 3 for 

translations and as many for rotations with respect to LCS axes. An additional limit can be set for each DOF 

as a range of values.  

One can also specify the degrees of freedom in the parameters of the source LCS in advance, in the 

fragment's file. Upon inserting a 3D fragment, the conditions are copied from LCS parameters to the 

parameters of the 3D fragment together with the degrees of freedom and are later accounted for when 

calculating the mates complex of the developed 3D assembly model. 

  

If the target LCS was not specified at the time of creating a 3D fragment, making the fragment 

attached “by default”, the degrees of freedom management mechanism will not be applicable to 

such fragment. 

When designing complete assemblies of mechanisms using the degrees of freedom and mates, it is 

important to account for the following point. A 3D fragment being inserted in an assembly by fixing to an 

LCS may or may not be related to some assembly component. In the latter case, the component behavior 

may not agree with the expectancy as other assembly components are moved. For example, it may stay 
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still while its surrounding parts move, or, vice versa, moving it may not induce motion in the neighboring 

parts. 

To have a 3D fragment be related with another component, its target fixing LCS must be built on 

geometrical objects of that component. Otherwise, it will be attached to the still environment. 

The so-called “Aggregate” mechanism is introduced in the system for creating complex assemblies. This 

mechanism allows creating mates in the model of the 3D fragment first, so that those are automatically 

accounted for when such a 3D fragment acts in an assembly. 

CREATING MATES  

To create a mate, use the command: 

Icon Ribbon 

 

Assembly → Mates → New 

Keyboard Textual Menu 

<3CT> Tools > Mate > Create Mate  

To create a new mate, complete the following steps: 

1. Select the mate type.  

2. Select the first object. 

3. Select the second object. 

4. Define parameters of the selected mate type (if necessary). 

5. Confirm the selections. 

Selecting Mate Type 

A mate type selection is done in the properties window. To make a selection, set the radio switch into the 

desired state. 

For “Distance” and “Angle” mates, one can define a condition with respect to the specified value. Pressing 

the button before the numerical value cyclically switches its condition sign. 

For transmission mates, the numerical parameters are defined in the respective input boxes. 
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Selecting Mate Elements 

The modes of selecting the first and second geometrical objects are engaged by the following options: 

 <F> Select first element 

 <S> Select second element 

Upon selecting the first element, the system automatically turns on the option for selecting the second 

element. If it is necessary to return to defining the first element, turn on the respective mode manually. 

Depending on the type of the mate being created, different geometrical objects can be selected. Tuning 

the selection to the desired type of geometrical data is done by the automenu options: 

 <V> Select point 

 <A> Select axis 

 <C> Select curve 

 <U> Select surface 

 <L> Select plane 

 <W> Select wire body 

 <H> Select sheet body 

 <B> Select solid body 

For some mates, a number of options may be unavailable or temporarily inaccessible (see the tables of 

combinations above). Each option turns on a set of filters for selecting objects suitable for defining the 

required geometrical element. 
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Selected objects are highlighted. Also highlighted are the operations whose geometrical elements are 

selected. Simultaneously, the system offers a preliminary choice of solving the mate. According with this, 

the system moves the elements as to fulfill the mate conditions. If one or both elements already have 

mates with other bodies or fixed still to the environment, then the new solution is calculated by accounting 

for all earlier imposed restrictions. 

Fixing Mate Member 

When creating a mate, one of the two mate members can be fixed in the space. Fixing is done by pressing 

the button marked by an anchor image, in the properties window. 

 

Upon fixing, the object becomes “frozen” in the 3D space in its current position. It will neither be affected 

by any new transformations nor by changes in parameters of existing translations. The “*” mark will appear 

before the name of the fixed operation in the model tree. 

 

Repressing  button cancels fixing of the mate component. 

It is also possible to fix a body in space outside the command of mate creation. Use Fix Component from 

the context menu of any body (  icon) if the current 3D assembly contains any mates or uses degrees 

of freedom for 3D fragments. 

The command Fix Component is always available in the context menu of the fixed component. The icon 

corresponding to this command is pressed if a component is fixed. Applying this command will disable 

fixing in this case. 

Selecting Elements for Defining Transmission Ratios 

You need to specify numerical parameters (transmission ratios) when defining transmission mates. An 

additional capability is provided in the cases of «Gear (angular speeds)» or «Worm (pinion-rack)», which is 

using geometry of the mated elements to automatically determine the numerical transmission ratio. The 

options for defining the transmission ratio appear automatically in an additional section of the automenu 

when selecting the appropriate mate type. 

The transmission ratio for the «gear» transmission is calculated as the ratio of the two selected elements' 

radii. The following options are used in the automenu: 

 <G> Select first element to define transmission ratio 
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 <D> Select second element to define transmission ratio 

 <Z> Cancel transmission ratio selection 

In the case of the «Worm» mate, the transmission ratio is calculated based on the connecting thread 

parameters. The following options are used in the automenu: 

 <T> Select threaded face to define transmission ratio 

 <R> Select edge or face to define transmission ratio 

 <Z> Cancel transmission ratio selection 

Additional Mate Parameters 

Reverse Direction. This option rotates the second (or the remaining movable) component being connected 

by a 180 degrees or moves it into another solution domain. For the transmission mates, this parameter 

alters the direction of the second component motion. 

Reverse Normal. This option works only with the “distance”-type mate between two planes. In addition to 

the previous option, it allows changing the direction of counting the distance. 

Maximum Calculation Time is the parameter controlling the number of passes the system is allowed to 

use in search for the solution with the specified precision. This limitation is necessary to avoid too long 

system computations due to an accidental user error, that are possible when searching for solutions in 

complicated cases. This parameter is set by a slider. 

 

If no solution was found after the current number of iterations, try to increase the allotment. On the 

other hand, it could be sufficient instead to manually move the components being connected 

toward the probable solution domain in the command “Move Coinstraint Operations” (see below). 

Animate – this parameter lets the system gradually relocate the elements being constrained in order to 

examine the mate solution behavior.  

Don't Recalculate – this parameter suppresses mates calculation at the time of creation. This capability can 

be used in order to save time when working with large assemblies. This could be useful, for instance, when 

the user adds several mates one after another. To search for a solution, you will need to do full model 

recalculation. In this case, note that upon adding several complex mates or simply a too large number of 

mates, the system might not finally find the correct solution (see the topic «Processing possible erroneous 

cases while working with mates» below).  
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TECHNIQUES OF HANDLING EXIST ING MATES  

Working with the Model Tree 

The created mates are displayed in the “3D model” window. Most of manipulations with existing mates are 

done via this tool window. A special folder is created in the model tree, in which the system automatically 

puts all mates. An icon is provided for each mate type that corresponds to the type. 

Each mate is preceded by the mark . Clicking it by  will show the objects in the expanding branch of the 

model tree, on which the mate is based.  

Mates can be additionally grouped in subfolders. 

 

However, only one subfolders nesting level is supported. All mate subfolders are marked with the icon 

. Each additional folder has a unique name. Grouping by additional folders doesn't affect anything. This is 

done merely for working convenience when sorting out a large number of mates. 

To move a mate to another folder, use the context menu item “Move to folder”.  The new submenu makes 

available the commands for creating a new additional mates folder and moving to the main and already 

existing additional folders. 

The rest of commands in this context menu are common across various system elements (“Parameters”, 

“Edit”, “Delete”, “Information…”). 
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Suppressing Mates 

Any mate can be suppressed. The command for suppressing a mate and canceling the suppression is 

accessed in the context menu by right clicking  a mate. It is also possible to impose suppression on a 

group of mates at once by accessing the command from the context menu on right clicking the mates 

folder. A suppressed mate is marked with a blue cross in the model tree and is excluded from calculating 

mates. 

Mechanism Motion 

To dynamically view the motion of a composed mechanism, use the command: 

Icon Ribbon 

 

Assembly → Mates → Move 

Keyboard Textual Menu 

<3CM> Tools > Mate > Move Mated Components 

Upon calling the command, you are required to select the desired part of the mechanism for defining 

motion. Motion is defined by dragging the selected part by the mouse. In this way, the user stimulates an 

influence on the mechanism as if a force is applied to the selected point on the part in the direction of the 

mouse pointer in the screen plane. The part of the mechanism starts moving under the influence of the 

force. The motion is restricted by the specified mates with other parts and the outer environment. The 

selected part pulls another one, and so on, until the whole mechanism is involved in motion. In this 

simulation, masses and moments of inertia of the moved components are correctly accounted for. 

Any translation and rotation parameters of mated (constrained) objects are recorded in the 

properties of each mate operation. A special transformation type, namely, “Mating transformation”, 

is created within the operation’s parameters. All quantifiable properties of this transformation are 

automatically calculated by the system. 

Several important considerations shall be kept in mind when moving mated elements: 

1. Exact numerical parameters cannot be specified for a translation. 

2. Upon completing the translation command with , the parts cannot be brought back in the 

exact previous state. If urged, this can be done only by undoing the steps in the current session. 

3. When moving the model of the mechanism for which an assembly drawing was furnished, there 

is a danger of irreversible changes to the original drawing created by projecting. This could 

happen after refreshing the projection, due to the new positioning of the assembly parts and 

complications on the way of the exact rollback to the previous state of part positions. 

The setup of the motion modes is done in the properties window.  
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Number of Elements: Maximal/Minimal. When moving constrained 

elements, it is possible to involve all parts of the composed mechanism 

or just the minimal chain of mates.  

“Calculation method”. Sets one of two available methods of 

calculation – precise or fast. The precise method is used for systems 

consisting up to several tens of joints. The higher the complexity of 

system, the slower it will run the calculation. For systems including 

hundreds of joints this calculation may work unsatisfactory slow. In this 

case you need to use the fast method that works with both large and 

small systems. The auto mode allows system to choose calculation 

method itself, according to the complexity of the system. 

The mode of the kinematic dragger is used for moving parts in a 

mechanism. This results in smooth motion. It is a simulation of the 

effect of applying a force at the point at which the user pulls the part. 

The motion is generated by accounting for all specified restrictions. As 

the boundary of the solution domain is reached, the mechanism stops.  

Movement Accuracy. This allows reducing the level of calculation 

precision for faster calculations and for maintaining the constraining 

conditions during a mechanism's motion. 

 

Maximum calculation time. Sets the number of computational passes allowed to the system for reaching 

the required computational accuracy during the motion. 

Dragger power. This setting adjusts the degree of the mouse impact on the dragging point of the body. 

This setting controls the applied force and, therefore, how fast the dragged parts will move after the mouse. 

Use material density. For more precise simulation of mechanism motion, a provision is made for 

accounting for the actual density when calculating mass properties of its parts. Otherwise, the density is 

assumed the same for all components. 

Consider contacts. To improve accuracy of movement simulation there is an opportunity to consider the 

intersection of objects. 

Mark dragged Body. This is an auxiliary parameter for switching On/Off highlighting of the mechanism 

part being pulled at the user for inducing the motion. 

Mark dragged Point. This parameter turns on highlighting of the point which is pulled by the mouse 

pointer. The point is marked by a cross. This functionality can be used when the body highlight is off. 

Disable transmission mates. This option allows disabling transmission mates. Such a capability is 

convenient for bringing transmission members to the starting mutual configuration (for example, the 

correct interlocking of wheel dents). 

Avoid inertia of dragging. This parameter allows to switch on/off the consideration of the body inertia. 

Inertial motion mode. This parameter allows to consider the inertia without its fading over time. 
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There is a simplified way to change 3D element position in space within the specified degrees of 

freedom. For activation of this opportunity you need to select the body in the scene using the filter 

. A small circular manipulator will appear in a second after selection. This manipulator is used 

for moving the element. 

 

 

Optimum Length of Chain of Mates 

As a mechanism is being created, one part gets “hooked up” to the outer environment, while other parts 

are linked to each other via mates. In this way, a number of parts subsequently linked to each other can be 

viewed as a chain of mates. If several parts all connect to one part, the chain of mates forks. When creating 

mechanisms, pursue the shortest chains possible. Shorter chains are solved faster, and fewer computational 

errors occur on the way.  

Let's review the following typical example – suppose, we need to create a model of a simple mechanism 

shown on the diagram. The mechanism represents a joint-type connection, joining together three parts – 

a support, a lever and an axis. The most rational approach in this case will be creating two short chains of 

mates, rather than one long. 

The lever needs to be attached to the support first, using concentricity and coincident flat faces mates. The 

axis can be attached to any of the parts as well, such as the support, by concentricity and coincidence. This 

results in two chains of mates: support-lever and support-axis. In this case, it would not be rational to 

attach, for instance, the axis to the support, and then the lever to the axis, since that would result in a 

longer chain of mates “support-axis-lever”. 

 

 

 
Sample mechanism Parts of mechanism Advancing mechanism 

(adding new mates) 
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Rational chain Undesirable chain 

Naturally, this simple example will not exhibit any noticeable slowdown in the system performance; 

however, the difference becomes substantial in more complex cases. 

Recommendations on Combined Use of Fixing by LCS and Mates 

In this section, we review the recommended rules of combined use of mates and fixing by LCS when 

creating assemblies. Fixing parts by mates shall mainly be used together with fixing by LCS. Note also that 

priority shall be given to the traditional way – fixing fragments by coordinate systems. This approach has 

a number of advantages over mates. 

Firstly, some types of geometrical relations, including the most commonly used (as a single-axis joint), can 

be solved by one LCS, while in the mate approach it may require bundling two or more mates. In particular, 

a single-axis joint is defined by two mates (concentricity + coincidence of end faces), or just one LCS (with 

rotation allowed about one axis). This main advantage has more consequences: 

 Overall, the system works faster (the chain of mates becomes shorter, computational errors 

are reduced, calculations become simpler). 

 A simpler model structure results from avoiding extra elements (the mates). 

 The model becomes more robust to topological changes (due to minimized use of 

topological body elements). 

So then, when the use of mates is justified? To answer this question, let's review the process of designing 

an assembly. In regard to the posed question, the designer typically faces 2 tasks. 

Task 1: creating an assembly model without a provision for a “movable” mechanism. The user knows in 

advance what he is developing, and that his model will not have to move upon assembling, that's 

unnecessary. For example, if we are designing a TV set or a house, it is unlikely that we will need to 

“animate” those dynamically. 

When the user faces such a requirement, then the single main concern of assembling parts is – how to 

correctly position a part within an assembly. The most effective solution is achieved by the “traditional” 

approach – inserting 3D fragments using LCS. In addition to overall advantages of this approach, fewer 

actions are required from the user. A 3D fragment insertion technique takes less time because fewer 

elements need to be defined, specifically: 

1. The source LCS (the selection can be automatic). 

2. The fixing position (selection of the target LCS or a geometry unit for its creation is done in 

the 3D window). 

Meanwhile, each new mates would require defining geometrical data for two components, while exact 

positioning of a component usually requires creation of several mates. 

Resort to the use of mates: 
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 in complex cases of geometrical interactions; 

 

 when assembling a part that is in contact with other parts at several locations. 

Task 2: building an assembly with a provision for “animating” the developed mechanism in the command 

for moving constrained elements. In this case, all parts of the assembled mechanism ought to interact 

correctly with each other. All movable parts shall necessarily have descriptions of the required conditions 

for calculating the mates arrangement while the mechanism is in motion. 

In such a case, we recommend holding on to the rules described below: 

 For the parts that are not supposed to change their position with respect to the elements 

they are attached to, we recommend using LCS with no degrees of freedom. For example, a 

nut fastened to a bolt shall always be with the bolt and shall not move with respect to the 

bolt. 

 For the parts with varying mutual situation, first use LCS providing degrees of freedom. This 

will benefit in all main aspects (see above). 

Mates are used for fixing parts in the following cases: 

 For parts with complex geometrical associations. 
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Example of complex interaction (helical surface and pushing rod) 

 For parts having more than one contact with several movable adjacent parts. 

 For terminating chains of mates. In this way, each chain can be created using an LCS with 

degrees of freedom. 

   

 For defining various restrictions, such as a restriction for mutual part penetration. For an 

example, refer to the hydraulic cylinder where the restriction is specified in the form of the 

condition “distance=0” (see the topic “Types of mates” above) 

Processing Possible Erroneous Cases while Working with Mates 

Errors in mates might occur at various stages of handling the model. The system may not always output 

the detailed reason for such failures; therefore, we will list here the most common erroneous situations 
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and typical techniques of correcting those. All erroneous situations can be divided into two types – errors 

occurring at a mate creation, and errors occurring in mates during model recalculation. 

The problems occurring at the time of creating mates could be due to two reasons. Firstly, a mate solution 

may not be found as it simply does not exist. For example, this may happen when the previously imposed 

geometrical relations in the model are such, that the system cannot relocate the selected components to 

satisfy the new conditions. In such a case, you need to check up the model. It is possible that excessive, 

unnecessary relations are present somewhere. If that's the reason, then you could try freeing up some 

system components or relieve extra geometrical relations. This may often be achieved by suppressing (and 

later deleting) a certain «obstacle» mate or allowing an additional degree of freedom in the parameters of 

the respective 3D fragment. Secondly, it could be so that a theoretical solution exists but the system fails 

to find it. There could be several reasons for that – either too short maximum calculation time is specified, 

or the system cannot find the solution with the current model components configuration. In such cases, 

there are combinations of measures helping the system to find the solution. First of all, you could defined 

the longer maximum calculation time to allow the system run more calculations. Also, before creating a 

new mate, you should manually move the components of the mechanism to the expected solution area 

(by using the command of moving mated elements). This would help the system to find the desired solution 

in complicated cases. 

A separate reason for a failure to review is when the user attempts to specify such relations that lead to 

recursion (self-dependency). Suppose, for example, that two components were initially fixed by LCS. Later, 

the user wants to impose an additional mate between two components. Meanwhile, the LCS axis of one of 

the components relies on geometry of the second component for orientation. Moving the second 

component leads to a change in the first component’s position. Satisfying the mate conditions implies that 

both components move. In such a recursive situation, the system will never be able to find a solution. To 

escape the trap, you would need to exterminate the reason of the recursion – which in this case means 

redefining the LCS of the first component to make it independent of the second component. 

Errors may occur on an initially correct model after performing the regeneration operation. Mates are 

calculated by groups (chains). Should an error occur in a group, each mate in this group is marked in the 

model tree by a red cross. The reasons for regeneration errors could be of two types. It could be so that 

the model underwent such changes due to which the solution satisfying all conditions is no longer feasible, 

or the relation between mates and component geometry is broken (as, for example, a missing topology 

element that was used in a mate). In such a case, restoration of mates is possible under the condition that 

the parent elements are restored. Otherwise, the mate needs to be redefined.  

 



Three-dimensional modeling 

1002 

Another example is a correct model yet the system failing to find the desired solution. This may happen, 

for example, due to insufficient allotted maximum calculation time. Another reason could be the model 

getting into a trap from which the system cannot escape. In such a case, you could first try to suppress all 

erroneous mates, and then one by one re-enable them in the model. Simultaneously with that, you could 

move the components to help the system find the solution. It could also be helpful in such a case to extend 

the maximum calculation time. This can be done with “Time” flag on the “3D” tab of the ST: Set Document 

Parameters command. 
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AUXILIARY TOOLS FOR 3D ASSEMBLIES MODELING 

MANIPUL ATORS OF EXTERNAL VARIABLES  

General Information 

To specify the values for external variables of a 3D model, the user-defined manipulators can be created. 

 

Manipulators of external variables can be used in two ways: 

 ·to change parameters of the model in the scene. The command for controlling visibility of 

manipulators in the scene – Show/hide manipulators is added to the object visibility control 

toolbar in the scene.  

 ·to change external variables values on the fragment when inserting the model into the assembly. 

To create manipulators it is required that the current 3D model have external variables that control 

parameters of the given model.  
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Creating manipulator 

The Parameters > Manipulators command allows us to create and edit manipulators of external variables:  

Icon Ribbon 

 

Parameters → Tools → Manipulators 

Keyboard Textual Menu 

<3CV> Parameters > Manipulators 

In this command it is possible to add new manipulators, remove existing ones, change manipulator’s 

description. Creation of the following types of manipulators is possible: 

 ·linear manipulator – arrow the length of which is equal to the variable’s value; 

 ·radial manipulator – ring the radius of which is equal to the variable’s value; 

 ·diametrical – ring whose diameter is equal to the variable’s value; 

 ·angular manipulator by three points and angular manipulator by axis and initial point – a 

segment of a circle whose angular dimension is specified in degrees and equal to the variable’s 

value; 

 ·list – for external variable the list of admissible values is available. The list can be tied to an arbitrary 

point on a 3D model. Manipulator of this type is shown as a small ball and upon pressing on this 

ball the list for variable’s value selection will appear. 
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When calling the Parameters > Manipulators command the list of already existing in the given document 

manipulators is displayed in the properties window. If there are no manipulators in the document yet, the 

list will be empty. 

Manipulators already created in the document are displayed in 3D window with a grey color. In order to 

edit the parameters of already existing manipulator, it is required to select it – with the help of in 3D 

window or in the list of the properties window. The selected manipulator is highlighted in 3D window with 

a color (by default – red color).  

 

To create a manipulator, the cursor has to be placed over the line in the list, and afterwards parameters 

of the manipulator must be specified in the fields below: 
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Section Variable: 

List for manipulator’s type selection: Linear, Radial, Diametrical, Angular by 

three points, Angular by axis and initial point, List. 

Field for specifying the manipulator’s name. The name (text string) can be 

typed manually. Also it can be specified automatically based on the name of 

external variable with which the given manipulator will be linked. For this case, 

it is required to leave the field empty. After selection of the variable from the 

list below, the system itself will fill in this field according to the format 

“Variable’s value “Variable_name””. 

List of external variables of document – allows us to indicate the external 

variable whose value will be controlled by the manipulator being created. 

Hide. This flag allows us to control manipulator’s visibility on the screen. As a 

value for this parameter it is possible to use the real variable. Manipulator will 

be hidden if the value of the variable is not equal to zero. 

Parameters of the Scroll step group specify the step with which the 

manipulator’s value changes:  

By default – the step is selected automatically depending on the scene’s scale; 

Value (the user can specify the exact value for the step);  

By list of values (the list is generated by the user). 

 

 

Parameters of the Range group specify the limits for the change in the manipulator’s value and scale: 

Limit at the beginning. This parameter allows us to specify the minimum admissible value of the 

manipulator; 

Limit at the end. This parameter allows us to specify the maximum admissible value of the manipulator; 

Multiplier. With the help of this parameter the coefficient by which the manipulator’s value will be 

multiplied can be specified. 

Also in the command’s properties window there is additional section with the manipulator’s visualization 

parameters: 

Size. Size of the manipulator in 3D scene. This parameter affects only the manipulator’s visualization; 

Colors/Draw. The color with which non-active manipulators will be drawn in 3D scene; 

Colors/Selection. The color with which the manipulator will be drawn in 3D scene when the cursor comes 

near the manipulator; 

Colors/Active. The color with which the active manipulator will be drawn in 3D scene; 
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Radius from a point. This parameter is available only for the angular manipulator and specifies the radius 

of the manipulator’s arc. By default this flag is enabled, the radius is determined automatically by the points 

specified by the user (when defining manipulator’s geometry). When this flag is disabled, the radius value 

can be specified manually. 

 

Geometrical parameters of the manipulator are specified with the help of the options of the automenu. 

The set of these options is different for each type of the manipulator. 

For a linear manipulator the following options are available: 

 <A> Select axis of manipulator  

 <F> Select start point of manipulator 

 <S> Select end point of manipulator 

These options allow us to specify the image of the manipulator in 3D scene by two ways – either to specify 

the initial and final points of the manipulator’s vector or to select a 3D object that is capable of defining 

the manipulator’s vector. 

For radial and diametrical manipulators: 

 <A> Select axis of manipulator  

 <F> Select start point of manipulator 

 <S> Select end point of manipulator 

These options allow us to specify the axis of the circular manipulator either by specifying two points or by 

selection of a 3D object capable of defining the axis entirely. The radius of the manipulator will correspond 

to the value of the variable linked with the manipulator. 

For angular manipulator by three points: 

 <1> Specify first point of arc 

 <2> Specify second point of arc 
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 <3> Specify third point of arc 

The arc of the angular manipulator of the given type is determined by three points: central point of an arc 

(selected with the help of the option), initial point of the arc (the option) and final point of the arc 

(the option). 

For angular manipulator by axis and initial point: 

 <A> Select axis of manipulator  

 <F> Select start point of manipulator 

 <S> Select end point of manipulator 

 <B> Select initial point of rotation 

For the angular manipulator of the given type it is required to specify the manipulator’s arc axis – by 

selection of two points (the and options) or one 3D object (the option). After the axis has been 

specified the initial point of the manipulator’s arc must be specified. The arc length will be determined by 

the system automatically based on the value of the variable linked with the manipulator. 

For manipulator of the type “List”: 

 <B> Select point 

This option allows us to indicate a 3D point in which manipulator in the form of a small ball will be created. 

To complete creation/editing of the manipulator it is required to press  after all parameters have been 

specified. 

Using manipulators 

When using manipulators, i.e., when changing the values of the variables of the model with the help of the 

manipulators, additional control element appears in the system toolbar – for specifying precise numeric 

value of the manipulator. 

 

Manipulators created in 3D model are displayed in the scene of the original document. If necessary, they 

can be turned off with the help of the 3SM: Turn off manipulators command. This command is available 

on the View toolbar: 
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Icon Ribbon 

 

View Toolbar → Turn off manipulators 

Keyboard Textual Menu 

<3SM>  

CONFIGURATIONS  

General Information 

Configuration – saved in the document additional version of the model’s geometry satisfying several given 

conditions. Geometry of configurations is not shown in the 3D scene of the document. 

By default, the T-FLEX CAD document stores only the geometry corresponding to the last saved 

state of the 3D model of the given document. 

The main domain of application of configurations is for design of 3D assemblies. Geometry saved in the 

configuration can be inserted into the assembly instead of the actual geometry of the fragment. The use 

of configurations allows the user to rapidly download the required version of the fragment without 

additional recalculation and transformation of fragment’s model. 

Variation is a special configuration type intended to work with the product structures. The variations are 

used for variant BOMs creation. 

More information about variant BOMs can be found in “Product structures, reports and BOMs” 

chapter. 

T-FLEX CAD document can contain any number of configurations/variations. Each of them is assigned the 

unique name. 

Depending on conditions defining the saved configuration, configurations can be divided into 2 types: 

Configurations by a total collection of bodies – store the geometry of all bodies of 3D model; 

Configurations by optional collection of bodies – store the geometry of an optional collection of bodies 

corresponding to any operations and Bodies from the model’s tree. 

If the document contains external variables, in each configuration a collection of values of external variables 

is also stored, for which the geometry of configuration was calculated. 

Configurations can be also created in the 2D documents. In this case, configuration is capable to 

store only collection of values of document’s external variables. Such configurations can be used 

while working with 2D fragments for quick specification of values of fragment’s variables. 
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Using Configurations 

When inserting a document with configurations as a 3D fragment, as usual, it is possible to either specify 

the values of external variables of fragment required in the assembly (if a fragment has them) or specify 

one of the configurations saved in the document. 

When specifying the values of variables, the system has to recalculate the entire model of the fragment 

according to the values specified in the assembly. The geometry obtained as a result of recalculation is put 

into the assembly. 

When using configuration (created in the document of a fragment in advance), recalculation of the 

fragment’s model is not carried out, - the geometry stored in the configuration is inserted right away. 

Geometry inserted into the assembly contains only the bodies which were saved in the configuration. 

Since there is no recalculation of the fragment’s model upon insertion of configurations, the time spent on 

assembly construction is significantly reduced. This is especially evident when inserting the fragments 

containing quite complicated constructions and the large number of operations. The possibility to control 

the structure of the geometry saved in the configuration provides even wider capabilities for design of 3D 

assemblies. 

Mechanisms, purpose and operation with the first and second types of configurations are considerably 

different, thus, a separate description of each is required. 

Configurations by a total collection of bodies 
When creating configuration by a total collection of bodies the user specifies only the values of those 

external variables of the document to which geometry of the configuration has to correspond. Geometry 

of all final bodies of the 3D model is saved in the configuration. 

The use of configurations of this type for 3D fragments allows the user to avoid the recalculation of 

fragment’s model in the assembly. To take advantage of this capability, upon the fragment’s insertion, 

instead of entering the values of the variables, the user needs to specify one of the configurations of the 

fragment. Geometry of the indicated configuration will be downloaded into the assembly. 

The system can use the geometry from the configuration of the fragment automatically. This happens 

when for 3D fragment the user specifies the values of the variables coinciding with the set of values for 

one of the configurations of the fragment. If this coincidence takes place, then instead of recalculation of 

the fragment’s model, the system downloads the geometry from the corresponding configuration. Note 

that this rule is valid only for configurations by a total collection of bodies. 

Configurations by optional collection of bodies 
When creating configuration by an optional collection of bodies, in addition to a collection of values of 

external variables, any arbitrary set of operations and Bodies from the model’s tree of the document is 

specified. The geometry that will be stored in the configuration represents a collection of all selected 
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operations/bodies. When using the current document as a fragment, such configuration will be inserted 

as a multi-body fragment. 

Multi-Body fragments can be automatically divided into several separate bodies, if, in the properties 

of the fragment in the assembly, the parameter “Use” (tab “Operation”) is assigned the value “As 

separate bodies”. 

Insertion of configuration by an optional collection of bodies into the assembly can be carried out only by 

explicit specification of the name of the required configuration in the fragment’s properties. 

Configurations by an optional collection of bodies can be used in cases requiring different representation 

of the model’s geometry in the fragment and in the assembly. For example, inside the assembly they allow 

displaying the bodies corresponding to the operations in the middle of the model’s tree of the fragment. 

Example – the parts with completed finishing of welded joints. Finishing of welded joints requires creation 

of a large number of additional operations complicating the model and increasing the recalculation time. 

In the 3D model of the part itself, the finishing of welded joints is necessary, but in the assembly it is often 

unnecessary and significantly burdens the assembly model. In such situation in the fragment it is possible 

to create configuration containing the part’s geometry without finishing of welded joints. The list of bodies 

stored in this configuration will consist from one operation which precedes the operations simulating the 

finishing of welded joints. If, upon the insertion of the fragment into the assembly, the user selects this 

configuration, the part will be displayed in the assembly without finishing of welded joints. 

 

Configurations can be also used for fragments whose structure must be modified from one assembly to 

another. For example, assume that the fragment’s model contains a collection of bodies, but it is required 

to include only some of them into different assemblies, and, moreover, in different combinations. In this 

situation, in the fragment’s document the user can create several configurations with different collection 

of stored operations, and download them into the assemblies as needed. 

 

As another example of the use of configurations consider the following: often, in the assembly the user 

needs to create a hole adjusted for a non-standard part, and then insert, as a fragment, the part itself. To 

do that, in the document of the fragment-part the user can create configuration storing a simplified state 

of the model (operation from the middle of the model’s tree) and a final view of the part (operation from 

the top of the tree or a Body). When inserting such configuration into the assembly with the use of 

fragments’ partitioning into the bodies one of the inserted Bodies can be used for creating a hole (with 

the help of Boolean operation of subtraction), another Body – for obtaining the fragment-part itself. 

Creating and Editing Configurations 

For creating and editing configurations the command FCE: Edit Model Configurations is used: 
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Icon Ribbon 

 

Parameters → Tools → Configurations and variations 

Keyboard Textual Menu 

<FCE> Parameters > Model Configurations and variations 

 

This command can be unavailable if the current document was not saved. 

Calling the command brings up the dialog box for managing configurations of the current model: 

 

The pane on the left-hand side displays the list of the existing configurations of the current model. To start 

working with some of the existing configurations, you need to select it in the list. If the document does not 

yet contain any configurations, the list will be empty. 

Option  Create configuration is used to create a new configuration. Option  Create variation is 

used to create a new variation. A new name may be assigned for the new configuration or variation. 

You can specify a product structure type for the new variation. It is recommended to select Variant BOM if 

you plan to create a variant BOM table subsequently. 
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If the field “Part No.” is filled, it will be set as 

configuration/variation name by default. If it 

is empty, the current document name will be 

used. 

The product structure will be automatically 

created after the variation saving. Its name 

matches the source name. 

For already created 

configurations/variations, you can change 

the name and, if necessary, specify the 

subtitle by editing the corresponding cell in 

the table. 

 

The set of variable values that corresponds to the current state of the model is assigned for a new 

configuration/variation, by default. 

There are following options in the context menu: 

Change type to configuration/variation allows to switch type of currently selected element. 

Sort by name allows to activate sorting by Name column. 

 

Delete product structure deletes product structure for the currently selected element. You can reassign 

the product structure in the Product Structure window by clicking “Create…”  

 

 

Base variation. The flag to the left from the name is used for the base variation selection. 
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The properties of product structure corresponding to 

the base variation are used for data display in the 

Product Structure window in the Apply product 

structure representation mode. If the flag is not set 

for any variation, the first variation in the list is 

considered to be the base. 

 

For selected configuration, the list of external variables 

values is shown in the table Variables in the upper right 

pane of the command’s window. 

The values of variables can be modified in the table. 

Upon modifying any external variable, the earlier saved 

configuration becomes outdated and is marked by an 

asterisk.  

You need to save changes using option  to make them actual. Some external variables can be 

deleted, and some can be created when you edit the model.  

The “State” column  displays information about each variable in configuration. It shows if a variable 

exists in the model and if the model variable exists in the configuration. 

At the lower right pane, there is a list of operations and Bodies of the model, stored in the selected 

configuration. 

  

“All operations” value is displayed in the list after creating configuration. If the configuration creation is 

completed at this stage, configuration by a total collection of bodies will be created. Uploaded operations 

and bodies configuration by an optional collection of bodies is created when you add elements to the list. 

For filling in the list, you need to set a desired filter in parameter Select: Bodies or operations. After that, it 

is possible to select any Bodies or operation in the 3D scene or in the tree of the 3D model. 

Buttons  and  allow you to edit the list of bodies in the configuration: 

-  – removes operation/Body selected in the list; 
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-  – removes the entire contents of the list (the list content is replaced with “All 

operations”). 

The following graphic buttons are used for managing configurations as well: 

 Apply changes – saves changes and new configurations/variations. 

  Copy/Paste - allows to copy or create a new configuration/variation based on the existing one. 

You need to specify name for the new configuration. The variables values and the product structure type 

are copied from the source object. 

  Move up/Move down - allows to change elements order in the list. The order is important only 

for the variations. Their order in the variant reports matches the order in the list. 

 Load - regenerates model with a variable values defined in the selected configuration. This command 

allows viewing geometry of each configuration. 

 Update - assigns current values to the external model variables in the current configuration/variation. 

 Delete - deletes the selected configuration/variation. 

 Delete all – deletes all configurations/variations. 

 Create new variations table – creates variation table of the model. 

You can find more information about variation tables in “Drawing title block” chapter. 

EXPLODED V IE W  

T-FLEX CAD provides a special command for exploding 3D models made of several operations (normally, 

this is an assembly 3D model). The exploding transformations can be defined in the parameters of any 

three-dimensional operation. The operations that require an LCS for creation, such as 3D fragments, 3D 

copies, etc., are positioned according to the transformations defining translations (offsets) and rotations 

with respect to the attachment LCS. Other operations can be transformed relative to world coordinates or 

the center of the outline box. This is defined in the transformation settings. More details on transformations 

are provided in the chapter “Assigning "Transformations" to 3D Entities”. 
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Command Execution 

The exploding mode is turned on and off by the command:  

Icon Ribbon 

 

Tools → Animation → Exploded View 

Keyboard Textual Menu 

<3VX> Tools > Exploded View 

The exploding mode is off by default. 

After activation, the “Explode animation” toolbar appears. 

 

More information about it can be found in section “Exploded view animation”. 

Calling the command transforms the current parameters that define positions of the operations. The 

parameters on the [Transformation] tab define the permanent transformations, as well as the exploding 

mode transformations. When the exploding mode is turned on, the transformations are applied that were 

defined for the exploding mode. 

 

The exploding mode can be used when you need to create a 2D projection of the product assembly taken 

apart. All necessary settings are collected in the 2D projection parameters.  
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More information can be found in the chapter “2D Projections. Creating 2D Drawings of the 3D 

Models”. 

Exploded view scenario 

The command is used for setting or editing exploded view parameters. You can perform the following 

steps in Exploded view scenario command: 

 Create and edit exploded view scenarios. It is possible to create several exploded view 

scenarios. 

 Create your own scenario of fragment exploded view as part of the general scenario. 

 Define animation parameters. 

 Control bodies visibility on each stage of exploded view scenario. 

Several exploded view scenarios can be created for an assembly. For example, assembly parts exploded 

view, assembly sequence, etc. Each scenario may consist of several stages. Stage includes sequence of 

actions. Action is an execution of individual transformation – translation or rotation of selected elements 

group. Group composition for various actions can be different. 

To call the command:  

Icon Ribbon 

 

Tools → Animation → Exploded View Scenario 

Keyboard Textual Menu 

<3TE> Tools > Exploded View Scenario 

Creation of Exploded View Scenario 

After activation you need to select objects which will be used for explosion view. For this purpose use 

options: 

 <O> Select object for individual transformation 

 <M> Select objects for transformation 

When  is selected it is possible to select only one object for transformation. You can select several 

elements using <Shift>.  

Upon selection of  it is possible to simultaneously select several objects for transformation. 

There is the possibility to choose dependent objects. For this purpose use special option in automenu: 
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Levels of dependence mean hierarchical dependence of assembly elements. The zero level corresponds to 

the fragment that is selected in the assembly. The first level corresponds to all the fragments in the 

assembly that depends on the first one. 

 

The option Don’t select dependent objects  is active by default, that’s why only one fragment is 

selected in the scene. 
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If you activate option Select dependent objects of the first level  and select the same fragment, all the 

fragments that are directly dependent on the fragment will be selected. 

 

If you activate option Select dependent objects of the second level , the fragments dependent on the 

first level fragment will be also selected. 
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If you activate option Select dependent objects of all levels , all elements that directly or indirectly 

depends on the first selected fragment will be selected. 

 

Using of the option is convenient in case of working with complex assemblies, for example, when you need 

to translate object together with its dependent objects. 

Creation of new or edition of existing explosion view scenario is made in the section Scenario Selection. 

 

You can create a copy of an already existing script. 
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You cannot create a new script, if work with the current one is not finished. 

The following objects can be selected as objects of the scenario: bodies, fragments, cameras, light sources.  

To edit scenario properties use section [Properties]. 

 

 

Using this section, you can edit name of scenario, set duration, type and speed of the exploded view 

animation.  

Each scenario contains stages, divided into actions.  

Full sequence of creating assembly from parts and subassemblies can be traced with the help of several 

stages. 

For creating and editing stages of exploded view use Contents section. 

 

 

This dialog box contains information about created stages, actions, and objects, used in stages. Several 

graphical buttons are located to the right of the transformations list.  

Button  is used for creation of a new exploded view stage.  

When you press  button, a new action for selected stage is created.  



Three-dimensional modeling 

 

1022 

 

Button  is used to delete all transformations of a stage. 

Button  deletes last exploded view stage in the list. To delete an action use button , located near 

actions name. 

When you press   buttons, the sequence of exploded view stages is changing.  

With the help of  button, you can control stages visibility. When active, icon changes its color . The 

“Hide” option affects not only the current stage, but also all following stages, until the activation of “show” 

option. All bodies are visible by default. 

There is a possibility to manage visibility and delete individual objects with the help of buttons. Hidden 

objects are shown in gray in the list. 

 

You can manage objects visibility only in current document. 

Button  allows to copy selected stage. The copied stage is added to the end of the list. 

 

 

Each action has one object or a group of objects and the chain of transformations for them. As a coordinate 

system for the chain of transformations you can use local coordinate system or coordinate system of the 

first group object (in a case of group transformations). A special option from automenu is used for the 

coordinate system selection: 

 <L> Select LCS for current transformation 

In case, when it is not possible right away to orient LCS in a desired way, the functions of additional 

coordinate system specification can be employed. These functions allow you to quickly rotate the 

constructed LCS around its axes by 90° ( , , ), perform cyclic turning of the axes of the coordinate 

system around the origin (when pressing  the axes change their places). 

All transformations are shown in the Transformations section of the properties window. 



Auxiliary Tools for 3D Assemblies Modeling 

 

1023 

 

 

Several graphical buttons are located to the right of the transformations list. Button  is used to add a 

new transformation. You can select required transformation from the transformations list that appears after 

pressing the button. This this list can be also called from the context menu, after pressing  in the 

“Transformations” window. 

After type selection a new string appears in the transformations list. You can specify transformation value 

in the value input field. 

Transformation values can be assigned numerically or using variables and expressions. 

 

When pressing button  the last transformation in the list is deleted. Pressing   buttons changes 

sequence of transformations. 

To save the transformations you need to press [Enter]. Also, a special manipulator in 3D window can be 

used to define transformations. This manipulator is moving according to the selected type of 

transformation. 

 

Group transformation can be performed either in the “common” coordinate system, or in own coordinate 

system of each group member. 
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Mode of setting transformations in the common coordinate system is activated by default after selection 

of several objects for transformation: 

 <G> Set transformations of selected objects in common CS 

If this option is switched off, the group transformation is transferred into own coordinate system of each 

group member. I.e. when you move several fragments, each of them is moving along its own X axis. 

 

 

 

 
 

Each bolt is translated in its own coordinate system Bolts are moved in the common coordinate system 

Thus, usage of the group transformations can significantly reduce time spent on specifying elements 

transformations. 

You can enable display of one of three positions: start, end and current, using options: 
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Start position Current position End position 

To improve convenience of objects selection use option: 

 <N> Group selection of objects by rectangle 

You can select rectangular area, holding . There are two selection conditions: 

1. All objects, which are completely covered by rectangular area, will be selected for the 

transformation. Common manipulator for these elements will appear. The cursor is moving from 

left to right. 

 

2. All objects that intersect the rectangle will be selected. Common manipulator for these elements 

will appear. The cursor is moving from right to left. 
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The area color differs for each condition. 

Exploded View of Subassembly Elements 
If there are subassemblies in the assembly you can move elements of the subassemblies separately. Use 

one of the following ways for this purpose: 

If there is an exploded view scenario in the subassembly document, you can use it in the assembly. You 

need to select the subassembly fragment in the scene and choose one of its scenarios.  

 

The second way to move subassembly elements separately is to divide subassembly using 3SD: Divide 

command. The way is not preferable, because the link between the product structure and subassembly is 

lost after division. This method can be used if the assembly document is used only for visualization. 

Exploded view Animation 
In “Exploded View Scenario” command, you can create animation of assembly/exploded view. While 

defining animation you specify position of assembly elements in each period.  

The [Player] section in properties window is used to manage animation. 
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All elements movements are displayed on the time scale. Time scale represents horizontal line with slider. 

Slider indicates the playback time of current stage and total duration of animation. When you move the 

slider, current animation position changes and model is accordingly updated.  

In the lower part of the section there are graphical buttons, which manage animation parameters. 

 - Play. Starts animation. 

 - Pause. Temporary stops the animation at the current stage. 

 - Stop. Stops animation. 

 - To Start. Scrolls animation to the beginning. 

 - To End. Scrolls animation to the end. 

Animation starts in one of the following modes: 

 - Forward Back. Plays the animation once from the beginning to the end. 

 - Forward Reiterated Playback. Plays the animation in a circle (from the beginning to the end, from 

the beginning to the end, and so on) until the button  is pressed. 

 - Loop Playback. Plays the animation in a continuous cycle (from the beginning to the end, from the 

end to the beginning, and so on) until the button  is pressed. 

 - Reverse Playback. Plays the animation once from the end to the beginning. 

 - Reverse Reiterated Playback. Plays the animation in a circle (from the end to the beginning, from 

the end to the beginning and so on), until the button  is pressed. 

 - Normal playback speed. Playback speed set by default. 
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 - Slow down playback. Playback with half speed. 

 - Speed up playback. Playback with double speed. 

The animation mode can be selected either before pressing [Play] button  or while animation playback. 

You can manage animation without activation of Exploded View Scenario command. For this purpose, the 

special tab on the Ribbon is used. It is called using the 3VX: Exploded View command. 

 

You can activate the command for scenario editing on the tab. 

Main options for the exploded view playback are in the Control group. You can also select the scenario in 

the group. 

You can stop animation by pressing<ESC>, model recalculation or reactivation of the Exploded 

View command. 

In the Output group there are commands for record and export of the scenario. 

 

Animation Record  
The Record Scenario option allows animation recording in *.avi and *.wmv formats. General scenarios and 

scenarios by default are supported. 

 Record Scenario window appears when you select the option. Here you can set the following 

parameters: 

 You can select one of three variants in the Photorealistic view generation 

section. 

Non-photorealistic rendering – the exploded view scenario is recorded according to the current view 

in 3D scene. 

The following variants are used for photorealistic view creation. Each frame of the video is processed 

using selected photorealistic view mechanism. 

Photorealistic rendering using OptiX – the video is created using NVIDIA OptiX mechanism. 

Photorealistic rendering using Embree – the video is created using Embree mechanism. 

You can set Image quality and Number of Ray Tracing iterations for the previous two variants. 
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Photorealistic rendering using POV-Ray – the video is created u sing the POV-Ray mechanism. 

 

You can find more information about photorealism in “Photorealistic view” chapter. 

 

 You can set view point using View point section. 

 Use current view point. The video is recorded according to the current view point in 3D scene. 

 Use camera. Video is recorded according to the selected camera from the list. It is available only 

if there are any cameras in the scene. 

You can find more information about cameras in “Cameras” chapter. 
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You can set File name and Number of frames per second. The path to the created file is shown in the File 

name field. You can specify name, file path and file format using  button. 

Video quality setting is available for the *.wmv format. The video quality and file size are changed 

according to its value. 

If the flag Use current view size is active, the video is recorded according to the active view size. Otherwise, 

you can set size manually. 

 

 

The Reverse flag allows to record exploded view video in the reverse direction to the given in scenario. 

When the flag Repeat scenario in cycle is active, you can set Number of cycles. It sets number of exploded 

view scenario repeats. 

 

 

The Video recording window appears after the [OK] button pressing. 

 

Number of processed frames and time until video creation are shown here. 

 

Using buttons you can pause recording [Pause], stop record on current frame [Stop] or cancel recording 

[Cancel]. When you stop recording, already created part of the video is saved. 

 

 

The preview window appears when you use photorealism. 
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Save Scenario 

Save scenario allows to export exploded view scenarios to *.wrl, *.x3d, *.pov, *.u3d, *.pdf formats. 

 The window Export Scenario appears after the command calling. 

 

 File path is displayed in the File Name field. You can select filename, its path 

and file format using button . 

 Save used elements only. All elements that are not used in the scenario will 

be not included in the file, when the flag is active. 

 Export light sources. Light sources are included in the file. 

 Save textures. The objects textures will be saved to the file. Otherwise they 

are not saved and the material of the object will be displayed instead of them. 

 Save model edges. Model edges are saved when the flag is set. The flag is 

enabled only for *.wrl and *.x3d formats. 

 Reverse. The scenario will be exported in the reversed direction. 

LARGE ASSEMBLY MANAGEMENT TOOLS  

To optimize working with assembly models, the system provides specialized large assembly management 

tools. Those allow working only with the subassemblies of concern, save the overall used memory and 

facilitate spinning the 3D scene when it is densely populated with objects. A “large assembly” is a model 

in which the large assembly mode is activated. 

The large assembly mode is activated in the ST: Set Document Parameters command on the Large 

Assembly Management tab using Unload Body Geometry Automatically parameter: 
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This mode is turned on automatically. It depends on the model complexity and the computer resource 

availability. 

First of all, the large assembly mode provisions for freeing memory by automatically unloading the detailed  

information about the assembly objects. Such bodies are displayed seemingly normal, however their edges, 

vertices, faces, etc. cannot be selected. 

Such parts are highlighted in a special color when selected and are marked in the model tree with a special 

icon (“feather”). The omitted data is loaded automatically as needed.  

 

Such a need arises when editing parts, when performing various modifications and geometry analysis, as 

well as when creating projections.  

You can also specify mimimal size of displayed parts. 

The image detailing level can be set for 3D fragments. One can choose a “Rough”, “Middle” or “Accurate” 

quality. 

When in the large assembly mode, the context menu on selected parts gains special commands that serve 

to:  

 Unload Geometry. Force unloading Body geometry from the assembly; 

 

 Load Geometry. Force loading Body geometry to the assembly; 
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 Don’t unload Geometry. When this option is active, the geometry of the concerned body will not be 

unloaded automatically. 

An auxiliary means that helps ease working with large assemblies is the capability of creating 2D projections 

based on a 3D model located in an external file. This allows separating the model handling process and 

the drawing creation. An associative relation is still maintained between the drawing and the model.
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ADAPTIVE 3D FRAGMENTS 

GENERAL INFORMATION  

An adaptive fragment in T-FLEX CAD is a 3D fragment with the external parameters being not only external 

variables, but also geometrical elements. A geometrical parameter can be represented by any model 

elements (a solid, 3D node, 3D path, 3D profile, workplane, LCS, vertex, edge, face, loop). The idea of the 

approach is using the substitution geometry of an assembly element instead of the original geometry of 

the external parameter in the structure of an adaptive 3D fragment when regenerating a particular instance 

of its model. In this way, the 3D fragment acts as if “adapting” to the objects of the assembly model. For 

example, adaptive 3D fragments are used in special operations of inserting holes and creating stamped 

features in the appropriate system commands. 

 

To use a 3D fragment as an adaptive model element, define in advance the set of geometrical parameters 

that can have relations with objects of an assembly model. Just like a set of external variables, a set of 

geometrical parameters is defined in the document of the given 3D fragment. The system allows defining 

geometrical parameters and their values actually at the time of inserting or editing a 3D fragment; however, 

the created relations will be used in this case only in the current assembly model. In such a case, this 

information will not be saved in the 3D fragment’s document. When inserting an adaptive 3D fragment, 

the user specifies the values of geometrical parameters. The type of the instantiating object must be the 

same as the type of the object which is the parameter of the 3D fragment. For example, the instantiating 

value for a 3D profile can be defined only by a 3D profile. 

The use of geometrical parameters for a 3D fragment can be combined with use of external variables and 

attachment coordinate systems. However, while doing so, keep in mind the specifics of instantiating a 

parameter object, as the substitution affects both the geometry of the adaptive parameter and its position 

in the assembly. As we know, the position of a 3D fragment in an assembly is defined by the source and 
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target coordinate systems. Those coordinate systems can be specified by LCS or defaulted to the global 

coordinate systems of a 3D fragment and an assembly models. 

 

When instantiating the geometrical parameter, the system runs a “reverse” transformation by carrying the 

object from the assembly to the 3D fragment model, from the target LCS of the assembly towards the 

source LCS of the 3D fragment.  

 

Upon instantiating the values, an adaptive 3D fragment is regenerated and inserted into the assembly 

model. The user needs to insure correct orientation of the parameter object instances to have them 

positioned according to the design intent upon embedding in the 3D fragment model. 

On the diagrams below, a 3D profile instance substitutes the original profile defining a hole in a wall of a 

3D fragment. According to the intent, the new profile instance will serve for creating an array of holes in a 

wall of a 3D fragment. Among the two possibilities, in the first case the profile instance will be suitable for 

creating holes upon embedding in the 3D fragment model, while not so in the second case.  
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Let's review in details what happens with the 3D fragment model in the second case. Since a different 

instance of the 3D profile is used in this case, oriented differently with respect to the target LCS, then the 

result differs in the final position of the profile in the 3D fragment model. The detail view clearly shows 

that protruding the array of profiles in the second case does not lead to hole creation (to demonstrate 

that, the second operand of the Boolean subtraction was left in the scene); therefore, the 3D fragment is 

inserted in the assembly without holes in its wall.  

If, upon inserting an adaptive 3D fragment, it is necessary to use the source coordinate system, then 

make sure that it is created based on 3D fragment model elements (3D nodes, edges, vertices) that 

are independent of the external geometrical parameters. In other words, the parents of the source 

coordinate system shall not change upon instantiating adaptive elements. 

SETTING UP ADAPTIVE 3D  FRAGMENT  

To make a 3D model suitable for use as an adaptive 3D fragment, a set of objects (adaptive elements) 

needs to be defined, whose geometry will be driven by the assembly objects. 

To specify the list of geometrical parameters, use the command 3U: Set Adaptive Fragment Parameters. 

The command is called as: 

Icon Ribbon 

 

3D Model → Advanced → Adaptive fragment 

Keyboard Textual Menu 

<3U> Tools > Adaptive Fragment 

Upon calling the command, you can fill in the item “Name” in the properties window (optional). The entered 

string will be the name of the 3D fragment in the model. If the name is not specified, the default “Part_No” 

is used in the model. The “Comment” item may contain a text explaining the intended uses of the given 

3D fragment. 

If a fragment document is equipped with a slide, this slide will be used as the icon of the 3D fragment in 

the model tree of the assembly document. Icons are created in the command Tools > Special Data > 

Preview. 
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To add a new object to the list of adaptive elements, select it in the 3D view window or in the model tree. 

The selected element appears in the upper list, “Model Elements”, in the properties window. Upon selecting 

an object, the system automatically adds to the list the topological elements of that object (edges, vertices, 

faces) that are referenced by the object’s children.  

The “Model Elements” list provides an intuitive display of interrelations of the selected object with 

its children and adds a capability of selecting elements that are not at the top level of the model 

hierarchy as the geometrical parameters. 

When creating or editing a 3D fragment in the assembly context (the “Top-down” design flow), the “Model 

Elements” list is built automatically. The system creates this list based on the objects that are referencing 

assembly model elements (3D profiles, workplanes, 3D nodes, etc.). If a 3D fragment is intended for 

insertion in other assembly models, the user can compose the list of external geometrical parameters by 

using the already built “Model Elements” list.  

To give an example of composing a list of external geometrical parameters, let's consider a 3D fragment 

that defines creation of a stamped feature (see the diagram at the beginning of the chapter). To create a 

groove in the assembly, all that is necessary is just to specify the body face in which the groove is to be 

extruded, and the trajectory defining its contour. The first element in the “Model Elements” list will be the 

3D profile serving as the base for creating the sweep. Let's designate the “Extrusion_1” as the second 

element in the list. In this way, the system adds to the list the face of this operation, since the face is the 

parent element for the “Sweep_2” operation. 
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The set of object types allowed for selection is defined by the option: 

 <V> Select type of parameter 

The drop-down list will help setting up the internal command filters for selecting objects of a certain type: 

workplane, worksurface, coordinate system, operation, 3D path, 3D node, 3D profile. 

The default active option in the automenu is: 

 <M> Show parameter in Fragment document 

It enables highlighting of the objects that are not at the top of the model tree hierarchy. For example, if 

the given operation is active, then upon selecting a face of the operation “Extrusion_0” in the list of objects, 

this face will be highlighted in the model (at the same time, all children of “Extrusion_0” will be temporary 

removed from the 3D scene). 

 

If the option is not active, then highlighting will only work if the current element in the list is a top-level 

operation. Therefore, in this particular example, the Extrusion_0 and its face will not be highlighted in the 

model. 
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The next required action is composing the “External Elements” list. This list gets the elements from the 

“Model Elements” list, that will be instantiated upon inserting the 3D fragment into an assembly model. 

We recommend putting in the list of external parameters all 

topological children of the model object, that were entered in the 

upper list, and instantiate them as values in the assembly.  

Suppose, the external parameters list of an adaptive 3D fragment does not 

contain all topological children of the selected model object, or some of 

those objects are not instantiated upon inserting this fragment into an 

assembly. In this case, upon regenerating the 3D fragment model (at the 

time of inserting it in the assembly) errors will occur when creating the 

operations (or other objects) that are based on the uninstantiated 

topological elements. 

To avoid a large number of unnecessary dependent elements in the list of 

geometrical parameters, prefer building the 3D fragment model in such a 

way that the model elements used as geometrical parameters are at the 

highest possible level in the model tree structure. 
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Move elements by selecting in the upper list and pressing the graphic 

button . You can enter a comment for any element in the list of 

external parameters. The entered string will pop up as a tooltip in the 

properties window when selecting the parameter instantiating value in the 

command 3F: Insert 3D Fragment. If necessary, an external parameter can 

be renamed by editing the default name that is the same as the name of 

the model object. When selecting an element in the list of external 

parameters, the respective element is automatically highlighted in the list 

of model objects. This allows easily tracking the renamed model object that 

was used for creating an external parameter. 

The “Auto Select” flag can be used for objects whose children are external 

parameters themselves. For instance, in the current example, “Auto Select” 

can be set for Extrusion_0 in order to reduce the number of items to select. 

 

Example of creating adaptive 3D fragment 

Let's review a simple example – a body in a 3D 

fragment file created from three operations: 

rotation, extrusion and a boolean operation. 

The “Extrusion_1” contour is constructed on a 

workplane that references an edge of 

“Rotation_0”, extrusion direction – along the 

normal to the profile plane. 

We need to create an adaptive 3D fragment that 

will be creating a grooving based on a round 

edge selected on any assembly operation.  

To compose the “Model Elements” list, simply select “Rotation_0” in the tree.Its edge and face that are 

parents of “Extrusion_1” will be added to the list automatically. “Extrusion_1” in this case is the operation 

that is used for creating the grooving. 
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The next step will be creating the list of external parameters. It's enough 

just to move the edge and face into the lower list, while the operation on 

which the grooving is to be created will be determined by the system 

automatically. Fill in the comment entries for each element and set the 

“Auto Select” flag for the face. Let us remind that instantiating upon 

inserting a 3D fragment is done only for the objects that are entered in the 

list of external parameters. In a general case, the “Model Elements” list may 

contain the elements that are not used as the external parameters. If in the 

current example the edge would have not been moved to the list of 

external parameters, then it would not be possible to specify what 

particular edge of the assembly to use for creating the grooving. In other 

words, the parent would have not been defined for “Workplane_3” in the 

fragment and, therefore, the “Extrusion_1” operation would have not been 

created. 

The contents of the adaptive elements list can be managed by graphic 

buttons in the properties window: 

- for the “Model Elements” list: 
 

 - Delete. Deleting current element; 

 - Delete all. Deleting all elements; 

 - Delete unused. Deleting unused elements. This button becomes accessible if the list 

contains objects deleted from the model. Such objects are marked in the list by the icon . 

- for the “External Elements” list: 

  - Up/Down. Moving current element around the list; 

 - New Folder. Creating a new folder. The list of external parameters can be organized into a 

tree structure, by distributing the list elements over different levels or over different folders in one 

level. When inserting a 3D fragment into a model, its geometrical parameters will be displayed 

according to the defined structure; 

 – Rename. Renaming selected external parameter. For each external parameter you can 

assign the meaningful name; 

 - Delete. Deleting current element; 

 - Delete All. Deleting all elements. 

Elements of the external parameters list can be renamed. To do this, click  at an element’s name, and then 

edit the parameter’s name. 
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INSERTING ADAPTIVE 3D  FRAGMENT ,  INSTANTIATING ADAPTIVE 

ELEMENTS  

When invoking the command 3F: Insert 3D Fragment for a 3D fragment with defined adaptive elements, 

the default focus is set on the “Value” entry of the first external parameter in the properties window, in the 

“Geometric Parameters” section. A bar below the list displays the comment to the current parameter. To 

define the value, in the 3D view window or in the model tree select an object of the same type as the 

external geometrical parameter of the 3D fragment. 

 

If the 3D fragment selected for inserting has the geometrical parameters preset the following option will 

be available in the auto menu: 

 <R> Show Geometric Parameters of Adaptive Fragment 

It allows viewing the 3D model of the fragment being inserted in an additional window, with the current 

external parameter highlighted. When selecting an object, the system also picks the instantiating values 

for those parents of the current parameter that are flagged “Auto Select”. The automatic instantiating can 

be altered by selecting a different model object. 

Use the  option to complete 

insertion of a 3D fragment. If errors 

are encountered in the 3D fragment's 

model due to the specified values of 

the geometrical parameters, then the 

3D fragment will not appear in the 

scene and the appropriate messages 

will be output in the diagnostics 

window. 
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DEFINING ADAPTIVE ELEMENTS OF AN EXIST ING FRAGMENT  

The system supports defining the list of external parameters and their instantiating values for both inserting 

new fragments and editing existing fragments in an assembly. To add an additional parameter, call the 

command for editing a 3D fragment. In the “Geometric Parameters” section of the properties window, 

press the button  and select the 3D fragment model's element to become an external parameter. The 

next step will be either instantiating its value or adding more parameters to the list. The difference of this 

approach from the steps described in the “Setting up adaptive 3D fragment” section is that such changes 

in the list are remembered only in the current assembly. When inserting this 3D fragment into another 

assembly model, the elements added to the list will not be available. Therefore, any 3D fragment of an 

assembly model can be converted to an adaptive 3D fragment, and the predefined list of geometrical 

parameters of an existing adaptive 3D fragment can be extended.
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2D PROJECTIONS. CREATING 2D DRAWINGS OF 3D 

MODELS 

A 2D projection is a two-dimensional image located in the 2D window, obtained by projecting a three-

dimensional model or its selected portion on the specified plane. Projections can be used for creating the 

necessary views on a 2D drawing, with their subsequent decorating, as well as for obtaining local views 

and sections. One can project whole bodies or even groups of bodies, as well as selected elements of the 

model, such as faces or edges. If you are working with large 3D models, use the method of creating 2D 

projections in a separate file. Projecting is also actively used in three-dimensional modeling for drawing 

on active workplanes bound to the topology of three-dimensional objects, for example, to faces or edges. 

TYPES OF 2D  PROJECTIONS  

T-FLEX CAD allows creating 2D projections of the following types: 

 Precise (Image Lines). The view of the projection of this type represents itself a collection of the 

graphic lines; 

 

 Vector Picture. The view created on the projection of this type entirely corresponds to the type 

“Precise (Image Lines)”. However, in this case the graphic lines themselves are not created, and the 

projection is drawn as a picture. This mode allows a user to reduce the 2D projection generation 

time, and also reduce the memory usage required for creating a large number of graphic lines; 

 

 Shading. The view of the projection is drawn in the form of shading which corresponds to the mode 

of the same name in the 3D window; 

 

 Rendering. The view of the projection is drawn in the form of rendering which corresponds to the 

mode of the same name in the 3D window; 

 

 Wireframe. The view of the projection is drawn as a wireframe which corresponds to the mode of 

the same name in the 3D window. In this mode, the parameter “Remove Hidden Lines” is available 

depending on which the removal of the hidden lines is carried out or not. 
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Projections of the types “Precise (Image Lines)”, “Shading”, “Rendering”, “Wireframe” have the following 

limitations: 

- it is not possible to hide (remove) separate elements (lines) of the projections or modify their 

parameters; 

- it is not possible to project 3D construction elements (3D paths, 3D profiles). Only bodies 

(operations) can be selected for projection. 

All types of 2D projections support the creation of the service elements based on the projection types. On 

the projection of the type “Precise (Image Lines)”, the service elements are attached to the projection lines, 

for the rest of the projection types – the service elements are attached directly to the elements of the 3D 

model. 

Creating projections of all types is carried out similarly. 

CREATING 2D  PROJECTION  

To create a 2D projection, use the command 3J: Create 2D Projection. Call the command as follows: 
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Icon Ribbon 

 

Draw → 2D Projection 

Keyboard Textual Menu 

<3J > Draw >2D Projection 

Upon calling the command, the following actions are available: 

 <1> Create three standard projections 

 <2> Create section view 

 <3> Create additional view 

 <4> Create local section view 

 <5> Create set of standard projections 

 <6> Create standard projection 

 <7> Workplane projection 

 <8> Projection by Projection 

 <9> Arbitrary View 

 <F> Select File with 3D Model to create Projection 
 

 

Before you begin creating drawings using 

projections, it is recommended that you determine 

the format of the drawing, how many pages it will 

occupy and what will be the scale on each page. 

All of these parameters are defined on the Page 

tab in the command Customize > Document 

parameters. Each page uses its own settings. The 

settings can be modified at any time. 

 

The general algorithm of creating a 2D projection 

includes several required and optional steps: 

Define the projection direction (required) by one of the 

following ways: 

- Using one of the options for creating 

standard projections (the options , 

, ). 

 
You can also select the type of the  

projection to create in a combo box 

 provided  in the properties window 
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- Automatically by the system, depending on the section line position, in the case of creating 

a section or local section view (the option ). 

- From the direction of the detail view specified by the detailing element (the option ). 

- Same as the direction of the original projection, when creating a local area view ( ). 

- By a workplane (the option ). 

- By 3D model elements, such as a flat face, using the set of additional options. 

- By defining the directional vector of projecting and the rotation angle about this vector in 

the projection parameters. 

- Along the projecting direction of an existing 2D projection (the option ). 

In most cases, the system attempts to determine the type of the projection being created by the 

first selected element. For example, if a section is picked, the system will offer creating a cut; picking 

a hatch prompts a local area view; picking a face – a general view, etc. 

Define the attachment point in the 2D window (optional). Normally, you need to specify the location on 

the drawing via a 2D node or free point at which the projection is to be created. In this case, the projection 

to be created is shown as a box indicating the projection extents. 

Select section to be used on the projection (optional). This step is necessary when creating a local view 

or section. 

Select bodies to subject to the section (optional). This step is necessary when creating a local view or 

section affecting only selected elements of the model being projected. 

Select model elements to project (optional). By default, the whole 3D scene is projected in its current 

state; however, it is also possible to project separate Bodies, operations or specific topology elements 

(faces, edges). 

Define projection parameters (optional). Some properties, such as scale, can be specified in the “2D 

Projection Parameters” dialog box or in the properties window. 

Select the type of 2D projection being created: “Precise (Image Lines)”, “Vector Picture”, “Shading”, 

“Rendering”, “Wireframe”; 

Confirm the input (required). As in any 3D command, the element creation must be confirmed upon 

competing definition of all parameters. This step is possible, when the option becomes accessible in the 

automenu:  

 <Y> Finish input 

Creating Standard Views 

The simplest way of quickly obtaining 3D model drawings is creating one of several standard projections 

(which is often sufficient). 
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Creating three standard projections 
For convenience, the capability of creating the three most common used standard views is separated in 

the special command, providing for the Elevation (“Front”) View, Plan (“Top”) View and Side (“Left”) View: 

 <1> Create three standard projections 

Upon selecting the option, the automenu offers the group of commands for creating the set of standard 

projections: 

 <M> Change projection placement 

 <K> Set/Break projection link with Front view 

 <E> Select model elements to project 

 

 

When creating standard views, the automenu has 

several additional options common for all types 

of projection (options for creating broken views 

and handling sections). Working with those will 

be described separately. 

If overall size of a projection exceeds the page 

size, system will open the dialog box with options 

for correcting inconsistency between the 

projection and the page. The dialog box offers 

the following options: 

 Change projection scale;  

 Change page scale;  

 Change page size;  

 Don’t change Scale and Page Size.  

All correctional parameters are calculated 

automatically. User can agree with them or set 

custom values. 
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Next, you need to position the projections on the drawing. 

Three blue frames appear in the 2D window, attached to the 

pointer. These frames mark the extents of the projections being 

created. Currently, all three projections are selected. Position a 

particular view, selected first. View selection is done by clicking 

once within the blue box (the second click activates the option 

of positioning the view ) or by selecting an item in the 

combo box in the properties window. After selecting a 

projection, you need to select the fixing point in the 2D view. If 

the view positioning option  is not yet active, engage it in 

the automenu. Click , and the projection will be attached to 

the position of the pointer. The option of positioning a view 

allows fixing a projection to an unconstrained point (right 

under the click) or to a 2D node. 

The mechanism of positioning a projection on the 

drawing is common to all types of projections; therefore, 

we will skip its detailed description in the future.  

 

 

If the front (main) view is being positioned, the rest of the views 

maintain their position with respect to the main one. When 

adjacent views are positioned, the projective relation is 

maintained with respect to the main view. The projection 

centerpoint snaps to the attachment point. To assign a specific 

3D model element as the attachment point, such as a 3D node 

or vertex, you need to use additional options for creating the 

projection that are made available by the option  (see the 

section “General case of creating projection”). 
 

By default, the adjacent views maintain the projective relation 

with the main view. This relation can be broken by the option 

. The property of being related to the main view is indicated 

by a special item in the properties window.  
 

Identical parameters are set for all views created simultaneously. In the case when different settings are 

required for a particular view, select it in the properties window. After that, you can define the specific 

elements to be projected on this view or select a 3D section to be used on the view. In some cases, this 

approach to creating views can save time. 

If necessary, one can select model elements to project using the option . Selection of bodies for 

projecting is described in details below, as this command is common for all types of projections (see the 

section “Selecting bodies for projecting”). 
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Creating the set of standard views 
This command is different from the previous one in that you can define an arbitrary number of standard 

views. All other steps are identical. Create a set of standard projections using the option: 

 <5> Create set of standard projections 

Upon calling the option, a dialog box appears for defining the projections to obtain. 

 

Creating one standard view 
Create the one standard view using the option: 

 <6> Create standard projection 

In the list of the standard views, select the one to be created. The type “Axonometric View” is added to the 

list of the standard views. Elements of this list are also present in the properties window, in the overall list 

of the 2D projection types.  

 

As usual, first, position the projection on the drawing – select the attachment point. In this case, you can 

attach the view being created to an existing 2D projection. You can define the relation between the view 

and another projection using the option . Once the option is engaged, select one of the projections. 
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Such a relation allows creating a “standard” view with respect to any arbitrary projection selected as the 

main view, that is, the “Front View”. The relation can be broken by the option . 

After attaching the view to the drawing, you can select elements to be projected using the option . 

Creating Additional View 

The directional view element is often used for decorating drawings. It can also be used for creating a 

projection. In this case, the projecting direction will be determined by the arrow and the projection nearest 

to the arrow. The mode of creating an additional view is turned on by the option: 

 <3> Create additional view 

 

Next, select a directional view element. The nearest to the 

arrow projection will then be highlighted. The system will use 

that projection as the main view. The additional view will be 

constructed relative to the main view. By default, the additional 

view maintains the relation with the main view. This relation 

can be broken using the option: 

 

 

 <K> Break link of Projection with Front View 

The final steps are positioning the projection on the drawing and, if necessary, selecting the model 

elements to be projected. 

Creating Local View or Section 

 

Before beginning with creating a local view or section, have certain elements available. First, you should 

create in advance either a 3D section (the command 3SE:Construct Section), or a 2D section on the drawing 

(the command SE: Create Section). Note that the latter element should be constructed on one of the 

existing projections. Only in this case it can be used for creating sections. 

The mode of creating a local view or section is set using the option: 

 <2> Create section view 

Next, you need to select a 2D section on the 2D drawing, or a 3D section. The normal to the section plane 

defines the projection direction. The elements are selected using the options: 

 <S> Create 2D Projection based on 3D Section 
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 <L> Select section defining projection 
 

Next, define the projection attachment point in the 2D view using the appropriate options. 

Breaking or reinstating the relation between the projection being created and the specified section is done 

using the option: 

 <К> Set/Break link with projection 

 

After that, you can select elements for projecting and elements to be sectioned. Selection of elements for 

projecting is done in a conventional way – by the option . By default, the section is applied to all bodies 

selected for projecting. However, this is not always required. There is a provision for specifying the list of 

operations or Bodies to be subjected to the section. 

When creating a local view or section on the basis of 2D section view, the presence of a gap on the initial 

projection is taken into consideration. 
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The parameters for controlling the sections that are in use are 

joined in one group and positioned on the tab “Sections” of the 

properties window. The used sections are displayed in the list 

“Use Sections”. This list displays the names of 3D sections or IDs 

of section notations. To select an additional 3D section, place 

the pointer at an empty line marked by an ellipsis, and then 

select the desired element in the model space or in the “3D 

model” window. Alternatively, a section can be selected by the 

automenu option: 

 <Ctrl+S> Select 3D Sections to apply 

The type of the projection created by using sections can be 

selected from the combo box: Section View, Only Section 

Planes, Unfold/Radial Section and Section with Unfolding. 

Unfolding can be done only if a composite section was used (a 

one containing multiple segments).  

 

Each of the sections can be applied to all objects being 

projected at once, or just to the specifically selected objects 

among those being projected. The list of operations/Bodies 

subject to the selected section is displayed in the “Use Sections” 

list. To select elements, use the list in the properties window or 

the automenu option: 

 

 

 <Ctrl+O> Select Operation to which 3D Section will be applied 

 

This option allows selecting not only operations, but also Bodies.  

The way of using the list of bodies can be set in the combo box. The available options are “Selected 

elements”, “All elements excluding selected”, “All elements”, “From section parameters”. The “All elements” 

option is set by default in the used if the elements list is empty. When choosing the “From section 

parameters” option the section application rules are taken from the 3D section properties. 
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It is possible to specify beforehand that a 3D fragment will NOT be cut by a section when creating 

a section view of an assembly. This option can be set in ST: Set Document Parameters command 

and is usually used in the libraries of standard parts. 

 

The option “Unfold section planes/Radial section” can work in one of two modes. This depends on what 

type of multiple-point section is used in the case. If a multiple-point section is composed of all straight 

segments, the whole section will be fully unfolded. If at least one segment of a multiple-point section is a 

circular arc, then the radial section mode turns on. In this case, all arcs are skipped when unfolding the 

section. 

The option “Section with unfolding” always creates full section unfolding, even when the section contains 

circular arcs. 
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In the following example, two sections are created, both based on the main view. In the first case, the 

section was applied to the shroud only, while in the second case – to all bodies. 
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(Show only section plane lines)
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(Section with unfolding)
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The following additional settings are provided in the sections 

handling group of parameters: 

Fill Element Outline. This setting helps correctly draw 

threaded connections in which elements penetrate each 

other (due to the specifics of this type of connection). 

Additionally, some elements of the threaded connection 

(for example, the standard elements) can be exempted 

from section.  

Hatch. This parameter defines whether to hatch the section 

or local view. The precision of defining the hatch contour 

can be set in the provided box. 

Scale. The hatch scale 

Accuracy. This is the accuracy of tracing the hatch contour. 

Adjusting this parameter helps in complicated cases, 

when the system cannot hatch the contour under the 

previously specified accuracy. 

Fit angle. Sets the choice of automatic hatch angle 

definition for crosscut parts. The combo box provides two 

choices: «45, -45» only and «30, 45, 60, -30, -45, -60» 

 

 

Fit step. Sets the upper and lower limits on the values, within which the system automatically picks 

up a hatch step. The step size is determined relative to the area of the hatch contour. 

By Graphic Lines. This option is available only for projection of the type “Precise (Image Lines”). When 

this flag is on, the hatch on cuts/sections is formed by graphic lines of the projection, when it is 

off – by faces which appear on the projected body as a result of applying 3D section. 

By default this flag is turned off, i.e., the hatches are created by the faces of the section (since the 

graphic lines on the projection do not always form a closed contour due to loss of accuracy while 

projecting). 

It is recommended to turn on the flag “By graphic lines” if the hatch being created will be used 

later for construction of 3D profile or local section view. 

Managing hatch properties in cuts and sections 
The drawing standards require that all cut or sectioned parts are hatched in a certain way. If the material 

the part is made of requires hatching by a special pattern, then the appropriate «pattern» hatch type must 

be set in the material properties. In all other cases, the material is hatched in the sectioned areas by the 

repeating lines with a certain slope and step. If multiple bodies are involved in a section, then the hatch 

slope and step must differ across them. When creating a cut or sectioned for the first time, the system 

automatically picks different hatch properties (slope angle and step) for different parts. Note also that the 

hatch parameters that were once picked for a certain part (operation) are automatically remembered in 
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the model, and the same hatch parameters will be used for the same part in any cuts or sections on other 

views.  

Those hatch properties are stored together with the original operation and are propagated on child 

operations, whenever those have the flag set, «Attributes from source operation». 

Nevertheless, the user can modify hatch properties in a cut at any time by editing its parameters. Upon 

confirming changes to hatch properties, the system will query you, offering two choices for the 

continuation. 

 

If the user responds «Yes», then the specified new parameters of the hatch slope angle and step will be 

saved in the model and will later be used for this part in all cuts and sections in which the part is involved. 

If the user responds «No», then the hatch will assume individual settings and will not depend on the 

operation properties in the future. 

To revert the individually specified hatch properties back to the properties assumed from the 2D 

projection, one would need to right-click this hatch  and in the coming up context menu select 

the item «Properties from Projection».  

Another useful item in the context menu of a cut hatch is Do not apply section. Upon calling this command, 

the operation for which the cut hatch was created will be added to the list of the operations that shall not 

be subjected to sectioning in the given projection. After that, the projection will be automatically rebuilt. 

Creating Local Section View 

This command allows creating local section views on an existing projection: 

 <4> Create local section view 

The boundaries of the local section view are defined by the hatch contour. The latter must be created 

before creating the local section view. To select the hatch, turn on the option: 

 <H> Select Hatch as boundary of local section view 
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Upon completing creation of the local section, the hatch 

becomes invisible, while screening out a portion of the main 

projection. The lines of the local section will be drawn with 

higher priority, than those of the hatch and the main 

projection. 

Geometry of the graphic lines bounding the contour of the original 

hatch can be taken into consideration when defining the boundaries 

of the local section view. For example, if the hatch contour pattern 

was set as waves, the boundaries of the local section view will also 

have waves pattern. A user can toggle on/off the lines type switch 

found in the parameters of the local section view. 

Next, define the position of the section plane. The plane normal 

automatically coincides with the viewing direction of the main 

projection – the one used for creating the local section view. 

Thereafter, position the view plane either by a 3D node or by a 2D 

node in another projection. For example, if you are creating a local 

section on the Left View, then the 2D node can be selected in one of 

the adjacent standard views: Front, Top, Bottom, Back. 

The 2D or 3D node can be selected using the options:  

 

 <3> Select 3D Point, defining section position 

 <2> 
Select 2D Node on other Projection, defining section 

position 

The local section view is automatically tied to the projection on which it was created. However, this tie 

needs to be broken in some situations, in order to attach the local view to the drawing at a different 

location. The option to break the tie is: 

 <К> Break link of Projection with Front View 

Once the tie is broken, the following option is available for attaching the projection to the drawing (an 

unconstrained attachment or snapping to a 2D node). 

 <M> Click to select 2D Projection attachment Point 
 

When creating a local section view, we recommend selecting specific model elements to be 

projected. Selecting the elements that actually fall in the area of the local section view speeds up 

regeneration of the projection. 
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Creating Projection on a Workplane 

The projection on a workplane is used when working with active workplanes. For example, when creating 

a new workplane based on a flat face, the selected face can be automatically projected on that workplane. 

The command of constructing the projection on an active workplane can be called by the icon , located 

on the main toolbar in the button sets “Workplane” and “Workplane (Sketch)”. 

If the workplane is present in the 2D view, sometimes it is convenient to use that workplane for projecting 

model elements. The following the option is provided for this purpose: 

 <7> Workplane projection 

The workplane can be selected either in the 3D window or on the 2D view. The projection will be created 

in the same page of the drawing as the selected workplane. You do not have to explicitly position the 

projection on the drawing. The position of the projection is determined automatically, since each 

workplane has its specific position in the 3D space. The objects are projected on the workplane along its 

normal direction. 

Projecting 3D point on workplane 

The capability of creating a 2D node on a workplane as a projection of the 3D point is not directly 

related to the 2D projection construction command, nor it has to the T-FLEX CAD “2D projection” 

element. 

Creating a 2D node as a projection of a 3D point is used when working with active workplanes, often 

together with the command for constructing a 2D projection on a workplane the command for creating 

3D nodes - projections of 3D point saves computational resources of the computer when it is not necessary 

to create a conventional path 2D projection. 

The icon  that launches the command of constructing a 2D projection node is located on the main 

toolbar (in the sets “Workplane” and “Workplane (Sketch)”) and is available only when working with the 

active workplane. To create a projection node, select a 3D point in the 3D window. 
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General Case of Creating 2D Projection 

The most general approach to creating a 2D projection is supported by the “Arbitrary View”  item. 

Upon turning on the option, the following actions are available: 

 <M> Click to select 2D Projection attachment Point 

 <F> Select Plane to set view direction 

 <N> 
Select point for superposing with the attachement 

point 

 <K> Cancel setting of view direction 

 <S> Select 3D Sections to apply 

 <E> Select model elements to project 

 

First, define the position of the projection on the drawing – select the 

attachment point.  

The axonometric projection of the whole scene is created by default in the 

world coordinates. The projection of the world coordinates origin is 

snapped to the point on the 2D view selected at the previous step. A 3D 

point can be selected to define the point in the space for aligning with the 

fixing point on the projection. 

The projecting direction can be changed by one of the following means: 

 Select projection plane. The projecting direction will be 

defined by the normal to this plane. To select a plane, use the 

option: 

 

 

 <F> Select Plane to set view direction 

 Define the viewing point in the properties window. It can be defined using coordinates or by 

selecting one of the standard or custom views. 

The coordinates of the view direction can be defined in the properties 

window. The X, Y and Z are entered in the respective input boxes of the end 

point of the direction vector. The start point of the vector is the origin of the 

world coordinate system. A user-defined custom view can be loaded with the 

help of the button “Load” . A custom view can be saved via the command 

“3VP: Set View Parameters”. 
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Angle is the parameter defining the rotation angle of the 2D projection on the 2D view about the fixing 

point. The positive values define rotation in the counterclockwise direction.  

Defining the coordinates and the rotation angle is possible only after creating an arbitrary view. When 

creating other types of view with projective relation, such as standard or section view, the coordinates are 

defined by the system, and so these fields may be blocked. 

Creating a 2D projection by an existing projection 

To create such a projection, the  option is used. Upon selecting this mode, the following options 

become available in the automenu: 

 <V> Select source Projection to specify Parameters 

 <E> Select model elements to project 

 <A> Select all Solids in current scene 

 <F> Select File with 3D Model to create Projection 

 <Ctrl+S> Select 3D Sections to apply 

 <Ctrl+O> Select Operation to apply 3D Section 

First, the source 2D projection is to be specified in order to use its properties for the projection being 

created. The new 2D projection will match the source one in its position, orientation, and the use of broken 

views. The rest of the projection parameters can be edited: you can change the list of the objects to be 

projected and the applied sections, the projecting (mapping) method, available line styles, and hatch 

parameters. 

The newly created 2D projection is automatically assigned the priority which is by five points greater than 

the source projection. In addition, the flag “Create Outlined Area” is set in the properties of the new 2D 

projection (see the section “2D projection parameters”). 

This method of creating a 2D projection can be used to construct projections of threaded connections 

where both the “screw” and the “nut” of the connected pair are sectioned. The thread lines of both the 

“screw” and the "nut" will be overlapped on the projections in which both parts are simultaneously 

sectioned. To insure the correct appearance of a threaded connection, what one can do is originally create 

the projection of the sectioned “nut”, and then create another 2D projection based on the first one, where 

you specify the “screw” only in the “to be projected” list. 

Selecting Elements for Projecting 

By default, that is, when nothing was selected, the whole scene is assumed selected for projecting. The 

option “Full scene” projects all operations visible in the scene at the time of regeneration, regardless of the 

number of the operations that were in existence at the time of creating the projection. New 3D elements 

cannot be created based on such projections (due to possible topology change or recursion), as prompted 

by the system warning at the time of creating the projection.  
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The elements need to be selected in the cases, when only specific elements need to be projected, rather 

than the whole model (particular operations, Bodies or construction elements/topology elements), or if the 

projection is intended for creating 3D elements. Besides, often happens, that some model objects are 

simply not visible on the projection because those were screened out by other bodies. For example, some 

parts may be inside a shroud. In this case, it is useful to exclude from projecting the objects that are not 

visible anyway. This will benefit in saving regeneration time of such a projection. 

To select specific model elements, use the option provided in any mode of creating projections: 

 <E> Select model elements to project 

 

This option has a pulldown list of filters for selecting the desired 

objects. Allowed for selection are Body, operations, 3D profiles, 3D 

paths, faces, edges and loops. The set to filter options for selecting 

objects is duplicated on the system toolbar. 

When activating the option  the group Projection Elements 

automatically opens in the properties window. This group contains 

a list into which selected elements are put. The list is subdivided 

into separate tabs according to the type of selected objects – 

“Bodies and operations”, “Welded joints”, “Profiles”, “Paths”, 

“Coordinate systems”, “Geometric elements”.  

It is also possible to activate the mode of selecting the elements for projection with the help of 

dialog of properties window. For that, it is sufficient to place the cursor in a free line of the list 

marked by dots and the option  will be turned on automatically. 

For each type of the selected elements the user can specify the 

method of projecting: 

- All elements – all elements of the given type in the scene 

will be projected; 

- Selected elements – only selected elements of the given 

type will be projected; 

- All except selected – all elements of the given type that 

has not been selected will be projected; 
 

- From file (only for Bodies and operations) – this option is set if projected operations and Bodies 

are selected from external file (see Section “Construction of 2D projection from model in external 

file”). When selecting this method, the option of selecting a file  is turned on automatically 

in the command’s automenu 

- Same as in operation (only for welded joints) – method of projecting welded joints will depend 

on the method set for operations and Bodies. If “All elements” is set for operations, all welded 
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joints will be projected. If any other method is set for operations, then welded joints are not 

projected. 

By default, for Bodies and operations the mode “All elements” is set, whereas for profiles, paths and 

coordinate systems – mode “Selected elements”. For geometric elements (faces, edges, loops) the method 

of projection is not specified (only selected elements are always projected). 

Projection of coordinate systems has certain specific features. The 

coordinate systems are projected on top of the entire 3D model without 

taking account of visibility. Projection lines of the coordinate systems are 

ignored when determining the boundaries of the projection. 

Projections of the coordinate system are formed from three graphic lines 

with arrows. The color of each line-axis coincides with the color of the 

corresponding axis of the global coordinate system in the 3D scene. The 

style of the lines can be modified as for the standard graphic lines of the 

drawing. 

The length of the coordinate system axes is controlled by the 

parameter Size > Coordinate System in the dialog of the command 

ST: Set document parameters, tab “3D”. 

 

Projection of global coordinate system is specified separately with the help of Global CS. Selected method 

for projection of LCS does not affect projection of global coordinate system. 

The automenu provides a separate option for quick selection of all operations currently present in the 3D 

scene: 

 <A> Select all Solids in current scene 

The difference between the behaviors of the option “Select all Solids in current scene” and that of the 

mode of projecting the whole scene can be described as follows. The list of all operations selected in the 

3D scene is formed at the time of using the option and stays unchanged unless intentionally modified. 

Therefore, the new bodies added to the scene do not appear in the list of the elements to be projected. 

Constructing a 2D Projection Using a Model from an External File 

The mode of constructing a projection by a model from an external file is useful when working with 

complex 3D models and assemblies, in which cases you can significantly save the computational resources 

by avoiding the 3D model recalculation. When creating a 2D projection, the system takes from the external 

file only geometrical data saved in this file. It is also possible, if necessary, to compose a single drawing 

from different 3D models (different versions, individual fragments, etc.). 

The option to select an external file to construct a projection is available in the command's automenu: 

 <F> Select File with 3D Model to create Projection 

If the user calls the command to create a 2D projection, but no 3D model is present in the current 

document, then at the beginning this will be the only option in the automenu. Upon calling this option, 
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the standard dialog window to select the file will appear. Once you selected a file with the 3D model, all 

the rest of the options to construct the projection would become available in the automenu. After that, the 

projection is constructed as usual. At the same time, there are restrictions on selecting elements to map 

(project). In this case, it is always the entire 3D model contained in the selected file that will be mapped 

(projected). 

If it is necessary to create several projections based on an external file, you do not have to select it 

over each time. When constructing  related views (a related standard view, cuts and sections, arrow 

views), the data about the 3D model is automatically accessed from the initial projection. 

The information about the used external file is recorded in the 3D model tree next to the 2D projection 

name. If you right-click on the 2D projection , then you will see in the context menu the command to 

open the file, which it uses. The name of the file used to construct the 2D projection can be found on the 

"Elements" tab of the «2D Projection Parameters» window. 

 

The mode of constructing a projection based on the model from external file can be also activated 

by setting the method of projection “From file” in the group of the properties window “Elements” 

for Bodies and operations. Simultaneously, the option  will be activated automatically. 

Creating Broken View on Projection 

When creating long parts, it is often necessary to limit the part view to a certain portion to keep the drawing 

compact. T-FLEX CAD provides a tool for creating projections with broken view of the three-dimensional 

parts. The broken view can be created for all types of projections, except for the local section view and the 

unfolding section view. 

Pay attention to the following details when working with broken views:  

 When attaching a radial dimension or both legs of a linear dimension to lines of such 

projection or their children, the system automatically adjusts the dimension to obtain the true 

value.  

 If the broken view was created in an already existing projection (when editing it) with some 

elements attached to it, such as dimensions, then these elements may get lost view to 

changes in the projection topology after creating the broken view. 
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If you create a new projection on the basis of the projection with a break, the break from the main 

projection will be copied to the dependent projection. 

The option for creating the broken view on a projection is available in many modes of creating projections: 

 <B> Add or edit Broken View 

 <V> Add horizontal break 

 <H> Add vertical break 

 <R> Enter angle 

The reduction can be performed only in two orthogonal directions. The number of breaks in either direction 

is unlimited. A break is defined by a rectangular area. Two of its boundaries are determined by the extents 

of the projection, while the other two are defined by the user using the mouse and the appropriate options. 

The rectangular area of the break is hatched by the lines at the time of creating and editing, the lines 

direction indicating the direction of the reduction (orthogonal to the breaking lines). The preview image 

of the projection is drawn in blue lines. 

The following diagram shows an example of a projection with a broken view. 

 

Also additional settings of broken views are done with the help of the properties window. 

Each broken view is added to the list of broken views in the properties window. Elements of this list are 

preceded by the icons marking the break direction (vertical/horizontal). Each broken view has properties 

defined, that determine the placement of the break lines on the projection. Initially, these properties are 

predefined automatically, as soon as the user selects a break location by the mouse. If the values are 

defined by variables then the respective variable name will appear in brackets next to the numerical value. 

Breaking lines position can be defined by absolute numerical values (the parameter “In model units”), or in 

percent (the parameter “In percents”). 

Start. This value defines the position of: left boundary - for a horizontal break, or the bottom one - for 

vertical. 

End. This value defines the position of: right boundary - for a horizontal break, or the top one - for vertical. 
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With the mode “In model units” turned on, the start and end values can be defined by variables. 

Distance between the break lines defines the distance between the pieces of the broken projection. 

Angle. This parameter defines the angle of rotating the break lines with respect to the 

vertical/horizontal (according to the direction of the break). The positive direction is 

counterclockwise. 

The angle can be also specified with the help of the option . After enabling this option, the line 

defining the initial boundary of the break (it is shown with red color) will play a role of a dragger. 

To specify the angle of rotation, it is enough to bring the cursor to this line, press  and move the 

boundary by a desired angle. 

Length of extension line. If the flag is cleared, then the breaking lines on the projection are restricted 

by the intersection points with the body. Otherwise, the breaking lines extend from one end of the 

body to the other end and beyond its limits by the “Length of extension line”. 

Don’t move broken parts. When the flag is on, projection lines, remained after applying the breaks, 

don’t change their location. 
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The following two parameters are intended for controlling the position of the 

break and its behavior with the model and the projection modifications. 

Those are available only if the break is defined “In model units”. 

Horizontal binding (Left, Center, Right). 

Vertical binding (Bottom, Center, Top). 

To describe how these parameters are used, we need to introduce the 

concept of the “outline box”. The center of the outline box is located in the 

center of the circumscribed rectangle of the projection. The outline box is a 

square, whose line length is equal to the length of the longer side of this 

rectangle. It is not displayed on the screen. 
 

The outline box is always are calculated on the projection 

regeneration. Therefore, a new outline box is generated as the 

projection dimensions change.  

An important fact is the distance defined by the parameters “Start” 

and “End” is always counted from the lower-left corner of the old 

outline box. 

The parameter values for the horizontal\vertical attachment defined 

a way of positioning the old outline books with respect to the new 

one. Suppose, for example, that the right center attachment is 

specified. This means that, after calculating the new outline box, the 

right side of the new box will be snapped to the right side of the old 

box, while the centers of both boxes will be placed on the center 

line of the part. The breaking lines are always constructed with 

respect to the lower-left corner of the old outline box. 

 

To set up the properties of the lines of a break’s boundaries, call an additional dialog. To launch it, press 

the button [Line Types] in the properties window. 

Show break lines. The option allows to hide break lines on the projection. 
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Broken lines type. The break in the projection can be outlined by lines of different types. This can be 

a straight-line, a waves, or a polyline. The waves and the polyline are provided the parameters  

 

Amplitude and Period. The units are same as the model units. 

 

Keep in mind the specifics of the broken view projection creating mechanism. When generating the 

projection, the program internally creates a cut according to the specified break type. Therefore, the 

more complex the breaking line, the longer it takes for regeneration of a broken view projection. 

 

The parameters Scale factor, Thickness and Line Type in this tab define the style of the breaking lines. 

When creating a new broken view, the breaking parameters can be copied from an existing projection.  

 

Upon pressing the button , the system waits for selecting a projection, whose breaking parameters will 

be copied to the projection being the defined. This is a one-time action. That is, when modifying the breaks 

of the original projection, the breaks on the projection to which they have been copied are not modified. 
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Type Selection for Created 2D Projection 

The type of a 2D projection being created (regardless of its creation 

method) is set in the command's properties window, in the group “Basic 

parameters”. 

The projection type is selected from the drop down list. 

 

PARAMETERS OF 2D  PROJECTION  

Some parameters of a 2D projection can be defined in the properties window at creation or editing. 

Additionally, the parameters dialog box can be accessed at any time from the context menu, or at any time 

while editing, when the option is accessible: 

 

 <P> Set entity parameters 

“General” tab 
Name. The following default names are assigned to 2D projections: Projection_0, Projection_12, etc. 
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Update. This parameter defines how the projection will be updated. 

- Auto (on any changes to model). 

- Manually and on full regeneration (when choosing the command "Update 2D Projection" or 

upon full model regeneration). These settings make sense only when dealing with complex 

models, whose full regeneration takes considerable time. 

Regeneration of “Vector picture” projection, in case of manual regeneration or regeneration on 

request, is carried out in background mode. When starting up regeneration, 2D projection view on 

the screen is replaced with a simplified view (similar to the view displayed in the 3D window in the 

mode “Quick hidden lines removal”). After that, they user can work with the system, for example, 

detail a drawing based on this projection. In parallel, the accurate regeneration of the projection 
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will be performed simultaneously. When the regeneration is completed, the simplified picture of the 

projection is replaced with the results of the accurate calculation. 

This approach allows the users to simplify the work with projections having long regeneration time. 

After creating and editing the projection, the users can continue working with the system right away, 

not awaiting the completion of projection recalculation. 

Penetration.  

Ignore penetration of bodies. Bodies intersection is not considered. 

Consider penetration of bodies. When projecting a group of mutually intersecting bodies, you can 

turn on the body intersection analyzer. With the parameter is set, the system will build the 

projection, taking into the account the intersection of bodies. It will increase the time of calculating 

the projection. 

Define intersection of bodies. Allows you to create accurate isometric projections with a section. 

Recognize straight lines. Recognize circles. These parameters turn on special algorithms that recognize 

straight segments or circles (circular arcs) within some tolerance limits. This is necessary in the cases when 

complex geometry is being projected. For example, projecting a variable-radius blend creates a polyline. 

With this option turned on, the polyline is replaced by a circular arc. The resulting arc can now be 

dimensioned. When these options are used, there is some loss in the projection accuracy. This may 

sometimes cause problems with automatic hatching of the sections and local views. This is due to rips that 

might occur in a contour, preventing the contour from hatching. A special option is provided to deal with 

the problem by controlling the accuracy of searching hatch contours (see the tab “View”). 

Exploded View Scenario. The option is available only if there is at least one exploded view scenario.  

The projection is constructed using transformations from the selected exploded view scenario. 

Variation. The option allows to to set link between the model configuration and the projection. Using the 

option you can create projections for each variation existing in the assemly. To specify a link, select the 

variation from the drop-down list. 

Simplify geometry. When the flag is set, Simplify model operation is performed before projections 

creation. This option is turned off by default, because it increases projections creation time. The option 

must be turned off when creating a projection of a sheet metal part unbending, for showing smooth edges 

of unbent areas. Option for showing smooth edges is located on in the Lines tab of projection parameters. 

When the option is active, splines are replaced with more simple geometry. You can create dimensions for 

it. 

    

Original part Simplified projection Bend areas are shown 
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Save information for 3D dimensions. This parameter allows creating 

“spatial” dimensions on nonstandard and perspective views (such as the 

axonometric view). 

Consider Welds. This option enables the display of weld seams created 

on the 3D model. 

Fill Welds. This parameter enables the mode of filling the side strips of 

the weld seams with a color. 

 

Geometry Search. If this flag is set on, at recalculation of a 2D 

projection, the search of service elements on the projection is 

performed by the geometry of the projection, and not by model IDs. 

 
A projection with «3D 

dimensions» 

When searching by geometry, the old location of the original projection element is taken (line, arc, etc.) 

and within the tolerance the nearest element of the same type is sought for. The identification search is 

performed regardless of the geometry by the projection elements internal ID formed during the history of 

the element creation. 

 

It is recommended to use geometric search when the model was subject to significant modifications and 

the usual search does not produce results (for example, upon updating the projections of the imported 

geometry after modifying the imported model with an external application). 

 

Create Outline Area. This option constructs an invisible outline hatch on all projected bodies with the 

priority of one point less than the priority of the projection itself. As a result, you can overlap some 

projections with other projections. 

 

This option doesn't work or works incorrectly in the case when paths, edges, faces, or loops are selected 

for projecting, or if the projection method without the removal of hidden lines is specified.  This option 

doesn't work for sections either. 

On the other hand, this option is automatically enabled for a 2D projection created on the basis of an 

existing 2D projection. 

Projection precision. Defines the accuracy of the projection lines representation. The minimum value of 

the parameter is 0.000001. 

Minimum size of elements. The parameter allows to reduce time of construction and recalculation of 

projections by omitting small details. In addition such detail exclusion may increase drawing readability in 

some cases. 

 

The minimum size is set in the current units of model measurement. All bodies with a smaller size won't 

be shown on the projections. 
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Recalculation time: 0,577 seconds. Recalculation time: 0,088 seconds. 

 

“Basic Parameters” tab 
The drop down list found at the bottom of the window defines the type of the projection: Precise (Image 

Lines), Vector Picture, Rendering, Shading, Wireframe. 

 

The following projection parameters are defined here as well: 
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Perspective projection. Parameter defines type of created projection: parallel or perspective. When the 

flag is set, perspective projection is created. Dimensions, based on elements of such 2D projection, also 

drawn according to the perspective parameters. 

Consider hidden lines. This parameter defines whether the hidden lines are shown on the projection. This 

parameter is not available for projections of the following types “Shading”, “Rendering”, and also for 

sections and cuts. 

Show edges. This parameter controls the view of the edges on the projection (only for projection of the 

types “Shading”, “Rendering”). 

Show outline. With the help of this parameter, the view of the outline edges of the projected bodies is 

controlled on the projection (only for projections of the types “Shading”, “Rendering”, “Wireframe”). 

Consider transparency. When the flag is set, transparency of objects is considered on the projection. 

Elements, located behind transparent objects will be shown on projection as well. 

The rest of the parameters on this tab reflect the information about the view direction, the scale and 

relations with other elements (see the detailed description above). 

“Lines” tab 
On the Lines tab you can change image line parameters for particular 3D construction elements, bodies 

and fragments. 

 



Three-dimensional modeling 

1076 

  

The upper pane displays the list of selected items. You can change lines parameters for the elements. 

You can select elements in the Properties window by clicking "..." in the list. 

 

You can select lines parameters for all elements on projection when you select Line styles by default, but if 

lines parameters are already set for any element in the list, they will not change. 

In the center, there is a list of categories of projection lines. If you want to display lines of the category set 

flag near its name. 

 

Lines Categories 

Basic lines. Allows to set parameters of basic lines. 

Hidden lines. This parameters of this group control the display of invisible lines and parameters of the view 

on the 2D projection. 

Smooth edges. The projection may or may not display the edges between the smoothly adjoining faces 

(connected without sharp corners). This group of parameters defines whether to display smooth transitions, 

and defines the way of displaying graphic lines (type, color, etc.) used for this purpose. 
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Axial lines. When projecting surfaces of revolution (cylinder, cone, torus), the axes, or centerlines, can be 

created automatically. In the case when the body has several surfaces of revolution, the option Unite can 

be conveniently used for avoiding overlapping of axes. 

The flag “Automatic creation of axial lines” also controls the display of bend axes on the projections of 

bodies obtained by applying operation SMU: Unbend Bend. 

Threads. When creating 2D projections, the threads existing in the model are recognized automatically. 

With the option turned on, the lines of the thread notation are created in the cases, when it is viewed on 

the given projection from the front or side, or when the section plane passes through the thread axis. When 

creating a dimension on a thread in one of the above representations, the system automatically creates 

the appropriate notation. The data for the notation is taken from the thread creating operation. 

Bend edges are designed to display lines on the projections of unbent sheet metal parts. 

 

Section lines is used for drawing of visible segments that appear when the projected body intersects planes 

of stepped sections orthogonal to the direction of the projection. 

Hidden smooth edges. Shows smooth lines that are invisible on the projection. 

Lines Parameters 

Parameters of lines available for changing are displayed in the lower part and depend on the selected 

category. 

 

 

You can select several categories at the same time and set common parameters for them. 

 

Any auxiliary type of the projection lines can be assigned Line Type and Thickness, Scale factor, Color. 
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Use bodies color. With this parameter turned on, the color of all projection lines and section hatches is 

determined by the color of the operations being projected. All bodies are colored only in the shading 

mode. 

 

Type. You can select lines type for the selected category from the drop-down list. 

Thickness. Specifies lines thickness. 

Scale factor. Allows to set scale factor for non-continuous lines. 

                                   

Color. You can select lines color from the drop-down list or enter number of the color. 

Shorten Line parameter is available for smooth lines. If this option is checked, the lines of smooth edges 

are drawn shortened at both ends. 

In the case of the thread, there is an additional parameter, Minimum thread height. It is used to make an 

exaggerated, to the specified degree, cosmetic thread profile, when the line thickness used in the drawing 

or the small scale of the projection do not allow to maintain the cosmetic thread legible in its actual size. 

 

Depending on the type of a 2D projection, the dialog of the option  can have additional tabs Gaps, 

Sections, Coordinate systems. The contents of these tabs duplicates the contents of the similar sections 

of the properties window when creating/editing 2D projections. 

EDITING AND MOVING 2D  PROJECTION  

Editing of 2D projections is done by the command 3EJ: Edit 2D Projection: 

Keyboard Textual Menu Icon 

<3EJ> Edit > Draw > 2D Projection  
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The editing command can also be called from the context menu by right clicking  on a projection or its 

direct child. 

Editing is little different from the projection creation. Upon calling the command, all options become 

available in the automenu that were provided at projection creation.  

The already described options allow editing or redefining the list of elements to be projected, and selecting 

operations to include or exclude from the section, etc. 

To move the projection, place the cursor on the projection perimeter, wait until  symbol appears and 

move projection by holding the left mouse button. 

 

Dynamic view of projection being moved, allows you to see the full image after moving the projection. 

When you move the projection of large drawings system offers option to disable dynamic view not to slow 

down operations. 

To move a projection, you can also change the position of its attachment point. Activate one of the two 

options for attaching the projection and specify the new projection position (a free point or a 2D node). 

In the case when the projection is attached to a 2D node, its position can be changed by simply 

modifying the respective 2D node position and updating the projection. There is no need for 

launching the projection editing command. 

USE OF 2D  PROJECTIONS  

Working with 2D Projections of Type “Precise (Image Lines)” 

A 2D projection of type “Precise (Image Lines)” is a special element in the system. The drawing only displays 

the direct children of this element, that is, graphic lines and hatches. Together, these elements make the 

image of the projection. Most of the properties of each element are taken from the projection 

customization settings at the time of creation. These are, for instance, types of various projection lines, 

Color, Scale factor, priority, etc. however, if desired, each element properties can be modified separately. 

This can be done via the element parameters dialog box, conveniently accessible from the context menu. 

As usual, it appears in the right click  over the element. 

Depending on which element was selected by right-clicking  (whether the 2D projection itself or 

a child element), the context menu will have different contents. 
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If an immediate child of the projection is selected (such as a graphic line or a hatch), then its own context 

menu will have some additional specific commands to work with the 2D projection. In this case, there is 

also a difference in the action of the standard Delete command . In this case, it does not actually delete, 

rather merely hides the selected element. This can serve to hide some “unnecessary” elements of the 

projection.  

Projection editing is activated by the Edit 2D Projection command. To delete the whole projection, use the 

command Delete 2D Projection.  

Next in the list is the command 2D Projection Parameters that is used for calling the projection parameters 

dialog box. This dialog allows defining some general properties of the projection elements (line types, 

Color, Type and hatch display), as well as all the rest of the projection settings. Details on handling this 

dialog box are presented in the respective section of this chapter. 

The projection is not regenerated as the 3D model updates. To have the model changes reflect on the 

drawing (projection), either start the full model regeneration or update the projection manually by the 

command  Update 2D Projection. A special parameter on the tab “General” of the projection parameters 

dialog box controls the ways of updating the projection (see description above). The command Update 

locally provides greater time saving when handling complex models and drawings. Unlike the previous 

one, this command does not start regeneration of the children elements. This is convenient for working 

with projections that take long time for regeneration and are subject to projective relations. 

 

 

The context menu upon selecting a projection line The context menu upon selecting a 2D projection 

The context menu of the 2D projection proper has several additional useful commands.  
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There is the command Restore deleted elements that serves to restore the "deleted" elements (lines or 

hatches hidden by the Delete command). 

If necessary, you can break the relation between the projection image and the 3D model, and turn the 2D 

projection into a collection of nonparametric unconstrained graphic lines and hatches. You use the Explode 

Projection command for this purpose. 

If the 2D projection is constructed based on a model from an external file, then you have the command 

Open which opens the document related with the projection. 

The command Create Dimension on Projection serves to carry the 3D annotation elements over to the 2D 

projection (see the next paragraph).  

When projecting two or more bodies penetrating each other, there could be inaccuracies in defining the 

lines of bodies intersection and the lines visibility. Therefore, it is recommended to join such bodies in one 

by using the Boolean operation whenever possible or use the parameter “Allow intersecting bodies” before 

projecting (see the description of the parameters dialog box). Turning on this option increases the time of 

the projection regeneration. 

Some 3D elements can be created based on a 2D projection, such as workplanes and 3D sections. The 

respective options are provided in the automenu sets of the commands creating the respective elements.  

2D projections can be later used as references for construction lines, dimensions, detailing elements, etc. 

When creating construction lines, object snapping is engaged to the projection elements, distinguishing 

circular arcs, ellipses, splines, line segments, end points (nodes) of lines, arc centers, etc. 

Some graphic lines created based on a 2D projection have additional parameters. For example, there are 

graphic lines of a special type “spline curve”, which may sometimes be generated when projecting. You 

can additionally specify the number of spline points for a graphic line of this type, if you find the mapping 

accuracy not satisfactory (it is 40 points by default). 

  

   

Working with 2D Projections of Types “Vector Picture”, “Shading”, “Rendering”, 

“Wireframe” 

On the drawing 2D projections of types “Vector Picture”, “Shading”, “Rendering”, “Wireframe” represent 

themselves (in contrast to 2D projections of the type “Graphic Lines”) inseparable objects. Parameters of 

separate elements of such projections cannot be modified. 

In other respects, working with 2D projections of these types is similar to working with the projections of 

the type “Precise (Image Lines)”. The context menu of similar 2D projections duplicates the context menu 

of the 2D projection of type “Precise (Image Lines)”. 
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When creating 3D annotations on the 2D projections of the types “Vector Picture”, “Shading”, “Rendering”, 

“Wireframe”, the annotation elements being created are attached directly to the elements of the 3D model. 

Creating Drawing Annotation Elements 

To accomplish a drawing created based on a 2D projection, you can use standard 2D commands – 

D: Create Dimension, IN: Create Leader Note, RO: Create Roughness Symbol. Dimensions, leader notes 

and roughness symbols can be created on the projection lines in the same way as on a common drawing.  

If the 3D model was modified significantly, the composition of projection lines and some element 

IDs might change to some extent upon the 2D projection recalculation. In such a case, some of the 

annotation elements based on the lines produced by the 2D projections may lose their relation with 

their source elements . The system will notify the user about it with a message in the diagnostics. 

A 3D model may include 3D annotation elements - dimensions, leader notes and roughness symbols, 

applied directly in the 3D window on the model faces. Those serve to make the 3D model appearance 

more intuitive and simplify modifying its geometrical parameters. Besides that, the information stored in 

3D annotation elements (such as tolerance parameters in a dimension, its additional text lines, roughness 

symbol parameters, etc.) can be carried over to the counterpart 2D annotation elements in the projections 

of the given model. For details on creating 3D annotation elements refer to the chapter “3D Annotations”. 

If there are 3D dimensions or roughness symbols on the current 3D model, then, when creating 2D 

dimensions and roughness symbols on the respective projection lines, the system can automatically find 

the correspondence between the element being created and its counterpart element in 3D. If such a 

correspondence is found, then all parameters from the 3D dimension or roughness symbol (the nominal, 

tolerance, text lines, etc.) will be carried over to the 2D element being created. If any of such parameters 

are to be changed in the 2D element, then you should modify its counterpart element in 3D. 

The data transfer from 3D dimensions onto a 2D projection can also be accomplished by a direct “mapping” 

of the dimensions from the 3D space onto the 2D projection. This is done using the Create Dimension on 

Projection command available in the context menu when called over a 2D projection. 

Upon calling the command, the system determines, which of the 3D dimensions existing in the model can 

be mapped on the selected view (projection). The system-selected dimensions are drawn on the projection 

in red. The user needs to specify, which of the system-supplied dimensions shall be created on the given 

2D projection. 

You select the dimensions using the following options of the command's automenu: 

 <M> Select Detailing Elements 

 <M> Cancel Selection 

 <*> Select All Elements/Cancel Selection of All Elements 

 <End> Finish Element Selection 
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When the  option is active, the dimensions are selected that shall be created on the given projection. 

To select a dimension, simply point the cursor to the desired dimension in the 2D window and click . The 

selected dimension color will change to blue. In this way, you can select any number of dimensions in a 

series. 

Activating the option  starts the mode of canceling the selection of dimensions. In this mode, picking 

a dimension by  cancels its selection. As a result, the dimension color turns back to red. 

The effect of the option  depends on which of the above-mentioned options is active. If the  option 

is active, then using this one will cause all system-provided dimensions to become selected, whereas with 

the  option active – it will do the opposite, canceling all dimension selection. 

You can confirm the creation of the selected dimensions on the projection using the option . 

Modes of Displaying Dimensions on 2D Projections 

Dimensions created on 2D projection lines can be displayed in two ways. The first method is the standard 

display of dimensions (in the plane perpendicular to the viewing direction). The second method is “spatial” 

display of annotation elements. The latter is usually used in nonstandard and “spatial” views (such as in the 

axonometric). In this mode, the dimensions created based on projection lines will be drawn in the plane of 

the selected elements. For example, if a dimension is applied to an elliptical projection image of a circular 

edge, then the dimension will be maintained in the plane of the circular edge. This capability helps creating 

dimensions with actual values on axonometric views. 

This capability is controlled by the Save information for 3D dimensions option on the General tab in the 

2D projection properties (see the section “2D Projection Parameters”). You need to update the projection 

after enabling this option. 

  

Dimensions on a 2D projection in the regular mode Dimensions on a 2D projection in the “3D” mode 

The “spatial” method of displaying dimensions on a drawing can be used with all types of 

dimensions except construction ones. 
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Using Dimensions on a Projection to Manage the 3D Model 

2D dimensions created on projection lines can sometimes be used to modify the 3D model. This is possible 

in the cases when the system managed to find a correspondence between the projection lines on which 

the dimension was created, and the control elements of the 3D model. Such elements may include faces 

of the 3D model dependent on the geometrical parameters of operations or on 2D constructions that 

provide the base for the 3D model operations. The system automatically tries to find such correspondence 

when dimensions are constructed on the 2D projection. If the system succeeds finding such 

correspondence, then the changes to the dimension values will affect the 3D model and its projections. 

You change the dimension value using the command PE: Set Dimension Values, described in detail in the 

chapter “Modifying the drawing using dimensions” of the “Fundamentals. Two-Dimensional Design” guide.



 

 

SHEET METAL OPERATIONS 
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SHEET METAL GENERAL INFORMATION 

Sheet metal commands and operations facilitate solving problems of modeling details manufactured by 

the sheet metal stamping method. They allow to create an initial flat part (workpiece) of the specified 

thickness and then perform various shape manipulations, such as bending about a selected line, attaching 

flanges to the workpiece, creating punches and hems. Once modeling is finalized, the part can be unbent 

to the unfolded sheet workpiece, you can create its drawing, bend table and then re-bent to the actual 

part shape.  

 
Sheet Metal Example 

The special forming feature command in the sheet metal group of commands helps to create various 

commonly used forming features, such as beads, ribs, flanges, airways, cradle. 

When working with sheet metal, you can use not only the specialized commands described in this chapter 

but also general-purpose commands (Extrusion, Primitive, Boolean operations, Hole and so on). 

 In addition, it is possible to create flat patterns and sheet parts based on solids using the Convert Solid 

to Sheet Metal operation and to create sheet parts over two sections with the Lofted Bend operation. 

Note that the sheet metal operations do not account for possible material deformations. Rather, those are 

based purely on geometrical calculations. 

PROTOT YPE FOR SHEET METAL PARTS CREATION  

To create a sheet metal part, it is recommended to use a special Sheet metal Part prototype.  
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Differences from the prototype 3D Model prototype are in the active Sheet Metal Ribbon tab, the presence 

of the s variable (to control the sheet metal thickness when optimizing the part design), the presence of 

the Nesting layer, and a special Flat Pattern page. 

SHEET METAL INTERFACE  

When creating a sheet metal part and designing drawings on it, it is convenient to use the Sheet metal 

Part tab in the Ribbon. The tab is context-sensitive and is divided into 3D and 2D parts. The 3D part contains 

a set of commands required for designing a sheet metal part in 3D. The 2D part contains a set of commands 

required to create and design a drawing of a sheet metal part and its unfolding, as well as to create a 

bending table. 

  

 

 GENERAL SHEET METAL COMMANDS PARAMETERS  

All sheet metal operations have a group of common parameters. You can set default values for some of 

these parameters.  

The main operation of working with sheet metal is bending. Many operations create geometry, which is 

the result of several bends in different ways or operations close to bending, but having their own 

characteristics. Accordingly, the dialogs of commands for working with sheet metal contain bending 

parameters that are the same for many operations.  

Some parameters are not available to the user in a single operation, which is explained by the logic of 

constructing the geometry and the capabilities of the command as an analog of a real technological 

operation. 
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Radius 

The parameter sets the value of the bend radius. The parameter has a custom default value. The parameter 

has a manipulator in the 3D scene. 

If you use a profile that sets the section of the sheet, the radius value will specify the fillet at the non-

rounded corners of the profile. 

Angle  

The parameter sets the value of the bend angle, which determines the slope of the wall of the sheet metal 

part. The parameter does not have a custom default value. For most of the operations, the default value of 

the parameter is 90°. The Toggle bend direction  option allows inverting the value. The parameter has 

a manipulator in the 3D scene.  

K-Factor 

The parameter allows specifying the neutral layer coefficient. The parameter controls neutral factor 

definition upon part bending and unbending. The parameter is required for all operations that have an 

unfolding. The neutral layer of a workpiece is its longitudinal section, whose geometry does not change 

during bending. 

 

 

 

1 - Workpiece 

2 - Workpiece thickness 

3 - Neutral layer 

4 - Bend radius 

5 - Bend angle 

6 - Bent workpiece 

The neutral layer coefficient value can either be entered by the user or defined by the system automatically, 

based on the table of Neutral factors versus “bend radius/workpiece thickness” ratio. The definition is 

controlled by a radial-button switch. To define the neutral layer coefficient automatically, set the switcher 

to the Autodetect position. Setting the other button allows entering an arbitrary number in the range from 

0 to 1. The value “0” means the neutral layer coincides with the workpiece face selected for bending, while 

“1” sets the neutral layer on the opposite face of the workpiece. 
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The Neutral factor dependency table is stored with the model document. You can view and change the 

table in the default parameters dialog for sheet metal <SPM> Defaults. 

Position 

The parameter determines the position of the bend line relative to the baseline.  

There are following possibilities: 

 Bend start - The beginning of the bended area is aligned with the base line (used as default); 

 Bend center - the middle of the bend zone of the workpiece is aligned with the base line; 

 Bend end - the end of the bend zone of the workpiece is aligned with the baseline. 

 
 

 
At the beginning of the bend, 

1 - baseline 

In the middle of the bend 

1 – bend line 

At the end of the bend 

1 – bend line 

 External Dimension/Internal Dimension – the bend area is positioned in such a way that the overall 

size of the resulting detail is measured from the outer/inner wall of the bent/attached flange to the 

opposite trimmed face of the part remains the same as for the original part. 

 
  

Workpiece 

 1 - baseline 

By inner size By outer Size 

Since the position of the baseline at the beginning of the bend zone is the most common, in the 

future, this option will be used to describe the possibilities of bending operations. 
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Bend baseline 
A baseline can be defined by two 3D points or a 3D object capable of determining a straight line. The 

baseline serves several purposes:  it allows the system to define the body being deformed and the base 

face of bending, determines the position and size of the bend area, determines the possibility of creating 

one or another type of bending. 

The baseline must lie in the plane of one of the workpiece faces being bent (normally, the top or bottom 

face). The baseline does not have to fully fit within the boundaries of a base face; however, at least some 

its portion must belong to the face. 

   

Defining the baseline with an open 

3D profile (1) 

Defining the baseline with the edge 

of the workpiece (1) 

Baseline Defining 

using two 3D nodes 

The face to which the baseline belongs is the base face of bending. The base face is used as the base 

reference when defining bending parameters.  

 
1 - fixed part, 2 - bend line,  

3 - bent part, 4 - rotatable part 

The boundary between the fixed part of the workpiece and the bend zone will be called the bend line.  

Left Offset and Right Offset 

The length of the bend line can be adjusted by Offsets from the ends of the baseline. Offsets are specified 

in the corresponding section of the properties window. Or they may be specified in the 3D scene using 

manipulators. A special flag on the right allows you to offset symmetrically. 
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Offsets are used when the selected baseline accurately determines the desired bend position, but its length 

exceeds the length of the workpiece section that needs to be bent. 

   
Workpiece with 3D Profile Bend without offsets Bend with offsets 

In some cases, the use of offsets allows creating a bend even if the original baseline was incorrect. This 

could be, for instance, the situation, when the baseline for the bend does not fully fit in the face of the 

workpiece. Without using offsets, bending cannot be created in this case. By offsetting from the line end, 

one can reduce the length of the bend line in such a way, that the bend area fully fits in the bending base 

face. 

  
Workpiece with a profile that extends beyond the edge Bending is built due to offset 

Measured 

Four parameter variants are implemented. The selection is made from the list: Neutral layer, External side, 

Internal side, Flat part.  
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Neutral layer 

1 - neutral layer, 2 - location of the flange gluing 

(determined by the baseline) 

External side 

1 - location of the flange gluing (determined by the 

baseline)  

  

Internal side 

1 - location of the flange gluing (determined by the 

baseline) 

Flat part 

1 - location of the flange gluing (determined by the 

baseline), 2 - bend zone, 3 - flat part 

Length 

The parameter determines the length L calculated by the method specified by the Measured parameter. 

The parameter has a manipulator in the 3D scene. 

Offset 

The parameter allows shifting the bend area and, therefore, the bend line off the baseline. The parameter 

has a manipulator in the 3D scene. 

Depending on the sign of the offset, the bend zone moves in one direction or another from the initial 

position: with a positive offset - to the bent/glued part, with a negative offset - from it. 
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Bend without displacement, 1 - bend line,  

is set by two 3D nodes 

Bend with offset, 1 - bend line, 2 -   

baseline defined by two 3D nodes, 3 - offset 

  

The baselines for flange gluing and flange 

bending (1) match 

Offset flange, baselines for gluing flange (1) and bending (2) 

do not match 

Shifting the bend line often helps in the cases, when the user is not satisfied with the location of the 

bend area, or when bending creation is impossible in the current location. 

Bend Relief 

A group of parameters by which special grooves can be defined to reduce stresses in the metal, 

concentrated at the bending angles. 

Bending operations allow you to create a Bend Relief automatically when performing certain operations. 

Reliefs are divided into Corner and Isolating. Isolating relief allows you to remove stress in the bendable 

flange. Corner relief allows you to remove stress at the joint of the flanges and walls. Corner reliefs can be 

specified with a separate Corner command. 



Three-dimensional modeling 

1094 

 

1 - Corner relief 

2 - Isolating relief 

The Isolating type has two variations, selected from the list: Round and Linear. The Extend Relief option 

is available for each of the variants.  

    

No reliefs Round reliefs Square reliefs Square reliefs 

through 

 Isolating relief 

Depth and Width parameters are available to determine the geometry of the isolating reliefs. For a square 

relief, those define the width of the groove and the length of the groove part ahead of the bend line, 

respectively. In the case of the round relief, the length of the head portion of the slot is increased by the 

radius of the end fillet. The fillet radius is equal to half the groove width. 

The rear part of a groove of any type can be arranged in one of two ways: 

 to the depth equal to bend radius plus workpiece thickness; 

 extended up to the borders of the workpiece (if the Extend Relief option is enabled) or to the end 

of the workpiece, if gluing a flange inside the workpiece with material removal by the flange length. 



Sheet Metal General Information 

1095 

  

1 - bend line, S - workpiece thickness, R - bend radius, D - width, H - depth 

Linear Reliefs (Non-Through) Round Reliefs (Non-Through) 

  
1 - bend line, S - workpiece thickness, R - bend radius, D - width, H - depth 

Square Reliefs (through to edge) Round Reliefs (through to edge) 

Corner reliefs have three choices from the list: Round, Square and Welding. 

   

Round Square Welded 

Corner reliefs 

The radius of the circular hole is equal to the radius specified in the parameters. The square hole is 

constructed by three or more points of intersection of the given radius circle with the planes selected for 

the operation.  
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When welding type is selected an optimal joint is formed in the bend area. The joint can be used for 

welding. 

Gap type 

The parameter sets the position of the adjacent sheet faces relative to each other. From the drop-down 

list, you can choose one of three items: Without overlap, Overlap, Reverse Overlap.  

 
  

Without overlap Overlap Reverse overlap 

Gap 

The parameter allows you to manually set the distance between adjacent sheet faces.  
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Flange 

The Flange parameter group allows you to set various cropping modes during bending. The need to reduce 

the flange when bending and gluing the flange is indicated using the flag Flange cutting. When the flag 

is enabled, this mode will be activated and the gap between the part and the flange on the unfolding will 

be equal to the specified value, by default 0.05.   

 

 
 

Bending after unbending Correct re-bending (with a decrease of the "flange") 

  

Removing material to the edge of the workpiece Removing material to the length of the "flange" 

The Limit cut to flange length flag allows you to set the method for removing the workpiece material 

under the flange for gluing the flange: when the flag is set (default state), the material will be removed 

only by the length of the flange. When the flag is disabled the material will be removed to the edge of the 

workpiece. 

Corner Relief 

When attaching a flange, intersections may occur between the flange and the workpiece. In such a case, 

automatic trimming can be performed. Trimming is done in such a way to leave a diagonal gap of the 

specified width in the intersecting area. To perform clipping, you need to specify the Clipping option in 

the Type list and set the gap thickness with the Gap parameter.  

When the value is set to No Clipping, intersecting parts will not be clipped. 

Clipping is possible if the flange and the intersected part of the workpiece have the same thickness and lie 

in one plane. Certain exceptions from these rules are allowed, such as tolerance on flange thickness and 

bending angle when matching with the workpiece. 
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Original solid body Flange without clipping Flange without clipping 

Options 

Use manipulators. When the flag is enabled the control manipulators in the 3D scene are shown. 

Show labels. When the flag is enabled the special markers informing about the current parameter values 

are shown, which can also be used to change the value of the operation parameters. 

 

Dynamic preview. The flag enables/disables the dynamic preview of the command. 

Bend face completely. When the flag is set, the body will be completely bent along the selected line. This 

parameter is important when performing operations on the sheet metal of certain geometry (for example, 

when it is required to bend the sheet body with a cut along the specified line). 

Check self-intersections. It allows you to monitor self-intersection of bent sheet faces. When the flag is 

set, system will not create bend that intersects with the source body. 

Operands 

All manually defined elements used in sheet metal commands are displayed on the Operands tab in the 

options window: vertices, edges, faces and operations.  
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The Delete  button located on the right side of the Operands tab allows you to exclude the selected 

item from the operation. It is also possible to delete the bend edge from the list by selecting it with a 

mouse click and pressing the <Delete> button on keyboard. In the working window the edge selection 

can be cancelled by clicking on it again with the left button of the mouse .  

The Up and Down  buttons, located to the right below the Delete button, are used to change the 

order of the operation for the given elements. This feature is not required for all the commands and 

elements. 

General Default Options 

To set default parameters for the whole group of operations for working with sheet metal, you need to call 

the command SMP: Default: 

 

Icon Ribbon 

  
Sheet Metal → Defaults 

Keyboard Textual Menu 

<SMP> Operation > Sheet Metal > Defaults 

 

The command brings up the dialog box Sheet Metal Parameters. In the dialog fields, you can set default 

parameter values for all sheet metal operations of the created part. 
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Common Tab 

Material thickness. Defines the thickness of the workpiece that is used by default upon the sheet workpiece 

creation command. 

Bend radius. Defines the default bend radius used in Bend command. 

Bend width. Sets default value for the bend width. 

Neutral factor (K-Factor). The parameter controls neutral factor definition for part bending and unbending. 

The parameter value can either be entered by the user or defined by the system automatically, based on 

the table of Neutral factors versus “bend radius/workpiece thickness” ratio. The Neutral factor dependency 

table is stored with the model document. To view or edit the table, use the button . Upon pressing the 

button, an additional window Neutral factors opens. This window displays the Neutral factor table of the 

current document. It represents a tabulated dependency of Neutral factor (the column “Value”) on the ratio 

“bend radius/workpiece thickness” (the column “Parameter”). The Interpolation flag sets the type of table 

data interpolation: the set flag means linear interpolation – the Neutral factor linearly interpolated between 

the tabulated data; the cleared flag means piecewise constant interpolation – the Neutral factor is 

maintained constant until reaching the next entry. 

 

The current table can be exported into a textual file by pressing the button [Save…]. 

The [Load ...] button allows you to change the table by loading new data from the user-created text file “* 

.tnf” of the following format: the first line in the file should specify the type of interpolation: “Interpolation” 

- linear, “Table” - tabular. Other lines contain the table data – the “bend radius/workpiece thickness” ratios 

and the respective Neutral factor values. Table data can be recorded in various ways in one row or in 

several, spaces or tabs can be used as delimiters. For example, the default table is written as follows: 



Sheet Metal General Information 

1101 

 Interpolation 

0.5   0.25 

0.8   0.3 

1   0.35 

2   0.37 

3   0.4 

4   0.41 

5   0.43 

10   0.47 

12   0.5 

 

Once loaded from a file, the table is stored in the document of the current model and is further used in 

model manipulations. 

Minimum gap. The parameter defines the width of a cut when creating operations with sheet metal. 

Defines the Reduce cutting option. 

Bend/unbend face completely. This parameter is important when performing operations on the sheet 

metal of certain geometry (for example, when it is required to bend the sheet body with a cut along the 

specified line). When this parameter is enabled, the entire body along the selected line will be bent without 

violating the construction logic. The parameter defines the setting/removal of the default flag for the Bend 

face completely option in the dialog for creating bending operations.  

  
1 - Bend Line 

Check self-intersections. This   parameter is important when creating the «Bend» parameter. It allows you 

to monitor self-intersection of bent sheet faces. When the flag is set, the system will not create bend that 
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intersects with the source body. Defines the default setting/clearing of the flag for the Check self-

interactions option in bending operations. 

Activate manipulator. When the flag is set for Flange, Hem, Jog operations, the value will be automatically 

entered via the length manipulator after selecting an edge or profile. 

Simplify geometry. The parameter removes the edges that are formed as a result of flanges, hems, bridge 

bends, and other sheet metal operations construction. 

Bend Parameters Tab. 

  

Bend position allows you to set the position of the bend zone relative to the bending baseline: Bend start, 

Bend end, Bend center, External Dimension or Internal Dimension. Defines the default option for the 

Position parameter in the bend command dialog. 

Length measured. Four values of the drop-down list (Neutral layer, External side, Internal side, Flat part) 

allow you to set the default measurement type. The parameter defines the default variant of the Measured 

parameter in the bend command dialog. 

The group Bend Relief defines the type and sizes of the reliefs created by default when bending. 

The type of reliefs is determined by the position of the switch: None (no relief is created), Round, Square.  
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Depth and Width parameters allow you to set default sizes for reliefs: the depth of the front part 

(protruding beyond the bend line) and the width of the groove. 

The flag Extend relief enables cutting of the groove to the borders of the workpiece.  

Flange parameter group allows you to set default values for various cutting modes during bending. The 

need to cut the flange when bending and gluing the flange is indicated using the Flange cutting flag. 

When the flag is enabled, this mode will be activated by default. The Limit cut to flange length flag allows 

you to set the method for removing the workpiece material under the flange when gluing the flange. When 

the flag is set, by default the material will be deleted only by the length of the flange. When the flag is 

disabled the material will be deleted to the edge of the workpiece. 

Corner Relief Group. The group allows you to enable by default cutting of intersecting parts of the flange 

with the workpiece. Enable the Clipping option with the specified Gap parameter (defines the default value 

of the Gap parameter in the bending command dialog). When set to No Clipping, overlapping parts will 

not be clipped by default. 

Offsets parameter group. Defines the default values for Left and Right parameters. The position of the 

indentation (left or right) is determined by the system depending on the position of the created geometry. 

Parameter values set in the command SMP:  Default will be used by default in all sheet metal 

operations. For text and numeric parameters, this will correspond to the current value of the 

parameter, enclosed in square brackets, for example, Radius: [2]. 

Draggers and markers 

During bending (after selecting the base line), auxiliary graphic elements - draggers and decorations - are 

displayed in the 3D scene.  

Draggers are used to change sizes directly in the 3D scene. Working with draggers in sheet metal 

operations is similar to their use in other 3D operations and commands (extrusion, primitive, etc.). When 

you put the cursor on the dragger line the corresponding icon appears. If at this moment you start moving 

the cursor with the button pressed, the value of the corresponding parameter will change in the value 

input window. 



Three-dimensional modeling 

1104 

 

 

 

1 - length dragger 

2 - angle dragger 

3 - bevel draggers 

4 - radius dragger 

5 - indentation dragger 

6 - offset dragger of bend line 

7 - direction dragger 

8 - preview  

 

1 - Dragger 

2 - Radius marker 

3 - Face sequence number marker  

Up to eleven draggers can be in the 3D scene. However, depending on the sheet metal command used, 

some of the draggers may be missing.  

If several elements are edited simultaneously in an operation, then to edit a specific element it is necessary 

to move the mouse cursor closer to the desired element. All available draggers will be displayed on the 

element, and the parameter window will correspond to the values of this element.  

Markers - these are markers consisting of pictograms schematically depicting the operation parameter and 

indicating the parameter value. By clicking  on the parameter value on the marker, you can call the 
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parameter input window. Some labels allow you to change the type of parameter by clicking  on the 

marker. So, for example, you can use the mark to change the type of overlap in the Angle operation.  

Attach Geometry using Dragger 
The direction and length of the dragger, and, consequently, the geometry being created, can be attached 

to 3D scene objects. To do this, call the context menu of the length dragger and select one of the dragger 

orientation options based on 3D scene objects. 

 

Move to Point. The length of the dragger will be determined by the length of its projection, which, in turn, 

is given by the selected point. After choosing the considered option in the context menu, it is necessary to 

indicate the 3D node or vertex in the 3D scene. 

Move to Surface. The length of the manipulator will be determined by the point of its intersection with 

the selected surface. After selecting the considered option in the context menu, it is necessary to indicate 

a face, surface or workplane in the 3D scene. 

Rotate Parallel to Direction. The direction of the dragger will be parallel to the selected direction. The 

direction can be specified by an edge or a normal to the plane. After selecting the considered option in 

the context menu, it is necessary to specify an edge, face, surface or workplane in the 3D scene.  

Rotate Parallel to Plane. The direction of the dragger will be parallel to the selected plane. After selecting 

the considered option in the context menu, it is necessary to indicate a face, surface or workplane in the 

3D scene. 

Preview 

The preview schematically shows the shape and dimensions of the created operation, dynamically 

changing when the command parameters are changed. With invalid parameter values, the operation 

preview is missing. In such cases, it is necessary to override the operation parameters. If there is no preview 

after setting the parameters in the 3D scene, it means that the parameters were set in such a way that the 

system could not find a solution. In this case, the only way is to recreate the operation. 
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CREATE PART  

To create a workpiece, use the command SMD:  Create Part: 

 

Icon Ribbon 

  
Sheet Metal → Create Part 

Keyboard Textual Menu 

<SMD> Operation > Sheet Metal > Create Part 

 

The operation allows you to create a sheet workpiece in two ways. 

 Sheet Bound 

 Sheet Cross-section 

Both methods use a flat 3D profile as the source. 

 
By sheet shape 

 
By section of the sheet 

All sheet metal operations are created on the basis of a previously created workpiece. The workpiece can 

be a solid body or imported body of virtually any shape. A system requirement for defining various sheet 

metal operations is the existence of two flat parallel faces in the area of deformation. One of such faces 
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will be used as the base when defining the desired type of a sheet metal operation. We recommend using 

a flat body as the sheet metal workpiece, with the side (end) faces perpendicular to main (top and bottom) 

faces.  

Use of this specialized operation instead of extrusion or other general-purpose operation simplifies 

workpiece creation, minimizing the number of parameters and settings to define.  

From now on throughout this chapter, any body subjected to a sheet metal operation will be 

referred to as "workpiece" regardless of the means of body creation. 

Command Parameters 

Command parameters related to general ones are described in the corresponding section above.  

Select the way of creation. 

 
Sheet Bound 

 
Sheet Cross-section 

Thickness. Input field for sheet thickness in millimeters. 

A variant of the direction of extrusion to a given thickness. 

 
Positive Direction 

 
Reverse Direction 

 
Symmetric 

Width. The parameter sets the width of the workpiece if created using the Sheet Cross-section option. 

 Automenu Options. 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 

 
<R> Select 3D Profile 

 
<W> Draw Profile 

Finish input. The option allows to build geometry by given parameters. If there are not enough parameters, 

the option is inactive. 
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Set entity Parameters. Invokes the standard dialog of the parameters of the 3D modeling command. 

Exit command. The option closes the command with the cancellation of the specified parameters. 

Preview Operation Result. The option enables/disables the standard option to view 3D modeling results. 

Select 3D Profile. The option allows to select the profile according to which the workpiece will be built. 

The option is mandatory to create a workpiece. 

Draw Profile. The option allows to create a workpiece using profile. The option allows you to switch to 

drawing mode on the selected work plane to create the original profile. In this case, when you exit the 

drawing mode on the workplane, the created profile will be automatically selected. 

Creating a Base Part 

To create a workpiece, just specify the source 3D profile. When entering the operation, the 3D profile 

selection mode is activated automatically. The type of the selected profile will determine the option to 

create a workpiece. If the contour is closed, then the option of creating according to the shape of the sheet 

will be automatically selected. If the contour is not closed, then the option for the sheet cross-section will 

be selected. Indicate the necessary parameters and complete the entry. 

Sheet Bound. The initial 3D profile defines the contour of the future workpiece body. We recommend 

using a single-contour 3D profile. However, it is allowed to use a multi-contour profile, which meets the 

following requirements: A 3D profile should consist of only one wraparound contour and the nested 

contours should be the first level.                    

  
Single-contour 3D profile Single-contour 3D profile: 1 - contour of the 1st level of 

nesting, 2 - wraparound contour 

When you select this way of the sheet workpiece creation you should specify the width of the workpiece 

and direction of the profile extrusion. The selected profile is extruded by normal to the specified thickness 

of the workpiece sheet. Extrusion is done in one of three ways: upward relative to the plane of the source 

profile, downward relative to the plane of the profile or in both directions symmetrically. 
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3D Profile Symmetrically Down Up 

Sheet Cross-section. The 3D profile determines the sectional shape of the workpiece body. In this case, 

only a flat single-contour 3D profile can be used. It can be closed (which will result in a “pipe”-type 

workpiece), or open. If you select a closed profile, you should manually change the type of the workpiece. 

As in the previous case, extrusion by the sheet thickness can be done in three ways relative to the surface 

resulting from the first extrusion. The edges of the resulting sheet body (the corners of the workpiece 

cross-section) are automatically rounded. The width of the workpiece (extrusion value) is determined by 

the Width parameter.  

 
 

1 - 3D Profile 2,3 - Extrusion to the given width and thickness 

Workpiece extrusion directions Workpiece by the given section shape 
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SHEET METAL. BENDING OPERATIONS 

FL ANGE GROUP (BENDING OPERATIONS )   

The group combines bending operations. The bending operations are in a pop-up list in the Ribbon, the 

main operation is Flange. All the operations have a common interface and the ability to switch between 

operations in the parameters dialog.  

 
Flange 

 
Hem 

 
Contour Flange  

 
Bend 

 
Cut and Bend 

The bending operations can be subdivided into shape-changing - Bend, Cut and Bend – and shape-

forming Flange, Hem, Contour Flange. 

Depending on the given base bending line the system automatically selects a preliminary bending type. 

The selecting criterion is the kind and way of setting the base line. E.g. if you choose a lateral edge of a 

workpiece as the base bending line, the system will offer to create a flange. In case of open profile inside 

the workpiece option folding will be selected. The result of the selection can be seen in the command 

dialog in the parameter window. 

 

You can change the variant offered by the system by choosing another variant from the list. 
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FL ANGE  

To create a flange on sheet parts SMA: Flange operation is used: 

 

Icon Ribbon 

  
Sheet Metal → Flange 

Keyboard Textual Menu 

<SMA> Operation > Sheet Metal > Flange 

 

The flange thickness coincides with the part thickness and the width is determined by the base line (taking 

offsets into account). The flange displacement can be either outside or inside. You can set reliefs at the 

flange corners in the command and set treatment parameters of the intercepting flanges.  

Command parameters  

The command parameters are common for the sheet metal commands and are described in the 

corresponding subsection above. 

The command menu options: 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity Parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 

 
<L> Select Line 

 
<M> Add Edges 

 
<E> Select first Vertex or 3D Node 

 
<S> Select second Vertex or 3D Node 

 
<R> Select Profile 

 
<W> Draw Profile 

 
<A> Cancel Selection 
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Finish input. To build geometry according to the given parameters. In case the parameters are insufficient, 

the option in not available. 

Set entity Parameters. Call a standard 3-D design command parameters dialog.  

Exit command. Shuts down the command cancelling the given parameters.  

Preview Operation Result. The option enables/disables a standard option for reviewing 3-D design 

commands.  

Select Line. The option to select a line determining the base bending line.  

Add Edges. The option to select an edge determining the base bending line. The option as active at 

entering the command on default.  

Select first Vertex or 3D Node. The option to select the first point determining the base bending line.  

Select second Vertex or 3D Node. The option to select the second point determining the base bending 

line.  

Select Profile. The option enables you to build a flange whose shape is determined by the profile. This 

option is not to be mixed up with Contour Flange command where the profile sets the flange cross-section. 

In this case the profile sets the flange shape in the plane. The profile is to be closed.  

 

Flange by user 3D profile 

Draw Profile. The option enables you to switch over to drawing work plane mode to create a profile. The 

system automatically activates drawing on the work plane which coincides with the face where the rib for 

building the flange was selected. In this case the created profile will be selected automatically on exiting 

from the drawing on the work plane mode and you don’t have to set it with Select Profile option. The 

profile is to be closed. 

Cancel Selection. Cancel all elements selected and clear the operand window.  
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Flange creation 

A typical procedure for creating a flange. 

 Select a rib determining the base bending line.  

 Select a counting variant. 

 Set the position. 

 Set the angle. 

 Set the parameters of the command determining the flange shape or select a profile. 

 Set the relief and displacement parameters if necessary. 

 Set the corner treatment parameters if the flange has intersections with the workpiece. 

 Set the overlapping variant if adjacent ribs are selected. 

 In case the flange is impossible to build, finish entering. Otherwise change flange parameters. 

When moving the flange or building the flange by the base line which is not at the marginal edge of the 

workpiece, there are some peculiarities of setting command parameters. 

At positive displacement there appears an additional flat part at the glued lug. The length of the part is 

determined by the Offset parameter. At negative displacement (i.e. displacement inwards of the workpiece) 

both lines are moved – the gluing line and the bending one. See subsection “General parameters of sheet 

metal commands” for details on the Offset parameter and the Position parameter associated with it. 

 

 
   

Workpiece Flange without bending 

line displacement 

Flange with bending line 

displacement outwards  

Flange with bending line 

displacement inwards 

In most cases the lug is glued at one of the side edges (it is realized by selecting the correspondent 

workpiece edge as a base line at zero displacement relative to it). However, gluing can be done inside the 

workpiece as well, e.g. when the negative displacement is set at gluing to the side edge. In this case the 

workpiece material replaced by the glued lug is removed. The removed part width is determined by 

perpendiculars to the base line running from its ends (taking indents into account), similarly to bending. 

There are two variants of removing: either all the material to the end of the workpiece is removed or the 

material at the glued lug length is removed only. 
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Workpiece Flange Material removal to the 

end of the workpiece 

Material removal at the lug 

length 

HEM  

SMH: Hem operation is used for flanging: 

 

Icon Ribbon 

  
Sheet Metal → Hem 

Keyboard Textual Menu 

<SMH> Operation > Sheet Metal > Hem 

 

The operation enables users to “glue” a flange of the selected type to the outline of the workpiece. For 

flanging you should select several workpiece edges belonging to one face. Flanging can build a closed 

loop.  

There are 6 types of flanging available: 

  

Rolled Opened 

 
 

Teardrop Closed 
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Double S- shaped 

Command parameters 

Command parameters are general for sheet metal commands and are described in the corresponding 

subsection above. 

The command automenu options are: 

 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity Parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 

 
<M> Add Edges 

 
<A> Cancel Selection 

Finish input. Builds a geometry according to the given parameters. In case there are not enough 

parameters set, the option is not available. 

Set entity Parameters. Calls a standard dialog of 3D modeling command parameters. 

Exit command. Shuts down the command with cancelling all the set parameters. 

Preview Operation Result. Enables/disables the standard option of 3D modeling commands review. 

Add Edges. Selects the edge determining the base bending line. The option is active by default on entering 

the command. 

Cancel Selection. Cancels all the elements selected and clears the operand window. 

Flanging creation 

A typical procedure when creating flanging is: 

 To select the edge determining the base bending line; 

 To select the count variant; 

 To set the location; 
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 To choose the flanging variant from the list; 

 To set the command parameters determining the flanging shape; 

 To set the relief and displacement parameters if necessary; 

 To set the angle machining parameters is the flanging has intersections with the workpiece; 

 To set the gap value if the flanging is given for adjacent edges. 

 In case it is possible to build such a flanging – finish entering. Otherwise change the parameters. 

CONTOUR FL ANGE  

To create a flange along a contour the SMI: Contour flange operation is used for sheet bodies. 

 

Icon Ribbon 

  
Sheet Metal → Contour Flange 

Keyboard Textual Menu 

<SMI> Operation > Sheet Metal > Contour Flange 

 

The operation enables users to “glue” a flange whose cross section shape is determined by the generatrix 

to the sheet body. The result of this operation is added to the edges of the base sheet body. 

 
1 - Generatrix 

A 3D profile, a trace or a 3D path should be chosen as an outline defining the future geometry of the 

flange. The generatrix cannot be closed. All of its points are to lie in one plane. The generatrix can be set 

by straight lines or circular arcs. 
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The operation requires selecting the generatrix and the edge along which the contour flange will be built. 

If the generatrix start does not touch the edge, it is necessary to set an adjoining point and the direction 

of the generatrix. 

Flanges can form a closed loop. Weakening conditions and gaps at the joins of the flanges for all the body 

can be set. 

 
1 – Generatrix 

Command parameters 

Command parameters are general for sheet metal commands and are described in the corresponding 

subsection above. There are some minor differences in Angle and Measured parameters. 

Angle. The parameter determines the outline turning in the plane perpendicular to the edge around the 

adjoining point. The parameter can be set by means of a manipulator or by a numerical value. 

  
The angle from the outline The angle is set manually 

Measured. This parameter is inactive. The system only determines the push-out direction for the material 

thickness. If the edge determining the outline position at the workpiece is the upper edge of the workpiece, 
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push-out is realized downwards. Vice versa, if the selected edge is the bottom edge of the workpiece, 

push-out is directed upwards.  

Command automenu options are: 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity Parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 

 
<W> Draw Profile 

 
<F> Select Flange Guide 

 
<M> Add Edges 

 
<V> Select Adjacent Point 

 
<O> Select Profile Direction 

 
<A> Cancel Selection 

Finish input. Builds a geometry according to the given parameters. In case there are not enough 

parameters set, the option is not available. 

Set entity Parameters. Calls a standard dialog of 3D modeling command parameters. 

Exit command. Shuts down the command with cancelling all the set parameters. 

Preview Operation Result. Enables/disables the standard option of 3D modeling commands review. 

Draw Profile. Builds a contour flange in transparent mode. Enables users to switch to drawing at the 

selected work plane mode to create a profile determining the flange section. In this case when exiting the 

drawing at the selected work plane mode the profile created will be selected automatically. The profile 

should not be closed. 

Select Flange Guide. Selects the 3D profile, trace or 3D path determining the flange section. The selected 

element should not be closed. 

Add Edges. Selects the edges determining the contour position relative to the workpiece. 

Select Adjacent Point. Selects a point at the profile which coincides with the edge: you should choose one 

of the end points of an unclosed contour. 

Select Profile Direction. The option determines one of the two possible profile positions. 
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Variant 1 Variant 2 

The direction can be set by any vector (defined by the edge, face or plane) having a meaningful component 

when projecting onto the plane where the profile lies. The direction of this component determines the 

profile direction. 

Cancel Selection. Cancels all the elements selected and clears the operand window. 

Building a contour flange 

To build a contour flange it is necessary to follow the procedure: 

 To select a generatrix – a 3D profile, a trace or a 3D path with the help of Select Flange Guide  

option. If the profile is not built, it can be built in the transparent mode, choosing the Draw Profile 

 option. 

 

 To select the edges involved in the operation with Add Edges  option. Normal to the plane 

where the generatrix lies either coincides with the edge or touches it in case the edge is curvilinear. 
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If the end point of the selected contour is at one of the selected edges, the contour flange is built 

right after the generatrix is selected. If necessary, you can change the contour direction with the 

option described below. If the end point of the contour does not belong the generatrix, set an 

adjoining point and the direction. 

 To select a point at the contour, which coincides with the edge in the Select Adjacent Point  

option: one of the two end points of the unclosed contour. 

 

 To choose one of the two possible variants of contour direction with the help of Select Profile 

Direction  option. 

 To set relief and angle machining parameters. 

 To finish entering. 
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BEND  

To create bending at sheet bodies SMB: Bend operation is used: 

 

Icon Ribbon 

  
Sheet Metal → Bend 

Keyboard Textual Menu 

<SMB> Operation > Sheet Metal > Bend 

 

When bending the initial workpiece is bent along the base line only, without cutting or removing any of 

its parts. In this type of folding the bending line is formed by extending the base line set as a segment 

sideways to crossing the base face side edges. There are two variants possible to extend the base line. 

  
 

Workpiece Not to fold all the face To fold all the face 

When creating a bending it is impossible to set indents from the base line ends. 

Command parameters 

Command parameters are general for sheet metal commands and are described in the corresponding 

subsection above. 

The command automenu options are: 

 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity Parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 

 
<L> Select Line 
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<W> Draw Profile 

 
<E> Select first Vertex or 3D Node 

 
<S> Select second Vertex or 3D Node 

 
<A> Cancel Selection 

 <D> Change the part to be bend 

Finish input. Builds a geometry according to the given parameters. In case there are not enough 

parameters set, the option is not available. 

Set entity Parameters. Calls a standard dialog of 3D modeling command parameters. 

Exit command. Shuts down the command with cancelling all the set parameters. 

Preview Operation Result. Enables/disables the standard option of 3D modeling commands review. 

Select Line. Selects a line determining the base bending line. The line can be set basing on the path, profile 

or the trace. 

Draw Profile. Sets the base bending line in transparent mode. When choosing the option you should set 

the workpiece face (the system automatically switches to drawing at the selected work plane mode), after 

which you should create the profile outline at the selected face. The outline should be a segment. When 

exiting the drawing at the selected work plane mode the profile created will be selected automatically.  

Select first Vertex or 3D Node. Chooses the first point determining the base bending line. 

Select second Vertex or 3D Node. Chooses the second point determining the base bending line. 

Cancel Selection. Cancels all the elements selected and clears the operand window. 

Change the part to be bend. When folding one part of the workpiece remains stationary and the second 

one moves in space according to the set folding parameters. This option enables users to swap the moving 

and the stationary parts of the workpiece. 

Creating the bend 

A typical procedure when creating a bend is: 

 To create the base line 

 To select whether to bend all the face or at the extension to the nearest edges 

 To change the bent part if necessary 

 To set the available standard bending operations parameters 

 Finish entering. 
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CUT AND BEND  

To create bending at sheet bodies SME: Cut and Bend operation is used: 

 

Icon Ribbon 

  
Sheet Metal → Cut and Bend 

Keyboard Textual Menu 

<SME> Operation > Sheet Metal > Cut and Bend 

 

Only a certain part of the workpiece is folded when bending. 

In this type of folding the base line should be a segment lying entirely within the base face limits. 

You can also set the base line by one of the side edges of the workpiece but in this case it is 

necessary to set the bending line displacement. 

 
 

3D profile workpiece Result of bending 

A special kind of bending is bending by 3D profile. An unclosed 3D profile built at the workpiece face is 

used as a template for the bent lug. The base line is set by finite profile points. 

 

  
3D profile workpiece Bending by 3D profile 

When bending by profile the base line always sets the start of bending area. In this case it is impossible to 

set bending line displacement and indents from base line edges. 
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Command parameters 

Command parameters are general for sheet metal commands and are described in the corresponding 

subsection above. 

The command automenu options are: 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity Parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 

 
<L> Select Line 

 
<E> Select first Vertex or 3D Node 

 
<S> Select second Vertex or 3D Node 

 
<W> Draw Profile 

 
<R> Select profile to bend 

 
<A> Cancel Selection 

 <D> Change the part to be bend 

Finish input. Builds a geometry according to the given parameters. In case there are not enough 

parameters set, the option is not available. 

Set entity Parameters. Calls a standard dialog of 3D modeling command parameters. 

Exit command. Shuts down the command with cancelling all the set parameters. 

Preview Operation Result. Enables/disables the standard option of 3D modeling commands review. 

Select Line. Selects a straight line determining the base bending line. The line can be set basing on the 

path, profile or the trace. The line should be a segment lying entirely within the face limits. 

Select first Vertex or 3D Node. Chooses the first point determining the base bending line. 

Select second Vertex or 3D Node. Chooses the second point determining the base bending line. 

Draw Profile. Sets the base bending line or a profile in transparent mode. When choosing the option you 

should set the workpiece face (the system automatically switches to drawing at the selected work plane 

mode), after which you should create the profile outline at the selected face. The outline should be a 

segment lying within the workpiece face or an unclosed succession of lines also lying within the workpiece 

face. When exiting the drawing at the selected work plane mode the profile created will be selected 

automatically.  
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Cancel Selection. Cancels all the elements selected and clears the operand window. 

Change the part to be bend. If the bending line is a straight line, there are two variants of bending, from 

two different sides. This option enables users to swap the bending side. In case of bending by profile the 

option is not available. 

Creating the bend 

A typical procedure when creating a bend is: 

 To select an unclosed profile or a straight line lying within the workpiece face. 

 To set general bending operations parameters. 

 To change the bent part in case of a straight bending line if necessary. 

 Finish entering. 

BRIDGE BEND  

To build a bridge between two sheet parts SM2: Bridge Bend operation is used: 

 

Icon Ribbon 

  
Sheet Metal → Bridge Bend 

Keyboard Textual Menu 

<SM2> Operation > Sheet Metal > Bridge Bend 

 

The operation enables users to create transition geometry with the given folding radius between the edges 

of the two sheet bodies of equal thickness, combining these bodies into one. 
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There are two variants of a bridge realized. 

 
Z/U From 

 
Folded 

There are three ways to build a bridge. 

 
By both edges 

 
By start edges 

 
By end edges 

Transition variants of U-shape. 

 

 
 

1 – initial edge, 2 – final edge U-shape, 2 folds U-shape, 1 fold 

Creating a transition of Z-shape. 

 
 

1 – initial edge, 2 – final edge Z-shape 
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In case of two sheet bodies intersecting it is possible to build a U-shape transition with one fold between 

them. 

  
1 – initial edge, 2 – final edge U-shape, 1 fold 

If two sheet bodies are inclined towards each other (the edges for building the bridge are still parallel), 

there are two types of a U-shape transition with one fold possible. 

 
 

 

1 – initial edge, 2 – final edge By displacement By radius 

Conditions of building a bridge 

Several conditions are to be followed when building a bridge between two sheet bodies. 

 Sheet bodies must be of equal thickness. 

 Only straight edges can be used for building the bridge. 

 The initial and the final edges must belong to different sheet bodies. 

 The initial and the final edges must be parallel. 

Command parameters 

Z/U From. The bridge will have two bending radii at each of the selected edges. 

Folded. The bridge will have one bending radius which is equal to half the distance between inner edges 

of the parts being connected. 

By both edges. The bridge shape will depend on both edges. The bridge symmetry axis will be determined 

by central points of the selected edges. 
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By start edges. The bridge shape will be determined by the first of the selected edges. The bridge symmetry 

axis will run through the centre of the first edge and will be perpendicular to the first edge. 

By end edges. The bridge shape will be determined by the second of the selected edges. The bridge 

symmetry axis will run through the centre of the second edge and will be perpendicular to the second 

edge. 

Other command parameters are general for sheet metal commands and are described in the 

corresponding subsection above. 

The command automenu options are: 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity Parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 

 
<F> Select start edge 

 
<S> Select end edge 

Finish input. Builds a geometry according to the given parameters. In case there are not enough 

parameters set, the option is not available. 

Set entity Parameters. Calls a standard dialog of 3D modeling command parameters. 

Exit command. Shuts down the command with cancelling all the set parameters. 

Preview Operation Result. Enables/disables the standard option of 3D modeling commands review. 

Select start edge. Selects the edge at the first body.  

Select end edge. Selects the edge at the second body. 

Bridge building 

A typical procedure when building the bridge is: 

 Choose the bridge variant: Z/U From, Folded. 

 Select the edge at the first body. 

 Select the edge at the second body. 

 Choose the building variant: By both edges, By start edges, By end edges. 

 Set general sheet material parameters. 

 Finish entering. 
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JOG  

To build a jog at sheet bodies SMJ: Jog operation is used: 

 

Icon Ribbon 

  
Sheet Metal → Jog 

Keyboard Textual Menu 

<SMJ> Operation > Sheet Metal > Jog 

 

The operation enables users to create a double fold at a sheet body at a random angle. Jogs can be helpful 

when it is necessary to build overlapping flanges, increase sheet part structure rigidity or provide a gap 

between two flanges. 

 

The length and position of the flange built at the second fold is determined by the initial face: the flange 

is parallel to the initial face and its length corresponds to the projection onto the initial face. 

Command parameters 

Command parameters are general for sheet metal commands and are described in the corresponding 

subsection above. 

The command automenu options are: 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity Parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 
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<L> Select Line 

 
<E> Select first Vertex or 3D Node 

 
<S> Select second Vertex or 3D Node 

 
<W> Draw Profile 

 <D> Reverse side 

 <F> Select Face 

Finish input. Builds a geometry according to the given parameters. In case there are not enough 

parameters set, the option is not available. 

Set entity Parameters. Calls a standard dialog of 3D modeling command parameters. 

Exit command. Shuts down the command with cancelling all the set parameters. 

Preview Operation Result. Enables/disables the standard option of 3D modeling commands review. 

Select Line. Selects a straight line determining the base bending line of the first fold. The line can be set 

basing on the path, profile or the trace. The line should be a segment lying entirely within the face limits 

(or the segment projection onto the face should lie within the face – in case the segment does not belong 

the face). 

Select first Vertex or 3D Node. Chooses the first point determining the base bending line. 

Select second Vertex or 3D Node. Chooses the second point determining the base bending line. 

Draw Profile. Sets the base bending line of the first fold in transparent mode. When choosing the option 

you should set the workpiece face (the system automatically switches to drawing at the selected work 

plane mode), after which you should create a segment at the selected face. The segment should connect 

opposite face edges or lie within the workpiece face. When exiting the drawing at the selected work plane 

mode the profile created will be selected automatically.  

Reverse side. Jog creates two parallel faces, one of which coincides with the initial one staying stationary 

by default. This option swaps the stationary and moving faces. 

Select Face. Selects the face which the operation is applied to. By default the nearest one to the set bending 

line is selected. 

Creating a jog 

A typical procedure when creating a jog is: 

 To select a rectilinear profile lying within the workpiece face or connecting opposite workpiece face 

edges. 

 Set general bending operations parameters: Height (Length in other operations), Angle etc. 

 Finish entering. 
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CORNER  

There is a special operation SMC: Corner for setting corner parameters at sheet bodies: 

 

Icon Ribbon 

  
Sheet Metal → Corner 

Keyboard Textual Menu 

<SMC> Operation > Sheet Metal > Corner 

 

The operation enables users to create relief at untreated corners of sheet parts and create overlapping. 

 

The operation requires selecting an adjacent folds intersection vertex. When choosing the vertex special 

markers appear. 

 Overlapping marker, consisting of two parts: an icon of selecting the overlapping type and an icon 

of gap value. The overlapping types are switched successively by pressing  on the overlapping 

icon. 

   

Overlap Without overlap Reverse overlap 

When pressing  on the gap value icon there appears an entry field.  
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 Corner relief marker, representing an icon depicting relief type.  

    

Round Square Welding No 

Weakening types are switched successively by pressing  on the icon. 

Overlapping type, gap value and relief type can be set in the operation dialog. 

Command parameters 

Following general sheet material parameters are available for the command: 

 Bend Relief (corner). With choosing between four variants from the list: Round, Square, Welding 

and No (if no relief is required).  

 Gap type. With choosing between three variants from the list: Without overlap, Overlap and 

Reverse overlap. 

 Gap.  

When choosing Corner command corner treatment is done automatically. 

 

Command automenu options are: 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity Parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 

 
<V> Select Vertex 

 
<A> Select Bend 
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Finish input. Builds a geometry according to the given parameters. In case there are not enough 

parameters set, the option is not available. 

Set entity Parameters. Calls a standard dialog of 3D modeling command parameters. 

Exit command. Shuts down the command with cancelling all the set parameters. 

Preview Operation Result. Enables/disables the standard option of 3D modeling commands review. 

Select Vertex. Enables users to choose the corner to be edited. The option is active at calling the command. 

It is necessary to select the adjacent elements folds intersection vertex.  

Select Bend. Alternative option of selecting the corner. Requires selecting adjacent elements folds. 

Corner creation 

A typical procedure when creating a corner is: 

 To select a folds intersection vertex. 

 To set general corner treatment parameters: Bend Relief, Gap type, Gap. 

 Finish entering.
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SHEET METAL. SPECIAL OPERATIONS 

LOFTED BEND  

SML: Lofted Bend operation is used to build bending by sections: 

 
Icon Ribbon 

  
Sheet Metal → Lofted Bend 

Keyboard Textual Menu 

<SML> Operation > Sheet Metal > Lofted Bend 

 

Lofted Bend operation is intended for modeling complex sheet bodies basing on two sections. 

 

 

To build a sheet body you need to select two sections lying in two planes that can be either 

parallel or not. The sections can consist of smoothly joined arcs or straight lines. 
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The number of arcs and straight lines in two sections is not necessarily the same. When building 

the bend arcs will connect to arcs and straight lines – with straight lines, and cylindrical bend 

segments will be formed. 

The body obtained as a result of this operation can be unbent with the help of SMU: Unbend 

operation. 

 

Command parameters 

General parameters section. 

Faceted approximation. The option enables users to build a surface consisting of planes set by three or 

four points. The surface obtained can be subsequently transformed into sheet metal, setting appropriate 

bending radii and weakening for the edges. 

Unfolding approximation. The option enables users to build a body by the surface which can be unfolded. 

Thickness. This parameter is general for all the sheet metal commands. The parameter value sets thickness 

of the sheet body being built. By default it is set in SMP: Defaults command. 

The variant of push-out direction at the given thickness relative to the plane built by the two selected 

sections has three variants similarly to Create Part operation. 
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Outside 

 
Inside 

 
Symmetric 

Radius. This parameter is general for all the sheet metal commands. The parameter value sets radius for 

all the bends of the body being built. 

Additional settings section: 

Accuracy. The less is the value, the higher is the accuracy of building the body. High accuracy increases 

number of bends and requires more time for building the body. 

Bends. The option enables users to manually set total number of bends taking into account the nearest 

possible number. 

  
30 bends 60 bends 

Gap. This option enables users to set the gap at the sheet part in case of using closed contours. 

Simplify. Eliminates (processes) the faces whose size does not allow to correctly build a 3D model from 

calculation. 

Command automenu options are: 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity Parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 

 
<U> Select first section 
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<V> Select second section 

 <1> Select starting point for the 1st section 

 <2> Select directions for the 1st section 

 <3> Select starting point for the 2nd section 

 
<4> Select directions for the 2nd section 

Finish input. To build geometry according to the given parameters. In case the parameters are insufficient, 

the option in not available. 

Set entity Parameters. Call a standard 3-D design command parameters dialog.  

Exit command. Shuts down the command cancelling the given parameters.  

Preview Operation Result. The option enables/disables a standard option for reviewing 3-D design 

commands.  

Select starting point for the 1st section. In case of an unclosed section the point will be selected 

automatically. With the help of this option you can set the point manually, e.g. when only a part of the 

unclosed contour is used. In case of a closed contour the point is to be set obligatory. The point will be 

selected at the contour under the cursor at pressing , according to possible bindings. You can also pre-

create a 3D node. The point will determine the plane position by which the cutting will be performed. If 

only the first section point is given, the plane will be perpendicular to the contour. 

Select directions for the 1st section. In case of an unclosed contour the option is not obligatory. In case 

of a closed contour it is necessary to set the plane or face determining the directing vector. The vector 

projection onto the tangent to the contour in the initial point will determine the points counting direction. 

Select starting point for the 2nd section. The option is similar to the first section initial point. The option 

is not obligatory: the initial point of the second closed section will be selected automatically as the 

intersection point of the section outline with the normal plane set by the first section initial point. Initial 

points of the first and the second sections (in case they are closed) determine the cutting plane where the 

gap is set. 

Select directions for the 2nd section. The option is not obligatory. The counting direction at the second 

section is automatically set the same as at the first one. The operation principle is similar to choosing the 

direction for the first section. The directions at the first and the second contours must be the same. 
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Creating a bend by sections 

Unclosed sections 
A sheet body can be built of two unclosed sections. 

 

To select the sections automenu options of selecting the sections  and  are used. 

 

If necessary a sheet body can be built by a part of the contour only. You need to select a point  and 

counting direction  for the first and the second contours. The contour counting directions must be the 

same. 

In the example in the picture a plane is chosen to determine the counting direction. 
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Closed sections 
A sheet body can be built by two closed sections. 

You need to additionally set the initial point and counting direction at least for the first section. 

 
 

The cutting plane can be set by selecting the initial point at the first section. Selecting the initial point at 

the second section enables users to set the cutting plane incline manually. 
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A 3D node at the upper section and counting direction 

are chosen 

Two 3D nodes at the sections and counting direction 

are chosen 

FORMING FEATURE  

To create sheet forming elements a SMF: Forming Feature command is used: 

 

Icon Ribbon 

 

Sheet Metal → Forming Feature 

Keyboard Textual Menu 

<SMF> Operation > Sheet Metal > Forming Feature 

 

The operation enables users to create forming elements at sheet bodies. Forming elements from standard 

or user libraries can be used. 
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Pimple type can be chosen from a drop-down list or by an icon showing the pimple type. If a pimple type 

whose icon is absent is chosen from the list, the last right icon will be replaced with the icon of the last 

chosen type. 

Pimple types and their icons are given below. 

 
Emboss 

 
Flange 

 
Flange non-closed 

 
Emboss non-closed 

 
Louver 
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Choosing from the standard list: 

 

  
Collar, V-shape, U-shape Groove, U-shape, V-shape 

 
 

Cradle, Airway, Round fold Flanging, Stamping 

There is a Select point in the drop-down list of choosing pimple type. It enables you to choose elements 

from user libraries. The content of the list is connected with the type chosen in the Standard field. The list 

changes if the standard is changed. 
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The following option is used for choosing the forming libraries: 

 
<B> Library Configuration 

More information about forming features creation can be found in “Create custom elements for 

sheet metal and holes libraries” chapter. 

A special library of typical stamping elements Sheet Metal Features supplied with the system is used for 

creating elements. If necessary, the library can be completed with the elements of your own. 
 

If inches are set as the units of length in ST: Document Parameters command in 3D tab, then Sheet 

Metal Features Inch library will be used when creating pimple. 

Command parameters 

Type. Enables users to choose pimple type from the list or by icon. 

Standard. Enables users to choose standard from the list. It is metric by default. 

The rest of the parameters depend on the pimple type chosen. 

Parameter dialog for every element contains a sketch of the element being created with entry fields for all 

the geometric dimensions. 

 

Command automenu options are: 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity Parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 

 
<B> Library Configuration 

 
<R> Select 3D profile 
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<F> Draw Profile 

Finish input. To build geometry according to the given parameters. In case the parameters are insufficient, 

the option in not available. 

Set entity Parameters. Call a standard 3-D design command parameters dialog.  

Exit command. Shuts down the command cancelling the given parameters.  

Preview Operation Result. The option enables/disables a standard option for reviewing 3-D design 

commands.  

Library Configuration. The option calls library selection dialog. 

Select 3D profile. The option chooses a 3D profile which will be the base for operation creation. The option 

is active by default. 

Draw Profile. The option enables you to build a profile in the transparent mode. You should choose a 

workpiece face and the system automatically switches over to drawing work plane mode. Then you build 

an outline within the face. The created profile will be selected automatically on exiting from the drawing 

on the work plane mode. 

Creating a pimple element 

To create a pimple element you should follow these typical steps: 

 Select a 3D profile which will be the base for operation creation. Profile choosing mode activates 

automatically at entering the command. 

 Choose the pimple element needed from the ones given in the library from the command 

parameters window (a parameter dialog for the element chosen will appear in the bottom part of 

the window). 

 Set the appropriate values of the parameters. 

 Finish entering. 

GUSSET  

To build stiffening ribs at sheet bodies SMG: Gusset operation is used: 

 

Icon Ribbon 

  
Sheet Metal → Gusset 

Keyboard Textual Menu 

<SMG> Operation > Sheet Metal > Gusset 

 

The operation enables users to build stiffening ribs (gussets) at a given pitch, of a given number, of different 
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types including ones made by user 3D profile. There are two variants of cross sections available for the 

gussets and the bending angles can be also different. 

 

Gusset positioning and their number are set according to the chosen construction variant which is set by 

icons in operation parameters window. 

 
By Point 

 
Fit 

 
Fill 

 
Step 

Another set of icons determines the gusset cross-section shape. 

 
Round 

 
Square 

Gusset shape from the side is linear by default but it can be set basing on the user profile with the help of 

 option. 
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Gusset of a standard linear shape Gusset based on user profile 

Command parameters 

Number, Step and Offset. The parameters determine the position and number of gussets at the given 

bend. Depending on the chosen construction variant these parameters can be available or closed. 

 By Point. Number and Step parameters are closed for this construction variant. The gusset position 

at the bend is determined by the Offset parameter with a dragger in the 3D scene. The Offset 

parameter determines the distance from the chosen face to the center of the gusset cross section. 

The face from which Offset parameter counting starts is determined automatically by the system. 

To change the position counting face, use  option and choose another face or a plane. 

 Fit. In this construction variant only Number parameter is available. The number of gussets set is 

uniformly distributed (the pitch is calculated automatically and is the same) along the bend. 

 Fill. Only Step parameter is available in this variant. Number parameter is calculated basing on 

maximum possible number of copies. Offset parameter is equal to the pitch. The distance to the 

center of the last gusset to the end of the bend depends on the pitch and number of copies, so the 

displacement counting face swap option  influences the result.  

 Step. For this variant Number and Step parameters are available. Offset parameter is equal to the 

pitch. The displacement counting face swap option  influences the result.  

Depth, Width, Taper Angle, Punch Radius and Die Radius determine gusset geometry. Depth parameter 

is not available in case the gusset shape is set by user profile. Punch Radius parameter is not available in 

case of using a cross section of a round shape. 

Command automenu options are: 

 
<Ctrl+Enter> Finish input 



Sheet metal. Special operations 

1147 

 
<P> Set entity Parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 

 
<A> Select Bend Face 

 
<F> Select Gusset Shape 

 
<Q> Select Plane 

 
<W> Draw Profile 

Finish input. To build geometry according to the given parameters. In case the parameters are insufficient, 

the option in not available. 

Set entity Parameters. Call a standard 3-D design command parameters dialog.  

Exit command. Shuts down the command cancelling the given parameters.  

Preview Operation Result. The option enables/disables a standard option for reviewing 3-D design 

commands.  

Select Bend Face. Choosing the bend (cylindrical face) between two surfaces where it is necessary to build 

the gusset. The option is active by default. 

Select Gusset Shape. The option determines the gusset shape from the side. Gusset shape can be set by 

profile, path or trace. The element determining gusset shape must lie in the plane perpendicular to the 

faces on which the gusset is built. 

Select Plane. The option to choose the plane determining the origin. Either a face or a plane can be chosen. 

Displacement determines the distance from the selected plane or face to the center of the gusset cross 

section. 

Draw Profile. The option enables you to build a profile in the transparent mode.  

Creating a gusset 

A typical procedure for creating a gusset is: 

 Choose a bend face. 

 Choose the gusset cross section variant. 

 Choose the gusset shape profile (in case when other than linear shape is required). 

 Set geometric parameters of the gusset. 

 Choose the variant to enter gusset position and number. 

 Change the origin plane (if necessary). 
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 Enter the gusset position and number parameters. 

 Finish entering. 

NORMAL CUTOUT  

SMN: Normal Cutout operation is used for creating cutouts at sheet bodies. 

 

Icon Ribbon 

  
Sheet Metal → Normal Cutout 

Keyboard Textual Menu 

<SMN> Operation > Sheet Metal > Normal Cutout 

 

The operation enables users to build a cutout with a gap at a sheet body with the edges perpendicular to 

the main faces. Multiloop 3D profiles are supported. 

 

There are three variants to create a cutout available in the command, switching between them is realized 

by icons. 

 
Thickness 

 
Mid Plane 

 
Nearest 

A list helps you to determine which of the faces is to have a cutout: the nearest one or all having 

intersections in the given direction. 
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Command parameters 

Type. Intersection of the projected profile onto a tilted sheet gives different results in terms of dimensions 

and position of the cutout depending on the surface to be considered the one for the profile to be 

projected onto. There are three variants for obtaining a cutout available: 

 Thickness. Maximum cutout size. 

 Mid Plane. According to the profile projection intersection with the middle surface of the sheet 

workpiece. 

 Nearest. According to the profile projection intersection with the nearest surface of the sheet 

workpiece. 

   

By thickness By middle By nearest 

Cutout. There are two variants: 

 To Nearest. The cutout will be made in the given direction at the nearest to the profile surface of 

the workpiece only. 

 Through All. The cutout will be made at all the surfaces of the workpiece that the profile projection 

intersects in the given direction. 

Symmetric. Symmetric direction of the profile projection. 

Gap. Sets the gap by equidistance from the cutout obtained. 

Round Corners. Profile corners rounding. 

The command menu options are: 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity Parameters 
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<X> Exit command 

 
<F5> Preview Operation Result 

 
<B> Select Body 

 
<F> Draw Profile 

 <W> Select Contour 

 <D> Select Direction 

Finish input. To build geometry according to the given parameters. In case the parameters are insufficient, 

the option in not available. 

Set entity Parameters. Call a standard 3-D design command parameters dialog.  

Exit command. Shuts down the command cancelling the given parameters.  

Preview Operation Result. The option enables/disables a standard option for reviewing 3-D design 

commands.  

Select Body. In case there are several bodies at the 3D scene, use this option to select the body where 

cutout will be made. The option is active by default in case there are several bodies at the 3D scene. 

Draw Profile. The option enables you to build a profile in the transparent mode. You should choose a 

workpiece face and the system automatically switches over to drawing work plane mode. Then you build 

a closed outline within the face. The created profile will be selected automatically on exiting from the 

drawing on the work plane mode. 

Select Contour. The option chooses a profile to create a cutout. You should choose a profile determining 

the cutout. The profile must be closed. The option is active by default in case there is only one body at the 

3D scene 

Select Direction. The option selects the profile projection direction. The direction is determined by a vector 

that can be set by a face or a plane (the plane sets a normal along which the projection direction vector is 

oriented). 

Creating a cutout by normal 

A typical procedure when working with Normal Cutout command: 

 Choose a sheet body if there are several bodies at the 3D scene. 

 Choose the profile determining cutout shape. 

 Set the profile projection direction. 

 Choose the cutout calculation type. 

 Set the gap and other parameters if necessary. 

 Finish entering.
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SHEET METAL. SHEET METAL WORKING 

CONVERT SOLID TO SHEET METAL  

To convert a body into sheet metal SMS: Convert Solid to Sheet Metal operation is used. To call the 

operation: 

 

Icon Ribbon 

 

Sheet Metal → Convert Solid to Sheet Metal 

Keyboard Textual Menu 

<SMS> Operation > Sheet Metal > Convert Solid to Sheet Metal 

 

Convert Solid to Sheet Metal operation is used to quickly create bodies or unfoldings from sheet metal 

basing on solid bodies. The result of Convert Solid to Sheet Metal operation is sheet body unfolding or a 

sheet part preserving the shape of the initial object. 

 
1 – solid body, 2 – sheet part unfolding, 3 – sheet part 

Operation description 

Solid bodies with flat faces can be used as initial bodies for the operation. 
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Stationary face 

Body unfolding takes place relative to the first face chosen which is considered fixed and determines the 

unfolding plane position. This face is called stationary face. 

Any flat face of the body can be chosen as stationary one. The edges for folding that will be involved in 

the operation are set relative to it. Stationary face is highlighted blue after being selected. 

 
Stationary face selection 

Edges for folding 

After the stationary face is selected it is time to select edges for folding. The first of the selected edges 

must be one of the stationary face edges. After the edge is selected the second of the faces building it gets 

involved in the operation. The moment it is done, you can select other edges of this face as folding edges. 

Therefore to select a face you need to select at least one of adjoining edges. Further on when building a 

sheet body a bend will be created at the selected edges, whose radius value is specified in the operation 

parameters. 

All the faces which the selected edges refer to are highlighted gray. The faces which are not involved in 

the operation are highlighted yellow.  
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Selected edges are highlighted blue Selected faces 

When selecting the edges, you should make sure that there are no collisions between the sheet elements 

obtained. This is because it is impossible to obtain a self-crossing flat template with the help of this 

operation. 

Adding thickness 

An equidistant surface at a given distance equal to the specified thickness is created for every selected 

face. The new surface is built inwards, outwards or symmetrically depending on the variant chosen in the 

parameters window. 

 
Outside 

 
Inside  

 
Symmetric 

After finishing the operation all the selected faces are converted into sheet metal and the faces not selected 

are deleted. 
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Selected faces are gray, deleted ones are yellow 

By default, all the faces highlighted yellow will be deleted when the operation works. If it is necessary to 

delete a selected face, <D> Select removable faces option is used. The selected face is added into 

Removed Faces tab of the Operands group in the parameters window and is marked red if selected in the 

list. In order to cancel face selection for deleting, switch to Removed Faces tab of the Operands group, 

select the face and press Delete. The button is to the right from the faces list. 

 

Operation parameters 

Thickness enables users to set thickness of the obtained sheet metal. Thickness direction can be specified. 

The following modes are available: inwards, outwards, symmetrically. 
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Inwards Symmetrically Outwards 

Radius enables users to specify the rounding radius of sheet metal faces. It is general for all the commands 

of sheet metal working. 

Neutral factor determines the way to specify neutral layer coefficient. It is general for all the commands of 

sheet metal working. 

Radius, Neutral factor and Thickness are taken into account when calculating unfolding length by bending 

radius arc. 

Remove bend edges. An absolutely smooth sheet body is created in the places of bend. When the option 

is active, Bend Result operation is not executed. 

Keep source body. The initial body is added to the current operation result. The option is useful for 

evaluating how the bended part is inscribed in the initial body dimensions. 

Corner group combines general commands parameters of sheet metal working and are described above. 

The following automenu options are available: 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity Parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 

 <K> Select fixed face 

 
<R> Cancel Selection 

 
<B> Select bend edges 

 
<D> Select removable faces 

 <E> Edit rip edges 
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<2>  Change relief type to square at selected vertex 

 <C> Bend result 

Finish input. To build geometry according to the given parameters. In case the parameters are insufficient, 

the option in not available. 

Set entity Parameters. Calls a standard 3-D design command parameters dialog.  

Exit command. Shuts down the command cancelling the given parameters.  

Preview Operation Result. Enables/disables a standard option for reviewing 3-D design commands.  

Select fixed face. Selects the stationary face relative to which the operation proceeds. 

Cancel Selection. Cancels selection of all the faces and edges involved in the operation. The option returns 

to the operation start. It is necessary to select a stationary face and edges again. All the values specified in 

General Parameters tab (thickness, radius etc.) stay the same. 

Select bend edges. Selects the edges by which bending radius will be built. After activating it is necessary 

to select the edges bordering with the faces involved in the operation starting with the stationary face 

edges. 

Select removable faces. Removes faces from the operation. After selecting the faces involved in the 

operation you can activate this automenu option and specify the selected faces to be removed as the result 

of the operation. The edges adjoining the removed faces become unavailable for selection. 

Edit rip edges. Enables users to select the edges for changing the gap and overlap type separately. You 

should choose an edge joining two faces involved in the operation. In the center of the selected edge there 

will be a marker consisting of two fields: overlap type switch icon and gap input field icon. Overlap types 

are switched in series by clicking  on the overlap icon. 

   

Overlap No overlap Reverse overlap 

When clicking  on gap icon an input field appears.  

 

Change relief type to square at selected vertex. Sets weakening at the given vertex. Weakening type can 

be changed to other than the default one at the selected vertex. By default all the vertices have round 

weakening. Weakening type can be chosen from a drop-down option list before selecting the vertex: 

Change relief type to square at selected vertex or Change relief type to welding at selected vertex.  
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After you choose the vertex a special marker appears near it. The type set for the vertex can be changed 

by clicking  on the marker.  

  

Square Welded 

To cancel the change of weakening at a vertex, select the vertex again. If there is no special marker of 

weakening change at this vertex, a default weakening of Round type will be created. 

Bend result. Enables/disables an additional command - Re-bend. If the option is enabled, the sheet body 

preserves the initial object shape. If the option is disabled, the sheet body will be unbent and unfolding 

will lie in the plane set by the stationary face. 

 

 

 

Sheet part (Bend result enabled) Sheet part unfolding (Bend result disabled) 

After finishing the operation with Bend result option enabled, another operation - Re-bend – will appear 

in construction tree, in addition to unfolding. 

In case of properties change in an operation which was already created, Bend result automenu button 

becomes unavailable. The reason for that is to preserve the logic of operations sequence in case there are 

other operations in 3D Model window after Unbend. 

Creating the operation 

A typical procedure for creating the operation is as follows 

 To select a stationary face of the body 

 To set sheet material thickness and rounding radius of the faces, otherwise they will be set from 

parameters by default 

 To select the edges involved in the operation 

 To enable/disable the options: bend result, flat body, initial body (if necessary) 
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 To set additional operation capabilities: weakening type, overlap type, gap between adjoining 

edges (if necessary) 

 To finish input. 

Example of operation work 

Using Convert Solid to Sheet Metal operation is demonstrated in the example. Besides, a case when it is 

necessary to change bending procedure is considered. 

Enter sheet metal parameters: 

 

Keyboard Ribbon Icon 

<SMP> Sheet Metal → Default 
 

 

Remove the flags from Bend/Unbend face completely and Check self-interactions options. Now in case 

of self-intersections of metal sheets the system can show the body obtained this way at the screen. If you 

leave the flags, the system will not be able to show the self-intersecting body and will display an error. 

    

To create Convert Solid to Sheet Metal operation, call the following command:  

 

Keyboard Ribbon Icon 

<SMS> 
Sheet Metal > Convert Solid to 

Sheet Metal  

 

The selection sequence of construction elements to create the operation is shown in the picture below. 

First, a stationary face is selected. Then three edges of the body are selected in turn. Before executing the 

operation it was specified in the Corner tab in the parameters window that sheet edges must overlap. 
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Selecting stationary face Selecting first edge Selecting second edge 

   

Selecting third edge Result Result 

After the operation is executed, we obtain a solid body with two sheets with non-deformed corners 

crossing a rounded face. This is because the body folding sequence was given incorrectly. 

This is exactly one of the cases when it is helpful to change edges folding sequence. It helps to avoid self-

intersection of the bodies, at the same time you don’t have to re-set the edges manually.  

Operands tab shows edges selection sequence for the operation. Use arrows  and  to change 

folding sequence. 
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Move the last of the selected edges two lines higher, selecting the required edge and pressing up arrow 

and repeat operation creation. Now the sheets adjoin each other smoothly and don’t intersect. 

 

UNBENDING  

 SMU: Unbend command is used to unbend the folds: 

 

Icon Ribbon 

  
Sheet Metal → Unbend 

Keyboard Textual Menu 

<SMU> Operation > Sheet Metal > Unbend 

 

The operation enables users to “unfold” the part and obtain a workpiece model for the designed sheet 

part. It can be helpful for making a sheet part unfolding drawing.  
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The operation works not only with the bodies created in bending operations. “Unfolding” of imported 

bodies, cylindrical faces obtained by turning or extrusion is also possible. Several folds can be unbent at a 

time. 

The folds to be unbent are chosen by selecting cylindrical faces. If you select a body and not separate 

unbending faces, the system automatically finds all the surfaces available for unbending and creates 

unfolding. If unbending variant offered by the system satisfies the user, the cylindrical faces to be unbent 

can stay unselected. 

At the same time with the fold chosen, the ones coaxial with it can be unbent. Coaxial are the folds that 

meet the following conditions: they belong to one and the same body, have bending lines lying on one 

straight line, have the same radius, angle and direction of bend (relative to the workpiece). 

     

Coaxial bends: one 

bending line, the 

same radius, angle 

and direction of 

bend relative to the 

workpiece 

Not coaxial bends: 

different bending 

direction relative to 

the workpiece 

Not coaxial bends: 

different bending 

angles 

Not coaxial bends: 

different bending 

radii 

Not coaxial bends: 

different bending lines 

When unbending, the workpiece neutral layer coefficient is taken into account. If a part created without 

using sheet metal operations is unbent, the neutral layer coefficient is determined by the user in command 

parameters. 
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The part section that is to remain stationary when unbending is chosen automatically by the system. By 

default such a face is highlighted yellow at the 3D scene. If necessary, the stationary face can be selected 

manually, using an automenu option. 

The unbending operation preserves all the topology obtained before, when creating the folds, i.e. the 

number of faces and edges of the body before and after unbending stays the same. It enables users to see 

bending areas at the flat unfolding and use them for example for future re-bending. 

The operation enables users to unbend unclosed conical faces of a body. 

 

Unbending cylindrical sheet bodies, truncated conical sheet bodies and random unfoldable surfaces is also 

available. 

Operation parameters 

NF. Unbend operation supports working with both the bodies created with the help of sheet metal 

commands and the bodies created in other ways. Therefore, unlike other sheet metal commands, there is 

a wider range of NF setting variants.  

 

 User value. It is entered by the user in the upper field. In case of selecting the bodies created not 

with sheet metal operations, it is the default variant. 

 Autodetect. Substitution from the table according to unbent body thickness and selected 

cylindrical face radius. 

 From geometry. The option is for the bodies obtained in sheet metal operations for which Neutral 

factor is already set. In case of selecting the bodies created with sheet metal operations, it is the 

default variant. 
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All the faces involved in unbending are unbent with the same coefficient. 

Reverse direction. The option is available for unbending closed body faces. It enables users to change 

unbending direction relative to the selected cutting plane. 

Gap. The field is only active when unbending closed body faces. It enables users to set the gap by cut. 

Unbend coaxial bends. It sets the forced unbending mode for the folds coaxial to the ones being selected 

in addition to them. The flag is on by default. When removing the flag only selected folds are unbent. 

The command automenu options are: 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity Parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 

 
<A> Select operation 

 
<E> Select cylindrical bend face 

 
<K> Select immovable unbending face 

 
<S> Select node to define split surface 

 
<D> Select unbending direction 

 
<R> Cancel selection 

Finish input. To build geometry according to the given parameters. In case the parameters are insufficient, 

the option in not available. 

Set entity Parameters. Calls a standard 3-D design command parameters dialog.  

Exit command. Shuts down the command cancelling the given parameters.  

Preview Operation Result. The option enables/disables a standard option for reviewing 3-D design 

commands.  

Select operation. The option to select a body for the operation. It is active by default at calling the 

command. When selecting a body, the system itself searches for all the faces available for unbending and 

creates the body unfolding. 

Select cylindrical bend face. Selects separate faces for unbending. You can choose cylindrical, conical and 

closed faces as well as other faces with unfolding. 

Select immovable unbending face. Enables you to choose the stationary face manually. It is necessary 

when the stationary face selected automatically by the system does not satisfy the user. 
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Select node to define split surface. The option is only available when selecting a closed face. You need to 

select a 3D node which defines the position of the plane along which the body with the closed face will be 

cut. 

Select unbending direction. The unbent face lies in the plane coinciding with the one tangent to the face 

being unbent in the point determining the cutting plane. The option enables you to define one of the two 

possible directions: to the right or to the left of the cutting plane. The direction vector projection onto the 

tangent line determines unbending direction. The direction vector can be specified by an edge or a plane 

(the plane determines the normal vector). You can also change unbending direction by setting the flag 

on/off in Reverse direction option. 

Cancel Selection. Cancels selection of all the elements and clears the operands window. 

Creating the operation 

A typical procedure for creating the operation is as follows 

 To select a body. The system offers an unfolding variant. 

 To set the Neutral factor. 

 To change the stationary face if necessary. 

 Finish input. 

If the result offered by the system automatically doesn’t satisfy the user, select bending faces manually. 

 Select bending faces. 

 Set the Neutral factor. 

 Change the stationary face if necessary. 

 Finish input. 

If the surface is closed: 

 Select bending face. 

 Select the point determining the cutting plane position. 

 Set the unbending direction if necessary. 

 Set the Neutral factor and Gap. 

 Finish input. 
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RE-BEND  

SMR: Re-bend command is used for re-bending of all the surfaces unbent by unbending operation: 

 

Icon Ribbon 

 

Sheet Metal → Re-bend 

Keyboard Textual Menu 

<SMR> Operation > Sheet Metal > Re-bend 

 

This capability is helpful for saving the image of the unfolding obtained with unbending operation in the 

model structure. E.g. unbending and re-bending operations can be used to create a drawing showing both 

unfolding and finished sheet part. 

Neutral layer coefficient used in unbending is used in re-bending. 

 

Operation parameters 

Command automenu options are: 

 
<Ctrl+Enter> Finish input 

 
<P> Set entity Parameters 

 
<X> Exit command 

 
<F5> Preview Operation Result 
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<A> Select operation 

 
<E> Select face to bending 

 
<K> Select fixed face  

 
<R> Cancel selection 

 

Finish input. To build geometry according to the given parameters. In case the parameters are insufficient, 

the option in not available. 

Set entity Parameters. Calls a standard 3-D design command parameters dialog.  

Exit command. Shuts down the command cancelling the given parameters.  

Preview Operation Result. The option enables/disables a standard option for reviewing 3-D design 

commands.  

Select operation. The option to select a body for the operation. It is active by default at calling the 

command. When selecting an unfolding body, the system automatically bends all the unbending faces. 

The stationary face is determined automatically by the system. 

Select face to bending. Manual selection of bending faces when the result offered by the system doesn’t 

satisfy the user. 

Select fixed face. Manual selection of the stationary face when the result offered by the system doesn’t 

satisfy the user. The option is only available at manual selection of bending faces. 

Cancel selection. Cancels selection of all the elements and clears the operands window. 

 

Creating the operation 

A typical procedure for creating the operation is as follows: 

 Select the unfolding body. The system automatically bends the unfolding to the initial body. 

 Finish input. 

If the result offered by the system doesn’t satisfy the user, choose bending faces manually. 

 Choose bending faces. 

 Change the stationary face if necessary. 

 Finish input. 

SHEET  PART AND ITS  UNFOLDI NG DRAWING  

Sheet part drawings are designed in the same way as for common parts (see section 2D Projections. 

Creating 2D Drawings of 3D Models).  
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To create a sheet part unfolding drawing a special command - Flat Pattern Projection – is used. The 

command is available from the ribbon in Draw group if 2D view is active. If a 2D sheet is not created in the 

document, it is recommended to pre-create it with the help of WSR Split Vertically or WSH Split 

Horizontally commands (their icons are in left lower corner of the 3D scene). 

To create an unfolding projection you can use the following command: 

 

Icon Ribbon 

  
Draw → Flat Pattern Projection 

Keyboard Textual Menu 

<3PF> Operation > Sheet Metal > Flat Pattern Projection 

 

If necessary, the sheet part and its unfolding drawings can be placed at one sheet. 

 

TABLE OF BENDS  

To work with bend tables, Create Bend Table , Bend Note  and Bend Table data  

commands are used. 
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With the help of Create Bend Table command you can create a table at the drawing, which will contain 

data on the bends of all the bodies present at the scene. 

 
 

Sheet part Table of bends 

To create a table of bends you can use the following command: 

 

Icon Ribbon 

  
Sheet Metal → Create Bend Table 

Keyboard Textual Menu 

<SMO> Operation > Sheet Metal > Create Bend Table 

 

Bend Table Data command creates a new product structure of the “For bend table” type: 

 

Icon Ribbon 

  
Sheet Metal → Bend Table Data 

Keyboard Textual Menu 

<SMT> Operation > Sheet Metal > Bend Table Data 
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Information on the bends is added to the corresponding product structure colomns. 

 

“For bend table” structure type can also be selected from Product Structure window manually and 

make a report. 

Bending line notations can be added for the unbent part projection. The following command is used: 

 

Icon Ribbon 

  
Sheet Metal → Bend Note 

Keyboard Textual Menu 

<SMZ> Operation > Sheet Metal > Bend Note 

 

If there is no “for bend table” product structure, the bend table will be created automatically at calling this 

command. 

After calling the command you should specify all the notations at the drawing that are to be added to it 

and press .  
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Unfolding drawing with bending lines noted



 

 

FACE OPERATIONS 
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FACE PROCESSING OPERATIONS 

The set of commands under the “Face” group provides means for direct manipulation with a body’s faces. 

This becomes necessary in special modeling situations, when handling 3D models imported from other 

systems, or when preparing 3D models for FEM analysis. 

Use of those commands results in operations that are added to the model structure. This insures correct 

regeneration and proper behavior through possible model modifications. 

The face group of commands includes the following commands: 

 Sew 

 Imprint Elements 

 Delete Faces 

 Separate Faces 

 Replace Faces 

 Change Faces 

 Transform Faces 

 Extend Faces 

 Fill Hole 

The commands are accessed from the textual menu item Operation, the group Face. Besides, some 

commands can be called from the context menu accessed by right clicking  over a selection of one or 

several faces or a closed loop of edges.  

Similar to other operations, the face processing commands have a corresponding representation in the 3D 

Model window. 
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SE W  

This command unites a set of disjoint surfaces into one sheet body and, if necessary, creates a closed 

volume, yielding a solid body. 

  
 

To create the operation, you need to define the set of surfaces to sew. You can select 3D profiles, faces or 

operations as the original surfaces. In the latter case, the operation must be a sheet body, for example, the 

result of extruding or rotating a wire contour, or an import surface from other applications. 

The surfaces being sewn must adjoin without overlapping. 

The result of sewing can be either a solid body or a new sheet body. By default, a solid body is created. In 

this case, the system attempts to create missing faces to make a closed volume. 

 

  

Original model Solid body created Sheet body created 

In some cases (for example, when the missing surface requires more than one face), the solid body cannot 

be created. 

                        

Call the command 3SS: Sew Surfaces: 
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Icon Ribbon 

 

3D Model → Special → Faces → Sew 

Keyboard Textual Menu 

<3SS> Operation > Face > Sew  

To execute the command, do the following: 

 Select surfaces to sew. 

 Specify advanced parameters (optional). 

 Confirm operation creation. 

To make a sewing, you need to specify the 3D elements defining the set of surfaces to sew. This can be 

done with the help of the following automenu options: 

 <R> Select 3D Profile 

 <F> Select Face 

 <O> Select surface operation 

The selected 3D elements are entered in the Elements list 

in the command's properties window. 

When selecting faces of some body (or several bodies), 

you can additionally tell the system which set of faces of 

this body (bodies) to sew: Selected Faces or All Except 

Selected Faces. This is done with the help of the parameter 

Consider Faces. In other cases (when selecting 3D profiles 

or entire operations), this parameter does not affect the 

sewing result.  

There are two ways to cancel a 3D element selection: 

- Pick this element again in the 3D scene using ; 

- Pick it in the “Elements” list in the command's properties window and click [Delete]. 

To cancel the selection of all elements at once, use the option: 

 <K> Cancel selection 

The Create Solid flag in the command's property window specifies whether to create a solid body 

from the sewn faces. The option is turned on by default. 

Sewing can be used not only to join isolated surfaces into one body. This operation can also be used to 

create a surface from one or multiple body faces.To do this, simply select the face or faces to sew. The flag 

“Create solid” must be cleared. As a result, a new sheet body will be created. In the future, it can be used 

to construct an equidistant (offset) surface using the “Shell” operation. 
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IMPRINT ELEMENTS  

This command is used for defining areas of specified shape on already existing faces. This might be 

necessary, in particular, for imprinting separator lines and surfaces into a 3D model as part of preparation 

for FEM analysis. Those elements could be used, for example, for defining forces applied to the model. 

                              

An element being split (the imprint target) can be one or several faces, or a whole operation. Those 

elements will serve as a basis for creating the new faces. Depending on the splitting method, the shape of 

the new area is defined based on either the shape of the dividing element (the imprint tool), as Face, Edge, 

3D Profile, Operation, or based on the geometry of the imprint target elements. 

The command for splitting faces is 3ZS: Imprint Elements: 

Icon Ribbon 

 

3D Model → Special → Faces → Imprint Elements 

Keyboard Textual Menu 

<3ZS> Operation > Face > Imprint Elements 

To create the operation, do the following steps: 

 Select the splitting method. 

 Select the objects to split (the imprint targets). 

 Select the imprint tool objects (optional). 

 Specify the direction (optional). 

 Confirm operation creation. 

Selecting Splitting Method 

A splitting method defines how the boundaries of the new faces will be 

determined, and, therefore, what data you need to specify. 

Select the splitting method from the pulldown list of a combo box located at 

the top of the property window. Upon entering the command, the method 

“Projection by direction” is set by default. 
 

Projection by direction 
In this method, the imprint tools are mapped on the imprint target objects along the specified direction. 
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In this method, you need to specify the imprint tool and the imprint targets. Additionally, you need to 

specify the mapping direction. If the imprint tool is a flat 3D profile, then the assumed direction is along 

the 3D profile normal. Make sure that the profile mapping direction is towards the imprint target objects. 

To use a different direction, specify it manually.  

 

It is possible that the imprint tool mapping occurs along the surface, or even 

on the opposite side of the surface. In the “Projection by direction” method, 

upon selecting an imprint tool element, the option “Connecting disjoint 

components” appears for selecting the mode of joining edges in this case. 

 
 

“No” means the system will attempt to create new edges only on the visible 

faces as viewed in the specified direction. 

 

“Vertical” means the system will attempt to create new edges on the faces 

visible in the specified direction or parallel to this direction. “All” means the 

system will attempt to create the edges on all faces, including the 

obstructed faces, as viewed in the specified direction. In this case, the new 

edges on the obstructed faces must allow a connection with new edges on 

other faces.  

 

The following diagrams show the results produced by each option. 

 

   

No Vertical All 
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Projection by normal 

                           

In this method, the boundaries of the new faces are determined by mapping the imprint tool objects on 

each imprint target object along the normal to the imprint target. All you need to specify is the imprint 

tool and target objects.  

If the imprint target is not flat, the normal changes from a point to a point of the surface. In such a case, 

the imprint tool object is mapped on the target as follows: each point along the edges of the imprint tool 

is mapped onto the point of the target that is the origin of the normal passing through the point on the 

tool. 

                             

It is important that all points of the imprint tool had a unique mapping on the surface of the imprint target. 

The command will fail otherwise. 

Intersection 
In this method, the boundaries of the new faces are the intersection lines between the tool and the target 

objects. 

                            

You need to specify the imprint tool and target objects.  
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If sheet bodies are selected as the imprint target and tool objects, the comboboxes “Imprint completion” 

and “Completion method” appear in the property window. 

                 

Those can be used in the case when the face of the tool sheet body does not 

fully intersect the imprint target. In this case, setting “Imprint completion” to 

“No” results in no new edges created upon executing the command. 

Alternatively, with the setting To nearest edge or To body boundary, the 

intersection line between the bodies will be extended (in the first case – up 

to the nearest edge, in the second – through all body), and that will be the 

edge.   

 

 
Edge extended up to the nearest edge 

 
Edge extended up to face bound 

The option “Completion method” lets you specify the direction of extending the edge: either tangent to 

the edge, or normal (reverse normal). The effect of each parameter is shown on the diagram below. 

 
Tangent direction 

 
Normal 

 

Reverse Normal 

Projection as outline 
In this method, the boundaries of the new faces are determined by the outline edges of the imprint target 

object. 
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You need to specify the imprint target object and direction. 

Create isoclinical curves 
In this method, the boundaries of the new faces are determined by an 

isocline. An isocline is a line connecting points on the surface being 

split, in which the tangency line to the surface makes the same 

constant angle with the specified direction. In 2D, this can be easily 

sketched (see the right-hand diagram). In 3D, the system builds a set 

of points – a line.  

                 

Isoclines are convenient in mold design. In some cases, an isocline is required for making “Taper”operation. 

Selecting Imprint Target Objects 

The imprint target are the objects that will be split as a result of the operation.  

It is possible to use multi-solid operations and multi-contour profiles as the imprinted elements. 

 

To launch the imprint target selection mode, use the automenu options: 

 <B> Select target operation 

 <F> Select target faces 
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Another way to select is by clicking the mouse on an empty line in the 

“Imprint targets” pane. After that, you can proceed with selecting the desired 

faces or operations in the 3D window. 

Selecting an operation as the imprint target means that all faces of the 

operation will be selected for imprinting. The system will correctly handle the 

situations when the number of the original operation’s faces changes after 

regeneration. 

 

To cancel selection use option: 

 <R> Cancel target selection objects 

Selecting Imprint Tool Objects 

Selection of imprint tools takes place only in the following imprinting methods: “Projection by direction”, 

“Projection by normal” and “Intersection”. In the other cases, you do not need to select the imprint tools. 

It is possible to use multi-solid operations and multi-contour profiles as the imprinting elements. 

In the first two cases, you can use the option: 

 <C> Select tool contours 

The option allows selecting elements (3D Paths, Edges, Profiles, Faces and Loops) that define boundaries 

of new faces. 

With the method “Intersection”, use either of the options: 

 <O> Select tool operation 

(In this case, the system constructs an intersection with all faces of the operation), or the option: 

 <A> Select tool faces 

(the system considers the selected faces only). 

If an operation was selected as the imprint target, then you can select a plane as the tool. In this case, use 

the option: 

 <P> Select tool plane 

To cancel selection use option: 

 <K> Cancel selection of tool objects 

Defining the Direction 

You must specify the direction if using one of the following split methods, “Projection by direction”, 

“Projection as outline” or “Create isoclinicalcurves”. In all those cases, the direction can be specified by 

selecting two 3D nodes. For this purpose, use one of the options: 
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 <1> Select first point 

  <2> Select second point 

Alternatively, use the option: 

 <D> Select direction 

That allows selecting elements for explicitly specifying the direction. 

Make sure that the profile mapping direction is towards the imprint target 

objects, otherwise the application will display a message about an error 

regenerating the model, upon confirming the operation. 

If the mapping direction is away from the imprint targets, use the option 

Reverse direction to flip the direction. The option is located at the bottom 

of the property window. 

 

 

To cancel selection use option: 

 <U> Cancel selection of projecting direction 

DELETE FACES  

This command allows deleting one or several selected faces. Face deletion breaks solid body topology. The 

introduced voids invalidate the closed volume. If required, the system can attempt healing those by various 

means. Otherwise, the result will be a sheet body. 

                             

 

The operation is used in surface and solid modeling, when local changes to the model topology are desired, 

without affecting the original relations. It can also be helpful when preparing a model to finite element 

analysis, for such tasks as removal of small model features that are insignificant to the calculations. 

You can directly select the faces to delete by explicitly picking the faces to delete. Alternatively, you can 

indirectly specify such faces. In this way, you either select a chain of edges surrounding the faces to delete, 

or a face on which the faces being deleted are dependent. 

 

 

Call the command 3ZD: Delete Faces via: 
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Icon Ribbon 

 

3D Model → Special → Faces → Delete Faces 

Keyboard Textual Menu 

<3ZD> Operation > Face > Delete Faces 

To execute the command, do the following: 

1. Select faces to delete. 

2. Select a healing method. 

3. Confirm operation creation. 

Selecting Faces to Delete 

The option “Select Elements” serves for selecting objects defining the faces to delete: 

 <F> Select Elements 

By default, you can select faces, edges and loops. 

In the simplest case, you can select the exact faces to be deleted. However, besides that, there is a 

convenient option of selecting a closed loop of edges that will define the faces to delete (the selected 

elements are added to the Faces list). This option is not just for speeding up the selection of faces to delete. 

In a parametric model, if a new face is created as a result of model modifications in the area of faces 

deletion, this face will be correctly handled by the system. 

                 

A closed loop of edges divides all body faces into two sets: one to be deleted, 

and the other to be left out. To determine what particular set of faces will be 

deleted and what left out, use the option “Face Selection Pattern”. 
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The default option value is “Auto”, for the system to delete the set of faces 

with the least area. The options “Forward” and “Backward” allow manual 

selection of the set of faces to delete. 

The set of faces to be deleted is automatically highlighted in the 3D 

window. 

Note that you can select several closed loops of edges simultaneously 

(intersecting and nested loops are not allowed). This makes possible 

defining more intricate sets of faces to delete. 

When selecting a set of edges, the following option is turned on by default: 

 

 

 <G> Smooth edge chain selection mode 

If you need to select specific edges, turn off this option. 

Selecting Healing Method 

“Healing method” determines the system actions after deleting the selected 

elements. It instructs whether to close the introduced voids, and, if so, how. 

Select a method from the pulldown list of the combo box in the property 

window. The command default method is “Cap”.  

No healing 
In this case, the system just deletes the select faces, leaving the resulting void in the model as is. If the 

original operation was a solid, then the model will lack the closed volume after the deletion, and will 

become a sheet body. 

               

Cap 
In this way, upon deleting the faces the system tries to form a surface for closing the resulting void. The 

capping surface must pass through all edges surrounding the void. As a result, this method works in the 

cases, when all edges surrounding the voids are obtained by an intersection with a single surface. This 

actually becomes the capping surface. 
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Grow from parents 
In this method, the system tries to close the voids caused by surface deletion by growing the faces adjacent 

to the deleted faces. 

                   

Shrink 
In this method, the system tries to close the voids caused by surface deletion not only by growing the faces 

adjacent to the deleted (as in the previous method), but also by trimming them. 
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Advanced Parameters 

Upon selecting the deletion method and the faces to delete, you can specify some advanced parameters.  

When surfaces are deleted, one or several sets of new loops (of edges) can be created, surrounding the 

model voids. 

 

By default, the system will try to process all those loops simultaneously, as 

part of processing the model. In the process, the capping surface is being 

formed that is passing through all loops (that’s a ruled surface). However, in 

some case,s it is necessary to make separate capping surfaces for each loop. 

The option Independent loops accounts for this. 
 

The effect of this option can be demonstrated on the example of a hole with two chamfers. Suppose, the 

surfaces of the hole and both chamfers are being deleted. In the course of the command, the faces of the 

hole are deleted, and two loops come into play (the upper and the lower loops), bounding the void 

introduced in the body. 

 

 
Original model 

 
Intermediate stage 

If the option “Independent loops” is turned off, the system unites the two loops in order to close voids, 

which results in another hole of a larger diameter than the original one. Instead, with the option 

“Independent loops” turned on, the system processes each loop separately, which in this case results in 

capping each with a flat surface. The hole completely disappears. 

 

 
Independent loops Off 

 
Independent loops On 

 

When using the “Independent loops” option, a situation can occur when two or more bodies are produced 

by the operation, instead of one. 
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Original model 

 
Independent loops Off 

 

Independent loops On 

The option “Select blend edges” is provided specifically for the cases 

of deleting faces created by blending.  

When deleting blends, one often needs to delete, besides the 

particular blend face, also some other faces in order to correctly cap 

the voids introduced in the model. 

 

Moreover, sometimes it is necessary to delete all blended faces 

adjacent to some flat face. Of course, you could select such faces 

manually; however, more convenient is to select just the flat face. This 

lets the system automatically select 

 

the blend faces to delete. Such automatic selection of faces insures the model parametric behavior through 

changes in the number of blend faces, maintained by the system. 

 

The option Select blend edges method tells the system which faces to select and delete automatically. 

There are several ways of selecting blend faces. 

 

Selected faces 
The system will attempt to delete only the faces that were explicitly selected by the user. 

                     

Chains excluding branch faces 
A smooth sequence of blend faces will be automatically selected for deletion. The sequence extends up to 

the faces at which the chain branches into several chains of blend edges (up to branching faces). 
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Chains including branch faces 
A smooth sequence of blend faces is automatically selected, extending up to and including the branching 

faces. 

 

                        

Maximum chains 
A smooth chain of as many blend faces as possible is selected automatically. 

 

                            

Only dependent faces 
Only those blend faces are selected automatically that are dependent on the faces selected by the user. 

The user-selected faces themselves are not deleted. 
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SEPARATE FACES  

This command allows excluding selected faces from an already existing body, and creating a new body 

based on them. The resulting voids in the bodies can be closed by one of several methods. 

                                     

When selecting the separation faces, that is, the faces that will be excluded from the existing body, the 

same mechanism is used as in the command “3ZD: Create Delete Faces”. The separation faces can be 

specified explicitly or indirectly. 

Call the command 3ZX: Separate Face via: 

Icon Ribbon 

 

3D Model → Special → Faces → Separate Faces 

Keyboard Textual Menu 

<3ZX> Operation > Face > Separate Faces 

To create the operation, do the following steps: 

 Select separation faces. 

 Specify the methods for processing the original and separated faces (optional). 

 Confirm operation creation. 

Selecting Separation Faces 

To select separation faces, use the option: 

 <O> Select Elements 
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When using this option, you can specify not only the particular faces to be separated, but also edges and 

loops defining the faces to separate. All selected elements are automatically added to the list of separation 

faces. 

Specifying Healing Methods for Original and Separated Faces 

As a result of separating faces from the original body, voids may occur in the 

original and the resulting bodies, that invalidate the closed volume. The 

options “Healing source faces” and “Healing separated faces” allow selecting 

a healing method for such voids. The sets of methods for the original and 

separated faces are the same.  

Note that the original faces and the separated faces are either healed (“Cap” 

or “Grow from parents/children”), or left as is. 

 

 

No healing 
In this case, the system does not process the introduced voids. The resulting bodies are sheet bodies. 

Cap 
The system attempts to process the introduced voids by creating a single capping surface. The capping 

surface must contain all edges surrounding the body’s voids. Therefore, this method works in the case 

when those edges result from intersecting the body with a single surface. 

                             

Depending on the original model geometry and the selected separation faces, more than two bodies could 

result from the operation. In the model tree, the resulting bodies will have references to the parent 

operation (the “Split Face”) named: in the first two bodies - “First part” and “Second part”, in other bodies 

– “Part”, “Part_0”, “Part_1”, etc. 

Grow from parents/children 
In this case, the system tries to heal the introduced voids by growing the faces adjacent to the voids (the 

child faces or parent faces). 
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Depending on the geometry of the original model interfaces selected for separation, the operation could 

yield more than two bodies. 

To get the desired result on the original (source) and resulting faces, you can use various methods of 

healing the voids (except for the “No healing” case). 

REPL ACE FACES  

This command allows replacing a geometrical surface underlying the selected face, by another geometrical 

surface. 

                             

In the usual command flow, the faces to be replaced are selected in pairs with the replacement surfaces 

(by selecting elements with these underlying surfaces). The surface underlying the face being replaced is 

substituted by the replacement surface. As a result, the face being replaced changes its shape according 

to the shape of the replacement surface. The side faces that bound the face being replaced are extended 

or trimmed to the intersection with the replacement surface. If several pairs of faces to replace - 

replacement surfaces were selected at once, this procedure is repeated for each pair. 

                         

It is possible that no intersection between the side faces and the replacement surfaces will be found despite 

extending the side faces. Then the command will end up in an error message. 

 
           Command is successful                                 Command fails 

The command 3ZR: Replace Face can be called as follows: 



Face Processing Operations 

1191 

Icon Ribbon 

 

3D Model → Special → Faces → Replace Faces 

Keyboard Textual Menu 

<3ZR> Operation > Face > Replace Faces 

To create the operation, do the following steps: 

1. Select sets (pairs) of faces to replace and the replacements. 

2. Define advanced parameters (optional). 

3. Confirm operation creation. 

Selecting Faces for Replacement 

You can select multiple pairs of faces to replace and replacement surfaces. 

To select faces to replace, use the option: 

 <F> Select replaceable faces 

A face to replace could belong to a sheet body, but in that case it should be “surrounded” by adjoining 

faces on all sides.  

To select replacement faces, use the option: 

 <R> Select replacement faces  

 

When specifying replacement faces, you can select not only faces, but also 

edges, workplanes and 3D profiles. Selecting a workplane or a flat 3D profile 

is similar to selecting an appropriately positioned flat face. If a non-flat 3D 

profile was selected, the system will use its underlying surface as the 

replacement. An edge can be selected if it fully lies in a plane, but is not 

straight. 

You can also start selecting a face to replace and a replacement surface via 

the property window. Working with the “Faces” list is similar to working with 

other such lists.  

Besides simply selecting the replacement surfaces, it is also possible to select a sheet body. The following 

option is used for this purpose: 

 <S> Select sheet body 

When using this option, you can select sheet bodies, faces and 3D profiles. 

The faces being replaced will be replaced by one or multiple new faces copying the shape of the 

replacement sheet body. 
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While only a single sheet body is allowed, you can select multiple faces to replace at once. 

                     

When using a sheet body, the faces to be replaced may not have holes, otherwise the command will fail. 

Besides that, the replacement sheet must be large enough, so that the intersection could be constructed 

between the replacement sheet and the extensions of the adjacency faces. 

To cancel selection of a particular pair of the face to be replaced - the replacement surface, you can use 

the properties window and the button . As for canceling selection of all faces, you can use the option: 

 <X> Cancel selection of all faces and surfaces 

Selection of the replacement sheet body can be canceled by the option: 

 <K> Cancel sheet body selection 

Defining Advanced Parameters 

As was mentioned above, the adjoining faces are grown or trimmed to the intersection with the 

replacement surfaces. If two intersections are found, which one will be picked by the system? By default, 

the intersection is accepted with the part of the surface where the normal points towards the faces to be 

replaced.  

However, in some cases, you may want the system to pick the second 

intersection choice. For this purpose, use the “Reverse” flag, located at the 

lower portion of the property window. 
 

If the flag is set, the system will pick the intersection with the portion of the replacement surface, whose 

normal points away from the face being replaced. 
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“Reverse” is Off 
  

“Reverse” is On 

CHANGE FACES  

This command allows modifying parameters of the faces whose underlying surfaces are analytical (cylinder, 

cone, sphere and torus), as well as the parameters of faces created by a blend operation. Most commonly, 

this command is used for handling imported models. 

                    

To use the command, select one or several faces to modify (faces being modified), and specify their 

parameters. Parameters vary depending on the face type, and can be shared across all faces or be specific 

to a face. The required condition for executing the command is, the face being modified must be 

“surrounded” by adjacency faces. 

The command 3ZC: Change Face can be called as follows: 

Icon Ribbon 

 

3D Model → Special → Faces → Change Faces 

Keyboard Textual Menu 

<3ZC> Operation > Face > Change Faces 

To use the command, do the following sequence of steps: 

 Select faces to modify. 

 Define face parameters. 

 Define advanced parameters (optional). 

 Confirm operation creation. 

Selecting Faces to Modify 

To select the faces to modify (the faces, whose parameters will be changed), use the option: 

 <F> Select faces 
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When selecting faces, the system allows selecting only the faces that can be 

modified, that is, cylinder, cone, sphere and torus type surfaces and blend 

faces. 

When selecting blend faces, you can use the Select blend edges method 

combo box. Exactly the same combo box is used among the properties of the 

command Delete Faces. Each item of this combo box was described in details 

in the respective section of this chapter. The command Change Faces utilizes 

this combo box in a similar way, except that the automatically selected faces 

are subjected to parameter changes, rather than deleted. 

You cannot modify blend faces and faces of other types 

simultaneously. 

You can select several faces of different types at once. 

 

Once a face is selected, it is added to the “Faces” list. Working with this list is 

similar to working with other such lists in the application. 

To cancel selection of all faces at once, use the option: 

 

 

 

 

 <X> Cancel selection of all faces and surfaces 

Defining Face Parameters 

New parameters of surfaces are always defined in the property window. However, different parameters can 

be defined depending on a face type. For the faces that are blends, cylinders and spheres, you can define 

the radius. For cone faces, define the cone angle. For the faces – tori, define the major and minor radii of 

the torus. Faces of different types may be selected when defining the command. The appearance of the 

property window changes accordingly, depending on the type of the face selected in the “Faces” list. 

If you check the “Relative Parameter” option, the respective face parameter 

will be changing relative to the original parameter. For example, if the original 

cylindrical face had the radius equal to 20, then, with the option “Relative 

Parameter” set, entering the radius value of 5 yields a cylindrical face with the 

radius 25 resulting from the operation. 
 

By default, each face in the list of faces being modified has parameters shared 

across other faces, while having the “Common Parameters”option set in the 

property window. To define specific properties of a face, turn off this option. 

If necessary, you can turn off the “Common Parameters” option for all 

selected faces.  
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TRANSFORM FACES  

This command applies a transformation to one or several selected faces. The command is mostly used for 

handling imported models, however it can be helpful in other cases as well. 

                 

By executing the command, the selected faces are moved to a new position and, if requested, extended 

(or trimmed) to achieve an intersection with the surfaces of the adjoining faces. The adjoining faces, in 

turn, are extended (or trimmed) to the intersection with the faces being transformed.  

 

The correctness of the command behavior can be guaranteed only if the topology of the resulting model 

is unchanged. If the model topology changes, the result of the operation may be incorrect. 

When selecting the faces to transform, the same mechanism is used as in the command 3ZD: Delete Faces: 

the faces to transform can be specified directly or implicitly. Defining transformation parameters of the 

selected elements is done similar to that in the command 3EG: Transform Element. 

The command 3ZT: Transform Faces can be called as follows: 

Icon Ribbon 

 

3D Model → Special → Faces → Transform Faces 

Keyboard Textual Menu 

<3ZT> Operation > Face > Transform Faces 

To use the command, do the following sequence of steps: 

 Specify faces to transform. 

 Define transformation parameters. 

 Confirm operation creation. 

Specifying Faces to Transform 

To specify the faces to transform, use the option: 
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 <F> Select Elements 

When using this option, you can select not only faces, but also edges with loops. The selected elements 

are put in the Faces list. 

To cancel selection of all elements, use the option: 

 <X> Cancel selection of all faces and surfaces 

If edges or loops are selected, the Face Selection Pattern parameter becomes available. The effect of this 

option is described in the command “Delete Faces”. 

When selecting a set of edges, the default option is: 

 <G> Smooth edge chain selection mode 

To select individual edges, turn off this option. 

SPECIFYING A TRANSFORMATION  

Special manipulator appears in the scene after selection of the first element. It helps you to change the 

position of the selected faces. Procedure of specifying transformations is described in detail in the "3EG: 

Transform Element" command description. The exact values of translations and rotations can be set in the 

properties window. 

 

Use the following options to select the coordinate system relative to which the transformation will be 

performed: 

 

 <1> Source CS on source operation 

 <2> Select LCS for current transformation 

Option  is active by default. The manipulator is in the center of original operation bounding box. The 

drop-down list of the option has the second variant of coordinate system positioning - option . When 

you select this option, the manipulator will be in the center of the bounding box that bounds all movable 

face. 
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Source CS on source operation LCS for current transformation 

Option  allows you to select any LSC for specifying the transformations.  

The operation can be confirmed either at the stage of selecting the elements to transform or at the stage 

of defining the transformation parameters. 

EXTENDING SURFACES  

This command allows extending a selected face (or several faces belonging to a sheet body) in the specified 

direction, for the specified length amount. The direction of extending the face is defined by selecting the 

side edges of the faces being extended. 3D profiles can be extended as well. In this way, an enlarged face 

will be created as a result of executing the command, identical in shape with the underlying surface of the 

3D profile. 

  

Sometimes, self-intersections occur when extending a face. In such cases, the command execution ends 

up in an error message. 

The command 3SX: Surface Extend can be called from the textual menu: 

Icon Ribbon 

 

3D Model → Special → Faces → Extend Faces 

Keyboard Textual Menu 

<3SX> Operation > Face > Extend Faces 

To use the command, do the following sequence of steps: 
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 Select the object to extend. 

 Select edges. 

 Specify extension amount. 

 Define advanced parameters (optional). 

 Confirm operation creation. 

Selecting Object to Extend 

To select an object to extend, use the option: 

 <R> Select surface operation 

When specifying an object to extend, you can select faces, 3D profiles and sheet bodies. 

Selecting Edges 

Once the object to extend is selected, you can select one or several edges bounding this object. Those 

edges will indicate the direction of extending the given object. To select edges, use the option: 

 <H> Select Edge 

The default option for selecting edges is: 

 <S> Smooth edge chain selection mode 

To select individual edges, turn off this option. 

To select all edges surrounding the selected object, at once, you can use the option: 

 <A> Select all edges 

To cancel selection of any of the edges, click it again. 

Defining Amount of Face Extension 

The entry Distance means the distance from the selected edge to the new 

edge bounding the extended surface, as measured along the surface. 

Enter the amount of face extension in the Distance input box of the property 

window.  

Besides the property window, this value can be modified in the 3D window, 

using arrow-shaped draggers. The draggers appear after selecting at least one 

edge. To “grab” a dragger, move the pointer to the tip of the arrow (the 

pointer will then change its appearance) and depress the left mouse button.  

Note that the same extension amount is applied in all specified directions. 
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Defining the Advanced Parameters 

The parameter “Modify source surface” tells the system, whether to modify the original face topology, or 

leave it as is. The effect of this parameter on the result is shown below. 

 

Original model 

 
“Modify source surface” parameter is 

off 

 
“Modify source surface” is on 

 

 

The parameter Keep source solid specifies, whether to leave the source 

body in the 3D scene (the whole body altogether, rather than just the 

selected face). If this parameter is off, the source body disappears upon the 

operation completion. 

The parameter Shape defines the shape of the new face created as a result 

of executing the command. This parameter can take several values. Linear 

means, the face extends straight, staying tangent to the original face at each 

point of the selected edge. In this way, the surface curvature has a jerk near 

the selected edge. With the parameter value set to Of Source Surface, most 

of the newly created surface is linear (ruled), as in the previous case. 

However, the surface curvature around the selected edge changes 

smoothly. 

 

 

 

 
Original model 

 
“Linear” Shape 

 
“Of Source Surface” Shape 

 
“Like Source Surface” 

Shape 

 

In real life, the angular difference between the new surface with the parameter Linear and that with the 

parameter Of Source Surface is about 3 degrees. Therefore, the difference between the two results is 

practically vanishing. 

The parameter Like Source Surface means the new surface will rely on the definition of the source surface. 

The example below shows the effect of this parameter on a spline surface. 
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Original model 

 

Resulting model 

 

Original faces may contain internal smooth edges. Internal edge is 

considered to be “smooth” when converging faces that form this edge 

are tangent to each other at the point of intersection of the edge with 

another edge that defines direction of surface extension. 

The “smooth” state of internal edges may be affected in the process of 

surface extension. To avoid this set G1 mode for Smoothness option (G1 

 is geometric continuity by first derivative). This option will recommend 

system to retain tangent continuity, keeping “smooth” state of the 

internal edge on surface extension. 

By default Smoothness option is set as GO (recommendation to ensure 

only surface continuity). 

 

 

F ILL  HOLE  

This command serves to patch “hole” contours (regions) in a sheet body. Filling is done by creating one or 

several faces closing the selected regions. It is also possible to patch regions in a solid body, however with 

numerous restrictions. 

The command is used in surface and solid modeling. It can also be useful when working with imported 

models whose bodies contain voids resulting from loss of faces due to export/import deficiencies. 
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When executing the command, the system may fill the gap using an analytical or ruled surface, depending 

on the original geometry. It is also possible to make patches based on a specified sheet body or 

geometrical surface. 

Selecting Regions to Fill 

You can close several regions of one body at once by performing the operation. 

Each region is defined by its contour - the set of edges making up the given contour. To define a contour, 

you need to specify all body edges that belong to it. Contours must be closed. 

When defining contours, you can use the mode of automatic selection of all edges. In this mode, you just 

need to select one of the edges in each contour. The system will select the remaining edges automatically. 

The composition of the selected contours can then be manually edited.  

An also provided mode to select all contours serves to automatically select all holes to patch in the specified 

body. 

Hole-Filling Methods 

The specified regions of a sheet body can be patched by various methods: 

- Automatic generation of the filling surface; 

- Fill by the sheet body; 

- Filling by a geometrical surface. 

The surface resulting from patching regions is by default merged into the source body. If necessary, it can 

be saved as a stand-alone operation. 

Filling with Automatic Patch Surface Generation 
In this way of patching, the system automatically creates the faces that can close the selected body regions. 

The user has a way to influence the type of the created faces. This is done by defining a preferred form of 

the closing surface: 

- Smooth – the system will attempt to create an analytical or ruled surface closing the selected 

region; 

- Preferably plane – the application attempts to close the selected region with a plane first, and 

then, in the case of a failure, with a spline surface; 

- Plane only – the system attempts to fill the region using only a plane. If this attempt fails, the 

command execution ends up with an error message. 
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Original model 

 
“Smooth” Filling 

 
“Preferably plane” Filling 

The preferred form of the filling surface is defined separately for each selected contour (that is, separate 

for each region to be patched). By default, the faces filling the area approach the original model smoothly 

(tangentially) at each edge bounding the area to fill. The smooth edge condition can be disabled for each 

individual edge or for all edges in a contour. 

 

When closing a region with a ruled surface, there is an option to minimize the topology. In this case, the 

system will attempt, whenever possible, to close the gap with a minimum number of faces. 

 
“Minimize topology” flag is off 

 
“Minimize topology” flag is on 

Fill by sheet body 
In this filling method, an additional sheet body shall be defined. The selected regions of the source body 

will be closed based on it. Please note that in this case the same filling method is applied to all selected 

contours of the source body. 

The sheet body defined as the filling surface must satisfy the following conditions:  

 Fully close all holes being patched; 

 Have only one boundary (for example, a sheet body like a side surface of a cylinder does not satisfy 

this condition); 

 Not have holes. 

Filling regions by a sheet body can be done in two ways. 

 



Face Processing Operations 

1203 

The first method is filling with trimming by the borders of the patched regions. In this case, the system 

trims the shape-defining sheet body along the boundaries of the patched regions. The resulting surface is 

the sought filling surface. This filling method can be used only under the condition that the filling sheet 

body goes through all edges that surround the regions to be patched. 

 

 
Original body 

 
Result 

The second method is filling with trimming by the sheet body boundaries. In this case, a region is cut from 

the source body along the boundary of the filling sheet body. The filling sheet body then "patches" the cut 

region. That means, the entire sheet body is used as the filling patch. The necessary condition to use this 

method is that all border edges of the sheet body lie on the source body. 

 

 
Original body 

 
Result 

Shown below are schematic diagrams that demonstrate the difference between these two methods. 
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Original model 
 

Filling with trimming by the patched 

region borders 

 
Filling with trimming by the 

sheet body borders 

Filling by a geometrical surface 
In this filling method, a geometrical surface is additionally defined, based on which the selected regions of 

the source body will be patched. The surface is defined by selecting a 3D object of an appropriate type (a 

worksurface or workplane, a face-underlying surface, a planar edge, etc.). 

 

In this case, as in the previous one, the same filling method is applied to all selected contours of the 

source body. 

 

The surface defined as the filling specimen must close all regions to patch in the source body. At the same 

time, you need to pay attention to the type of the selected surface. Some types of simple surfaces can be 

extended by the system beyond its defining element. For example, if a plane underlying a flat face was 

selected as the filling surface, then the system can extend this surface up to the infinity, and it will be always 

closing all selected regions. On the other hand, a surface beneath a spline face is strictly limited to the face 

borders. 
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Besides that, to successfully fill the gaps, the borders of all regions being patched must lie on the selected 

surface. 

 

When patching, the system constructs a sheet body by the specified surface and trims it by the borders of 

the regions to be patched. The resulting body will be the filling one. 

 

Specifics of working with solid bodies 
The region-filling command allows processing holes in solid bodies as well. However, in this case the 

command capabilities are limited.  

 

When patching the surface of holes in a solid body, only the “Filling by a geometrical surface” method can 

be used. You cannot use filling by a sheet body. In the cases when the surface is not specified, but the 

system managed to perform filling on its base, the system will automatically find the methods of closing 

this surface (you cannot specify it, unlike the case of the sheet body). Besides that, the result of filling a 

region in a solid body is always created as a stand-alone body (a separate operation). It cannot be merged 

with the source body. 

 

Please note that the face - filling operation cannot be used to remove holes in solid bodies. The 

“Delete Faces” operation is instead used for this purpose. 

Defining the Operation 

The command 3ZF: Fill Hole can be called as follows: 

Icon Ribbon 

 

3D Model → Special → Faces → Fill Hole 

Keyboard Textual Menu 

<3ZF> Operation > Face > Fill Hole 

To use the command, do the following sequence of steps: 

 

1. Select the areas to fill. 

2. Select the filling method by specifying the preferred form of the filling surface or a filling surface 

itself (a sheet body or a geometrical surface). 

3. Define additional parameters for the selected filling method (optional). 

4. Confirm operation creation. 
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Selecting regions to patch 
Upon launching the command, the option to select contours of the regions to be patched is active by 

default in the automenu: 

 

 <C> Select Contour 

The additional option is turned on by default: 

 

 <G> Contour selection mode 

 

This option serves to create a new contour and select all edges belonging to it by picking just one edge. 

If the  option is enabled, then you just need to select one of its 

member edges in the 3D window in order to have the contour selected. 

The system will automatically find the remaining edges of this contour 

and make them selected. After that, you can right away proceed with 

selecting an edge of another contour, and so on. 

The selected contours are entered in the Contours list in the properties 

window. If you select one of the contours in the list (by picking it with 

), then the Edges field will display the list of edges that make up this 

contour. 

To manually select contour edges (this may be required, for example, 

when working with a solid body), disable the option . In this mode, 

selecting an edge with the option  will create a new contour in the 

list of contours (with a single selected edge). You can then select more 

edges for the contour using the option: 

 

 <E> Select Edge 

To define a second contour, you need to use the  option again, create a new contour with a single edge 

in it, and then select more edges using the option , and so on. 

 

To delete one of the defined contours, select it in the “Contours” list in the properties window, and then 

click the button  beside this list.  
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To delete an individual edge in a contour, select the intended contour in the list of contours. The “Edges” 

list will display the edges of that contour. Select the desired edge and click the button  beside the list 

of edges. The selected edge will be removed. 

 

To automatically select all holes in a sheet body as the contours to patch, use the option: 

 <A> Select all Contours 

After calling this option, you just need to select the sheet body, in which you want to close the holes. All 

contours will be defined automatically. 

 

 

Defining parameters when filling with automatic generation of the patch surface 
The preferred form of the patch surface is defined in the “Filling” field 

of the properties window. Please note that defining a preferred filling 

form of the patch surface is done individually for each selected contour. 

That means, in the case of selecting multiple contours, you need to pick 

each contour in the list in a sequence and define the preferred surface 

form for each of them. 
 

When creating a continuous patch surface for all edges of all contours, the smoothness condition is set by 

default. To disable this condition for an individual edge, select the contour in the list of contours, which 

includes the given edge, and then select the desired edge in the list of edges of that contour. Set the Non-

smooth edge flag for the selected edge. You can similarly reenable the smoothness condition for an 

individual edge of a contour, by selecting this edge and disabling the flag Non-smooth edge. 

 

To disable the smoothness condition for all edges of all contours, you just need to click the button [All 

Non-Smooth]. The button [All Smooth] allows to reenable the smoothness condition for all edges of all 

contours. 

 

The minimal topology mode is enabled by setting the flag Minimize Topology – separately for each 

patched contour. 

 

Defining parameters when filling by a sheet body 
You can define the sheet body that will be used as the specimen to create the patch surface by using the 

option: 

 

 <S> Select surface operation 



Three-dimensional modeling 

1208 

The selected sheet body is entered in the Surface field of the command's 

properties window. 

The trimming method is defined in the field Method. To trim by the borders 

of the regions being patched, use Trim to hole, to trim by the sheet body 

borders – Trim to sheet. 

A selection of a replacement sheet body can be canceled by the option: 

 

 

 <D> Cancel sheet body selection 

Defining parameters when filling by any geometrical surface 
You can specify a 3D object defining the geometrical surface to use for patching body regions, using the 

option: 

 <U> Select surface 

The selected 3D object is entered in the “Surface” field of the properties window. 

In the complicated cases, the system may be mistaken with the direction of 

closing the selected contours. That means, the new faces could be applied 

not on the selected holes in the body, but rather around them. In such a case, 

use the additional flag “Reverse” that alters the direction of closing the 

selected regions. 
 

Selection of a replacement sheet body can be canceled by the option: 

 <D> Cancel sheet body selection 

Adding the filling surface to the source body 
By default, the created surfaces become part of the source body. This is indicated by the enabled flag 

Attach to Source Body. 

This flag is unavailable when working with solid bodies.



 

 

SERVICE 3D TOOLS AND 

ENTITIES 
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EDITING 

This chapter gives basic ideas and recommendations on editing a 3D model and its related elements of a 

2D drawing in T-FLEX CAD. By editing, we mean certain user actions aimed at making changes to an existing 

3D model. There could be various reasons for editing: 

 correcting model flaws in the event of getting critical errors in the diagnostics window; 

 introducing improvements to existing model geometry, rearranging or rectifying a model, inserting 

sequences of operations in the middle of the model tree; 

 rearranging graphic elements in a drawing or in 2D constructions. Replacing elements. Resolving 

recursive references; 

 redefining geometrical or other properties of individual model elements; 

 modifying variable values; 

 modifying the model structure, reordering operations within the model tree; 

 modifying the methods of snapping and relations between 3D assembly elements, optimizing 

mates and setting up the function of a mechanism model; 

 deleting elements, excluding model objects from a sequence of related elements. Deleting 

sequences of related elements, deleting “extra” elements. Other. 

A T-FLEX CAD model is usually a parametric one. Therefore, depending on a case it may become necessary 

to undertake a group of measures aimed at editing the model, since certain changes, once introduced, 

often cause a need to correct other relations. Therefore, before going ahead with profound editing, it is 

advisable to do some research and prepare the best plan of actions. When you do such preparations, you 

may face the following tasks: 

1) identifying (researching) the model structure and the steps and methods of its creation; 

2) identifying the sequence of related parents and children for a given model element; 

3) finding elements: 

 operations; 

 3D construction elements; 

 2D construction or graphic elements; 

 variables that control the specific parameters; 

4) tracing parametric dependencies: geometrical relations and element dependencies on 

variables; 

5) geometry measurements and checks; 

6) identifying invalid elements and the reasons behind model regeneration failures. 
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In this chapter we review the system tools that may be useful in various scenarios of the editing process. 

The specifics of editing certain elements is given in dedicated chapters of the documentation, which 

describe the workflow specifically for those elements. 

We recommend to set aside a backup copy of the source file before proceeding with significant 

modifications to the model structure. 

BEFORE YOU EDIT  

Researching the Model Structure and Selecting Elements 

The user may often face the task of understanding the sequence of the model creation, the order in which 

elements and operations are calculated, and identifying relations between model elements. In particular, 

you may face this task if you need to modify a model created by another author. The following model 

research approaches are possible: 

 reviewing the model structure in the model tree window; 

 using the rollback function to determine the sequence of operations creation and analyzing 

the methods used for creating operations at various steps of model creation; 

 “Destructive method”. This implies sequential deletion of operations and detailed analysis of 

the model at certain creation steps, identification of individual operation creation methods, 

experimenting with the model in various ways at its early stage of creation. We recommend 

doing this kind of experiments with a copy of the source file; 

 going into an operation editing mode, but then canceling the editing, in order to see what 

elements this operation was based on and how it was created. When you enter the editing 

mode, the time is spent solely to calculate the rollback state, and when it is canceled, the 

original state is quickly restored. 

“3D Model” Window 
The “3D Model” tool window serves to display the information about the 3D model structure and its 

creation history, as well as for selecting and managing the model elements. The 3D model tree displays all 

3D construction entities and operations of the model. This information is displayed as a tree. One can select 

3D elements either on the tree branches which illustrate the history of creating Bodies of the given a model, 

or on the auxiliary “Constructions” and “Operations” branches, where the elements are sorted by types. 

The model structure can be traced by expanding the model tree branches and watching the order of 

operations creation. Each model tree branch represents the history of creating a certain Body of the model. 

Any element in the structure that possesses a creation history has an associated  or  glyph to expand 

or collapse the tree branch. Other elements have an associated  or  glyph for viewing the list of source 

parent elements. Some elements do not have any associated glyph since they have neither parents nor a 

creation history within the model structure. 
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By expanding the model tree branches one can watch the elements corresponding to a given operation, 

which were used as the base for the operation's creation. To view or edit the respective parameters, you 

can select the object by . The context menu containing the element's commands is displayed upon . 

You can select 3D construction elements and operations in the 3D model tree within the folders containing 

the elements of the relevant type. Upon pointing the cursor to a 3D element name in the model tree, the 

respective element is highlighted in the 3D scene - this helps to keep the track of the location when there 

are many elements of the same type in the model. If you select an operation which is buried deep in the 

model structure, the system will attempt to highlight in the 3D window the model topology elements 

(edges, faces, vertices), which were created by this operation. This is possible only if such elements are still 

identifiable within the final Body. Such highlighting helps to understand what part of the model is 

represented by a given operation. By subsequently selecting operations in the model tree, one can 

understand the order and the purpose of the operations. This is how you proceed with the preliminary 

general analysis of the model structure.  

 

 

To enable the selector and filter settings at the time of selecting elements in the 3D model tree, 

enable the “Use active View Filter” flag. 

When analyzing the structure, it is helpful to know that the last operations in the creation history of the 

model's Body, that is the ones that are displayed in the 3D window, are by default entered in black in the 

model tree. Other operations are entered in blue. The names of the visible 3D construction elements are 

also entered in black in the 3D model tree. The invisible elements (that is, those hidden through the use of 

layers, the hide command or otherwise) are displayed in gray in the 3D model tree. When selected in the 

3D model tree or simply pointed to with the cursor, the hidden 3D elements are highlighted in the 3D 

scene. 

 

For detailed information on working with the “3D Model” window see the chapter “Basic 3D Terms and 

Concepts of Modeling with T-FLEX CAD”. 
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Rollback Model 
The system provides the function of rolling back a three-dimensional model to the level of a specified 

operation. This functionality is helpful in the cases when it is necessary to work more on the model 

somewhere in the middle of the model tree, that is, revert it to an earlier creation stage.  

To perform a rollback, use the “3D Model” window. Select the operation, up to which you need to roll back. 

Click . Select the “Rollback Model” button in the context menu. To return from the rollback, select the 

“Finish Rollback” command in the context menu. 

 

Elements and operations that follow after the rollback point in the model's history become hidden in this 

mode and are inaccessible for you to work on. In this state, those are marked by semitransparent icons in 

the model tree. All elements and operations newly created in the rollback mode are automatically inserted 

in the model's history. At each such instant, the system automatically rebuilds the relevant dependencies 

as necessary to be able to re-create the following operations. If for some reason the introduced changes 

result in errors in the model, then the system will offer restoring the model state before the rollback. This 

protects the user from introducing invalid modifications to the model.  
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Sometimes, it is helpful to subsequently delete elements and operations in order to get a detailed 

understanding of the model structure as part of other experiments. In this case, the system will not 

be spending time for saving and rebuilding relations, unlike in a rollback. But the model itself may 

be damaged by this, therefore this method should be used on a copy of the source file. 

Tracing parameter dependences and relations between variables 
One may often need to find out what elements directly depend on a given variable, or which geometrical 

or parametric relation makes the selected element interact with other objects in the model. This 

information is not reflected in the “3D Model” window.  

The Help > Info command brings up a special dialog window in which the full model structure is displayed 

that pertains to all model elements. Sequences of related elements are displayed as a tree. Unlike the “3D 

Model” window, the “Info” window's structure provides more details not only on the 3D elements, but also 

on the drawing elements and all auxiliary objects.  

This command can be conveniently called from the context menu of the selected element of interest. In 

this case, the model structure in the command's window is given relative to the selected element or group 

of elements. The model structure can be displayed in two relational directions: ParentsChildren or 

ChildrenParents. 
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The command's dialog window provides the buttons for launching the general commands for editing, 

sorting elements and running measurements. Such commands are applied to the element selected in the 

model structure pane in the left-hand side of the dialog. 

The "Info" pane in the right-hand side displays the data pertaining to the currently selected element. This 

includes its creation method, some general parameters, the ID, etc.  

The special command Parameters > Links… serves to trace the elements which are directly controlled by 

each system variable or expression that involves that variable. This command's dialog window is similar to 

the window of the Help > Information… command. It displays all system variables and expressions, and 

the structural sequences of dependent elements relying on those variables and expressions. 
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Element Search 
You can use the search to select an element, if you know its individual name or ID. To search an element, 

there is the dedicated command Edit > Find… You then need to enter the element ID or name in the 

command's dialog. To run the search, close the dialog by clicking the [OK] button. If the system finds the 

element, it will become selected and highlighted in the 3D window, and its name will be marked in the 

model tree. After that, you will be able to proceed with editing, as by calling a desired command or by 

accessing the context menu via .  

 

In the search window, all existing system elements are also arranged by types in the relevant folders. 

Selection can be done directly in the dialog window.  
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Selecting elements in the 3D scene 
By default, you can only select the visible 3D elements in the 3D window. The elements hidden by whatever 

means - whether through the layers mechanism, or through suppressing or hiding 3D elements, etc. - are 

not selectable in the 3D scene.  

If necessary, the user can enable selection of invisible elements in the 3D window (the View tab of 

the ST: Set Document Parameters command). 

To select an object, point the cursor to it. The system will offer the current selection choice by highlighting 

the respective element and display a tooltip with the element name. To confirm the selection, click  or 

. In the case of  the context menu will appear with the set of the element's commands. 

When selecting elements, pay attention to the selector's filter settings. To control 3D elements selection in 

a densely populated 3D scene, configure the selector (the command FT: Set Selector Configuration) and 

the filter (the command FL: Filter Settings). The filter quick access buttons are available on the system 

toolbar: . When all filters are enabled, then, upon 

pointing the cursor to a Body, the topology elements (faces, edges, vertices) are offered first.  

The cursor may often point to several objects at once. In this case, if the system-offered selection choice is 

not suitable, then, after a 2-second delay, the multichoice cursor appears. It lets you make another choice 

by spinning the mouse wheel. 

Operations Selection by Geometry Elements 
You can select a topological element (face, edge, vertex) and enable edition of the operation, which created 

it. To do this, use the context menu.  
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There is a drop-down submenu for the last operation in the body model tree in the context menu of each 

topological element. The name of the string in the context menu corresponds to the name of the last body 

operation for which the submenu is formed. For example, the figure shows that when the context menu 

for the face formed by the operation “Extrusion_1” is called, the context menu shows the name of the last 

operation in the model tree of the body - “Blend_5”. 
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If you go to the submenu of the operation, you can call the command to edit it.  
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In the selector filter set on the system panel there is the  <Ctrl + Alt + J> Select operations by created 

faces option, which allows you to select earlier operations in the model history by topological elements. If 

you enable this option, the names of those operations that directly created the selected topological 

element will appear in the context menu.  

 

Let's make this option active. Call the context menu for the vertical face once again. It can be seen from 

the figure that when the option  is active, the context menu does not indicate the name of the last 

operation in the body model tree (“Blend_5”), but the name of the operation that formed this face, i.e. - 

“Extrusion_1”.   
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Similarly, with the active option , the system will work for other elements, for example, for the edges of 

the face formed by rounding. 
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To quickly switch to editing any body operation, you can use the <Ctrl + Alt + J> Select operations by 

created faces option in conjunction with the <Ctrl + Alt + X> Select Operations filter.  

 

Then, when you hover the cursor in the 3D scene on the edge of the body, the system will offer to select 

operations that participated in the creation or modification of this face. If the element forming operation 

is Primitives, Extrusion, or Sheet Metal, then control manipulators will be automatically available. 
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To edit other operations, you can use the Edit command available in the drop-down panel. 

 

If the system finds several operations for a given face, the multivariate selection icon will appear at the 

cursor. 
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Geometry Measurements and Checks 

The system has several different tools to perform various checks and measurements of geometrical data. 

This paragraph lists them all without providing a detailed account of the respective working techniques. 

For details please refer to the dedicated sections of the documentation.  

 The Parameters > Measure command serves to get geometrical data about an object or to 

measure relations between two selected objects. This command operates mostly in the 3D 

window or in the drawing area where objects to be measured are selected. The achieved 

results can be bound to a variable. This function is used when you need to save the results of 

measurements and include the achieved data in other expressions that drive some model 

parameters. This command is also accessible via the context menu on right-clicking  a 

geometrical object or from the context menu called from an input box in any of the dialogs. 

 The sets of commands in the Tools > Geometry Analysis > … group serves to perform various 

studies of the model, as getting mass-inertia properties of a selected body, the geometry 

validity check on various bodies, body intersection or contact analysis of the model, etc.  

Sometimes, to perform a series of distance measurements between various elements of a part, it may be 

helpful to construct a temporary 2D projection somewhere on the 2D page and create the required 

dimensions. Once done with measurements, you can delete that projection unless useful for other 

purposes.  
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Identifying Failing Elements and the Reasons of Model Regeneration Errors 

Upon encountering errors during the model recalculation, the system outputs relevant signals. The user 

shall be able to correctly interpret those in order to proceed with a sound and quick fix to the source of 

errors and restore the model validity. 

Diagnostics Window 
The “Diagnostics” tool window serves to output various system messages regarding errors in the model 

encountered during a recalculation, as well as warnings and information messages. 

Messages are output in the diagnostics window line by line. Each line includes the message type symbol (

   error-type, info-type, etc.), a brief description of the message cause and the name/ID of the 

model element. 

 

Below we review the most typical errors occurring in the course of model recalculation: 

Message text Remarks 

Geometry is too complex... A geometrical parameter specified in the operation's properties (for 

example, a blend radius) does not support a valid result under the 

current conditions. To correct the error, check the geometry near the 

location of the operation or modify the geometrical parameter value. 

Error regenerating *a 

source/parent element* 

One or more elements used as the base for the concerned operation 

failed the regeneration for some reason. The operation cannot be 

recalculated because of a missing source element. To correct the 

error, try to restore the source element or redefine the operation. 

Degenerate *element* The source data used for constructing the element (usually, a 3D 

profile or a 3D path) for some reason does not support a correct 

construction of the element. To correct this error, check the source 

2D construction elements (for such issues as self-intersecting 

hatches, open contours etc.). 

Error opening Fragment file  

Link to Nonexistent File 

The system couldn't find the required file neither by the specified 

path nor in the assembly folder. 

Error regenerating source 

*Element*  

The system encountered additional errors when recalculating the 

element, which lead to an invalid result. 
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Input data is incorrect The operation's input parameters do not support a valid result. 

Modify the source elements or the operation's geometrical 

parameters. 

Missing operand in Boolean 

operation 

A Boolean operand could be missing due to an error in its 

regeneration or due to parametric modifications of the model that 

caused the body to disappear. In this case, only one operand is left, 

and the Boolean operation no longer makes sense within the 

sequence of the model's operations. It could be the case, however, 

that such "blinking" elements are intentional instances within a 

family of parametric versions of the part. The Boolean operation 

provides an option among its parameters to allow a missing 

operand. 

Error recalculating Fragment 

model 

This is a general message conveying the fact that errors were 

encountered when regenerating a model of a Part or a 3D fragment. 

You need to investigate the fragment's model to correct the error. 

Use the command Open Fragment, Detail. 

Recursion in Element links In most cases, the system warns the user by this message in advance 

about an attempt to create recursive relations (that is, the element's 

dependencies on itself). This message being displayed during model 

regeneration means the model already has recursive relations. To 

resume the normal function, make sure you find and break the 

recursion by redefining the elements with invalid relations. 

Upon error messages being displayed in the diagnostics, make sure to investigate and fix their causes. By 

selecting a message line in the diagnostics window you automatically select the respective element. You 

can call the context menu containing the commands for the selected element by , which includes the 

editing commands (see “Editing Techniques” below).  
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Diagnostics may include messages about the regeneration errors which occurred during recalculation of 

3D fragments. In this case, the context menu will provide the command Show Fragment Structure. Once 

this command is called, the system will show in what fragment the error occurred. Next, depending on the 

situation, you can use the command Open Fragment or Detail to investigate the fragment's model. 

 

Since model elements are related with each other, a failure in one element may simultaneously 

cause a sequence of errors in other elements. In a case like that, you need to start fixing problems 

from the very first failing element. Therefore, if you see several messages, first pay your attention to 

the beginning of the list in the upper part of the diagnostics window.  

 

Sometimes, it is not the element triggering a recalculation error that actually needs to be fixed, but rather 

one of its “parents”. For example, a 3D profile doesn't cause regeneration errors by itself, but its geometry 

may not support valid calculation of a further operation. In such a case, you need to look for the reason 

why the 3D profile changed. Maybe, that reason originates on the workplane page that contains the source 

construction for the profile. After that, the error in the child 3D element may disappear automatically. 

 

“3D Model” Window 
Working with the diagnostics may be enhanced by using the 3D model structure in the “3D Model” window 

for finding the desired element. The model elements within which errors are detected are marked by special 

signs: 

 A red cross on an element ( , , ) means the failure occurred in that particular element.  

 A red arrow attached to the icon of a 3D element ( , , , , ) means an error was 

detected among its parents. By tracing the history of the element's creation along the model 

tree branch, you can reach the first failing element. If there are errors, then the red arrow will 

also show on the special folders of the model tree containing lists of elements ( , ). 

 

 A blue cross on an element ( ) means the operation was suppressed by the user. This is just 

an info message, rather than an error. 

 

To reach the failing element, you need to expand the branches of the model tree and follow the tree 

structure, finding the so marked elements. 
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EDITING TECHNIQUES  

Modifying Element Properties Without a Rollback 

Each system element possesses a certain combination of settings and geometrical parameters. One can 

view and modify those parameters in the element parameters dialog window. One can call this dialog and 

modify the values at any time. This is convenient when the full-function editing command is not required, 

in avoidance of forcing the system to run a potentially time-consuming recalculation up to the edited 

element. 
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Select the desired element to call its properties dialog. This can 

be done directly in the “3D Model” window or with the help of 

the search function. You can select the element by  to access 

the context menu, and then call the Properties command. When 

you work in the “3D Model” window, you can bring up the 

element's properties by  . 

When selecting the element by clicking , the properties window 

displays certain common properties which can be modified. You 

can handle common parameters of multiple simultaneously 

selected elements in the same way. You can conveniently select 

multiple elements in the “3D Model” window with the help of the 

<Shift> or <Ctrl> key. Once the objects are selected, a table with 

all parameters common across the group of the selected objects 

will be loaded in the properties window. Set the checks against 

the parameters which are to be edited, enter the new respective 

values, and then click the button  in the properties 

window. 
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"Edit" Command Workflow 

Each system element has its own editing command that serves to redefine the setup, modify the source 

data, etc. Several methods are available to launch the editing commands. 

The commands to edit all types of 2D and 3D elements are located in the “Edit” textual menu: 

Keyboard Textual Menu Icon 

<3E..> "Edit > Construction > …" … 

<3E..> "Edit > Operation > …" … 
 

In most cases, the editing command name for a 3D element differs from the respective creation 

command by just one letter “E” (Edit). Examples: 3N – 3EN – these are the commands to construct 

and edit a 3D node, 3X– 3EX – the commands to create and edit an extrusion operation. The icons 

of the editing commands differ from that of the respective creation commands in the added scissors 

symbol .  

The edit a particular element, you first need to select it, and 

then lunch the editing command. You can select the element 

in the 3D window or in the 3D model tree by , and the Edit 

command will be available in the context menu. You can also 

use the “Info” window (see above), which also has the [Edit] 

button, or launch the editing command on a preselected 

element, as by using the Search command.  

When the editing command is launched for a particular 

element, the system appears to be as if in its creation 

command, with the parameters already defined and 

geometrical elements selected. The user can proceed using 

the same methods and techniques as one would use in the 

element's creation command. Please refer to the dedicated 

chapters of the documentation for the description of 

relevant techniques. 

 

If no element was selected at the time of launching the editing command, then you will see the options 

for selecting an element and general edit-specific actions in the command's automenu: 

 <Esc> Cancel selection 

This option clears the selection of the selected objects. 

 <A> Select All Elements 

This option serves to select all objects of a particular type present in the model. Invisible objects will be 

selected if this was allowed by the setting in the command ST: Set Document Parameters on the View tab. 
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 <Z> Select element by name 

The list of elements available for selection will appear. 

 <I> Select Other Element 

If the first 3D element was selected by the parent 2D element, then using this option will cause subsequent 

selection of all 3D construction elements of an editable type created based on 2D elements. If an element 

was selected in the 3D window, then the selection will loop through all similar 3D elements lying on the 

selection ray. The selection ray is directed perpendicular to the screen plane and goes through the point 

of the cursor position at the selection instant. Only those elements will be selectable which are located 

close enough to the point of the cursor. Using this option over causes the sequential selection of all such 

3D elements. 

 <P> Set entity parameters 

This option allows to modify parameters of the selected 3D element. When this option is called, the element 

parameters dialog window appears on the screen. This option is fully analogous to the 3D element 

parameters editing command accessible from the context menu (by selecting the 3D element in the 

command-waiting mode). 

 <F4> Execute Edit Command 

This option launches the element creation command and loads in it all source data attributable to the 

edited element. After that, the user can make changes to the set of source data using the same techniques 

as in the element creation command. 

 <R> Change Definition 

This option allows to modify the creation method of the selected 3D element. This mode is fully analogous 

to the 3D element redefinition (recreation) command accessible from the context menu (by selecting the 

3D element in the command-waiting mode). 

 <Del> Delete entity 

This option's function is fully analogous to the Delete command accessible from the context menu (by 

selecting the 3D element in the command-waiting mode). 

 <M> Transformation 

This option calls the 3EG: Transform Element command for the given 3D element or group of elements. 

Working with this command is described in the “Assigning "Transformations" to 3D Entities” chapter of 

this manual. 
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If several elements of the same type are selected in the editing command using the option  and the 

<Shift> or <Ctrl> key, then the only options available in the automenu will be the transformation and 

deletion.  

Retain Operation Geometry after Recalculation 

Upon the activation of the editing command, the system rolls back the model to the state in which it was 

at the time of creating the operation. The elements remaining in the scene are those independent from 

the edited object. When executing a rollback, a part of the model requires regeneration, therefore the 

command may take some time to activate. 

To eliminate this regeneration phase and thus speed up the command activation, you can enable saving 

the intermediate geometry for a certain operation. This will increase use of computer memory and the 

model file size to some extent, but will help speed up editing. In fact, saving geometry can be used as a 

temporary measure while experimenting with model editing. To turn on geometry saving, right-select  

the operation (for instance, in the model tree) and choose the “Retain Geometry after Recalculation” item 

in the context menu. The system will query the user as to when it shall regenerate the model in order to 

calculate the geometry to be saved - immediately or upon the next recalculation: 

 

When the “Retain Geometry after Recalculation” option is enabled, the operation icon in the model tree is 

marked with the special symbol . 

Element Redefinition 

The context menu of any 3D element accessed by  has the Recreate command which serves to modify 

the element's definition method. The system rolls back to the state as before the element creation and 

launches the element creation command. After that, the user shall create that element anew. This command 

is typically used instead of simply deleting an element and creating a new one, in case it may be used 

somewhere else. Therefore, it is important to know that the old element's ID, name and subsequent 

relations are maintained. 

Element Deletion 

There are several ways to delete elements from a model. Depending on the case, it may be possible to 

delete groups of dependent objects or eliminate isolated objects from the model's structure, if possible. 
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The system also allows to automatically trace the objects unused downstream in the model, and delete 

them. 

“Delete” Command (the 3D element deletion command) 
The Delete command is called from the context menu when an element or a group of elements is selected. 

The command serves to delete one or several elements (whether 3D or 2D elements). When the selected 

objects are deleted, their parent elements can also be deleted automatically, upon the condition that the 

latter are not referenced anywhere else in the 3D model. 

When the command is called for the selected 3D element(s), there are two possible scenarios.  

If the selected element(s) has neither dependents nor parent elements not referenced anywhere else 

otherwise, then the deletion will be instant and without any prompts. If the above condition doesn't hold, 

then, once the command is called, the Element Deletion dialog window will appear. 

 

In the left-hand side of the dialog window, you will be able to select one of the possible options of the 

command's function: 

 Delete Selected Elements and all related Elements. If this option is chosen, then the selected elements 

will be deleted together with all their dependents. 
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To have the unreferenced parent elements (if any) deleted too, you shall set the flag Delete 

unused Parent Elements. If there are workplanes among such elements, those will be deleted 

together with their respective pages. 

If some of the selected or dependent 2D objects are named, then an additional flag Don't 

Delete Named 2D Elements will be available. With this flag set, the found named 2D objects 

will be excluded from the deletion list. 

When you delete layout elements (schematic images of 3D fragments on the assembly 

workplanes) the flag Delete 3D fragment when deleting its projection becomes available. You 

can delete 3D fragment that is linked with the deleted layout element. 

When you delete 3D fragment, which has a layout, the flag Delete all projections of 3D 

fragment becomes available. It allows to delete all its schematic images from all workplanes. 

 Delete only selected elements modifying type of related elements. This option is available only when 

selecting 2D elements (for example, graphic lines on a workplane), which have dependent 2D objects. 

As a result of choosing this option, only the selected 3D elements will be deleted. As for the children 

of the deleted elements, the system finds an alternative definition for them. 

 For example, when LCS linked with a 3D fragment is deleted, the fragment 

will stay in 3D scene and its position will be fixed. All other links between child and other 

elements will be broken. 

 In some cases, geometry or elements of deleted fragments can be left in the 

scene. For example, if extrusion was created using external profile from the fragment 

document, the profile and the extrusion will be left in the assembly after fragment deletion. 

 Another example: when two elements are connected using LCS-connector, 

the connector will be left in assembly after one of the elements deletion. 

 Workplanes, nodes and LCS-s remain in a document if their parent element 

was deleted. Their location is kept according to all transformations. If such object is created 

using several other objects, and one of the objects is deleted, the link with all other parent 

objects will break too. 

The only exclusion are 2D nodes that define workplane borders. The workplane can’t 

break links with them. 

 Exclude selected elements from Model Tree (by reassigning the references of dependent elements to 

other elements). When this method is used, the system attempts to switch the references of the 

dependent elements to other model objects. When an operation is deleted, the references of its 

dependent 3D elements are reassigned to the operation that stands before the deleted one in the 3D 

model tree. This option is available only in the case when the deleted 3D element has both a parent 

operation and a dependent 3D element. 

The list of the elements to be deleted is displayed in the right-hand side of the dialog window. The elements 

are sorted by types and are placed into the appropriate folders. To view the information on the elements 

selected for deletion, you can click the [Info…] button. 
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If the option Only show this dialog when the Shift key is down is flagged, then the “Element Deletion” 

dialog will not be displayed upon subsequent calls to the command. To have it display when the command 

is called, you will have to additionally hold <Shift>. The command will be working in this way until the user 

changes this setting or until the end of the current T-FLEX CAD work session. 

“Delete Body” Command 
When a Body is selected (which can be done in the 3D model tree) then instead of the Delete command 

the context menu will provide the command Delete Body. This command will delete from the 3D model 

all the operations which are part of this Body's creation history. Besides that, the command allows to delete 

the parent elements used in this Body's operations. 

After calling the Delete Body command, the following dialog window is displayed. 

 

You need to select one of the following actions regarding the deletion of auxiliary elements: 

 Delete only unused parent construction elements. As the Body is deleted, so are the 

construction entities and workplanes, together with their pages, if those are not referenced 

by other elements. 

 Delete All Parent Elements. The selected Body is deleted together with all elements used in 

the body's operations (construction entities, variables, etc.), which are not referenced by the 

model's other Bodies. 

 Don't delete parent elements. Only the operations that form the selected Body will be 

deleted. 

The flag Only show this dialog when the Shift key is down has the function similar to the same-name flag 

of the 3D element deletion command. 

 

“Purge” Command 
The command Edit > Purge serves to delete all 2D or 3D construction elements that were used neither for 

creating graphic lines of the 2D drawing nor for operations. 
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After calling the command, the “Purge” dialog window is displayed. In it, you can set the following flags: 

 Delete Unused 3D Construction. All unused 3D construction elements will be deleted. 'Unused' are 

considered the 3D construction elements that are not referenced by a single operation. 

 Delete Unused 2D Construction. All unused 2D construction elements will be deleted, which are those 

not involved in creating 2D graphic lines, hatches, dimensions and other drawing elements. The named 

2D constructions, that is the 2D construction elements assigned individual names are not deleted by 

default. To have them deleted, you would need to turn on an additional flag Delete Unused Named 

2D Elements. 

 Delete Unused Invisible Variables. All invisible system variables (do not confuse with the “Hidden” 

document variables displayed in the variable editor) that are not used in the model will be deleted. 

 Delete Unused Pages. All empty pages in the current document will be deleted. The unused 2D pages 

also include the pages of workplanes created automatically by the Draw On Face command if the user 

didn't use them to create anything. Such pages are deleted together with the projections of source 

faces which were automatically created on those pages.  

 Delete Unused 3D IDentifiers. As the unused 3D IDs are deleted, the 3D model size gets reduced. As 

a result, the undo stack of the UN: Undo Changes command also gets cleared. 

When 2D elements are deleted on a page of a 2D drawing or on the active workplane, the following 

additional flags are available in the command's dialog: 

 Delete Unused Named 2D Elements. When this flag is set and the unused 2D constructions are deleted, 

the named 2D construction elements will be deleted too. In addition, this flag allows deleting the 

workplanes created on faces, if the projections on those workplanes include named graphic lines.  

 Current Page Only. When this flag is set, the unused 2D constructions will be deleted only on the 

current page of the 2D drawing or on the active workplane. 

Source Geometry Editing Command 

This command allows to quickly select for editing the geometrical elements used for creating the selected 

3D element. The list includes the 2D objects (hatches, 2D paths, 2D nodes, etc.), which were used for 
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creating the selected 3D element and its parent elements. If a 3D element, for example, a 3D profile, was 

created based on a set of graphic lines on a workplane, then the “geometry” list also includes the workplane 

itself. 

 

When you select a 2D element in the list of the source geometry, the appropriate drawing page opens and 

the mode of drawing on the workplane activates; at the same time, the editing command for the selected 

element is launched. Therefore, this command can be conveniently used to quickly go to the page of the 

source workplane of a given 3D object.  

Command Edit Profile is available in context menu of operations, created from 3D profiles (for example 

extrusion and rotation), and workplanes, on which 3D profiles were created. The command activates the 

workplane on which the source 3D profile is located.  

Handling the Drawing Elements while Editing 

When modifying a 3D model, one may often have to deal with drawing elements, since those may be used 

as references for constructing base 3D model elements (3D profiles, 3D paths, 3D nodes, etc.). The user 

may proceed with the same editing techniques for 2D elements as one uses when working with a 

conventional drawing. To modify the shape of a 3D element constructed on the basis of 2D elements, you 

need to appropriately redefine the source 2D elements. Some of them, for example, hatches directly related 

with 3D profiles, cannot be deleted and built anew, unless the entire model tree branch is to be deleted 

together with the children of that hatch. In order to redefine such hatches, one should use the function of 
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editing hatch contours. Otherwise, the model's structural integrity can be broken. If a 3D profile was created 

based on a set of graphic lines on a workplane, then those lines can be freely modified, including deletion 

and subsequent new creation. When the session of drawing on the active workplane is over or when the 

system undergoes the next calculation, the 3D profile will be rebuilt according to the modifications to the 

graphic lines.  

 

If a certain 2D construction element needs to be modified but cannot be deleted, then you can rebuild it 

by using another creation method for it in the editing command. The option to rebuild 2D construction 

elements is available in the automenu of the construction lines editing command. 

 

Sometimes it is helpful to use the command RL: Replace Element. It allows to transfer all relations with 

parents and children from one 2D construction element to another one, and then delete the original 

element. In this case, the other construction element may use a different construction method and maintain 

its own relations or dependent elements. 

 

Avoiding Recursion 

When creating long chains of element dependencies, the user may run into an attempt of creating a 

recursive dependency, that is, a dependency of a certain element on itself. In most cases, the system 

automatically checks the created relations and does not allow saving the changes that cause a recursion. 

Yet in isolated cases a recursion may occur. Such dependences are seen most of the times in complex 

chains of relations like "3D elements  2D elements  3D  2D and so on". One danger of the situation 

for the user is that the one may save the file with a recursion and not be able to undo the erroneous actions 

when opening this file later. In such a case, it won't be possible to normally work with the file in which the 

system detects a recursion, up until it is rectified.  

 

In such a situation, the elements shall be edited in a special way. As was already mentioned, upon an 

attempt to make any changes, the system will run a check for invalid relations in the modified chain of 

dependent elements. If such invalid relations are found, the system will disallow the changes. This creates 

certain complications for the user in one's attempts to delete or edit elements.  
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The user's goal shall be detecting a recursive relation and breaking the chain of dependences at any 

suitable point, all in one editing step. It is often enough to change the definition method of a certain 

element in the recursive chain. This could be either a 2D or a 3D element. You can redefine the element by 

changing its definition method - for example, define its position in absolute coordinates or relate it with 

some other independent elements.  

Such elements can be identified with the help of the diagnostics window - the names of the elements are 

indicated in the recursion warning line. Next, you need to investigate the dependencies between the 

elements - you can call the “Info” window for that purpose. After identifying the causes of the recursion, 

one can proceed to editing. Once corrections are made, run the model recalculation to check and make 

sure there are no new warnings. 

Techniques of Simplifying the Model Structure and its Display in the 3D 

Window 

T-FLEX CAD system provides means for speeding up primary work processes - this is achieved by freeing 

additional computer resources when some secondary processes and model details are temporarily 

dropped. 

1. Display simplification: 

 the use of the wireframe display mode in most cases helps the system faster recalculate the 

objects in the scene and speeds up the scene spinning and object selection; 
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 The image quality deterioration affects the display of 3D objects in the scene. The objects 

appear coarser but are drawn faster. The image quality can be controlled in the ST: Specify 

parameters of document command, on the “3D” tab; 

 The 3D model display simplification settings help when spinning the 3D scene densely 

populated with model elements. Those are system settings that are defined in the command 

SO: Set System Options, on the tab “3D”. To call the setup dialog, click the button [Graphics 

Settings]. For details, please refer to the “Customizing System” chapter of the 2D manual; 

 

 Any element in the 3D scene can be made invisible. Reducing the number of elements in the 

scene helps speed up the display. An element can be hidden by means of changing the level 

settings, the layer, or by using the Hide command in the drop-down “Visibility” submenu of 

the context menu of the element right-selected with . 

2. Element Suppression. By suppressing individual operations, the user not just hides them from the 

3D scene, but also excludes them from the regeneration process. This also helps reduce the total 

model regeneration time. An operation can be suppressed by calling the “Suppress” command 

from the context menu or by setting the element suppression in the parameters dialog window 

on the “General” tab. 

3. Set of options to assist in handling a large assembly model. These options are provided in the 

command ST: Set Document Parameters, on the tab Large Assembly Management. For details, 

please refer to the “Auxiliary Tools for 3D Assemblies Modeling” chapter of this manual.
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ASSIGNING "TRANSFORMATIONS" TO 3D ENTITIES 

The command serves for translating, rotating, scaling and mirroring operations and 3D constructions. 

Transformation parameters are recorded in the properties of 3D elements. Moreover, properties of 

operation (or the element of 3D construction) can contain simultaneously several transformations that are 

executed successively one after another. It is also possible to form a group of objects and create common 

transformations for them.  

To define transformation parameters of 3D elements, use the command “3EG: Transform Element”. 

However, a transformation can be specified directly in the parameters of specific elements as well. 

Most common examples that involve transformations are assemblies of 3D fragments, the exploding mode 

and mates. 

In T-FLEX CAD there are several types of transformations: 

 Translation. This type of transformation allows us to specify translation with respect to the coordinate 

axes Х,Y,Z or in one of three coordinate planes along two axes simultaneously. 

 Rotation around axis. This type of transformation allows us to specify rotation with respect to any 

coordinate axis. Transformation is specified with a value of the rotation angle. 

 Scaling. This type of transformation allows us to change the size of the object with respect to the 

coordinate system or the point of scaling. The transformation is specified by the value of the scale. 

 Symmetry.  This type of transformation allows us to create the object symmetrically with respect to the 

selected plane. One of the planes of the coordinate system is used by default.  

For transformations of operations and construction elements the 

Global coordinate system and the coordinate system at the center of 

parallelepiped encompassing the selected object can serve as an initial 

coordinate system. Direction of the axes of the coordinate system 

associated with the parallelepiped coincides with that of the Global 

coordinate system. 

For operations and construction elements the local coordinate 

system can be selected with respect to which the transformation will 

be performed.  

 

 <L> Select LCS for current transformation 

For transformations of fragments as an initial coordinate system we 

can use the default snapping (Global coordinate system), one of the 

external LCS of the fragment or the fragment’s LCS created during the 

fragment insertion (snapping by fragment). 

To select the target coordinate system of the transformation we use 

the option:  
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In case when it was not possible right away to orient LCS in a desired way, the functions of additional 

coordinate system specification can be employed. These functions allow us to quickly rotate the 

constructed LCS around its axes by 90°( , , ), perform cyclic turning of the axes of the coordinate 

system around the origin (when pressing  the axes change their places). 

The target coordinate system can be defined in the process of specification of transformation. To do so, it 

is possible to use the option of selection of geometric snapping points for the center of the coordinate 

system of the element: 

 <N> Select point 

Directions of the axes in this case will be coincident with the global LCS. 

In order to cancel all data that define the coordinate system at the present moment, the option of the 

automenu can be used: 

 <C> 
Cancel coordinate system for the current 

transformation 

For selection of the source coordinate system of the transformation we can use the option: 

 

 

After opening the new window at the beginning in addition to the standard options the following options 

are present in the automenu: 

 <1> Select 3D node or vertex as LCS origin 

 <2> Select point that sets direction of the X-axis  

 <3> Select point that sets direction of the Y-axis  

 <C> Reset target LCS 

 <A> Rotate LCS around the X-axis by 90° 

 <O> Rotate LCS around the Y-axis by 90° 

 <Z> Rotate LCS around the Z-axis by 90° 

 <9> Change LCS axes orientation  

 

Selection of the  option returns the user to the assembly and activates the mode of the target LCS 

specification. 

 <T> Select or create target LCS  

 <S> Select or create source LCS 
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WORKING WITH COMMAND  

There are several ways to launch the Transformation command. 

Firstly, the command can be called through the text menu of the program. 

To invoke the 3EG: Transformation command we use: 

Icon Ribbon 

 

Assembly → Additional → Move/Rotate 

Keyboard Textual Menu 

<3EG> Tools > Move/Rotate 

The Transformation command can also be invoked through the context menu of object. 

 

After entering into the command, it is required to select 3D element for which the transformation will be 

specified. To do so, we use the option: 

 <1> Select objects for transformation 

 <2> Select object for individual transformation  

Upon selection of  it is possible to simultaneously select several objects for transformation. When  

is selected it is possible to select only one object for transformation. 

After selection of operation, construction element or fragment the program enters into the mode of 

specification of transformation for the selected object. 

The properties window changes its view. 
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The Transformations section of the properties window can be used for 

control, correction of numeric values, creation and removal of 

transformations. In the special field the list of all transformations 

specified for the object at the present moment is displayed. Each 

transformation is marked with a special symbol that signifies its type 

(translation or rotation). If the value of transformation is specified with 

a constant, then the value of the constant is displayed next to the 

symbol.   

Below the main list of transformations there is a field for entry and editing of values. 

To input the values of transformation, we can also use the special field on the system toolbar. 

 

Graphics buttons are located to the right of the list of 

transformations. The  button is used for addition of new 

transformation. When it is pressed the list of possible 

transformations appears from which the desired type is offered for 

selection. The list of possible transformations can also be invoked 

with the help of the context menu when pressing  in the 

«Transformations» window. 

After selection of the type in the list of transformations a new line 

will appear. In the values entry field the value of transformation can 

be entered. The transformations’ values can be specified both as 

numbers and with the help of variables and expressions. 

 

To save a transformation, press [Enter]. In addition, for specification of the value we can go to 3D window 

and use the dragger which moves according to the selected transformation type. At the moment of 

transformation creation its value will be displayed in the special field of the system toolbar: 

 translation along one axis 

 

 translation along several axes 

 

 rotation 
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In the Main transformations section it is possible to create 

groups of transformations. Each group has its name. Below the 

list of transformation groups there is the Suppress flag. With the 

help of this parameter the transformation group can be 

temporarily excluded from the calculation. Next to the flag there 

is a field for entry of values. It is possible to use numeric values, 

real variables or expressions as a value for the given parameter. 

If the value different from 0 is entered into this field, the 

transformation group becomes suppressed. 

 

Graphics buttons are located to the right of the list of transformation groups. The buttons are accessible 

only if one object is selected. 

With the help of the  button it is possible to add a new group of transformations. 

When pressing the  button the last transformation group in the list is removed. 

The  button allows us to remove all transformations groups. 

When pressing the   buttons the order of execution of transformation groups changes. 

Note that when changing the order of execution of transformations (including groups of 

transformations) the final result changes. 

The 3D Assemblies. Creation of 3D models-assemblies chapter describes the use of transformation 

groups in more detail. 

The option of scaling is invoked with the help of the icon on the automenu toolbar: 

 <М> Scaling 

Scaling selected objects can be carried out in several ways. 

The first method implies the use of the encompassing parallelepiped that bounds the domain around the 

selected object in 3D window.  

When pressing  on one of the vertices of encompassing parallelepiped the axis (direction) along which 

the scaling of the object will be carried out is highlighted. After that the value of the scale can be specified 

in the special field of the system toolbar. 
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Several successive transformations of the scale are automatically summed up. 

The second method implies the use of the Scaling tab in the properties window. 

Scaling can be common (all values by all axes will be identical) and with different numeric values along the 

axes X, Y, Z. 

The value of the common scale can be specified with the help of the Uniform scale flag  

 

To specify different numeric values for each direction there is the entry field next to the axes. 

 

To cancel the result of scaling we can use the option on the automenu toolbar: 

 <J> Remove scaling 

Scaling cannot be suppressed. 

To create the symmetry of the selected object it is required to select the symmetry plane. To do so, we can 

use the option: 

 <P> Select mirror plane  

Planar faces, workplanes, 3D profiles and edges can serve as element with respect to which the symmetry 

will be applied. 

To move element along or around the defined axis, use options: 

 <O> Rotate around arbitrary axis 
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 <B> Move along arbitrary axis  

 

Children of the transformed objects can’t be selected. This prevents recursion in the model. 

 

Manipulator that specifies transformation appears after axis selection. You can specify transformation value 

in special field on the system toolbar. 

 

To create transformations it is possible to use geometric attachments. The Transformations command 

works with the following nodes: vertices, edges, faces, 3D paths, profiles, 3D nodes and LCS. 

For example, let us suppose that in the existing 3D layout it is required to change location of the object (1) 

by aligning it with object (2). 

Let us invoke the «Transformations» command via the context or text menu. We select the chair, object 

(1) for transformation. After that on the dragger we select the X-axis along which the translation will be 

carried out. Next, with the help of the cursor on the object (2) we select the midpoint of the edge to which 

the X-coordinate of the chair being moved will be «snapped». When pressing  object (1) will move to a 

new location. 
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In the «Transformations» tab a new recording will appear. 

 

If you need to transform an adaptive fragment you should enable the option Don’t use transformation 

for geometric parameters. 

 

It is recommended to use the option if the geometry of the adaptive fragment does not depend on the 

adaptive parameters, but changes on their bases.  

Group transformations 

In the Transformation command it is possible to create transformations for several objects simultaneously.  

Only the objects independent from each other can participate in the group transformation. Objects are 

considered independent if they are not connected with each other geometrically (i.e., they are not 

descendants of each other). 
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The selected objects are displayed in the «Objects» tab in the properties window. 

  

To make selection of objects for transformation more convenient the command includes the following hot-

key combinations: 

  − selection of object, ungrouping previous groups; 

 +<Shift> − addition of object to the group; 

 +<Ctrl> − if the object is absent in the group add it to the group; if the object is already in the group 

delete it from the group. 

Group transformation can be performed either in «common» coordinate system or in individual coordinate 

system of each member of the group.  

After selection of objects for transformation the mode of specification of transformations in «common» 

coordinate system is enabled by default. 

 <G> 
Mode of setting transformations for selected 

objects in general coordinate system 

For a group transformation on the Objects tab and in the 3D window domain the object in the coordinate 

system of which the transformation is performed is highlighted with green color. All other members of the 

group are highlighted with yellow color.  
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If the mode of specification of transformations for selected objects in the «common» coordinate system is 

disabled the group transformation is transferred to the individual coordinate systems of each member of 

the group. The Global coordinate system or LCS of the fragment will serve as individual coordinate system 

for fragments. The Global coordinate system or the coordinate system at the center of the parallelepiped 

encompassing the selected object will be the individual coordinate system for operations and construction 

elements. 

When selecting one object or a group of objects the command is launched in the mode of not allowing 

addition of new objects. When destroying the group, each object of the group is assigned the local 

transformation from the group transformation. 

Group transformations can be used in the most efficient way in the mode of disassembly. More detailed 

information on using group transformations in the disassembly mode can be found in the 3D Assemblies 

Creation – Additional tools for working with 3D models-assemblies chapter. 

Using draggers 

To specify parameters of transformation in 3D window the draggers can be used. A dragger constitutes an 

image of the coordinate system. 

To change parameters of transformation with the help of a dragger, it is required to place the cursor over 

the dragger and move it to a new place. 3D element will also change its position together with a dragger.  

Various parts of dragger are the active elements used for specifying transformations: 
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 the dragger axes are intended for defining translations; 

 the dragger arcs are used for defining rotations; 

 images of the planes are designed for translation in the planes XY, XZ, YZ; 

 the dragger center is used for manual entry into the mode of dynamic snapping. 

Upon bringing the cursor to different active parts of the dragger the cursor changes its appearance 

prompting the user to specify the corresponding types of additional transformations. Next to cursor a 

tooltip will appear providing information about the type of offered transformation. The selected element 

of the dragger is highlighted with a different color. When a user points at the axis he can start to specify 

translation along the selected axis. 

Upon pointing at the arc, the system prompts the user to specify rotation in the corresponding plane. In 

addition, the axis of the dragger closest to the cursor is also selected so that a user could define a rotation 

by directing the selected axis towards a specific element of the model.  

When pointing at the image of the coordinate plane the user can start defining the shift in the selected 

plane. 

When selecting one of the dragger’s elements mentioned above the following commands become 

available in the context menu: 

 for translation along the axis; 

 for translation in the plane; 

 for rotation about three axes; 

 for translation along three axes. 

To specify transformation with the help of the dragger the user has to choose an active element of the 

dragger by pressing the mouse. 

Draggers are described in more detail in the “3D Assemblies. Creation of 3D models-assemblies” 

chapter.
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GRAPHS 

There is a special object type in the T-FLEX CAD system - the “Graph”. A graph is a function based on a set 

of points in its own two-dimensional coordinate system, connected by a polyline or by a smooth curve. 

This versatile instrument serves to define dependencies of different nature, for example, to specify a 

variable load in Analysis modules, or to create a parametric dependency based on an array of numbers 

from a database. Graphs are also used to store and display results of a dynamic motion analysis. Graphs 

can be used in the variables editor to read the values that they define. It is also possible to graphically 

define the laws of scaling or twisting in the “Sweep” operation, properties of an offset 3D path to define 

the offset distance, the variable radius value in the “Blend” operation. 

Graphs are created and stored in the document together with the drawing and the 3D model. The system 

provides a specialized editor to create and edit graphs. It serves to manage arrays of points and their 

coordinates, supports multiple point selection as well as clipboard handling (copy/paste), undo/redo 

actions, axial zoom control, points dragging etc. 

 



Three-dimensional modeling 

1254 

CREATING AND EDITING GRAPHS  

Graphs Manager 

Working with graphs is done via a special dialog window - the “Graphs” manager, which displays the list 

of all graphs in the current document, and the buttons to start all required commands. The list of graphs 

is accessed via the command: 

Icon Ribbon 

 

Parameters → Tools → Graphs 

Keyboard Textual Menu 

<PL> Parameters > Graphs 

After calling the command, the Graphs window appears  

 

To create a new graph, use the button [Create Graph…]. When creating a new graph, you are prompted 

to select the connection type of the graph nodes: by a spline (a smooth curve) or by a polyline. A newly 

created graph is empty. It is assigned its own name – “Graph_1”, “Graph_2” etc. If desired, the user can 

modify the graph name using the button [Rename] or in its properties (see below). 

The buttons [Delete] and [Delete All] serve to delete existing graphs from the current document. 

Graph Properties 

A dialog with descriptive and defining graph properties can be accessed by clicking the [Properties…] 

button in the graphs manager window. 
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The graph name and type are displayed in the upper part. You can edit the graph name. The graph type is 

defined at creation and is not changed later. 

You can define the following graph properties in the Units parameters group:  

 The labels for the graph's coordinate axes – in the fields Argument Axis Title and Function 

Axis Title; 

 The Function/Argument Scale Factor parameter defines the units scale along one axis 

relative to another one when plotting the graph. It is used to setup the image when individual 

axis scales need to be used. The graph editor can set this value automatically (see below); 
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 The Minimal Argument Step parameter determines the minimum allowed distance between 

two neighboring nodes of the graph in the X-direction.  

The Current Limits group of parameters displays the information regarding the current graph 

bounds. You can also deliberately impose graph limits by the argument and by the function. When 

limits are enabled, the system will not allow creating points out of the limit bounds. By default, 

limits are not imposed. 

The Boundary Conditions group of parameters defines the conditions for the ends of the graph line. 

Such parameters can be used only for the “smooth curve” graph type. You can define the tangent 

of the curve direction slope at the graph start and end. You can also set equalities of first and 

second derivatives at the graph start and end. Such boundary condition allows obtaining a smooth 

transition between copies when having a master graph segment repeated cyclically. 

The Read Only Mode flag prohibits modifying properties and coordinates of graph points.  

The Show Nodes flag enables the display of function nodes on the graph. 

The Show Limits flag turns on graphic rendering of the range-of-definition bounds and the values 

range (actual) for the given graph. Graph bounds are displayed as a dotted frame. 

The Return Closest Fuctions Value for Arguments out of Graph Limits flag serves to use the graph 

for any argument values, including those outside the existing defining range. This parameter is used 

to work with the function graph(“GRAPH NAME”, ARGUMENT VALUE) of the variables editor. 

The flag Logarithmic Argument Scale sets the logarithmic scale along the argument axis of the 

graph. 

The Auto Repeat group of parameters defines a cyclic repeating of a master graph segment in both 

directions. When repeating in the positive direction, then each copy of the master segment is 

attached by its start point at the end point of the graph, and vice versa when in the negative 

direction. 

Graph Editor 

Graphs are edited in a special graph editor. The editor is called by selecting the desired graph in the 

“Graphs” window and clicking the [Edit…] button, or by double-clicking on the graph's row. To 

simultaneously edit several graphs, select them into graphs manager using <Shift> and use the [Edit…] 

button as well. All graphs will be simultaneously displayed in the editor. At the same time, one of them will 

be active and editable. To switch between graphs, use the interface control (the drop-down list) with graph 

names. 
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The main portion of the editor window is occupied by the workspace, in which graphs are displayed. The 

workspace is ruled for convenience with an automatically scalable coordinate grid. Image moving 

(panning) and scaling (zooming) is done by the mouse wheel – in the same way as when drawing in T-FLEX 

CAD. 

The coordinate rulers are displayed along the borders of the workspace. You can use these rulers in the 

same way as in the T-FLEX CAD drawing window – to pan and zoom the image. The graph editor allows 

separate zooming along the coordinate axes. Separate zooming is done using a ruler, when the appropriate 

mode is enabled in the graph properties, or by the  icon on the editor's “View” toolbar. A specified ratio 

of coordinate axes units is automatically stored in the graph properties.  

Clicking  in the workspace creates a new graph point. All points are connected by a line (curve) of the 

specified type (a polyline or a spline). For user convenience, the current cursor position coordinates are 

displayed in the status bar in the lower-right corner of the graph editor. 

At the right of the workspace there is the table of graph point coordinates. Point coordinates can be edited 

directly in this table. You can start editing coordinates after double-clicking   in the desired table cell. 

To input changes, press <Enter> or switch the input focus to another window. The edited (selected) graph 

point is highlighted. To select several points, use the keys <Shift> or <Ctrl>. 
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A graph point position can be modified with the cursor, by “grabbing” the 

point with  and dragging it to the new position. When double-clicking   

on a graph point, a special dialog appears to edit point coordinates. Here you 

can enter the absolute point coordinates (when switched to position) or set 

offset coordinates with respect to the current point position (when switched 

to offset). If, when double-clicking  , several points were preselected (for 

example, in the table of coordinates), then only the offsets can be used. This is 

convenient, if you need to “move” a segment of the graph by a certain distance 

(see an example below).  

  

Graph Editing Tools 
The graph editor has three bars with various tools and icons to launch utility commands. 

The “Standard” toolbar  contains: 

 Commands to close the graph editor with or without saving changes: 

 
- Save changes and close 

 
- Cancel changes and close 

 A drop-down list to select the name of the graph being edited is 

used when several graphs are edited simultaneously. 
 

 The command to save the edited graph in the external file: 

 
<Ctrl><S> Save to File 
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 The “Download from file” command that allows us to replace the graph being edited with 

another graph from the external file “*.tflaw”. As a result of execution of this command all 

source points are removed, and the basic properties are replaced with other properties: 

 
<Ctrl><L> Download from file 

The “Edit” toolbar  contains: 

 An icon to call the edited graph properties dialog: 

 
- Graph Properties 

 A drop-down list (combo box) to define the colors of the graph line: 

 
- Graph Color 

 Commands to work with the clipboard: 

 <Ctrl><A> Select all nodes 

 <Ctrl><C> Copy 

 <Ctrl><X> Cut 

 <Ctrl><V> Paste 

To copy graph points to the clipboard, you first need to select points in the table of coordinates 

or in the workspace. Next, you can use the command “Copy” or “Cut”. When copying graph 

points, the system must remember the reference point for future snapping when pasting from 

the clipboard.  

To define the point, the Copy… dialog window appears. The user can define the 

coordinates of the reference point or select it on the graph. To select a point in 

the workspace, you need to enable the option Show on Graph and click [OK]. 

Next, the system goes into the mode of waiting for point selection. The 

respective help message appears at the bottom of the graph editor in the status 

bar line. The user can point at any location in the workspace or select any of the 

existing graph points. If the user did not specify a reference point, the system 

will use the origin instead.   
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When adding the copied points from the clipboard to the graph, the system will 

prompt for defining the target point to snap the insertion to. The Insert Nodes 

dialog window will appear. In it you can also define the coordinates of the 

insertion target point or enable the mode of selecting such point in the 

workspace. If the user did not define the reference point at the time of copying, 

then, when defining the coordinates for the insertion, the user will thus define 

the offsets of the new graph points from the original position. When specifying 

the target point, the preview image of new graph points rubberbands with the 

cursor.  

 Commands to work with graph nodes: 

 <Ctrl><N> Add new Node by Coordinates 

 <Ctrl><E> Edit Node Coordinates 

 <Del> Delete Selected Nodes 

 <Ctrl><Shift><Del> Delete All Nodes 

 Commands to undo unwanted actions and redo undone actions: 

 <Alt><BackSpace> Undo 

 <Ctrl><BackSpace> Redo 

 Options to enable the modes of selecting nodes and object snapping: 

 - Mark / Select nodes 

 - Snap to Nearest Point 

 - Snap to Nearest Node 

 <Ctrl> Move Nodes by Coordinate Axes 

The “View” toolbar  contains: 

 The command to refresh the image: 

 <F7> Update Window 

 Commands to zoom in and out the image: 

 <Ctrl><Shift><PgUp> Zoom In 

 <Ctrl><Shift><PgDown> Zoom Out 

 The command to automatically fit the entire image within the workspace window bounds: 
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 <Ctrl><Shift><End> Zoom All 

 Commands to pan (move) the image: 

 <Ctrl><Shift><Left> Left 

 <Ctrl><Shift><Right> Right 

 <Ctrl><Shift><Down> Down 

 <Ctrl><Shift><Up> Up 

 The button to enable the mode of separate zooming by axes: 

 - Zoom separately by axes 

 The command to enable/disable the mode when a special vertical marker is displayed that 

reads the argument position and returns the respective function value. This command is 

duplicated with a special switch flag in the graph editor options (see below): 

 - Argument Marker 

 An icon to call the graph editor options dialog (see options description below): 

 
- Options 

 

The drop down list, which pops up upon pressing the symbol  to the 

right of the button, allows the user to customize the view of the graph 

editor window (display of the toolbars, rulers, grid, etc.). 

 

Setting Up the Graph Editor 

The dialog contains interface controls to set up the graph editor appearance. 
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The Show group of options contains the switches to enable/disable auxiliary utility objects – the 

ruler, the automatically scalable coordinate grid, coordinate axes, the argument marker.  

The pane in the Current View group of options displays the coordinates of the displayed area for the 

user reference. 

The flag Independent Zoom by Axes controls the mode of independent scaling along the axes. If it 

is turned on, then upon scaling with the help of the ruler the visual scale factor along the X-axis 

changes independently of the scale along the Y-axis. 

The flag Logarithmic Scale by Argument Axes is a reference flag and is always unavailable for 

editing. This flag shows what argument scale is set in the properties of the graph being edited. 

In the right part of the dialog there is a group of controls to set up the colors of various objects in the 

graph editor. 

With the help of the parameter Ruler font size you can also define the font size for the graph editor ruler. 

USING GRAPHS  

As was mentioned in the beginning of the chapter, graphs can be used in various areas of the system. In 

this topic we will review specific examples of using graphs. 

Using Graphs in 3D Operations 

Graphs can be used for a more intuitive way of defining tabular dependencies in some 3D modeling 

commands. For example, in the “Blend Edge” command – to define the law of changing a variable radius, 

or in the “Sweep” operation – to define the law of changing the twist angle or scaling of the contour. It can 



Graphs 

1263 

be used wherever you need to define the law of changing some operation's parameter over a certain range, 

whose length is defined in percent (0%-100%).  

To define a dependency by a graph, use the special “Graph” button  in the 

operation properties window, next to the field for defining the entries of 

tabular dependencies. Upon clicking the button, the graph editor opens, in 

which there is already a graph constructed based on the input data. (By 

default, those are the point positions 0% and 100% with the respective 

parameters.) The graph type in this case is always a smooth curve.  

 

Depending on the operation type, we can distribute various properties using a graph. The definition range 

and the graph values range are also limited depending on the operation type. The range of values allowed 

for input in the X-axis is always from 0 to 100. This defies the position of each point. In the Y-axis we reckon 

the operation parameter values for each point. For example, for a variable round blend, one can define the 

law of the radius distribution along the span of the selected edges. In this case, the system will not allow 

setting the function value less than zero, since this is restricted in the blend operation. 
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To save the results of editing a graph, exit the editor by clicking the button . After closing the editor, 

the system will transfer all graph points to the properties window to display the dependencies in the tabular 

form. 

Using Graphs in the Motion Analysis, in the Variables Editor 

Graphs are used on several occasions in the «Dynamic motion” module: 

1. To display the results of a dynamic calculation – to record the changing in time coordinates, 

forces, moments etc. 

2. To define variables for loads, springs. 

A prepared graph can be used in the variables editor for further calculations, by reading its function value 

in the variables editor using the expression graph(“graph name”, argument value). 

Note that this chapter brings only the examples of using a graph in the dynamic motion calculations. 

For detailed information on the dynamic motion analysis refer to the respective chapter of the 

documentation. 

As an example of a varying load, which can be defined using a graph, consider a motor (the “Torque” load), 

which turns on and off at a certain time instant. The graph for such load may look as follows: 

 

Sometimes, one may need to define nonlinear properties in spring, for example, to account for an imperfect 

spring. At the extreme compression, when its coils contact each other, the rigidity increases manifold. One 

can also account for the spring destruction instant at a certain deformation level value (the spring 

elongation). At that instant, the spring resistance disappears. We shall clarify here, that the “destruction” 

of such spring in the model will be reversible, that is, when the model returns to a state with the spring 

elongation within the normal range, then the spring will automatically restore. The graph for such spring 

will define the dependency of the bipolar force on elongation and may look as follows: 
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Let's review the use of graphs to record results of a motion analysis and using the function graph(“GRAPH 

NAME”, ARGUMENT VALUE) on an example of solving a typical problem of finding and maintaining an 

equilibrium of a moving body. For the example, we will create a simplified model of the “Waterslide” 

attraction.  

Problem conditions. There is a spatial descending and trajectory (a 3D path). A body shall move strictly 

along this path under the gravity force. The problem is formulated as to design such a surface, along which 

the body could slide and follow the prescribed path. To simplify the example, we will use a ball as the 

moving body and neglect the friction force. Let's also skip some details of the design in the example 

description, which are not related to working with graphs. 

The file with this example is located in library “Examples/3D Modeling/Graph/Waterslide.grb”. 

  

To solve this problem, you need to have the dynamic motion module installed. 
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The solution to this problem is obtained in several steps: 

 The ball shall be made moving under the gravity force along the specified path (as if on a rail). At 

the same time, it is necessary to remember the extra G-forces acting on the ball. We will create the 

first motion analysis study for this purpose. We can collect all necessary data in the way of graphs. 

 Adjusting the results of the motion analysis, creating variables, reading graphs. 

 Constructing the ball path.  

 Constructing the surface. 

 Verifying the result. Creating the second motion analysis study. 

Step 1. To create a dynamic motion study, we will need to create one “Coincident” mate, which will bind 

the ball (the center of gravity) to the trajectory (the 3D path). To read the results, we will need two sensors. 

To record the changing in time reaction force (the extra G's) we will need a joint sensor (joins are created 

automatically based on mates). To record the coordinates of the ball position, we will need a “point” sensor 

(at the ball's center of gravity). As the result of the motion analysis, we will record in the way of graphs the 

following values: 

 the graph “Х, Point of Rotation_0 Body” - records the X-coordinate of the ball position Х; 

 the graph “Y, Point of Rotation_0 Body” - records the Y-coordinate of the ball position; 

 the graph “Z, Point of Rotation_0 Body” - records the Z-coordinate of the ball position; 

 the graph “RF_Joint_0” - records the magnitude (vector length) of the reaction force in 

the joint_0; 

 the graph “RFX_Joint_0” - records the X-component of the reaction force in the joint_0; 

 the graph “RFY_Joint_0” - records the Y-component of the reaction force in the joint_0; 

 the graph “RFZ_Joint_0” - records the Z-component of the reaction force in the joint_0. 
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Step 2. Create several variables to read the values from graphs in the variables editor. The function 

graph() will be used in the expressions. The {a} variable will be used as the time counter. All events of 

interest occur in the time period from 0.008 to 1.4 seconds with the step of 1/125. The variables are 

recorded as shown on the following figure. The function graph()can read values from graphs using the 

time counter {a}. 
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Step 3. By using the variables {XX}, {YY}, {ZZ} we can re-create the ball's center of gravity position at any 

time instant by varying the {a} variable.  

The tools that we use (a 3D path with the parametrically changing 3D node, a parametric sweep), 

can only use an integer counter and vary it with the step equal to 1. Therefore, the variable {a} will 

be varied with the help of another counter {t}. 

The variables {fx}, {fy}, {fz} will be assigned the coordinates of the reaction 

force unit vector, therefore those can be used to define the direction of the 

extra G-force action. Let's create a 3D node and enter these variables instead 

of the coordinates. Additionally, we need to account for the ball radius, 

therefore we introduce a correction to the coordinates as 5*(fx,fy,fz). This 

node will be changing its position along with the varying variable {t} 

Next, based on the new 3D node, construct a parametric 3D path by varying 

the counter {t} in the range from 1 to 175 (at the same time, the time counter 

{a} will sequentially read all values from graphs). This new path (3D path_1) 

renders the line of contact between the ball and the surface which we need 

to construct. It will also be needed to correctly position the “movable” profile 

for the prospective surface. 
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Step 4. To construct the surface using the “By Parameters” operation, we need a “movable” profile. We can 

bind it to our “movable” 3D node by creating in it a local coordinate system (LCS). To define the direction 

of one of the LCS axes, we will create an offset 3D node in the force vector direction (by defining the 

coordinates (fx,fy,fz) relative to the source 3D node). The second LCS axis will be set tangent to the 3D 

path_2. By having a “movable” profile, we can create a parametric sweep by varying the {t}-counter 

operation parameter in the range from 1 to 175.  

Step 5. Result verification. Create a new motion analysis study and release the ball on the created surface; 

it will exactly follow the claimed path, meaning that the created surface fully satisfies the problem 

requirements. 
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3D ANNOTATIONS 

T-FLEX CAD allows creating drawing detailing elements (dimensions, leader notes, roughnesses) directly 

on faces of a 3D model. 

 

GENERAL INFORMATION  

The capability of creating 3D annotations allows instantly introducing in the 3D model not only 

geometrical, but also technological process and other information that can later be used when creating 

drawings by projections, as well as in other applications, for example, in the process design modules or 

when creating CNC control sequences.  

For example, if a dimension between faces or a dimension on a cylindrical face (radius or diameter) uses a 

tolerance or additional text lines, then, when creating the dimension in the drawing you select the 

respective lines on a projection - this information is automatically passed on to the dimension on the 2D 

projection. The same happens when creating a roughness symbol on a face – if you create a roughness 

symbol on the respective lines of the 2D projection image, then the roughness parameters will be copied 

from the 3D model. 

 

Data transfer from 3D dimensions to a 2D projection can be done also by a direct “projection” (mapping) 

of dimensions from the 3D space onto the 2D projection. In this case, the system automatically determines, 

which of the existing 3D model dimensions can be “transferred” to the current 2D projection. The user just 

needs to select, which out to the system-offered dimensions one would like to put on this 2D projection. 

This functionality is described in detail in the chapter “2D Projections. Creating Drawings from 3D Models” 

(see the section “Creating Drawing Detailing Elements on 2D Projections”). 
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3D dimensions can be used to manage dimensions of the 3D model. When creating various 3D operations, 

the systems allows for an automatic creation of “driving” 3D dimensions. A driving dimension is directly 

related with the operation that created it, or, more precisely, with its geometrical parameter. As soon as its 

nominal value is modified in the command Parameters > Dimensions > Set Value, the respective 

parameter of the dimension-producing operation will change. 

You need to select opposite body faces when specifying dimension. 

 

The driving 3D dimensions can also be created by the user manually. To do this manual dimension creation, 

select the faces, whose positions are determined by the operation's geometrical parameter. For example, 

you can use the opposite faces of a body created by extruding, or a cylindrical face created by blending. 

By using such dimensions, you can also modify the operation parameters and, therefore, the entire 3D 

model. 

2D dimensions can also be used to modify an operation's parameter values, which are created between 

the lines of 2D projections that correspond to the body faces driven by that operation's geometrical 

parameter. The system finds this corespondence automatically. 

Besides that, the system can in some cases automatically find correspondences between various 3D 

dimensions, which are not the control dimensions (the ones not related with the operation parameters), 

and 2D constructions used for the body creation, on whose faces those dimensions are based. This also 

allows managing the 3D model by modifying the nominal values of such 3D dimensions. When the nominal 

value of such a dimension is modified, the system will attempt to automatically find the 2D constructions, 

which shall be modified in order to accommodate for the new nominal value of the given 3D dimension. 

For example, if a 3D dimension is created between two side faces of a 3D profile extrusion operation, then 

the system is able in a number of cases to restore the constructions train: 3D profile  Profile contour on 

the workplane  2D constructions that determined the 3D profile contour. In this case, as soon as the 

dimension nominal value is modified, the system will adjust the corresponding 2D constructions, the 3D 

profile based on them and the body itself, which resulted from the extrusion operation. 

A 3D dimension nominal value is modified, just like that of a 2D dimension, by the command PE: Set 

Dimension Values. Note that this command does not work on 3D dimensions in the transparent mode. It 

can be accessed, however, from any 3D dimension's context menu (on right-clicking it ). 

3D annotations can be hidden or displayed in each particular window using the new command SN: Hide 

3D Annotations: 
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Icon Ribbon 

 

 

Keyboard Textual Menu 

<SN> View > Hide 3D Annotations 

 

CREATING 3D  ANNOTATIONS  

3D annotations can be created as follows: 

 In the 3D window, using the common commands for creating dimensions, leader notes and roughness 

symbols (D: Create Dimension, IN: Create Leader Note, RO: Create Roughness Symbol); 

 As 2D detailing elements on workplanes and their consequent display in the 3D window. 

Creating 3D Annotations in the 3D Window 

Creating 3D Dimensions in 3D Window 
To create a 3D dimension, call the command “D: Create Dimension” while in the 3D window. 

3D dimension can be drawn: 

 Between two planes. When choosing two planar faces, a linear dimension is drawn (for parallel planes) 

or an angular dimension - (for nonparallel planes); 

 Between a plane and a line. A linear dimension is drawn if a line is parallel to a plane, and a radial 

one – otherwise; 

 Between a plane and a point. A linear dimension is drawn between a given plane and a point; 

 Between two lines. A linear dimension is drawn if the lines are parallel to each other, and a radial one 

– otherwise; 

 Between a line and a point. A linear dimension is drawn between a given line and a point; 

 Between two points. A linear dimension is drawn between selected points (vertices); 

 On a single rotation surface. A radial/diametrical dimension is drawn for selected face. 
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The planes are specified by selecting a planar face or a planar curvilinear edge, the rotation surfaces – by 

selecting a face of revolution lying on the given surface. The lines are specified by selecting straight edges 

or the axes of the rotation surfaces. The axis of the rotation surface is specified by selecting the 

corresponding face of revolution. The points are specified by selecting vertices of the 3D model solid 

bodies and 3D nodes. 

When creating 3D dimensions, the elements are selected with the help of the following auto menu options: 

 <L> Select Flat Face or Flat Edge 

 <C> Select Cylinder, sphere or torus 

 <A> Select Axis 

 <N> Select Vertex 

By default, in the 3D window the user can select planar faces, faces of rotation surfaces, edges and vertices 

of solid bodies without turning to the corresponding auto menu options. 

If upon creating a 3D dimension, the user selects first the edge-circle/circular arc, or the face of revolution 

of type cylinder, sphere, torus, then the system will automatically start creating a radial/diametrical 

dimension. In other cases, the system will wait for selection of the second object (face, edge, vertex) for 

creating a linear or angular dimension. 

For selecting the axis of the rotation surface (cylinder, sphere, torus) as the first object for creating a 

linear/angular dimension, it is necessary to use the option  when choosing the face of revolution. The 

same option is used for selecting a planar edge-circle (circular arc) as the first object of the linear/angular 

3D dimension. 

A dimension being created may lie in various planes. The initial position of the dimension being created is 

automatically determined by the system based on the 3D view. You can then modify the 3D dimension 

plane by the option: 

 <H> Change 3D Dimension Orientation  

 <T> Select Plane of Orientation 

The option  allows one to cyclically switch between various dimension positions. 

The option  is used for direct selection of the plane, to which the dimension being created has to be  

parallel. After turning on the option, in the 3D window the user has to select a face, to the plane of which 

a 3D dimension has to be parallel. 

When creating 3D dimensions, several standard options for setting dimension parameters are also 

available: 

 <Z> 
Change leader line jog orientation (only for linear 

dimension) 
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 <Space> Place Dimensions in absolute coordinates 

 <J> Center Dimension Text 

 <Z> 
Change Dimension Orientation (only for angular 

dimension) 

/  <M> 
Change Dimension type (only for radial/diametrical 

dimensions) 

 <D> 
Click to toggle radius/diameter mode (only for 

radial/diametrical dimensions) 

 <R> 
Click to toggle radius/diameter mode (only for 

radial/diametrical dimensions) 

 <K> 
Break (kill) relations (only for linear and 

radial/diametrical dimensions) 

Creating 3D Leader Note and 3D Roughness in 3D Window 
To create a 3D leader note or 3D roughness, you need, while in the 3D window, to call the command 

IN: Create Leader Note or RO: Create Roughness Symbol. When creating a leader note/roughness, you 

select the face, on which the element being created shall be placed. The face can be of any type. The snap 

point of the leader note or roughness is the point on the selected face where the cursor was positioned at 

the time of selecting the face. For a leader note, you need to additionally specify its shelf position in the 

space.  

Other than that, creating 3D dimensions, 3D leader notes and 3D roughness symbols is same as creating 

the respective 2D elements. 

Creating 3D Annotations by 2D Detailing Elements on a Workplane 

To create 3D annotations by 2D elements on a workplane, you need to first create the respective 2D 

dimensions, leader notes, roughness symbols on the page of the workplane. To display them in the 3D 

window, you just need to enable the flag “Show 2D Annotations on 3D View” in the workplane parameters 

dialog box. 
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For working convenience, this option is also available in the context menu of the plane (“Show Dimensions 

in 3D”). 

Such dimensions can be used for modifying the display parameters on the workplane page and, 

respectively, the 3D elements created based on it (profiles, operations etc.). 

AUTOMATIC CREATION OF 3D  D IMENSIONS  

Automatic creation of driving 3D dimensions, that is the 3D dimensions related with the geometrical 

parameters of 3D operations, is made either directly when creating the operation, or from the context 

menu of an already existing operation. 

When creating a 3D operations, you just need to enable the flag Create Driving Dimensions in the 

operation's properties dialog (the Options section). The driving 3D dimension will appear in the 3D window 

once this operation creation is completed. 

If an operation was already created, call the context menu (by right-clicking ) and select the Create 

Driving Dimensions command in it. This will also result in creating a 3D dimension that controls the 

geometrical parameter of the given operation. If several operations are selected, then you can still access 

the control 3D dimension creation command in the context menu. This command is also available in the 

Body's context menu. In the latter case, the control 3D dimensions will be created in all operations used 

for creating the Body, wherever possible. 
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MATERIALS 

A material is a T-FLEX CAD element. It contains a list of characteristics of a real material with which we deal 

in reality. A material is used as a parameter for all 3D operations, and, additionally, by a special command 

of applying material to individual faces. 

 

Material characteristics can be roughly divided into two types. Characteristics of the first type affect the 

appearance of three-dimensional objects in the 3D window, and, additionally, define the parameters of a 

material as part of generating a photorealistic image in the POV-Ray system. Characteristics of the second 

type are various physical-mechanical parameters of a material, such as density, elasticity coefficient, etc. 

Those parameters are taken into the account when calculating mass-inertia properties, as well as 

conducting structural computations in the analysis module. Besides that, materials are accounted for when 

creating hatches on sections of 3D models. You can define parameters of such hatch for a particular 

material. 

GENERAL INFORMATION  

For each model we can associate a set of materials that were assigned to Bodies, operations or individual 

faces. These materials are called the materials of the current model. Material – is a 3D element containing 

a set of characteristics of the real material with which we are dealing in reality. The element “material” has 

parameters such as density, reflection power, absorbing capacity, etc.  

For any Body of the model it is possible to specify the basic material and cover material. 

The basic material is used for calculation of mass-inertial characteristics and engineering analysis, and also 

for displaying the Body in 3D scene in the visualization mode “Shading with materials” (if the additional 

material of the cover is not specified). 

The cover material – is an additional material for defining parameters of the model display in the 3D 

window. It allows us to specify the material different from the basic one to be used for visualization 



Materials 

1277 

purposes, creating the effect of the Body “painting”. At the same time for engineering calculations the 

basic material will still be used. 

 

The material can be applied on individual faces of the body. When the face’s geometry is changed as a 

result of further transformations of the model the material that was applied onto the face is retained. When 

applying the material on individual faces, the body itself does not change its own material. You can apply 

material on individual faces only when the flag Apply as coating material is enabled. 

Materials used in the current model are displayed in the tree of the 3D model, in the operations properties 

dialogs, and in the dialog of the 3MТ: Edit materials command. 

M A T E R I A L S  I N  T R E E  O F  3D  M O D E L   

Materials used in the current model are displayed in the tree of a 3D model in the special folder – Materials. 

 

Different icons are used in 3D model tree to identify coating and basic materials.  
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The icon  is used to identify coating material. The icon  is used to identify basic material.  

If the material is applied to any body in scene, the icon  appears to the left of the materials name. If you 

press this icon, the list of objects to which the material is applied will appear. Icon do not appear near not 

applied materials.  

It is possible to edit material properties or delete the material from the current model using 3D model tree. 

The commands for deleting and editing the material properties are available in the context menu of the 

3D model tree.  

 

Note that upon deletion of the applied material, the system will also prompt you to delete the 

operations to which the given material was applied. 
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If necessary, the user can create the new materials directly in the tree of the 3D model by activating the 

command of the context menu Create Material. After that the material properties dialog appears on the 

screen.  

        

 

SERVICE WINDOW “MATERIALS”  

Special service window – Materials is used to work with materials. It is available even if there is no open 

document.  

To display this window, the following commands can be used: 

 

Keyboard Text menu Icon 

<Alt+8> 
Customize > Tool Windows > Materials 

Window  

<3MT> Tools > Materials 
 

This command can also be invoked by pressing  in the domain of automenu or of any toolbar. 
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The Materials window is divided into three parts: current model materials, material libraries and preview. 

 

The current model materials are displayed in the upper part of the window. By default, the list contains 

one element – “Steel”. 

 

Material libraries are displayed in the middle part of the window. All opened libraries are listed here. There 

are three libraries that are opened by the default: Metals, Non-metals and Coatings. 

 

Preview window is displayed in the lower part. 

 

On the top of Materials window there is a special toolbar. It is used to work with materials and material 

libraries. 
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Materials Toolbar Options 

To view/edit the material’s properties it is required to select the material (in the list of materials of the 

current model or in the library) and press the button  in the upper part of the window or press . If 

the window is “fixed”, a separate dialog window of parameters of the selected material will appear. 

 

 

 

When the Materials window is in “floating” mode, the dialog of parameters of the selected material will 

appear in the right part of the “Materials” window itself. The dialog of parameters can be hidden by 

pressing  again. 
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The same dialog window can be invoked from parameters of any 3D operation or Body with the 

help of the  button. This button is located on the «Common» tab.  
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The option «Create material»  allows you to create a new material. Material is created either in the 

current model or in the library, according to the currently selected part of the window. 

The «Create color-based material» option  allows us to create the cover material based on color. After 

activation, the dialog for selection from the colors catalog appears. 
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After selection of the color the new material is assigned the same name as the selected color (for example, 

“RAL 1000”). After confirming color selection, in the current window of the materials library or of the model 

the cover material is created with the corresponding name and properties. 

The flag Apply as coating material is automatically set for a created coating material.  
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To navigate across the material libraries you can use search toolbar. With its help, the material can be 

found by the name or by part of the name. 

 

 

For searching, you need to enter the name of material 

or part of its name into the text field or select the 

material from the drop-down list, if it already exists in 

the search field. After pressing <Enter> or  the focus 

of the model tree will be placed on the desired material. 

Repeated pressing of <Enter> or  initializes the 

transition to the next search result in the library. The 

entered name of the material if it does not yet exist 

must be added to the list in the text field.  

The search among materials of the model is not carried 

out. 

The remaining icons in the upper part of the Materials 

window are designed for working with the materials 

libraries.  

The  option allows us to create the new user-defined library of materials. The library is highlighted 

with green color , if it is located in system readonly folder. If library is located in any non-system folder 

and can be edited, it is highlighted with yellow icon . 

The option “open library”  serves for opening already existing materials library. After activation, you 

need to specify a path to the library file. 

The option “Save changes in libraries”  allows us to save the changes introduced into the 

materials library.  

More information about working with libraries of materials can be read below. 

Materials of the Current Model 

The list of the current models materials provides quick access to the most frequently used materials without 

searching through the libraries. It contains all materials that were used in the current document.  

To identify coating materials icon  is used. To identify basic materials icon  is used. To identify 

materials that were applied previously but not in use, there is icon . 

The following actions can be executed with the list of materials of the current model: 
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 Edit materials (The “Properties” option in the context menu); 

 Add information about material into report and BOMs (The “Add to reports/Bills of materials” option 

in the context menu); 

 Add new materials (the Create Material option in the context menu); 

 Remove materials from the model (the Delete option in the context menu); 

 Copy materials from the library to the list of materials of the model, from one T-FLEX CAD document 

to another (the Copy, Insert options in the context menu): 

 Enable/disable preview option. 

 

 

Materials libraries  

The list of material libraries is an archive with basic and coating materials that are most frequently used in 

design. These materials are sorted by categories. There are three libraries that are opened by the default: 

Metals, Non-metals and Coatings. They are identified by  icons. 

 

Materials from these libraries can’t be changed inside the libraries. For this purpose, they should be 

moved into Current model materials window or into created library. 

 

The obsolete libraries of previous T-FLEX CAD versions are also available and can be opened if necessary. 

For various operations with libraries and materials you can use commands from right button context menu 

of “Materials” window or materials toolbar. 
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Material Libraries Creation 
You can create your own libraries with customized set of materials. 

For this purpose, use option  on the materials toolbar or item “Create Library” in context menu. The 

user-created library is identified by icon . The newly created library appears in the list of available libraries 

and has the default name "New Library". 

 

Material can be created only in custom library open for editing. You cannot create material in system 

read-only folders identified with  icons. 

The newly created library is not saved by default. In order to make the library available in future, use option 

 on the materials toolbar or item “Save as…” from the context menu. You can rename library and set 

new folder location before saving. Files in T-FLEX CAD are saved in .mtr format. 

File in .mtr format can be opened in any text editor. 
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To open a library use option  at the materials toolbar or item “Open Library” from the context menu. 

All material libraries are located in folder “Program\MaterialLibrary” by default. The path is displayed 

when you put the cursor on the library name. 

 

In a case, when changes in library were not saved before closing, system will offer you to save these 

changes.  

 

 

Catalogs of Materials Creation 
For convenience, you can combine materials within the separate catalogs for each group of materials.  
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To create a new catalog you need to select 

library, in which it will be created, press  and 

select item “Create catalog” from the context 

menu. Created category will be called “New 

Catalog”. You can rename catalog directly after 

creation or rename it later using item “Rename” 

from the context menu. 

Created category can be deleted using item 

“Delete” from the context menu. 

 

To copy all materials from a catalog to the list of 

materials of the current model, use command 

“Copy to Document” from the context menu or 

drag the category manually.  

Within one library, you can create any number of catalogs. In each 

catalog, you can create additional folders with materials (sub-

catalogs). 

The catalog can be copied and transferred to another library or 

catalog. 
 

Materials Creation and Applying  

To create a material in the new libraries and catalogs, use command New Material or options  and  

on the materials toolbar. 

 

To apply a material to objects in the scene, you can use item Apply to model from the context menu or 

"drag&drop" method. 
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If there are several bodies in the scene, the following dialog window appears: 

 

If you press OK or if there is just one body in scene, the following window appears: 

 

Add to Report/Bill of materials allows to add information about material into reports and bills of materials. 

In case, when changes in one or several materials from library were not saved before closing, system will 

offer you to save these changes.  

To move materials within a library or from one library to another or between catalogs and lists of materials 

of the current model you can also use "drag&drop".  The individual materials can be copied, using the 

context menu commands Copy and Paste. 

If the material or catalog is copied to a material library or catalog that already contains an element 

with the same name, the copied item will be automatically renamed and numbered with (1), (2) and 

so on suffix. 

Preview 

The preview window allows to estimate material visually, without applying it to the objects in the scene. 

The mode is activated by item Preview from the context menu. 

 

Selected material can be displayed on the cubic or spherical surface. To switch between these modes click 

 on the picture. 
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CHANGE MATERIAL USING VARIABLES  

Variable can be used to assign material names. For that purpose you should use existing or create a new 

text variable using command: V:Edit Variables. 
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In the expression field, you should enter 

or copy from the library the name of the 

material that will be used for the model. 

 

In order to generate a list of several 

items you need to use the [Edit...] button. 

In the window "Value List for Variable" 

you need to specify all materials that can 

be used for this model. It is important 

that the names of materials must match 

similar names in the library. 

 

After creation of the variable you need 

to enter the properties of the body, and 

set the name of the created variable in 

the field "Expression". Thus you can set 

main material and coating material. 

 

 

After completing these steps, you can change the material of one or more bodies with the drop-down list 

in the variables window. 

 

To display the new material in the scene, you need to update the 3D model using the option . 
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MATERIAL ’S PROPERTIES DIALOG  

The material’s properties dialog contains all physical-mechanical properties of the material, displays 

parameters of the material in 3D scene and on projections, and parameters for creation of photorealistic 

image (see the «Photorealistic view» chapter). 

To call properties dialog window you need to select material (in the current model materials list or in the 

library) and perform one of the following actions: 

-  press  icon on the materials toolbar 

-  press   on the material name 

-  select item Properties from the context menu. 

«View» Tab 

This dialog combines parameters controlling characteristics of color, reflection, transparency and material’s 

light emission. 
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The image of the material on this tab is available in two versions: in the form of a sphere with a hollow or 

in the form of a cube, for a more complete display of the visual characteristics of the material. 

Name. In this field, material name can be edited. 

 Description.. This field displays the name of folder containing material. 

For the model material this field can be edited so you may enter your own description. 

When copying material to a library, description will be named by folder name where it is placed. 

«Colors» Group 

 

This group combines parameters defining characteristics of material’s color. To specify the color for one of 

the parameters, it is required to click into the color rectangle and use the standard mechanism for color 

selection. 

Main. This parameter controls the color of the material lighted up by direct light. This is a base color 

of the material. 

Ambient. This parameter controls the color of the material lighted up by dispersive light. It 

significantly affects the color of the material’s surface since at the given moment of time only a 

small portion of object is subject to the action of direct light. 

Reflecting (blink). This parameter controls the color of blinks that appear on the surface of object. 

The brighter the color, the more intensive the blink is. 

Light Emission. This parameter controls the intensity of the light radiated by the material. If the 

material does not radiate the light, the black color is specified. 

«Effects» Group 

 

This group of parameters allows us to customize the following optical characteristics of materials: 

Shininess. This parameter controls the power of reflection of light sources on object’s surface. It is 

specified as a single number that can range between 0 (minimum) and 1 (maximum). Large values 

create the appearance of smoother and shinier material whereas the decrease in their values 

imitates dull surfaces. 
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Transparency. This parameter controls the value of transparency of the object’s surface. It changes 

between 0 (nontransparent surface) and 1 (totally transparent surface). 

Reflection. This parameter controls the value of the specular reflection of the material. It is specified 

as a number in the range between 0 (reflections of surrounding objects will not be shown on the 

material’s surface) and 1(entire reflectivity of the material is provided). 

Index of refraction. This parameter characterizes the deflection of light rays as they pass through the 

transparent material. Using the index of refraction you can set the value of this parameter for a 

transparent material. This option is taken into account when generating photorealistic images. 

If the «Apply as cover’s material» parameter is enabled, the 

material is applied as a cover’s material and not as the basic 

material. 
 

«Texture» Tab 

This tab combines parameters that control the material’s texture specification. Texture – is an image that 

is stored in the file and helps us to display special features of material’s surface coloring. 

File. File of the image containing the picture of the 

texture. To specify the texture, the files of the formats 

bmp, gif, jpg, jpeg, tga, tif, tiff and png can be used. 

The work with texture files is realized according to 

the general algorithm of working with references to 

external files (similar to fragments, pictures, files of 

databases by reference etc.). This means that: 

Texture files can be located in the same folder as 

the model’s file that uses this texture; 

Color texture and relief texture can be specified by 

different files; 

2. Texture files can be moved with the “Move 

assembly” command similar to other types of files; 

3. Texture files can be included into the file of the 

model that uses the texture (embedded textures); 

4. To specify the path to the texture file the library’s 

name can be used; 

5. To specify the path to the texture file, the relative 

paths that includes the folders names or transition 

to the upper level (..\) can be used. 

 

When you choose texture file folder “Program\Textures” is opened by default. 
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«Texture transformation» group 
This group of parameters serves for customizing the appearance of the texture, translation of the texture, 

changing its scale and for rotation. 

 

Shift X. This parameter defines the shift of the texture’s start point along the horizontal axis. 

Shift Y. This parameter defines the shift of the texture’s start point along the vertical axis. 

Scale S. Texture’s scale along the horizontal axis. The scale’s value can be negative. If, for example, 

we specify the value «−100», the texture will be symmetrically reflected with respect to the 

horizontal axis. 

Scale Т. Texture’s scale along the vertical axis. The scale’s value can be negative. 

Rotation. Texture’s rotation angle. The texture is rotated around the center located in the plane 

perpendicular to the direction of texture’s projection. The coordinates of the rotation center in the 

plane are specified by the parameters «Center S» and «Center T». 

«Relief texture» group 
This parameter group is responsible for creating the visual relief of surface material. The essence of the 

feature is that by adding shadows and highlights we get effect of the surface material relief. 

There are three main ways for creating effect of relief surface corresponding to texture type: 

 

 

Normal Map. This texture like bump map allows to simulate bumps and roughness of the surface. This 

texture more accurately renders surface relief compared to bump map texture. It is set by default. 

 

 Bump Map. This texture allows you to create the illuminated and shaded areas to simulate 

simple bumpy surfaces, flat protrusions or dents. 
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 Parallax Map. If you use this texture surface relief becomes three-

dimensional and looks differently from various angles. 

 

 

File. File of the image containing the picture of the texture’s relief. To specify the texture it is possible 

to use the files of bmp, gif, jpg, jpeg, tga, tif, tiff and png formats. 

 «Hatch» tab 

When creating sections and cut views in the «3J: Create 2D projection» command there is a capability of 

automatic hatching of the section. Hatching used in the section is defined with the following parameters: 

Type. Hatching type. 

Size. Distance between the neighboring hatching 

lines. 

Rotation angle. Angle of rotation of hatching lines. 

When selecting the hatching, the tilt angle of 0 

degrees signifies the hatching with horizontal lines  

Line thickness. . Parameter allows to specify the 

thickness of lines.  
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«Physical properties» tab 

In the window of this dialog, you can specify physical-

mechanical properties of the material. These 

parameters are used in calculation of mass-inertial 

characteristics and also when performing structural 

calculations in the analysis module. 

In the upper part of this window, the physical-

mechanical properties can be specified. In the lower 

part of the window, the units of measurement can be 

selected.  

When changing the parameters of the units of 

measurement, the values of physical-mechanical 

properties are recalculated automatically. 

You can specify the physical-mechanical properties 

with variables. 

For the material that is already used it the model, you 

can specify properties using graphs. Special icon 

appears near each of the properties. 

 

 

«POV-Ray» tab 

In the window of this dialog, you can specify 

parameters that are used upon creation of 

photorealistic view (see the Photorealistic view 

chapter). 

In POV-Ray tab, a large number of characteristics 

of surfaces and inner space of bodies are used for 

description of the 3D scene. All materials from the 

materials libraries supplied with the system 

already have the POV substitutions (libraries from 

POV-Ray, for example, textures.inc, are used in 

them). 

In the Material POV window, the following 

parameters can be specified: 

Include files. The field of the given 

parameter shows the files in which 

available characteristics for the specified 

material are stored.  



Materials 

1299 

“Texture” group 
Properties of the body surfaces are specified in this group. 

Description. Name of texture that is specified in one of the included files is displayed in this field. Here you 

can specify custom properties if you know POV-Ray programming language. 

Scale. Defines way of displaying for the specified texture, when applied to a body. 

Don’t scale. The specified texture will repeat without scale changes. 

By default. The texture will be stretched on the whole surface. 

Use minimum/maximum size. The scale will be maintained by the minimum/maximum size of 

surface to which the texture is applied. 

Apply to: 

Bodies. The texture display will look more real. Most of all it refers to wood textures. In this case, 

slice of the wood fibers will be displayed on one of the body’s faces. 

Individual faces. All body faces will have similar texture display. 

“Interior” group 
Interior properties are specified in this group: index of reflection, light dispersion in volume, etc. 

Parameters Description and Scale are similar to the parameters above. 

Allow rotation. If this parameter is set, texture, applied to the interior space of a body will be rotated 

together with the body. 

APPLYING MATERIAL ON INDIVIDUAL FACE (FACES )  

The command 3AM: Apply Material allows applying a certain material on one or several model's faces. 

The applied material will be maintained through the future model modifications despite changes in the 

face’s geometry. The command  does not change the model geometry, but it is displayed in the model 

tree, standing as an independent operation. 

The command is convenient for accurate texture positioning using different applying laws and in situations, 

when you need to dye only selected faces.  

The command 3AM: Apply Material is called via: 

Icon Ribbon 

 

3D Model → Modify → Apply Material 

Keyboard Textual Menu 

<3AM> Operation > Apply Material 

You can apply material using “drag’n’drop”. In this case “Apply Material” operation is automatically created. 
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Upon entering the command, the automenu provides options that allow selecting of body faces. The 

following option is automatically enabled: 

 <F> Select Face 
 

You select faces using this option. At the same time, you can only 

select the faces belonging to a single operation body. The 

selected faces are entered in the “Faces” list in the command's 

properties window. 

Using the Material Application parameter, you can specify on 

what faces the material will be applied: the Selected Faces or the 

All Except Selected Faces. 

If you plan to assign the same material to several faces of 

one body, it is recommended to select all of them within 

one material application operation. This will help avoiding 

the unnecessary complications to the model structure. 

 

To select all faces of the operation body, you can use the option: 

 <O> Select Operation 

When using this option the material is applied to all faces of the selected operation body. 

To select a material to apply, you can use field Material in the properties window. Material of the current 

model can be selected from the drop-down list. To open properties window use  button. 

 

To call the operation parameters use option: 

 <P> Set entity parameters 

To cancel selection of all faces, use the option: 

 <K> Cancel selection of all faces 
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In the command's properties window, additional parameters of the 

texture mapping can be specified: 

The Mapping mode group allows us to select the material 

mapping mode and the scale of the texture along different 

axes. In the drop-down list of mapping modes the following 

options are available: 

 

 From material – all parameters are taken from the 

properties of the material. 

 

 Plane – mapping is carried out as if the texture is projected along the normal to the plane on 

which the texture is located, i.e., on the XY-plane of the manipulator.  

 Sphere — mapping is carried out as if the texture is located on a segment of the sphere. This 

option is convenient for mapping textures on spherical and close to spherical surfaces. 

Parameters of the sphere determine the scale of the texture of the material and are controlled 

by the manipulator. 

 Cylinder – similar to the sphere but the type of the surface is different. 

 Box – it is assumed that the textures are mapped on the faces of a parallelepiped and are 

projected from these faces. For this mapping mode, additional scale along the third coordinate 

is used. The scales thus define the dimensions of the «template surface». 

 By surface coordinates – this mapping is useful for curvilinear surfaces. For this mapping mode, 

the texture coordinates are associated with internal coordinates of the surface. It can be 

considered as a generalization of the texture mapping on a sphere or a cylinder. The texture is 

always displayed on the surface in a unique way, therefore, the manipulators are not used. 
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To control the mapping of a texture and its accurate positioning, the intuitively clear manipulators 

are used. The view of a manipulator depends on the selected mode of material mapping. All parts 

of the manipulator are functional. For each element of the manipulator there is the context menu 

with various fixings and commands. 

More information about manipulators can be found in the chapter 3D Assemblies Creation. 

 The Texture transformations group allows us to specify for the texture the mapping parameters 

that are different from those specified in the properties of the material itself. The Without 

properties of material flag determines the source for the parameters of the mapping. By default 

it is disabled and the mapping parameters are taken from the properties of the material. When 



Materials 

1303 

the flag is enabled, the user can specify new values of the parameters (Direction S, Direction T 

and so on.) 

Example of Applying Image to a Face  

An image of a wristwatch dial will be applied to the face of a watch body as an example of using “Apply 

Material” command. 

 

First, you need to create the coating material. Color texture of the material will be specified by image file. 

In this case coating material named “Clock-face” was created. The image file “Clock-face.jpg” used as the 

color texture. It is located in the folder: “…\Examples\3D modeling\Apply material” 
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The example is located in library “Examples\3D modeling\Apply Material\Watch.grb”. 

In order to apply the material "Clock-face" on the selected face of the watch base you should: 

 Open the file with watch body on which the material will be applied; 

 Add Clock-face material to the list of materials of the current model. 

 

 Activate command 3AM: Apply Material ; 

 Select required watch face with the help of option Select face ; 

 Select “Clock-face” from drop-down list in Material Application window  
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 Select plane in mapping mode drop-down list. 

 

 Specify positioning of material on the face with the help of special manipulators in the 3D scene 

and the Texture Transformation group in properties window. 
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 Press .to finish input. 

 

 

USAGE OF DRAG ’N ’DROP AND “COPY/PASTE”  COMMANDS TO APPLY 

MATERIALS  

You can edit body, operation and face materials not only from the clipboard with the help of Copy and 

Paste commands, but also using drag’n’drop: moving the selected material and “dropping” it to a face or 

a body . 

If there are several program instances running on the computer, you can apply materials from one instance 

to the model of the other instance using drag’n’drop. T-FLEX CAD can use materials from datasets of T-

FLEX DOCs application running on the same computer including integration mode. 

Copying into clipboard is performed using option Copy from the context menu. In Materials window 

materials from the list of the current model material and from the libraries list are copied using item Copy 

from context menu or by pressing <Ctrl>+<C>. The Copy to Document command (<Ctrl>+<D>) copies 

material from the library to the list of the current model material and to the clipboard simultaneously. 

When you copy material to the clipboard, name of the material is available for pasting into any text editor. 

The material from the clipboard will be applied to the selected objects: bodies and faces, when you use 

command Paste. If there are no objects selected, a dialog window appears. In this window, you can choose 

applying of the material to all bodies in the scene. If you refuse, the material will be placed in the list of the 

current model materials. 

The system checks existence of coating materials applied to body faces when you use Copy/Paste 

commands or drag’n’drop to apply the material to the operation. If any coating material is already applied 

to one or several faces, the following dialog window appears: 
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If you press “Yes”, all previously applied coating materials will be deleted. If you press “No”, the material 

will be applied only to faces without applied material. Button Cancel cancel applying of the coating 

material. 

The coating material can be applied to faces and bodies, even if all filters are disabled.The appropreate 

filters become active when you work with the coating materials. For convenience, you can disable one of 

them. 

 

The basic material is always applied to the whole body. 

When you use drag’n’drop T-FLEX CAD helps you to select object for material applying. For this purpose 

selected objects are highlighted with red and tooltips appear near the mouse cursor. In addition, the 

material preview window appears in the scene. 

 

When you use drag’n’drop, system shows the last operation, which was applied to the body.
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LIGHT SOURCES 

A light source is an element serving for rendering three-dimensional objects and helping controlling the 

lighting of the three-dimensional scene. Light sources are snapped to 3D nodes. Their directions are also 

defined by 3D nodes. There are three types of light sources - point, directional and projector. 

Spot light source emits the light from one point in all directions over the whole 3D scene. 

Directional light source emits the light in a certain direction over the whole 3D scene. 

Projector light source emits a light cone from a given point in a certain direction with the specified drop-

off rate. 

A light source is displayed as a small “radiant” sphere.  

 

3D window rendering uses simplified lighting calculations: the lightness (and, respectively, the color) of the 

surface depends only on the angle of the incident light to the surface. The effects of shadowing, reflecting, 

refracting and scattering of light are not present. To create more realistic scene rendering, use the 

command 3VY: View Ray Tracing (see the chapter Ray tracing). 

A light source can be hidden from display while maintaining the lighting effect. By default, lighting of the 

3D scene also involves a light source (one or multiple) on the camera, oriented along the viewing direction. 

The parameters of those light sources are set by the command 3VP: Set View Parameters (see the chapter 

Working with the 3D View Window). 

One scene allows creation of an arbitrary number of light sources. However, the number of light sources 

affecting the resulting rendering of the 3D window depends on the type of a video card installed on the 

computer. 

Lately, the number of light sources handled by video cards varies from 8 to 16. 

 

CREATING L IGHT SOURCE  

To create a light source, use the command 3L: Create Light Source. The command is called by one of the 

following ways:  
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Icon Ribbon 

 

View → 3D Model → Light source 

Keyboard Textual Menu 

<3L> Construct > Light source 

After calling the command, the following options will appear in the automenu, along with the general 

system options: 

 <1> Select position of Light Source 

 <2> Select direction of Light Source 

 <L> Point Light Source 

 <D> Directional Light Source 

 <S> Projector 

To define a light source, you need to use a special manipulator.  

User may also select a 3D node or point of an object in the scene to define position for the light source. 

For this purpose activate the option . 

 

Use the option  to define the direction of light propagation for the directional light source  or 

projector . You should select a 3D node or point of an object in the scene to define the direction. 

 

The initial color of the light source is white. 

Point Light Source 

Point light source has no direction of light propagation. You should specify only position of the light source 

for its creation. 

You should call the following option for the point light source creation: 

 <L> Point Light Source 

 

 
Diagram of light propagation from a spot source  
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Directional Light Source 

To create a directional light source call the option: 

 <D> Directional Light Source 

You should specify a position of the light source and direction of the light propagation for a directional 

light source creation. Then press . 

 
Diagram of light propagation from directional source  

Projector 

Select the following option for the projector creation: 

 <S> Projector 

You should specify a position of the light source and direction of the light propagation for a projector 

creation. Then press . 

 

 
Diagram of propagation of light 

from projector 

 

The drawings with sample constructions of all types of light sources can be found in the library 

“Examples” located in the folder: “Additional resources/Light sources”. 

L IGHT SOURCE PARAMETERS  

To define parameters of a light source, bring up the dialog box. This is done by the option: 

 <P> Set entity parameters 
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Type. This parameter indicates the type of the light source (spot, 

directional, projector). It is defined automatically during the 

construction. 

Intensity. Defines the intensity of the light source. The higher the 

light intensity, the more it affects the image in the 3D window, and 

the higher is lightness of the resulting image.Drop off rate. Defines 

the projector's drop-off angle. 

Cut off rate. This rate defines the smoothness of transition from 

light to dark across the boundary of the projector's light spot. The 

diagram on the right clearly shows the effect of this parameter with 

the values 0 and 1 respectively. 

 

 

The “Visibility” group of parameters is common across the system functionalities and define the modes of 

displaying a light source on the screen: 

Color. The color of the light source. The light source is drawn in this color in the 3D window, and also emits 

light in this color. 

Show Image in 3D View. Checking this parameter makes visible the image of a light source existing in the 

3D scene. If the parameter is cleared, the light source will be hidden, but the lighting effect remain. To 

select, or modify properties of, a light source made invisible in the 3D window, use the model tree. 

Show on Fragment. If a model is used as a 3D fragment, then the light source with this parameter set will 

be exported into an assembly model. 

POV Instructions. You can enter instructions in this parameter’s field, that will be appended to the end of 

the description of the light source upon exporting the given file into POV for creating a photorealistic 

image.
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CAMERAS 

A camera is necessary element for visualizing three-dimensional objects, that determines the point and 

direction of viewing the 3D scene. Each 3D window provides a system camera installed “by default”. The 

user can additionally create one's own cameras and make one of them active. 

A camera has its own coordinate system and a set of manipulators.  The manipulators allows you to 

translate the existing cameras around the 3D scene and change their viewing direction. This can be used 

when examining inner elements of the scene and creating animation clips. 

The system camera activates upon opening a new 3D window. Initially, it is located at the distance that 

permits watching all elements in the 3D scene. 

CREATING CAMERAS  

To create a camera, use the command 3CA: Construct Camera. The command is called by one of the 

following means: 

Icon Ribbon 

 

View → 3D Model → Select Camera → New Camera 

Keyboard Textual Menu 

<3CA> Construct > Camera 

Or you can create camera using View toolbar: 

 

The camera creation steps include: 

1. Set location and direction of viewing of the camera (you can use manipulators or select one of 

the existing local coordinate systems. 

2. Setting parameters (optional). 

3. Confirming camera creation. 

Defining Camera 

Upon calling the command, the option automatically sets in the automenu: 

 <L> Select target LCS 
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Use this option to select a local coordinate system in the 3D view window. 

Once a coordinate system is selected in the 3D view window, a schematic image of the camera will be 

displayed. The initial camera direction is always along the X-axis, with the Y-axis always directed up, and 

the Z-axis to the right.  

 

After that, you can set up parameters (if necessary), and then confirm the camera creation by pressing 

. 

If there is no LCS existing in the scene you can specify the camera position using manipulators. 

 

Preview window is displayed in the upper right angle of working window in camera creation mode. It shows 

the view from the camera in real time. 
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Activating Camera 

To activate a created camera, use the command 3VC: Select Camera: 

Icon Ribbon 

 

View → 3D Model → Select Camera 

Keyboard Textual Menu 

<3VC> View > Camera 

Or you can select camera using View toolbar. 

 

Calling this command brings up a dialog box containing a list of all cameras existing in the 3D scene. Select 

the camera with which the 3D scene will be viewed. 

 

 

Another way of selecting the active camera is, while in the command waiting mode, moving the pointer 

over a 3D camera in the 3D window and right clicking , and, after that, in the coming up menu picking 

the item “Select”. 

A camera can be selected from the context menu accessed by right clicking  over a blank area of the 3D 

window. Yet another way is to do so on the 3D model tree. 

Moving Camera 

To watch the 3D scene via a moving camera, you need to make that camera active. 

Selected camera mode enables “walking” around the current 3D scene. It is especially convenient when 

creating floor plans of buildings. 
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A separate mechanism for cameras movement is used. When camera is active you can move inside 

designed areas, rotate camera and perform operations as usually in T-FLEX CAD.  

 

If camera is moved inside the solid body in the scene, a wireframe mode is activated for the body. 

 

Controls in active camera mode: 

Note! Controls for the perspective camera are described below. Result of the key combinations 

usage may differ for the parallel camera, because of the parallel projection properties. 

LMB1 - camera rotation. 

To eliminate rotation around view axis you need to activate Panorama  mode. 

Arrow keys allow to move camera forward/backward. 

Page up/Page down keys allow to move camera up/down. 

                                                 
1 Pressed left mouse button 
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It is recommended to disable object snap  on View toolbar upon movement in selected camera 

mode. 

LMB + CTRL – movement in the screen plane. 

LMB + SHIFT – zoom. 

LMB + ALT – rotation around vertical axis. 

Pressed mouse wheel + CTRL – mode of smooth move forward/backward. Movement speed changes 

according to the cursor position. 

A cross will appear on the screen that will become the reference center for the direction vector (the vectors 

are not displayed). The motion occurs in the following way: moving the pointer by the mouse with the 

button depressed upward from the cross moves the camera forward. Moving the pointer downward from 

the cross will move the camera backwards. Moving the pointer in the horizontal direction right or left of 

the cross will make the camera rotate about its vertical axis right or left, accordingly. Moving the pointer 

along a diagonal with horizontal and vertical components (see the diagram) will make the camera both 

move in the respective direction and rotate. Note that, depending on the pointer's bias to one or the other 

main vector, the translation or else the rotation will dominate to some degree. The farther the pointer is 

moved away from the cross, the faster the camera will move. 

 

Mouse wheel rotation – zoom: move the camera forward/backward. 

Mouse wheel rotation + CTRL – zoom: perspective angle changed without camera movement. 

Long press left mouse button (until the cross symbol appears) – orbital rotation around the selected center. 

The center is selected using the existing in the scene geometry. 

Special tab in the Document Parameters dialog is used for camera management. 
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More information about camera management can be found in “T-FLEX CAD User Manual. Fundamentals. 

2D Design” book in “Drawing setup” chapter. 

Additional options for camera are available on the View toolbar after selecting camera as active. 

 

Active Camera Options 

Options available when camera is active: 

Option  allows to restore original/last saved position of the camera. 

Option  allows to reset vertical orientation of the camera.  

This option performs a one-time action. In this way, the values of the coordinates resulting from spinning 

the camera and setting its vertical position reset to the original values, which are those recorded as a result 

of the last call of the  command. 

 

Option  allows to save current position and perspective of the camera. If you didn’t activate the option 

after movement/rotation of the camera, the camera will return to the original position after exiting selected 

camera mode. 
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CAMERA PARAMETERS  

Parameters section: 

The “Type” parameter defines the method of projecting the objects in the 3D scene when visualizing with 

the help of the given camera.  

The projection can be “Orthogonal” – defining parallel mapping without respect to the distance from the 

viewpoint, or “Perspective” – defining perspective mapping that accounts for the distortion as the distance 

between the camera and the watched object grows. 

External. If a model is used as a 3D fragment, then the model’s cameras with this parameter set will be also 

available in an assembly. The position of such camera will be defined by the position of the 3D fragment. 

Parameters of such camera cannot be modified in an assembly.  

 

 

Angle. Defines the watching angle of the perspective projection. The height of the rectangle adjusts with 

changes in the view angle. 

 

Height. Defines the watching height of the projection. The view angle adjusts with changes in the height. 



Cameras 

1319 

 
 

 

Length. Defines distance to the projection. 

 

Height-to-width ratio defines projection height to width ratio. You can select a value from the drop-down 

list or manually. 

Height-to-width ratio is applied when you record explode animation. 

More information about exploded view can be found in “Auxiliary Tools for 3D Assemblies Modeling” 

chapter. 

 

Options section 

Size of preview window. Specifies size of the preview window in the scene. 

 

All camera translations are displayed in Transformations section. 
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To define additional camera parameters, call the respective dialog box. This is done by the option: 

 <P> Set entity parameters 

The “Visibility” group of parameters is system-wide and defines the modes of displaying cameras on the 

screen: 

Show Image in 3D View. Setting this parameter makes the image of an existing camera visible in 

the 3D scene. If the parameter is not set, the camera will be hidden, but the effect of its presence 

remain.
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PHOTOREALISTIC IMAGES 

GENERAL CONCEPTS  

Ray tracing of the 3D scene is a special way of rendering the scene that accounts for shadows cast by the 

objects, as well as for such phenomena as light reflection and refraction. 

There are three different mechanisms of photorealistic images generation. First of them uses POV-Ray 

application; the second uses integrated NVIDIA OptiX technology; the third uses Embree – ray tracing 

kernel developed by Intel.  

RAY TRACING  

For the first mechanism uses POV-Ray, a ray tracing program which generates images from a text-based 

scene description exported from T-FLEX CAD. POV-Ray installation is included in T-FLEX CAD installation 

package or can be downloaded from appropriate web site. 

 
T-FLEX CAD rendering 

 
Ray tracing (POV-Ray) rendering 

Note that the POV-Ray application requires separate installation. To install it, select the file 

“povwin36.exe” on the distribution CD, in the folder “POV-Ray”. POV-Ray installation runs in 

English. The users who do not know the English language are advised to follow all pre-selected 

items (such buttons as [Next], [Yes] or [I Agree]) in the subsequently coming windows of the wizard. 

When creating a ray-traced image, the 3D scene is exported into POV format, using the settings of the 

current 3D window. Next, the POV-Ray application is automatically launched for generating the 

photorendering. Once generated, the resulting image can be viewed in the View window and, if desired, 

saved in a file. 

When exporting into POV-Ray, the textures are mapped onto the objects in the same way as they 

are displayed in the 3D window of T-FLEX CAD. Moreover, along with POV-Ray it is possible to use 

the textures of all formats supported by POV-Ray (gif, tga, iff, ppm, pgm, png, jpeg, tiff, sys). 

POV-Ray processing runs parallel to other systems; therefore, you can continue working with T-FLEX CAD 

after launching this application. However, depending on the complexity of the image being generated, 

POV-Ray may consume more resources, and so T-FLEX CAD operation could be delayed. 
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Command Operation 

To create a ray-traced image, use the command 3VY: Ray Tracing. This command will be available if the 

3D window is active. Before calling the command, set the 3D scene in the desired orientation, apply the 

desired materials to the operations, place light sources (one can use the light sources on the camera). 

Prefer the perspective projection when creating a ray-traced image. 

The command is called as follows: 

Icon Ribbon 

 

Tools → Title block → Photorealistic view → Ray Tracing 

(POV-Ray) 

Keyboard Textual Menu 

<3VY > Tools > Ray Tracing (POV-Ray) 

T-FLEX CAD saves the information about the location of POV-Ray application and checks its 

availability upon each call to this application.  

The first time POV-Ray is called, as well as in the cases, when the system cannot find this application, 

T-FLEX CAD requests the path to the application. In such a case, a dialog box is displayed that allows 

defining the path to the POV-Ray application. Normally, the path to this application is: “Program 

Files\POV-Ray for Windows v3.6\bin”. If this folder is missing, the application may not be installed 

(refer to the topic “General concepts”). 

Upon calling the command, the following dialog box will be displayed. 

 

Width and Height. These define the width and height of the ray-traced image being created, in pixels. The 

default size is that of the current 3D window. 

Antialiasing. Provides smooth color transition in the generated image. The value of this parameter must be 

greater than 0.  
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The smaller is this value, the softer will appear the transition from one color to 

another; however, the rendering (image generation) will take more time in this 

case. The value of this parameter can be selected from the list or specified 

manually.  

Use Material substitutions. POV-Ray uses a special language for describing the 3D scene. It allows 

specifying a large variety of properties for material surfaces and insides. Due to this, T-FLEX CAD uses 

special instructions for materials, determining, how a material would appear when visualized in POV-Ray 

(the command 3MT: Edited Materials, the button [POV Material]). When the Use Material substitutions 

flag is set, those instructions are passed to POV-Ray. All materials included in the system distribution 

possess special instructions for POV-Ray. Besides the materials, the light sources and additional 

instructions for light sources will also be exported in POV (see Light source parameters, the item “POV 

Instructions”). 

If the Use Material substitutions flag is off, then the instructions will be passed on to POV-Ray, that are 

automatically generated by T-FLEX CAD based on such material properties as color and specularity. 

Export Lights on Camera. By default, one or more light sources are attached to a camera in the 3D window. 

These light sources have specified orientation with respect to the camera and move together with it (see 

the manual on “3D View Parameters”). If the flag Export Light on Camera is on, those light sources are 

passed to POV-Ray. 

Save result in. This item displays the path to the temporarily created output file that used by POV-Ray for 

setting the resulting image in the .bmp format, and by T-FLEX CAD for reading it. Therefore, if T-FLEX CAD 

is closed before the result is created, the image in this file can be viewed later, using any other program 

for viewing images. 

All temporary files created during the image generation are stored in the folder pointed at by the 

system variable TEMP. Upon completing the image, all files except the output one are deleted. The 

output file itself will remain in this folder up until creation of another ray tracing. 
 

Information for advanced users of POV-Ray 

Additional INI file: When the POV-Ray application is started, a file is created with the extension ini, 

recording the exported settings. If necessary, different settings can be specified in this file, even 

redefining those generated in T-FLEX CAD. Should this be the case, enter the desired filename 

in this input box of the dialog. 

Include statements: You can type expressions in this pane, in the POV format, that will be inserted 

in the exported file. 

Clarification: When launching the command, a file in the POV format is created that has the following 

structure:  

<generated variables> 

<included expressions> 

<exported 3D scene>.  
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Generated variables. 

The following variables are included in the exported file: 

fAspectRatio – Width / height screen ratio. When redefining the Width and Height settings in the 

additional INI file, you need to also redefine this variable by using <included expressions>. 

vSceneMin and vSceneMax – the corners of the box outlining the 3D scene in the 3D space. 

vSceneCenter – the center of the box. 

fSceneSize – the length of the box’s diagonal. 

vCameraPos – the camera's position. 

vCamera2Scene – the vector from vCameraPos to the box center. 

fCamera2Scene – the vCamera2Scene vector length. 

cBackColor – the background color. 

These variables can be redefined or used in <included statements>. Example: 

#declare cBackColor <0.1, 0.1, 0.1> 

fog { 

fog_type 2 

distance fCamera2Scene / 2 

rgb <0, 0, 1> 

fog_offset vSceneMin . z 

fog_alt (vSceneMax . z -  vSceneMin . z) / 4 

up <0, 0, 1> 

} 

redefines the background color and sets blue fog that depends on the orientation and size of the 3D 

scene. 

Upon defining all necessary parameters for creating a ray tracing, press the button [OK]. Sometimes, when 

running POV-Ray, the “About POV-Ray(tm) for Windows” dialog box may pop up. In such a case, to run 

the application, simply press the button [OK]. 

When creating an animation with photo rendering turned on by using the command AN: Animate 

Model, you are advised to wait until the first frame visualization starts in POV-Ray, to make sure 

that the “About POV-Ray(tm) for Windows” window does not pop up and does not interfere with 

the animation creation. 

Once POV-Ray is launched, control returns to T-FLEX CAD so that you can continue working with it. Upon 

completing the image generation or in the case of its termination, a message is displayed on the screen: 
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To view the resulting image, press the button [Yes]. As a result, the view window opens allowing to save 

the image in a file. If viewing and saving the resulting image is not necessary, press the button [No]. In this 

case, the resulting ray tracing will remain in the system folder TEMP (until the creation of another ray 

tracing). 

POV-Ray can be started again before completing an image generation (the number of starts is not 

limited). In such a case, T-FLEX CAD exports data in POV, and then, once the process of the previous 

image generation finishes, will launch another POV-Ray application. This creates a queue of image 

generation tasks, with a new task launched upon completing the previous one.  

Selection and Settings of Image Quality 

It is rather unlikely that a satisfactory photorealistic image will be created on the first try. Usually, several 

test photo renderings are required that help adjusting the camera position, brightness and position of the 

light sources, and checking the animation correctness. After that, the final rendering is run. 

However, photo rendering could take unspecified time, depending on the scene complexity and the 

parameters defining the image quality. Understanding these parameters helps avoiding excessive time 

spending on test renderings, on one hand, and helps achieving higher quality of the final image, on the 

other hand. 

There are various parameters for adjusting the quality of the resulting ray-traced image. 

Mesh density. This parameter is defined in the document parameters (the command “ST: Set Document 

parameters”), and, besides the photo rendering, affects the quality of rendering objects in the 3D window. 
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The greater this parameter is, the longer time it takes for exporting the scene by POV, the more RAM is 

used by POV-Ray and the longer POV-Ray runs the preprocessing of the scene before the rendering 

(Parsing). Due to this fact, we recommend decreasing the mesh density when running a test rendering, 

sometimes even up to the minimum setting. When running the final rendering, best is to use the maximum 

mesh density. 

Light source parameters. When creating a photorealistic image by using conventional light sources, the 

objects cast well-defined shadows because the light sources are infinitely small. In the reality, this happens 

very seldom; therefore, shadows are often blurred. The use of the diffused light sources allows making 

shadows smoother and enhances the image quality and realism. The diffused light sources use multiple 

concentrated light sources offset from each other, instead of one such light source. The more those are 

offset, the less sharp will be the shadow. The more concentrated light sources are included in a diffused 

light source, the more the shadow is blurred and the longer time it takes for the rendering. 
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Conventional light 
 

Diffused light 

 

A diffused light source in POV-Ray is made of multiple concentrated light sources. 

These light sources are placed in a rectangular array oriented in a certain way with 

respect to the specified center. The number of light sources along each of the 

rectangle’s sides can be different. 

To make a light source created in T-FLEX CAD a diffused light source in POV- Ray, 

enter the following in the “POV Instructions” input box for the light source 

properties: 

 

area_light <0.035, 0, 0>, <0, 0.035, 0.035>, 5, 5 adaptive 1 jitter 

Above, the coordinates of the opposite corners of the rectangle are entered in the angle brackets with 

respect to the origin point (the point where the diffused light source is positioned). “5, 5” - is the number 

of light sources in each direction. In this way, the total number of the concentrated light sources is equal 

to 5x5=25. “adaptive 1 jitter” - are the additional parameters directing optimization of shadow calculation.  

Antialiasing. In conventional rendering, the phenomena of jagging and dashing of thin lines could be 

encountered. Smoothing by additional calculations may reduce the negative impact of such phenomena. 

 
Jagged edges 

 

Antialiasing is on 

Antialiasing involves increasing the resolution when visualizing some parts of the scene. This slows down 

the scene rendering. Therefore, avoid using antialiasing in test renderings. However, antialiasing is 

preferable in the final rendering.  

Radiosity. In conventional renderings, only the direct light is accounted for, that illuminates only the objects 

directly lightened by the light source. However, in the real world, the light originates not only from the 

sources. It is also reflected from the objects illuminated by the direct light. POV-Ray provides an option of 

turning on the method of calculating radiosity, that in certain cases enhances the image realism. 
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Conventional light 

 

Radiosity 

Due to bulky additional calculations, use of radiosity mechanism may cause significant slowdown of 

rendering. Therefore, use low resolution when including radiosity in test renderings. 

To turn on the radiosity mechanism, enter the following expression in the “Include statements” input box 

of the “Ray Tracing Options” window: 

global_settings { 

radiosity { count 500 minimum_reuse 0.018 brightness 0.8}} 

Refer to the POV-Ray application manual for the meaning of the quoted instructions, as well as for 

additional information regarding the radiosity mechanism. 

Image resolution. This parameter noticeably affects the time used for rendering. With the image quality 

defined, the speed of rendering is directly proportional to the size of the resulting image. You can restrict 

test renderings to small resolution, for example, 320*240. 

Examples of Ray-Traced Images of T-FLEX CAD Models 
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PHOTOREALIST IC  V IE W  

The second mechanism for generation of the photorealistic images uses NVIDIA OptiX technology. It is 

used for creating of high quality images based on lighting and material properties such as transparency, 

refractive index, surface properties, etc. 

 

The mechanism allows obtaining photorealistic images directly from T-FLEX CAD environment, providing 

convenient interface of 3D scene parameters management, control over the quality of result and possibility 

to print result or save it into a file. 

With this mechanism, photorealistic image can be generated not only from three-dimensional solid 

models, but also from imported 3D models. 

The NVIDIA OptiX technology is used for creation of photorealistic videos when you record 3D 

model exploded view animation in command 3VX: Exploded View. 

The third mechanism for generation of the photorealistic images uses Embree – ray tracing kernel 

developed by Intel.  

Embree uses CPU for its calculations and provides high performance and image quality. 

User interface for NVIDIA OptiX is similar to the Embree. They will be described together in the 

following chapters 

 

Command of Photorealistic View 

To activate the command use: 

 

Icon Ribbon 

 

Tools → Title block → Photorealistic view → Photorealistic 

view (GPU NVIDIA) 

Keyboard Textual Menu 

<3RV> Tools > Photorealistic view (GPU NVIDIA) 

 

Icon Ribbon 

 

Tools → Title block → Photorealistic view → Photorealistic 

view (CPU Intel) 

Keyboard Textual Menu 

 Tools > Photorealistic view (CPU Intel) 

After activation new window with generated image appears. 
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Quality of the generated image depends on the number of iterations. The iteration is evaluation of image 

pixels color. The evaluation process depends on image size, mesh quality and number of objects. 

The iteration number is displayed in the lower part of the window. 

 

 

Process of the image generation can take from several minutes to several hours according to your 

computer power, model complexity and image quality. 

Options for the operation are displayed on toolbar. 

 

 Print image. Allows to print generated image. 

 Save image. Allows to save generated image in *.bmp, *.jpg, *gif, *tiff, *tif, *.png, *.tga formats. You 

can set the file name and specify folder. 

 View parameters. Allows defining the image generation parameters. More information about it can 

be found below. 
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 Fix generation parameters. Allows fixing the image view and scale. Model rotation becomes 

unavailable.  

 Update generation of photorealistic view. Restarts photorealistic view generation. All current results 

are cancelled.  

 Pause photorealistic view generation. Allows to pause generation of the image. This option stops 

calculations and releases computer resources. 

Image quality. You can set one of four kinds of quality from the drop-down list. 

 

The low and standard qualities are used for rough drafts of images. When one of them is set, the minimum 

quantity of iterations for generation of the image with certain level of “noise” is evaluated by the system.  

To generate the most realistic images you need to choose high or maximum quality. When the quality set 

to maximum, the number of iterations is not limited. 

Select of current active camera. Allows to select one of the cameras existing in scene. Image will be 

generated according to the camera location.  

  

An important role in the photorealistic image creation plays Mesh Quality configuration. You can change 

it with the drop-down list on the 3D tab in the ST: Set Document Parameters window. 

 

The higher the quality the higher is the density of the mesh. To create the most realistic images, it is 

recommended to set “Fine” or higher quality.  

This configuration is especially important for models with rounded faces. 
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Difference between images with different quality. 

 

Ultra Coarse Standard Ultra Fine 

Generation of photorealistic images requires high computer characteristics. More information about 

requirements can be found on our website or in the Getting started chapter.  

The image generation can be paused anytime. Its result can be saved to disk with option  or printed 

with option . 

 
Source model Photorealistic image 

Examples of photorealistic image generation can be found in library “Examples/Additional 

resources\materials and photorealistic view. 

The photorealistic image and 3D model windows can be displayed simultaneously. For this purpose use 

command WO: New Window. 
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In the dialog window select Photorealistic View from the drop-down list. You can set convenient windows 

placement with the help of four drop-down lists.  

 

Image Parameters 

Fit to window. The option is enabled only when the flag “Use current view size” is set. When the option is 

active, image of the current size is fully displayed.  
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Use current view size. When active, the option allows to set the generated image size. After activation, 

option Fix generation parameters  on the toolbar automatically activates.  

Size of the image is specified in pixels. The image of specified size will be generated completely, even if it 

does not fit the window. To generate images of the highest quality it is recommended to set the largest 

current view size. 

Image quality. The option duplicates the drop-down list of settings from the toolbar. The only difference 

is the possibility to set the number of iterations manualy. You need to select user quality and specify the 

number of iterations. 

Reflection max depth. The option is important for generation of refractions and reflections. 

All texture parameters are similar to the standard parameters of 3D view.  

More information about them can be found in chapter “Working with the 3D view window”. 

Luminance factor of environment. Allows to set luminance by adjusting the amount of light coming to 

objects. 
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Photorealistic Images Examples 

NVIDIA Optix: 

 

Embree: 
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PHOTORENDERING PROTOT YPES  

The standard distribution includes the prototypes designed specifically for quick creation of ray tracings. 

To create documents based on such prototypes, call the command FP: Create New Document Based on 

Prototype, and on the tab Photorendering select one of the two prototypes: Room or Flying around 

object. 

Each of these prototypes has several predefined light sources, a camera and a coordinate system for fixing 

a 3D fragment. The placement of these elements can be modified as desired by moving the respective 

elements in the drawing window. Additionally, the 2D window provides a brief instruction on using the 

prototype. 

Normally, you work with these prototypes as follows. Create a new document based on one of the 

prototypes. Insert a 3D fragment in this document as the 3D fragment or 3D picture (using the appropriate 

scale), whose ray tracing needs to be generated. Next, do several test renderings to determine the 

appropriate placement of the light sources and the camera. After that, run the final rendering. 

The settings required for test and final renderings will be described below. Before that, let us mention 

distinct features of each of the prototypes. 

The Room prototype is intended for creating a static image. The scene in this prototype appears as a 

“room”, with two light sources and a camera. Additionally, a coordinate system is created in advance for 

convenience of fixing the 3D fragment. By default, the two walls and the ceiling of the “room” are not 

visible; however, those can be made visible by clearing the “Hide ceiling” flag in the 2D window. 

The Fly around object prototype is intended for creating either a static image or a photorealistic animation 

in which the camera moves around the object. The scene appears as a large round platform, with three 

light sources and a camera. A coordinate system is provided in advance with the scene for fixing a 3D 

fragment. Additionally, the camera position is driven by an expression and depends on the particular frame 

of showing the scene. The animation duration needs to be defined in the 2D window (this is the time, in 

which the camera completes the flight around the object and returns to the original position). The scene 

in animation needs to be related to the variable “frame”, considering the number of frames per second 

equal to 25. 

You may find the example on using “Flying Around Object” template in the library “Examples”, folder 

“Additional resources\Ray Tracing\Flying around object”. After opening “Scene Based on 

Template.grb” file activate camera “Camera” in 3D scene using 3VC: Select Camera…. Then use AN: 

Animate Model command and apply animation by variable “frame” from 0 to  250 with step 1. 



Creating Custom Elements For Sheet Metal and Holes Libraries 

1337 

CREATING CUSTOM ELEMENTS FOR SHEET METAL AND 

HOLES LIBRARIES 

This chapter describes the rules of creating custom elements for sheet metal and holes libraries. 

The libraries of typical sheet-metal features, "Sheet Metal Features" and "Sheet Metal Features Inch", 

provided with the system, are used when creating the “Forming Feature” operation. The library elements 

are 3D models created in a special way. If necessary, the user can append the standard libraries with one's 

own elements. The first section of this chapter describes the sequence of steps to create such elements. 

 

The standard holes libraries "Hole Features" and "Hole Features Inch" are used in the "Hole" operation. Each 

element of a hole library is a parametric 3D model, whose geometrical parameters are bound to special 

reserved variables. Hole libraries can be appended by the user. The second section of this chapter describes 

methods of creating a 3D model that can be used as a 3D fragment-hole. 

EXAMPLE OF CREATING A NE W SHEET METAL FEATURES L IBRARY 

ELEMENT  

Sheet-metal features library elements are 3D models created by following certain rules. The base of each 

element's 3D model is the base 3D profile. It is an “external parameter” of the sheet metal feature, similar 

to external geometrical parameters of adaptive 3D fragments.  

Sheet metal feature elements are applied to a part by using the command SMF: Create Sheet Metal 

Feature. At that time, a 3D profile is selected on the part that defines the desired shape of the sheet metal 

feature. That profile is passed by the command into the 3D model of the sheet metal feature and is used 

to substitute its base profile. The 3D model of the sheet metal feature element is recalculated according 

to the new shape of the profile and is inserted in the part's 3D model. 

Let's review the creation of a new element using the example of the “Emboss” element included in the 

standard T-FLEX CAD distribution. 

mk:@MSITStore:C:/Program%20Files/T-FLEX/T-FLEX%20CAD%209/Program/tflex.chm::/smf.htm
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The diagram shows a draft of the elements being created. The inner and 

outer surfaces of the prospective element are marked by different colors. 

The dimensions indicate the parameters whose values can be defined by 

the user. Besides those, the user will be able to select the blending radius 

of the corners of the original profile. 

 

The new sheet metal feature element shall be created as a 3D fragment in 

the assembly context. Therefore, first you need to create an auxiliary file 

with the “workpiece” part, to which the forming feature will be applied. 

This is exactly the document, in which the 3D fragment-forming feature 

will be created in the assembly context. 

 

 

An auxiliary file is required only for the process of creating a new sheet metal feature element. You 

can delete it once the library element creation is complete. 

Creating Auxiliary Document 

Let's create an auxiliary document to create a sheet metal feature element. With the help of command 

 you need to create a new 3D model. 

 

In the created document, let's build the “workpiece” part for the 

forming feature (by any familiar means). The workpiece should 

have a simple shape and as few edges and surfaces as possible. 

The forming feature element file size will depend on how simple 

the workpiece is, and so will the time to open and recalculate the 

element. Best of all is to make it round and flat. 

 

Let's create the 3D profile on the top faces of the workpiece, that 

will be the base profile of the forming feature element. The profile 

should also be made as simple as possible. In this example, let's 

create a triangular profile. 

 

 

Save the file under the name “Part for emboss”. Now we can proceed with creation of the forming feature 

element itself. 

 

Creating the 3D Model of a Sheet Metal Forming Feature Element 

1. Create a new 3D fragment by calling the command FM: Create Fragment in Assembly (File > 

Fragment > Create) and specify an arbitrary name for the prospective element, for example, 
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“Emboss new”. After clicking [ОК], the assembly context mode activates automatically (the 

source body will become transparent). 

Make sure that the associative snapping mode is On. To do this, click the right mouse button 

on an empty space in the 3D window and select the context menu item “Snap Modes”. 

2. In the variable editor, create required variables that will define the element parameters: “Depth”, 

“Angle”, “Radius_side”, “Radius_below”, “Radius_above”. All variables must be external. 

 

 

 

3. To correctly create the forming feature, you need to know the thickness of the source workpiece. 

To have this thickness defined automatically, you can use the top and bottom faces of the 

workpiece. Call the command Parameters > Measure, select the option “Measure relation 

between two elements”. Specify the top and bottom faces of the workpiece, and click . In 

the list of relations, select “Distance”, and then create the “Thickness” variable based on it. The 

value of the created variable will be equal to the distance between the selected faces (the 

thickness of the source body). 
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4. Extrude (the 3X: Create Extrusion command) the triangular 

profile lying on the top face of the source body. When creating 

the extrusion, the top face shall be selected for the direction; 

click the  button in the property window to flip the extrusion 

vector. The end blending shall be defined by the 

“Radius_below”, the side edges blending – by the “Radius_side” 

variable.  

The extrusion we have created (“Extrusion_1”) will be used to 

obtain the inner surface of the forming feature. 

When creating an ordinary model, it is possible to skip using 

additional blending options for the extrusion and instead use 

common blend operations. However, in the present case that is not 

an option, since the model must correctly recalculate with any 

admissible 3D profile. If, for example, we would change the number 

of joint points of the top 3D profile in the “Part for emboss” file, 

then the 3D model in the “Emboss new” file would still recalculate 

correctly. If using an ordinary blend, then this may not work if it fails 

to account for the increased number of profile edges.  

 

    

5. To obtain the external surface, we will use the “Shell” operation. 

Call the command 3SH: Create Shell, select the option “Select a 

body” and specify the extrusion created at the previous step. 

Enter the name of the “Thickness” variable in the “Common 

Thickness” field. Set the shell parameters as shown on the figure 

on the right: the “Create offset body” and “Keep source body” 

flags shall be made active.  

The created body will be named “Shell_2”.  

6. By now we created the inner portion of the “Emboss new” prospective element – “Extrusion_1”, 

its outer portion – “Shell_2” and the source workpiece – “Extrusion_0 (from assembly)”. But 

“Shell_2” comes out above the source body. This outcoming portion needs to be deleted. 
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To cut the extra portion, we will use the 3CU: Cut By Section operation. Select the top face of 

the source workpiece body as the cutting plane. The resulting body will be called “Cut 

operation_3”. 

 

7. It is now possible to add together “Cut operation_3” and the 

source workpiece (the latter being no longer needed) using the 

Boolean operation (the 3B: Create Boolean command).  

In the Boolean operation properties set the flags “Blend New 

Edges” and “Chamfer”. The “Radius” parameter value shall be 

defined by the following expression: 

Radius_above-Thickness>=0? Radius_above-Thickness:0. 

When creating the Boolean operation, chamfers will be created on 

new edges. The chamfer offsets shall be less than the 

“Radius_above” defined by the user, by the “Thickness” amount, 

and cannot be less than zero. This requirement conditions the 

above-written expression.  

8. What is left now is to generate the inner surface of the “Emboss 

new” element. To do this, we shall use a Boolean operation again. 

We will subtract “Extrusion_1” from the “Boolean_4” body 

obtained at the previous step. Just like in the previous step, the 

option of chamfer creation on new edges shall be enabled in the 

Boolean operation properties. The chamfer size shall be defined 

by the “Radius_above” variable. 
 

At this point, the new forming feature model element can be assumed completed. Next, right-click  on 

an empty space in the 3D window and select the context menu item Save Fragment and return. The 

“Emboss new” file, which contains the created 3D fragment, will become a new element in the sheet metal 

features library.  

What to do with the obtained sheet metal forming feature element will be described a bit later. For now, 

let's verify the function of the created forming feature element. Upon finishing working in the assembly 

context, the “Part for emboss” file will open again. You do not have to save it – we shall not need it anymore. 

But, before the file is closed, change the number of segments in the source profile on the “workpiece” of 

the part – the forming feature shall adjust accordingly. 



Three-dimensional modeling 

1342 

          

Creating a Dialog for New Library Element 

Besides the 3D model proper, a new sheet-metal library element requires creation of a dialog to input 

parameters of the given forming feature element (which is the external fragment element parameters). This 

dialog will be coming up in the command SMF: Create Sheet Metal Feature when inserting our forming 

feature element. 

To create the dialog, open the file “Emboss new”. Add a new 2D page to 

it to hold control elements (the TR: Create Control command). On this 

page, position the elements of the “Static Text” type with the appropriate 

parameter names and the value input fields (“Edit Box” elements) for all 

external variables of the created fragment using the TR: Create Control 

command. As a result, you will get a simple dialog that will serve to help 

the user defining parameters of the forming feature being created. If 

desired, a more complex dialog can be created, by introducing in it a 

schematic image of the element as in standard sheet metal library 

element dialogs. 

 

The forming feature dialog is automatically scaled in the “SMF: Create Sheet Metal Feature” 

command property window so as to have the font size in it matching the Windows font size. 

Therefore, when creating a dialog, we recommend you not to change the font size set by default 

for the dialog page (it is set to be close to a standard Windows font). This will help avoid distortions 

when displaying the dialog.  

Besides that, do not create too wide dialogs that do not fit within the standard property window.  

After creating the dialog, save the file again. 

Defining Limitations on the Source 3D Profile Type 

Limitations can be imposed on the type of a 3D profile that will be used for creating the new forming 

feature element in the SMF: Create Sheet Metal Feature command. To impose limitations, you need to 

create two external variables named “contour_type” and “profile_type”. The values assigned to those 

variables will define the 3D profile types allowed for the given forming feature element: 
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profile_type: defines the geometrical appearance 

of the 3D profile contour 

contour_type: defines the nesting of the 3D profile 

contour 

0 - any 

1 - closed 

2 - open 

3 - line segment 

4 - from polylines 

0 - any 

1 – simple only (no nested contours and no 

multiple contours) 

2 - no nested contours 

When these variables are created, then, upon an attempt to select a 3D profile of an inappropriate type in 

the forming feature creation command, the system will output an appropriate warning in the Diagnostics 

window. As a result, the profile will not get selected. On the other hand, if the variables were not created 

in the forming feature fragment, then, when applying it, any 3D profile types will be allowed for selection. 

The fact that an incorrect profile was selected will then only be hinted by the errors occurring when 

recalculating such a forming feature. 

In our example, the “profile_type” variable must be equal to 1, and the “contour_type” variable must be 

equal 0. 

Adding a Created Fragment to the Sheet Metal Features Library 

To use a created element in the SMF: Create Sheet Metal Feature command, you need to copy the “Emboss 

new” file into the folder “...\System\Sheet Metal Features”. After that, when calling the forming feature 

creation command, the created element will show up in the list. 

Element Name and Icon 
 

Our new forming feature element will be referred to in the SMF: 

Create Sheet Metal Feature command by its filename and the 

standard icon of a T-FLEX CAD document. If desired, it is possible 

to define for it another, more intuitive and complete, name. To 

do that, call the PS: Show Model Properties command in the 

element file (in our example that's “Emboss new”), and fill in the 

“Title” field on the “Summary” tab. 

Icon may be changed using command IC: Create/Edit document 

icon.  

 

More information about icons creation can be found in 

“Preview-slide” chapter. 
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EXAMPLE OF CREATING A NE W HOLES L IBRARY FRAGMENT  

Let's review another example of creating a new hole fragment. Open a standard hole – “Center Hole with 

metric thread”: 

1. Since there are different implementation versions of the hole, an internal database was created 

within the fragment document, that contains standard dimension sets. 

 

2. Special external variables were created in the fragment document that are required for correct 

handling of the fragment in the command 3H: Create Hole: 

 IsThrough – this is the variable that defines the hole type (0 – blind, 1 – through).  

The 3D model of any hole fragment shall be created in such a way as to have the hole 

type (blind, through) change depending on this variable value. The variable value will be 

determined by the state of the option in the command “3H: Create Hole” when inserting 

the hole. This external variable must necessarily be present in the hole fragment. 

 length – this is the variable responsible for the hole depth (when creating a fragment, 

this variable value can be arbitrary).  

When applying a fragment, this variable value will be determined by the system (for a 

through hole) or by the user in the fragment's external variables dialog (for a blind hole). 

You do not have to create this variable (or make it external), if the hole being created can 

only be blind and its depth cannot be arbitrary, but is rather determined by the standards. 

In such a case, the depth is uniquely determined by other hole parameters (for example, 

the diameter, as found in the holes for the positioning screw tips). When applying a hole 
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without the “length” external variable, the hole type selection options will be inaccessible 

in the 3H: Create Hole command automenu. 

Other necessary variables can be created and named by the user as desired. For example, in the 

described hole fragment, an additional external variable “IsThrough” is created. Depending on 

its value, the hole length can be increased by the amount defined by another external variable, 

“tempDistCurv”. This is necessary in the case when the hole is applied on a curved face (convex 

or concave) or is directed at an angle to a flat face. When the “IsThrough” variable value is equal 

0 – no length extension is required, 1 – the length needs to be extended. A blind hole will be 

extended by this amount on one side, a through one - on both sides. 

3. The 3D profile of the hole is created based on 2D constructions on a workplane. 2D 

constructions are made in such a way as to describe all possibilities for creating a given hole 

(the change of the hole type is defined by the values of the above-described variables). 

 

4. A rotation operation is created based on the 3D profile.  

When creating a hole it is also possible to use the “Extrusion” command. An example is a square 

hole in the standard library. A general rule while creating any hole fragment is to create only a 

single body in it. If a hole has several versions, its shape should be possible to change using 

construction lines. 

           

5. Since the considered hole is threaded, there is a thread applied to the cylindrical face (the “3AT: 

Create Thread” command). The cylindrical face diameter corresponds to the inner thread 

diameter. The thread parameters (type, diameter, pitch, direction) are bound to variables. To 

make sure that the thread in the hole appears correctly on a projection, the “Thread” operation 

parameters include the “Side/Inner” property. 

6. To snap a hole when using it in the 3H: Create Hole command, a local coordinate system is 

created. An LCS for snapping any hole is created by the following rules: the coordinate system 

origin point must be on the hole axis, the X-axis must be directed inward of the hole along its 

axis. In the coordinate system parameters, have the “Use for Fragment Fixing” flag set. 
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7. To manage hole parameters, a dialog of control elements is created. 

 

8. The file of the described hole fragment is stored in the folder “…\System\Hole Features”. This is 

how it is made accessible in the list of holes in the 3H: Create Hole command. 

The mentioned folder is for the metric library of holes. Save inch-base hole files in the folder 

“…\System\Hole Features Inch”. 

9. Additionally, the full name of this hole is specified among the properties of the described 

fragment file. Besides that, the file of the whole icon is created in the same folder, that contains 

the images in two sizes (16x16 and 32x32). The icon file name matches the name of the hole 

fragment file. The hole name and its icon will be displayed in the list within the 3H: Create Hole 

command. 



Creating Custom Elements For Sheet Metal and Holes Libraries 

1347 

The icon creation and the hole name definition are optional. Nevertheless, those help make the hole 

handling more intuitive in the 3H: Create Hole command.



 

 

MODEL GEOMETRY ANALYSIS 
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MODEL GEOMETRY ANALYSIS 

A set of commands united in the Geometry Analysis group serves for conducting various checks on the 

model. These commands neither modify the model nor create new bodies or operations. 

The set of the geometry analysis commands includes the following: 

 Mass-Inertia Properties; 

 Model check; 

 Intersection check; 

 Curve curvature; 

 Surface curvature; 

 Surface deviation; 

 Surface gap; 

 Normal deviation; 

 Surface smoothness; 

 Model separation check; 

 Model Separation Check. 

The commands can be called from the textual menu Tools > Geometry Analysis. 

MASS-INERTIA PROPERTIES  

This command allows calculating mass-inertia properties of the selected operations. The command 3MP: 

Mass-Inertial Properties is called via: 

Icon Ribbon 

 

Measure→ Measure → Mass Properties 

Keyboard Textual Menu 

<3MP> Tools > Geometry Analysis > Mass Properties 

Upon entering the command, the following option is active by default: 

 <B> Select source 3D operation 

It allows selecting the operation, whose properties need to be calculated.  

To calculate the properties that depend on all existing operations, do not select any operations or use 

option: 

 <A> Select all solids 
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This is the case if you need to calculate properties of an assembly model composed of several bodies. The 

bodies may even have different density. The system will account for that. 

To cancel selection of all operations, use the option: 

 <F> Cancel Operation selection 

If necessary, calculations can be done relative to a local coordinate system that can be selected by the 

option: 

 <L> Select target LCS 

To cancel coordinate system selection, use the option: 

 <K> Cancel LCS selection 

If no target coordinate system is specified, the calculation will be done in the global coordinates. 

Upon selecting the operations and the coordinate system, finish the input. Upon finishing the input, the 

“Mass properties” window will be displayed. 

 

The parameters “Mass units” and “Linear units” allow setting up the desired measurement units. 

The computational accuracy can be defined in the respective input box or set by the provided slider. 
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If you press the button [Compute], the dialog will display the calculated values of the parameters that are 

represented in this dialog box. 

The button [Export] allows saving the calculation results in a text file. 

The button [Exit] closes the parameters calculation window and brings you back to the mode of selecting 

bodies and coordinate systems. 

MODEL CHECK  

This command serves for analyzing the selected body in order to expose errors in its geometry. Errors may 

become an obstacle on the way of future manipulations with the model. Errors in geometry may occur, for 

example, due to deficiencies of importing 3D models from other systems. Sometimes, however, errors may 

be introduced at the time of creating a 3D model in T-FLEX, since only a local model check is automatically 

performed when creating a 3D operation. Meanwhile, the full check may take some time, depending on 

the model complexity. 

Examples of some typical errors are shown below. 

 

Mismatching loops 

 
 

Self-intersection 

 

 

Mismatching faces 

To call the command QM: Check Model, use the textual menu: 

Icon Ribbon 

 

Measure→ Geometry analysis → Model Check 

Keyboard Textual Menu 

<QM> Tools > Geometry Analysis > Model Check 

 

Once in the command, you can select elements to check. Those could be edges, faces or whole operations 

(in the latter case, all edges and faces belonging to this operation will be checked simultaneously). Use the 

following options for selection: 

 <E> Select Edge or cancel Edge selection 

 <F> Add/Remove selected Face 
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 <B> Add/Remove all Faces of Solid 

To select all operations at once, you can use the option: 

 <A> Select all operations 

 

Once selected, the element is put in the list Check results. This list displays the type of the element and 

whether it was already checked or not. If it was, then the results of the analysis are displayed as well. 

   

 

To cancel selection of one of the elements, click it again in the 3D window. To cancel selection of all 

elements, use the option: 

 <R> Cancel selection 

To run the check on the selected elements, use the option: 

 <Enter> Finish input 

After picking this option, the system will check the selected elements and display the results in the Check 

results pane. If there are no errors, [OK] will be put next to the element. 

If, on the contrary, an error was found, then the list of the detected errors will be displayed next to the 

element name. 

If you quake a particular error, then the erroneous part of the model will be highlighted red in the 3D 

window. 

You can immediately select more elements to check, without leaving the command. 

INTERSECTION CHECK  

This command allows checking the model for intersections and contacts of the selected bodies. The 

command is particularly helpful when working with assemblies. 
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To call the command QI: Check Model Intersections, use the textual menu: 

Icon Ribbon 

 

Measure→ Geometry analysis → Intersection Check 

Keyboard Textual Menu 

<QI> Tools > Geometry Analysis > Intersection Check 

 

The command offers two checking modes: checking intersections of all 

bodies in the scene, and checking intersection of the selected operations. 

The desired mode is selected in the property window. 

Upon entering the command, the All Operations in Scene button is pushed 

in the property window. Therefore, you can finish input immediately and run 

the check for intersection of all operations in the scene.  

If the scene is rather complex, contains numerous bodies, and the bodies have complicated geometry, then 

checking intersection of all bodies in the scene can take long time. In such cases, you are advised to directly 

specify the bodies whose intersection needs to be checked. To do this, use the option: 

 <F> Select source 3D operation 

 

Once an operation is selected, it will be added to the checklist, and 

the “Operations” button will be pushed automatically in the 

properties window. Upon finishing the input, the check for 

intersections will be run on the listed operations only. 

To delete a specific operation from the checklist, use the button . 

To cancel selection of all bodies, you can simply switch to the All 

Operations in Scene mode, and the list of the operations to check 

will be cleared. 
 

To run the intersection check, use the option: 

 <Enter> Finish input 
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Upon finishing the check, the results will be displayed in the 

“Intersections Found” pane. If you click an intersection report, the 

intersecting bodies will become semitransparent in the 3D window 

and change the color, while the intersection region will be brightly 

highlighted. The volume of the bodies’ intersecting region will be 

displayed in the Volume pane.  

 

If the intersecting region is too small, you can use the button Zoom in, and the image of the intersection 

region will be magnified. 

Depending on the specified additional parameters, the analysis results 

will be displayed differently in the “Intersections Found” pane. 

The command provides two additional parameters, Adapt Threads and 

Consider Tangent Faces.  

 

Often, one part is connected with another one by a thread. In this case, 

with the Adapt Threads parameter set, the system will be taking into the 

account thread parameters of the intersecting operations and, in the 

case of finding a mismatch in some thread parameters (for example, the 

pitch), the message “Face geometry doesn’t match thread standard” will 

be displayed in the “Intersections Found” pane. If you click this message, 

the respective faces with the thread will be marked in the 3D window by 

dashed lines. 

 

 

By default, the system accounts only for intersections of the 

bodies penetrating each other. If the Consider Tangent 

Faces option is set, the system will be also accounting for 

touching contacts, besides intersections of operations. 

Therefore, the touching faces of the operations will be 

mentioned in the “Intersections Found” pane, besides 

intersections and mismatching thread parameters.   

If you click a report about a touch, the respective faces will be marked by dotted lines in the 3D window. 

MEASURING CURVATURE OF CURVES  

This command allows measuring curvature and the curvature radius of the selected curves. You can select 

edges and 3D Paths to measure curvature. 
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The command QC: Show Curve Curvature can be called via: 

Icon Ribbon 

 

Measure→ Geometry analysis → Curve Curvature 

Keyboard Textual Menu 

<QC> Tools > Geometry Analysis > Curve Curvature 

Upon entering the command, you need to select one or several elements, whose curvature needs to be 

measured. To select, use the options: 

 <E> Select Edge or cancel Edge selection 

 <T> Select 3D Path 

To cancel selection of a curve, you need to click it again. To cancel selection of all curves, use the option: 

 <U> Cancel selection 

 

Right after selecting an element, its curvature will be measured and 

displayed in the 3D window as a multiplicity of colored lines stemming 

from the curve, called curvature porcupine quill. 

You can modify two parameters: Curvature and Radius. Depending on 

the selected parameter, rendering in the 3D window will appear 

differently. 

If Curvature is selected, the colored quill lines will be pointing in the 

direction away from the center of curvature. The lines originate on the 

curve. Their length corresponds (to a certain scale) to the curvature at 

the point, from which the line originates. 

The scale coefficient that relates the curvature of the curve and the 

length of the colored lines is defined in the properties window by the 

parameter Size. 
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If the Radius parameter is evaluated, the colored lines will be 

connecting points on the curve with their respective centers of 

curvature. The length of the colored lines corresponds to the radius of 

the curve's curvature. 

The density of the colored lines is controlled by the Density parameter 

both in the case of curvature evaluation and in the case of the 

curvature radius evaluation. 

 

Working with the tab “Colors” 
The quill lines are painted in different colors, depending on the value of 

the curvature at the point. Color distribution within the range of the 

measured parameter is set up on the tab “Colors”, located in the 

properties window. 

A color scale is displayed on the tab. The values at the left of the scale 

correspond to certain colors on the scale. The black triangular markers at 

the right of the scale are used for adjusting the scale. 

Each marker relates to a certain color. The colors of the scale change 

smoothly from one marker to another. You can move the markers along 

the color scale. To do this, you need to “grab” a marker with the mouse 

and drag it to the new position. As you do this, the color scale will change 

its appearance, and so will the image in the 3D window. 

 

 

To define the color of a certain marker, right click  this marker, and in the 

coming up menu select “Color”. After that, you can select the color in the 

standard color selection window. 

The scale can have two markers (for the maximum and the minimum 

values), or more. To add a marker, right click  where you want to add it, 

and in the coming up menu select “Add”. 

 

To delete a marker, right click  this marker, and in the coming up menu select “Delete”. 

The marker placement scheme and the colors can be saved and 

unloaded to a file (the file extension is “*.col”). To do this, use the menu 

items (Save and Load), coming up upon right clicking  anywhere on 

the Colors tab.  
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The range of the color scale for the measured parameter can be 

modified as well. To do this, use the parameter “Scale” at the top of the 

properties window. By default, the parameter is set to “Auto”. This 

means that the minimum and maximum values on the scale correspond 

to the minimum and maximum parameter values of the selected 

elements.  

 

In this case, the entries “from” and “to” cannot be edited, since these 

parameters are defined automatically. 

Note that the quill lines defining the amount of curvature are displayed 

only on the portions of the curve whose curvature falls within the 

specified range. Thus, if using the automatic scale, the colored quill will 

be displayed along the whole curve. 

 

If the parameter is set to “Custom”, then the values in the entries “from” 

and “to” can be specified manually. Note that the quill will be shown 

only along the portions whose curvature falls within the specified range.  

Thus, for example, the minimum curve of the curve shown on the 

diagram is equal to zero. Therefore, setting a positive value in the 

“from” input box (in the example, set to 0.18), will make the quill 

disappear on some parts of the curve. The quill coloring will also be 

different.  

Besides the color-coded curvature display, a provision is made for reading the curvature at a specific point. 

To do this, use the option: 

 <C> Measure curvature at arbitrary point 

 

When this option is active, the pointer changes its shape. As the 

pointer approaches the curve, the position on the curve where the 

curvature is measured is marked by the red square. The value of the 

curvature and the radius of curvature at the point appear in a tooltip 

next to the pointer.  
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If the option Collect data is set on the tab Results, then, upon 

clicking a point on the curve, the point coordinates, curvature and 

the radius of curvature will be written in the curvature measurement 

log. 

The created log can be copied to the clipboard (the button ) or 

saved in a text file (the button ). 

To clear the log, use the button . 

 

Besides collecting data into the log, you can create 3D labels when 

clicking a point on the curve. A 3D label appears as a semi 

transparent text in the 3D window, containing the results of the 

conducted measurements and an arrow marking the point where 

the measurement was done. 

 

 

3D labels are handled by using the parameters located on the tab 3D Labels. 

The option Create determines whether to create new 3D labels upon clicking a point on the curve.  

If the option is set Displayed value: All, both values will appear by the newly 

created 3D label: the curvature and the radius of curvature. 

If, instead, the option Displayed value: Current is set, then the newly created 

label will show only the parameter that is currently being measured.  

If the Update option is set, then the 3D labels that show the current value 

are updated automatically when switching to a difference type of the 

measured value. 

To delete all 3D labels, use the button [Clear All].  

 

3D labels are displaced at some distance (in the screen coordinates of the 

3D window) from the point they corresponds to, and participate in the 

motion when the screen is spun. This relative position can be modified. To 

do this, move the pointer to the 3D label (in this case, the pointer will change 

its appearance) and drag the 3D label to the new position.  

 

To find the point of maximum curvature, use the option: 

 <M> Find point with maximal curvature 

When using this option, the system will automatically create a 3D label indicating the point on the curve 

with the maximum curvature. A distinctive feature of such 3D label is that it is red. 



Model Geometry Analysis 

1359 

MEASURING CURVATURE OF SURFACES  

This command allows measuring the curvature and radius of curvature of one or several selected faces.  

 

You can view the overall distribution of the curvature on a face (for this, the model will be colored 

appropriately), or find the curvature value at a specific point. 

To call the command “3VV: Show Surface Curvature”, use the textual menu: 

Icon Ribbon 

 

Measure→ Geometry analysis → Surface Curvature 

Keyboard Textual Menu 

<3V V> Tools > Geometry Analysis > Surface Curvature 

When measuring the curvature, you can select either separate faces or whole operations (that is, all faces 

of the given operation). 

 <F> Add/Remove selected Face. 

 <B> Add/Remove all Faces of Solid 

To cancel surface selection, click it again. To cancel selection of all objects, use the option: 

 <U> Cancel selection 

When selected, the face will change its color according to the type of curvature subject to the measurement 

and the settings on the “Colors” tab. Color handling for surface curvature measurements is done in the 

same way as in the command QC: Show Curve Curvature.  

When additional faces are selected, the range of the curvature radius changes; therefore, the color of the 

earlier selected faces may change.  
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Types of Measured Values 

As in the case of measuring curvature of curves, you can specify the value to measure in this command: 

Curvature or Radius. However, you need to additionally specify the type of the measured value. 

The type of the measured value is defined with the help of the Type 

combo box, located at the top of the properties window.  

The surface curvature at a specific point depends on the 

direction, in which the curvature is measured. The curvature 

will be maximal in one direction and minimal in another 

direction. Due to these facts, the system allows measuring 

the following types of values:  

 

“Minimal” or “Maximal”. With these parameter settings, measurements of the maximum or the 

minimum value will be done at each point of the selected surface. 

“Mean” - is half the sum of the minimum and the maximum measured values. 

“Gaussian” - is the product of the minimum and the maximum measured values. 

“U” and “V” - these parameters require the measurement to be done in just one of the directions. 

Measuring Curvature at a Point 

To measure curvature at a specific point, use the option: 

 <C> Measure curvature at arbitrary point 

 

Now, if you move the pointer to any point on the surface, the measured 

values will be displayed next to the pointer. The types of the measured 

values are defined by the parameter Displayed value, located on the tab 3D 

Labels.  

Clicking at some point on the face creates a 3D label.  

3D label handling is done in the same way as in the command QC: Show 

Curve Curvature, except that the parameter Displayed value, located on the 

tab 3D Labels, can take three values instead of two. 
 

Upon clicking a face, besides 3D label creation, the measured parameters can be added to the log. Once a 

face is clicked, the following is logged: the point coordinates, the values of all types of curvature and the 

values of the curvature radii of all types. Working with the Results” tab is done same as in the command 

QC: Show Curve Curvature”.  

To find the points of the maximum and minimum curvature of the specified type, use the option: 

 <M> Find minimal and maximal curvatures 
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When using this option, two 3D labels will be created automatically, one – red, and another one - blue, 

indicating the positions of the minimum and the maximum curvature. 

SURFACE DEVIATION  

This command allows finding deviation of the normal from the specified direction for the selected face. 

 
 

Color scale 

The colored image of the face allows viewing the deviation over all face area. It is also possible to measure 

deviation at a specific point. 

The command QD: Show Face Deviation can be called via: 

Icon Ribbon 

 

Measure→ Geometry analysis → Surface Deviation 

Keyboard Textual Menu 

<QD> Tools > Geometry Analysis > Surface Deviation 

Upon entering the command, you need to specify the direction, with respect to which the surface deviation 

will be determined. To select a direction-defining element, use the option: 

 <D> Click to select direction 

When using this option, you can select faces, edges, 3D profiles, workplanes and coordinate systems. 

To define the direction by specifying two 3D points, use the options: 

 <S> Select first Vertex or 3D Node 

 <E> Select second Vertex or 3D Node 

For point selections, you can use 3D nodes, vertices, edges, coordinate systems, sphere or torus faces. 

The specified direction can be flipped to the opposite by the option: 

 <I> Switch 

Upon choosing the direction, you need to select faces, whose deviation needs to be evaluated. To specify 

a particular face, use the option: 
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 <F> Add/Remove selected Face 

To select all faces of some body, use the option: 

 <B> Add/Remove all Faces of Solid 

Select all operations in the scene using the option: 

 <A> Select all operations 

To cancel face or body selection, you need to select them once again. 

To cancel selection of all faces, use the option: 

 <U> Cancel selection 

If the direction is specified, selected faces will change color according to the scale located on the tab 

Colors”. Working with this tab is exactly same as in the command QC: Show Curve Curvature”.  

To measure deviation at a specific point, use the option: 

 <C> Measure slope at point 

 

If you then move the pointer to a certain point on the face with this option active, the 

value of the face deviation from the specified direction will be displayed next to the 

pointer (at the given point). 
 

By default, if you click at a point on a face, a label will be created with the value of the face deviation in 

this point. Additionally, the values of the point coordinates and the slant angle will be recorded in the 

measurements log. 

Working with the tabs Results and 3D Labels is same as in the command QC: Show Curve Curvature.  

SURFACE GAP  

This command allows evaluating the gap between two or several selected faces or edges. The system 

evaluates the distance between edges. In this case, the command is used for evaluating the distance 

between edges throughout their extent, rather than the direct measurement of the distances between two 

points on the edges. To measure the exact distances, use the command PM: Measure Element or relation 

between two Elements. 

The command is mostly used for analyzing models resulting from deficiencies of an import or export. 
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         Color scale 

The distances between edges are calculated in the planes perpendicular to the 

edges. Therefore, for example, two choices of the distance it is used for a pair 

of nonparallel edges: from the first edge to the second and from the second 

edge to the first.  

The diagram on the right-hand side depicts two lines: a and b. The distances 

from a to b are shown by dashed lines (the segments l1a, l2a, l3a) and from b 

to a (the segments l1b, l2b, l3b).  

These are the exact distances (the dashed lines on the diagram), whose set is 

displayed in the 3D window as the distances between edges.  

 

The command QH: Show Gap Between Faces is called via: 

Icon Ribbon 

 

Measure→ Geometry analysis → Surface Gap 

Keyboard Textual Menu 

<QH> Tools > Geometry Analysis > Surface Gap 

Upon entering the command, you need to select faces or edges, between which you want to measure gaps. 

To select the faces, use the option: 

 <F> Add/Remove selected Face 

To select ribs use command: 

 <E> Select edge or cancel edge selection 

To cancel specific face of rib selection, click it again. To cancel selection of all faces, use the option: 

 <U> Cancel selection 

When several faces are selected, colored “quill” lines appear between the edges, indicating the gaps 

between the faces.  
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The option Maximal distance defines the maximum distance between 

two edges, for which the gap is to be measured. The greater is this 

parameters value, the more will be the number of edges between 

which the system would evaluate the gaps.  

If the Maximal distance value is great enough, the gaps will be evaluated from each edge of one face to 

each edge of the other face. 

Minimum distance defines the minimum distance between two edges, for which the gap is to be measured.  

Each line of the quill is painted depending on its length, in an appropriate color according to the color 

scale. The color scale setup is done on the tab Colors. Working with this tab is similar to that in the 

command QC: Show Curve Curvature.  

DEVIATION OF NORMALS  

This command allows measuring deviation of the normals on the adjacent faces at the selected edges.  

 
 

              Color scale 

The quills displayed in the 3D window allow viewing deviation of normals across the extent of an edge. 

You can also measure the angle of normal’s deviation at a specific point. 

The command QN: Show Normal Deviation” is called via: 

Icon Ribbon 

 

Measure→ Geometry analysis → Normal Deviation 

Keyboard Textual Menu 

<QN> Tools > Geometry Analysis > Normal Deviation 

Upon entering the command, you need to specify edges, at which you need to measure the deviation of 

normals. To select all edges belonging to a certain face, use the option: 

 <F> Add/Remove selected Face 

To select a specific edge, use the option: 

 <E> Select Edge or cancel Edge selection 

To cancel element selection, click it again. To cancel selection of all elements, use the option: 
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 <U> Cancel selection 

Upon selecting an edge, a quill diagram is displayed reflecting differences between the normal directions. 

The quill color varies according to the color scale defined on the tab “Colors”. Working with this tab is 

same as in the command QC: Show Curve Curvature. 

Depending on the difference in the face normals, the length of the quill 

lines may vary as well as the color. The way in which the length changes 

depending on the angle difference is defined by the parameter Length. 

The length of a quill’s lines can be proportional to the angle, inversely 

proportional to the angle, or constant.  

To measure normals deviation angle at a specific point on an edge, use the option: 

 <C> Measure deviation at point 

As the pointer approaches an edge, the angle value will be displayed next to the pointer. If you click this 

point on the edge, a 3D label will be created. Additionally, by default, the point coordinates and the angle 

value will be entered in the log on the tab Results. Working with the tabs Results and 3D Labels is done 

same as in command QC: Show Curve Curvature. 

SURFACE SMOOTHNESS  

This command allows evaluating regularity of the model. 

                        

This type of rendering allows to visually determine whether the adjoining faces are connected smoothly 

with tangency transitions, or with continuous transition of curvature. 

If all surfaces adjoin tangentially, then the texture stripes appear continuous, although may sharply change 

the direction. If the surfaces have smooth transition with continuous curvature, then the texture stripes are 

not just continuous, they also transit smoothly. 

The command QZ: Show Surface Smoothness (Zebra) can be called via: 

Icon Ribbon 

 

Measure→ Geometry analysis → Surface Smoothness 

Keyboard Textual Menu 

<QZ> Tools > Geometry Analysis > Surface Smoothness 
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Right after entering the command, the model coloring changes. By default, it 

will be a two-color pattern. The colors used in this case are defined by the 

buttons [Color 1] and [Color 2]. 

The width, relative width, the slant angle of the stripes and accuracy of their 

rendering are defined in the properties window. Use the appropriate sliders 

provided for this purpose. 

Besides, you can specify your own file in bmp, jpeg, gif or png format, 

containing the pattern that you want to use for examining the model’s 

smoothness. An input box is provided for this purpose at the bottom of the 

properties window. 
 

However, you may find the default pattern most convenient. In this way, the higher is the curvature, the 

finer are the stripes of the pattern applied on the model. The colored stripes are widest on flat faces. 

The stripes that paint the faces can be drawn in different directions. However, if the faces adjoin smoothly 

in terms of continuous tangency, the stripes are neither interrupted nor shifted with respect to each other, 

but can sharply change the direction. If the faces connect smoothly with continuous curvature, the stripes 

are not interrupted and smoothly change the direction. 

 
Non-smooth connection faces 

 
Smooth (continuous tangency) 

connection of faces 

 
Smooth (continuous curvature) 

connection of faces 

Rendering of the colored stripes in the 3D window is noticeably affected by the parameter Mesh 

density, defined on the tab 3D in the document status. We recommend using highest accuracy of 

the mesh density when examining the model regularity. 

MODEL SEPARATION CHECK  

This command serves for checking, whether an injection or die-cast mold used for making the model part 

is separable. 
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The command allows finding the faces of the regions preventing the mold from parting. Additionally, the 

faces are highlighted, whose taper angle with respect to the selected direction is less than specified. 

The command QS: Check Model Separation is called via: 

Icon Ribbon 

 

Measure→ Geometry analysis → Model Separation Check 

Keyboard Textual Menu 

<QS> Tools > Geometry Analysis > Model Separation Check 

Upon entering the command, you need to specify the direction of separating the mold. To select a 

direction-defining element, use the option: 

 <D> Click to select direction 

When using this option, you can select faces, edges, 3D profiles, workplanes and coordinate systems. 

To define the direction by specifying two 3D points, use the options: 

 <S> Select first Vertex or 3D Node 

 <E> Select second Vertex or 3D Node 

For point selections, you can use 3D nodes, vertices, edges, coordinate systems, sphere or torus faces. 

Upon choosing the direction, you need to select the operation, whose faces will be analyzed. To select an 

operation, use the option: 

 <B> Select source 3D operation 

Select all operations in the scene using the option: 

 <A> Select all operations 

To cancel an operation selection, you need to select it once again. 

To cancel selection of all operations, use the option: 

 <U> Cancel selection 

Upon completing the check, the operation’s faces change in color. By default, highlighted red are the faces 

of the regions preventing the mold from parting. The yellow color marks the faces, whose taper angle with 

respect to the selected direction is less than specified. The green marks the faces that are sufficiently 

tapered with respect to the selected direction and do not prevent the mold from parting. 

If multiple bodies are selected simultaneously, the system will run the separation check on all bodies 

together as if it was one part. Therefore, the results of checking several bodies separately and 

together will be different. 
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Besides the colored rendering in the 3D window, the check results are 

displayed in the Interfering faces pane. It contains overlapping faces (that 

prevent the part from ejecting) and faces with insufficient draft. The core 

and the cavity faces are also specified here.  

The core and the cavity faces – not overlapping faces with sufficient draft that ensures that the part ejects 

properly from the tooling. These faces define the mold working region. 

If you expand the list of reports and click the name of a problematic face, the face will be highlighted in 

the 3D window. 

If the Keep selection flag is set, then, upon leaving the command, 

the highlighted faces will stay selected. This is done for 

convenience. 

The parameter Minimal slope sets the minimum permissible taper 

angle of the faces with respect to the selected direction. 

 

CHECKING MODEL CHANGES  

The command for checking modifications of the model allows the user 

to reveal the differences between two solid bodies of the 3D model. 

With the help of this command, the user can compare different bodies 

or the same body at various stages of creating modifications. Also, 

upon the presence of the saved configurations in the model, you can 

compare between each other two versions of the same part. In 

addition, the command is able to calculate the volume of the modified 

space, which allows us to estimate the extent of differences more 

accurately. 
 

The command QA: Check Model Changes can be invoked by the following means: 

Icon Ribbon 

 

Measure→ Geometry analysis → Check Changes 

Keyboard Textual Menu 

<QA> Tools > Geometry Analysis > Check Changes 

After entering into the command, the user has to specify the model operations/configurations to be 

compared. 

For comparing two bodies the following options are used: 

 <F> Select first Solid 

 <S> Select second Solid 
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With the help of these options, the user can select different solid 

bodies of the same model as well as operations applied at different 

history levels to the same body. For selecting operations, you can use, 

for example, the tree of the 3D model. The selected operations are 

put into the fields First operand and Second operand in the 

command's properties window. 

 

If in the current 3D model there are saved configurations, in the auto menu of the command the additional 

option will appear: 

 <C> Select Model Configuration 

This option allows selecting one of the configurations saved in the model as 

the second operand for comparison. 

The way of comparing the selected operands can be chosen in the dialog of 

the command's properties window with the help of the drop down list Type: 

Subtraction (1-2). The result of comparison will be similar to the 

outcome of the boolean operation of subtraction of the first 

operand from the second; 
 

Subtraction (2-1). The result of comparison will be similar to the 

outcome of the boolean operation of subtraction of the second 

operand from the first; 

Intersection. The result of comparison will be similar to the outcome 

of the boolean operation of intersection of the first and second 

operands; 

Union. The result of comparison will be similar to the outcome of the 

boolean operation of union of the first and second operands. 

 

The way of comparing can be also selected in the auto menu of the command by turning on one of the 

following options: 

 <-> Subtraction “1-2” 

 <Ctrl><-> Subtraction “2-1” 

 <*> Intersection 

 <+> Union 

After pressing  the result of comparison of the selected operands is highlighted in the 3D window with 

the red color. 
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For calculating the volume of the modified space, you additionally need to 

set the flag Calculate Volume in the dialog of the command's properties. 

The precision and units for calculating the volume are set with the help of 

the group of parameters below the given flag. 
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